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i. Copyright and Trademark Information
© 2022 ANSYS, Inc. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, AUTODYN, CFX, FLUENT and any and all ANSYS, Inc. brand, product, service and feature
names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries located in the
United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark of
Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property of
their respective owners. FLEXlm and FLEXnet are trademarks of Flexera Software LLC.

Disclaimer Notice
THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL
AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and
documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that
contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws,
warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and
documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of
that software license agreement

ANSYS, Inc. and ANSYS Europe, Ltd. are UL registered ISO 9001: 2015

U.S. Government Rights
For U.S. Government users, except as specifically granted by the Ansys, Inc. software license agreement, the use,
duplication, or disclosure by the United States Government is subject to restrictions stated in the Ansys, Inc. software
license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software
See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software
and third-party software. If you are unable to access the Legal Notice, contact Ansys, Inc.

Published in the U.S.A.

Protected by US Patents 7,639,267, 7,733,340, 7,830,377, 7,969,435, 8,207,990, 8,244,508, 8,253,726, 8,330,775,
10,650,172, 10,706,623, 10,769,850, D916,099, D916,100, and 11,269,478.

Copyright © 2003-2022 ANSYS, Inc. All Rights Reserved. SpaceClaim is a registered trademark of ANSYS, Inc.

Portions of this software Copyright © 2010 Acresso Software Inc. FlexLM and FLEXNET are trademarks of Acresso
Software Inc.

Portions of this software Copyright © 2008 Adobe Systems Incorporated. All Rights Reserved. Adobe and Acrobat
are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries

Ansys Workbench and GAMBIT and all other ANSYS, Inc. product names are trademarks or registered trademarks of
ANSYS, Inc. or its subsidiaries in the United States or other countries.

Contains BCLS (Bound-Constrained Least Squares) Copyright (C) 2006 Michael P. Friedlander, Department of
Computer Science, University of British Columbia, Canada, provided under a LGPL 3 license which is included in the
SpaceClaim installation directory (lgpl-3.0.txt). Derivative BCLS source code available upon request.

Contains SharpZipLib Copyright © 2009 C#Code

Anti-Grain Geometry Version 2.4 Copyright © 2002-2005 Maxim Shemanarev (McSeem).
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Some SpaceClaim products may contain Autodesk® RealDWG by Autodesk, Inc., Copyright © 1998-2010 Autodesk,
Inc. All rights reserved. Autodesk, AutoCAD, and Autodesk Inventor are registered trademarks and RealDWG is a
trademark of Autodesk, Inc.

CATIA is a registered trademark of Dassault Systèmes.

Portions of this software Copyright © 2010 Google. SketchUp is a trademark of Google.

Portions of this software Copyright © 1999-2006 Intel Corporation. Licensed under the Apache License, Version 2.0.
You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0.

Contains DotNetBar licensed from devcomponents.com.

KeyShot is a trademark of Luxion ApS.

MatWeb is a trademark of Automation Creations, Inc.

2008 Microsoft ® Office System User Interface is licensed from Microsoft Corporation. Direct3D, DirectX, Microsoft
PowerPoint, Excel, Windows, Windows Vista and the Windows Vista Start button are trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other countries.

Portions of this software Copyright © 2005 Novell, Inc. (http://www.novell.com)

Creo Parametric and PTC are registered trademarks of Parametric Technology Corporation.

Persistence of Vision Raytracer and POV-Ray are trademarks of Persistence of Vision Raytracer Pty. Ltd.

Portions of this software Copyright © 1993-2009 Robert McNeel & Associates. All Rights Reserved. openNURBS is a
trademark of Robert McNeel & Associates. Rhinoceros is a registered trademark of Robert McNeel & Associates.

Portions of this software Copyright © 2005-2007, Sergey Bochkanov (ALGLIB project). *

Portions of this software are owned by Siemens PLM © 1986-2011. All Rights Reserved. Parasolid and Unigraphics
are registered trademarks and JT is a trademark of Siemens Product Lifecycle Management Software, Inc.

This work contains the following software owned by Siemens Industry Software Limited: D-CubedTM 2D DCM ©

2021. Siemens. All Rights Reserved.

SOLIDWORKS is a registered trademark of SOLIDWORKS Corporation.

Portions of this software are owned by Spatial Corp. © 1986-2011. All Rights Reserved. ACIS and SAT are registered
trademarks of Spatial Corp.

Contains Teigha for .dwg files licensed from the Open Design Alliance. Teigha is a trademark of the Open Design
Alliance.

Development tools and related technology provided under license from 3Dconnexion. © 1992 – 2008 3Dconnexion.
All rights reserved.

TraceParts is owned by TraceParts S.A. TraceParts is a registered trademark of TraceParts S.A.

Contains a modified version of source available from Unicode, Inc., copyright © 1991-2008 Unicode, Inc. All rights
reserved. Distributed under the Terms of Use in http://www.unicode.org/copyright.html.

Portions of this software Copyright © 1992-2008 The University of Tennessee. All rights reserved. [1]

Portions of this software Copyright © XHEO INC. All Rights Reserved. DeployLX is a trademark of XHEO INC.

This software incorporates information provided by American Institute of Steel Construction (AISC) for shape data
available at http://www.aisc.org/shapesdatabase.

This software incorporates information provided by ArcelorMittal® for shape data available at
http://www.sections.arcelormittal.com/products-services/products-ranges.html.

All other trademarks, trade names or company names referenced in SpaceClaim software, documentation and
promotional materials are used for identification only and are the property of their respective owners.
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*Additional notice for LAPACK and ALGLIB Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:-Redistributions of source code must
retain the above copyright notice, this list of conditions and the following disclaimer.-Redistributions in binary form
must reproduce the above copyright notice, this list of conditions and the following disclaimer listed in this license
in the documentation and/or other materials provided with the distribution.-Neither the name of the copyright
holders nor the names of its contributors may be used to endorse promote products derived from this software
without specific prior written permission.

BCLS is licensed under the GNU Lesser General Public License (GPL) Version 3, Copyright (C) 2006 Michael P.
Friedlander, Department of Computer Science, University of British Columbia, Canada. A copy of the LGPL license
is included in the installation directory (lgpl-3.0.txt).

Please contact open.source@ansys.com for a copy of the source code for BCLS.

Eigen is licensed under the Mozilla Public License (MPL) Version 2.0, the text of which can be found at:
https://www.mozilla.org/media/MPL/2.0/index.815ca599c9df.txt. Please contact open.source@ansys.com for a
copy of the Eigen source code.

HDF5 (Hierarchical Data Format 5) Software Library and Utilities

Copyright (c) 2006, The HDF Group.

NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities

Copyright (c) 1998-2006, The Board of Trustees of the University of Illinois.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted for any purpose
(including commercial purposes) provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following
disclaimer in the documentation and/or materials provided with the distribution.

3. In addition, redistributions of modified forms of the source or binary code must carry prominent notices stating
that the original code was changed and the date of the change.

4. All publications or advertising materials mentioning features or use of this software are asked, but not required,
to acknowledge that it was developed by The HDF Group and by the National Center for Supercomputing Applications
at the University of Illinois at Urbana-Champaign and credit the contributors.

5. Neither the name of The HDF Group, the name of the University, nor the name of any Contributor may be used to
endorse or promote products derived

from this software without specific prior written permission from The HDF Group, the University, or the Contributor,
respectively.

DISCLAIMER:

THIS SOFTWARE IS PROVIDED BY THE HDF GROUP AND THE CONTRIBUTORS "AS IS" WITH NO WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED. In no

event shall The HDF Group or the Contributors be liable for any damages suffered by the users arising out of the use
of this software, even if advised of the possibility of such damage. Anti-Grain Geometry - Version 2.4 Copyright (C)
2002-2004 Maxim Shemanarev (McSeem)

Permission to copy, use, modify, sell and distribute this software is granted provided this copyright notice appears
in all copies. This software is provided "as is" without express or implied warranty, and with no claim as to its
suitability for any purpose.
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Some ANSYS-SpaceClaim products may contain Autodesk® RealDWG by Autodesk, Inc., Copyright © 1998-2010
Autodesk, Inc. All rights reserved. Autodesk, AutoCAD, and Autodesk Inventor are registered trademarks and RealDWG
is a trademark of Autodesk, Inc.

CATIA is a registered trademark of Dassault Systèmes.

Portions of this software Copyright © 2013 Trimble. SketchUp is a trademark of Trimble Navigation Limited.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software Copyright © 1999-2006 Intel Corporation. Licensed under the Apache License, Version 2.0.
You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Contains DotNetBar licensed from devcomponents.com.

Portions of this software Copyright © 1988-1997 Sam Leffler and Copyright (c) 1991-1997 Silicon Graphics, Inc.

KeyShot is a trademark of Luxion ApS.

MatWeb is a trademark of Automation Creations, Inc.

2010 Microsoft ® Office System User Interface is licensed from Microsoft Corporation. Direct3D, DirectX, Microsoft
PowerPoint, Excel, Windows/Vista/Windows 7/Windows 8/Windows 10 and their respective Start Button designs are
trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.

Portions of this software Copyright © 2005 Novell, Inc. (Licensed at
http://stuff.mit.edu/afs/athena/software/mono_v3.0/arch/i386_linux26/mono/mcs/class/Managed.Windows.Forms/System.Windows.Forms.RTF/)

Pro/ENGINEER and PTC are registered trademarks of Parametric Technology Corporation.

POV-Ray is available without charge from http://www.pov-ray.org. No charge is being made for a grant of the license
to POV-Ray.

POV-Ray License Agreement

DISTRIBUTOR'S LICENCE AGREEMENT

Persistence of Vision Raytracer(tm) (POV-Ray(tm))

13 August 2004

Licensed Versions: Versions 3.5 and 3.6

Please read through the terms and conditions of this license carefully. This is a binding legal agreement between
you, the "Distributor" and Persistence of Vision Raytracer Pty. Ltd. ACN 105 891 870 ("POV"), a company incorporated
in the state of Victoria, Australia, for the product known as the "Persistence of Vision Raytracer(tm)", also referred
to herein as "POV-Ray(tm)". The terms of this agreement are set out at http://www.povray.org/distribution-license.html
("Official Terms"). The Official Terms take precedence over this document to the extent of any inconsistency.

1. INTRODUCTION

1.1. In this agreement, except to the extent the context requires otherwise, the following capitalized terms have the
following meanings:

(a) Distribution means:

(i) a single item of a distribution medium, including a CD Rom or DVD Rom, containing software programs and/or
data;

(ii) a set of such items;

(iii) a data file in a generally accepted data format from which such an item can be created using generally available
standard tools;

(iv) a number of such data files from which a set of such items can be created; or

(v) a data file in a generally accepted data storage format which is an archive of software programs and/or data;
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(b) Derived Code means all software which is derived from or is an adaptation of any part of the Software other than
a scene file;

(c) Intellectual Rights means:

(i) all copyright, patent, trade mark, trade secret, design, and circuit layout rights;

(ii) all rights to the registration of such rights; and

(iii) all rights of a similar nature which exist anywhere in the world;

(d) Licensed Version means the version set out at the top of this agreement against the heading "Licensed Version"
and all minor releases of this version (ie releases of the form x.y.z);

(e) POV Associate means any person associated directly or indirectly with POV whether as a director, officer, employee,
subcontractor, agent, representative, consultant, licensee or otherwise;

(f) Modification Terms means the most recent version from time to time of the document of that name made available
from the Site (g) Revocation List means the list of that name linked to from the Official Terms;

(h) Site means www.povray.org;

(i) Software means the Licensed Version of the Persistence of Vision Raytracer(tm) (also known as POV-Ray(tm))
(including all POV-Ray program source files, executable (binary) files, scene files, documentation files, help files,
bitmaps and other POV-Ray files associated with the Licensed Version) in a form made available by

POV on the Site;

(j) User Licence means the most recent version from time to time of the document of that name made available from
the Site.

2. OPEN SOURCE DISTRIBUTIONS

2.1. In return for the Distributor agreeing to be bound by the terms of this agreement, POV grants the Distributor
permission to make a copy of the Software by including the Software in a generally recognised Distribution of a
recognised operating system where the kernel of that operating system is made available under licensing terms:

(a) which are approved by the Open Source Initiative (www.opensource.org) as complying with the "Open Source
Definition" put forward by the Open Source Initiative; or

(b) which comply with the "free software definition" of the Free Software Foundation (www.fsf.org). 2.2. As at June
2004, and without limiting the generality of the term, each of the following is a "generally recognised Distribution"
for the purposes of clause 2.1: Debian, Red Hat (Enterprise and Fedora), SuSE, Mandrake, Xandros, Gentoo and
Knoppix Linux distributions, and officially authorized distributions of the FreeBSD, OpenBSD, and NetBSD projects.

2.3. Clause 2.1 also applies to the Software being included in the above distributions 'package' and 'ports' systems,
where such exist;

2.4. Where the Distributor reproduces the Software in accordance with clause 2.1:

(a) the Distributor may rename, reorganise or repackage (without omission) the files comprising the Software where
such renaming, reorganisation or repackaging is necessary to conform to the naming or organisation scheme of the
target operating environment of the Distribution or of an established package management system of the target
operating environment of the Distribution; and (b) the Distributor must not otherwise rename, reorganise or repackage
the Software.

3. DISTRIBUTION LICENCE

3.1. Subject to the terms and conditions of this agreement, and in return for Distributor agreeing to be bound by the
terms of this agreement, POV grants the Distributor permission to make a copy of the Software in any of the following
circumstances:(a) in the course of providing a mirror of the POV-Ray Site (or part of it), which is made available
generally over the internet to each person without requiring that person to identify themselves and without any
other restriction other than restrictions designed to manage traffic flows;
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(b) by placing it on a local area network accessible only by persons authorized by the Distributor whilst on the
Distributor's premises;

(c) where that copy is provided to a staff member or student enrolled at a recognised educational institution;

(d) by including the Software as part of a Distribution where:

(i) neither the primary nor a substantial purpose of the distribution of the Distribution is the distribution of the
Software. That is, the distribution of the Software

is merely incidental to the distribution of the Distribution; and

(ii) if the Software was not included in the Distribution, the remaining software and data included within the
Distribution would continue to function effectively and

according to its advertised or intended purpose;

(e) by including the Software as part of a Distribution where:

(i) there is no data, program or other files apart from the Software on the Distribution;

(ii) the Distribution is distributed by a person to another person known to that person; or

(iii) the Distributor has obtained explicit written authority from POV to perform the distribution, citing this clause
number, prior to the reproduction being

made.

3.2. In each case where the Distributor makes a copy of the Software in accordance with clause 3.1, the Distributor
must, unless no payment or other consideration of any type is received by Distributor in relation to the Distribution:

(a) ensure that each person who receives a copy of the Software from the Distributor is aware prior to acquiring that
copy:

(i) of the full name and contact details of the Distributor, including the Distributor's web site, street address, mail
address, and working email address;

(ii) that the Software is available without charge from the Site;

(iii) that no charge is being made for the granting of a licence over the Software.

(b) include a copy of the User Licence and this Distribution License with the copy of the Software. These licences
must be stored in the same subdirectory on the distribution medium as the Software and named in such a way as
to prominently identify their purpose;

3.3. The Distributor must not rename, reorganise or repackage any of the files comprising the Software without the
prior written authority of POV.

3.4. Except as explicitly set out in this agreement, nothing in this agreement permits Distributor to make any
modification to any part of the Software.

4. RESTRICTIONS ON DISTRIBUTION

4.1. Nothing in this agreement gives the Distributor: (a) any ability to grant any licence in respect of the use of the
Software or any part of it to any person;

(b) any rights or permissions in respect of, including rights or permissions to distribute or permit the use of, any
Derived Code;

(c) any right to bundle a copy of the Software (or part thereof), whether or not as part of a Distribution, with any
other items, including books and magazines. POV may, in response to a request, by notice in writing and in its
absolute discretion, permit such bundling on a case by case basis. This clause 4.1(c) does not apply to Distributions
permitted under clause 2;

(d) any right, permission or authorisation to infringe any Intellectual Right held by any third party.

4.2. Distributor may charge a fee for the making or the provision of a copy of the Software.
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4.3. Where the making, or the provision, of a copy of the Software is authorised under the terms of clause 3 but not
under those of clause 2 of this agreement, the total of all fees charged in relation to such making or provision and
including all fees (including shipping and handling fees) which are charged in respect

of any software, hardware or other material provided in conjunction with or in any manner which is reasonably
connected with the making, or the provision, of a copy of the Software must not exceed the reasonable costs incurred
by the Distributor in making the reproduction, or in the provision, of that copy for which the fee

is charged.

4.4. Notwithstanding anything else in this agreement, nothing in this agreement permits the reproduction of any
part of the Software by, or on behalf of:

(a) Any person currently listed on the Revocation List from time to time;

(b) Any related body corporate (as that term is defined in section 50 of the Corporations Law 2001 (Cth)) of any
person referred to in clause 4.4(a);

(c) Any person in the course of preparing any publication in any format (including books, magazines, CD Roms or
on the internet) for any of the persons identified in paragraph (a);

(d) Any person who is, or has been, in breach of this Agreement and that breach has not been waived in writing
signed by POV; or

(e) Any person to whom POV has sent a notice in writing or by email stating that that person may not distribute the
Software.

4.5. From the day two years after a version of the Software more recent than the Licensed Version is made available
by POV on the Site clause 3 only permits reproduction of the Software where the Distributor ensures that each
recipient of such a reproduction is aware, prior to obtaining that reproduction, that that reproduction of the Software
is an old version of the Software and that a more recent version of the Software is available from the Site.

5. COPYRIGHT AND NO LITIGATION

5.1. Copyright subsists in the Software and is protected by Australian and international copyright laws.

5.2. Nothing in this agreement gives Distributor any rights in respect of any Intellectual Rights in respect of the
Software or which are held by or on behalf of POV. Distributor acknowledges that it does not acquire any rights in
respect of such Intellectual Rights.

5.3. Distributor acknowledges that if it performs out any act in respect of the Software without the permission of
POV it will be liable to POV for all damages POV may suffer (and which Distributor acknowledges it may suffer) as
well as statutory damages to the maximum extent permitted by law and that it may also be liable to

criminal prosecution.

5.4. Distributor must not commence any action against any person alleging that the Software or the use or distribution
of the Software infringes any rights, including Intellectual Rights of the Distributor or of any other person. If Distributor
provides one or more copies of the Software to any other person in accordance with the agreement, Distributor
waives all rights it has, or may have in the future, to bring any action, directly or indirectly, against any person to
the extent that such an action relates to an infringement of any rights, including Intellectual Rights of any person in
any way arising from, or in relation to, the use, or distribution, (including through the authorisation of such use or
distribution) of:(a) the Software;

(b) any earlier or later version of the Software; or

(c) any other software to the extent it incorporates elements of the software referred to in paragraphs (a) or (b) of
this clause

5.4.

6. DISCLAIMER OF WARRANTY
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6.1. To the extent permitted by law, all implied terms and conditions are excluded from this agreement. Where a
term or condition is implied into this agreement and that term cannot be legally excluded, that term has effect as
a term or condition of this agreement. However, to the extent permitted by law, the liability

of POV for a breach of such an implied term or condition is limited to the fullest extent permitted by law.

6.2. To the extent permitted by law, this Software is provided on an "AS IS" basis, without warranty of any kind,
express or implied, including without limitation, any implied warranties of merchantability, fitness for a particular
purpose and non-infringement of intellectual property of any third party. The Software has inherent limitations
including design faults and programming bugs.

6.3. The entire risk as to the quality and performance of the Software is borne by Distributor, and it is Distributor's
responsibility to ensure that the Software fulfils Distributor's requirements prior to using it in any manner (other
than testing it for the purposes of this paragraph in a non-critical and non-production environment), and prior to
distributing it in any fashion.

6.4. This clause 6 is an essential and material term of, and cannot be severed from, this agreement. If Distributor
does not or cannot agree to be bound by this clause, or if it is unenforceable, then Distributor must not, at any time,
make any reproductions of the Software under this agreement and this agreement gives the

Distributor no rights to make any reproductions of any part of the Software.

7. NO LIABILITY

7.1. When you distribute or use the Software you acknowledge and accept that you do so at your sole risk. Distributor
agrees that under no circumstances will it have any claim against POV or any POV Associate for any loss, damages,
harm, injury, expense, work stoppage, loss of business information, business interruption,

computer failure or malfunction which may be suffered by you or by any third party from any cause whatsoever,
howsoever arising, in connection with your use or distribution of the Software even where POV was aware, or ought
to have been aware, of the potential of such loss.

7.2. Neither POV nor any POV Associate has any liability to Distributor for any indirect, general, special, incidental,
punitive and/or consequential damages arising as a result of a breach of this agreement by POV or which arises in
any way related to the Software or the exercise of a licence granted to Distributor under this

agreement.

7.3. POV's total aggregate liability to the Distributor for all loss or damage arising in any way related to this agreement
is limited to the lesser of: (a) AU$100, and (b) the amount received by POV from Distributor as payment for the grant
of a licence under this agreement.

7.4. Distributor must bring any action against POV in any way related to this agreement or the Software within 3
months of the cause of action first arising. Distributor waives any right it has to bring any action against POV and
releases POV from all liability in respect of a cause of action if initiating process in relation to that action is not served
on POV within 3 months of the cause of action arising. Where a particular set of facts give rise to more than one cause
of action this clause 7.4 applies as if all such causes of action arise at the time the first such cause of action arises.

7.5. This clause 7 is an essential and material term of, and cannot be severed from, this agreement. If Distributor
does not or cannot agree to be bound by this clause, or if it is unenforceable, then Distributor must not, at any time,
make any reproductions of the Software under this agreement and this agreement gives the Distributor no rights
to make any reproductions of any part of the Software.

8. INDEMNITY

8.1. Distributor indemnifies POV and each POV Associate and holds each of them harmless against all claims which
arise from any loss, damages, harm, injury, expense, work stoppage, loss of business information, business
interruption, computer failure or malfunction, which may be suffered by Distributor or any other

party whatsoever as a consequence of:

(a) any act or omission of POV and/or any POV Associate, whether negligent or not;

(b) Distributor's use and/or distribution of the Software; or
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(c) any other cause whatsoever, howsoever arising, in connection with the Software. This clause 8 is binding on
Distributor's estate, heirs, executors, legal successors, administrators, parents and/or guardians.

8.2. Distributor indemnifies POV, each POV Associate and each of the authors of any part of the Software against all
loss and damage and for every other consequence flowing from any breach by Distributor of any Intellectual Right
held by POV.

8.3. This clause 8 constitutes an essential and material term of, and cannot be severed from, this agreement. If
Distributor does not or cannot agree to be bound by this clause, or if it is unenforceable, then Distributor must not,
at any time, make any reproductions of the Software under this agreement and this agreement gives the Distributor
no rights to make any reproductions of any part of the Software.

9. HIGH RISK ACTIVITIES

9.1. This Software and the output produced by this Software is not fault-tolerant and is not designed, manufactured
or intended for use as on-line control equipment in hazardous environments requiring fail-safe performance, in
which the failure of the Software could lead or directly or indirectly to death, personal injury, or severe physical or
environmental damage ("High Risk Activities"). POV specifically disclaims all express or implied warranty of fitness
for High Risk Activities and, notwithstanding any other term of this agreement, explicitly prohibits the use or
distribution of the Software for such purposes.

10. ENDORSEMENT PROHIBITION

10.1. Distributor must not, without explicit written permission from POV, claim or imply in any way that:

(a) POV or any POV Associate officially endorses or supports the Distributor or any product (such as CD, book, or
magazine) associated with the Distributor or any reproduction of the Software made in accordance with this
agreement; or(b) POV derives any benefit from any reproduction made in accordance with this agreement.

11. TRADEMARKS

11.1. "POV-Ray(tm)", "Persistence of Vision Raytracer(tm)" and "POV-Team(tm)" are trademarks of Persistence of
Vision Raytracer Pty. Ltd. Any other trademarks referred to in this agreement are the property of their respective
holders. Distributor must not use, apply for, or register anywhere in the world, any word, name

(including domain names), trade mark or device which is substantially identical or deceptively or confusingly similar
to any of Persistence of Vision Raytracer Pty. Ltd's trade marks.

12. MISCELLANEOUS

12.1. The Official Terms, including those documents incorporated by reference into the Official Terms, and the
Modification Terms constitute the entire agreement between the parties relating to the distribution of the Software
and, except where stated to the contrary in writing signed by POV, supersedes all previous

negotiations and correspondence in relation to it.

12.2. POV may modify this agreement at any time by making a revised licence available from the Site at
http://www.povray.org/distribution-license.html.

This agreement is modified by replacing the terms in this agreement with those of the revised licence from the time
that the revised licence is so made available. It is your responsibility to ensure that you have read and agreed to the
current version of this agreement prior to distributing the Software.

12.3. Except where explicitly stated otherwise herein, if any provision of this Agreement is found to be invalid or
unenforceable, the invalidity or unenforceability of such provision shall not affect the other provisions of this
agreement, and all provisions not affected by such invalidity or unenforceability shall remain in

full force and effect. In such cases Distributor agrees to attempt to substitute for each invalid or unenforceable
provision a valid or enforceable provision which achieves to the greatest extent possible, the objectives and intention
of the invalid or unenforceable provision.

12.4. A waiver of a right under this agreement is not effective unless given in writing signed by the party granting
that waiver. Unless otherwise stipulated in the waiver, a waiver is only effective in respect of the circumstances in
which it is given and is not a waiver in respect of any other rights or a waiver in respect of

xRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

i. Copyright and Trademark Information



future rights or actions.

12.5. The validity and interpretation of this agreement is governed by the laws in force in the State of Victoria,
Australia. Distributor submits to the exclusive jurisdiction of the courts of that State and courts located within that
State exercising federal jurisdiction.

12.6. References in this agreement to "written" and "writing" mean on paper or by fax and expressly exclude email
and other forms of electronic communication.

13. CONTACT INFORMATION

13.1. This clause 13 does not form part of the agreement. License inquiries can be made via email; please use the
following address (but see 13.2 below prior to emailing) : team-coord-[three-letter month]-[four-digit year]@povray
org. for example, team-coord-jun-2004@povray.org should be used if at the time you send the email it is the month
of June 2004. The changing email addresses are necessary to combat spam. Old email addresses may be deleted at
POV's discretion.

13.2. Note that the address referred to in 13.1 may change for reasons other than those referred to in that clause;
please check the current version of this document at http://www.povray.org/distribution-license.html. for the current
address. Your inability or failure to contact us is no excuse for violating the licence.

13.3. Do NOT send any email attachments of any sort other than by prior arrangement. Do not send email in HTML
format. EMAIL MESSAGES INCLUDING ATTACHMENTS WILL BE DELETED UNREAD.

13.4. The following postal address is only for official license business. Please note that it is preferred that initial
queries about licensing be made via email; postal mail should only be used when email is not possible, or when
written documents are being exchanged by prior arrangement. While it is unlikely this address will change in the
short term it would be advisable to check http://www.povray.org/distribution-license.html for the current one prior
to sending postal mail.

Persistence of Vision Raytracer Pty. Ltd.

PO Box 407

Williamstown,

Victoria 3016

Australia

POV-Ray Licence Agreement

GENERAL LICENSE AGREEMENT

FOR PERSONAL USE

Persistence of Vision Ray Tracer (POV-Ray)

Version 3.6 License and Terms & Conditions of Use

version of 1 February 2005

(also known as POVLEGAL.DOC)

Please read through the terms and conditions of this license carefully. This license is a binding legal agreement
between you, the 'User' (an individual or single entity) and Persistence of Vision Raytracer Pty. Ltd. ACN 105 891 870
(herein also referred to as the "Company"), a company incorporated in the state of Victoria, Australia, for the product
known as the "Persistence of Vision Ray Tracer", also referred to herein as 'POV-Ray'.

YOUR ATTENTION IS PARTICULARLY DRAWN TO THE DISCLAIMER OF WARRANTY AND NO LIABILITY AND INDEMNITY
PROVISIONS. TO USE THE PERSISTENCE OF VISION RAY TRACER ("POV-RAY") YOU MUST AGREE TO BE BOUND BY
THE TERMS AND CONDITIONS SET OUT IN THIS DOCUMENT. IF YOU DO NOT AGREE TO ALL THE TERMS AND
CONDITIONS OF USE OF POV-RAY SET OUT IN THIS LICENSE AGREEMENT, OR IF SUCH TERMS AND CONDITIONS ARE
NOT BINDING ON YOU IN YOUR JURISDICTION, THEN YOU MAY NOT USE POV-RAY IN ANY MANNER. THIS GENERAL
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LICENSE AGREEMENT MUST ACCOMPANY ALL POV-RAY FILES WHETHER IN THEIR OFFICIAL OR CUSTOM VERSION
FORM. IT MAY NOT BE REMOVED OR MODIFIED. THIS GENERAL LICENSE AGREEMENT GOVERNS THE USE OF

POV-RAY WORLDWIDE. THIS DOCUMENT SUPERSEDES AND REPLACES ALL PREVIOUS GENERAL LICENSES.

INTRODUCTION

This document pertains to the use of the Persistence of Vision Ray Tracer (also known as POV-Ray). It applies to all
POV-Ray program source files, executable (binary) files, scene files, documentation files, help files, bitmaps and
other POV-Ray files contained in official Company archives, whether in full or any part thereof, and are herein referred
to as the "Software". The Company reserves the right to revise these rules in future versions and to make additional
rules to address new circumstances at any time. Such rules, when made, will be posted in a revised license file, the
latest version of which is available from the Company website at

http://www.povray.org/povlegal.html.

USAGE PROVISIONS

Subject to the terms and conditions of this agreement, permission is granted to the User to use the Software and
its associated files to create and render images. The creator of a scene file retains all rights to any scene files they
create, and any images generated by the Software from them. Subject to the other terms of this license, the User is
permitted to use the Software in a profit-making enterprise, provided such profit arises primarily from use of the
Software and not from distribution of the Software or a work including the Software in whole or part.

Please refer to http://www.povray.org/povlegal.html for licenses covering distribution of the Software and works
including the Software. The User is also granted the right to use the scene files, fonts, bitmaps, and include files
distributed in the INCLUDE and SCENES\INCDEMO sub-directories of the Software in their own scenes. Such permission
does not extend to any other files in the SCENES directory or its sub-directories. The SCENES files are for the User's
enjoyment and education but may not be the basis of any derivative works unless the file in question explicitly grants
permission to do such.

This licence does not grant any right of re-distribution or use in any manner other than the above. The Company
has separate license documents that apply to other uses (such as re-distribution via the internet or on CD) ; please
visit http://www.povray.org/povlegal.html for links to these. In particular you are advised that the sale, lease, or
rental of the Software in any form without written authority from the Company is explicitly prohibited. Notwithstanding
anything in the balance of this licence agreement, nothing in this licence agreement permits the installation or use
of the Software in conjunction with any product (including software) produced or distributed by any party who is,
or has been, in violation of this licence agreement or of the distribution licence
(http://www.povray.org/distribution-license.html)

(or any earlier or later versions of those documents) unless:

a. the Company has explicitly released that party in writing from the consequences of their non compliance; or

b. both of the following are true:

i. the installation or use of the Software is without the User being aware of the abovementioned violation; and

ii. the installation or use of the Software is not a result (whether direct or indirect) of any request or action of the
abovementioned party (or any of its products), any agent of that party (or any of their products), or any person(s)
involved in supplying any such product to the User.

COPYRIGHT

Copyright © 1991-2003, Persistence of Vision Team.

Copyright © 2003-2004, Persistence of Vision Raytracer Pty. Ltd.

Windows version Copyright © 1996-2003, Christopher Cason.

Copyright subsists in this Software which is protected by Australian and international copyright laws. The Software
is NOT PUBLIC DOMAIN. Nothing in this agreement shall give you any rights in respect of the intellectual property
of the Company and you acknowledge that you do not acquire any rights in respect of such intellectual property
rights. You acknowledge that the Software is the valuable intellectual property of the Company and that if you use,

xiiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

i. Copyright and Trademark Information



modify or distribute the Software for unauthorized purposes or in an unauthorized manner (or cause or allow the
forgoing to occur), you will be liable to the Company for any damages it may suffer (and which you acknowledge it
may suffer) as well as statutory damages to the maximum extent permitted by law and also that you may be liable
to

criminal prosecution. You indemnify the Company and the authors of the Software for every single consequence
flowing from the aforementioned events.

DISCLAIMER OF WARRANTY

express or implied, including without limitation, any implied warranties of merchantability, fitness for a particular
purpose and non-infringement of intellectual property of any third party. This Software has inherent limitations
including design faults and programming bugs. The entire risk as to the quality and performance of the Software is
borne by you, and it is your responsibility to ensure that it does what you require it to do prior to using it for any
purpose (other than testing it), and prior to distributing it in any fashion. Should the Software prove defective, you
agree that you alone assume the entire cost resulting in any way from such defect.

This disclaimer of warranty constitutes an essential and material term of this agreement. If you do not or cannot
accept this, or if it is unenforceable in your jurisdiction, then you may not use the Software in any manner.

NO LIABILITY

When you use the Software you acknowledge and accept that you do so at your sole risk. You agree that under no
circumstances shall you have any claim against the Company or anyone associated directly or indirectly with the
Company whether as employee, subcontractor, agent, representative, consultant, licensee or otherwise ("Company
Associates") for any loss, damages, harm, injury, expense, work stoppage, loss of business information, business
interruption, computer failure or malfunction which may be suffered by you or by any third party from any cause
whatsoever, howsoever arising, in connection with your use or distribution of the Software even where the Company
were aware, or ought to have been aware, of the potential of such loss. Damages referred to above shall include
direct, indirect, general, special, incidental, punitive and/or consequential. This disclaimer of liability constitutes
an essential and material term of this agreement. If you do not or cannot accept this, or if it is unenforceable in your
jurisdiction, then you may not use the Software.

INDEMNITY

You indemnify the Company and Company Associates and hold them harmless against any claims which may arise
from any loss, damages, harm, injury, expense, work stoppage, loss of business information, business interruption,
computer failure or malfunction, which may be suffered by you or any other party whatsoever as a consequence of
any act or omission of the Company and/or Company Associates, whether negligent or not, arising out of your use
and/or distribution of the Software, or from any other cause whatsoever, howsoever arising, in connection with the
Software. These provisions are binding on your estate, heirs, executors, legal successors, administrators, parents
and/or guardians.

This indemnification constitutes an essential and material term of this agreement. If you do not or cannot accept
this, or if it is unenforceable in your jurisdiction, then you may not use the Software.

HIGH RISK ACTIVITIES

This Software and the output produced by this Software is not fault-tolerant and is not designed, manufactured or
intended for use as on-line control equipment in hazardous environments requiring fail-safe performance, in which
the failure of the Software could lead or directly or indirectly to death, personal injury, or severe physical or
environmental damage ("High Risk Activities"). The Company specifically disclaims any express or implied warranty
of fitness for High Risk Activities and explicitly prohibits the use of the Software for such purposes.

CRYPTOGRAPHIC SIGNING OF DOCUMENTS

Changes to this Agreement and documents issued under its authority may be cryptographically signed by the POV-Ray
Team Co-ordinator's private PGP key.

In the absence of evidence to the contrary, such documents shall be considered, under the terms of this Agreement,
to be authentic provided the signature is
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valid. The master copy of this Agreement at http://www.povray.org/povlegal.html will also be signed by the current
version of the team-coordinator's key.

The public key for the POV-Ray Team-coordinator can be retrieved from the location https://secure.povray.org/keys/.
The current fingerprint for it is

B4DD 932A C080 C3A3 6EA2 9952 DB04 4A74 9901 4518.

MISCELLANEOUS

This Agreement constitutes the complete agreement concerning this license. Any changes to this agreement must
be in writing and may take the form of

notifications by the Company to you, or through posting notifications on the Company website. THE USE OF THIS
SOFTWARE BY ANY PERSON OR ENTITY IS

EXPRESSLY MADE CONDITIONAL ON THEIR ACCEPTANCE OF THE TERMS SET FORTH HEREIN. Except where explicitly
stated otherwise herein, if any provision of this

Agreement is found to be invalid or unenforceable, the invalidity or unenforceability of such provision shall not
affect the other provisions of this agreement, and all provisions not affected by such invalidity or unenforceability
shall remain in full force and effect. In such cases you agree to attempt to substitute for each invalid or unenforceable
provision a valid or enforceable provision which achieves to the greatest extent possible, the objectives and intention
of the invalid or unenforceable

provision. The validity and interpretation of this agreement will be governed by the laws of Australia in the state of
Victoria (except for conflict of law provisions).

CONTACT INFORMATION

License inquiries can be made via email; please use the following address (but see below prior to emailing) :
team-coord-[three-letter month]-[four-digit year]@povray.org for example, team-coord-jun-2004@povray.org should
be used if at the time you send the email it is the month of June 2004. The changing email addresses are necessary
to combat spam and email viruses. Old email addresses may be deleted at our discretion.

Note that the above address may change for reasons other than that given above; please check the version of this
document at http://www.povray.org/povlegal.html for the current address. Note that your inability or failure to
contact us for any reason is not an excuse for violating this licence.

Do NOT send any attachments of any sort other than by prior arrangement.

EMAIL MESSAGES INCLUDING ATTACHMENTS WILL BE DELETED UNREAD.

The following postal address is only for official license business. Please note that it is preferred that initial queries
about licensing be made via email ; postal mail should only be used when email is not possible, or when written
documents are being exchanged by prior arrangement.

Persistence of Vision Raytracer Pty. Ltd.

PO Box 407

Williamstown,

Victoria 3016

Australia

Portions of this software are owned by Siemens PLM © 1986-2013. All Rights Reserved. Parasolid, Unigraphics, and
SolidEdge are registered trademarks and JT is a trademark of Siemens Product Lifecycle Management Software,
Inc.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. © 1986-2013. All Rights Reserved. ACIS, SAT and SAB are registered
trademarks of Spatial Corp.
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Contains Teigha for .dwg files licensed from the Open Design Alliance. Teigha is a trademark of the Open Design
Alliance.

Development tools and related technology provided under license from 3Dconnexion. © 1992 – 2008 3Dconnexion.
All rights reserved.

•TraceParts is owned by TraceParts S.A. TraceParts is a registered trademark of TraceParts S.A.

Copyright © 1991-2017 Unicode, Inc. All rights reserved.

Distributed under the Terms of Use in http://www.unicode.org/copyright.html. Permission is hereby granted, free
of charge, to any person obtaining a copy of the Unicode data files and any associated documentation (the "Data
Files") or Unicode software and any associated documentation (the "Software") to deal in the Data Files or Software
without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or
sell copies of the Data Files or Software, and to permit persons to whom the Data Files or Software are furnished to
do so, provided that either (a) this copyright and permission notice appear with all copies of the Data Files or Software,
or

(b) this copyright and permission notice appear in associated Documentation.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE

WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD
PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE
FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THE DATA FILES OR
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to
promote the sale, use or other dealings in these Data Files or Software without prior written authorization of the
copyright holder.

Portions of this software Copyright © 1992-2008 The University of Tennessee. All rights reserved.

This product includes software developed by XHEO INC (http://xheo.com).

Portions of this software are owned by Tech Soft 3D, Inc. Copyright © 1996-2013. All rights reserved. HOOPS is a
registered trademark of Tech Soft 3D, Inc.

Portions of this software are owned by MachineWorks Limited. Copyright ©2013. All rights reserved. Polygonica is
a registered trademark of MachineWorks Limited.

Apache License

Version 2.0, January 2004 http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1
through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are
under common control with that entity. For the purposes of this definition,

"Control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.
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"Source" form shall mean the preferred form for making modifications, including but not limited to software source
code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form,
including but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as
indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix
below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the
Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole,
an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications
or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the
Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright
owner. For the purposes of this definition,

"Submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and
improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing
by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been
received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants
to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce,
prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative
Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to
You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section)
patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such
license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their
Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was
submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit)
alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date
such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium,
with or without modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark,
and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part
of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute
must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices
that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text
file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the
Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License.
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You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum
to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying
the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license
terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works
as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions
stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution

intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede
or modify the terms of any separate license agreement you may have executed with Licensor regarding such
Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product
names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work
and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and
each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY
KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE,
NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely

responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated
with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or
otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing,
shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential
damages of any character arising as a result of this License or out of the use or inability to use the Work (including
but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other
commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may
choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or
rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf
and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend,
and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by
reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

xviiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

i. Copyright and Trademark Information



Contents

i. Copyright and Trademark Information......................................................................ii
1: Introduction...................................................................................................................................30

1.1. Ansys Subscription Licensing......................................................................................................................30
1.2. Quick Reference Card...................................................................................................................................31
1.3. Mouse and Touch Gestures..........................................................................................................................31
1.4. The SpaceClaim Interface............................................................................................................................31

1.4.1. Structure Tree................................................................................................................................33
1.4.2. Selection Panel..............................................................................................................................37
1.4.3. Layers Panel...................................................................................................................................41
1.4.4. Groups Panel.................................................................................................................................43
1.4.5. Customizing a View.......................................................................................................................46
1.4.6. Status Bar......................................................................................................................................48
1.4.7. Options Panel................................................................................................................................49
1.4.8. Properties......................................................................................................................................50
1.4.9. Keyboard Shortcuts......................................................................................................................54
1.4.10. Using a Multi-Touch Screen........................................................................................................57
1.4.11. Radial Menu.................................................................................................................................63

1.5. SpaceClaim Objects.....................................................................................................................................65
1.5.1. Working with Components...........................................................................................................65

1.5.1.1. Internal, External, and Independent Components.......................................................68
1.5.1.2. Lightweight Components..............................................................................................71

1.5.2. Working with Faceted Bodies.......................................................................................................71
1.6. Undo and Redo.............................................................................................................................................74

2: File Operations...............................................................................................................................76
2.1. Creating, Opening, and Saving Documents................................................................................................76
2.2. Importing and Exporting..............................................................................................................................79
2.3. Copying and Pasting from Other Applications..........................................................................................106
2.4. Locking and Unlocking Objects.................................................................................................................106
2.5. Printing Drawing Sheets and Designs.......................................................................................................107
2.6. Creating Journals and Logs.......................................................................................................................109
2.7. Running SpaceClaim From the Command Line........................................................................................111
2.8. SpaceClaim File Format.............................................................................................................................112

3: Selecting......................................................................................................................................115
3.1. Using Clip With Plane.................................................................................................................................119
3.2. Using Clip With Volume..............................................................................................................................122
3.3. Filtering the Selection................................................................................................................................124
3.4. Selecting by Drawing a Box........................................................................................................................126
3.5. Selecting by Drawing a Freeform Shape (lasso).......................................................................................128
3.6. Selecting Using Polygon............................................................................................................................129
3.7. Selecting by Painting..................................................................................................................................130

xviiiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



3.8. Selecting Using Boundary..........................................................................................................................131
3.9. Selecting Components...............................................................................................................................132

4: Designing.....................................................................................................................................133
4.1. Cutting, Copying, and Pasting...................................................................................................................134
4.2. Sketching....................................................................................................................................................135

4.2.1. The Sketch Plane.........................................................................................................................141
4.2.2. Moving the Sketch Grid...............................................................................................................142
4.2.3. Sketch Options............................................................................................................................143
4.2.4. Sketching with Constraints.........................................................................................................144
4.2.5. Sketch Tools................................................................................................................................153

4.2.5.1. Lines..............................................................................................................................154
4.2.5.2. Rectangles....................................................................................................................157
4.2.5.3. Ellipses..........................................................................................................................159
4.2.5.4. Circles............................................................................................................................160
4.2.5.5. Arcs................................................................................................................................162
4.2.5.6. Polygons.......................................................................................................................165
4.2.5.7. Splines...........................................................................................................................167
4.2.5.8. Points............................................................................................................................172
4.2.5.9. Trimming and Modifying..............................................................................................173
4.2.5.10. Inserting a Face Curve................................................................................................181
4.2.5.11. Projecting onto the Sketch Grid................................................................................182
4.2.5.12. Sketch Equations........................................................................................................184
4.2.5.13. Scaling Sketches.........................................................................................................189

4.2.6. Working with Sketch Curves in 3D..............................................................................................192
4.2.7. Editing a Sketch...........................................................................................................................193
4.2.8. Copying a sketch.........................................................................................................................195
4.2.9. Layout Sketches..........................................................................................................................195
4.2.10. Moving in Two Dimensions.......................................................................................................197
4.2.11. Dimensional Sketching.............................................................................................................198

4.3. Design Modes..............................................................................................................................................198
4.3.1. Editing in Cross Section..............................................................................................................199

4.4. Editing.........................................................................................................................................................201
4.4.1. Pulling..........................................................................................................................................202

4.4.1.1. Offsetting or Extruding Faces......................................................................................213
4.4.1.2. Extending or Extruding Surface Edges........................................................................214
4.4.1.3. Rounding Edges............................................................................................................216
4.4.1.4. Rounding Between Faces and Surfaces......................................................................222
4.4.1.5. Modifying Rounds.........................................................................................................223
4.4.1.6. Chamfering Edges........................................................................................................227
4.4.1.7. Extruding Edges............................................................................................................234
4.4.1.8. Pivoting Edges..............................................................................................................237
4.4.1.9. Revolving Faces............................................................................................................238
4.4.1.10. Revolving Edges..........................................................................................................239
4.4.1.11. Revolving Helices.......................................................................................................242

xixRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



4.4.1.12. Sweeping....................................................................................................................243
4.4.1.13. Drafting Faces.............................................................................................................248
4.4.1.14. Creating Slots.............................................................................................................251
4.4.1.15. Scaling solids and surfaces........................................................................................254
4.4.1.16. Copying Edges and Faces...........................................................................................256
4.4.1.17. Pulling with the Select tool........................................................................................258
4.4.1.18. Pivoting an Edge with the Select Tool.......................................................................259
4.4.1.19. Using Measure to Drive Pull.......................................................................................259

4.4.2. Moving..........................................................................................................................................260
4.4.2.1. The Move Handle..........................................................................................................267
4.4.2.2. Moving Symmetrically..................................................................................................270
4.4.2.3. Creating a Pattern........................................................................................................272
4.4.2.4. Pivoting and Pulling Solids..........................................................................................281
4.4.2.5. Moving a Solid or Surface with the Select Tool..........................................................282
4.4.2.6. Moving with the Fulcrum Tool Guide..........................................................................289
4.4.2.7. Moving the Sketch Grid................................................................................................290
4.4.2.8. Moving Protrusions and Depressions..........................................................................291
4.4.2.9. Using Measure to Drive Move.......................................................................................292

4.4.3. Fill.................................................................................................................................................294
4.4.3.1. Removing Rounds........................................................................................................309

4.4.4. Blending.......................................................................................................................................314
4.4.4.1. Blending Between Faces..............................................................................................317
4.4.4.2. Blending Between Edges.............................................................................................320
4.4.4.3. Blending Between Points.............................................................................................328

4.4.5. Replacing faces............................................................................................................................329
4.4.6. Tweaking a Face..........................................................................................................................332

4.4.6.1. Tweak Face Tool Editing Methods...............................................................................334
4.4.6.2. Adding a Control Curve................................................................................................335
4.4.6.3. Tweak Face Display Options........................................................................................335

4.4.7. Editing with Annotation Dimensions..........................................................................................336
4.4.8. Mathematical Expressions..........................................................................................................338

4.5. Intersecting.................................................................................................................................................339
4.5.1. Combine and Split Tools.............................................................................................................340

4.5.1.1. Merging Solids and Surfaces........................................................................................343
4.5.1.2. Merging Solids..............................................................................................................344
4.5.1.3. Merging Surfaces..........................................................................................................344
4.5.1.4. Merging Surface Protrusions.......................................................................................346
4.5.1.5. Capping a Surface with a Plane...................................................................................346
4.5.1.6. Removing Material From a Solid..................................................................................347
4.5.1.7. Splitting Bodies and Surfaces......................................................................................347
4.5.1.8. Splitting a Surface........................................................................................................349
4.5.1.9. Splitting a Solid with a Surface, Plane, or Another Solid...........................................350

4.5.2. Split Body Tool............................................................................................................................351
4.5.3. Splitting Faces or Edges .............................................................................................................354

xxRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



4.5.4. Project Tool.................................................................................................................................359
4.6. Datum Objects and Relationships.............................................................................................................361

4.6.1. Inserting a plane..........................................................................................................................361
4.6.2. Inserting an Axis..........................................................................................................................364
4.6.3. Inserting Points...........................................................................................................................365
4.6.4. Inserting an Origin.......................................................................................................................366
4.6.5. Pinned Datums............................................................................................................................368
4.6.6. Inserting Temporary Points, Axes, and Planes..........................................................................369
4.6.7. Linear Patterns............................................................................................................................373
4.6.8. Circular Patterns..........................................................................................................................379
4.6.9. Fill Patterns..................................................................................................................................384
4.6.10. Shelling a Solid..........................................................................................................................388
4.6.11. Creating an Offset Relationship................................................................................................389
4.6.12. Creating Mirror Relationships...................................................................................................390

4.7. Bodies.........................................................................................................................................................395
4.7.1. Geometry from Equations...........................................................................................................395
4.7.2. Creating a Cylinder......................................................................................................................398
4.7.3. Creating a Sphere........................................................................................................................401

4.8. Dimensions.................................................................................................................................................402
4.9. Detach.........................................................................................................................................................405
4.10. Checking Geometry..................................................................................................................................406
4.11. Recording..................................................................................................................................................406

4.11.1. Recording Blocks.......................................................................................................................407
4.11.2. Scripting.....................................................................................................................................412

5: Changing the Display.....................................................................................................................427
5.1. Orienting Designs.......................................................................................................................................427

5.1.1. Orienting Your Home View..........................................................................................................428
5.1.2. Displaying a Head-on View of the Sketch Grid...........................................................................429
5.1.3. View Selection.............................................................................................................................429
5.1.4. Snapping to a View......................................................................................................................430
5.1.5. Customizing a View.....................................................................................................................432
5.1.6. Spinning Your Design..................................................................................................................433
5.1.7. Panning Your Design...................................................................................................................436
5.1.8. Zooming Your Design..................................................................................................................437
5.1.9. Rotating Your Design...................................................................................................................439

5.2. Styles...........................................................................................................................................................439
5.2.1. Applying Colors............................................................................................................................439

5.2.1.1. Changing Object Transparency...................................................................................441
5.2.2. Line Styles....................................................................................................................................444
5.2.3. Layers Panel.................................................................................................................................444
5.2.4. Applying a Graphics Style...........................................................................................................446
5.2.5. Applying a Rendering Style.........................................................................................................447
5.2.6. Displaying Edges.........................................................................................................................448
5.2.7. Painting Display Properties from One Object to Another.........................................................449

xxiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



5.3. Flythrough..................................................................................................................................................450
5.4. Workspace Windows..................................................................................................................................455

5.4.1. Displaying Your Design in Multiple Windows.............................................................................455
5.4.2. Splitting the Workspace Window...............................................................................................456
5.4.3. Switching Between Windows in the Workspace........................................................................456
5.4.4. Maximizing the Design Window..................................................................................................457

5.5. Sketch Grid Styles.......................................................................................................................................457
5.6. Displaying Workspace Tools......................................................................................................................458
5.7. Showing and Hiding Objects......................................................................................................................460
5.8. Displaying Lightweight Components........................................................................................................461

6: Assemblies....................................................................................................................................462
6.1. Parts............................................................................................................................................................462

6.1.1. Inserting Another Design............................................................................................................462
6.1.2. Inserting an Image.......................................................................................................................463
6.1.3. Inserting a Video..........................................................................................................................466
6.1.4. Standard Parts.............................................................................................................................467

6.1.4.1. Downloading TraceParts.............................................................................................467
6.1.4.2. Downloading CADENAS models..................................................................................468

6.2. Assemble.....................................................................................................................................................468
6.2.1. Making Objects Tangent.............................................................................................................469
6.2.2. Aligning Objects...........................................................................................................................470
6.2.3. Orienting Objects........................................................................................................................473
6.2.4. Locking the Orientation and Position of Components..............................................................475
6.2.5. Creating Gear Conditions............................................................................................................476
6.2.6. Anchoring components...............................................................................................................477

6.3. Edit..............................................................................................................................................................478
6.3.1. Moving Parts in an Assembly......................................................................................................478

6.4. Managing Configurations...........................................................................................................................479
7: Facets..........................................................................................................................................488

7.1. Selecting Facets..........................................................................................................................................488
7.2. Faceted Body Cleanup...............................................................................................................................494

7.2.1. Automatically Cleaning up Faceted Bodies...............................................................................495
7.2.2. Shrinkwrapping...........................................................................................................................496
7.2.3. Fixing Facet Intersections...........................................................................................................502
7.2.4. Fixing Over-Connected Facets....................................................................................................503
7.2.5. Fixing Holes..................................................................................................................................504
7.2.6. Fixing Sharps...............................................................................................................................509

7.3. Organizing Faceted Bodies........................................................................................................................511
7.4. Modifying Faceted Bodies..........................................................................................................................514

7.4.1. Merging Faceted Bodies..............................................................................................................514
7.4.2. Subtracting Faceted Bodies........................................................................................................515
7.4.3. Intersecting Faceted Bodies.......................................................................................................517
7.4.4. Splitting Faceted Bodies.............................................................................................................518
7.4.5. Shelling Faceted Bodies..............................................................................................................519

xxiiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



7.4.6. Scaling Faceted Bodies...............................................................................................................538
7.4.7. Thickening Faceted Bodies.........................................................................................................539

7.5. Adjusting Facets.........................................................................................................................................540
7.6. Inspecting Faceted Bodies.........................................................................................................................548

7.6.1. Facet Overhangs..........................................................................................................................548
7.6.2. Facet Thickness...........................................................................................................................550
7.6.3. Facet Cavities...............................................................................................................................552

7.7. Creating a Faceted Body............................................................................................................................554
8: Detailing.......................................................................................................................................557

8.1. General Detailing Options..........................................................................................................................557
8.2. Drawing Sheet Size and Format Options..................................................................................................562
8.3. Modular Grid Options.................................................................................................................................562
8.4. Formatting Note Text.................................................................................................................................564
8.5. Annotation..................................................................................................................................................564

8.5.1. Creating Dimension Annotations...............................................................................................566
8.5.1.1. Dimensioning Between Virtual Points.........................................................................578
8.5.1.2. Editing with Annotation Dimensions...........................................................................581

8.5.2. Creating Notes.............................................................................................................................584
8.5.2.1. Creating Circular Notes................................................................................................590

8.5.3. Adding Hyperlinks to Annotations..............................................................................................591
8.5.4. Creating Note Leaders.................................................................................................................592
8.5.5. Threads........................................................................................................................................595
8.5.6. Center Marks and Lines...............................................................................................................597
8.5.7. Geometric Dimensioning and Tolerancing................................................................................597

8.5.7.1. Encoding Geometric Tolerances.................................................................................598
8.5.7.2. Geometric Tolerance Annotations..............................................................................609
8.5.7.3. Datum and Surface Finish Symbols.............................................................................611
8.5.7.4. Datum Targets..............................................................................................................611

8.5.8. Welding Symbols.........................................................................................................................615
8.5.9. Barcodes......................................................................................................................................620
8.5.10. Bolt Circles.................................................................................................................................622
8.5.11. Bills of Materials (BOMs)............................................................................................................622
8.5.12. Balloons.....................................................................................................................................627
8.5.13. Surface Finish Symbols.............................................................................................................628
8.5.14. Tables.........................................................................................................................................629
8.5.15. Hole Tables................................................................................................................................631
8.5.16. Curve Table................................................................................................................................634

8.6. Drawing Sheet Views..................................................................................................................................639
8.6.1. General Views..............................................................................................................................641
8.6.2. Projected Views...........................................................................................................................643
8.6.3. Cross-Section Views....................................................................................................................644
8.6.4. Offset Cross Sections...................................................................................................................648
8.6.5. Aligned Cross Sections................................................................................................................650
8.6.6. Detail Views..................................................................................................................................652

xxiiiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



8.6.7. Broken Views...............................................................................................................................653
8.6.8. Broken Out Sections....................................................................................................................656
8.6.9. Displaying a Modular Grid...........................................................................................................657

8.7. Custom Symbols.........................................................................................................................................658
8.7.1. Using Custom Symbols...............................................................................................................659
8.7.2. Creating Custom Symbols..........................................................................................................662

8.8. Drawing Sheets...........................................................................................................................................664
8.8.1. Setting Up a Drawing Sheet........................................................................................................667
8.8.2. Formatting a Drawing Sheet.......................................................................................................667
8.8.3. Editing on a Drawing Sheet.........................................................................................................668

8.9. 3D Markup...................................................................................................................................................669
8.9.1. Creating 3D markup slides..........................................................................................................670

8.9.1.1. Inserting........................................................................................................................671
8.9.2. Displaying Changes to Dimensions............................................................................................671
8.9.3. Coloring Changed Faces.............................................................................................................672

9: Measuring and Analyzing...............................................................................................................674
9.1. Quick Measurements..................................................................................................................................674
9.2. Inspect.........................................................................................................................................................675

9.2.1. Displaying Measurements...........................................................................................................675
9.2.2. Displaying Mass Properties.........................................................................................................681

9.2.2.1. Measuring a Projected Area.........................................................................................683
9.2.3. Checking Geometry.....................................................................................................................684

9.3. Interference................................................................................................................................................684
9.4. Quality.........................................................................................................................................................686

9.4.1. Displaying Normal Direction.......................................................................................................686
9.4.2. Displaying a Face (UV) Grid.........................................................................................................687
9.4.3. Displaying Curvature...................................................................................................................688
9.4.4. Displaying a Dihedral Graph.......................................................................................................690
9.4.5. Displaying Draft Angles...............................................................................................................690
9.4.6. Displaying Stripes........................................................................................................................692
9.4.7. Displaying Deviation...................................................................................................................694

10: Sheet Metal.................................................................................................................................697
10.1. Creating and Editing Sheet Metal............................................................................................................697
10.2. Working with Sheet Metal........................................................................................................................698
10.3. Importing Sheet Metal Designs................................................................................................................699

10.3.1. Converting a Design to Sheet Metal.........................................................................................699
10.3.2. Sheet Metal Square-Up.............................................................................................................701
10.3.3. Identifying Sheet Metal.............................................................................................................701

10.4. Sketching Sheet Metal Parts....................................................................................................................705
10.4.1. Lines...........................................................................................................................................707
10.4.2. Tangent Lines............................................................................................................................708
10.4.3. Tangent Arcs..............................................................................................................................709
10.4.4. Rectangles.................................................................................................................................710
10.4.5. Three-Point Rectangles.............................................................................................................711

xxivRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



10.4.6. Ellipses.......................................................................................................................................712
10.4.7. Sweep Arcs.................................................................................................................................712
10.4.8. Three-Point Circles....................................................................................................................713
10.4.9. Circles.........................................................................................................................................714
10.4.10. Polygons..................................................................................................................................715
10.4.11. Splines......................................................................................................................................716
10.4.12. Three-Point Arcs......................................................................................................................717

10.5. Editing Sheet Metal Parts.........................................................................................................................718
10.5.1. Selecting Sheet Metal Objects..................................................................................................718
10.5.2. Pulling Sheet Metal Parts..........................................................................................................718
10.5.3. Moving Sheet Metal Objects......................................................................................................727

10.5.3.1. Rotating Sheet Metal Walls........................................................................................728
10.6. Modifying sheet metal parts....................................................................................................................730

10.6.1. Changing junction types...........................................................................................................730
10.6.1.1. Creating a partial flange junction..............................................................................732

10.6.2. Creating and changing edge reliefs..........................................................................................733
10.6.3. Creating and changing corner reliefs.......................................................................................735
10.6.4. Creating and changing notches................................................................................................742
10.6.5. Creating and changing hems....................................................................................................743
10.6.6. Sheet metal miter......................................................................................................................747

10.7. Create........................................................................................................................................................747
10.7.1. Adding Sheet Metal Forms........................................................................................................748
10.7.2. Splitting a Sheet Metal Face.....................................................................................................753
10.7.3. Adding a Sheet Metal Bead.......................................................................................................755
10.7.4. Bending a Sheet Metal Wall......................................................................................................756

10.7.4.1. Adding a Cross Break..................................................................................................762
10.7.5. Adding a Sheet Metal Marker....................................................................................................763
10.7.6. Creating a Double Wall..............................................................................................................764
10.7.7. Creating a Sheet Metal Gusset..................................................................................................765
10.7.8. Creating a Tab............................................................................................................................766
10.7.9. Creating a Hinge........................................................................................................................769
10.7.10. Creating a Flange.....................................................................................................................771
10.7.11. Adding Engraved or Cut-out Text in Sheet Metal...................................................................772
10.7.12. Creating a Lightweight Pattern...............................................................................................773

10.8. Unfolding Sheet Metal Components.......................................................................................................774
10.8.1. Calculating Unfolded Lengths..................................................................................................778
10.8.2. Calculating Bend Allowances...................................................................................................779
10.8.3. Using a Bend Deduction Table.................................................................................................780

10.9. Changing Sheet Metal Part Properties....................................................................................................785
10.10. Correcting a Sheet Metal Component...................................................................................................787

11: Tools..........................................................................................................................................789
11.1. Reverse Engineering.................................................................................................................................789

11.1.1. Auto Skin....................................................................................................................................789
11.1.2. Skin Surface...............................................................................................................................793

xxvRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



11.1.3. Extract Curves............................................................................................................................804
11.1.4. Orient Facets..............................................................................................................................806
11.1.5. Fit Spline....................................................................................................................................808
11.1.6. Creating Curves from Images....................................................................................................809

11.2. Manufacturing..........................................................................................................................................812
11.2.1. Standard Hole............................................................................................................................812
11.2.2. Identify Holes.............................................................................................................................819
11.2.3. Move Body.................................................................................................................................823
11.2.4. Create Workpiece......................................................................................................................825
11.2.5. Toolpaths...................................................................................................................................830

11.2.5.1. Turn Profile.................................................................................................................830
11.2.5.2. Deburring Toolpath....................................................................................................832
11.2.5.3. Edges...........................................................................................................................833

11.2.6. Relief..........................................................................................................................................833
11.2.7. Unroll.........................................................................................................................................835

12: Repairing Problems.....................................................................................................................840
12.1. Navigating Through Issues.......................................................................................................................840
12.2. Solidify......................................................................................................................................................841

12.2.1. Stitching Adjacent Faces...........................................................................................................841
12.2.2. Repairing Gaps..........................................................................................................................843
12.2.3. Finding and Correcting Missing Faces......................................................................................844

12.3. Fix..............................................................................................................................................................846
12.3.1. Repairing Split Edges................................................................................................................846
12.3.2. Repairing Extra Edges...............................................................................................................848
12.3.3. Repairing Duplicates.................................................................................................................850

12.4. Fix Curves..................................................................................................................................................850
12.4.1. Fitting Curves.............................................................................................................................851
12.4.2. Fixing Curve Gaps......................................................................................................................852
12.4.3. Duplicating Curves....................................................................................................................853
12.4.4. Fixing Small Curves...................................................................................................................854

12.5. Adjust........................................................................................................................................................855
12.5.1. Merging Faces............................................................................................................................855
12.5.2. Removing Small Faces..............................................................................................................856
12.5.3. Simplifying Designs...................................................................................................................857
12.5.4. Repairing Inexact Edges............................................................................................................858
12.5.5. Straightening Faces...................................................................................................................860
12.5.6. Relaxing Surfaces......................................................................................................................862
12.5.7. Adjusting Tangency...................................................................................................................863

13: Preparing Designs for Analysis......................................................................................................865
13.1. Analysis.....................................................................................................................................................865

13.1.1. Extracting Volume.....................................................................................................................865
13.1.2. Creating Midsurfaces.................................................................................................................869
13.1.3. Creating Spot Welds..................................................................................................................873
13.1.4. Creating Welds...........................................................................................................................876

xxviRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



13.1.5. Wrapping Geometry..................................................................................................................879
13.1.6. Creating Enclosures..................................................................................................................882
13.1.7. Splitting by Plane......................................................................................................................885
13.1.8. Extending Adjacent Faces.........................................................................................................886
13.1.9. Imprinting..................................................................................................................................888

13.2. Remove.....................................................................................................................................................892
13.2.1. Removing Rounds.....................................................................................................................892
13.2.2. Removing Interference..............................................................................................................895
13.2.3. Removing Faces.........................................................................................................................896
13.2.4. Finding Short Edges..................................................................................................................897

13.3. Detect........................................................................................................................................................898
13.3.1. Finding Bad Faces.....................................................................................................................898
13.3.2. Finding Sharp Edges..................................................................................................................898
13.3.3. Checking Clearance...................................................................................................................900

13.4. Beams.......................................................................................................................................................900
13.4.1. Beam Properties........................................................................................................................903
13.4.2. Creating Beam Profiles..............................................................................................................905

13.4.2.1. Changing beam profiles.............................................................................................906
13.4.3. Creating Beams.........................................................................................................................907
13.4.4. Extracting Beams From Solids..................................................................................................908
13.4.5. Changing Beam Orientation.....................................................................................................910
13.4.6. Connecting Beams....................................................................................................................911
13.4.7. Splitting Beams.........................................................................................................................913
13.4.8. Changing the Beam Display Style.............................................................................................914
13.4.9. Moving Beams...........................................................................................................................915

14: Workbench.................................................................................................................................916
14.1. Icepak........................................................................................................................................................916

14.1.1. Identifying Icepak Objects........................................................................................................916
14.1.2. Simplifying Objects for Icepak..................................................................................................918
14.1.3. Creating Icepak Openings.........................................................................................................923
14.1.4. Creating Icepak Fans.................................................................................................................924
14.1.5. Creating Icepak Grilles..............................................................................................................926
14.1.6. Creating Icepak Enclosures.......................................................................................................934

14.2. Shared Topology......................................................................................................................................937
14.2.1. Preparing Overlapping Bodies..................................................................................................938
14.2.2. Detecting Split Edges................................................................................................................941
14.2.3. Removing Extra Edges...............................................................................................................943
14.2.4. Simplifying Designs...................................................................................................................945
14.2.5. Removing Small Faces..............................................................................................................946
14.2.6. Navigating Through Shareable Topology................................................................................947
14.2.7. Sharing Topology......................................................................................................................948
14.2.8. Unsharing Topology..................................................................................................................955
14.2.9. Force Sharing Topology............................................................................................................957
14.2.10. Viewing Tools...........................................................................................................................958

xxviiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



14.2.10.1. Viewing Assembly Structure....................................................................................958
14.2.10.2. Viewing Connected Bodies......................................................................................960
14.2.10.3. Share Topology Display Options.............................................................................961

14.3. Ansys Transfer..........................................................................................................................................962
15: Meshing......................................................................................................................................964

15.1. Mesh Ribbon Behavior.............................................................................................................................964
15.1.1. Using the Delete Tool................................................................................................................966

15.2. The Typical Meshing Workflow................................................................................................................967
15.3. Selecting a Physics Type..........................................................................................................................968
15.4. Generating the Mesh................................................................................................................................969

15.4.1. Selecting an Element Shape and Order...................................................................................972
15.4.2. Setting Sizing Options...............................................................................................................975
15.4.3. Selecting a Blocking Technique................................................................................................979

15.4.3.1. CartSweep Method.....................................................................................................986
15.4.3.2. ThinSweep Method....................................................................................................989
15.4.3.3. Blocking Types...........................................................................................................991
15.4.3.4. Conformal Meshing Between Bodies........................................................................993
15.4.3.5. Meshing Assemblies...................................................................................................995

15.5. Editing the Mesh.......................................................................................................................................996
15.5.1. Applying Mesh Controls............................................................................................................999

15.5.1.1. Creating a Size Control.............................................................................................1000
15.5.1.2. Setting a Mesh Type.................................................................................................1006
15.5.1.3. Adding Boundary Layers to a Mesh.........................................................................1014
15.5.1.4. Copying Mesh Parameters From one Face to Another...........................................1020
15.5.1.5. Deleting Mesh Controls............................................................................................1023

15.5.2. Editing the Blocking................................................................................................................1024
15.5.2.1. Understanding the Blocking Structure...................................................................1029
15.5.2.2. Splitting Blocks.........................................................................................................1035
15.5.2.3. Merging Block Volumes, Surfaces or Vertices.........................................................1038
15.5.2.4. Aligning Block Vertices.............................................................................................1042
15.5.2.5. Associating the Blocking to Geometry....................................................................1043
15.5.2.6. Shaping a Block Edge...............................................................................................1047

15.5.3. Pulling a Mesh or Blocking......................................................................................................1050
15.5.4. Blending a Mesh or Blocking...................................................................................................1055
15.5.5. Projecting Mesh or Blocking...................................................................................................1059

15.6. Fixing the Mesh.......................................................................................................................................1061
15.7. Checking the Mesh.................................................................................................................................1062

15.7.1. Setting Mesh Display Options.................................................................................................1062
15.7.2. Viewing Quality Statistics........................................................................................................1066

15.8. Transferring a Mesh to Downstream Systems in Ansys Workbench....................................................1082
16: Customizing SpaceClaim............................................................................................................1087

16.1. Popular Options.....................................................................................................................................1088
16.2. General Detailing Options......................................................................................................................1092
16.3. Drawing Sheet Size and Format Options..............................................................................................1097

xxviiiRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



16.4. Modular Grid Options.............................................................................................................................1097
16.5. Limits and fits options............................................................................................................................1098
16.6. Appearance Options...............................................................................................................................1099
16.7. Selection Options...................................................................................................................................1101
16.8. Snap Options..........................................................................................................................................1102
16.9. Units Options..........................................................................................................................................1105
16.10. Sheet Metal Options.............................................................................................................................1108
16.11. Mesh Options........................................................................................................................................1113
16.12. Navigation Options...............................................................................................................................1115
16.13. Advanced Options................................................................................................................................1117
16.14. File Import and Export Options...........................................................................................................1122
16.15. Support File Options............................................................................................................................1136
16.16. Ribbon Tabs..........................................................................................................................................1138
16.17. Panels....................................................................................................................................................1138
16.18. Quick Access Toolbar Options.............................................................................................................1139
16.19. License Options....................................................................................................................................1139
16.20. Resources..............................................................................................................................................1141

16.20.1. Quality Assurance Services...................................................................................................1142
16.21. Multitouch Options...............................................................................................................................1142
16.22. Displaying Workspace Tools................................................................................................................1143
16.23. Configuring Windows...........................................................................................................................1145
16.24. Customizing a View..............................................................................................................................1145
16.25. Creating Custom Shortcuts..................................................................................................................1147

17: SpaceClaim Add-Ins...................................................................................................................1148
17.1. SpaceClaim API.......................................................................................................................................1148
17.2. Ansys Add-In...........................................................................................................................................1149

17.2.1. Ansys Part Names....................................................................................................................1150
17.2.2. Using Groups to Drive Changes in Ansys................................................................................1151

17.2.2.1. Adding a Driving Dimension with the Pull Tool......................................................1152
17.2.2.2. Adding a Driving Dimension with the Move Tool....................................................1153
17.2.2.3. Adding a Driving Dimension for Rounds.................................................................1153

17.2.3. Using Named Selections in Ansys...........................................................................................1154
17.2.4. Ansys Workbench Settings......................................................................................................1154
17.2.5. Configuring SpaceClaim and Ansys........................................................................................1156

17.2.5.1. Connecting to Ansys.................................................................................................1157
17.2.5.2. Updating Data with Ansys........................................................................................1157

17.3. Driving dimensions with Excel...............................................................................................................1158
17.4. MakerBot Thingiverse............................................................................................................................1159

18: Getting Help..............................................................................................................................1160

19.1. Glossary.......................................................................................................1162
List of Terms....................................................................................................................................................1162

xxixRelease 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Contents



1: Introduction

SpaceClaim is the leader in 3D Direct Modeling solutions for rapid concept design and geometry manipulation.

SpaceClaim is intended for use by those who need to focus on core competencies while benefiting from working in 3D.
With SpaceClaim, engineers can collaborate in the design and manufacture of mechanical products across a broad range
of industries. The software provides a highly flexible design environment coupled with a modern user experience, and
meets manufacturer's requirements for excellence in engineering-driven product development that is both fast and
cost-effective.

The Online Help (F1) and Video Help (F3) are provided to help you become productive with SpaceClaim as quickly as
possible.

User's Guide
This User's Guide begins with a focus on the basic tools and on simple concepts. SpaceClaim is all about adding and
manipulating the faces of a design model, primarily through pull and move operations. If there is a face, you can pull on
it. If you need a new face, draw an edge or copy an existing one. Design clutter is minimized wherever possible. This guide
communicates these simple, but powerful concepts so that you can extrapolate them to your real-world designs. This
guide also provides useful shortcuts to use as you progress, as well as animations of tools in action to help you understand
their function.

SpaceClaim is different, and we encourage you to open your mind and enter into a world where you can focus on the
design, not the software. SpaceClaim appreciates your feedback, so let us know where we have succeeded and what we
can do better. Thanks for your purchase and we look forward to working with you!

Getting Started Using SpaceClaim
1. Sketch and pull to create a part, or open an existing model from any modeling software.

2. Edit the part using SpaceClaim's 2D and 3D editing tools.

3. (Optional) Customize SpaceClaim and your workspace to your working style.

4. Detail the part with notes, measurements, and geometric tolerances.

5. Submit the part for review using 3D Markup.

1.1. Ansys Subscription Licensing
If you are using an Ansys subscription to run Ansys SpaceClaim, you can click Manage subscription

from within SpaceClaim to sign in to your Ansys account.

Use Manage subscription

to:

• See when your subscription expires.

• Access and manage your Ansys account. For more information, see the Ansys Account Management Guide.

• Release the subscription activation on the current device.
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• Access the Ansys Discovery Forum, where you can find general information, tutorials, and support.

1.2. Quick Reference Card

Quick Reference Card

1.3. Mouse and Touch Gestures
Use gestures in the Design window as shortcuts to common actions and tools. Gesture information is displayed in
the status bar as you use gestures.

• To gesture with amouse, hold down the right mouse button and drag in the gesture pattern.
• To gesture with a touchscreen or touchpad, touch with two fingers, pause, then drag in the gesture pattern.

With a pen, touch and drag in the gesture pattern with the pen button pressed.
• To cancel a gesture, pause for one second.

Note: If you have upgraded SpaceClaim from a previous version and some of these gestures don't work for
you, then you may need to remove your user settings file. On Windows systems, remove the files and folders
in C:\Users\<YourUserName>\AppData\Local\SpaceClaim.

1.4. The SpaceClaim Interface
SpaceClaim's graphical user interface (GUI) was designed to conform (within reason) to Microsoft standards and
contains the toolbars, buttons, and windows associated with a Microsoft-compliant graphical application. As a
result, only those features of the GUI that relate to performing SpaceClaim-specific tasks are explained in this guide.
We assume, for example, that you are familiar with standard Windows conventions, such as dragging a window's
title bar to move the window, or clicking the close button to close the window.

To take advantage of the full range of SpaceClaim features, you should use SpaceClaim with a scroll wheel mouse.
However, SpaceClaim is also fully operational with a laptop's touchpad and integrated mouse buttons. You can use
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the nub as a scroll wheel, and configure the laptop so that pressing both buttons simultaneously behaves the same
as pressing a middle mouse button.

This image shows the major interface elements in the SpaceClaim application:

File menu (1): Contains file-related commands and options to customize SpaceClaim.
Quick Access toolbar (2): Can be customized so that it contains the file-related shortcuts you use most often.
Ribbon (3): Contains all the tools and modes you need to design, detail, and display models, drawing sheets,
and 3D markups.
Active tool (4): The active tool is highlighted in orange.
Design window (5): Displays your model. If you are in sketch or section modes, it also contains the sketch grid
to show the 2D plane on which you are working. The tool guides for the selected tool appear on the right side of
the Design window. The cursor also changes to indicate the selected tool guide. The mini-toolbar places commonly
used options and actions close to the cursor.
Mini-toolbar (6): Contains frequently used options for the current tool.
Tool guides (7): Help step you through using the tool and change the way the tool behaves.
Statusbar (8): The status bar displaysmessages (9)and progress information about your actions on the current
design.

Panels
The panels initially appear along the left side of the application window. You can dock and detach these panels.

Structure panel (10): Contains the Structure tree, which shows you each of the objects in your design. You can
quickly show or hide any object using the check box next to the object's name. You can expand or collapse the
nodes of the tree, rename objects, create, modify, replace, and delete objects, as well as work with components.

32Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Introduction



Layers panel: The Layers panel allows you to group objects and set their visual characteristics, such as visibility
and color.
Selection panel: The Selection panel lets you select other objects related to the one currently selected.
Groupspanel: The Groups panel stores groups of selected objects. Selection, Alt+selection, and move anchoring,
axis, and ruler dimension information is all stored with the group.
Views panel: The Views panel stores standard and custom views, and lets you assign shortcut keys to custom
views.
Optionspanel (11): The Options panel allows you to modify the functions of the SpaceClaim tools. For example,
when you use the Pull tool, selecting an edge and then selecting the Chamfer Edge option creates a chamfer
instead of a round when you pull the edge.
Properties panel (12): The Properties panel displays details about the selected object. You can change the
property values to change the object.

1.4.1. Structure Tree
The Structure panel contains the Structure tree, which shows you each of the objects in your design. Objects are
displayed in the order in which they were created, or in the order in which they were imported. The figures below
show all the object types that can be displayed in the Structure tree.

The appearance of solid bodies in the Structure tree will vary when they contain hidden faces or surface bodies.
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Exploded Components
With theDefault configuration active, there are no exploded components, so theAssemblyname appears as shown
below.

With a Non-Default configuration active, the assembly either has exploded components, or can be exploded, so
"Exploded" is added to the assembly name.

You can use the Structure tree to find objects, select objects, set object visibility, expand or collapse the nodes of
the tree, rename objects, create, modify, move, replace, and delete objects, as well as work with components using
the Structure tree.

You can clear the box next to an object to hide it in the Design window.

Note: Some objects, such as sketch curves and 3D curves, are automatically placed in Curves groups in the
Structure tree. You can rename a curve, but not the curve group. You can move the Curves group, but you
cannot move a curve out of the group. Deleting the group deletes all the curves in the group.

You can set the visibility of a Curves group or an individual curve in the group, even if the Curve group is
within a dependent copy of a component.
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Finding Objects
To find an object in the Design window, hover over an object in the Structure tree to highlight it in the Design window.
Hovering over a hidden object displays it temporarily in the Design window.

To find an object in the Structure tree:

• Hover your mouse over an object in the Design window to highlight it in the Structure tree. (Its component is
highlighted if it is not expanded.)

• Right-click an object in the Design window and select Locate in Structure Tree to highlight the object in the
Structure tree.

• Press Ctrl+F to open the Find dialog.

When Pattern is selected in the Structure tree, the selection list updates to display the number of patterns included
in the design.

Moving Objects
Drag an object or component to change its position in the Structure tree.

Right-click an object and selectMove toNewComponent to create a component within the active component and
move the object into it. If the object has a custom name, the new component will have the same name.

Ctrl+right-click multiple objects, then right-click and select Move Each to New Components to create a new
component for each object within the active component and move the objects into the components. If the object
has a custom name, the new component will have the same name.

You can move the view of a component from one drawing sheet to another by dragging the view in the Structure
panel.

Note: An annotation plane cannot be moved to a sub-component after you add dimensions because the
references would be lost.

Offset, mirror, and shell relationships stay with a solid when it is moved to another component, unless the
relationship would link two components when it is moved.

Setting the Visibility of Objects Using the Structure Tree
• Check the box next to the object in the Structure tree to set the visibility of the object to the layer visibility.

• Uncheck the box next to the object to hide it in the Design window and display its icon in gray in the Structure
tree, like Component2 in the figure above. You cannot work with hidden objects in the Design window.

• Right-click an object in the Structure tree and select Always Visible from the context menu.

• Right-click a body with hidden faces in the Structure tree and select Face to choose Inverse Face Visibility or
Show All Faces.

Expanding or Collapsing Components
The top-level object displayed in the Structure tree (called Design1 in the image above) is a component.

To expand components:
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• Click
or press ' + ' on the number pad to expand a component. You can also right-click the component and selectExpand.

• Right-click any component (including the top-level component) and selectExpandAll or press ' * ' on the number
pad to expand the component and all its subcomponents.

• To see hidden objects in a Curves group, click More curves. This is only visible when the group contains many
curves.

To collapse a component, click

or press ' - 'on the number pad.

Renaming Objects
Right-click an object in the Structure tree and select Rename or press F2 to rename the selected object. You can
also click the object, pause, then click again to rename it.

The top level component is automatically named when you first save your design, but you can rename it.

Multiple bodies selected in the Structure Tree can be renamed at once. The new name applies to the body for which
it was entered. The remaining bodies are numerically incremented with a number appended to the name. This also
applies to components.

Converting a Solid to Surfaces
1. Right-click the solid in the Structure tree.

2. Select Detach all.

All faces on the solid will be detached from each other and will become surfaces.

Locking and Unlocking Objects
Locking a solid or surface prevents any changes from being made to it.

1. Right-click the object and select Lock from the context menu to lock the object.

• If you right-clicked a component, all the objects in the component that can be locked are locked.

2. Select Lock again to unlock the object.

Supressing Objects from Simulation (SCDM License Only)
Suppressing an object means it will not be included when you transfer to Ansys for analysis.

1. Right-click an object (solid, surface, beam, component) in the Structure tree, or select multiple objects and
right-click

2. Select Suppress for Physics.

The objects are suppressed as indicated by the change in their icons.

To include suppressed objects in downstream analysis, right-click them in the Structure Tree and select Activate
for Physics.

Legacy models used Hidden/Visible settings to determine what was transferred to Ansys for analysis. When these
models are retrieved into session, the Suppress/Activate attribute will be set as follows.

• Hidden objects in legacy models are Suppressed.
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• After first retrieval, there is no link between Visible and Active/Suppressed. These are totally independent things.
• Beam Profile Parts are filtered out when searching for Suppressible objects..

Use the following commands to Hide/Show All Suppressed objects.

• Hide All Suppressed
• Show All Suppressed

1.4.2. Selection Panel
Use the Selection panel to select objects in the same part that are similar or related to the object currently selected.
The results list is based on the object you select for the search. See the examples below to see what happens when
you select each of the search results.

Selecting Objects Similar to the Currently Selected Object
1. Select any object.

2. Click the Selection tab to display the Selection panel.

The Selection tab is initially located at the bottom of the Structure panel.

3. (Optional) Select the Search all bodies option to search all bodies in the active component.

The following selection categories can be selected on more than one body:

• Edges: Same length, Same length with same orientation, Equal or smaller radius hole.

• Faces: Equal rounds, Equal or smaller rounds, Equal or smaller chamfer, Equal or smaller hole, Same area,
Same place, Equal radius cylinder.

4. (Optional) Select a category from the drop-down list to show only those objects with the selected relationship.

Select All Types to display all the geometry related to your selection.

After selecting objects with the selected relationship, you can also search a second time to select objects based
on another applicable category.

5. (Optional) If you disable Automatically calculate power selection results in the Selection options page of
SpaceClaim Options, then you must click

to search for related objects in your design. Otherwise, the search results are automatically displayed.

Related objects are displayed in the main area of the panel. Hover over the objects in the list to highlight those
objects in the Design window.

6. (Optional) Set thePower Selection Relative Tolerance in the Selection options page of SpaceClaim Options to
find items within a tolerance of the target size.

7. (Optional) Click a blue link to change that parameter in the search.
8. Click any number of the related objects in the list to add them to the current selection.

You can Ctrl+click to select multiple objects.

Selection Categories
Selection categories are presented in the table below.
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Selection typesExampleDescriptionCategory

Beams based on the profile of the
currently selected beam.

Beams with lengths <=, =, or >=
the length of the currently
selected beam.

Beams based on
profiles or length

Beams

Mapped, Swept or FreeFind all Free blocks that you want
to convert to swept or mapped
blocks to get an all hex mesh.

Selects blocks based
on their type:
Mapped, Swept or
Free

Block volumes

(Meshing Only)

All bodies with volume <=, =, or
>= the volume of the currently
selected body.

This power selection category is
especially useful when you need
to find and delete multiple, small
items in a design, such as
fasteners.

Bodies based on
volume compared
with the currently
selected body.

Bodies

All unmeshed bodiesFinds bodies that have still not
been meshed so that you can
mesh the remaining bodies.

Finds bodies that
have not been
meshed.

Bodies Mesh State

(Meshing Only)

All bodies with element size = xFinds bodies that
have similar mesh
options defined on
them.

Bodies with Mesh
Options

(Meshing Only)

Coaxial hole

Coaxial protrusion

Coaxial cylinder

Coaxial surfaces

Objects with the same
axis

Coaxial faces

ComponentsAll instances of the
selected component.

Components

Edges with same length

Edges with same length and same
orientation

Edges with same length in same
face

Surface edge loop

Hard sheet metal edges

Edges that are like the
currently selected
edge

Edges

All edges with divisions = x

All edges with mesh control

Find all edges that have the same
number of divisions assigned to
control the mesh flow.

Find edges that have
mesh sizing controls
defined on them.

Edges with Mesh Size
Controls

(Meshing Only)

Faces with match controlFind faces that have a
match control defined
on them.

Face with match
control

(Meshing Only)
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Selection typesExampleDescriptionCategory

All faces with Boundary Layers
Control

Find faces that have a
boundary layers
control defined on
them.

Faces with Boundary
Layers Control
(Meshing Only)

All faces with mapped mesh
control

Find faces that have a
mapped mesh control
defined on them.

Faces with Mapped
Mesh Control
(Meshing Only)

All block faces with element size
= x

All block faces with mesh size
control

Find faces that have
mesh sizing controls
defined on them.

Faces with Mesh Size
Control (Meshing
Only)

Protrusion

Depression

Inner faces

Enclosed by

Groups of faces that
form defined regions
on a model.

Features

Faces and BodiesFinding zero thickness faces and
surface bodies allows you to
verify that thickness has been
assigned to all faces and surface
bodies in the model.

Midsurface faces with
the same thickness
(including zero)

Midsurface Face
Thickness

All offset baseline faces

All offset faces

Faces with same offset

All coincident faces

Faces that have an
offset relationship
defined

Offset faces

Pattern member

All pattern members

Recognized pattern

Note: If the pattern does
not have a pattern
relationship in
SpaceClaim, you must
hold Alt and select the
face that contains the
pattern members in order
to select a recognized
pattern.

Pattern members,
entire patterns, or
recognized patterns

Patterns
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Selection typesExampleDescriptionCategory

Equal radius rounds

Rounds within a range of values,
including equal or smaller radius
rounds

Equal or smaller-sized chamfers

Variable radius round faces and
chains of faces even if they are
composed of a mix of constant
and variable faces

Rounds and chamfersRounds

Faces and faceted bodiesFaces and faceted
bodies of the same
color

Same Color

Lines/curves that are the same
type. For example, you can select
an arc to find all other curves that
are arcs.

Curves of the same
color, type, and
length

Same Curve Type

Standard HolesStandard Holes with
the same Hole
Dimensions

Same Hole
Dimensions

Equal radius cylinder

Equal radius hole

Equal radius protrusion

Faces with the same area

Holes equal to or smaller than

Surface holes equal to or smaller
than

Faces that have the
same radius or area

Same size

Miter Corners

Same Junction type and
parameters

Beads and Forms with the same
parameters

Sheet Metal objectsSheet Metal

All bodies suppressed for physicsSuppressed Items

All sweepable bodiesFind bodies that have a natural
sweep path to be automatically
meshed. Other bodies may
require more manual user
intervention.

Finds bodies that
have a natural sweep
path for meshing.

Sweepable Bodies
(Meshing Only)

For example, you can first seed a single face.
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Use the option in the Selection panel to select all coincident faces.

Then, you can search on all of those faces to find all the depressions.

1.4.3. Layers Panel
Layers can be thought of as a grouping mechanism based on visual characteristics. Visual characteristics include
visibility, color and line style. Layers are managed in the Layers panel and accessed and modified with the Layer
tool in the Display tab Style group.
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The default layer color for new documents can be set in the Appearance section of SpaceClaim Options.

Layers are especially useful when you want to hide annotation planes.

Sheet metal parts have a set of default layers when the part is in an unfolded state. They are:

• Dimension
• Bend Lines Up
• Bend Lines Down
• Bend Dimensions
• Forms

Creating a Layer
Right-click in the Layers panel and select New.

This layer becomes the activate layer. Any objects created are automatically placed on this layer.

Placing an Object on a Layer
1. Select one or more objects to assign to the layer.

2. Right-click a layer to open the context-sensitive menu.

3. Choose Assign to layer.

Renaming a Layer
Right-click the layer in the Layers panel and select Rename or click the layer name and slowly drag to the right.

Layer0 cannot be renamed.

Deleting a Layer
Right-click the layer in the Layers panel and select Delete.

Layer0 cannot be deleted.

Deleting Empty Layers
Right-click in the Layers panel and select Remove Empty Layers.

Activating a Layer
1. Right-click a layer to open the context-sensitive menu.

2. Choose Make Active.

3. New objects created are assigned to the active layer.
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Setting Layer Visibility
1. Select a layer in the Layers panel.

2. Click
to show the objects on the layer. Click

to hide them.

If an object is located on a layer with the visibility turned off, and the object in the Structure tree is set to show
visibility by layer, the object is not visible in the Design window, and cannot be acted on by the design tools.
Layer visibility can be overridden in the Structure tree.

You cannot hide the active layer.

Use Hide Others on an inactive layer to make it active and hide the other layers.

You can make a hidden layer active which automatically makes it visible.

Setting the Visibility of Layout Lines and Imported, DWG and DXF Lines
Select Solid or Hidden from the layer's line drop-down in the Layers panel.

Modifying the Layer Color
1. Select a layer in the Layers panel.

2. Select a color from the

drop-down.

You can also specify a custom color by selecting Custom Color and using the Color window.

You can override the layer color for solids, surfaces, faces, or curves. See Applying colors to design elements.

1.4.4. Groups Panel
You can create a group from any set of selected objects. When storing Ruler Dimensions for the Pull or Move tool in
a group, note the following list of other information that will be stored in the group.

• Active tool
• Move tool placement

º The Move tool initially places itself (for ease of quick moving) with respect to the oriented bounding box of the
selected items

• Selected objects
• Sub-selections that affect the behavior of the tool
• Active ruler dimension
• Anchor reference for the active ruler dimension

For example, insofar as Group creation goes, a Move tool can be anchored to an edge of a face and oriented in a
direction. This stores the selection, the edge, and the orientation direction. Subsequently, a selected axis of the
Move handle can have a ruler dimension to a dimension reference. This stores the Move handle axis and the ruler
dimension. Any re-invocation of this group will attempt to re-setup the tool, the selection, any options, and ruler
dimensions, according to how the group was saved.
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Note: When using groups to store Move and Pull operations as described above, choose references
appropriate to your design intent and the likelihood of any of the required references being present on
re-invocation.

You can use groups in combination with the SpaceClaim API to change these parameters, or use them as a way to
indicate to others your design intentions about which sort of changes you expect them to make to your design.

Scope
Groups can be saved for the root part or for its children. To change the scope at which groups are displayed, select
Root Part or Active Part in the drop-down list near the top of the Groups panel. This allows you to see groups that
are in children components without opening the component in another window.

Importing Groups from External Components
Groups in external components of an assembly do not show up at the Root Part level of the assembly. Because they
are not visible at the Root Part level, they do not automatically get exposed in Ansys. You can import groups from
external components by doing the following:

• Right-click an External component in the Structure Tree of an assembly
• If Import Component Groups appears in the context menu, the component contains groups
• Click the command to copy the groups from the external component into the Root Part (that is, the assembly)

External component groups will now be exposed in Ansys.

Note:

• Modifications to the copied groups are at the assembly level
• If you redefine the copied group (at the assembly level), the original group will not get redefined
• To redefine the groups in the external component, make it the Active Component and make the changes

Driving Dimensions and Named Selections
When you select an object with a dimension property, you have the option of creating a Driving Dimension group.
These groups are added to the Driving Dimensions folder. Driving dimensions include offset distance (faces with an
offset relationship), round radius, and ruler dimensions. You can change the dimension in the groups panel, and
the geometry will change. These saved groups can be used for API-driven modification and can be sent to Ansys.

• Creating a driving dimension with Pull (offset)

• Creating a driving dimension with Move (translation or rotation)

• Creating a driving dimension with the Select tool (round radius and distance between offset faces)

You may choose to create a Named Selection group whether or not a dimension property exists. If a dimension
property is not available, you may create only a Named Selection group. These groups allow you to save selection
sets to easily recall them.

Creating a Named Selection Group
1. Select any set of 3D objects.
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2. Click Create NS in the Groups panel or press Ctrl+G.

The group appears in theNamedSelections list with the default name. Click in white space to accept the default,
or start typing to rename the group.

Hover over the group to highlight the objects in the group and click the group to select them. Properties and
other information, such as the selected axis for the last Move rotation, are saved with the group.

To detect overlapping selections, right-clickNamedSelectionsand selectDetect
Overlapping Selections.

In top to bottom order, SpaceClaim takes a selection and checks if any of the
objects are used in other named selections. Named Selections are created for
the overlapping selections.

Detecting Overlapping Selections

To repair overlapping selections, right-clickNamedSelectionsand selectRepair
Overlapping Selections.

In top to bottom order, SpaceClaim will take a selection and check if any of the
objects are used in other named selections. If yes, the overlapping objects will
be removed from the lower named selections. If no objects exist in a named
selection after going through all the Named Selections, the named selection will
be deleted.

Repairing Overlapping Selections

Working with the Groups Tree
• Drag a group in the Groups panel to change its position in the list. Group order is important because they are

changed from top to bottom when the change is initiated in an external application.
• You can sort the Groups by right-clicking on Named Selections or Driving Dimensions at the top of the tree.
• A round group is also created each time you fill a round and is saved in the Filled Rounds folder. You can reattach

a group of rounds as long as some portion of the original edges (or faces that bordered the edges) still exists in
your design.

1. Select two coaxial cylindrical faces on a solid. Ensure that the cylindrical
faces are on the same solid.

2. Right-click and select Create Coaxial Group.

The group is added in the Face Groups folder in the Groups panel. A relationship
is created between the cylindrical faces, so the faces remain coaxial when you
change the faces. If you move one of the faces, the other will move with it.

Creating a Coaxial Group

1. Select the driving dimension from the Groups Panel. The current value should
appear next to the Type.

2. Click the value. A dimension box should appear.
3. Type the new value for the dimension and press Enter.

The driving dimension is updated in the Design window. You can follow these
steps to change round radii, offset distance, and ruler dimensions.

Editing a Driving Dimension

1. Right-click one or more round group in the Groups panel.
2. Select Reattach Round from the context menu.

Reattaching a Round
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1. Select the group in the Groups panel.
2. Right-click and select Explode from the context menu.

Each group will be placed in its own group. The new group names are based on
the parent group. For example, a group named "Group" will explode into "Group
1", "Group 2", etc.

Exploding a Group

1. Select the group in the Groups panel.
2. Press the Delete key or right-click the group and select Delete Group from

the context menu.

If all of the objects that comprise a group are removed from the design, the group
is automatically deleted.

Deleting a Named Group

1. Select two or more Group from the Groups panel.
2. Right-click a group and select Merge from the context menu.

The groups will be merged to a single group, taking the name of the last group
selected.

Merging Two or More Named
Groups

1. Right-click the group in the Groups panel.
2. Select Rename from the context menu.
3. Or, select the group and press F2.
4. Enter the new name for the group and press Enter.

Renaming a Named Group

1. Select any set of 3D objects.
2. Right-click a group and select Replace from the context menu.

You can only replace groups in Named Selections.

Replacing Objects in a Named
Group

1. Select any set of 3D objects. You may also select another Group from the
Groups panel.

2. Right-click a group and select Add from the context menu.

Adding Objects to a Named Group

1. Select any object that is part of a named group.
2. Right-click the group name in the Groups panel and select Subtract from

the context menu.

Subtracting Objects from a
Named Group

• To hide objects in the group(s), right-click the group name(s) and select Hide
from the context menu.

Note: If the group contains only faces, then only faces on objects that
are part of the group will be hidden.

• To focus on objects in the group(s), right-click the group name(s) and select
Hide Others from the context menu.

• To show objects in previously hidden group(s), right-click the group name(s)
and select Show from the context menu.

Hiding/Showing Objects using
Named Groups

1.4.5. Customizing a View
You can change the shortcut keys for standard views and create your own custom views to save settings for object
orientation and visibility.
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User-created views will not auto-scale when they are moved.

Clicking the Name column header in the Views panel toggles through ascending, descending, and user defined order.

Changing View Shortcut Keys
1. Select the View tab in the Structure panel.
2. Select a shortcut key combination in the Shortcut drop-down list for the view you want to change.

Adding a Custom View
1. Position the view in the design window as you want it saved.
2. Select the View tab in the Structure panel.
3. Click Create View at the top of the panel.
4. Select from the following options:

• Name: Enter a unique name for the view. The name will appear in the Structure tree.
• Shortcut: Select a key combination from the drop-down list.
• Orientation: Select if you want the current orientation to be saved in the view.
• Object visibility: Select if you want the visibility of objects in the current view to be saved in the view. Objects

that are hidden when you create the view will be hidden when you apply the view. Visibility is applicable to all
types of geometry, planes, and curves.

• Visibilitybehavior fornewobjects: Select the visibility behavior you want to apply to objects you create after
you create the view.

• Leave Unchanged: New objects will retain their visibility when you apply the view.
• Visible: New objects will be visible when you apply the view.
• Hidden: New objects will be hidden when you apply the view.

5. Click OK.

Your custom view is added to the View tool menu.

Using Custom Views
The options that are available for custom views are:
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You can change the current view to a custom view in the following ways:

• Select the View tab in the Structure panel, right-click the view, and select
Apply view from the context menu.

• Use the shortcut key (if assigned).
• Select the view from the View tool menu

in the Orient ribbon group.
• Double-click the view.
• Select the view and click enter.

Applying a Custom View

Position the view in the design window as you want it saved.

Right-click the custom view you want to replace and select Replace from the
context menu.

The custom view is replaced with the current view.

Replacing a Custom View

Right-click the custom view you want to rename and select Rename from the
context menu.

Enter a new name for the view.

Renaming a Custom View

Right-click the custom view you want to edit and select Properties from the
context menu.

Edit the view properties.

Editing Custom View Properties

Select the view you want to delete and clickDelete View at the top of the panel.

You cannot delete standard views.

Deleting a Custom View

1.4.6. Status Bar

From left to right in the image above, the blue Status Bar shows the following:

Displays messages and progress information about your actions in the current tool. You
can also view these messages in the top left of the Design window by selectingShowstatus
messages in window in the Popular options.

You can hover over status icons in the message window to see tool tips.

The number of objects affected is included in status messages.

Status message

Displays simple measurements of the selected object(s), such as the distance between two
objects or the X, Y, Z coordinate of a point. See Quick measurements. Use the Measure tool
for other types of measurements, such as volume and mass. You can select the text that
appears here for copy and paste operations.

Quickmeasurement
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Displays messages as they occur. Click the icon to display all the messages currently relevant
to your design. Click a message to highlight the object referenced by the message.
Double-click a message to select the object(s) referenced by the message. Enable theZoom
option to zoom into the affected objects in the Design window when you double-click the
message.

Error, warning and
information
messages

Shows you a list of objects you currently have selected. Hover over the list area on the status
bar to see a complete list. When Pattern is selected in the Structure tree, the selection list
updates to display the number of patterns included in the design.

Selection list

Depending on the selection, you can select the parents (up arrow) of the currently selected
objects or the children (down arrow) of the currently selected objects.

Select Parents or
Select Children

Reverts your selection to your previous selection.Revert

selection

Allows you to choose what can be selected in the Design window. A label in the status bar
displays the currently selected object.

Enable or disable the Smart selection check box for additional control over filtering:

• EnableSmart to collapse the Selection Filter. In this case, only theBoxSelectionoptions
are selectable.

• DisableSmart to expand the Selection Filter to show all choices. See Filtering the Selection
on page 124 for details.

Selection Filter

Choose Box, Lasso, or Paint.Selectionmode

Use these controls to spin, pan, zoom, and switch to previous or next views. You can also
change your view using the tools found in the Orient group, which is found on most tabs.

When spinning, you can also select one of the following from the Spin pull-up menu:

• On Center to spin around the center of your design
• On Cursor to spin around the cursor location
• Rotate 90 Clockwise to rotate your design 90° in a clockwise direction
• Rotate 90 Counterclockwise to rotate your design 90° in a counterclockwise direction

When zooming, you can also select one of the following from the Zoom pull-up menu:

• Zoom Extents to zoom the selection so that it fills the Design window
• Zoom Box In to zoom into a selected area
• Zoom In to zoom into the view
• ZoomOut to zoom out from the view

View controls

1.4.7. Options Panel
The Options panel allows you to modify the functions of the SpaceClaim tools. For example, when you use the Pull
tool, selecting an edge and then selecting the Chamfer Edge option creates a chamfer instead of a round when you
pull the edge.

Options are enabled when the relevant geometry is selected.
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This is the Options panel for the Pull tool when an edge is selected:

Some options are also displayed in the mini-toolbar:

1.4.8. Properties
The Properties panel is on the left side of the SpaceClaim interface, below the Structure tree and Options panel.
When you select a complete component, surface, or solid by triple-clicking it in the Design window or selecting it in
the Structure tree, you will see its properties in the Properties panel. You can use the Properties panel to modify
various properties values, such as Color to set the color of a selected face or body, or to change other properties
values.

In addition to components, surfaces, and solids, you can modify property values for sketched objects, inserted
images, patterns, and sheet metal. The property settings for these objects are described in detail in their specific
topics.

It may be helpful to configure the Properties panel so that you can see object properties and the Structure panel
simultaneously.

Modifying an Object's Properties
1. Select an object in the Structure tree or right-click the object in the Design window and select Properties.

2. Edit the property values.

Modifying Analysis Properties
1. Select the top level assembly component in the Structure Tree
2. In the Properties panel, expand the Analysis properties to display the Share Topology property
3. Click in the property input panel
4. Open the drop-down menu and choose

• None (default)
• Merge
• Share
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Modifying Document Properties
1. Select the top-level design or a component in the Structure tree.

You can hold Ctrl and select more than one component.

2. In the Properties panel, expand Document properties to display the following information

• Display Name: If you want the name to be different than the file name.

• Document Path: Path to the file on disk.

• Locked: Set this to true if you want to prevent the model from being modified.

• Use File Name: Set this to True if you want to display the file name for the top level design component in the
Structure tree. Set this to False if you want to use the Display Name.

3. Enter additional information such as Creator, Description, Title, and Version in the File section of the Properties
panel.

These properties can be included in BOM tables.

Creating a Custom Document Property
1. Select the top-level design or a component in the Structure tree. You can select more than one component.

2. Right-click in the Properties panel and select Add Document Property to create a custom property.

3. Expand the property to display its value.

4. Enter a name for the property, select its type (date, Boolean, number, or string), and enter its value.

Delete a custom property by right-clicking the property in the Properties panel and selecting Delete Document
Property.

Creating a Custom Component Property
1. Select a component in the Structure tree.

2. Right-click in the Properties panel and select Add Component Property to create a custom property.

3. Expand the property to display its value.

4. Enter a name for the property, select its type (date, Boolean, number, or string), and enter its value.

Custom component properties can be used in BOM's and note fields. Delete a custom property by right-clicking
the property in the Properties panel and selecting Delete Component Property.

Material Properties
You can set the gage for a material used in a sheet metal part. Assigning a gage enables you to control the thickness
of a sheet metal part at a more granular level. Gage, or, ‘gauge', is the thickness of the metal organized by numbers:
the smaller the number the thinner the metal. A sheet metal design or component of a design must be assigned a
material in order for the gage drop-down to display. You cannot select a gage for designs or components that are
assigned the ‘Unknown Material' option.

To assign a material, from the Structure tree select the design at the top level, or select the component for which
you want to assign a material, and then click theMaterialNamedrop-down from the Material group in the Properties
panel. From the Thickness group in the Properties panel, click the gage drop-down, and select a gage.
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You can specify material properties for a component in several ways:

1. Select a component in the Structure tree.

2. In the Properties pane, expand Material properties.

3. Click

in the Material Name field to display the Materials Library.

4. Select the Library tab.

5. Select a material and click OK.

The material and its properties are displayed and can be edited in the
Properties panel. The material also appears in the Local Materials tab and
saves with the SCDOC file. You can download materials from Resources in
SpaceClaim options.

Selecting a Material from the
Materials Library
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1. Select a component in the Structure tree.

2. In the Properties pane, expand Material properties.

3. Click

in the Material Name field to display the Materials Library.

4. Select the Local Materials tab.

5. Select a material and click OK.

The material and its properties are displayed and can be edited in the
Properties panel. The material also saves with the SCDOC file.

You can rename, copy, and delete Materials from the Local Library. You can
also create new Materials.

Selecting a Material from the
Local Library

1. Select a component in the Structure tree.

2. In the Properties pane, expand Material properties.

3. Click

in the Material Name field to display the Materials Library.

4. Click the New button to create a new material.

5. Enter the name of the material.

6. Click OK.

7. Enter the density of the material in the Density property.

If you specified the density for the material elsewhere in the design, or
specified it in the same SpaceClaim session, SpaceClaim displays that value
in the Density property for you.

8. (Optional) Expand other material properties and enter their value and units.

The material and its properties appear in the Local Materials tab and save
with the SCDOC file.

Creating a Material

To remove a material from a component, select Unknown Material from the Local Library.
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You can only change the Density value for material properties. All other values are determined by the material you
select.

In the Local Materials tab, you can also do the following:

• Select a material and click the Copy button. A new material is created with the original name and "Copy 1"
appended

• Delete selected materials
• Rename selected materials
• Select a material and click the Add to Library button to add that material to the Library.

Recognizing Rounds and Chamfers
Rounds and chamfers created in SpaceClaim are automatically recognized, but they may not be recognized on
imported models.

1. Select a round or chamfer face.

2. Change the Round or Chamfer property to True.

Drawing Sheet Properties
You can modify properties of the drawing sheet views and other aspects of drawing sheets such as annotations,
BOM, tables, and threads in the Properties panel.

1.4.9. Keyboard Shortcuts
You can use the following shortcuts to quickly access tools, tool guides, and other SpaceClaim commands.

OOpen the Radial Menu

BBlend

CCircle

ICombine

EscEscape

EMeasure

FFill

HHome

LLine

PPull

RRectangle

SSelect

D3D mode

VPlan view

XSection mode

KSketch mode

UUp To tool guide
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MMove

TTrim Away

Drag with middle mouse buttonSpin

Shift+drag with middle mouse buttonPan

Ctrl+drag up and down with middle mouse buttonZoom

Alt+ZZoom Extents

Shift+double-click middle mouse buttonSnap view

Left arrowPrevious view

Right arrowNext view

Alt+FFile menu

Ctrl+F4Close document

EnterComplete

Ctrl+C

Ctrl+Shift+C

Copy

Copy Faces

Ctrl+GCreate Group

Ctrl+X

Ctrl+Shift+X

Cut

Cut Faces

DelDelete

Ctrl+DDetach face

Alt+F4Exit

Ctrl+Shift+IInvert selection

Ctrl+TabDisplay next Design window

Ctrl+Shift+TabDisplay previous Design window

Ctrl+right arrowMove sketch grid in

Ctrl+left arrowMove sketch grid out

Shift+up arrowNudge primary (active) dimension Up by normal amount

Shift+down arrowNudge primary (active) dimension Down by normal
amount

Alt+Shift+up arrowNudge primary (active) dimension Up by small amount

Alt+Shift+down arrowNudge primary (active) dimension Down by small amount

Ctrl+Shift+up arrowNudge primary (active) dimension Up by large amount

Ctrl+Shift+down arrowNudge primary (active) dimension Down by large amount

Shift+left arrowNudge secondary (inactive) dimension Down by normal
amount

Shift+right arrowNudge secondary (inactive) dimension Up by normal
amount
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Shift+Alt+left arrowNudge secondary (inactive) dimension Down by small
amount

Shift+Alt+right arrowNudge secondary (inactive) dimension Up by small
amount

Ctrl+Shift+left arrowNudge secondary (inactive) dimension Down by large
amount

Ctrl+Shift+right arrowNudge secondary (inactive)dimension Up by large
amount

Ctrl+NNew

Ctrl+OOpen

Ctrl+VPaste

Ctrl+PPrint

Ctrl+F2Print Preview

Ctrl+YRedo

Ctrl+SSave

Ctrl+Shift+S

Alt+Shift+S

Save As

Save As New

Alt+SShare As File

Ctrl+Alt+SSave As New Version

Ctrl+ASelect all of same type as selected

Ctrl+BBold text

Ctrl+IItalicize text

Ctrl+UUnderline text

Ctrl+HHide object

Alt+HHide others

Ctrl+ZUndo

Ctrl+ +Zoom In

Ctrl+ -Zoom Out

Ctrl+TSet spin center

Ctrl+LLocate spin center

Ctrl+QClear spin center

' * ' on number padExpand entire node in Structure tree

' + ' on number padExpand selected node in Structure tree

' - ' on number padCollapse selected node in Structure tree

Ctrl+Shift+AActivate Component

Ctrl+Shift+HShow All

Ctrl+Shift+FInitiate FlyThrough mode
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1.4.10. Using a Multi-Touch Screen
SpaceClaim supports Microsoft® Touch technology for Windows. It allows you interact with your designs using a
stylus or multiple fingers on a touch screen. Touch screens with multi-touch capabilities improve your work experience
by providing:

• User interface controls that are always close to a finger, so you use your mouse less often.

• 3D interaction, such as panning and rotating views, that offers a different navigation mechanism than with modifier
keys or separate tools.

• More intuitive selection, because you put your fingers directly on the geometry you want to manipulate.

• Modeling in a more hands-on environment, so it feels more like working on a real part than a virtual part.

• Real-time, interactive design reviews using large format multi-touch displays.

See it in action on YouTube

When using SpaceClaim's multi-touch feature, you can widen the SpaceClaim application window to span across
two multi-touch monitors at the same time, or, you can move SpaceClaim between monitors to display the entire
SpaceClaim window on either monitor.

While a significant effort was made to optimize the multi-touch functionality to fit (and enhance) the SpaceClaim
user model, the intention was never to replace the mouse entirely. Touch should be used when it feels easier to do
so, and the mouse should be used alongside the touch screen. The same philosophy applies to keyboard shortcuts
and even to precise selection techniques. You are encouraged to try out touch to see where it improves the user
experience and feedback is very welcome.

Touch is incorporated into SpaceClaim in many ways:

• Navigation (Spin/Pan/Zoom/Rotate) uses emerging Microsoft standard gestures (those having been extended
from 2D to 3D).

• Precise selection of toolbar buttons is made easier by heads-up bubble notes, that appear over the icon that a
finger may obscure.

• Radial menus have been introduced to ease the choice of selection types, as a shortcut to get to major tools, and
as a method to select edge loops.

• A flick gesture takes the place of the missing mouse wheel to select objects that lie behind other objects.

• Where possible, difficult selections have been made easier by automatic selection, such as the one axis that is free
to move in the Move tool (on assembled components).

For HID-supported devices, SpaceClaim will use the faster HID signal.

For non-supported hardware, SpaceClaim will use the Windows built-in Multi-touch API.

Timing-based Mode and Gizmo-based Mode
Two modes have been added for interacting with the SpaceClaim touch interface:
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• Timing-based: This mode automatically chooses touch functions based on the amount of time a touch signal is
maintained. For example, using two fingers moving together to immediately drag invokes panning, while holding
two fingers down for a while, then moving them, invokes what are normally right-mouse-button drag mouse
gestures.

• Gizmo-based: This mode is intended to transition existing SpaceClaim users to the touch interface. Existing mouse
buttons and popular keyboard buttons are placed in an on-screen gizmo, to clearly map existing functions onto
the touch interface. The benefits in terms of usability are not as apparent with the Gizmo style, but users are
encouraged to experiment with it. Because the gizmo buttons act exactly like the mouse and keyboard buttons,
use of the gizmo will not be explicitly described here.

An exception is that using the gizmo does not allow for flicks, so to select objects that are under other objects,
you must place the gizmo over the object, then drag the Select gizmo button around the gizmo circle, and it acts
like rotating a wheel (and therefore more directly maps to the mouse wheel function.)

The mouse experience is characterized by a cursor that is always visible, whose default mode is to innocuously
move the cursor around the screen. Nothing happens with a mouse until a button is pressed, or a movement is
made with a button pressed. Conversely, with touch, there is a lack of an always-visible cursor (and it would be
obscured by a finger anyway). And so in SpaceClaim, the default mode is innocuous pre-selection, until a selection
is made (in various ways described below.) In the timing-based paradigm, once a selection is made, then following
touch movements act as mouse-button drag actions. Here the important difference in the Gizmo is the most
apparent--as ALL touch movements are interpreted as pre-selection actions--and only touching the screen using
the gizmo button labeled Left acts as a drag (same as the left mouse button.)

Additionally, precise sketching is made possible by the gizmo, since it is difficult to draw lines when the endpoint
of the line is under the fingertip (in the timing-based scheme.)

Basic Touch Gestures
ActionDescription

Touch screen brieflyTap

Touch screen briefly twiceDouble-tap

Touch screen briefly three timesTriple-tap

Touch screen and hold. This multi-touch icon pops up to
show the difference between a tap and a touch.

Touch

Touch screen, move finger or pen across screenDrag

Touch screen, wait briefly, then move finger or pen across
screen. This multi-touch icon comes up to show that the
input for the next selection will be an Alt reference
(normally highlighted in blue.)

Delayed drag

Touch screen, move finger or pen a few inches, then
remove finger or pen from screen

Flick

Move pen over screen without touching -- only works
with a pen

Hover
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ActionDescription

Touch the screen with one finger and tap with two others
to invoke the radial menu.

Switch between radial menus with successive two-finger
taps or a following tap in the center of the menu.

Radial menus are disabled when using the gizmo.

Radial menu

An animation is displayed when you use a multi-touch
gesture with a pause, such as touching with two fingers,
waiting, and then dragging to invoke gesture mode. The
animation shows the wait time as the circle is drawn.
When the circle is complete, then the wait time has been
reached and the alternate behavior is invoked. If you lift
or move your finger before the circle is complete, then
the alternate behavior or mode is not invoked. So in this
example of two fingers touching, it would revert to
panning the view.

Hold one, two, three or four fingers to invoke different
functions.

Hold

Navigating
DescriptionAction

Move two fingers together across the screen.Pan

Move two fingers away from each other to zoom in or toward each other to zoom out.Zoom

Hold one finger on the axis you want to rotate around and move the other finger in an arc
that is centered on your first finger.

Rotate

Move three fingers together across the screen.Spin

Hold one finger on the axis you want to spin around and drag two fingers on the screen.Spin on an axis

Hold three fingers to activate the Snap View tool. While the Snap View tool is active, tap for
a left mouse click and flick for a left mouse flick. Hold three fingers again to inactivate the
tool. You can also press the Escape key to exit the tool.

Snap View

Note: If you use multiple screens, then the screen that is designated as the touch screen at the operating
system level is the one for which SpaceClaim detects touch input. If a SpaceClaim session has windows on
multiple multi-touch displays, you can sequentially use one or the other display for multi-touch interaction.

Touch Gestures in Select, Pull, and Move
MouseTouch or pen gestureAction

ClickFinger: Tap

Pen: Hover to preview the selection, tap to select

Select geometry
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MouseTouch or pen gestureAction

Ctrl + clickCtrl + tapAdd or remove geometry from
selection, remove query-selected
edge loops

Shift + clickShift + tap

In Pull and Select: Drag to prehighlight the object(s), then
lift your finger.

Add geometry to selection

Alt + click

Alt + tap

• If you are already dragging geometry, then a long touch
with a second finger changes to an alternate selection
tool (shown on-screen with a blue touch circle)

Add geometry to alternate
reference selection

Double-click(s)Double-tap or touch and double-tap

• If you are preselecting an edge, invoke the Edge Radial
menu to preview and select one of the loops with the
menu.

• If you are using the Gizmo, use the Select gizmo button
to scroll to the other loops.

Select a tangent chain of edges,
tangentially connected faces,
successive edge loops, etc.

Triple-clickTriple-tap or touch and triple-tapSelect a solid

Scroll the mouse
wheel

Finger: Drag to preselect, then flick one finger up

• You can change the direction of the flick in Multi-touch
options

• If you are using the Gizmo, use the Select gizmo button
to scroll to the other objects.

Select the next face or edge (that
is behind a face or edge)
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MouseTouch or pen gestureAction

Click, hold, and then
drag to the right or
left

Finger or pen: Touch, pause, and drag to the right or leftBox-select

n/a

There are two modes:

• Quick select: Touch with four fingers and lift to select
everything inside the box.

• Preview select: Touch with four fingers and pause to
preview the selection. Move your fingers to change the
selection and you will see a new preview when you
pause. The selection is confirmed when you lift your
fingers.

This allows you to preview and change your selection
before it becomes final, rather than getting one chance
to select the objects you want. Slight finger movements
will not interrupt the previewing.

Box-select with four fingers

Click Select, then
click Using Lasso

Invoke lasso selection with the radial menuLasso-select faces or edges

Click Select, then
click Using Paint

Invoke paint selection with the radial menuPaint-select

Right-clickFinger or pen: Touch long enough to show the
multi-touch circle, then lift finger or pen

Pen: Tap with pen button pressed

If using the gizmo, just click the button labeled Right on
the gizmo.

Invoke a context-sensitive menu
(a right-mouse-button menu)
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MouseTouch or pen gestureAction

Gesture with the right
mouse button

Finger: Touch with two fingers, pause, then drag in the
gesture pattern. You will know when the gesture can start
when two multi-touch circles like this pop up under your
fingers:

Pen: Touch and drag in the gesture pattern with the pen
button pressed

If using the gizmo, just drag the button labeled Right on
the gizmo.

Use gesture recognition (see
Mouse and touch gestures)

n/aCtrl + Shift + F2Reset all pen and touch input

n/aCtrl + Shift + F3

(This slows down drag by 10% for precise selection with
tap, double-tap, or up-select.)

Invoke magnifying loupe window

n/aCtrl + Shift + K

(This is useful for tablet PCs on which the keyboard is
obscured by the rotated screen.)

Invoke keypad for Ctrl, Alt, Shift,
Tab, Esc, Enter, and Space

n/a

While something is selected and being pulled with one
drag action, pause the drag action (keep the finger down),
and use a finger of the other hand to select more
geometry with the standard MT selection methods.
Continued dragging of the first finger will now pull the
new (augmented) selection.

If the second selection is started with a Touch-Hold, until
the multi-touch icon turns blue, and then continued
through to the selection, then that second selection is
treated as an Alt-reference - and the Pull tool reacts
accordingly.

Select more while pulling
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MouseTouch or pen gestureAction

n/aWhile something is selected and being pulled with one
drag action, pause the drag action (keep the finger down),
and use two or three fingers of the other hand to perform
Spin/Pan/Rotate/Zoom actions. Continued dragging of
the first finger will now pull the existing selection - at the
same time as the model is being navigated visually.

Navigate while pulling

Multi-Touch with the Pull Tool
• Select and drag geometry to change it.

• Immediately drag to pre-highlight geometry. You can also touch in white space and drag to pre-highlight. This
shows you what will be selected before you select it.

• After you pre-highlight geometry, tap with a second finger or raise the first finger to select the geometry.

• Press the spacebar to enter dimensions for an offset face, just like you can when you use a mouse instead of
multi-touch.

• Starting on whitespace, drag with one finger, then hover over an edge and double-tap with another finger to query
select through the available edge loops. This behavior is the same as a simple double-tap.

• Starting on whitespace, drag with one finger, then hover over a face and triple-tap with another finger to select
all the faces of the body. This behavior is the same as a simple triple-tap

Multi-Touch with the Move Tool
• Select faces, bodies, or components to move or rotate.

• Select secondary objects to set the direction.

• Re-anchor the move handle by dragging the yellow ball at its center.

• Tap to activate a rotation or linear axis. This is easiest to do using a pen, or if just fingers, by dragging along then
up-to-select.

• Drag to move or rotate geometry.

Multi-Touch with Windows
Multi-touch devices are automatically detected on computers running Windows, and SpaceClaim can be run using
these devices. You may need to configure one display at a time to avoid common problems with multiple displays
and multi-touch (a symptom of this is dragging a finger across the multi-touch screen's desktop, only to see a box
made on the other screen).

You should set up the multi-touch screen as the only display device first (make it the primary display), then configure
your second display device. After this, the setting is remembered and you can drag the SpaceClaim session from
one screen to the other, using multi-touch as it is available.

1.4.11. Radial Menu
This menu gives you quick access to the most commonly used tools and makes it easy to choose a select mode while
another tool, such as the Pull tool, is active. The radial menu supports secondary selection. For example, you can
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select one of the Pull tool guides, then select loops of edges with the radial menu, whether or not a primary reference
was selected.

When the radial menu is displayed on a multi-touch screen, touch input is processed only within the menu to avoid
accidental dismissal of the menu.

You can change radial menu options in Popular options.

Using the Radial Menu
1. Press and hold the left mouse button, then right-click to display the radial menu.

You can also press O to open the radial menu.

If your mouse is over an edge when you open the radial menu, the radial menu for edges is shown.

2. Click in the center of the radial menu to toggle between select modes and tools.

The active tool is highlighted in orange.

3. Mouse over or click one of the select modes or tools to activate it.

The radial menu disappears and the cursor changes to indicate the active select mode or tool.

You can click outside of the menu or press Esc to close the menu without making a selection.

Examples

Opening the radial menu for an edge
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1.5. SpaceClaim Objects
The SpaceClaim interface describes objects slightly differently than other modeling software you might be familiar
with.

• Assembly constraints: Components are aligned using assembly constraints.
• Body: In SpaceClaim, a body is a solid or surface.
• Component: A component consists of any number of objects, such as solids and surfaces. You can think of a

component as a "part." A component can also contain any number of sub-components. You can think of a hierarchy
of components and subcomponents as an "assembly."

• Curve: An imported Curve file.
• Document: A SpaceClaim .scdoc file may contain any combination of design versions, associated drawing sheets,

and 3D markup slides.
• Design: A design is a 2D or 3D model, which contains at least one top-level component.
• Object: An object is anything recognizable by SpaceClaim tools. For example, 3D objects include vertices, edges,

faces, surfaces, solids, layouts, planes, axes, and origins. 2D objects include points and lines.

Examples of some object types are shown below:

EdgeAxis

OriginFace

SolidPlane

VortexSurface

1.5.1. Working with Components
Components are shown in the Structure tree on the Structure panel. All the objects in the Structure tree are contained
within a top-level design component (Design1 in the figure below.) This top-level component is created automatically
when you first save your design.

You must create any other components yourself. Once you have created a component, the icon changes to show
that the top-level design is now an assembly.
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Creating a Component
You can do any of the following in the Structure tree to create a component:

• Right-click any component and selectNewComponent from the context menu to create a new component within
that component.

• Right-click an object and select Move to New Component to create a component within the active component
and move the object into it. If the object has a custom name, the new component will have the same name.

• Ctrl+click multiple objects, then right-click and selectMove Each toNewComponents from the context menu to
create a new component for each object within the active component and move the objects into those components.
If the object has a custom name, the new component will have the same name.

Note: An annotation plane with dimensions cannot be moved to a component because the references
would be lost.

Activating a Component
Activating a component allows you to work with the objects within that component.

Right-click the component the Structure tree and select Activate Component from the context menu.

If the component is lightweight, it is also loaded. As you design, any new objects you create are created within this
component.

You can right-click an object in the design window and select Load Component.

Cutting, Copying and Pasting a Component
1. Select the component.
2. Click the Cut tool in the Clipboard group on the Design tab or press Ctrl+X.

Cut

1. Select the component.

2. Click the Copy tool in the Clipboard group on the Design tab or press Ctrl+C.

Copy
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1. Copy or Cut a component.

2. Activate the component into which you want to Paste the component.

• Activating the top-level design will create a first-level component.

• Activating a component with no sub-components creates a sub-assembly of the active
component and the pasted component.

• Activating a component with sub-components adds the pasted component to the first
level of the sub-assembly.

3. Click the Paste tool in the Clipboard group on the Design tab or press Ctrl+V.

Paste

You can also use Ctrl+drag to Copy and Paste:

1. Select a component in the Structure Tree.

2. Ctrl+drag the component over other components in the tree.

3. When the destination component highlights, release the mouse and Ctrl key.

Copied components are Dependent by default. There are two ways to make copied components Independent.

• To paste the component, use RMB > Paste > Independent.
• After pasting, select the component and use RMB>Source>Make Independent.

Mirroring a Component
1. Click the Mirror tool in the Design tab Insert group.
2. Select a mirror plane.
3. Select the component to mirror.

Sorting Objects within a Component
Right-click the component and select Sort > Sort A to Z or Sort > Z to A from the context menu.

Renaming a Component
Components have a part name and a component name. The part name is displayed in the Structure tree next to the
component icon. The component name is shown in parentheses next to the part name.

To change a component's part name, right-click the component in the Structure tree and select Rename from the
context menu.

To change a component's component name, select the component in the Structure tree and modify theComponent
Name value in the Name section of the Properties panel.

To change the top-level component's display name, select the top-level component in the Structure tree and modify
the Display Name in the Name section of the Properties panel.

Deleting a Component
Right-click a component and select Delete Empty Components from the context menu to delete any empty
subcomponents within the component. If the component itself is empty, or contains only empty sub-components,
it is also deleted.
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Flattening Assemblies
Right-click an assembly and select Flatten Assembly from the context menu to flatten the assembly hierarchy.
Underlying sub-assemblies will be flattened to components in the tree. Any groups defined for the sub-assemblies
will be deleted as well.

1.5.1.1. Internal, External, and Independent Components

Internal Components
Objects that are inside of the SpaceClaim document file are internal components. Components you create in the
Structure tree are internal by default.

You can convert an internal component into an external component. This creates a separate file for the component
and makes it external. See the instructions below.

You can create an internal copy of an external component. This integrates the component into your design, and
removes the association to the external component.

External Components
Objects that are outside of the SpaceClaim document file are external components. Designs that you load using
the File tool on the Design tab are external. See Inserting another design.

You can make a copy of an external component internal. The copy will be included in the .scdoc file so it can be
viewed and modified in your design. The original external component will not be changed. See the instructions
below.

If you have the Use lightweight assemblies option selected in the File import and export options, external
components will be loaded as lightweight components. See Lightweight components.

Dependent and Independent Components
You can load multiple instances of an external component. These are known as dependent components. Changes
to one instance will change all instances. The copy exists in the .scdoc file, but its geometry comes from the external
file.

Copies of external components that have been made independent of other copies are known as independent
components. Changes to the independent copy will not affect the original and vice versa.

Notes About Dependent and Independent Components
• You can make an instance of an external component independent, so changes to that instance don't affect other

instances.
• If your design includes multiple copies of an external component, making one of them internal does not affect

the other copies.
• Making another copy of the same external component internal creates a second instance of the same internal

component. You are asked to save the new external component when you exit SpaceClaim if you haven't saved
it.

• Making an external subcomponent independent makes its parent component independent.
• Independent status is propagatedup through the structure as far as needed to differentiate the subassembly from

peer assemblies. Names are changed accordingly.
• Independent status is not propagated down through the structure.
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Examples
The structure of a design with copied subassemblies is shown below. Copies of the wheelAxleAssembly subassembly
(highlighted) exist in both suspension assemblies:

When making the highlighted sub-assembly independent, the sub-assembly names are changed. The names of the
components are the text not in the parentheses. The change affects wheelAxleAssembly and its parent. Both names
have a "2" appended in the image below:

Inserting a Component or Assembly
1. Select the Insert File tool

in the Insert ribbon group.

2. Navigate to the component and double-click to insert it.

The component will be inserted as an external component. The component is placed in the center of the workspace
and its sub-components (if it is an assembly) appear in the Structure panel.

Making a Component Independent
Right-click the inserted, dependent component in the Structure tree, then hover over the Source option and select
Make Independent from the context menu. You can hold the Shift key to select multiple components and make
them all independent at once.

The icon in the Structure tree changes, and the component is renamed <OriginalComponentName>2.

Making an Internal Component External
If you want the document saved in the same folder as its parent and its name to be the same as the component
name:

1. Right-click the component in the Structure tree and hover over theSourceoption then selectConvert toExternal.
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If you want to save the document in a different folder or with a different name:

1. Right-click the component and select Open Component from the context menu.

The selected component appears in a new Design window.

2. Select Save As from the File menu. (DO NOT check the Save as copy box.)

3. Browse to select the folder where you want the document saved or create a new folder.

4. Type a file name.

5. Click OK.

Whichever method you use, the component is saved as a separate file and its icon in the Structure tree changes to
reflect that the component is now external.

Note: If the design has not been saved, you are prompted to choose a folder no matter which method you
use.

Making a Copy of an External Component Internal
1. Select one or more components in the Structure tree.

2. Right-click the component and hover over the Source option then select Use Internal Copy from the context
menu.

The selected component is copied into your design. Any changes you make to the component do not affect the
original, external file.

3. Use Internalize All to make all external components in the design internal.

Saving a Copy of an External Component
1. Select one or more external components in the Structure tree.

2. Click Save As.

3. Select Save as copy.

4. Click References.

The Referenced Designs dialog will open.

5. Click Browse and select a folder where the copies of the external components will be saved.

6. Select the external components you want to save.

7. Click OK.

8. Click Save.

Files are automatically renamed to resolve conflicts. You will receive a warning message in the status line when
this happens.
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1.5.1.2. Lightweight Components
If you have the Use lightweight assemblies option selected in the File import and export options, external
components will be loaded as lightweight components. Only the component's graphic information is loaded.

A lightweight assembly component uses less memory than an object that is fully loaded. You can quickly view the
component with the Orient tools. When you are ready to work with it in SpaceClaim, you can load the geometry
information.

See also Displaying lightweight components and Internal and external components.

Loading a Lightweight Component
Right-click the component in the Structure tree and select Load Component from the context menu.

The component and all its subcomponents' geometry information is fully loaded. You can modify the components
with any SpaceClaim tool.

Making an External Component Lightweight
Right-click the component in the Structure tree and select Make Lightweight from the context menu.

The component becomes lightweight and uses less memory. You cannot make an internal component lightweight.

1.5.2. Working with Faceted Bodies
An STL file can be imported as lightweight (facets:facet only) with the ability to snap to the facets.

You can place faceted bodies on a layer.

Faceted Bodies in the Structure Tree are labeled Facets.

If the Faceted Body is over-connected (non-manifold), the icon has a small yellow warning triangle.

Sketching on a Faceted Body
You can sketch on a faceted body, as shown in the figure below, and your sketch tools will snap to the facets.

You can:

• Sketch lines, spines, and points in 3D mode. Click the sketch tool, switch to 3D mode, then sketch on the STL
model. The cursor snaps to the facet vertices, edges, and faces on the model.

• Use the line, rectangle, circle, spline, ellipse, 3 point arc, polygon, sweep arc, and point sketch tools to create
curves that snap to geometry intersecting with the plane. Other sketch tools do not snap to the geometry intersecting
the plane but you can use them to create geometry off of newly drawn curves.

• Sketch on a cross section plane of a faceted body, which allows snapping to facets that intersect the plane.
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Selecting on a Faceted Body
When you select placement points on a faceted body, a circle around the point of the cursor helps you to identify
facet faces, edges, and points. The following images show the types of selections you can make:

A double circle (normal to the screen) is displayed when
the cursor point is snapped to a facet's vertex.

A single circle is displayed and the facet's edge is
highlighted when the cursor point is snapped to a facet's
edge. The circle lies in the plane at the average of the two
neighboring facet faces.

A single large circle is displayed and the facet is
highlighted when the cursor point is on a facet. The circle
lies in the plane of the facet face.

Changing Facet Edge Display
The Edges

menu in the Display tab has options for changing the display of facet edges.
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Internal Edges Displayed

Open Edges Displayed

Open and Internal Edges Displayed

In SpaceClaim Options, the Appearance section has options for changing facet colors and highlighting.

The Highlighting scheme for facets matches that for solid bodies (Classic, Default, Custom). You can use the
Ctrl+Alt+Shift+H shortcut to toggle through the different schemes.

Also in the Appearance Options, you can enable theBack face color to make it different than front faces. If enabled,
you can change the color of facet back faces.
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You can toggle the Front and Back faces (that is, switch the normals) using the context menu for a selected Faceted
Body. You know the switch has taken place because the Front and Back colors will switch. If Back face color is NOT
enabled, there will be no visible change.

Copying and Pasting Facet Edges
Facet edges can be copied and pasted as a polyline. An example is shown below.

Material Properties
You can assign Material Properties to Faceted Bodies.

Material Properties are preserved after operations such as:

• Copy/Transform
• Move to component
• Mesh boolean operations
• Facets>Reduce

The Material ID is preserved for operations such as:

• Facets > Export
• Conversion between mesh and solid
• Converting from simple mesh to connected mesh

1.6. Undo and Redo
SpaceClaim stores all your actions from the moment you open the SpaceClaim application until you close it. This
includes the use of all tools in all tabs, opening and closing files, and loading and activating components. Every
action is recorded and can be undone and redone.

Undo and redo allows you to have multiple models open and move between them making changes. You can return
to any window where you have been working and undo changes from the last time you worked in the window.

Dependencies created between windows, however, will permanently merge the Undo operations for those windows.
For example, if you open a component of an assembly in a second window, a model dependent on the first window,
the Undo operations will be merged. Making changes in the first window and then choosing to Undo those changes
in the second window will undo the changes in both windows.
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The undo list is set to 50 steps by default. You can modify this number, but it's recommend that you keep the default
setting.

Undoing or Redoing a Tool Action

Click the Undo and Redo tools in the Quick Access toolbar or press Ctrl+Z to undo and Ctrl+Y to redo.

You can undo and redo actions until you have undone or redone every action in your session, or you can jump to a
particular action by selecting that action from the Undo and Redo menus. If undoing an action will open or close a
document or switch to a new Design window, a confirmation window is displayed.

When you undo a tool action, the view is also changed to the view you used to perform that action.

Purging All Actions
Select

Purge from the Undo menu.

This clears the memory of all previous actions for the SpaceClaim session.

Undoing or Redoing a View

Click thePrevious View andNext View tools on the status bar to undo and redo your design view changes.
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2: File Operations

This section contains the following topics:

2.1. Creating, Opening, and Saving Documents
When you create a new design, it appears on a tab in the workspace. Designs can contain drawing sheets, multiple
windows, and 3D markups. Each drawing sheet and 3D markup appears on its own tab in the workspace. You can
edit your design directly using the drawing sheet.

You can create a drawing sheet for an existing design, or you can begin with an empty drawing sheet

Click a tab at the bottom of the SpaceClaim application window to display that design, drawing sheet, or 3D markup
document, or click the arrow icons to cycle between them. Click the x button to close the tab.

You can also backup your files, and archive them.

Creating a New Design
Select New > Design from the File menu.

Creating a New Drawing Sheet for the Active Design
• SelectNew>DrawingSheet from the File menu to create a drawing sheet with three standard views of the design.
• Select New > Empty Drawing Sheet to create a drawing sheet without a format or views.
• If these menu options are disabled, create a new design.

Creating a New Design and Associated Drawing Sheet
Select New > Design and Drawing Sheet from the File menu to create a new design and an associated drawing
sheet.

Opening an Existing Design, Drawsing Sheet, or 3D Markup Document
• Select Open from the File menu. You can open the Preview pane in the Open dialog to preview the files. Select

the file to open.
• The design and its windows, drawing sheets, and 3D markups open.
• You can Ctrl+click or Shift+click to open multiple files at once. Mouse over a recent file to see an image of the

design and the full path to the file.

Opening an Existing Design by Dragging and Dropping
• Drag the .scdoc file icon to anywhere in the title bar and ribbon area.
• You can also drag the icon into the design window if no design tab is open.
• This will open the design in 3D mode along with all of its drawing sheets, annotations, etc.
• You can drag-and-drop .scdoc files and any other importable files attached to emails in Microsoft Outlook.
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Inserting a Design by Dragging and Dropping
• Drag the .scdoc file icon into the design window.
• This will insert the design into the active window in 3D mode. Drawing sheets, annotations, etc. are not inserted.

Saving a Design
• Select Save from the File menu.
• If you imported or opened non-SpaceClaim designs as multiple external documents, click References to specify

where the documents are saved.
• Otherwise, opened design documents are stored in their original locations as .scdoc files, and inserted documents

are saved in the same directory as your design.

Saving a Design and Using It as a Template
1. Create some geometry (or set some parameters) you wish to use as a template for new designs
2. Save the document as a SpaceClaim Template File (*.scdot)
3. Go to the Support Files section of the SC options
4. Check ON the Use template for new designs box
5. Click the Browse button and choose an .scdot file, then click the Open button
6. Click the OK button
7. Begin a New design. A new design opens with the geometry which was created in the Template document

Copying a Design
1. Save any changes made to external components.

2. Select Save As from the File menu and specify a new name for the design.

3. Click Save to save your active design with a new name and/or format.

If the design contains external components, a dialog box appears with options for overwriting modified external
components.

4. If the design contains external components, select one of the following options:

• Save every external document as a new version - Saves all external documents regardless of their modified
status. For multi-level external components, all levels of the component will be saved as new versions.

• Saveonlymodified external documents as newversions - Saves only the modified external documents. For
multi-level external components, all levels of the component will be saved as new versions.

• Overwrite anymodified external documents - Saves only the modified external documents by overwriting
the existing files. For multi-level external components, the files for all levels of the modified component will
be overwritten.

To make a copy of a design and all its references for sharing or archiving, click Send.

Archiving a Design
• Select Share from the File menu.
• Select As file. The Archive dialog box opens.
• When you archive a model, it stores the .scdoc file and the .zip file in a file folder named with the file naming

convention <model name>_archive.
• This feature allows for improved file organization and use of file storage space.
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Sending a Design
• Select Share from the File menu.
• Select As Outlook attachment.
• The Send In Outlook dialog box opens.
• Specify recipients and add any message text.
• Click OK.

Saving a Version of Your Design
Select Save as > New version from the File menu.

Saving a version allows you to create 3D markups.

Saving a Design as Another File Type
See Importing and exporting for details.

Closing a Design
Make sure its window is active in the workspace, then do one of the following:

• Select Close from the File menu.

• Right-click the Design window tab and select Close.

• Click the x (Close) button on the Design window tab bar (at the bottom of the application window).

• Click the x at the upper right of the Design window if you have undocked it.

• Click thexat the upper right of a document tab. Thexdisplays after the design or drawing sheet name. A thumbnail
of your design displays when you hover over the name of your design, as shown below. A Save prompt displays
if you have made changes to your design. Select Yes to save your changes and close the design,No to discard your
changes and close the design, or Cancel to stop the close process and return to your design.

Modifying Design Properties
• Document properties are displayed when you select the top-level design in the Structure tree.
• Click in any property value to change it
• There is a Locked property that, when set to True, prevents the file from being modified.
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Adding Custom Properties
• Right-click in the Properties panel and select Add Property to create a custom property.
• Expand the property to display its value.
• Enter a name for the property, select its type (date, Boolean, number, or string), and enter its value.

2.2. Importing and Exporting
Use the Open command to open files created in any supported format. Use the Save As command to export parts,
assemblies, drawing sheets, and 3D markups to formats read by other applications. Your license type determines
which of these actions are supported.

If you work frequently with non-SpaceClaim files, you should set your file options to optimize the importing and
exporting process for your needs.

Object IDs for edges, faces, and bodies are now stored within the .scdoc file. Object IDs are preserved when other
files are opened or inserted into, and the IDs can also be exported. For example, if you export a design to an analysis
company, and they tag geometry with load positions, boundary conditions, and so on, then when you re-import
that design, make changes, and re-export to the analysis company, they will not need to recreate their tags on the
new design.

If you import a file and it fails, the reason for the failure is reported in the Status Log on the lower right edge of the
window.

Importing a Design
1. Select Open from the File menu or click

in the Quick Access toolbar. You can also insert into an existing design using the File tool in the Part group on
the Assembly tab.

Depending on the selected file type, additional elements appear in the Open window. For descriptions of these
options or to set their default values, click Options.

2. SelectCheckGeometry to run the geometry check after the file is opened or imported. See Checking geometry.

3. Navigate to and select the file you want to open or insert.

If you are opening a file, it is displayed in a new Design window. If you are inserting a file, it appears as an external
component in the active design.

If there is an invalid character in the path of a file you are trying to open or insert, that character is replaced with
a valid character to avoid errors.

If you open an Inventor, Creo Parametric, or Unigraphics file that has missing components, SpaceClaim will
prompt you to locate the missing files.

Click Stop in the status bar to cancel an import while it is in progress.

The name of the imported file is displayed in the Status Log when it is successful.

Expand the sections below for information about a specific file format.

Exporting a Design or 3D Markup
1. Select Save as from the File menu.

You can also press F12 or Ctrl+Shift+S.
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Save your design as a document before you can export it in another format.

2. Select a file type from the Save as type drop-down.

3. Depending on the selected file type, additional options appear in the Save As window:

• Save as copy if you want to save copies of external components referenced by the design with new names or
replace external components with other external components. You must click Resources to do this.

• References to display all the external components referenced by the file. Select one or more external
components and click Browse to rename or replace the components.

• Override Units is available when you export some file types. Select the units from the list.

• Options to also set your default export options for the selected file type.

• Improve data on export to clean up imprinted edges and split curves when you export data.

• Units Depends on file type

• View Choose a standard view

• Version Depends on file type

• Export part manufacturing information (JT)

• Use Perspective Camera for KeyShot

• Store 3D data as: For PDF, choose either Geometry (PRC B-Rep) or Facets only (Universal 3D)

• Convert components to Rhino layers

• Protocol: For STEP files, this can be 203, 214, or 242.

• Image size (pixels): For Bitmap, GIF, JPEG, PNG, TIFF files, opens Image Size dialog

Hidden lines are exported with the default line weight. Components maintain their mirror relationships when
they are exported.

For CATIA, Parasolid, STL, and STEP files, you can select which version or protocol to save as. You can also set
your default export options by clicking Options.

You can save documents that only contain sketch curves to ACIS binary (.sab), ACIS text (.sat), Parasolid, CATIA,
IGES, STEP, and VDA formats. You can import and export free points for Rhino, PDF, ACIS, IGES, JT Open, Parasolid,
STEP and VDA formats.

Imported designs with identical file names are given unique file names when you save your design. For example,
if you imported name.prt and name.asm, these files are saved as name.scdoc and name2.scdoc.

Expand the sections below for information about a specific file format.

4. Browse to a folder and type a file name in the dialog.

5. Click Save.

Note: Import and Export are separate operations, and not symmetric (that is, one is not the opposite of the
other). Therefore, exporting an scdoc to another format and then importing back into SpaceClaim presents
a small risk of losing some data.
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Importing: Supported File Types

Discovery
.dsco

Note:

• The Discovery files are imported using a translator. A full data match may not be guaranteed in all cases
as some data may not be transferred during import.

• If the model contains simulation data from Discovery, the Physics objects and existing simulation data
will be removed and will be lost when the model is saved.

ACIS
Up to 2021 1.0

3D - parts, assemblies

.sat, .sab, .asat, .asab

• When you save an SAT file to an X_T file, bad edges are cleaned up in the design.

• When you import ACIS files, the instance name "part n (body m)" is now imported, but only if the body name is
different from the part name. The component and body names are separated by a character which you can define
in the options for ACIS files. For example, the default character is a period, so the imported name would be
component.body. This way, if there were one body named wheel in one component, the name of the imported
component in SC would be wheel. An instance is a copy of a body (a copied or pattered solid).

• ACIS bodies can be imported using the RealDWG option, Sketch curves and text can be imported into Designs, 2D
entities can be inserted to Drawing Formats

• Part and Assembly level PMI can be imported from ACIS.

Acrobat 3D PDF
Facets, 3D - parts, assemblies, Geometry (PRC B-Rep)

.pdf

• 32-bit and 64-bit platforms are supported.
• Color information is imported for 3D PDFs.
• Supports B-REP import and export without Adobe Acrobat
• Defaults to B-Rep when exporting
• Importing PMI as graphical objects - not semantic - is supported.

º Notes
º Dimensions
º Geometric Tolerances
º Surface Finishes
º Datum Symbols
º Datum Targets

• Adobe Acrobat X Pro is not supported
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• 3D PDF via a PRC neutral file along with Semantic PMI (if PMI data is present)
• Curves are imported from faceted data.
• SCDM optional module for 3D PDF is available.

AMF
V1.0 (Facets)

3D - parts, assemblies

.amf

• Import also supports compressed AMF.

• You can stop AMF import using the Stop button when image processing takes too long.

• Body names and colors are supported.

Ansys DesignModeler
parts, assemblies

.agdb

(Ansys SCDM only) Up to 16

• Assemblies are flattened
• Ansys DesignModeler software must be installed locally

Ansys Electronics Database
3D - parts, assemblies

.def

AutoCAD®
R12 to 14, 2000, 2004, 2007, 2010, 2013, 2016, 2018, 2021

Includes Polyface Meshes

.dwg, .dxf

• AutoCAD drawings can be inserted as layouts.

• If you import an AutoCAD file and you don't see the geometry you expect, try changing the import options. See
File import and export options.

• You can import polyface meshes from AutoCAD files as 3D solids. See File import and export options for a list of
polyface mesh import options.

• You can import "Proxy entities" in AutoCAD DXF and DWG files when you select the TeighaDWG option.

• If an AutoCAD file does not open, try changing the DWG option to RealDWG. Some AutoCAD files contain embedded
ACIS models, however, these may not be standard ACIS models. The RealDWG libraries contain an API to save
back these variant ACIS models in the last common format, ACIS v7. The TeighaDWG libraries do not.

• ACIS bodies can be imported using the RealDWG option, Layout space entities can be imported using the Teigha
option, Sketch curves and text can be imported into Designs, 2D entities can be inserted to Drawing Formats,
Polyface meshes import as lightweight (read-only).
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• Layout Spaces are imported into separate windows.

• Empty Layout Spaces are ignored on import.

• Layout Spaces are only supported for Teigha, not RealDWG.

• Body Arrays: Geometry created using the AutoCAD "Array" command will not automatically be imported into
Ansys Workbench. To import the bodies in the array, do the following:

º Load the drawing file into AutoCAD

º Select the array

º Issue the "Explode" command

CATIA V4®
versions V4 4.1.9 to 4.2.4

parts, assemblies

.model, .CATPart, .CATProduct, .cgr, .exp

• CATIA faceted (.cgr) files can be opened, but appear as lightweight components that cannot be loaded. You can
save imported .cgr files as documents that can be opened later. However, this document's content remains
lightweight. It is visible in the Design window but you can't change the model.

• Part-level PMI
• CATIA files with product manufacturing information (PMI) can be opened or inserted. Visibility is turned off. If a

layer doesn't exist, it is created automatically.

• Includes Product Manufacturing Information (PMI) placed on the Imported Annotation Planes.

• Import and export of free points is supported
• CGR imports Facets as mesh objects. SpaceClaim recommends editing meshes on a 64bit OS.
• Named selections of faces are created when importing geometrical sets.
• Publication Sets are imported as named selections.

CATIA V5®
versions V5 R8 to R25, V5-6 R2022

assemblies

.model, .CATPart, .CATProduct, .cgr, .exp

• CATIA faceted (.cgr) files can be opened, but appear as lightweight components that cannot be loaded. You can
save imported .cgr files as documents that can be opened later. However, this document's content remains
lightweight. It is visible in the Design window but you can't change the model.

• Part-level PMI
• CATIA files with product manufacturing information (PMI) can be opened or inserted. Visibility is turned off. If a

layer doesn't exist, it is created automatically.

• When exporting CATIA V5 files, you can deselect the Simplify Spline Surface Data option. When importing or
exporting CATIA files, the XYZ locations of point objects scale correctly.

• Includes Product Manufacturing Information (PMI) placed on the Imported Annotation Planes.

• Import and export of free points is supported
• CGR imports Facets as mesh objects. SpaceClaim recommends editing meshes on a 64bit OS.
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• Named selections of faces are created when importing geometrical sets.
• Publication Sets are imported as named selections.
• SCDM optional module for CATIA V5/V6 is available.

CATIA V6®
R2010x - R2017x

parts, assemblies

.3DXML

• CATIA faceted (.cgr) files can be opened, but appear as lightweight components that cannot be loaded. You can
save imported .cgr files as documents that can be opened later. However, this document's content remains
lightweight. It is visible in the Design window but you can't change the model.

• CATIA files with product manufacturing information (PMI) can be opened or inserted. Visibility is turned off. If a
layer doesn't exist, it is created automatically.

• Includes Product Manufacturing Information (PMI) placed on the Imported Annotation Planes.

• Part-level PMI
• CATIA V6 precise part and product data must be exported as V5CATPart and CATProduct to be read into SpaceClaim.
• Import and export of free points is supported
• Named selections of faces are created when importing geometrical sets.
• Publication Sets are imported as named selections.
• For 3DXML, SCDM optional module for CATIA V5/V6 is available.

Creo Elements/Direct Modeling
(Ansys SCDM only) V18.1 and V19, 20.3

• Creo Elements/CoCreate software must be installed locally
• Only part level coordinate systems import if Import hidden components and geometry is checked ON in

SpaceClaim General File options and Coordinate systems is also checked ON.

Creo Parametric®
Pro/E16 through Wildfire 5.0 (Creo 1.0 to Creo 8.0)

parts, assemblies

.prt, .asm, .xpr, .xas

• When you import Creo Parametric assemblies and parts are missing, SpaceClaim will prompt you to search for
the missing files

• For Creo Parametric, Pro/E semantic PMI import is supported.
• For Wildfire 3 and above, PMI display information import is partially supported.

• Wildfire 5 (Creo 1.0, 2.0) PMI is not supported
• Instance and assembly accelerator files (*.xpr and *.xas) can now be opened directly into SpaceClaim.

• Mesh is automatically imported when there are no B-Rep contents in the Rhino file.
• Only part level coordinate systems import if Import hidden components and geometry is checked ON in

SpaceClaim General File options and Coordinate systems is also checked ON.

ECAD IDF, IDB, EMN
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IDF 3.0 and IDF 4.0

open IDF and PADS files

.idf, emn, .idb

• Most content within IDF 4.0 files is supported.

• Assembly of panels and boards, cutouts, filled areas, keep-ins, materials, panels and everything related, sublayouts,
and thermal models are not supported.

• Open IDF and PAD files

• IDF files can be synchronized with the imported model.

º Select any geometry in the model and use RMB > Update IDF to update the IDF file based on component
operations performed in the model (for example, moved components).

º The current SpaceClaim document must have been created by importing an IDF file.
º The source IDF file must be present on disk at its original location.
º A new IDF file is written that contains the updated information.
º The new file can be read back into the originating ECAD system to update the components.

ECAD (Other)
• ODB++

º The translator does not support multi-step files.
º ODB++ is designed for manufacturing formats that can support everything from a single image to an entire

fabrication panel. For the electronics tools, ODB++ is used as a means of translation for a single board, and the
associated translator does not support import of an entire panel.

º ODB++ export is available in most 3rd-party layout tools. Generally, you can select a single step export during
the export process.

º Quality and adherence to the formal ODB++ specification varies among vendors. A verbose translation log can
be found in the Temp directory. Warnings and errors are not posted to the SpaceClaim interface.

º Depending on the 3rd-party layout tool, ODB++ may not be the best choice.

• .tgz

• EDB

.def in a .aedb folder

• IPC2581

.xml, .cvg

• GDSII

.gds, .sf, .strm

º GDSII files are imported through the GDSII import window. This window lists layers in the design and allows
you to designate a control file.

º You can import information from an XML control file or a layer mapping file (*.tech, *.layermap). Click Import
stackup... and select the control file in the dialog box.

The format of the file is shown in the example.
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<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<c:Control xmlns:c="http://www.ansys.com/control" schemaVersion="1.0">
<Stackup schemaVersion="1.0">

<Materials>
<Material Name="FR4_epoxy">
<Permittivity>
<Double>4.4</Double>

</Permittivity>
<Permeability>
<Double>1</Double>

</Permeability>
<Conductivity>
<Double>0</Double>

</Conductivity>
<DielectricLossTangent>
<Double>0.02</Double>

</DielectricLossTangent>
</Material>
<Material Name="air">
<Permittivity>
<Double>1.0006</Double>

</Permittivity>
<Permeability>
<Double>1.0000004</Double>

</Permeability>
<Conductivity>
<Double>0</Double>

</Conductivity>
<DielectricLossTangent>
<Double>0</Double>

</DielectricLossTangent>
<MagneticLossTangent>
<Double>0</Double>

</MagneticLossTangent>
</Material>
<Material Name="copper">
<Permittivity>
<Double>1</Double>

</Permittivity>
<Permeability>
<Double>0.999991</Double>

</Permeability>
<Conductivity>
<Double>58000000</Double>

</Conductivity>
</Material>

</Materials>

<ELayers LengthUnit="mm">
<Dielectrics>

<Layer Color="#008000" Material="FR4_epoxy" Name="Dielectric"
Thickness="10"/>

</Dielectrics>
<Layers>

<Layer Color="#004080" Elevation="5" Material="copper" Name="bottom"
Thickness="5" Type="conductor"/>

<Layer Color="#008000" Elevation="0" Material="copper" Name="top"
Thickness="5" Type="conductor"/>

</Layers>
</ELayers>
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</Stackup>
</c:Control>

For additional details, refer to the Ansys Electronics Desktop Help.

Fluent Mesh
facets/mesh

.msh, .tgz

• Only surface/boundary mesh gets imported as a single faceted body.
• The mesh units are assumed to be Meters.
• Groups are auto-created per face zone in the mesh file on import into SpaceClaim.

glTF
Not supported

ICEM CFD
geometry

.tin

• Turn the Object names option ON in SpaceClaim Options > General file options to import ICEM CFD Part names.
With an Ansys license, Part names are always imported even if the Object names option is OFF.

• ICEM CFD Parts come in as separate bodies in SpaceClaim.
• With the Improve importeddata optionON, the imported model may result in a formation of solid bodies and/or

a Part structure different from what appears in ICEM CFD.
• Models containing faceted curves or surfaces are NOT supported.
• If a tetin file contains edges attached to faces and the edges and faces are in different ICEM CFD parts, the ICEM

CFD part name for the edges will be lost as the edges are put in the part containing the faces.
• You can adjust values and re-run build topology in ICEM CFD to improve the success of the import.
• With the Import faces independently option ON, ICEM CFD Parts will be imported as individual surface bodies.

This allows users to ignore topology information on import so they can stitch the faces together after import into
SpaceClaim. However, if Improve importeddata is alsoON, along with Import faces independently, the surfaces
will be stitched together as a part of the improved operation, which may result in the formation of solid bodies.

• Named-selections/Groups per ICEM CFD Part names are auto-created on import of ICEM CFD geometry model.

IGES
versions up to 5.3

parts, assemblies

.igs, .iges

Curves and Curve Colors are supported on import.

Image Files
files (insert only)

.bmp, .pcx, .gif, .jpg, .png, .tif

87Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

File Operations



See Inserting an image

Inventor®
versions V6 - 2022, V11 to 2022

parts, assemblies

.ipt, .iam

• You can read the limitations here:
http://doc.spatial.com/index.php/InterOp:Connect/Inventor/Inventor_Reader#Limitations.

• Limited support for Inventor assembly

º Assembly attributes such as colors and layers are not supported.

º Inventor parts and Inventor sub-assemblies should be present in the main (root) of the Inventor Assembly
directory.

º Assembly level features are not supported. For example, an instance can be marked as suppressed (that is, not
visible) in an Inventor assembly. Because the translator does not support reading suppressed information,
suppressed instances are translated.

• Inventor surfaces not supported

The translator currently does not handle "helical" surfaces in Inventor 6 files and "cylspl" surfaces in Inventor 7
files. If the Inventor file contains any of these surfaces, a partial translation takes place skipping the data for these
surfaces and converting the remaining entities.

• Limited entity support for Inventor 11, 2008, 2009, and 2010

The translator currently does not support some specific entities resulting from advanced feature Inventor operations
such as Lofting.

• No support for attributes

The translator does not support translating attributes such as colors and layers.

• No support for hidden flag

The translator does not support filtering hidden bodies. Thus, all hidden bodies are translated as well.

• Limited support for units

The translator supports only millimeter and inch for Inventor 6 - 11 and 2008. For versions 2009 and 2010, the
translator supports only millimeter as unit. All unsupported units are assumed to be millimeter.

JT Open
versions 6.4, 7.0, 8.0, 8.1, 8.2, 9.0 to 10.6

parts, assemblies

.jt

• JT Open 5.3 libraries are available for reading and writing JT files that were created with version 5.3.
• JT files with product manufacturing information (PMI) are supported for:

º datum labels
º text notes
º dimension measurements
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º GD&T
º Surface finish symbols
º Weld symbols
º Flagnotes

• PMI option is ON by default (Part level PMI)
• PMI is placed on imported annotation planes
• Semantic and Polyline PMI are supported. Semantic imported dimensions will update with geometry changes.

Polyline are simply curves in space that do not update.
• Semantic PMI is placed on Layer0 after import. Polyline is placed on a layer called Imported Polyline Annotations.
• For GD&T symbols, you can click any tolerance annotation or datum symbol to view its values in the Properties

panel.
• Click an arrow or line to view or modify arrow or styles in the Properties panel.
• Unicode file names are supported.
• Import and export of free points is supported
• JT Open V6.4 and V7.0 imported and exported as faceted data
• SCDM optional module for JT Open is available

Keyshot
Not supported

NX
NX1 through NX12 and UG v11 through 18, 1872, 1899, 1926, 1980

parts, assemblies

.prt

• Includes PMI placed on imported annotation planes.

• PMI import and export is supported

OpenVDB
.vdb

Parasolid®
V10.0 through V34

parts, assemblies

.x_t, .x_b, .xmt_txt, .xmt_bin

Plmxml Format (*.plmxml) from Siemens
• PlmXml assemblies with JT part / JT subassembly nodes
• PlmXml assemblies with non-JT (for example, CATIA or STEP) sub assembly nodes

Ply
V1.0

parts

89Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

File Operations



.ply

Point Curve Text
curves (insert only)

.txt

• A spline curve is created by default or if the option Polyline=False is used. If the option Polyline=True
is used, then the points are connected by straight line segments.

• By default, 2D curves are created. When specifying 2D curves, the first column of the data points must be an integer
and gives the height of the plane of one of the curves. The beginning of a new curve is specified by changing this
height from one line to the next. If option 3D=True is used, the curves can be 3D

• Use the Fit keyword to specify whether Curve Fitting or Interpolation is used.

Fit=Trueuses Curve Fitting. Curve Fitting creates a curve that "Fits" the data points using a specified tolerance.
The curve may not pass exactly through all points and the distance from the curve to the point will be within the
tolerance.

Use the Fittol keyword when Fit=Trueto specify the Curve Fitting tolerance in model units. For example
Fittol=1.0e-2

The curve below uses Curve Fitting (that is, Fit=true). A large tolerance (fittol=2.0) is used to exaggerate the fact
that the curve does not pass through the points but only gets within the specified tolerance.

Fit=False uses Interpolation. Interpolation requires that the curve pass exactly through all of the points. An
interpolation method is used to build a continuous curve through all of the points.

The curve below is interpolated (that is, Fit=False). There are seven points in the file and the curve passes
exactly through each one.
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• Multiple curves are separated by blank lines.

• You can import point curve text files that contain single-point curves, which will be created as points.

• Point-curve text files opened or inserted in display a closed curve when the file has a repeated value.

• Curves can be imported to coordinate systems or other geometry like other imported objects.

• Point-curve text files with columns separated by commas can be opened or inserted. This feature allows you to
import any comma-separated value file into .

• If there is an error reading the input text file, a message will appear with the line number of the error in parentheses
followed by the text appearing on that line.

• The following example shows the contents of a point curve text file on the left and the 3D curves it creates on the
right:

º Note that the point coordinates are (Z, X, Y).

º For example (1, 2, 3) is (Z=1, X=2, Y=3).

3d=true

polyline=false

1 0 0

1 0 1

1 1 0

1 1 1

2 0 1

2 1 0

3 0 0

3 0 1

3 1 0

Keywords:

• polyline=false - spline curves are created.
• polyline=true - straight lines are created.
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• 3d=true - 3D curves are created.
• 3d=false - curves are two-dimensional. This is also the case if the option is not set.
• fit=true - use Curve Fitting.

º Curve Fitting finds the "Best Fit" through the points.
º Does not require the curve to pass through all of the points

• fit=false - use Interpolation.

º Interpolation forces the curve to pass through all the points in the file.

• fittol=1.0e-2 - Curve Fitting tolerance in the units used in the file.

The blank line after the first set of coordinates indicates that the next set of coordinates is a new curve.

You can copy the file contents above and paste them into a text file, then use

Insert File to try it yourself.

POV-Ray
Not supported

Microsoft® PowerPoint®
Not supported

QIF
V2.0

parts, assemblies

PMI import and export supported

Revit
V2020, V2021, V2022

.rvt, .rfa

Rhino®
version 4.0, V5.0, V6.0, V7.0

parts, assemblies

.3dm

• When importing a Rhino file, multi-segmented curves are consolidated.

• You can export layer names, color information, sketch lines, and material information.

• Neighboring topology is taken into consideration by default. This means that if problems are found with a face,
then its neighboring faces can provide information used to fix the face.

• The SpaceClaim plugin for Rhino is only supported for Rhino V5.0.

entityRhino objectSupported Rhino Object
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Solid bodyClosed polysurfacesSolids

Closed surfaces: sphere, torus,
ellipsoid dots;

Sheet bodyPolysurfaces (open)

Sheet bodyTrimmed surfacesSurfaces

Untrimmed surfaces with boundary
edges

Named sketch curveCurves (curve, polycurve)

Not supportedPoint objects (point, point cloud)

Not supportedPolygon mesh objects

Entity nameObject name

Entity colorObject color

Layer nameLayer nameLayers

Layer colorLayer color

Show/hide layerOn/off layer

Locked/unlocked layerLocked/unlocked layer

Component structureLayer structure

Material nameMaterial nameMaterials

Not supportedOther material attributes

Not supportedGroups

RS Components
V2015.0 SP0

parts, assemblies

.rsdoc

rsdocs can only be imported for the first 30 days after SpaceClaim activation. After 30 days, a limit of 100 individual
file imports is enforced.

SketchUp®
Up to SketchUp 8, V2013, V2014, V2018, V2019, V2020, V2021

parts, assemblies

.skp

SolidEdge
V18 - 2022

parts, assemblies

.par, psm, .asm
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SOLIDWORKS®
SW 98 through SW 2022

parts, assemblies

.sldprt, .sldasm

• If you open a SOLIDWORKS file, searches for required assembly and external part files in the following locations:

º Root folder of the assembly

º Equivalent subfolder in new root folder

º Absolute path to the component saved in the assembly file

• When you import a design from SOLIDWORKS, the units are changed to match the part.

• Import supports User Defined Attributes for Parts, Assemblies, and Sub-assemblies.
• SpaceClaim supports selective imports from SOLIDWORKS assemblies:

º When opening the file:

Select "SOLIDWORKS" file type.
Check the "Expand Assemblies" in the file open dialog.
Select the ".sldasm" file for your configuration.

Select the configuration or sub-assembly to load from the Assembly Browser dialog and click Open.

STEP
AP203, AP214, AP242 (geometry)

parts, assemblies

.stp, .step

When you import STEP assemblies from one file, select theCreatemultipledocumentswhen importingassemblies
file option if you want the assemblies to remain in one file instead of being split into multiple files, one for each
internal component.

• Origin import and export is supported
• PMI import is supported
• License is required

STL
Facets or Solids

parts, assemblies

.stl

• When exporting STL files, the output is set to Binary by default.

• STL files can include polyface meshes, and they can be imported as lightweight objects. Polyface meshes are
imported as solids.

• When saving as an .STL file, the quality is based your graphics quality setting. You should set the option to enable
the highest possible graphics quality if you want your design to be useful as an SLA rapid prototype for form, fit,
and function purposes.
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• You can import an STL file as a solid, if it has multiple planar areas that can be merged into one planar face.

• You can import an STL file as a Mesh object and export it as another STL file. This makes it possible to import
multiple STL files into a document and then export everything as a single STL file.

VDA-FS
version 1.0 and 2.0

parts

.vda

Video files
files (insert only) with proper codec(s) required for all but WMV and AVI

.wmv, .avi, .flv, .mkv, .mov, .mp4, .mpg, mpeg, .ogm, .vob

See Inserting a video

VRML
Facets

parts, assemblies

.wrl

Non-triangular faces are supported.

Wavefront
Facets

parts, assemblies

.obj

XAML
Not supported

XPS
Not supported

Exporting: Supported File Formats

ACIS
Versions 6, 7, 15-31, 2021 1.0 (V27 default)

parts and assemblies (assemblies are flattened)

.sat, .sab

• When you save an SAT file to an X_T file, bad edges are cleaned up in the design.
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• When you import ACIS files, the instance name "part n (body m)" is now imported, but only if the body name is
different from the part name. The component and body names are separated by a character which you can define
in the options for ACIS files. For example, the default character is a period, so the imported name would be
component.body. This way, if there were one body named wheel in one component, the name of the imported
component in SC would be wheel. An instance is a copy of a body (a copied or pattered solid).

• ACIS bodies can be imported using the RealDWG option, Sketch curves and text can be imported into Designs, 2D.

• Part and Assembly level PMI can be written to SAT and SAB files.
• Material assignments can be written to SAT and SAB files.

Acrobat PDF 3D
Facets, Geometry (PRC B-Rep), curves

parts and assemblies

.pdf

• 32-bit and 64-bit platforms are supported.
• Color information is exported for 3D PDFs.
• Supports B-Rep import and export
• Mesh-only .scdoc's can be exported to PDF.
• No Adobe Acrobat required for B-Rep import and export, 32bit and 64bit platforms supported, Adobe Acrobat X

Pro is not supported
• SCDM optional module for 3D PDF is available

Acrobat PDF 2D
2D Print to or save drawings only

.pdf

32-bit and 64-bit platforms are supported.

AMF
V1.0

3D - parts, assemblies

.amf

• Export also supports compressed AMF

• The following are supported for export:

º Geometry

º Body and face colors

º Body material

º Textures

º Lightweight components

º Assembly structure tree

• Export is supported by the Converter.

96Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

File Operations



Ansys Neutral Format
.anf

License is required

Ansys Mesh Modeler
.amm

Ansys
.inp, .dat

AutoCAD
R12 to 14, 2000, 2004, 2007, 2010, 2013, 2018

Export as 2D snapshot and AutoCAD Solids (ACIS V7 format)

.dwg, .dxf

• When you save a design with a shaded graphics style as a DWG file, it is converted to the hidden line style.

• When you save a sheet metal design as a DXF file, notes and bend lines are saved on the same layer, and the overall
unfold dimensions are removed.

• Line weights can be exported to AutoCAD (DXF or DWG). Hatch lines on drawing sheets are exported as stand-alone
lines.

• Export as 2D snapshot

CATIA
V5/V6 R15 to V5-6 R2022 (R25 default)

parts, assemblies

.CATPart, .CATProduct,

• CATIA faceted (.cgr) files can be opened, but appear as lightweight components that cannot be loaded. You can
save imported .cgr files as documents that can be opened later. However, this document's content remains
lightweight. It is visible in the Design window but you can't change the model.

• CATIA files with product manufacturing information (PMI) can be opened or inserted. Visibility is turned off. If a
layer doesn't exist, it is created automatically.

• When exporting CATIA V5 files, you can deselect the Simplify Spline Surface Data option. When importing or
exporting CATIA files, the XYZ locations of point objects scale correctly.

• Includes Product Manufacturing Information (PMI) placed on the Imported Annotation Planes

• CATIA V6 precise part and product data must be exported as V5CATPart and CATProduct to be read into SpaceClaim
• Export as Hybrid Design is supported
• SCDM optional module Catia V5/V6 is available

CGNS
.cgns
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Creo Parametric
Not supported

Excel
MS Office 2003, 2007, 2013

.xls, .xlsx

• If MS Office is installed
• Table export: Web page (.htm, .html), XML document (.xml), CSV file (.csv)

ECAD IDF
Not supported

Fluent Mesh
Meshes generated using the options in the Mesh tab.

.msh

• Exports the Blocking mesh to Fluent.

• You can choose to export one .msh file for the entire design or one .msh file per component (blocking object) in
the Structure tree.

Fluent-Meshing Faceted Geometry
parts, assemblies, facets and/or solids

.tgf

• Faceted bodies as well as solid and surface bodies are supported.
• The Improve data on export option in SpaceClaim Options > General file options is ignored for .tgf export.
• Invisible bodies and components are not exported unless the Export hidden components and geometry option

is turned ON in SpaceClaim Options > General file options.
• Model units are preserved on export.
• In SpaceClaim Options > TGF file options, Object is set to Per body by default. This will create a Fluent-Meshing

Object for each body in the exported model.
• Fluent-Meshing Objects are always created of type Geometry.
• Groups or Named Selections are exported as Fluent-Meshing Face Zone Labels.
• Since the aspect ratio is defined in the parametric (u,v) space of a surface, it is recommended NOT to define this

parameter unless it can be ensured that all surfaces are arc-length parameterized.

Important: It is a uv-grid aspect ratio and that does NOT guarantee the aspect ratio of resultant facets.

FM Database
Geometry transferred to Fluent Meshing (for input to the Fault Tolerant Workflow)

.fmd

glTF
parts, assemblies
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.glb

• Binary glTF (GL Transmission Format) for scene graphics export.
• Supported features include solid bodies, surface bodies, faceted bodies, lightweight components, and curves.
• Includes graphics information such as body and face color, body finish (High/Medium/Low Gloss), and camera

position.
• Known limitations include faces with texture or hatched, brushed, and metallic render styles.
• Use caution with proprietary models since the data is copied to web location.

ICEM CFD
Meshes generated using the options in the Mesh tab.

.uns

You can choose to export one .uns file Per design (default) or one file Per component (blocking object) in the
Structure tree.

IGES
V5.3, JAMA-IS, Types: 186, 144, 143

parts, assemblies

.igs, .iges

Image Files
parts, assemblies, drawing sheets, 3D markup slides (export as 2D snapshot)

.bmp, .gif, .jpg, .png, .tif

On export, you can specify the image size in pixels or percent of full size.

When saving a drawing as an image you can specifyUseSceneextentsorUseSheetextents. Scene extents includes
gray borders around the drawing to fill the size of the entire scene. Sheet extents only includes what is within the
sheet boundary.

See Inserting an image

Inventor
Not supported

JT Open
V6.4, 7.0, 8.0, 8.1, 8.2, 9.0 to 10.6

parts, assemblies

.jt

• JT Open 5.3 libraries are available for reading and writing JT files that were created with version 5.3.
• JT files with product manufacturing information (PMI) are supported for:

º datum labels
º text notes
º dimension measurements
º GD&T
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º Surface finish symbols
º Weld symbols
º Flagnotes

• PMI option is ON by default (part level PMI)
• Semantic and Polyline PMI are supported. Semantic imported dimensions will update with geometry changes.

Polyline are simply curves in space that do not update.
• Semantic PMI is placed on Layer0 after import. Polyline is placed on a layer called Imported Polyline Annotations.
• For GD&T symbols, you can click any tolerance annotation or datum symbol to view its values in the Properties

panel.
• Click an arrow or line to view or modify arrow or styles in the Properties panel.
• Unicode file names are supported.
• Semantic GD&T created in is exported to JT.
• Export and import of free points is supported
• JT Open V6.4 and V7.0 imported and exported as faceted data
• SCDM optional module for JT Open is available

LS-Dyna
.k

Keyshot
parts, assemblies V7

.bip

NX
Not supported

OpenVDB
.vdb

Parasolid
V12 through V34 (V27 default)

parts, assemblies

.x_t, .x_b

Plmxml Format (*.plmxml) from Siemens
JT Export options are used during PLMXML Export to JT from SpaceClaim. The Yes/No/Cancel message box is
suppressed during export through scjournal.

PLY
V1.0

parts

.ply
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Point Curve Text
Not supported

POV-Ray
3.6

parts, assemblies

Mesh-only .scdoc's can be exported to POV file format

Microsoft PowerPoint
MS Office 2003, 2007, 2013

3D markup slides .ppt

If MS Office is installed

QIF
V2.0

parts, assemblies

.qif

PMI import and export is supported

Rhino
V4.0, V5.0, V6.0

parts, assemblies

.3dm

• When importing a Rhino file, multi-segmented curves are consolidated.

• You can export layer names, color information, sketch lines, and material information.

• Neighboring topology is taken into consideration by default. This means that if problems are found with a face,
then its neighboring faces can provide information used to fix the face.

• The SpaceClaim plugin for Rhino is only supported for Rhino V5.0.

entityRhino objectSupported Rhino Object

Solid bodyClosed polysurfacesSolids

Closed surfaces: sphere, torus,
ellipsoid dots;

Sheet bodyPolysurfaces (open)

Sheet bodyTrimmed surfacesSurfaces

Untrimmed surfaces with boundary
edges

Named sketch curveCurves (curve, polycurve)

Not supportedPoint objects (point, point cloud)
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Not supportedPolygon mesh objects

Entity nameObject name

Entity colorObject color

Layer nameLayer nameLayers

Layer colorLayer color

Show/hide layerOn/off layer

Locked/unlocked layerLocked/unlocked layer

Component structureLayer structure

Material nameMaterial nameMaterials

Not supportedOther material attributes

Not supportedGroups

SketchUp
V3.0 to V8.0, V2013 to V2020

parts, assemblies SketchUp

.skp

SOLIDWORKS
Not supported

STEP
AP203, AP214, AP242 (geometry)

parts, assemblies

.stp, .step

When you import STEP assemblies from one file, select theCreatemultipledocumentswhen importingassemblies
file option if you want the assemblies to remain in one file instead of being split into multiple files, one for each
internal component.

STL
parts, assemblies

.stl

• When exporting STL files, the output is set to Binary by default.

• STL files can include polyface meshes, and they can be imported as lightweight objects. Polyface meshes are
imported as solids.

• When saving as an .STL file, the quality is based your graphics quality setting. You should set the option to enable
the highest possible graphics quality if you want your design to be useful as an SLA rapid prototype for form, fit,
and function purposes.

• You can import an STL file as a solid, if it has multiple planar areas that can be merged into one planar face.
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• You can import an STL file as a Mesh object and export it as another STL file. This makes it possible to import
multiple STL files into a document and then export everything as a single STL file.

• STL export can be performed directly from lightweight (visualization only) .scdoc

VDA-FS
V2.0

parts

.vda

VRML
Triangles

.wrl

Body and face colors

Video files
Not supported

Wavefront
Triangles

.obj

• Structure is not maintained when you save as an OBJ file.

• When you save your design as an OBJ file, the current graphics tessellation is used for accuracy. You can modify
the tessellation by setting the Image quality vs. graphics speed option.

• UV's are transformed according to a body or face and texture information is exported with the file.
• Body and face colors

XAML
part and assembly solids only

.xaml

The orientation and translation of the current view is saved in an XAML file.

XPS
3D markup slides

.xaml

Importing a Design by Dragging and Dropping
Drag the file icon to anywhere in the title bar and ribbon area. You can also drag the icon into the design window if
no design tab is open.

This will open the design and all of its drawing sheets, annotations, etc.
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You can also cut and paste data from certain applications. See Copying and pasting from other applications.

Exporting a Design as an Image
1. Select Save as from the File menu.

You can also press F12 or Ctrl+Shift+S.

Save your design as a document before you can export it in another format.

2. Select an image file type (GIF, JPG, PNG, or TIFF) from the Save as type list.

3. (Optional) Enable Transparent background to set the image background to be transparent when saving the
scene as an image (PNG, TIFF,etc.).

4. (Optional) Click Image size to change the size of the image.

5. Browse to a folder and type a file name in the dialog.

6. Click Save.

Copying the Contents of the Design Window toWindows Clipboard
Right-click in the Design window and select Copy Scene to copy an image of the contents of the Design window to
the Windows clipboard. You can then paste the image into a document.

Opening the Parent Document of a Design
Right-click the top level component in the Structure tree and select Open root part to open the parent document
of a design that was saved after its parent was closed. This problem may exist in files that were created with previous
versions of .

Examples

PMI information from a CATIA file
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Consolidated multi-segmented curves from a Rhino file

Converter Utility
The SpaceClaim Converter is a utility to translate between file formats supported by SpaceClaim. It is a separate
application, called ‘Converter.exe', located in the SpaceClaim installation folder.

The Converter is designed to allow you to convert many files from one format to another in a single operation. You
can specify files one-by-one and/or choose directories. All files to be converted must be of the same type.

Running the Converter
The Converter is located in the SpaceClaim installation directory. Simply double-click converter.exe to open
the Converter dialog.

Select the files you want to convert. All the files have to be the same format. Build your list using any combination
of the commands below.

• Add Files: Opens a dialog to browse to specific files to convert. All files must have the same format. Specify the
format by setting the Filter in the Open dialog.

• Add folder: Opens a dialog to browse to a directory containing files to convert. All files matching the File Filter on
the Options page will be added.

• Remove: Removes the currently highlighted file(s).

Once you have the list of files to convert, click the Convert button. As the conversion proceeds, you are given the
following feedback.

• The file currently being converted is highlighted in Yellow.
• Files that converted successfully are highlighted in Green.
• Files that could not be converted are highlighted in Red. If any file fails to convert, a copy of the file is written to

the Failures directory specified on the Options page.

Skip: Click this button to skip (do not convert) the current file.

Abort: Click this button to cancel the process.

Pause: Click this button to pause the process. When paused, the button switches to Resume.

Converter Options
You need to specify the output file type as well as some other directories used by the Converter. Frequently used
conversion settings can be saved and reused. When SpaceClaim is started from Converter, there is no longer a check
for updates in SpaceClaim when it starts.

The Converter options are described below.

• File Filter: When you specify a directory to convert, it may contain many different file types. Since all input files
must be the same type, the File Filter specifies which type to convert.

• Recurse directories: Check this option to include subdirectories.
• TimeOut: This is the maximum time allowed for the conversion. It will be aborted if it exceeds this time limit.
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• File Type: This is the output file format. All the input files will be converted to this format. Converted files are
written to the same directory as the input file.

• Failures Directory: Any files that fail to convert will be copied to this directory.
• Settings Directory: Converter settings can be saved to an XML file in this folder.
• SpaceClaim directory: This is the directory where SpaceClaim.exe is located. Normally this will be the same

directory containing Converter.exe.
• Output directory: The converted files will be saved to this directory.
• Email Recipient(s): The converter will send an email to the specified email addresses. You can select when you

want email sent with the following check boxes.

º Complete
º Errors

• Abort if failuresexceed: Check this box and enter a percentage of failures. The process aborts when the percentage
is exceeded.

• Start separate SpaceClaim for each design: A separate SpaceClaim instance is started for each design to avoid
memory exhaustion on large models. This sacrifices speed to save memory. The option is Off by default.

• Multiprocess: Multiprocessor support allows multiple SpaceClaim sessions to run in parallel to translate files.
This setting is defaulted to the number of cores available, based on your system and available memory, but you
can configure it. Be careful not to exceed the number of cores present, and to expect performance of other running
programs to degrade potentially.

There is a command line switch (for SpaceClaim) to check for add-ins

• CommandLineAddInsOnly will only load add-ins specified in the command line for SpaceClaim
• For example: /CommandLineAddInsOnly=true
• The switch is primarily intended for use with the Converter to limit the add-ins loaded
• The switch can be used to start SpaceClaim without looking for add-ins in the usual locations

2.3. Copying and Pasting fromOther Applications
You can copy from another application and paste into SpaceClaim. This is currently supported for Rhino and Moment
of Inspiration (MoI). Simply copy an object in Rhino or MoI, then open SpaceClaim and click Paste.

Objects are placed in their original position and will not be placed relative to selected objects in SpaceClaim.

Objects pasted from MoI do not have their units defined by default and could be scaled very differently when you
paste them into SpaceClaim. To change the units in MoI, click Options, then set the Unit System field.

2.4. Locking and Unlocking Objects
You can lock solids and surfaces so they cannot be changed. When an object is locked, you can only change that
object's visibility by clicking its check mark in the Structure tree. You cannot change the object's geometry, location,
name, color, or properties. Locked objects display a lock icon in the Structure tree, as shown in the image below.

• You can't modify locked bodies directly or by group modification, and the API cannot modify them via group
values.

• Locked bodies cannot be pulled or moved, so the Pull arrow or Move handle appears gray. They can be copied by
holding Ctrl with the Pull or Move tool. The Pull arrow or Move handle changes to color when you hold Ctrl.

• You can use a locked body as a cutter with the Combine tool, but you cannot use it as target.
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• You can use a locked body as a location or selection reference, but it cannot be changed as a result. For example,
you can sketch on a locked body but the sketch lines will not imprint on the body.

Locking a Solid or Surface
1. Right-click the solid or surface in the Structure tree.

You can lock all solids and surface parts in a component by right-clicking the component.

2. Select Lock.

The object's icon changes to a locked icon.

Unlocking a Solid or Surface
1. Right-click the solid or surface in the Structure tree.

2. Select Unlock.

2.5. Printing Drawing Sheets and Designs
Your zoom settings determine how a drawing sheet or design will print. For best results, select a paper size from the
Print window that is the same as the drawing sheet format. If you changed the orientation of the drawing sheet,
then the view that appears in the Design window is the one that will be scaled to fit the selected paper size. This can
result in a clipped drawing.

Shaded designs are converted to hidden-line removed graphics style when you select Print from the File menu.
Select Shaded from the Graphics Style drop-down after printing to return your design to the shaded style.

When a curve is clipped (or hidden) behind a solid or surface in the Design window, it will not be clipped when it is
printed. The curve will appear to be in front of the solid or surface on the printed page. The example below shows
a curve that is clipped in the Design window on the left, and the same view in print preview on the right.

Printing a Drawing Sheet
1. Position your design in the Design window as you would like it to appear on the printed page.

Tip: Select Zoom > Zoom Extents from the Orient ribbon group in the Design tab.

You can also print the design at different zoom levels by zooming in or out, but for the best results you should
use Zoom Extents.

2. Select SpaceClaim Options from the File menu and click Detailing.

3. Select All New Documents from the Detailing options for drop-down list.

4. Click No format and select the paper size and orientation.

5. Click OK.

6. Select Print > Print Preview from the File menu to preview the print.

Use the Zoom menu to Zoom In, Zoom Out, Zoom-Box In, or Zoom Extents.
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Use the Navigate tool, when zoomed in, to position the print window.

You can also set the page orientation, set print properties, and print the sheet from this window.

7. Select Print from the File menu.

You can also use Save As to save the sheet as a 2D PDF (*.pdf). The PDF will reflect the current format and size
properties of the sheet.

Printing All Open Drawing Sheets
1. Click Print in the File menu.

2. Select All Open Sheets for the Sheet Range.

3. Set the paper size, margins, and other options as desired.

4. Click Print.

Printing a Design
1. Position your design in the Design window as you would like it to appear on the printed page.

Tip: Select Zoom > Zoom Extents from the Orient ribbon group in the Design tab.

You can also print the design at different zoom levels by zooming in or out, but for the best results, you should
use Zoom Extents.

2. Select Print from the File menu.

3. Set the following options:

• Number of copies

• Paper margins: Set the margins in millimeters (mm) or inches (in).

• Paper orientation: Choose between landscape or portrait mode.

• Paper size: Select from the list of standard paper sizes.

• Print content: Select Scene to print the design based on the size shown in the Design window. This setting is
used by default for designs. Select Extents to expand the design until it fills the printable area of the page. This
setting is used by default for drawing sheets.

• Print scale: If you select Extents for the Print content, you can set the scale of the printed image. Set a value
for the scale, or select Scale to fit.

• Shaded quality: You can set the resolution for 3D objects in dpi (dots per inch). Select System-defined to use
the printer's default dpi setting.

• Print as image: Set this to Yes to print the drawing as a snapshot of the screen. Default is No.
• Print toPDF:The design window and its contents scale to fit the paper size of the selected printer. The Shaded

Quality is automatically set to 110 dpi, which is best for on-screen viewing. For printing, change the value to
300dpi.

4. (Optional) Click Preview to see how your printed design will look.

5. Click Print.

The Design window contents will be zoomed so that it fits the page size.
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Adjusting the Design's Size on the Page
1. Select Print from the File menu and click Print Preview.

2. Select one of the following from the Content ribbon group:

• Scene to display the design based on the size shown in the Design window. This setting is used by default for
designs.

• Extents to expand the design until it fills the printable area of the page. This setting is used by default for
drawing sheets.

3. If you selected Extents, select or enter one of the following from the Scale ribbon group:

• Scale to fit to scale the design to fit the page. This setting is used by default.

• Enter a value in the scale drop-down to scale your design by that amount.

Correcting a Clipped Print Preview
1. Close the print preview.

2. Select the Home tool from the Orient ribbon group.

3. Select Print from the File menu and click Preferences to display your printer's Printing Preferences window.

4. Set your printer settings in the Layout area to match the format and orientation of the drawing sheet.

5. Set the paper size in the Advanced area to match the format paper size.

If your printer only handles 8.5 x 11" paper, select the option that scales the image to fit the paper.

6. Click OK on the Advanced Options and Printing Preferences windows, and click Apply on the Print window.

Setting Page Margins
1. Select Print from the File menu and click Print Preview.

2. Click the Display tab and check Margins in the Show group.

3. Click the Print Preview tab and set the margins in the Margins ribbon group.

2.6. Creating Journals and Logs
Journals record the actions you performed while creating your design, including file actions, such as closing a design.
You must play a journal from a newly opened SpaceClaim application to avoid errors.

SpaceClaim also logs information automatically into the log file, which can be found in one of the following directories:

• C:\Users\<User>\AppData\Roaming\SpaceClaim\Log Files

• C:\Documents and Settings\<User>\Application Data\SpaceClaim\Log Files

You can replay journal files in Cosmetic Replay mode, which skips extraneous cursor movements and shows only a
minimum of spin, pan, zoom, and other navigation movements. This allows you to make a journal file and record it
as a video without doing as much editing after the video is recorded. Animations are shown for pulls and geometry
moves and changes when appropriate.
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Displaying the Journal Tools
1. Select SpaceClaim Options from the File menu

2. Click Customize and then click Ribbon Tabs
3. Check the Journal box and click OK.

The Journal Tools tab is displayed. It contains the Journal ribbon group.

Saving All Your Actions in the Current SpaceClaim Session to a Journal
1. Click Save Current.

2. Navigate to the directory where you want to save the journal, enter a name and click Save.

3. Save the design files used in the session.

Playing the Journal from Your Last Session
1. Exit and restart SpaceClaim.

2. Click Replay Previous.

Playing a Saved Journal
1. Exit and restart SpaceClaim.

2. Click Play or Cosmetic Replay.

Play plays back every movement you made in the session, while Cosmetic Replay skips extraneous cursor
movements and shows only a minimum of spin, pan, zoom, and other navigation movements.

3. Navigate to and select the journal file you want to play and click Open.

4. Review the actions from the session.

Creating a Video
1. Click Create Video in the Journal tab. The Create Video dialog box opens.

2. Specify an output video file (.avi) by browsing to a location and entering a name for the file.

3. Select a video codec.

4. (Optional) Adjust the video settings
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a. Pixel Depth: (16, 24, or 32) The default is 16. Pixel Depth represents the video quality and therefore, the size
of the file. The higher the pixel depth, the more colors are maintained in the video.

b. Frame Rate: The default is 10.

c. Compression: On or Off

5. Click the Start button to begin recording video.

6. Perform the operations you want to record.

7. Click the Stop button to end recording. Once recording stops, the video file is created in the specified location.

You can also play an existing journal file by checking the Journal check box and browsing to a file. The journal can
be played with delay.

2.7. Running SpaceClaim From the Command Line
SpaceClaim includes line arguments that can be included when launching from a command line or terminal prompt.
All command-line arguments are case-insensitive.

Command-line syntax

SpaceClaim.exe /[option name]=[value]

Tip: It is a good practice to put quotation marks around the full paths to ensure that spaces in the path or
project will not be an issue.

DescriptionOption

Specifies a default file open directory./DefaultOpenDirectory

Specifies a default file save directory./DefaultSaveDirectory

Specifies the full path of a default user settings file./DefaultUserSettingsFile

Specifies if the application should exit when the script
(defined by the RunScript options) is finished.

/ExitAfterScript

Boolean value indicating whether to run the application
in batch mode, without UI.

/Headless

Override the Primary SpaceClaim license and Alternate
license preferences, and specify a different license on
application startup. See License Options on page 1139 for
details on the License preference options available.

Example:

SpaceClaim.exe /p=ansys

/p

Specifies the fully qualified pathname of the script file to
run.

/RunScript

Specifies the Script API when used with the RunScript
option.

/ScriptAPI
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DescriptionOption

Specifies the script arguments as a comma separated list
(for example, ScriptArgs="arg1, arg2, arg3").

/ScriptArgs

Boolean value indicating whether to run the script
asynchronously.

/ScriptAsync

Specifies the fully qualified pathname of the script output
file.

/ScriptOutput

Boolean value indicating whether to show the splash
screen or not. The default value is True.

/Splash

Use the current directory as the default file open / save
directory.

/UseCurrentDirectory

Sets the window location. For example,
/WindowLocation=5,5

/WindowLocation

Sets the window to be maximized, if true./WindowMaximized

Sets the window size. For example,
/WindowSize=1000,800

/WindowSize

Example

"PATH\ANSYS Inc\vxxx\scdm\SpaceClaim.exe" /RunScript="%mypath%\script.py"
/ScriptArgs="arg1, arg2, arg3" /ExitAfterScript=True

where %mypath% is the path to your *.py script.

2.8. SpaceClaim File Format
Our files comply with the Microsoft Open Packaging Convention. These files are actually zip archives with a special
structure, the contents of which are primarily XML data.

This open format makes it possible for third parties to get the information they need from SpaceClaim without
talking directly to the SpaceClaim API. For example, a PDM system could check in a SpaceClaim document with all
external dependencies and show a 3D preview of the model. One could also create a batch translator that runs on
a UNIX operating system.

Third parties planning on working with SpaceClaim data should contact SpaceClaim for advice on how to best
integrate their solutions. In general, the benefit of working with SpaceClaim files is that there is no need for a license
of SpaceClaim to be present to read SpaceClaim data. When creating SpaceClaim data or extending the SpaceClaim
user interface, the API is a better choice. SpaceClaim provides sample code for extracting solids from SCDOC files.

Files Contained within the SpaceClaim File
This figure shows the files contained within a sample Flashlight.scdoc file.
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The document.xml.rels file contains pointers to all the files required to load the design into SpaceClaim. The
figure below shows this content for the Flashlight example.

For example, you can use the information in this file to determine all the parts required for a BOM by looking at the
assemblyComponent relationship. In this case, it points to another file called Standard Parts.scdoc. By
opening this file and reviewing its components and subcomponents, you can generate a BOM report.

There are three types of external file pointers:

• assemblyComponent points to a file that contains subcomponents used in the assembly
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• drawingFormat points to the file used to format the drawing sheet

• redlineComponent points to a 3D markup slide

There are also multiple internal file pointers to the geometry files, thumbnail, tessellated data, and window settings.
The bodyGeometry Id provides the key to identifying the bodies described in the other XML and XAML files.

Viewing the Data Contained within SCDOC Files
1. Copy the .scdoc file you want to view.

2. Replace the .scdoc file extension with the .zip file extension.

3. Extract the files within the zip file.

4. Open the folders and view the contents of the xml and xaml files with an XML viewer like XMLNotepad.

Editing the Data Contained within SCDOC Files
You can safely modify some of the data contained within the .scdoc file. However, when creating SpaceClaim data
or extending the SpaceClaim user interface, the API is a better choice. The following steps explain how to edit an
annotation within the Flashlight\SpaceClaim \document.xml.

1. Once you extract the files, open the document.xmlwith an XML viewer like XMLNotepad.

2. Search for the text of the annotation you want to change.

3. Edit the text.

4. Save the file.

5. Create a new zip file containing all the previously-extracted files. Make sure that you do not include the top-level
folder.

6. Replace the .zip extension with a .scdoc extension.

7. Open the file in SpaceClaim to check your edits.

Viewing a Tessellated Model
Open the facets.xaml file with Internet Explorer, or any other xaml viewer.

Viewing a Thumbnail of the File
Open the thumbnail.png file with any graphics program. The thumbnail is displayed in Windows Explorer.



3: Selecting

You can select vertices, edges, planes, axes, faces, surfaces, rounds, bodies, solids, and components in 3D. In 2D, you can
select points and lines. You can also select circle and ellipse centers, the midpoints of lines and edges, and the internal
points and end points of splines.

You can select components and other objects in the Structure tree and use the Selection panel to select objects in the
same part that are similar or related to the object currently selected.

Objects that cannot be selected are dimmed in the Design window.

Your selection list is shown in the status bar at the bottom of the SpaceClaim window. Status bar labels display both
pre-selected and selected objects. Hover over the status message for a detailed list of what you have pre-selected or
selected, including primary and secondary (Alt+selected) objects.

Selection Modes
You can click the arrow on the Select tool to use the following optional modes:

• Using Box: Click and hold the mouse button while drawing a box in the Design window. If you draw the box from left to
right, all objects fully enclosed within the box will be selected. If you draw the box from right to left, all objects touching
the box will be selected.

• Using Lasso: Click and hold the mouse button while drawing a freeform shape. All objects fully enclosed by the shape
will be selected.

• Using Polygon: Click and move the mouse to draw a line, then click again to draw the next connecting line, so that you
create a polygon shape around the area you want to select.

• Using Paint: Click and hold the mouse button while highlighting adjacent faces and edges. All edges and faces that you
move the mouse over will be selected. Release the mouse button to finalize your selection.

• Using Boundary: Select faces or edges that define a boundary, click the Select Seed tool guide, and click any object
within the boundary. All objects from that seed object to the boundary are selected.

• Select Components: In this selection mode, as you hover over geometry, when you are over an object that is in a
component, that component will be pre-highlighted. This mode is set on a per window basis. It can beOn in one window
and Off in another.

No matter which mode you use, the objects that will be selected are highlighted to preview your selection. You can use
the Selection filter to control what gets selected. To select or deselect all available filters, select the All check box.

Note: If you go into the Design tab with sheet metal features selected, the Select tool will work as it does in Sheet
metal. Right-click the sheet metal part in the Structure tree and choose Suspend Sheet Metal in the context menu.

Using the Select Tool

1. Select the Select tool from the Edit ribbon group.

2. Hover over the vertices, edges, faces, bodies in the workspace to preview the selectable items in your design.

If multiple objects occur at your cursor location, use the scroll wheel or arrow keys to preview each one.
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Click to select a vertex, edge, face, or body in 3D, or to select a line or point in 2D.

The most commonly used selection methods are:

• Click to select an object - a vertex, edge, face, or body in 3D, or to select a line or point in 2D.

• Double-click to select an edge loop. (Double-click again to cycle through alternate loops.)

• Triple-click to select a solid.

• Drag (or select Using Box from the Select tool menu) to create a selection box.

• Use Ctrl+A to select all similar objects, such as bodies, faces, edges, or points on the same solid or surface part. For
example, if you have a sketch curve selected when you press Ctrl+A, then only sketch curves will be selected.

• Use Ctrl+click and Shift+click to add or remove items from the selection set.

• Use Ctrl+click to add or remove one item from the selection set. Use Shift+click to add everything between your
first click and the Shift+click to the selection.

• Ctrl with box-selection toggles the selection, while Shift with box-selection adds to the selection.

• You can add or remove items both in the workspace and on the Structure tree.

• You can also press Ctrl and drag to add the items within the selection box to the selection.

• Use Alt+click to create a secondary selection set.

Use the Alt key with any of the other selection techniques (double-click, triple-click, Ctrl, Shift) to create the second
selection set. Alternate selections are shown in blue, and you can use them to guide the actions of the Pull and Move
tools.

Do this:To select:

• Click once to select a face:

• Click once to select an edge:

Click to select an object.

Double-click to select and cycle through chains of similar,
connected faces:

Double-click a face to select chains of rounds or tangent
faces.

Double-click to select connected faces:
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Do this:To select:

Double-click to select and cycle through chains of
connected edges (edge loops):

When you repeatedly double-click outside surface edges,
the selection cycles through open loop, tangent chain, and
face loop, then repeats through that list.

You can also right-click the edge or line and choose one
of the loop options in the Select menu.

All the edges around a face or closed loop

Click one face or edge, then Shift+click another face or
edge to select all the faces or edges between the two.

Contiguous edges or faces

Triple-click to select the solid, or right-click the solid and
select Select > Body.

A solid or surface body

Triple-click the sketch.An entire sketch

Right-click the component and select the Select >
Component option. This option is available only when
you right-click an object in the active component.

A component

Select an object and press Ctrl+A. to select all similar
objects, such as bodies, faces, edges, or points on the same
solid or surface part. For example, if you have a sketch
curve selected when you press Ctrl+A, then only sketch
curves will be selected.

All objects of same type as selected object

Click Select All in the Select tool menu, or right-click and
selectSelect>SelectAll from the context menu. The types
of objects selected depend on whether you are in Sketch,
Section, or 3D mode.

All the objects in the active component (except layout
surfaces)

Check the Lightweight Components box in the Options
panel. Then right-click and select Select > Component.

A lightweight component

Hold the Ctrl key and roll the mouse wheel.Objects that are behind other objects ("query selection")
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Note:

• If any object was part of a group selection used to perform an action, the other parts of the group are
highlighted when that object is selected. Click again to select the entire highlighted group.

• When selecting an object in a view on a drawing sheet, you can only select those objects that are on the
cross-section plane, or that are within the boundary of a detail view. Box selecting in Sketch mode selects
only sketch lines. Box-selecting in Section mode selects only section lines.

Using the Selection Context Menu
The Select context menu contains options for selection based on the object(s) selected. The available options include:

• Component

• Body

• Block (Meshing only)

• Component Blocks (Meshing only)

• Blocking (Meshing only)

• Inverse Selection

• Protrusion

• Depression

• Pattern Member

• All Pattern Members

• Pattern Edges

• Select Tangent Edge Loop

• Select Edge Loop One/Select Edge Loop Two

• Select All

• Clear Selection

Clearing a Selection
Click any empty space in the Design window or select Clear Selection from the Select tool menu.

Reverting Your Selection
Click Revert Selection in the status bar to go back to your previous selection.

This tool is especially useful when you accidentally clear your selection or add the wrong object and want to go back to
your previous selection. You can find this tool next to the Selection filter in the status bar.
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Selecting by Rolling the Mouse Wheel
• Coincident objects: Objects often appear at the same location in 2D, such as a vertex and end point of a line that are

located at the same point in space. When selecting, make sure you have selected the correct object by rolling the mouse
wheel without moving the mouse.

• Edge shared by two surfaces or solids: Hovering over the edge shades the face that will be affected by an action to the
edge if you select it. Roll the mouse wheel to switch between the two faces.

• Vertex shared between two edges: Hovering over a vertex shades the edge that will be affected by an action to the
vertex if you select it. Roll the mouse wheel to switch between the edges.

• Face of a solid when only the edge is displayed (such as in a drawing sheet view): You can select the face by turning
the mouse wheel. The edge becomes a slightly thicker line when the face is highlighted.

• Edge loops: IfSelectedge loopsusing themousescrollwheel is selected in the Advanced SpaceClaim options, scrolling
through edge loop choices pre-highlights the selection. Click the pre-highlighted edge loop to select it.

The up and down arrow keys work the same as the mouse wheel. Hover over the element you want to select, and press
the up or down arrow keys to "scroll" through the possible selections. This is useful if you are on a laptop or when you use
a mouse that does not have a scroll wheel.

For more information about selecting facets and the related tools, see Selecting Facets.

Tool Guides
The following tool guide is available:

The Select tool guide is active by default. This tool lets you click, double-click, triple-click, Ctrl+click,
Shift+click, and Alt+click to select items.

3.1. Using Clip With Plane
You can use multiple planes to quickly clip your design to show only the geometry on one side of a plane or the
other.

The Clip with Plane options includes Clip, Reverse Direction, and Union. Planes, axes, and annotations are not
clipped. The image below shows how planes in different clip states display in the Structure tree:

By default, when you create a plane, the Structure tree displays a black-outlined visible plane icon. You can select
a visible plane you want to clip from either the Structure tree or in the Design window, then right-click anywhere in
the Structure tree or Design window to display the Clip with Plane context menu.
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You can select up to 10 planes to set a clipped volume. Planes selected for clipping display with red boundaries in
the design window.

As you develop a model, you can also work with Clip with Volume to create a spherical clip volume around an
object so that you can selectively isolate a specific region, element, or section of a design.

Clipping Your Design With a Plane or Multiple Planes
1. Select a plane, or, use Ctrl+Select to select multiple planes.

2. Right-click and hover over Clip with Plane to display the entire context menu.

3. Select Clip.

The plane or planes you clipped display with a red outline. Icons update in the Structure tree. With the plane(s)
selected, you can modify values in the Properties panel.

To restore the view of your design, right-click the plane and select Clip again.

By default, when clipping is initially set, additional selected planes automatically combine using an "and" operation.
This way you can isolate the inside of two parallel planes or the inside of 3 pairs of parallel planes (one of the most
common usages for this feature).

Reversing the Direction of the Clipped View
1. Right-click a plane and hover over Clip with Plane to display the entire menu.

2. Select Reverse Direction.

The geometry of your design flips to what is on the other side of the plane. To return to the original clipped view of
your design, right-click the plane and select Reverse Direction again.

To view the plane's direction, click the Move tool. The blue arrow on the Move tool indicates the positive direction
of the plane. The reversed direction is the opposite direction of the blue Move tool arrow, as shown below:

Selecting multiple planes for clipping adds them to an ‘or' set. With a group (2 or more) of planes, you can also right
mouse click, then select Union from the Clip with Plane context menu. This option is essentially an "or" operation
that defines a plane group that you intend to combine with the rest of the planes. Once you define and unite a group
of planes, the Union set is put at the beginning of the logical set, and the rest of the planes follow with their default
"and" states. Union is ON by default when more than one clipping plane is selected.

For example, you can select 3 planes and get these logical sets, as shown in the table of images below:

• A and B and C, which is the default (showing 1/8 of the model)
• (A or B) and C, where A and B are united (showing 3/8 of the model)
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• (A or C) and B, where A and C are united (showing a different 3/8 of the model)
• (B or C) and A, where B and C are united (showing a different 3/8 of the model)
• A or B or C, where A and B and C are united (showing 7/8 of the model)

Creating a Union Between Planes
1. Ctrl+Select more than one plane.

2. Right-click one plane and hover over Clip with Plane to display the entire menu.

3. Select Union.

The image below shows the results of uniting two planes. Sets of parallel planes default to keeping the material
inside:

When you save a model with clipped planes, and you are working with the model in various clipped plane states in
two or more design window panes, the clip state of each plane in the model is saved per window with the model.
As you move between window panes, the Structure tree updates to reflect the clip state of each plane in the active
window context.
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3.2. Using Clip With Volume
As you develop a model, the Clip with Volume tool enables you to create a spherical clip volume around an object
so that you can selectively isolate a specific region, element, or section of a design.

Using Clip with Volume can be particularly helpful when you need to closely view and work on a specific feature of
interest within a complex model. For example, after isolating a design area, you can use the Repair > Missing Faces
tool to help detect and fix missing faces on a body.

Clipping Your Design With a Volume
1. Rotate and zoom in to your model to locate the model element or area you want to view.

2. With nothing selected, right mouse click and select Clip with Volume > Set.

This action clips the viewable and selectable geometry by the radius of a virtual sphere.

3. Hover over the center of the element you want to view and thenClick+drag to create your spherical clip volume.

4. Release the mouse.

The area you selected to preview magnifies and displays in a sphere as clipped, or isolated, from the rest of the
model.

5. Right mouse click and select Clip with Volume > Select.

This selects the virtual spherical surface of the area.

In the Properties panel, you can change the following:

• Center: Enter new coordinates (based on the World Origin) for the sphere's center.
• Clip selection: Choose Yes to clip the current selection by the sphere. The default is No.
• Radius: Enter a new sphere radius.

6. Right mouse click and select Clip with Volume > Set Using Selection.

This sets the virtual sphere's extents based on the current selection.

7. Hover over the area to identify all of the various design elements.

8. To re-display your design with no clipping, right mouse click and select Clip with Volume > Clear.

Using Move
Use theMoveoption in the Clipped Volume menu to move the clipped volume frame to a different area of the model,
or the Resize option to adjust the size of the Clipped volume frame. See images below.
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Using Extract Geometry
Use the Extract Geometry option to cap off clipped boundaries according to Clip Type (Spherical volume or by
Planes). The result is shown in the Structure Tree as a Geometry Snapshot.

For intersections with Solids, Extract Geometry creates a Geometry Snapshot that is a solid.

For intersections with Surface models, Extract Geometry also creates a Geometry Snapshot, but displays the
surfaces with a more opaque, solid look.

For intersections with Mid-surface models, or any surface with an assigned thickness, Extract Geometry creates a
Geometry Snapshot with the assigned thickness.

For Beams, Extract Geometry creates a Geometry Snapshot showing their actual geometry.
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Extract Geometry also creates a Named Selections group that shows the faces created at the boundary.

3.3. Filtering the Selection
Click the Selection Filter

in the status bar to open the filter options. The options are:

• Smart
• All

º Bodies
º Faces
º Edges
º Sketch Curves
º Annotations

Notes
Dimensions
Other

º Planes
º Axes
º Vertices
º Points
º Images
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º Faceted Bodies
º Blocks (SCDM only)

Volumes
Faces
Edges
Vertices

• Lightweight Components
• Transparent Objects

The Smart option is enabled by default and whenever you switch to another tool.

When Smart is enabled, all filters are checked and cannot be unchecked. Within the defined area, only the highest
checked item in the filter list will be selected. This differs between Design Windows and Drawing Windows as follows.

• In a Design Window: Body, Face, Edge, Sketch Curve, Annotation, Plane, Axis, Point, ...

• In a Drawing Window: Annotation, Sketch Curve, Body, Face, Edge, Plane, Axis, Point, ...

The images below show only the body being selected in the Design Window when Smart is enabled.

Disable Smart to select all object types checked in the filter list. The images below show that all items are selected
in the Design Window when Smart is disabled.

All is a shortcut for enabling/disabling all of the filter items.

When you switch to another tool, the filter selections are remembered but the Smart option is selected. If you
deselect theSmartoption, the previously selected options remain selected while the previously deselected options
remain deselected.

The following Box selection options are available in the Selection Filter.

• Automatic selects faces and connected hidden faces
• Visible selects visible faces only
• Through selects visible and hidden faces
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3.4. Selecting by Drawing a Box
The Using Box mode is found in the menu under the Select tool in the Edit ribbon group on the Design tab, and
also in the radial menu. You can access this menu while almost any tool is active. For example, if you want to change
selection modes while the Pull tool is active, just click the arrow under Select. The Pull tool will remain active.

From the context menu, you can also choose Select > Using Box.

This mode enables you to draw a box in the Design window to select objects for most tools. As you draw a selection
box, objects are highlighted (after a slight delay) to help you see exactly what will be selected.

Draw the box from left to right to select only the objects that are fully contained within the box. The box appears as
a solid line.

Draw the box from right to left to select everything the box crosses, even if it isn't fully enclosed by the box. The box
appears as a dashed line.

In the animation below, box mode is used twice with the selection filter set toSmart (the default) to select the entire
part. You can see vertices, edges, and faces highlighted for selection as the box is drawn. First the part is selected
by fully enclosing the part with a box drawn from left to right. Then the part is selected by drawing a box from right
to left that crosses over but does not enclose all faces on the part. You can release the mouse button at any time to
select the highlighted objects.

Selecting Objects by Drawing a Box
1. Click the arrow beneath the

Select tool and click Using Box.

2. (Optional) Use the Selection Filter

in the status bar to control what will be selected.

3. Start drawing a rectangle in the Design window. Click and hold the left mouse button at one corner of the area
you want to box-select.

4. Hold the mouse button and draw a rectangle in the Design window.

• Draw the box from left to right to select only the objects that are fully contained within the box. The box appears
as a solid line.

• Draw the box from right to left to select everything in the box, even if it isn't fully enclosed by the box. The box
appears as a dashed line.
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The objects that will be selected are highlighted as you draw the box.

5. Release the mouse button to complete the box.

The objects are selected when you release the mouse button.

Changing Your Selection
Holding Shift while box-selecting adds to the selection. In the first image, the blue box is selected. After holding
Shift and box selecting, all of the boxes are selected:

Holding Ctrl while box-selecting toggles the selection. In the first image, the blue box is selected. After holding Ctrl
and box selecting, the blue box is deselected and the green boxes are selected:

Examples - Using Box Selection

Box-selecting from left to right

Box-selecting from right to left

127Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Selecting



3.5. Selecting by Drawing a Freeform Shape (lasso)
The Using Lasso mode is found in the menu under the Select tool in the Edit ribbon group on the Design tab, and
also in the radial menu. You can access this menu while almost any tool is active. For example, if you want to change
selection modes while the Pull tool is active, just click the arrow under Select. The Pull tool will remain active.

This select mode enables you to draw a free form shape in the Design window to select objects for most tools. As
you draw, objects are highlighted (after a slight delay) to help you see exactly what will be selected.

In the animation below, lasso mode is used with the selection filter set to Smart (the default) to select the entire
part. You can see vertices, edges, and faces highlighted for selection as the shape is drawn. You can release the
mouse button at any time and a straight line is drawn from the beginning point to the current point to complete the
shape, and everything within the shape will be selected.

Selecting Objects by Drawing a Freeform Shape
1. Click the arrow beneath the

Select tool and click Using Lasso, or click and hold in the Design window to activate the radial menu and then
select Lasso.

2. (Optional) Use the Selection Filter in the status bar to change the type of objects that will be selected.

The Smart option is enabled by default and whenever you switch to another tool. Select Smart to select the
highest checked item in the list that is found in the boxed, lassoed, or painted area. Drawing a box or freeform
shape selects objects in the following order:

• In a Design Window: Body, Face, Edge, Sketch, Annotation, Plane, Axis, Point

• In a Drawing Window: Annotation, Sketch, Body, Face, Edge, Plane, Axis, Point

Deselect Smart to select all the selected object types. Click to select or clear the types of objects you want to
select.

3. Start drawing a shape in the Design window. Click and hold the left mouse button at the spot where you want
to start drawing the shape.

4. Hold the mouse button and draw a shape in the Design window.

You can make multiple loops, like drawing a figure 8.

5. Release the mouse button to complete the shape.
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The shape will be closed by a straight line between your starting and ending points when you release the mouse
button.

Everything except inserted images is selected when you release the mouse button.

Note: You can activate Lasso mode by holding the Alt key while the Select tool is active. This hotkey only
works when you are using the Select tool, and not when another tool is active.

Example - Using Lasso Selection

Selecting three surfaces by drawing multiple loops

3.6. Selecting Using Polygon
TheUsing Polygonmode is found in the menu under the Select tool in the Edit ribbon group on the Design tab, and
under the Select tool in the Edit Group on the Sheet Metal tab. You can also right-click in the design window and
choose Select > Using Polygon. This selection mode enables you to select all objects within a polygon you create.
Each time you click, a new starting point for the next line is created. You control the length and angle of each polygon
line you create.

Use this mode to draw around a specific geometry or model feature you want to select, for example, a protrusion
of other geometry you may want to clearly identify. Using a polygon shape for selection can apply when you are, for
example, trying to select an irregular or angular shaped part, or assembly of parts.

Selecting Objects Using a Polygon
1. Select the Using Polygon tool.

2. (Optional) Use the Selection Filter in the status bar to change the type of objects that will be selected.

Deselect Smart to select all the selected object types. Click to select or clear the types of objects you want to
select.

3. Click points to draw a polygon around the model feature that you want to select.

As you draw the polygon lines, selected objects highlight as they are pre-selected.

4. Double-click or cross the polygon lines to finalize the selection.
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Example - Using Polygon Selection

Creating a polygon to select around a specific geometry.

3.7. Selecting by Painting
The Using Paint mode is found in the menu under the Select tool in the Edit ribbon group on the Design tab, and
in the radial menu. You can access this menu while almost any tool is active. For example, if you want to change
selection modes while the Pull tool is active, just click the arrow under Select. The Pull tool will remain active.

This select mode enables you to select faces, edges, and sketch curves in the Design window by "painting" faces
and edges that are adjacent to each other. As you paint, objects are highlighted to help you see exactly what will be
selected.

In the animation below, paint mode is used with the selection filter to select only the edges of the lower box. Edges
are selected as the mouse moves over them. You can release the mouse button at any time to select the highlighted
faces or edges.

Selecting Objects by Painting
1. Click the arrow beneath the

Select tool and click Using Paint, or click and hold in the Design window to activate the radial menu and then
select Paint.

2. (Optional) Use the Selection Filter in the status bar to change the type of objects that will be selected.

The Smart option is enabled by default and whenever you switch to another tool. Select Smart to select the
highest checked item in the list that is found in the boxed, lassoed, or painted area. Drawing a box or freeform
shape selects objects in the following order:

• In a Design Window: Body, Face, Edge, Sketch, Annotation, Plane, Axis, Point

• In a Drawing Window: Annotation, Sketch, Body, Face, Edge, Plane, Axis, Point

Deselect Smart to select all the selected object types. Click to select or clear the types of objects you want to
select.
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3. Click the first object you want to select and hold the mouse button.

4. Drag the mouse onto adjacent faces or edges that you want to add to the selection.

The objects that will be selected are highlighted as you move over them with the mouse.

If you hold Ctrl you can move the mouse over an object without selecting it, or move the mouse over a selected
object to deselect it.

5. Release the mouse button to complete the selection.

The objects are selected when you release the mouse button.

3.8. Selecting Using Boundary
The Using Boundary mode is found in the menu under the Select tool in the Design tab Edit group. This mode
enables you to select all objects within a boundary.

Selecting Objects Using a Boundary
1. Select the Using Boundary tool from the Select drop-down menu in the Edit ribbon group on the Design tab.

The Select Bounds tool guide is enabled by default.

2. (Optional) Use the Selection Filter in the status bar to change the type of objects that will be selected.

Deselect Smart to select all the selected object types. Click to select or clear the types of objects you want to
select.

3. Select the faces or edges you want to use to define a boundary.

You cannot select a combination of faces and edges.

The Select Bounds tool guide is sticky, so you do not have to hold the Ctrl key to add to your selection. You can
click in white space to clear your selections.

The objects remain selected as secondary references in case you need to add or subtract from the boundary.

Note: You can select bounds (Ctrl+alt+selection) and seeds (Ctrl+selections), then click the boundary
tool under theSelectiondrop-down menu to perform the boundary selection operation without actually
entering the Select tool. The Select Bounds tool guides does not display.

4. Click the Select Seed tool guide.

5. Click any object within the boundary to use as the seed object.

You can select multiple seeds. All objects from the seed object to the boundary are pre-highlighted for selection.

6. Click the Select tool to finalize the selection.

Example - Using Boundary Selection
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Select faces to define a boundary and then select the seed object. All objects from the seed object to the boundary
are selected.

3.9. Selecting Components
The Select Components mode is found in the menu under the Select tool in the Edit ribbon group on the Design
tab. You can access this menu while almost any tool is active. For example, if you want to change selection modes
while the Pull tool is active, just click the arrow under Select. The Pull tool will remain active.

In this selection mode, as you hover over geometry, when you are over an object that is in a component, that
component will be pre-highlighted.

Pre-highlighting while box-selecting shows just the component bounding boxes. Faces, edges, etc. are not
pre-highlighted.



4: Designing

The tools you use for 2D and 3D sketching and editing are found in SpaceClaim's Design tab. With the design tools, you
can sketch in 2D, generate and edit solids in 3D, and work with assemblies of solids.

In SpaceClaim, there are three modes you can use to design: Sketch, Section, and 3D mode. You can switch between these
modes at any time.

When creating designs, you will use the following tools most often:

Use the Select tool to select 2D or 3D objects in your design for editing. You can select vertices,
edges, axes, faces, surfaces, solids, and components in 3D. In 2D, you can select points and
lines. You can also use this tool to change the properties of recognized or inferred objects.Select

Use the Pull tool to offset, extrude, revolve, sweep, draft, and blend faces; and to round or
chamfer corner edges.

Pull

Use the Move tool to move any single face, surface, solid, or component. The behavior of the
Move tool changes based on what you have selected. If you select a face, you can pull or draft
it. If you select a solid or surface, you can rotate or translate it.

Use the Combine tool to merge and split solids and surfaces.

Combine

Use Section Mode to create and edit designs by sketching on and editing any cross-section
through the design.Section Mode

Design tools are grouped into the following ribbon groups:

Cut, copy, and paste 3D objects.Clipboard

Spin, pan, and zoom your design. You can also select or create a view.Orient

Create and edit lines, arcs, splines, rectangles, circles, and points in 2D.Sketch

Switch between sketching in 2D, editing a cross-section, and creating and editing objects
directly in 3D

Mode

Edit 2D and 3D geometry.Edit

Merge or split solids and faces.Intersect

Create other components for your design.Create

Create other components for your design.Body

If an operation runs more than three seconds, the Stop icon is activated in the status bar. Click

to cancel the current operation. You can also press and hold Esc to cancel out of any design action that is taking too long.

When using any tool guide, you can click an empty point in the Design window to clear the tool guide selection and return
to the previous action within the tool.
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4.1. Cutting, Copying, and Pasting
Select a tool from the Clipboard ribbon group to cut, copy, or paste any 2D or 3D object. You can use these tools any
time, even when you are designing with other 2D or 3D tools.

Objects are pasted into the active component. Objects that can be named (components, bodies, axes, or planes)
will retain their names when pasted.

When you cut and paste a solid or surface, the object retains its color and face style.

Cutting an Object
1. Select the object.

2. Select the Cut tool

from the Clipboard ribbon group.

You can also press Ctrl+X or right-click in the Design window and select Cut from the context menu. If you cut
the face of a solid, it is converted to a surface.

Copying an Object
1. Select the object.

2. Select the Copy tool

from the Clipboard ribbon group.

You can also press Ctrl+C or right-click in the Design window and select Copy from the context menu.

Pasting an Object into the Design Window
1. Cut or copy the object.

2. Select the Paste tool

from the Clipboard ribbon group.

You can also press Ctrl+V or right-click in the Design window and select Paste from the context menu.

If you do not specify a location to paste, the copy is placed in its original location relative to the world origin.

When you paste an object and it is located outside of the visible area in the Design window, the zoom is adjusted
to make the object visible.

Note: Face edges that are Copied and Pasted create Curves. In some cases, there may be a very small
deviation between the curve and the underlying edge that was copied. Most cases involve spline edges
because of the way spline curves are constructed. A small number of cases may occur where lines and arcs
connect due how the connecting vertex is calculated.
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Pasting an Object onto a Face
1. Select all the faces of the object.

2. (Optional) Alt+click the face of the object you want to attach to the face.

The face is highlighted in blue.

3. Cut or copy the selection.

4. Click the face onto which you want to paste the object.

5. Paste the object.

The object is pasted on the face at the location you clicked. The blue face is attached to the clicked face.

Pasting a Round Onto Another Edge
1. Select the face of the round.

2. Cut or copy the face.

3. Click the edge onto which you want to paste the round.

4. Paste the round.

Deleting an Object
1. Right-click the selected object (or set of objects).

2. Press Delete.

If you want to delete something and fill the gap with neighboring geometry, or create faces in the gap, you should
use the Fill tool.

If you delete the face of a solid, it is converted to a surface.

4.2. Sketching
Sketching is useful if you want to create a region that can be pulled into 3D. If you want to create a 2D layout, and
have no immediate need to generate 3D objects from the lines in the layout, then you should create a layout.

Use the sketch tools to sketch shapes in 2D. When you exit the sketch, regions are formed by intersecting lines. These
regions will become solids and lines become edges when you pull your sketch into 3D with the Pull tool. Even when
pulled into 3D, a region can be decomposed back into its sketched lines for further editing as long as any remnant
of the lines is still unused in 3D.
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To use any of the sketch tools to sketch in 2D, you must first display the sketch grid. If you have a planar surface
highlighted, and press a sketch tool shortcut (such as L for the Line tool), you can hover over planar surfaces in the
design to highlight surfaces for the sketch grid. (Press Escwhile in this state to return to the Select tool in 3D mode.)
You can adjust the units and spacing of the grid, you can also fade the scene under the grid to enhance the visibility
of your sketch.

You can lock the base dimension base point when sketching multiple objects. Locking a base point enables you to
secure the dimensions of an object relative to that point, or, the dimensions of an object relative to any object you
previously sketched. As you sketch, you can enter coordinates for each successive point relative to the previous
point.

While you are sketching, you may need to orient your design. If you use the Spin, Pan, or Zoom tools to reorient the
sketch, click the navigation tool again or press Esc to continue sketching where you left off.

If you selectAuto-extrude/revolve sketches in Sectionmode in the Advanced options, sketching in Section mode
will automatically extrude your sketch to 3D. The extrusion depth is set to 10 times the spacing of your sketch grid.
You can dimension this depth for any extruded sketch by entering a value in that dimension field. If your are sketching
on an already revolved face, the sketch is automatically revolved.

When you copy and paste sketch objects, they are placed in their original location relative to the center of the grid.
The objects will be highlighted when you paste, so you can move them to a different position, if required.

Sketched objects are added to the Curves folder in the Structure tree as you create them. If the list of sketch curves
is long, then you will see More Curves in the list. Click More Curves to display the entire list.

Detailed Instructions
1. Click

Sketch Mode in the Mode group on the Design tab.

2. Choose where you want to sketch.

Hover over the planes and planar faces in your design to preview the location and orientation of the sketch grid.

The sketch grid is placed automatically if you pre-select an object in the active component before you click
SketchMode. If you pre-select an origin object, the sketch grid will be aligned with its X and Y axes and the sketch
origin will be centered on the origin object. If you pre-select axes objects, the grid will run through the axes.

If you previously selected a set of references that define a plane, the sketch grid is placed on the defined plane.
The sketch grid mini-toolbar allows you to switch from sketching on one plane to sketching on another without
leaving the sketch tools.

a. If the sketch grid is currently displayed, click Select New Sketch Plane

in the mini-toolbar, or right-click and select Select New Sketch Plane from the context menu.

b. Mouse over any existing geometry to display existing planes.

c. Click to select the highlighted plane and display the sketch grid. Any vertices or edges on the plane are drawn
in the current layer color and bolded.

d. (Optional) Click Plan View

in the mini-toolbar or in the Orient ribbon group to view the sketch grid head-on.

3. (Optional) Move or rotate the sketch grid.

a. (Optional) Select any points, lines, or curves that you want to move with the sketch grid.
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b. Click Move Grid

in the mini-toolbar.

c. Use theMove handle tomove or rotate the sketch grid. Highlighted curveswill bemovedwith the grid.

d. (Optional) Use the Orient To Object tool guide to orient the sketch grid to an object in the Design window.
The object does not have to lie in the sketch plane.

4. Select any sketch tool from the Sketch ribbon group.

You can draw points, lines, tangent lines, construction lines, rectangles, three-point rectangles, circles, three-point
circles, ellipses, splines, tangent arcs, three-point arcs, sweep arcs, and polygons using the sketch tools. You can
also create sketch lines by projecting the edges of 3D solids onto the sketch grid.

SpaceClaim's sketch tools also let you split, trim, and offset lines, as well as create corners and rounded corners.

5. Draw with the tool.

Mousing over the sketch grid snaps to points based on your snapping options. Press Shift to turn snapping on
and off.

While hovering, SpaceClaim also provides extension lines when you are parallel to an edge or perpendicular to
an end point. For certain drawing tools, it displays indicators of tangency, line midpoint, line end point, squares,
and golden rectangles.

All tools let you enter dimensions while sketching. In some tools, you can press Shift at a reference point to see
dimensions from that point to the cursor.

When you are done sketching with the tool, you can:

• Click another sketching tool.

• Click Return to 3DMode

in the mini-toolbar or 3DMode in the Mode group in the ribbon bar to pull your sketch to 3D.

• Press Esc or click the Select tool in the Edit ribbon group to edit the sketch.

Locking a Base Point
1. Enter Sketch mode.

2. Select the Cartesian dimensions option in the Sketch Options panel.

3. Select the Lock base point check box in the Sketch Options panel.

4. Place the sketch on the sketch grid relative to your chosen dimensions from the locked base dimension base
point.

Changing the Location of a Base Point
1. While in Sketchmode, while hovering over the base dimension point from which you want to take a dimension,

press Shift to dimension between the selected object and that point.

2. Click and drag the line or point you want to edit.

The Cartesian dimensions are now taken from this new base dimension base point.
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Editing a Sketch
1. Click the Select tool. (You can also press Esc if you are in a sketching tool.)

2. Click and drag the line or point you want to edit.

Alt+click and drag if you want to detach the line or point before moving it.

Ctrl+click and drag to create a copy.

Enter a value to dimension the move.

You can also use the Move tool to edit a sketch.

Toggling Between a Curve and a Construction Curve
Right-click the curve and select Construction On/Off.

Mirroring in Sketch Mode
1. Draw a line or construction line.

2. Right-click the line and select Set as Mirror Line from the context menu.

3. Sketch on one side of the line to mirror the sketch on the other side.

You can only mirror geometry drawn after you set the mirror line. If you want to mirror existing geometry, use
the Mirror tool.

Sketch Ribbon
The tools in the Create ribbon group are used to create sketch and construction curves.

Use the Line tool to sketch lines in 2D.

Use the Tangent Line tool to sketch lines tangent to any curves in your design.

Use the Construction Line tool to draw lines that help you create an accurate sketch. These lines
become axes in 3D mode.

Use the Rectangle tool to draw a rectangle along the axes of the sketch grid.

Use the Three-Point Rectangle tool to quickly sketch a rectangle at any angle in 2D.

Use the Ellipse tool to sketch an ellipse in 2D.

Use the Circle tool to sketch a circle in 2D when you know the location of the circle's center and radius,
diameter, or a point on the circle's edge.

Use the Three-Point Circle tool when you don't know the center of the circle, but you know where the
edge of the circle must be. This tool works with any combination of free points, known points, or
tangent attachments.

Use the Polygon tool to sketch a polygon with up to 32 sides.

Use the Tangent Arc tool to sketch an arc tangent to any single curve or line in your design.

Use the Three-Point Arc tool to create an arc by specifying its start and end points, and the radius or
chord angle.

Use the Sweep Arc tool to create an arc with a known center and end points.
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Use the Spline tool to sketch splines in 2D. A spline is a continuously curved line, without sharp
boundaries (that is, without vertices).

Use the Point tool to sketch points in 2D.

Use the Face Curve tool to sketch a curve on a face of a solid.

The Modify group contains the following sketch editing tools:

Use the Create Rounded Corner tool to trim back or connect two intersecting lines or arcs so that they
meet with an arc tangent at both ends.

Use the Offset Curve tool to create an offset of any line in the grid plane.

Use the Project to Sketch tool to project edges from a 3D object onto the sketch grid.

Use the Create Corner tool to trim back or extend two lines so that they meet at a corner.

Use the Trim Away tool to delete any line portion bounded by an intersection with a line or edge.

Use the Split Curve tool to split one line with another line or point.

Use the Bend tool to bend straight lines and edges to form an arc. You can also use the Bend tool to
adjust the radius of arcs and arced edges. Bend works on straight lines when you are sketching and
when you are editing in cross-section.

Use the Scale tool to display control handles you can use to manipulate a 2D object.

The Constraints group contains the following tools to add constraints to sketches:

Use the Dimension tool to create a dimension constraint.

Use the Coincident tool to create a coincident constraint.

Use the Midpoint tool to create a mid-point constraint.

Use the Concentric tool to create a concentric constraint.

Use the Fixed tool to create a fixed constraint.

Use the Horizontal tool to create a horizontal constraint.

Use the Vertical tool to create a vertical constraint.

Use the Parallel tool to create a parallel constraint.

Use the Perpendicular tool to create a perpendicular constraint.

Use the Tangent tool to create a tangent constraint.

Use the Equal Radius tool to create an equal radius constraint.

Use the Equal Distance tool to create an equal distance constraint.

139Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Use the Show Constraint Tips tool to view the constraints applied.

Use the Delete Constraints tool to delete constraints.

Use the Autoconstrain tool to find the specified constraint types and automatically set up
constraints.

The End Sketch group contains options to enable sketching in 3D and end sketch editing.

Use Enable 3D Sketch to switch to sketching in 3D. See Working with Sketch Curves in 3D on
page 192 for the sketch tools you can use in 3D mode.

Use End Sketch Editing to complete sketch editing.

Sketching Tool Guide
The sketching tools have several tool guides that allow you to change the behavior of the tool. These guides are
active when appropriate:

Use Select Reference Curve to dimension a sketch based on an existing curve.

Use Move Dimension Base Point to move the base point from your starting point to a different location.
This is useful when you want to control the distance between your new sketch and existing object.

Use Change Dimension Reference Angle to dimension a sketch based on a reference angle from a point
on an existing object.

Sketching Mini-toolbar
While you are sketching, the mini-toolbar provides quick access to the following actions:

ClickReturn to 3DMode to switch to the Pull tool and pull your sketch into 3D. Any closed loops will form
surfaces or faces. Intersecting lines will split faces.

Click Select New Sketch Plane to select a new face to sketch on.

Click Move Grid to move or rotate the current sketch grid with the Move handle.

Click Plan View for a head-on view of the sketch grid.

Options
The common sketch options are described in Sketch Options on page 143.
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4.2.1. The Sketch Plane
The sketch grid indicates that you are performing actions in a 2D plane. Selection, sketching, creating layouts,
adjusting blend planes, cross-section editing, and annotation all use the sketch grid. You can adjust the units and
spacing of the grid, as well as how solids are displayed when the grid appears.

Displaying a Sketch Plane
1. Select Sketch Mode or any sketching tool.

2. Click a face, plane, axis, or drawing sheet.

You can also select the combinations used to insert a plane to display a sketch grid at that location.

If you do not see the grid, make sure that the Show Sketch Grid box is checked in the Display tab's Grid ribbon
group.

Selecting a New Location for the Sketch Plane
1. Click Select New Sketch Plane in the mini-toolbar, or right-click and select Select New Sketch Plane from

the context menu.

2. Mouse over any existing geometry to display existing planes.

3. Click to select the highlighted plane and display the sketch grid.

Moving the Sketch Plane
1. (Optional) Select any points, lines, or curves that you want to move with the sketch grid.

2. Click Move Grid in the mini-toolbar.

The Move handle is now placed on the end point of the last line or curve you drew. This makes drawing a trajectory
in 3D space easier.

3. Use the Move handle to move or rotate the sketch grid.

Viewing the Sketch Plane Head-on
Click Plan View in the mini-toolbar or in the Orient ribbon group to view the sketch grid head-on.

Switching to the Last Sketch Plane
Right-click the plane and select Use Last Sketch Plane.

This command is in the context menu for all tools that can be used in both sketch and section modes, such as Pull.

All closed sketch curves in the current plane are converted to surfaces.

The last plane used for sketching on is set as active, and dynamic plane mode is ended when you use the Use Last
Sketch Plane command.
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Using Alt+Select in Sketch Mode
While working inSketchmode, you can align a sketch plane to any linear reference that youAlt+Select. For example,
on a block with angled planar faces, you can select a face and then Alt+Select an edge. The Sketch grid aligns to
the Alt reference.

4.2.2. Moving the Sketch Grid
Use the Move Grid tool to move the sketch grid. Make successive sketches by moving the grid after sketching closed
line regions. These closed lines turn into regions when you move the grid.

The icon at the center of the sketch grid

indicates the origin of the grid and moves with the grid as you move the grid.

Moving the Sketch Grid
1. Click the Move Grid tool

on the mini-toolbar or click the Move tool and check the Move Grid option.

2. (Optional) Select any sketch entities that you want to move along with the sketch grid.

3. Select a Move handle axis.

4. Drag along the axis of the Move handle to move or rotate the sketch grid.

Press Shift while dragging to snap the move to angular and linear increments based on your snap settings as
well as to snap the move parallel to planes, edges, and axes. You can also right-click and select Use Ruler
Dimension, and enter a value or press Enter to drag the grid. You can also use the standard Move tool guides
when moving the grid.

The Move handle can be moved around by dragging the center ball onto appropriate entities on the sketch grid.
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Moving the Center of the Sketch Grid

1. Insert an origin.

2. Select an axis of the origin.

3. Switch to Sketch mode.

You can also move the center of the sketch grid while sketching by using the Move Grid or Select New Sketch
Plane tools in the Sketch mini-toolbar.

4.2.3. Sketch Options
The following common sketch options are available in the Options panel for every sketch tool:

• Sketch Options:

º Automatically Create Constraints: When Constraint-based sketching is enabled, select this option to
automatically generate constraints based on shapes created or on snaps. This option is enabled by default.

º Snap to grid: Select this option to turn snapping on or off while sketching. The cursor will snap to the minor
grid spacing increment while you sketch. The defaults are 1mm for Metric and 0.125in for Imperial units. See
Units options to change the minor grid spacing.

º Snap to angle: Select this option to turn angle snapping on or off while sketching. The cursor will snap to the
angular snap increment while you sketch. The default is 15 degrees. See Snap options to change the angular
increment used for snapping.

º Layout Sketch: The sketch curves are created as layout curves. If you move the design to a drawing sheet, with
Sketch mode selected you must select the Layout Sketch check box again in the Sketch Options group of the
Options panel to create layout curves on the drawing sheet. See Layout Curves.

• Dimension Options:

º Cartesian dimensions: Select a point in a sketch and then click this option to see Cartesian dimensions from
the point. Cartesian dimensions show you the X and Y distances from the point you select. If you don't have a
point selected, it shows you the X and Y distances from the origin.

º Polar dimensions: Select a point in a sketch and then click this option to see Polar dimensions from the point.
Polar dimensions show you an angle and a distance from the point you select. If you don't have a point selected,
it shows you the angle and distance from the origin.

º Lock base point: Select this option to dimension to a base point that is locked at a set distance or reference
while sketching.

• Mesh Fit Options: If the Sketch plane passes through a Mesh object, the system will fit curves through the facet
points. Lines are displayed green and arcs are displayed blue. The following options apply to the system-generated
curves.

º Fit curves - Disable this option if you do not want the system to fit curves through the points.
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º Tolerance - Determines how many points will be found, which also determines how many curves will be created.
The smaller the tolerance, the more points will be found and the curves will be generated.

º Auto-merge - When enabled, the system will merge lines and arcs to form splines. Splines are displayed pink.

4.2.4. Sketching with Constraints
You can choose constraint-based sketching to reduce the degrees of freedom (place constraints) on the drawing
objects in 2D drawings and designs. Adding constraints restricts the type and range of movement of the objects,
and links objects such that certain editing tasks on one drawing object will cause linked objects to be modified. Use
tools in the Constraints group in the Sketch tab to add constraints to sketches.

Certain sketching tools included rudimentary tangency and coincident constraints (enabled with the Maintain
Connectivityoption), but these may be overridden during drawing editing. The tools in theConstraints group offer
additional types of constraints which can be applied to any of the standard drawing objects (line, circle, arc, and so
on) and are more robust.

To use constraint-based sketching, ensure that Enable constraint based sketching is selected in the Advanced
options in the SpaceClaim Options.

Saving and Retaining Sketches
You canSaveandOpenmodels containing sketchConstraints. Designs that includeConstraintswill open inSketch
mode. Leaving Sketch mode will trigger the deletion of all constraint data. You need to save a copy of the sketch
with constraints intact before solidifying if you intend to resume the design with constraints.

Note: Sketch constraints are active only in 2D sketch mode. If you switch to 3D mode, existing constraint
data is deleted. If you expect to edit constraints as part of your design workflow, you must save a copy of
the sketch with constraints before switching to 3D mode.

You can also select the Retain Sketch option so that the sketch is not consumed by 3D geometry when sketching
is complete.

• Sketch objects added after retaining the sketch are also retained.

• The sketch and sketch objects remain in the tree until you choose to delete them. To delete the sketch/sketch
objects, select them in the tree and select Delete from the context menu.

After retaining the sketch, you can select the Use for 3D option to create regular curves and surfaces for closed
sketch regions. The original sketch is retained for reuse even after you select Use for 3D.

Removing Interior Surfaces
Use theRemove Interiorsoption to remove interior surfaces that would be created for closed sketch regions within
the sketch on switching to 3D mode. Select the Sketching Plane node in the Structure tree and enable Remove
Interiors from the context menu.

Adding Layout Curves to an Imported Datum
When a .dwg or .dxf file is imported and constraint-based sketching is enabled, use the Add Layout Curves option
to add layout curves to the imported datum. Select the datum in the Structure tree and enable Add Layout Curves
from the context menu.
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Note: If you activate or switch to another sketch, you need to end the sketch before continuing to add layout
curves.

Constraint Types
The following Constraints can be added to your sketch:

• Dimension

• Coincident

• Midpoint

• Concentric

• Fixed

• Horizontal

• Vertical

• Parallel

• Perpendicular

• Tangent

• Equal Radius

• Equal Distance

• Symmetric

• Equal Length

Note:
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• Most of these constraints require two selected drawing objects. The first selection is the target and will
generally be moved to satisfy the constraint. The second is the anchor object and will generally remain in
position. The cursor symbol changes to indicate the type of constraint and whether you are selecting
target or anchor.

For example:

First selection for Parallel:

Second selection for Parallel:

• Fixed, Horizontal and Vertical constraints require only one selected drawing object.

• The Fixed constraint tool acts as a toggle - click an object to apply, click a second time to remove.

• Concentric and Equal Radius constraints propagate when modifying the curves.

• The Equal Distance constraint uses on-screen tool guides to determine the anchor and target. See the
example below.

• Equal Radius constraints are added automatically when you create multiple rounded corners using the
Ctrlkey and theCreateRoundedCorner tool in theModifygroup. All the rounds created this way maintain
an Equal Radius constraint so that changing the size of one will change all of them.

Adding Dimension Constraints
1. Activate the Dimension constraint in the Constraints group.

2. Select an individual sketch object, or two objects as required for certain types of dimensions. Move the cursor
away from the object to position the dimension. The normal behavior for applying and locating dimensions is
observed. However, when applied as a constraint, if you attempt to edit one object, other objects may be modified
to maintain the dimension constraint.

• You can use dimension constraints to modify the size of the selected object. After creating the dimension
constraint, double-click to select the dimension and then modify the value.

• Each dimension is automatically assigned a label. You can also specify labels of your choice.

Note: A valid label should have an alphabet or an underscore (_) as the first character.
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• You can also define dimensions using basic mathematic expressions.

• Dimensions may be positioned vertically, horizontally, or aligned with the object.

• Angle dimensions are supported - select the first object and then hover over the second object until the angle
dimension appears. Move the cursor to position the dimension.

• Arc length dimensions are supported - hold theCtrlkey while selecting the arc to create an arc length dimension.
Move the cursor to position the dimension.

• You can modify the arrow style, expression, label, type of dimension, and precision in the Properties panel.

Adding an Equal Distance Constraint
The Equal Distance constraint uses on-screen tool guides to determine the anchor and target distances, and to
create the constraint. This is because more than one selection is often necessary to create the constraint.

1. Activate the Equal Distance constraint in the Constraints group.

2. With the Target tool guide active, select your moveable drawing object or pair of geometries to define the first
dimension.

A dimension line with the target symbol is added to the design page.

3. Select the Anchor tool guide (or hold the alt key), and then select your stationary drawing object or pair of
geometries.

A dimension line with the anchor symbol is added to the design page.

4. Click the Complete tool guide to create the constraint.

The target object will be modified as required.

Note: A dimension between two lines will force the lines to be parallel.

Adding Symmetric Constraints
1. Activate the Symmetric constraint in the Constraints group.

2. Select the Make ends symmetric option (enabled by default) to make the curve end points symmetric.
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3. With the Select Axis of Symmetry

tool guide active, select the axis about which the sketch objects are to be symmetric.

4. With the Select Curves

tool guide active, select the pair of curves to be made symmetric. The cursor symbol changes to indicate whether
you are selecting target or anchor.

The target object will be modified as required.

Adding an Equal Length Constraint
The Equal Length constraint uses on-screen tool guides to determine the anchor and target lengths, and to create
the constraint.

1. Activate the Equal Length constraint in the Constraints group.

2. With the Target tool guide active, select the target line.

3. With the Anchor tool guide active, select the source line.

`The target line will be modified accordingly.

Using the Autoconstrain Tool
You can use the Autoconstrain tool to find the specified constraint types and automatically set up constraints.

Select Autoconstrain in the Constraints group.

• Select the Curve options to allow points and/or axes to be considered for creating constraints.

• Select the constraints to be automatically set up from the Constraint Options list. The following constraints can
be set up:

º Coincident constraint

º Tangent constraint

º Parallel constraint

º Perpendicular constraint

º Equal radius constraint

º Concentric constraint

Tool guides

The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This tool guide allows you to
select sketch entities that are automatically found by the tool.
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The Select Geometry tool guide allows you to select entities that were not
automatically found. Hold Ctrl to select multiple entities or box select in the design
area.

The Exclude Problem tool guide allows you to exclude entities from selection.

The Complete tool guide adds constraints for the highlighted sketch entities.

Object States
When using constraint-based sketching, you can make sketch objects under-defined, fully-defined, or over-defined.

Select Show Constraint Colors

to view the sketch objects colored based on the object state. This option is enabled, by default.

• Under-defined objects have some degree of freedom and are highlighted cyan in the design window.

• Fully defined objects have no degrees of freedom and are highlighted dark blue in the design window.

• Over-defined objects are highlighted red in the design window. This also applies to dimensionally over-constrained
lines. One or more constraints must be removed before you can proceed with your design.

The sketch properties show the constraints needed to make the sketch objects fully defined.

Note: Large changes on fully defined sketches can be problematic because the first dimension has to resize
and then resolve all others. You should use several small changes to get to a certain size, instead of a large
change that may fail.

For example, if you change a dimension by 30 mm in one go, the other dimensions may not be resolved
correctly, resulting in an invalid dimension. However, if you change the dimension in 5 mm - 10 mm
increments, the dimensions may be resolved correctly.
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Creating Multiple Sketches with Constraints
You can create multiple sketches with constraints on the same sketching plane. The active Sketch node is shown in
bold in the tree and the active sketch is highlighted in the design window.

To activate a different sketch, select the Sketch node in the Structure tree and select Activate Sketch.

Note: Constraints may be applied within sketches on the sketching plane.

Creating a New Sketching Plane
1. Click Select New Sketch Plane

in the mini-toolbar, or right-click and select the Select New Sketch Plane option from the context menu.
2. Hover over any existing geometry to display existing planes.
3. Click to select the highlighted plane and display the sketch grid.

Existing sketches are solidified, and a new Sketch node is added to the Sketching Plane in the tree. The previous
sketch remains active temporarily until you start sketching in the new Sketch.

Note: Coplanar Sketch Constraints can reside on different containing planes.

Viewing Constraints
Select Show Constraint Tips

in the Constraints group to view the constraints applied.

Hover over the constraint tip to see the type of constraint. The geometries involved will be highlighted in green.
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If multiple constraints are applied, click the drop-down to see all the constraints applied.

Deleting Constraints
You can delete constraints using the Delete Constraint

tool in the Constraints group or using the option from the mini-toolbar.

Using the Delete Constraint tool:

Select Delete Constraint

in the Constraints group. The Delete Constraint tool is available when Show Constraint Tips

is enabled.

Select the constraint to be deleted. In case of multiple constraints, click the drop-down and then select the constraint
to be deleted.

Using the option from the mini-toolbar:

1. Right-click a drawing object.

In addition to the context menu, a mini toolbar appears at the cursor location.

2. Click the drop-down next to the Delete icon to see the list of active constraints on the selected drawing object.
For example,

151Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Note: If the drawing object is a point, the mini toolbar and drop-down will be simpler, containing only
the point's constraints. If multiple drawing objects are selected, the drop-down panel will contain the
constraints common to all the selected objects.

Alternatively, click the red X to delete a constraint. The list of active constraints is shown.

3. To check which geometries are involved in a constraint, hover over the constraint's symbol in the drop-down
panel. Geometries involved will highlight in red. For constraints involving a point, the point's parent curve will
highlight dashed as well, to help distinguish it from other overlapping points. If applicable, related constraints
will highlight in yellow. Related constraints will be affected by changes to the highlighted constraint. Circles
constrained to have equal radii could be an example of related constraints.

4. To delete a constraint, click the constraint's symbol in the drop-down panel. The symbol will gray out. If the
sketch was in an over constrained state, the sketch may adjust if a solution is now achievable.

Using Mirror with Sketch Constraints
1. With Constraint-based sketching active, sketch a line in the desired mirror position.

2. Use the right-click context menu, select Set as Mirror Line to set up the mirror.

3. With multiple Mirror Lines, entities are mirrored about each mirror line whether they are perpendicular or not.

4. To stop creating mirror constraints, uncheck Set as Mirror Line.
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Note:

• Splines are not supported with a Mirror Line, but the other Sketch tools are.
• A Fixed constraint is automatically applied to the mirror line to ensure more predictable dragging. It is

possible to delete this constraint but dragging behavior may deteriorate.
• EqualRadius constraints are made automatically when creating multipleRoundedCornerswithaMirror
Line.

• To deleteMirror (Symmetry) constraints individually, click an entity to open the mini toolbar. Individual
constraints can be removed using the Delete drop-down menu.

Note: 1D Patterns and 2D Patterns are not supported for Constraint-based sketching.

Referencing Existing Geometry
It is possible to create constraints and dimensions to cross-sections and edges that lie in the sketch plane. Such
cross sections and edges are treated as reference curves and will not be changed. Creating a Sketch Constraint
or dimension requires at least one non-reference curve to allow for the constraint to be satisfiable.

4.2.5. Sketch Tools
This section contains the following topics:
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4.2.5.1. Lines
Use the Line tool to sketch lines in 2D or to draw lines between points on objects in 3D. These lines will become
edges when you pull your sketch into a solid with the Pull tool.

The sketch grid must be visible in the workspace before you can draw.

Drawing Lines on a Sketch Plane
1. Click

Line in the Sketch group or press L.

2. If a sketch plane is not active, click an object or objects in the Design window to make a sketch plane.

3. Click to set the first point of the line.

You can dimension the points relative to other objects.

4. Continue selecting points to draw line segments.

If you want any section of the line to be an arc, right-click and select Switch to Arc, then click to set the radius.
Right-click and selectSwitch to Line to return to drawing straight lines between points. You must create at least
one line segment before using this option.

5. End the line:

• Double-click to set the end point of the line.

• Right-click and select Finish Line.

• Press Esc.

• Connect the end point to the start point.

• Click any tool (except the Clipboard and Orient tools).

Note: Click and drag to draw one straight line.

Drawing Lines Between Points in 3D
1. Select Enable 3D Sketch.

2. Click
Line in the Sketch group or press L.

3. (Optional) Select Define line from center in the Options panel to start drawing the line from its center instead
of an end.

4. Click to set the first point of the line.
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Select any point on an object in your design.

5. Continue selecting points to draw line segments.

6. End the line:

• Double-click to set the end point of the line.

• Right-click and select Finish Line.

• Press Esc.

• Connect the end point to the start point.

• Click any tool (except the Clipboard and Orient tools).

Example: Sketching a line between two solids in 3D

Using a Line as a Mirror
Right-click the line and select Set as Mirror Line.

Toggling Between a Line and a Construction Line
Right-click the line and select Construction On/Off.

Options
The common sketch options are described in Sketch Options on page 143.

The following additional options are available in the Options panel:

Select this option to sketch a line from the center. Click
to define the center of the line, then click again to set the
length. You can also drag to draw the line.

Define line from center

4.2.5.1.1. Tangent Lines
Use the Tangent Line tool to sketch lines tangent to any curves in your design.

The sketch grid must be visible in the workspace before you can draw.
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Drawing a Tangent Line on a Sketch Plane
1. Click

Tangent Line in the Sketch group.

The tool is disabled if there are no curves or lines in the sketch plane.

2. Click the curve you want to draw tangent to.
3. As you move the mouse, the start point moves so that the line remains tangent to the curve.

The tangency indicator shows you how the new line will be tangent with existing geometry if you click the current
cursor location.

4. (Optional) Dimension the line with a length.

You cannot dimension from another sketch object when creating a tangent line.

5. Click to set the end point of the line.

If you move your mouse over another curve, the line snaps so that it is tangent to the second curve. Hold Alt to
stop your cursor from snapping to curves.

The common sketch options are described in Sketch Options on page 143.

Drawing Tangent Lines between Points in 3D
1. Select Enable 3D Sketch.

2. Click
Tangent Line in the Sketch group.

3. Click to set the first point of the line.

Select any point on an object in your design.

The tangency indicator shows you how the new line will be tangent with existing geometry if you click the current
cursor location.

4. Click to set the end point of the line.

Using a Tangent Line as a Mirror
Right-click the line and select Set as Mirror Line.

Toggling Between a Tangent Line and a Construction Line
Right-click the line and select Construction On/Off.

4.2.5.1.2. Construction Lines
Use the Construction Line tool to draw lines that help you create an accurate sketch. Construction lines become
axes in 3D. They are also useful for creating mirrors.

The sketch grid must be visible in the workspace before you can draw.
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Drawing a Construction Line
1. Select the Construction Line tool

from the Sketch ribbon group.

2. (Optional) Dimension the first point relative to another sketch object.

3. Click to set the first point of the line.

4. (Optional) Dimension the line.

5. Click or press Enter to end the line.

By default, the line is dimensioned to its start point, but you can dimension to another sketch object.

The common sketch options are described in Sketch Options on page 143.

Using a Tangent Line as a Mirror
Right-click the line and select Set as Mirror Line.

Toggling Between a Line and a Construction Line
Right-click the line and select Construction On/Off.

4.2.5.2. Rectangles
Use the Rectangle tool

in the Design tab or press R to draw a rectangle along the axes of the sketch grid. When you exit the sketch, any
rectangles become surfaces, and the lines become edges of a rectangular solid when you pull your sketch into 3D
with the Pull tool.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Rectangle
1. Click

Rectangle in the Sketch group or press R.
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2. (Optional) Select Define rectangle from center in the Options panel to start drawing the rectangle by clicking
the point for its center instead of a corner.

3. Click to set the first corner.

Move your mouse over the sketch grid to preview the rectangle. Dashed lines appear when you create a square
or golden rectangle.

You can dimension the points relative to other sketch objects.

4. Click to set the opposite corner of the rectangle.

Options
The common sketch options are described in Sketch Options on page 143.

The following additional options are available in the Options panel:

Select this option to sketch rectangles from their centers.
Click to define the center of the rectangle, then click again
to set the length of the sides. You can also drag to draw
the rectangle. Hold the Alt key while drawing a rectangle
to toggle this option on-the-fly.

Define rectangle from center

Examples

Sketching a square

Sketching a rectangle from its center

4.2.5.2.1. Three-Point Rectangles
Use the Three-Point Rectangle tool to quickly sketch a rectangle at any angle on the sketch plane. These lines will
become the edges of a rectangular solid when you pull your sketch into 3D with the Pull tool.

The sketch grid must be visible in the workspace before you can draw.
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Drawing a Three-Point Rectangle
1. Click

Three-Point Rectangle in the Sketch group.

2. (Optional) Select Define rectangle from center in the Options panel to start drawing the rectangle by clicking
the point for its center instead of a corner.

3. Click to set the first corner of the rectangle.

Move your mouse over the sketch grid to preview the rectangle. Dashed lines appear when you create a square
or golden rectangle.

You can dimension the points relative to other sketch objects.

4. Click to set the length of the second side.

Note: Click and drag to draw the first side, then click to set the length of the second side.

Options
The common sketch options are described in Sketch Options on page 143.

The following additional options are available in the Options panel:

Select this option to sketch rectangles from their centers.
Click to define the center of the rectangle, then click again
to set the length of the sides. You can also drag to draw
the rectangle. Alt+drag or Alt+click to return to the
standard behavior when the option is selected.

Define Rectangle from Center

4.2.5.3. Ellipses
Use the Ellipse tool to sketch an ellipse in 2D. The ellipse can become an elliptical solid or hole when you pull your
sketch into 3D with the Pull tool. You can also sweep the ellipse in 3D, or rotate it.

The sketch grid must be visible in the workspace before you can draw.
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Drawing an Ellipse
1. Click

Ellipse in the Sketch group.

2. Click to set the center of the ellipse.

You can dimension the points relative to other sketch objects.

3. Click to set the overall length and angular orientation of the first axis.
4. Click to set the length of the second axis.

The common sketch options are described in Sketch Options on page 143.

4.2.5.4. Circles
Use the Circle tool to sketch a circle in 2D when you know the location of the circle's center and a point on the circle's
edge, or the radius or diameter. The circle can become a cylinder or hole when you pull it into 3D with the Pull tool,
or a sphere or torus if you rotate or sweep it.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Circle
1. Click

Circle in the Sketch group or press C.

2. Click to set the circle's center.

You can dimension the points relative to other sketch objects.

3. Click to set the circle's diameter.
4. The circle will snap to existing sketches or determined circles and arcs in the plane of the sketch.

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by editing
its dimension, tangency with the other circle is maintained.

If you drag the center of a circle that is tangent to another circle, the radius of the other circle changes to maintain
tangency.

The common sketch options are described in Sketch Options on page 143.
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Examples

Editing a tangent circle by dragging the circle's center with tangency is maintained.

4.2.5.4.1. Three-Point Circles
Use the Three-Point Circle tool when you don't know the center of the circle, but you know where the edge of the
circle must be. This tool works with any combination of free points, known points, or tangent attachments. The
circle will become a cylinder or hole when you pull it into 3D with the Pull tool. You can also rotate the circle about
a line to make a sphere or torus.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Three-Point Circle
1. Click

Three-Point Circle in the Sketch group.

2. (Optional) Select Three-point circle segment in the Options panel to create an arc that is a segment of a
three-point circle.

3. Click to set the first point on the circle's edge.

If you click a curve or line, the circle will be drawn tangent to the curve or line, unless you click the midpoint or
vertex.

You can dimension the points relative to other sketch objects.

4. Click to set the second point on the circle's edge.

If the circle disappears as you move your mouse over the sketch grid, then the cursor location cannot be included
in any circle drawn through the first two points and the current point. If you click a curve or line, the circle will
be drawn tangent to the curve or line unless you click the midpoint or vertex.

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by editing
its dimension, tangency with the other circle is maintained.

5. Click to set the last point on the circle's edge.

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by editing
its dimension, tangency with the other circle is maintained.

161Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



If you drag the center of a circle that is tangent to another circle, the radius of the other circle changes to maintain
tangency.

Options
The common sketch options are described in Sketch Options on page 143.

The following additional options are available in the Options panel:

Enable this option to create an arc that is a segment of a three-point circle.
To create an arc with this option, click to set the first point, click to set the
second point, then specify the diameter or click to set the final point.

Three-point circle segment

Examples

Editing a tangent circle by dragging the circle's center, tangency is maintained

Dragging (with the Select tool) a three-point circle drawn through a rectangle's vertex maintains the connection

4.2.5.5. Arcs
This section contains the following topics:

4.2.5.5.1. Tangent Arcs
Use the Tangent Arc tool to sketch an arc that is tangent to a curve or line in your design. This arc will become an
edge when you pull your sketch into 3D with the Pull tool.

The sketch grid must be visible in the workspace before you can draw.
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Drawing a Tangent Arc
1. Click

Tangent Arc in the Sketch group.

The tool is disabled if there are no curves or lines in the sketch plane.

2. Select the line or curve you want to draw tangent to.

This is usually the end point of a line, arc, or spline, but it can be on the line. If two lines share an end point, use
the scroll wheel to set tangency to the other line.

3. (Optional) Dimension the radius and chord angle.

4. Click to set the end point of the arc.

The arc cannot end on its start point to make a circle or end on the same line as its start point.

The common sketch options are described in Sketch Options on page 143.

Drawing a Tangent Arc Between Points in 3D
1. Select Enable 3D Sketch.

2. Click
Tangent Arc in the Sketch group.

3. Click to set the first point of the arc.

Select any point on an object in your design.

The tangency indicator shows you how the new arc will be tangent with existing geometry if you select the current
cursor location.

4. Click to set the end point of the arc.

Editing a Tangent Arc
Drag the arc to edit it. When you drag a tangent arc, it increases its radius while maintaining its chord angle.
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Examples

Arc sketched tangent to two circles

Editing a tangent arc maintains its connections

4.2.5.5.2. Three-Point Arcs
Use the Three-Point Arc tool to create an arc by specifying its start and end points, and the radius or chord angle.
This arc can be created tangent to another arc, line, or spline at its start. The arc will become an edge when you pull
your sketch into 3D with the Pull tool. As an option, you can also create a Three-Point Arc in 3D mode.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Three-Point Arc
1. Click

Three-Point Arc in the Sketch group.

2. Click to set the start point of the arc.

If the start point is on another line, arc, or spline, then the arc will initially be drawn tangent to that line, arc, or
spline.

You can dimension the point relative to other sketch objects.

3. Click to set the end point of the arc.

4. Click to set the arc's radius.

You can dimension the chord angle or radius.

The arc will snap to tangent objects.

The common sketch options are described in Sketch Options on page 143.
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4.2.5.5.3. Swept Arcs
Use the Sweep Arc tool to create an arc with a known center and end points. Tangency is not a factor in the creation
of this arc. The arc will become an edge when you pull your sketch into 3D with the Pull tool.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Swept Arc
1. Click

Sweep Arc in the Sketch group.

2. Click to set the center of the arc.

You can dimension the point relative to other sketch objects.

3. Click to set the start point and radius of the sweep circle.

You can dimension the chord angle or offset the angular dimension.

4. Click to set the end point of the arc.

The common sketch options are described in Sketch Options on page 143.

4.2.5.6. Polygons
Use the Polygon tool to draw a polygon with between 3 and 64 sides. You can dimension the location of the axis,
the length of the radius, the orientation angle, and set the number of sides as you sketch the polygon.

The sides of a sketched polygon maintain their relationship to each other. When you pull a polygon into 3D, faces
with a polygon relationship are displayed with a pattern when you select the solid. Changing one face or edge affects
all the faces in the relationship.
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Drawing a Polygon
1. Click

Polygon in the Sketch group.

2. (Optional) Select Use internal radius in the Options panel to dimension the polygon based on the diameter of
a circle inscribed within the polygon. Uncheck the option to dimension the polygon based on a circumscribed
circle.

3. Click to set the center of the polygon.

You can dimension the points relative to other sketch objects.

4. Drag the mouse to draw the polygon and change its orientation.

The orientation is the polygon's angle relative to the X and Y axis.

You can press Tab and type a number to change the diameter, orientation, or number of sides.

5. Click to complete the polygon.

The sides of the polygon are all related, and act as one object. When pulled in 3D, the edges and faces of the
polygonal solid will also maintain this relationship.

Tip If you trim a polygon sketch with the Trim Away tool, you can drag the original sides of the polygon with the
Select tool to recreate the polygon.

Setting the Number of Sides
Press Tab and type a number while you draw a polygon.

or

1. In Sketch mode, select the polygon with the Select tool.

2. Right-click the polygon and select Properties.

3. Enter a value for the Number Of Sides property.

Polygons can have a minimum of 3 sides, and a maximum of 64 sides.

Removing the Polygon Relationship from the Faces of a Polygon Solid
Right-click a face of the polygon and select Remove Association.

Any changes you make to the face of the polygon will affect only that face.

Options
The common sketch options are described in Sketch Options on page 143.

The following additional options are available in the Options panel:
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Select this option to dimension the
polygon based on the diameter of a
circle inscribed within the polygon.
Uncheck the option to dimension the
polygon based on a circumscribed
circle. In the image below, the blue
circle is inscribed within the polygon
and the orange circle is circumscribed
around it.

Use internal radius

Examples

Hexagonal head nut

A polygon pulled into a solid maintains the relationships between its sides. In this example, pulling one side pulls
all sides of the polygon.

4.2.5.7. Splines
This section contains the following topics:
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4.2.5.7.1. Creating a Spline
Use the Spline tool to sketch splines in 2D or to draw splines between points on objects in 3D. A spline is a continuously
curved line, without sharp boundaries (that is, without vertices). Splines can become edges when you pull your
sketch into 3D with the Pull tool. Sweeping along a spline in 3D lets you create smooth, curvy shapes.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Spline on a Sketch Plane
1. Click

Spline in the Sketch group.

2. If a sketch plane is not active, click an object or objects in the Design window to make a sketch plane.

3. Click to set the first point of the spline.

HoldAlt and click to set the point if you want it to be tangent with an adjacent sketch or edge. When highlighting
the vertex (which is actually an end point of one of the intersecting edges which has influence at the time) scroll
the mouse wheel to select other adjacent edges with which to set the tangent vector direction, as previewed by
the green tangency symbol.

4. Click to set the next points of the spline.

You can Dimension spline points by entering the coordinate distance from the start point to each point, or
dimension each point relative to another sketch object.

5. End the spline:

• Double-click to set the end point of the spline.

• Hold Alt and click to make the end point tangent with an adjacent sketch or edge.

• Right-click and select Finish Spline.

• Press Esc.
• Connect the end point to the start point.

• Click any other tool (except the Clipboard and Orient tools).

The common sketch options are described in Sketch Options on page 143.

Drawing a Continuous Spline
1. Click

Spline in the Sketch group.

2. Select Draw continuous spline from the Spline section of the Sketch options panel.

3. Click and drag to draw the spline.
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4. Release to finish drawing.

Dawing a Spline Between Points in 3D
1. Select Enable 3D Sketch.

2. Click
Spline in the Sketch group.

3. Click to set the first point of the spline.

Select any point on an object in your design.

HoldAlt and click to set the point if you want it to be tangent with an adjacent sketch or edge. When highlighting
the vertex (which is actually an end point of one of the intersecting edges which has influence at the time) scroll
the mouse wheel to select other adjacent edges with which to set the tangent vector direction, as previewed by
the green tangency symbol.

4. Continue selecting points to draw spline points.

5. End the spline:

• Double-click to set the end point of the line.

• Hold Alt and click to make the end point tangent with an adjacent sketch or edge.

• Right-click and select Finish Line.

• Press Esc.
• Connect the end point to the start point.

• Click any tool (except the Clipboard and Orient tools).

Creating a Closed Spine
You can create a closed spline in the following ways:

• When drawing a spline, end it on the start point.

• When editing the spline, drag one end point on top of the other point.

Once you have created a closed spline, you cannot edit it into an open spline.

Examples

Sketching a spline between points in 3D

4.2.5.7.2. Editing a Spline
You can drag a spline, its spline points, or its control points while the Select tools is active. You can be in 2D or 3D
mode.
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Spline points are the points along the spine that define the position of its curves. Spline points are displayed as
circles when you hover over a spline.

Control points are displayed outside of the spline, and define the curvature of the spline between points. Control
points are displayed as diamonds connected by a dotted line when you select a spline.

Moving a Spline
1. Click the Select tool in the Edit group on the Design tab while in 2D mode.

2. Mouse over the spline to highlight the spline and display its defining points.

3. Click anywhere on the spline except for the defining points, and drag it to move it.

Editing a Spline
1. Click the Select tool in the Edit ribbon group while in 2D mode.

2. Mouse over the spline to highlight the spline and display its defining points.

3. Click and drag on any spline or control point to move it, leaving the other spline and control points fixed in space.

You can box-select spline points.

4. (Optional) Edit the dimensions associated with that point.

Changing Spline End Points
1. Select the spline to display its end point control handle.

The end point control handle is a light blue point at the end of a dotted line extending outwards from the end of
the spline. In some cases, these end points may be located some distance away from your sketch. Zoom out
from the sketch until you can see the end point control handle.

If another line, arc, or spline shares that end point, the end point influence may snap into tangency with that
sketch entity. To adjust the end point influence in this case, move the mouse a short distance away from the end
point to display the end point control handle.

After it is moved, the end point will snap to its original tangency.

2. (Optional) In 3D, hold Alt and select a planar or linear object that you want the spline to be tangent with. You
can hold Alt and select a curve, edge or face if the curve, edge or face passes through the point. If you select a
face, the tangency at the point where the point intersects the curve or surface is used. The default is the tangency
direction with the least amount of curvature.

3. Drag the end point control handles to change the influence of that end point on the shape of the spline.

The control handle will snap back to its initial tangent direction, which is indicated by a dotted line.

The amount of the end point's influence can be controlled by dragging the end point control handle closer to or
further away from the end point.

170Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Adding Spline Points
1. Click the Select tool in the Edit group on the Design tab while in 2D mode.

2. Mouse over the spline to highlight the spline and display its defining points.

3. Right-click anywhere on the spline except on the defining points, and select Add Knot to create another spline
point at that location.

Removing Spline Points
1. Click the Select tool in the Edit group on the Design tab while in 2D mode.

2. Click the spline to highlight it and display its defining points.

3. Right-click the point you want to remove and select Remove Spline Point.

The spline adjusts to accommodate the removal of the point.

Changing the End Point Tangency of a Spline
1. Click the Select tool in the Edit group on the Design tab while in 2D mode.

2. Select the spline in the Design window.

3. Set the value for Periodic in the Properties panel:

• True: If you change this property to True, the tangencies of the beginning and end of the spline curve will match
to create a closed curve. If a spline curve is open and you set the property to True, the spline will be closed, as
shown here:

• False: If you change this property to False, the end tangencies of a closed curve don't match. If a spline curve
is closed and you set the property to False, the curve will become teardrop-shaped because the end points
will no longer be tangent, as shown here:

Extending a Spline by Pulling
1. Click the Pull tool in the Edit group on the Design tab while in 3D mode.

2. Click an end point of the spline and drag in the direction of the Pull arrow.

You can also click the end point, click the Up To tool guide, then click the object up to which you want to pull.
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Examples

Dragging a spline point

Dragging a control point

Dragging end point control handles in 3D

4.2.5.8. Points
Use the Point tool to sketch points in 2D and 3D. Points are useful as a dimensional reference, for splitting, and for
creating a point on a line or curve through which you want to draw a three-point circle. You can also project vertices
in 3D to create points in the sketch.

The sketch grid must be visible in the workspace before you can draw.

Drawing a Point
1. Click

Point in the Sketch group on the Design tab.

2. Select a mode:
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• If a sketch plane is not active, press Esc to sketch in 3D or click an object or objects in the Design window to
make a sketch plane.

• If a sketch plane is active, click 3DMode in the Mode group or press D to sketch in 3D.

3. (Optional) Dimension the point relative to another object.
4. Click to place a point:

• On a face or surface: click a location on a face or surface.

• On an edge or curve: click a location on the edge or curve.

• On themidpoint of a straight line between two points in 2D: hold Alt and Shift and select two points, then
click the temporary point at the midpoint.

• On themidpoint of a straight line between two points in 3D: select two points.

• Projected onto a face: select a point and then a face to project onto.

• Projected onto an edge: select a point and then an edge to project onto.

• In a UV direction within a face/surface: select an existing point on a face and then a location on the face to
specify the direction.

• Along an edge from an existing point on the edge: select a point on an edge and a location along the edge.

You can also use temporary points, axes, and planes to help you create points. When hovering over, or selecting
on a point with the Select tool, the X, Y, Z locations of the point display in the status bar.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use the Select tool guide to select a location for the point.

Use the Select Direction tool guide to change the direction of the dimension for the
point.

The common sketch options are described in Sketch Options on page 143.

4.2.5.9. Trimming and Modifying
This section contains the following topics:

4.2.5.9.1. Creating Rounded Corners
Use the Create Rounded Corner tool to trim back or connect two intersecting lines or arcs so that they meet with an
arc tangent at both ends. You can also use this tool with coplanar 3D lines, such as lines you created by blending.

The sketch grid must be visible in the workspace before you can create rounded corners, which are also known as
fillets.
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Connecting Two Lines with a Rounded Corner
1. Click

Create Rounded Corner from the Sketch group on the Design tab.

2. Select a line or arc.

The first line or arc you select will be extended, if necessary.

3. Hover over another line to preview the round that will be created.

If you hover over a line that is the edge of a solid, that edge will not change. Only a sketched line will change. The
radius of the arc is previewed as you move the mouse. Specify a radius to dimension it.

4. Select an intersecting line to trim the lines, or a non-intersecting line to connect the lines.

Where you click the intersecting line defines the radius of the tangent arc, or you can dimension the round (or
chamfer) by entering its diameter.

If the lines intersect, click the part of the intersecting line you want to keep. If the lines do not intersect, you can
click anywhere on the line to extend the first line to form a rounded corner. Circles are never trimmed.

For lines that meet at a corner, you can select and drag the vertex.

You can also select the tool first and then make your selection.

Creating Multiple Rounded Corners using Ctrl
1. Sketch some curves with several vertices (for example, a rectangle).
2. Enter the Create Rounded Corner tool.
3. Click a corner vertex and drag to preview the round.

4. Press and hold the Ctrl key

• The preview disappears
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5. While holding Ctrl, click another corner vertex. Then release the Ctrl key and move the mouse to preview BOTH
rounds.

6. Press and hold the Ctrl key

• The preview disappears

7. Repeat for the remaining corners.
8. On the last corner (meaning no more Ctrl key selection), you will see all rounds previewing simultaneously.
9. Click to place the rounds or specify a radius value
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Editing a Rounded Corner
Drag the rounded corner with the Select tool to change its radius. Tangency is maintained.

Options
The following options are available with the Create Rounded Corner tool.

Create an equal-sided chamfer instead of an arc.Chamfer Mode

Leave the underlying lines instead of removing them.Disable Trimming

Examples

Rounding a corner with the Chamfer Mode option

Rounding a corner with the Disable Trimming option
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Rounding a corner where the first line selected is extended

Rounding corners of 3D lines, then sweeping to create a pipe

4.2.5.9.2. Creating Corners
Use the Create Corner tool to trim back or extend two lines so that they meet at a corner.

The sketch grid must be visible in the workspace before you can create corners.

Connecting Two Lines with a Corner
1. Click

Create Corner in the Sketch group.

2. Click a line, arc, or spline.

3. Hover over another line to preview the corner that will be created.

If you hover over a line that is the cross-section edge of a solid or a silhouette edge, it will not change. Only a
sketched line will change.

4. Click an intersecting line to trim the lines, or a non-intersecting line to extend the lines.

5. If the lines intersect, click the part of the intersecting line you want to keep. If the lines do not intersect, you can
click anywhere on the line to extend the lines to form a corner.
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Options
The following options are available in the Create Corner tool:

If you select this option and click the first line, then click a second, non-intersecting
line, you extend the first line, but not the second. If the two lines intersect, the first
line is trimmed by the second line.

Trim/Extend curve

Examples

Creating a corner between arcs.

Extending a spline to the intersection with another sketch curve.

4.2.5.9.3. Trimming Lines
Use the Trim Away tool to delete any line portion bounded by an intersection with a line or edge.

Note: Line segments to be removed appear in red.

The sketch grid must be visible in the workspace before you can trim lines.

Deleting a Bounded Line
1. Click

Trim Away in the Sketch group or press T.

2. Mouse over a line to preview the section that will be deleted.

3. Click to delete the highlighted line section.

The portion of the line you clicked is deleted up to any intersection with another 2D line or edge of a solid.
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4.2.5.9.4. Offsetting Curves
Use the Offset Curve tool to create an offset of any curve in the grid plane. If you are creating an offset spline, you
will get the best results with an offset distance appropriate to the curvature of your spline.

The sketch grid must be visible in the workspace before you can create offset curves.

Offsetting a Curve
1. Click

Offset Curve in the Sketch group on the Design tab.

2. Select the curves you want to offset.

Standard curve selection techniques apply, so you can double-click to select connected loops of curves. Ctrl and
Shift can also be used to extend or replace the selected items prior to offsetting.

You can also use box, lasso, and paint select modes to select multiple sketch curves. See Using the radial menu
to learn how to access these select modes.

If you select more than one curve, then they will be merged when they are offset.

To clear the current selection, click an empty spot in the Design window.

3. Hover the mouse over a line or point and press Shift to create an offset from that curve or point.

As you move the cursor away from the selected curve, you can see a preview of the offset result. The offset defaults
to one grid square.

4. (Optional) Select an option to specify how intersecting offset curves should meet.

5. Enter a dimension or click to set the width of the offset.

Options
The following options are available in the Offset Line tool:

Close intersecting offset lines with a corner.
Close with corner

Close intersecting offset edges with an arc.
Close with arc

Close intersecting offset edges with a curve.
Close naturally

Create two offset lines on either side of the selected line.Offset both ways
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Example

Highlighted line offset using each option. Shown from top to bottom: Close naturally, Close with corner, and Close
with arc.

4.2.5.9.5. Splitting Curves
Use the Split Curve tool to split one curve with another curve or point. You can also use a 3D object that intersects
the curve, such as a plane or face. The segments of the split curve can then be selected and edited independently.

The sketch grid must be visible in the workspace before you can split curves.

Splitting a Curve
1. Click

Split Curve in the Sketch group.

2. Click the curve you want to split.

3. Click a curve or point that intersects the curve you want to split. The curve will be split at the intersection.

4.2.5.9.6. Bending
Use the Bend tool to bend straight lines and edges to form an arc. You can also use the Bend tool to adjust the radius
of arcs and arced edges. Bend works on straight lines when you are sketching and when you are editing in
cross-section.

You can insert a point curve text file to make a complicated bend.
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Bending a Line of Edge
1. Click

Bend in the Sketch group.

2. If you are working in Section mode, select the face that contains the edge.

3. Click and drag a line or arc to bend it or change its radius.

Enter a value to dimension the radius.

The common sketch options are described in Sketch Options on page 143.

4.2.5.10. Inserting a Face Curve
You can draw spline curves on a 3D face using the Face Curve tool. These curves follow the contour of a face. The
face curve can be used like any other edge to modify the object.

Inserting a Face Curve
1. Click

Face Curve in the Insert group on the Design tab.

2. Click spots on the faces or edges of a part to draw the spline curve. Your spline can be drawn on one or more
faces, but can only be drawn on one object.

Face curves can also be sketched on mesh bodies by selecting facet points as spline points.

3. Double-click to end the curve or close the curve by clicking on your beginning point.

Now you are in editing mode and can change the curve as desired. The curve will not be applied to your design
until you complete the operation.

4. (Optional) Right-click a spot on the curve and select Add Face Curve Point to add a spline point.

5. (Optional) Right-click a spline point and select Remove Face Curve Point to delete the point.

6. (Optional) Drag points to change the curve.
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7. (Optional) Set the value for Periodic in the Properties panel:

• True: If you change this property to True, the tangencies of the beginning and end of the curve will match to
create a closed curve. If a curve is open and you set the property to True, the spline will be closed.

• False: If you change this property to False, the end tangencies of a closed curve don't match. If a curve is closed
and you set the property to False, the curve will become teardrop-shaped because the end points will no longer
be tangent.

8. Click the Complete tool guide or press Enter to apply the curve to your design.

Tip: You will get much more predictable results if the face to face boundaries you are drawing over are tangent. Click
the edges (tangent or not) to place a point for more control over the intersection point at that boundary.

Tool Guides
The Complete Face Curve tool guide creates the face
curve.

Examples

Sketching a face curve that is closed over tangentially-connected solid faces

The result of offsetting the edges that were created as a result of the face curve above

4.2.5.11. Projecting onto the Sketch Grid
Use the Project to Sketch tool to copy an edge or vertex of a solid to a 2D line or point that you can manipulate with
the sketch tools. You can also project a note onto the sketch grid. Projecting an axis onto the sketch grid creates a
construction line.

Except when explicitly selecting a new sketch plane, this is the only sketch tool that can select items that are not on
the sketch grid. You can also select note text and project the text onto your sketch.

The sketch grid must be visible in the workspace before you can project edges onto it.

You can project a body onto a layout sketch plane on a drawing sheet.

182Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Projecting an Edge, Vertex, or Note onto the Sketch Grid
1. Click

Project to Sketch in the Sketch group on the Design tab.

Mouse over your design to highlight the objects available for projection.

2. Click the edge, edge chain, vertex, or note text you want to project into the sketch plane.

Standard edge selection methods apply, so you can double-click, Ctrl+click, and Shift+click to create or modify
your selection.

You can also click and drag to draw a selection box enclosing the objects you want to project, including silhouette
edges.

The edge, vertex, or text appears as a sketched line to show that it is now a line or point in the sketch plane.

Duplicate edges (that appear on top of each other) in the sketch are consolidated when you return to 3D mode.

Tip If you have difficulty seeing a projected line, check that Fade Scene Under Grid is selected on the Display
tab.

Projecting a Solid onto a Sketch Grid
1. Click

Project to Sketch in the Sketch group on the Design tab.

2. Click the Select Bodies tool guide if you want to select bodies in the design window.

You do not need the tool guide to select bodies in the Structure tree.

3. Select one of the following options:

• All body edges if you want all edges projected onto the sketch grid.

• Visible body edges if you want only the visible, or silhouette, edges projected onto the sketch grid.

• Bodyoutline if you want to just project the body outline. Select a body in the Design window or Structure tree.

Examples

Projecting all body edges to the sketch grid
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Projecting the body outline to the sketch grid

It may be necessary to use the tools in the Fix Curves group on the Repair tab if the sketch does not automatically
close into a surface.

4.2.5.12. Sketch Equations
Use the Equation tool

in Sketcher to create curves based on mathematical equations.

You can select from a number of preset equations or write custom equations in Sketcher.

The image below shows a Sine Wave equation.

The equation is constructed in the Options panel. The image below shows the equation for the Sine Wave shown
above.
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You can enter an equation in the input fields for X and Y. Z is for 3D equations. You can enter a value to offset the
curve in the Z-direction.

Clicking the icon to the right of the X, Y, or Z input fields opens an editor for more complex equations.

Use the Equation tool

in the Design tab to create 3D curves and surfaces based on mathematical equations.

Creating a Preset Equation
1. Click the Equation tool

in the Design tab
2. (Optional) Click the Set Grid Location tool guide

and select a different sketch plane
3. Choose an equation from the Curve Types dropdown list in the Options panel
4. Edit the equation as needed in the Options panel
5. Click Complete to create the equation curve

Creating a Custom Equation
1. Click the Equation tool

in the Design tab
2. (Optional) Click the Set Grid Location tool guide

and select a different sketch plane
3. Choose Custom in the Curve Types dropdown list in the Options panel
4. Enter the equation in the input panels
5. To create a Parameter to use in the equation enter it in square brackets "[ ]"
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For example: [L]•
• The parameter is added to the Parameters list in the Options panel

6. Click Complete to create the equation curve

Saving a Custom Equation
The Save Custom Equation button next to the Curve Types dropdown menu allows you to save your custom
equations. They are saved to an XML file in the following location:

%APPDATA%\Roaming\SpaceClaim\SketchEquationCustoms.xml

Saved equations are added to the Curve Types dropdown menu and can be used in other documents and across
multiple sessions. If you do not see a newly saved equation in the list. open/create a new document or close and
re-open the current document.

Editing an Equation Curve
1. Click the Equation tool

in the Design tab
2. The Select Curve tool guide

is active
3. Select the curve to edit
4. (Optional) Click the Set Grid Location tool guide

and select a different sketch plane
5. Edit the equation as needed in the Options panel
6. Click Complete to create the equation curve

Editing an Equation Curve in 3D is limited to the range of the equation. For example, if a Sine curve has a range of
4π, you can Pull an end to anywhere within the that range. You cannot make it longer (for example, 6π)

If the curve has been Split, the ends of any of the pieces can be Pulled within the range of the original equation.

Scaling an Equation Curve
Use the Scale parameter and slider in the Options panel to scale an equation curve.

The Scale tool in Sketcher and 3D scaling with the Pull tool also work on equation curves.

Syntax and Predefined Functions
• Parameters include a name and are enclosed in square brackets [L]
• Functions include a function name followed by parenthesis containing any values as arguments

º For example: Sine([t]-[r])

• The table below shows common predefined functions included

DescriptionName

Returns the absolute value of a specified numberAbs
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Returns the angle whose cosine is the specified numberAcos

Returns the angle whose sine is the specified numberAsin

Returns the angle whose tangent is the specified numberAtan

Returns the cosine of the specified angleCos

Returns the sine of the specified angleSin

Returns the square root of the specified numberSqrt

Returns the tangent of the specified angleTan

Preset Curve Examples
The preset curves include those shown in the following table. All curves have default values.

Involute of CircleSine Wave

Lemniscate
(Bernoulli)

Cosine Wave

LimaҫonArchimedesSpiral

LissajousCatenary
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Logarithmic
Spiral

Epicycloid

Normal
Distribution

Epitrochoid

TractrixHypocycloid

TrochoidHypotrochoid

There are also 3D curves included in the presets. These are shown in the table below. All curves are at default values.

SlinkyHelix
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Viviani'sLine

4.2.5.13. Scaling Sketches
Use the Scale tool to display control handles that you can use to manipulate a 2D object. The Scale tool also works
in Section mode on solids with only planar faces.

The Scale tool works for sketches that lie on a plane. If you need to scale sketches that lie on multiple planes, see
Scaling sketches with Pull.

Scaling, Rotating, or Panning an Object
1. Click

Scale in the Sketch group on the Design tab.

2. Select a drawing or clipping plane.

3. Select any 2D object (including arcs and splines) or 3D edge.

You can hold Ctrl or draw a box in the Design window to select multiple objects.

You can select individual spline points to change part of a spline curve.

4. Scale, rotate, or pan the object by doing the following:

• Scale: Drag the white control handle. You can press Shift while dragging to lock the aspect ratio. You can also
enter a dimension, including a percentage (such as 50%).

• Rotate: Drag the green control handle.

• Change the center of rotation and scaling: Drag the pink circle.

• Pan: Move the mouse over the dashed border so it changes to a solid line then drag the boxed object(s).

Options
The following option is available in the Scale tool:
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Select this option to keep the ratio between the sides the
same when you drag or enter a dimension. You can also
Shift+drag to keep the aspect ratio without selecting this
option.

Fix aspect ratio

Move and rotate the scale bounding box without affecting
the selected geometry.

Reorient the box

Keep the connection between a sketch curve and other
curves that share its end points. If you deselect this option
and scale a sketch curve, the curve will scale independent
of other curves.

Maintain sketch connectivity

The following options are available for every sketch tool:

• Cartesian dimensions: Select a point in a sketch and then click this option to see Cartesian dimensions from the
point. Cartesian dimensions show you the X and Y distances from the point you select. If you don't have a point
selected, it shows you the X and Y distances from the origin.

• Polar dimensions: Select a point in a sketch and then click this option to see Polar dimensions from the point.
Polar dimensions show you an angle and a distance from the point you select. If you don't have a point selected,
it shows you the angle and distance from the origin.

• Snap to grid: Select this option turn snapping on or off while sketching. The cursor will snap to the minor grid
spacing increment while you sketch. The defaults are 1mm for Metric and 0.125in for Imperial units. See Units
options to change the minor grid spacing.

• Snap to angle: Select this option to turn angle snapping on or off while sketching. The cursor will snap to the
angular snap increment while you sketch. The default is 15 degrees. See Snap options to change the angular
increment used for snapping.

• Create layout curves: The sketch curves are created as layout curves. If you move the design to a drawing sheet,
with Sketch mode selected you must select the Create layout curves check box again in the Sketch Options group
of the Options panel in order to create layout curves on the drawing sheet. See Layout Curves.

• Curve Fitter Options: If the Sketch plane passes through a Mesh object, the system will fit curves through the
facet points. Lines are displayed green and arcs are displayed blue. The following options apply to the
system-generated curves.

º Fit curves - Uncheck this option if you do not want the system to fit curves through the points.

º Tolerance - Determines how many points will be found, which also determines how many curves will be created.
The smaller the tolerance, the more points will be found and the curves will be generated.

º Auto-merge - When checked On, the system will merge lines and arcs to form splines. Splines are displayed
pink.
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Examples

The Scale tool's dimensions refer to the extents of the selected sketch object

Scaling in Section mode

4.2.5.13.1. Scaling Sketches with Pull
You can scale sketch curves with the Scale tool, or you can use the Pull tool.

You should use the Scale tool when you want to scale sketch curves that lie on a plane. Use the Pull tool when you
want to scale curves that lie on multiple planes, as in the example below.

Scaling Sketch Curves with the Pull Tool

1. Click
Pull in the Edit group on the Design tab.

2. Select the curves.

3. Click the Scale tool guide.
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4. Select an anchor point.

5. If Blend is highlighted in orange, click to turn this option off in the Options panel.

Scaling won't work if the Blend option is enabled.

6. Drag in the direction of the yellow guide arrow.

4.2.6. Working with Sketch Curves in 3D
Use Enable 3D Sketch to switch to sketching mode in 3D.

You can use the following sketch tools in 3D mode:

Line

Three-Point Circle

Tangent Line

Construction Line

Spline

Tangent Arc

Three-Point Arc

Point

You can use the following tools from the Sketch group to change curves in 3D mode:

Create Rounded Corner can be used on curves when they are coplanar.

Create Corner can also be used on coplanar curves.

Trim Away can be used to trim curves in 3D mode.

Split Curves can be used to split curves in 3D mode.

Using Other Tools to Create and Edit Sketch Curves in 3D Mode
There are several methods that can create or edit sketch curves in 3D mode:

• Use the Pull tool to pull a point into a line or sweep a point along an edge.
• Use the Move tool to translate or rotate curves in 3D mode.
• Use the Face Curve tool to sketch on a face or surface.
• You can use the Extend tool on the Prepare tab with sketch curves in 3D mode.
• You can change the radius of a circle or an arc directly in 3D by selecting it with the Select tool.
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Examples

Sketching a path and sweeping to create a pipe

4.2.7. Editing a Sketch
You can edit the dimensions of sketched lines, arcs, and points using the Select tool. Tangency is maintained when
you edit a sketch.

Editing a Sketch
1. Click the Select tool. (You can also press Esc if you are in a sketching tool.)

Select the Select Reference Curve tool guide to dimension from another object, similar to the Shift+hover
functionality in other tools.

2. Click and drag the line or point you want to edit.

Alt+click and drag if you want to detach the line or point before moving it.

Ctrl+click and drag to create a copy.

Enter a value to dimension the move.

Editing the Length and Angle Dimensions of a Line
1. Click the end point of a line or arc to edit the length or diameter and angle or chord angle dimensions of the line

or arc.

2. Mouse over the opposite end point of the line or arc to display a blue circle.

3. Drag to move the reference point for the dimension's length.

4. Enter the dimension for the length from the end point of the line to the new reference point.

5. Mouse over the line showing the end of the angle reference to highlight it in blue.
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6. Drag the blue line to move the reference for the angle dimension.

If you move the angular reference 360°, the angle measurement is changed from clockwise to counterclockwise.

7. Enter the dimension to adjust the angle of the line from the new reference line.

Editing the Distance from Another Point
1. Click the midpoint of a line, the center of an arc, or any sketched point to display a dimension to a reference

point.

2. Mouse over the reference point, then drag the blue circles to the location you want to dimension from.

3. Click to set the new reference location.

To skew the X-Y lines, click the outer blue circle and enter the skew angle.

Changing the Properties of a Sketch Object
1. Click the Select tool. (You can also press Esc if you are in a sketching tool.)

2. Select the sketch object to display its properties in the Properties panel.

You may need to adjust the width of the Properties panel or the columns within the properties panel. Place your
mouse over the vertical column line and drag to widen the column. Place your mouse over the border of the
panel and drag to widen the panel.

3. You can:

• Select a new color from the Color property to color the object.

• Switch between lines and construction lines by selecting a value from the Construction property.

• Switch between straight lines and mirror lines by selecting a value from the Mirror property.

• Enter the number of sides for a polygon in the Number of Sides property.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Select the Select Reference Curve tool guide and click another sketch line to edit the dimensions
from the selected point to that sketch line.

Use the Move Dimension Base Point tool guide and click any point to edit the dimensions from the
selected point to that point.

Use the Change Dimension Reference Angle tool guide and click to set the angle reference for the
selected point.
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Examples

Editing a racetrack by dragging internal lines. You can drag to resize, rotate, lengthen, or make one side larger than
the other by dragging different lines or points in the sketch.

4.2.8. Copying a sketch
You can copy a sketch line in Sketch mode with the Select tool.

To copy a sketch line
Ctrl+drag (with the Select tool) while sketching to copy a sketch line.

Press the spacebar while Ctrl+dragging a sketch line to dimension the distance between the first line and the second,
copied line.

You can also select a sketch line, copy it, and then select a point to paste the line onto the point.

4.2.9. Layout Sketches
You can sketch on a plane when you want to draw curves but have no immediate need to generate 3D objects. If
you want to create a region that can be pulled into 3D right away, create a sketch instead.
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You can think of a layout as a pencil drawing made on your design. If you try to pull layout lines to 3D, they do not
behave the same way that sketched lines do. Closed lines are not converted to regions, so if you pull a layout line,
it creates a surface, not a solid. When you are ready to use your layout to create geometry, project the layout lines
to a sketch. Projecting a layout line to a sketch is like inking the line.

Layouts always appear on planes in the Structure tree.

You can use layers when working with layouts to help organize your design. For example, you can color individual
lines on each layout, show or hide the lines, or put the bounding planes on a separate layer and turn that layer's
visibility off to declutter your design. (When you import files, they will initially appear in one color.)

Creating a Layout
1. Insert a plane.

2. Right-click the plane in the Structure tree or graphics window and select Activate Curve Container.

The icon on the Structure tree changes to reflect that the plane is a layout.

3. Sketch on the plane.

Alternatively, while sketching, enable Layout Sketch in the Sketch Options to create the sketch curves as layout
curves.

Converting a Sketch to a Layout
1. Select the sketch entities that you want to appear on the layout.

• Select in the graphics window

• Select in the Structure Tree under the 'Curves' folder

2. Click the Plane tool in the Create ribbon group

• A layout plane is drawn around the selected sketch entities

• The curves are removed from the Curves folder in the Structure Tree

• If all of model curves were converted, the Curves folder is removed from the Structure Tree

3. Right-click the plane in the Structure tree or graphics window and select Activate Curve Container.

Importing a 2D AutoCAD DXF or DWG File as a Layout
You can import a 2D AutoCAD file into your design in the following ways:

• Drag and drop the DXF or DWG file into the Design window to create a layout in the active component.

• Drag the file onto a plane in the Structure tree to place the drawing on that plane and convert it to a layout.

Editing a Layout
When constraint-based sketching is enabled (default), use the Add Layout Curves option to add layout curves to
the imported datum. See Adding Layout Curves to an Imported Datum on page 144 for details.

When constraint-based sketching is disabled, right-click the plane in the Structure tree or graphics window and
select Activate Curve Container.

A layout plane is drawn around the selected sketch entities.
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4.2.10. Moving in Two Dimensions
Use the Move tool to move lines or points with the Move handle. When you move points or lines with this tool, they
do not maintain their connections to other lines or points. If you want to maintain the connections in your sketch,
use the Select tool to edit the sketch.

Moving Sketch Entities

1. Click
Move in the Edit group on the Design tab.

2. Select the curve or curves that you want to move.

3. Select the following options:

• Move grid: Select this option to move the sketch grid.
• Ruler: Can be used to dimension the move. See the instructions below.
• Create patterns: Create a pattern of the selected objects. Pattern relationships of sketch curves and points

are lost when you go into Section or 3D mode.
• Maintain sketch connectivity: Keeps the connections between a sketch curve and other curves that share its

end points. If you deselect this option and move a sketch curve, the curve will move independent of other
curves.

• Other options in the Options panel are not relevant when you move sketch entities.

4. (Optional) To change the anchor location of the Move handle

• Drag the yellow center sphere on the Move handle.

• Click the Anchor tool guide and select the face, edge, or vertex on which to place the Move handle.

The yellow center sphere turns into a blue cube when the Move handle is anchored.

5. (Optional) To change the direction or trajectory for the move,

• Drag one of the small balls on the rotational axis to reorient the Move handle, or dimension the orientation by
typing the rotation angle while you are dragging, then pressing Enter.

• You can also Alt+click a point or line, or click theMoveDirection tool guide, then click a point or line, to orient
one of the Move handle's axes toward that point or along that line.

If you Alt+click a trajectory, you can move along the trajectory. Ctrl+Alt+click to add contiguous lines or edges
to the trajectory.

If you Alt+click a plane, the direction of movement is set perpendicular to the plane.

6. Click an axis and drag in that direction to move the selected object.

A line extends from the Move handle axis to indicate the direction you selected for movement.

7. To dimension the move,

a. Click Ruler in the Options panel.

b. Click an edge or face to anchor the ruler.

The ruler is oriented along the selected Move handle axis.

c. Type a distance and press Enter.
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4.2.11. Dimensional Sketching
SpaceClaim allows you to do precise, dimensional sketching internal to the current line and relative to other lines
and points. If a dimension cannot be edited, it does not highlight on mouse over.

Dimensioning the Current Line
1. Press the space bar to enter a value.

2. Press Tab to highlight and edit a secondary dimension.

3. Press Enter to accept the values.

SpaceClaim allows you to enter mathematical expressions as dimension values.

Dimension Relative to Other Lines and Points
Hover the mouse over a line or point and press Shift to create a dimension relative to that line or point. If you click
a spline, the dimension is always created from the start point of that spline.

The dimension is displayed as Cartesian or Polar coordinates based on which coordinate system you select in the
Options panel.

Creating an Offset Angular Dimension
If the angular reference does not touch the arc center, parallel reference lines are created.

4.3. Design Modes
In SpaceClaim, there are three modes you can use to design: Sketch, Section, and 3D. These modes make it clear
when you are working in 2D vs. 3D, and clarify the difference between working in cross-section (where you can alter
3D objects) and sketching (where you cannot alter 3D objects).

Switching Modes
1. Click a tool in the Mode ribbon group.

You can also right-click an empty area of the Design window and selectSketchMode,SectionMode, or3DMode
from the context menu, or press K (for Sketch mode), X (for Section mode), or D (for 3D mode).

If you are sketching, you can also click Return to 3Dmode

in the Sketch plane mini-toolbar.

2. If you are switching from 3D mode to one of the other modes, select a plane to sketch on or create the cross-section.

When you select an origin object or its center and click Sketch mode, the sketch plane is aligned to the origin
object's XY axis.

Flipping the ViewWhile in Section Mode
Right-click and select Flip Viewing Direction while section mode is active.
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Mode Ribbon Group
The Mode ribbon group contains the following tools:

Sketch mode displays the sketch grid, so you can use any of the sketch tools to sketch in 2D.

Section mode lets you edit solids and surfaces by working with their edges and vertices in cross-section.
You can also use all the sketch tools in Section mode to create and edit solids and surfaces in cross-section.

3D mode lets you work directly with objects in 3D space.

Examples

A design in section mode. The active component is displayed in the part color (magenta in this example) and the
inactive components are displayed in gray.

Switching from Sketch mode to 3D mode automatically converts closed sketched curves into surface objects and
the sketch curves become edges. Only the sketch curves that contribute to the closed surface are converted to edges.
Leftover curves remain in the design as free curves.

4.3.1. Editing in Cross Section
Use Section mode to edit solids by working with their edges and vertices in cross-section. You can modify faces,
edges, planes, cylinders, rounds, and chamfers in section mode. You can edit solids and surface bodies.

In Section mode, lines represent faces and points (or vertices) represent edges.

For example, to rotate a face around an edge, select the line that represents the face, Alt+click the vertex that
represents the edge, and pull. Moving a sketched line in Section mode does not move the solid it is sketched on.
You must move a section line (a line that represents a face) to modify a solid in Section mode.

Hatching is used to show the intersection of the cross-section plane and a solid. Arc centers are shown as small cross
marks. Hatching appears bolder inside faces to indicate what is shown in a cross-section view. (See Examples, below).

You can use the following tools: Select, Pull, Move, Combine, Split Body, Shell, Offset, Fill, and all sketch tools. Use
the Select tool to edit spline faces (represented by a spline in cross-section). You can also cut, copy, and paste. It's
recommended that you clip the scene above the grid to enhance the visibility of the cross-section.
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Editing in Cross-section
1. Select or de-select options based on whether you want to maintain and view relationships while you edit in

cross-section.

2. Select the face you want to use to create the cross-section plane, or select any faces, edges, or vertices that define
a plane.

If you are in a drawing sheet with cross-section views, you do not have to choose a face, as the plane of the
drawing sheet is automatically used as the section plane.

3. (Optional) Move or rotate the cross-section grid and click the Section tool when you are finished.

4. Click and drag the edges and vertices of the cross-section to edit them.

You can also bend edges with the Bend tool, and pull section points (edges) and section lines (faces) with the
Pull tool. If you set the Auto-extrude/revolve sketches in Sectionmode Advanced SpaceClaim option, sketch
made with the sketch tools are automatically extruded or revolved to form surfaces and solids when you begin
the sketch on the edge of an existing surface or solid. To automatically revolve, the sketch must be attached to
a revolved face. If you do not begin the sketch on an existing edge, you are switched to Sketch mode.

We recommend zooming into your design so that it is easier to select the correct entity. For example, if you are
trying to select an edge, but your design appears very small in the Design window, it is possible to accidentally
select a midpoint or end point of the edge instead. Moving the midpoint or end point of an edge will not be
reflected by a mirrored entity.

Options
The following options are available in the Section tool:

Select this option to maintain the influence of mirrors in your design while
editing.

Maintain Mirror

Select this option to maintain the influence of baselines in your design while
editing. Baseline faces are shown as blue edges when viewed in cross-section.

Maintain Offset

If the section plane passes through a Mesh object, the system will fit curves
through the facet points. Lines are displayed green and arcs are displayed blue.
The following options apply to the system-generated curves.

Curve Fitter Options

• Fit curves - Uncheck this option if you do not want the system to fit curves
through the points.

• Tolerance - Determines how many points will be found, which also determines
how many curves will be created. The smaller the tolerance, the more points
will be found and the curves will be generated.

• Auto-merge - When checked On, the system will merge lines and arcs to form
splines. Splines are displayed pink.
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Examples

Moving a spline point in section mode

Bold hatching indicates the hatching that would be shown on a drawing sheet cross-section view

Extruding while sketching in Section mode

4.4. Editing
Use the editing tools to create and edit 2D and 3D solids. You can select, pull, move (in 2D and 3D), edit in cross-section,
fill (heal), bend lines and edges, and tweak faces.

In SpaceClaim, there is little need for a distinction between creating and editing. There is no hierarchical feature
tree, so you have considerable freedom when designing. Create a box by pulling on a rectangular region. Edit the
size of the box by pulling on one of its faces. Draw a rectangle to create a pull-able region. Draw a rectangle on a
face to create a new face.

In general, you are either editing or creating with one of the main tools (Select, Pull, Move, Combine, or sketching
and editing in Section mode), the many secondary tools, or inserting relationships between faces in the design
(Shell, Offset, Mirror). Combining objects (intersecting, merging, cutting, etc.) is handled by the tools in the Intersect
ribbon group.

Selection is integral to face and edge manipulation. You can extend selections with standard controls (double-click,
Ctrl, Shift), by right-clicking and selecting from the Select menu, or using SpaceClaim's power selection functions.

A quick note about solids and surfaces: SpaceClaim always converts a closed set of surface faces into a solid. Similarly,
sketched lines that clearly create regions on faces are replaced with real edges. The change in face transparency
and edge lines reflects this transformation.

You can cut, copy, paste, and detach objects in most tools.
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You can also nudge objects in most tools. Hold Ctrl+Alt and the up or down arrow to nudge an object. The up arrow
increases the dimension and the down arrow decreases the dimension. If you nudge multiple times then click Undo,
all the nudges will be reverted. You can view and change the nudge distance in the Snap options.

In SpaceClaim, there are three modes you can use to edit your designs:

Sketch mode displays the sketch grid, so you can use any of the sketch tools to sketch in 2D.

Section mode lets you edit solids by working with their edges and vertices in cross-section.

3D mode lets you work directly with objects in 3D space.

Edit Ribbon Group
The Edit ribbon group contains the following tools:

Use the Select tool to select 2D or 3D objects in your design for editing. You can select vertices, edges,
curves, planes, axes, faces, surfaces, rounds, solids, and components in 3D. In 2D, you can select points
and lines. You can also select circle and ellipse centers, the midpoints of lines and edges, and the internal
points and end points of splines. The Select tool can also be used to edit a sketch.

Use the Pull tool to offset, extrude, revolve, sweep, draft, scale, drape, and blend faces; use it to round,
chamfer, or extrude edges.

Use the Move tool to move one or more faces, surfaces, solids, or components. The behavior of the Move
tool changes based on what you have selected.

Use the Fill tool to fill in the selected faces with the surrounding surface or solid. The region must be
completely surrounded to be filled. You can also use the Fill tool to patch new surfaces through loops of
edges.

Use the Replace tool to replace one face (or multiple faces) with another face (or faces). You can also use
it to simplify a spline face that is very similar to a cylinder or plane, or to align a set of planar faces that
are almost aligned.

You can edit any face or surface with Tweak Face to change its surface geometry. This tool is available in
3D mode and in drawings.

4.4.1. Pulling
Use the Pull tool to offset, extrude, revolve, sweep, and draft faces. You can use it to round, chamfer, extrude, copy,
or pivot edges. You can also drag a point with the Pull tool to draw a line on a sketch plane.

The Pull tool can also be used on facets in Faceted Bodies.

Pulling the apex of a cone changes its height. Pulling through the base plane will invert the cone. Pulling a loop of
edges attached to a vertex will create conical faces at the corners when appropriate.

You can select a face, then pull, dragging anywhere to act, or you can click, drag, and release a highlighted face. In
general, the result of a pull stays selected or highlighted after the pull operation.

The action of the Pull tool depends on which faces and edges you select to work with, and which faces, planes, or
edges you select to drive the change. For example, if you choose to work with a face, then select an edge to "drive"
the pull, the Pull tool infers that you want to pivot the face around that edge. When multiple actions can be inferred,
you can use the Tool guides to correct the Pull tool's inference. The Pull tool maintains any offset, mirror, pattern,
or coaxial relationships.
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When you pull a face, there are two main decisions you need to make. The first is to determine the direction you
want to pull in. A default direction is offered to you, but it can be overridden using the Direction tool guide. The
second is to determine what is going to happen at the edges of the face. By default, the edges of the face are
determined by its neighbors, but you can override this behavior by including the edges in your Pull selection to
create an extrusion. When you pull, connected chamfers are automatically removed and replaced.

Note: If you entered the Design tab with sheet metal features selected, the Pull tool will work as it does in
Sheet metal. To work as usual, right-click the sheet metal part in the Structure tree and choose Suspend
Sheet Metal in the context menu.

Creating and Editing a Solid

1. Click
Pull in the Edit group on the Design tab or press P.

Mouse over faces and edges in your design to preview the natural Pull direction. If your mouse is over multiple
faces or edges, use the scroll wheel to preview the Pull direction for each one.

2. Select the faces, edges, and points you want to pull to create 3D solids or surfaces.

You can right-click in the Design window and select Anchor Pull Handle, then click to anchor the Pull handle on
another object. This command is useful when you want to dimension a Pull from a different location than the
center of a face.

If the Pull arrow appears gray instead of yellow, then the object is locked and can't be pulled unless you unlock
it. To unlock an object, right-click the object in the Structure tree and select Unlock.

3. (Optional) Alt+click to select the face or edge that will drive the change.

You can also select the appropriate tool guide, then click the face, point, or edge. The driving edge or face is
shown in blue. If you select theShowcursorarrowsSpaceClaim option, arrows appear to indicate the directions
you can move your mouse to edit the selected object.

If you want to use an annotation dimension, see Driving modification with annotation dimensions.

Measurements can also be used to drive modifications.

To drivemodifications withmeasurements.
a. Enter the Pull tool
b. Select a face, edge or vertex
c. Enter the Measure tool (shortcut is "e")and measure any single object or measure between two objects
d. Click in the Measurement results (hover over measurements to display purple box). Once selected, that single

measurement will display on screen with arrows pointing to either object chosen for measurement.
e. Click in the highlighted dimension box and modify the value for a one-time adjustment of the model or create

a Measurement Group which can be modified at any time.
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f. Measurement groups can also be created from Area results. Modifying the group then adjusts the model to
produce a desired area. For example, create a Measurement group for the area of a side of a box. While pulling
the front of the box, you can enter a new area value for the side to complete the Pull.

4. (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar.

5. Click and drag in the direction of the Pull arrow to create or edit a solid.

6. If the correct pull arrow is not highlighted, press Tab or click the Pull arrow you want to use.

Press Shift to snap while pulling.

Press the spacebar or click a dimension to enter a value.

To dimension the pull, type the distance you want to pull and press Enter. You can also type a dimension in the
dimension box in the mini-toolbar.

You do not have to click and drag (or even click near) the Pull arrow. In fact, you should move the cursor away
from the arrow for more precise control of the pull. The only important input to the Pull tool is the direction in
which you are moving the cursor. When you pull, contiguous solids are automatically combined.

If you want to pull in a head-on view, use the ruler at the bottom right corner of the Design window to pull instead
of the Pull arrow. Slide the gray bar to the left to subtract material, and to the right to add material.

If you pull through another object in the same component, the smaller object is merged into the larger one, and
receives the larger object's properties. If you pull multiple, touching surfaces, the smaller surfaces are merged
into the largest one. Select the NoMerge option if you don't want objects merged.

Hold the Ctrl key while pulling to create a copy of the object that is offset by the distance you pull. You can also
hold Ctrl while revolving to create a copy of a surface. The influence of neighboring faces is taken into account
to trim or extend the edges of the copied face, when appropriate. You can use the Up To tool guide with Ctrl to
make a copy, and you can use the Both Sides option to make two copies that are offset in opposite directions
from the original. You can also use the Up To tool guide to pull surfaces up to a reference edge.

Press Esc to cancel the Pull.

See the topics in the Table of Contents underDesigning>Editing>Pulling for the list of actions you can perform
with the Pull tool.

Do it faster
1. Select the faces, edges, and points you want to work with.

In general, pulling a face increases the size of the solid, pulling an edge creates a surface, and pulling a point
creates a line or curve.

2. (Optional) Alt+click the face or edge that will drive the pull.
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3. Drag in the direction of the Pull arrow.

Pulling a curve
When you select a curve with the Pull tool, the direction of the extrusion is determined by the plane of the curve.

The default direction to pull a curve is along the Z axis.

If a curve lies on the Z axis, the pull arrow points in the Y
direction.

If you select two curves on the same plane, the pull arrow
points in the direction that is perpendicular to the plane
of the curves.

If you select a curve that touches another curve, the pull
arrow points in the direction perpendicular to the plane
of the two curves.

Pulling curve ends
You can toggle between Tangent and Natural (curvature continuous) extension when dragging the end of a curve.
To drag the extension Tangent to the curve, press and hold Ctrl prior to dragging. You can release the Ctrl key once
you start dragging. If you do not press Ctrl, the extension is created Curvature Continuous.

• Works for Splines (extended or trimmed-back)

• Works for Arcs
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Press Ctrl and drag to Pull the curve end tangent to the curve.

Without pressing Ctrl, Pulling the curve end extends it with its natural curvature.

Pulling surface edges
Surface edges can be Pulled normal to their neighboring face. Press the Ctrl key when you begin the Pull.

Press Ctrl and drag to Pull the edge tangent to the surface.
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Without pressing Ctrl, Pulling the edge extends it with its natural curvature.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. When this tool guide is active, you can perform
standard selection tasks, and create natural offsets and rounds. Select a face, parallel faces,
or surface edges to offset them. Select a solid edge to round it. Alt+click to select the driving
face or edge for revolves, directed extrusion, sweeps, and drafts. Alt+double-click an edge
to select an edge loop. Alt+double-click again to cycle through alternate edge loops. You
can select objects across multiple components to pull.

Use the Direction tool guide to select a straight line, edge, axis, origin axis, plane, or planar
face to set the pull direction.

Select a face to pivot or select a face and edge to revolve. Then use the Revolve tool guide
to select the straight line, edge, or axis around which you want to pivot or revolve.

Select any number of contiguous faces on the same body, then use the Draft tool guide to
select the plane, planar face, or edge around which you want to pivot. None of the contiguous
faces can be parallel to the neutral plane, face or edge around which you want to pivot.

Use the Sweep tool guide to select the straight or curved lines or edges along which you
want to sweep. Faces and edges can be swept, and the sweep trajectory cannot be in the
same plane as the face.

Use the Scale Body tool guide to scale objects in 3D. See Scaling solids and surfaces.

Use the Up To tool guide to select the object that you want to pull to. The pulled object's
face or edge will mate with the surface of the selected body or be pulled up to a plane through
the selection. You can also use this tool guide to pull surfaces up to a reference edge or facet.
When pulling Up To a Facet reference, a dimension is displayed for further editing. The object
will be copied if you hold Ctrl.

The selection used for Up To can come from the Structure Tree, if it can be determined. A
single face surface is an example of an Up To selection in the Structure Tree.

Extends an edge or face to the nearest face. This option works similar to the Up To tool
guide, except you don't select the face to extend to.

You can use Full Pull to automatically pull edges up to the closest faces that intersect with
the object. The edges you select are extended in the direction of the Pull handle up to the
next set of faces or edges that fully bound the extension. The original surfaces that the edges
belong to are extended and new edges may be created. However, new faces are not created.
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Pull Options
The following options are available in the Pull tool. Once you select the edge or face to pull, select these options
from the Options panel or the mini-toolbar:

Only add material when you pull. If you pull in a subtractive direction, no change
will occur. You can combine this option with other Pull options.Add

Only remove material when you pull. If you pull in an additive direction, no change
will occur. You can combine this option with other Pull options.Cut

Pulls without merging into other objects even when the object pulled intersects
with an existing object.NoMerge

When this check box is selected and you pull a surface, the surface is extruded into
a solid. This is the default behavior. When the option is deselected and you pull a
surface, the surface is offset to a new location, changing the original surface. When
you hold Ctrl and drag a surface with the option selected or deselected, the surface
is copied and then offset.

Thicken surfaces

Select this check box to maintain the offset relationship when pulling.

Maintain Offset

Select a single, detached edge, imprinted edge, surface, or helix then click this
option to pull both sides of the edge or surface at once.Pull Both Sides

Opens the Measure tool. Selecting a measurement result returns you to the Pull
tool and displays the measurement value in a dimension box with an arrow pointing
to the measured object. Modify the value for a one-time adjustment of the model
or create a Measurement Group which can be modified at any time.

Measure

Opens the Mass Properties tool. Selecting a mass property result returns you to
thePull tool and displays the measurement value in a dimension box with an arrow
pointing to the measured object. Modify the value for a one-time adjustment of the
model or create a Measurement Group which can be modified at any time.

Mass Properties

Select this option, then click to connect a ruler, oriented along the pull axis, to an
anchor edge or face. You can use the ruler to dimension the pull. The direction must
be specified to successfully create a ruler dimension. Press Esc to cancel the ruler
dimension.

Ruler

When you are pulling an edge, select this option to create a rounded corner, which
is also known as a fillet.

Note: The default minimum radius is 0.1 mm. Smaller radii can be specified
if the units are in micrometers, nanometers, or mils.

Round

When you are pulling an edge, select this option to create a chamfer.
Chamfer

When you are pulling an edge, select this option to extrude the edge into a surface.
Extrude Edge
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When you are pulling an edge, select this option to create a copy of the edge.

The type of offset is determined by whether or not Offset edges by geodesic
calculation is selected in Advanced options. This option is selected by default.
When this option is selected, all the points on the offset edge are the same distance
from the initial edge. In the examples below, the original edge is highlighted in
green, the regular offset is shown in orange, and the geodesic offset is shown in
blue.

Copy Edge

When you are pulling an edge, select this option to pivot the edge along the selected
Pull arrow.Pivot Edge

Examples

Pulling the edge of a surface first simplifies the edge, then its neighboring edges are extended (or trimmed)

Pulling the edge of a surface while holding Ctrl makes a new surface that is tangent to the edge.
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Pulling edges up to other edges with the Up To tool guide

Pulling a point on a surface towards an Alt+clicked vertex

Pulling edges with theFull Pulloption. If you select the lower edge of the green surface shown above, you will receive
an error because the neighboring surface does not extend past the end of the selected edge. The edge on the right
side of the face can be pulled with the option, because the neighboring face extends beyond its length. A new edge
is created, which is marked in red in the illustration on the right.

Pulling edges to their nearest neighbor with the Full Pull option
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Pulling a sketched line on a planar face creates a surface in the same plane as the face

Pulling the edge of a toroidal surface. Three directions are available for pulling.

Holding Ctrl while pulling a surface with the Both Sides option creates copies of a surface.

Pulling two edges with the Extrude (2a), Copy Edge (2b), and Pivot (2c) options.

Pulling a face offsets it, and its edges are influenced by neighboring faces.
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Pulling a face with its edges selected extrudes the face without influence from neighboring faces.

Pulling a conical face Up To a parallel cylindrical face replaces the cone with the cylinder if the axes are close together.
Otherwise, the conical face is replaced with a cylindrical face that is coaxial to the cone and has the same radius as
the cylinder.

Pulling a pocket with rounded edges down through the bottom of a solid transfers the rounds to the resulting hole.

Pulling a surface up to a reference edge.

Pivot two separate edges together when pulling in one direction.
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4.4.1.1. Offsetting or Extruding Faces
1. Select the

Pull tool in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should
be active.

2. Select the face or surface you want to offset or extrude.

You can select multiple surfaces and faces of solids to offset or extrude them simultaneously.

3. (Optional) Add edges to your selection.

Select the edges of the face that you want to extrude when you pull. (Any unselected edges are defined by the
neighboring geometry during the pull, creating an offset instead of an extrusion.)

4. (Optional) Select the Direction tool guide

,
then click the straight line, axis, or edge if you want to offset or extrude in a different direction.

You can also Alt+click a straight line, axis, plane, origin axis, or edge. Sometimes SpaceClaim guesses your intent
incorrectly when you Alt+click the direction line. If this happens, just use the Direction tool guide to correct it.

The pull direction is shown in blue and the pull arrow is reoriented.

5. Click and drag the face in the direction of the Pull arrow.

Does this:Dragging a:

Offsets the face in its natural offset directionSolid face

Creates an extrusionSolid face and all its edges

Thickens or thins the faceSurface face

Creates a round, chamfer, or extrusion, depending on
the selected option

Corner edge of a solid

Offsets the round or chamferRound or chamfer

Uniformly offsets the variable roundVariable round

Offsets the cylinder, torus, or coneCylinder, torus, or cone

To dimension the offset, type the distance you want to pull and press Enter.

Press and hold Ctrl to offset a copy of the face as a surface.

Neighboring faces automatically extend to bound the offset face.

You can also use the Up To tool guide to pull up to any edge, plane, surface, or face in your design. If you pull a
round, chamfer, or cylinder with the Up To tool guide, and pull up to similar geometry, the radius or offset is
changed to the dimension of the Up To face you select.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar:
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Examples

Selecting a face to offset

Selecting a face and edges to extrude

Selecting a face and edges, and setting a direction to extrude in a direction

Pulling an inner cylindrical surface up to an outer surface to create a solid ring

4.4.1.2. Extending or Extruding Surface Edges
You can extend or extrude the edges of any surface with the Pull tool. When you extend an edge, the pull extends
the neighboring faces without creating a new edge. Extruding an edge creates edges.

1. Click
Pull in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should be
active.

2. Select the outside edge of a surface.

Ctrl+click to select multiple edges.
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3. Click the Pull arrow oriented along the surface to extend the edge. Press Tab or click the other Pull arrow to
extrude the edge in another direction.

4. (Optional) Ctrl+click the vertex of one or both neighboring edges to ignore their influence.

5. Drag in the direction of the Pull arrow to extend the edge or create a new surface perpendicular to the old one.

If the correct pull arrow is not highlighted, press Tab or click the Pull arrow you want to use.

The natural direction of a surface edge is in the plane of the surface.

You can use the Up To tool guide to pull a linear edge up to a face, surface, edge, or point. If the face or surface
does not intersect the edge you are pulling, the edge will be pulled parallel to the selected object.

To dimension the extension, type the distance you want to extend the surface while you are pulling and press
Enter.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar.

Examples

Pulling the edge of a surface up to another edge forms a solid if it closes the body

Pulling the edge of a cylindrical surface extends the surface along a cylindrical path (A) unless you hold Ctrl (B).

Pulling the edge of a cylindrical surface with the NoMerge option selected creates a new edge.
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Pulling the edge of a cylindrical surface with the Both Sides option and holding Ctrl creates a new surface tangent
to the cylinder and extends in both directions from the edge.

Pulling an edge with the Pivot Edge option

Pulling an edge with the Copy Edge option

4.4.1.3. Rounding Edges
Use the Pull tool's

Round option to round the edges of any solid. You can also round an inside or outside corner of a surface. To create
a rounded face between two faces, see Rounding between faces and surfaces.

Rounds are recognized as a face type, with their own options in the Properties panel. You can change the Round
value (true or false) and the Radius value. The Round value for a variable radius round is Varies.

You can change a constant- or variable-radius round with the Pull tool in section mode.

216Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Rounding an Edge
1. Click the

Pull tool in the Edit group on the Design tab.

2. Select the edge or edges you want to round. Double-click to select a tangent chain.

You can also select the vertex of an inside or an outside corner of a surface.

3. Select the Round option

in the Options panel or from the mini-toolbar. This option is automatically selected for edges that can be rounded.

4. Click and drag the edge in the direction of the Pull arrow.

To dimension the round, press the Spacebar, type the radius, and press Enter.

When you pull an edge to create a round, the Pull tool determines whether it should be a constant radius or a
variable radius round based on the geometry.

Once you create a round, pulling an adjacent face also pulls the round.

When you round more than one edge at the same time, and one or more of the rounds cannot be created, only
the successful rounds are created.

Note: The face hidden by the round is remembered, so that if you fill the round it can be displayed. If you
move a round, the face hidden by it is also moved.

Examples

Rounding the inside and outside corner of two surfaces.

Pulling edges on geometry that automatically determines rounds will be variable radius.
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When creating surface-to-surface rounds, the expansion direction depends on the order in which you select the
edges. In the example above, the rounds expand toward the left because the upper edge was selected first.

Rounding the edge created by two rounds with one edge not tangent.

Pulling rounds in a tangent chain. Pulling the selected tangent chain does not change the round shown in blue.

Adding and changing a rounded edge on a shelled or offset part changes the inside faces.

Rounding elliptical edges.

Creating a Full Round by Selecting Edges
1. Click the Pull tool.

2. Select the two edges on opposite sides of the face you want to become a full round, or select the circular edge
on the end of a cylinder.

You can select more than one pair of edges, and create full rounds between the pairs.

3. Pull the edges down so they are just rounded.

4. Slowly pull the mouse in the opposite direction, until the faces are no longer round, and continue pulling until
the full round appears.

218Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Creating a Full Round by Selecting Faces
1. Click the Pull tool.

2. Select the face where you want the full round.

3. Hold Ctrl and select the two side faces that will be tangent to the full round.

4. Right-click and select Full Round.

Example

Creating a full round by selecting three faces

Converting a Constant-radius Round to a Variable-radius Round
1. Click the Pull tool.

2. Check the Edit as Variable Radius Round option.

Editing a Variable Radius Round
• Click the Pull arrow on an end of the round face and drag toward or away from the face to adjust the radius at the

edge of the round.

• Click the Pull arrow pointing toward the center of the face and drag it along the face (or enter a length or percent)
to set another point where you can adjust the round's radius.

• Hold Ctrl and drag to copy a control point.

• Press Tab to switch among and edit the dimensions by typing a number.

• Two rounds that intersect at a shared edge can be made variable together by selecting the shared sharp edge for
modification. Both rounds become variable at that point. They can be made variable independently by selecting
the sharp end edge that is not shared by the rounds.
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In the Pull tool, when you select an edge of a constant radius round, the Smooth option becomes enabled if the
geometry allows it. When checked, the transition between radius at each end of the round will vary smoothly instead
of linearly. Once set, the Smooth option remains set for subsequent rounds until you change it.

The image below shows a Smooth variable radius round. Other editing examples follow.

Examples

Editing a variable radius round

The variable radius round handles have a drag (ball) handle. The center Radius Handle cannot be dragged, all radii
values are adjusted at once.

Click the ball and drag to add and place a new radius handle.
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Setting another point for adjusting a variable round's radius

Selecting multiple edges to create a variable round across those edges

Removing a Rounded Edge

Removing a Rounded Edge with the Pull Tool
This method completely removes the rounded edge.

1. Click the Pull tool.

2. Select the rounded edge.

3. Select the Round option

in the Options panel or from the mini-toolbar.

The round is removed.

Removing a Rounded Edge with the Fill Tool
This method removes the rounded edge and creates a round group in the Groups panel. You can right-click the group
and select Reattach Round to restore the rounded edge.

1. Click the

Fill tool in the Edit group on the Design tab.

2. Select the rounded edge.

3. Click the Complete tool guide.
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The round is removed and a round group is created.

4.4.1.4. Rounding Between Faces and Surfaces
You can create a rounded edge across the gap between two faces or surfaces that would meet at a corner. To create
a rounded face on an edge, see Rounding edges.

When you round between faces of two solids, the solids must extend into the area where the rounded face is created.

Rouding Between Faces or Surfaces

1. Click
Pull in the Edit group on the Design tab.

2. Select the faces you want to create a round between.

3. Select the Round option

in the Options panel.

The pull arrow changes to indicate that a round will be created between the faces and a curve is displayed to
show you the direction of the round. Yellow cursor arrows show you the directions you can pull to create the
round if you have cursor arrows enabled.

4. Press Tab to cycle through all of the possible rounds that can be created between two faces or surfaces.

If the two faces you are rounding between are rounds, then Tab lets you choose either rounding between or
changing the radius of both existing rounds.

5. Click and drag in the direction of the Pull arrow.

To dimension the round, press the Spacebar, type the radius, and press Enter.

When you pull an edge to create a round, the Pull tool determines whether it should be a constant radius or a
variable radius round based on the geometry.

Once you create a round, pulling an adjacent face also pulls the round.

When you round more than one edge at the same time, and one or more of the rounds cannot be created, only
the successful rounds are created.

When pulling Face-to-Face round,s you can match their radius to an existing round using the Up To tool guide.

Note: Unlike rounds made on edges, the faces hidden by the round arenot remembered. If you fill the round
it will be replaced by an edge.
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Examples

Rounding between faces on two parts. Material exists in the area where the rounded face is created, so this operation
will succeed.

A rounded face cannot be created between these faces because material doesn't exist in the area between the parts
where the round will be created.

This sequence shows creating a round between faces, then using the Fill tool to remove the round. The Fill replaces
the round with an edge and not with the original geometry.

Rounding between two surfaces creates a rounded surface.

4.4.1.5. Modifying Rounds
Some modifications fail because the entire round chain (along with all chains required to be removed by the
modification) are all included in the modification. In some cases, parts of the chain (or others, even far away ones)
are restricted by surrounding geometry and the modification fails. To make modifications more robust, they are
localized to the selected piece of the round.
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For this to work, the ends of the localized section need to be "auto-capped". In other words, they need to be able
to be closed off by a plane triangular face, essentially normal to the last-visited construction edge. The following
example illustrates this.

The radius is going to be increased at the selected edge.

Localizing means that the round pieces on either side of the edge are removed first. For this to work, the ends of the
removed pieces need to be "capped" with a triangular face or be the start or end point of the round chain. These
end conditions are necessary to rebuild the new variable round between the ends.

An end cap is shown in the example below.

The Localized round can then be reconstructed with the modified radius as shown below.
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The image below shows an example where capping the end is difficult. The red circles highlight points where there
is ambiguity for capping. It's difficult to construct a capping face normal to the construction edge.

With Localization, the modification will fail if either of these edges is an end of a modified piece of the round.

Without Localization, the modification would include these areas and the modification would fail.

In order to remove a round for modification, the side faces need to be able to Extend up and form a sharp edge as
shown below.

225Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



In some cases, extra surface patches can cause ambiguous situations where the sharp edge cannot be determined
and the round cannot be removed for modification. The image below is an example of a round that cannot be
removed because of face extension ambiguity.

Round Order
The order in which rounds are created influences the appearance and quality of the resultant geometry. TheReverse
Round Order button in the Round mini-toolbar enables you to reverse the order of selected rounds that interact
with other rounds.

You can change the order of round creation to clean up split rounds that produce extra edges as shown in the example
below.
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A round is applied to an edge which is broken by existing rounds.

Because the edge is broken, the new round is segmented.

Reversing the round order produces smoother rounds.

4.4.1.6. Chamfering Edges
You can chamfer the edges of any solid by selecting the Pull tool's Chamfer option. Sketched chamfers that you
make using the Create Rounded Corner tool with the Chamfer option are recognized as chamfers when they are
extruded into a solid.

Chamfers are recognized as a face type, with their own options in the Properties panel. You can change the Chamfer
(true or false) and Distance values.

After you create the chamfer, you can adjust the setback distance of both sides and you can change its offset. Drag
the arrows above or below the chamfer to change the distance, or drag the arrow that is perpendicular to the chamfer
to change its offset. You can also pivot the edges and the chamfer's distance properties will be updated with the
new values.
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Note: When you make a hole in a chamfered face, the face is no longer a chamfer. You can still pull the face,
or the hole, but you cannot change the chamfer to a round or dimension the chamfer.

Chamfering an Edge

1. Click
Pull in the Edit group on the Design tab.

2. Select the edge or edges you want to chamfer. Double-click to select a tangent chain.

3. Select the

Chamfer option in the Options panel or from the mini-toolbar.

4. Click and drag the edge in the direction of the Pull arrows.

Pulling the arrow that is normal to the chamfer face changes the offset distance for the whole chamfer. Pulling
either of the side arrows changes the setback distance of that side. You can press Tab to move among the arrows.

To dimension the chamfer, right-click and enter a setback distance in the mini-toolbar, or press the space bar,
type the setback distance, and press Enter.

To create a chamfer with the same setback distance and size as an existing chamfer, use the Up to tool guide
and select an existing chamfer face. You can also select an edge with Up To to set the setback distance.

Chamfering Stop Faces
Stop Chamfers have conical stop faces that mimic the effect of an angled cutting tool rotating and then stopping
somewhere in the middle of an edge.

Select a chamfered edge.

• When you click the Chamfer option in the Pull tool, the edge ends switch to yellow cones that can be dragged.
This is similar to Pull Edge UI in Sheet Metal and sets the point where the simulated cutter will stop.
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• Note the conical stop face created at the chamfer's end.

• You can move both ends to create stop faces at both ends of the chamfer.
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Reverse Chamfer Stop has been added to Chamfer options. This flips the ‘direction' of the conical Stop Face.

• The handle used to set the location of the Stop Face is a cone that indicates the orientation of the cutting tool that
would create the Chamfer.

• Here it is 'reversed' or flipped 90 degrees.
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• An Apex offset input box has been added to Chamfer options to offset the cone apex (the lowest point of the cone)
past the furthest extent of the intersection of the virtual cutter with the material.

Apex offset = 2Apex offset = 1Apex offset = 0

• The linear dimension in the image refers to the arc length of the un-chamfered part of the original edge. Note in
the example below that 7.22mm is the length of the arc between points.

Modifying a Chamfered Edge
Select a chamfered edge or a chain of chamfered edges.

• To change the setback distance of one side of the chamfer, pull the arrow above or below the chamfer, as shown
below. Press the space bar while pulling to type a distance value. You can also change both setback distances in
the Properties panel and in the mini-toolbar. TheUpTo tool guide can be used to pull the setback up to an object.
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• To change the offset distance of the chamfer, pull the arrow that is perpendicular to the chamfer, as shown below.
Press the spacebar while pulling to type a distance value.

• To modify by Distance and Angle, select one of the side handles to display the mini-toolbar and click the Angle

dimension option. The selected side becomes the distance side and the other switches to angle.

• To convert the chamfer to a normal face, select False in the Chamfer field of the Properties panel. You can select
True to convert a face to a chamfer, however, faces with holes cannot be modified as chamfers. Changing this
property does not change the geometry. See the instructions below to remove a chamfer from an edge.

Note: Hold the Shift key while pulling a chamfer setback or offset to snap to existing edges.

Converting Between Rounded Edges and Chamfered Edges

1. Click
Pull in the Edit group on the Design tab.

2. Select the edge or edges you want to convert to chamfers or rounded edges.

Double-click to select a tangent chain.

You can't convert a chamfered edge if you have changed the setback distance(s).

3. Select the
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Chamfer option or the

Round option in the Options panel or from the mini-toolbar.

The rounded edge is converted to a chamfered edge.

Note: You cannot convert a chamfer to a round if you have changed its setback distance(s).

Making a Chamfer with the Same Setback and Offset as Another Chamfer

1. Click
Pull in the Edit group on the Design tab.

2. Select an edge or an existing chamfer that you want to change.

3. Click the Up To tool guide.

4. Select the chamfer whose values you want to copy.

The first chamfer will be changed so its offset and setback distances are the same as the second chamfer.

Removing a Chamfer with the Pull Tool
This method completely removes the chamfered edge.

1. Click
Pull in the Edit group on the Design tab.

2. Select the chamfered edge.

3. Select the Chamfer option

in the Options panel or from the mini-toolbar.

The chamfer is removed.

Removing a Chamfer with the Fill Tool
This method removes the chamfered edge and creates a chamfer group in the Groups panel. You can right-click the
group and select Reattach Chamfer to restore the chamfered edge.

1. Click
Fill in the Edit group on the Design tab.

2. Select the chamfered edge.

3. Click the Complete tool guide.

The chamfer is removed and a chamfer group is created.
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Examples

Pulling to enlarge an existing chamfer while holding Shift to snap to an edge. You can only snap to an edge in this
case when you pull an existing chamfer.

Using the Up to tool guide to change the offset and setback distances of a chamfer to match an existing chamfer.

Creating a chamfer on multiple edges at the same time.

4.4.1.7. Extruding Edges
You can extrude the edge of any solid by selecting the Pull tool's Extrude Edge option. You can also extend and
extrude surface edges.

Extruding an Edge

1. Click
Pull in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should be
active.
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2. Select the edge or edges you want to extrude.

Ctrl+click to select multiple edges. Double-click to select a tangent chain.

3. Select the Extrude Edge option

in the Options window, or from the mini-toolbar.

The Pull arrow changes to show the two directions in which you can extrude the edge. One arrow is highlighted
to show the primary direction.

4. If the arrow pointing the direction you want to pull is not highlighted, click the arrow or press Tab to change the
direction.

Click and drag the edge in the direction of the Pull arrow.

To dimension the extrusion, right-click and enter a distance in the mini-toolbar, or type the distance while you are
pulling and press Enter.

Press Ctrl to copy the edges.

Press Ctrl+C, then Ctrl+V to quickly copy and paste a selected set of edges in place.

You can click the Up To tool guide and click a face, edge, or point to pull up to. If the face does not intersect the edge
you are pulling, the edge will be pulled parallel to the face. If you pull the edge of a surface up to another object, the
result is automatically solidified if it creates a closed volume.

Extruding a Curve

1. Click
Pull in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should be
active.

2. Select the curve or curves you want to extrude.

Ctrl+click to select multiple curves. Double-click to select a tangent chain.

3. Select the Extrude Edge option

in the Options window, or from the mini-toolbar.

The Pull arrow changes to show the two directions in which you can extrude the curve. One arrow is highlighted
to show the primary direction.

4. If the arrow pointing the direction you want to pull is not highlighted, click the arrow or press Tab to change the
direction.

Click and drag the curve in the direction of the Pull arrow.

To dimension the extrusion, right-click and enter a distance in the mini-toolbar, or type the distance while you are
pulling and press Enter.

Press Ctrl to copy the curves.

Press Ctrl+C, then Ctrl+V to quickly copy and paste a selected set of curves in place.

You can click the Up To tool guide and click a face, edge, or point to pull up to. If the face does not intersect the curve
you are pulling, the curve will be pulled parallel to the face. If you pull the curve of a surface up to another object,
the result is automatically solidified if it creates a closed volume.

When extruding sketch curves into surfaces, the following rules apply to the resulting surface color.
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If all curves being pulled
are the same color AND
the curve colors override
their layer color, the
surface is the same color
as the curves.

If all curves being pulled
are the same color AND
the curves take their
color from a layer that is
not the Active layer, the
surface is the color of the
Active layer and not the
color of the curves.

If all curves are not the
same color, the surface
uses the Active layer
color.
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If all curves are not the
same color AND take
their colors from
different layers, the
surface uses the Active
layer color.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar:

4.4.1.8. Pivoting Edges
You can pivot the edge of any solid with the Pull tool's Pivot Edge option. You can also pivot two separate edges
together when pulling in one direction.

To turn a cylinder into a cone, select the Pull tool and the Pivot Edge option. Then click the edge of the cylinder and
pull it until it forms a point. To turn a truncated cone into a cylinder, click the small edge and pull it out.

Pivoting an Edge
1. Select the

Pull tool in the Edit group on the Design tab.

The Select tool guide is enabled by default.

2. Select the edge or edges you want to pivot. Double-click to select a tangent chain or edge loop.

3. Select the Pivot Edge option

in the Options panel, or from the mini-toolbar.

The Pull arrow changes to show the two directions in which you can move the edge to pivot the connected faces.
One arrow is highlighted to show the primary direction.

4. If the arrow pointing in the direction you want to pull is not highlighted, click the arrow or press Tab.

5. Drag the edge in the direction of the Pull arrow.

During the pull, the distance you have moved the edge is displayed. You can dimension the distance in Section
and 3D mode, and dimension the angle in Section mode.

You can hold Shift to snap to existing geometry.
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Examples

Simultaneously pivoting multiple edges.

Pivoting two separate edges together when pulling in one direction.

Dimensioning the pivot angle.

4.4.1.9. Revolving Faces
You can revolve any face or surface with the Pull tool. The face or surface can lie on both sides of the revolve axis.

1. Select the

Pull tool in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should
be active.

2. Select the surfaces, faces, or solids you want to revolve.

3. Alt+click the straight line, axis, or edge to set the revolve axis.

You can also select the Revolve tool guide, then click to set the revolve axis. The revolve axis is shown in blue.

4. Click and drag in the direction of the Pull arrow to revolve the selected object, select the Up To tool guide and
click an edge, face, or plane, or select Full Pull from the Options panel or mini-toolbar.

Neighboring faces automatically extend to define the boundaries of the revolved faces of solids. Revolving from
a flat surface face has no neighboring faces, so it makes new face boundaries.

To dimension the rotation, type the rotation angle and pressEnter. The positive direction is shown by the Revolve
handle.
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Note: Alt+click an axis, then mouse over a face and pull to revolve the face around the axis.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar.

Revolve Options
The following options are available once you select the edge or face to pull, and the Revolve tool guide:

• Revolve helix: Use this option to revolve the selected face or edge around the selected axis to create a helix.
Specify the length and the pitch, and set the handedness of the helix by selecting or deselecting theRight-Handed
Helix option. See Revolving Helices on page 242 for details.

• Rotational rib: Use this option to revolve the selected face or edge around the selected axis to create a rotational
rib.

Examples

Revolve using cut, 180 degree revolve, and a full revolve of an ellipse around an asymmetrical axis

Revolving a surfacing using Cut, when the surface lies on both side of the axis and is enclosed within a solid

4.4.1.10. Revolving Edges
You can revolve an edge to form a surface with the Pull tool. You can revolve the edge of a solid or surface.
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Revolving an Edge of a Solid or Surface
1. Select the

Pull tool in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should
be active.

2. Select the edges you want to revolve.

3. Alt+click a straight line, axis, or edge to set the rotation axis.

You can also select the Revolve tool guide, then click the revolve axis. The revolve axis is shown in blue.

4. Click and drag in the direction of the Pull arrow to revolve the selected edge or select the Up To tool guide and
click an edge or face to revolve up to.

Ctrl+click to select edges of faces along with the face to force the pull tool to create new neighboring faces to
contain these edges (essentially changing from a draft to a revolve). Unlike other CAD products, SpaceClaim
allows revolving planar and non-planar edges and faces about lines that do not lie in those planes. This allows
skewed rotational solids and surfaces.

You can use the Up To tool guide when you revolve edges.

To dimension the rotation, type the rotation angle while the Revolve handle is displayed and press Enter.

Revolving an Edge of a Surface
1. Select the

Pull tool in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should
be active.

2. Select the outside edge of a surface.

3. (Optional) Hold Ctrl and select an end point to maintain constant radius as the edge is revolved.

If you don't select an end point, the edge will follow influencing sides of surfaces or solids, if they exist. A side
influence can be another edge of the surface if it lies in the same plane, or a solid or surface that touches the end
of the edge. See the examples below.

4. Alt+click a straight line, axis, or edge to set the rotation axis.

You can also select the Revolve tool guide, then click the revolve axis. The revolve axis is shown in blue.

5. Click and drag in the direction of the Pull arrow to revolve the selected edge.

To dimension the rotation, type the rotation angle while the Revolve handle is displayed and press Enter.
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The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar.

The Revolve Options are available once you select the edge or face to pull, and the Revolve tool guide.

Examples

Revolving the edge of a solid to create a surface.

Revolving an edge of a surface that is not in the plane of the surface makes an edge with a constant radius because
the edge has no side influence in this direction.

Revolving an edge of a surface with side influence makes an edge that is influenced by adjacent edges.

Revolving an edge of a surface with side influence with its end-point selected makes an edge with a constant radius.
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Revolving an edge that crosses the axis will create more than one surface or solid if the edge is not symmetrical
across the axis.

4.4.1.11. Revolving Helices
You can revolve a helix with the Pull tool. Path and geometry are previewed as you pull along the axis or enter
dimensions, as shown in the image below.

Revolving a Helix
1. Select the

Pull tool in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should
be active.

2. Select the face or edge you want to revolve.

3. Select the

Revolve tool guide.

4. Click the axis you want to revolve around.

5. Select the Revolve Helix option in the Revolve Options group.

6. For points, select the Pull Both Sides option in the general Options panel to create a helix in both directions.

7. Set the handedness of the helix by selecting or deselecting theRight-HandedHelix option in the Options panel.
To create a Left-Handed Helix, deselect the Right-Handed Helix option.

8. Pull along the axis to create the helix dynamically.

As you pull, you can enter dimensions in the helix dimension fields:

• Pitch is the amount that the helix face shifts per 360 degrees of rotation.

• Taper is the helix angle.

Press Tab to switch between dimension fields and Enter to accept the dimensions and create the helix.

Creating a Helix Dimensionally
You can also create a helix by entering the height (the total length of the helix). PressTab to switch between dimension
fields and preview the helix. Click the Full Pull option to create the entire helix based on the dimensions.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar.
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4.4.1.12. Sweeping
You can sweep a face, edge, surface, 3D curve, or other object along a trajectory with the Pull tool. Sweeping a face
around a closed path creates a torus.

Sweeping a Face

1. Click Pull in the Edit group on the Design tab.

2. Select the profile you want to sweep.

3. Select the Sweep tool guide, then click the sweep trajectory. The sweep trajectory is shown in blue.
Alt+double-click to select a tangent chain. Ctrl+click to add contiguous paths.

You can also select the profile to sweep and then Alt+click the sweep trajectory or Alt+Ctrl+click multiple
trajectories. The sweep tool is selected automatically.

If the trajectory along which you want to sweep is a non-linear curve, you can also Alt+click the curve, which
selects the Sweep tool guide automatically.

If you select the Normal to Trajectory option, the sweep is aligned along the origin trajectory

To quickly sketch a face perpendicular to a desired trajectory, select the end of the trajectory and select a
sketching tool to place the sketch grid at that point. Then draw the face.

4. (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar.

Select:

• SelectNormal toTrajectory to keep the swept surface normal to the sweep trajectory. If your sweep trajectory
is perpendicular to the face you want to sweep, this option is enabled for you.

• Select Scale Sections to control the effect of the vector from the 0-to-X trajectory so that it controls both
orientation and scale of the sweep sections. Uncheck the box if you want the vector to control only the
orientation of the sweep sections.

• You can also select from the standard Pull options listed below.

5. Click and drag in the direction of the Pull arrow to sweep the selected objects, or select Full Pull from the
Options panel or mini-toolbar to sweep the entire length of the trajectory. If you select Full Pull and the profile
being swept is in the middle of the trajectory, it will be swept in both directions.

You can also use the Up To tool guide to select a face or surface on which you want to end the sweep.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar.

Examples

Hexagons swept around circular and hexagonal sweep paths
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Sweeping along a primary trajectory with Normal to Trajectory selected. Every section plane that is normal to the
origin trajectory is the exact same profile as the initial section, limited by the extents of the trajectory.

Sweeping along a primary trajectory withNormal to Trajectory not selected. Every section plane that is parallel to
the initial section profile is the exact same profile as that initial section, limited by the extents of the trajectory.

Sweeping a rectangle along a trajectory with Normal to Trajectory selected.

Sweeping a rectangle along a trajectory with Normal to Trajectory not selected.
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Sweeping a hole along a trajectory by selecting the axis of the hole, then the trajectory.

If you sweep a non-continuous profile, separate swept surfaces are created.

4.4.1.12.1. Sweeping with Multiple Trajectories
You can Alt+Ctrl+click to select multiple trajectories to sweep along. The trajectory you click first is the origin trajectory
(labeled O) and the second trajectory is labeled X. If you select the Normal to Trajectory option, the sweep is aligned
along the origin trajectory. If the object being swept is in the middle of the sweep, you can pull in either direction
to sweep only in that direction.

Sweeps can vary the sketch entities (or edges) along the sweep trajectory. The trajectories can be thought of as
guides that make continual changes to the profiles as if they had been dragged while in Sketch mode. Tangency
and other constraints are maintained.

When you sweep using more than two trajectories and Scale Sections is turned off, the profile lines and curves will
follow the trajectories individually and constraints are preserved. You can see an example in the image below.

You can use a chain of tangent edges as a guide for Sweep.

The extent (or length) of a sweep is limited by the shortest trajectory. If the profile being swept intersects at any
point along the trajectory, you can pull in either direction to sweep only in that direction. You can also select Full
Pull to create a bidirectional sweep that extends throughout the trajectory.

The sweep preview includes the following visual elements:

• The blue square indicates the direction of the origin trajectory at its start, and is localized around the origin
trajectory's intersection with the profile to be swept.

• A right-angle symbol is displayed on the origin trajectory when you select theNormal toorigin trajectoryoption.
• The preview rectangles are green and scale with the sweep if you select the Scale sections option.
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Sweeping with Two Guides
In a sweep with two guides, every section plane that is normal to the origin trajectory has a profile section that is
aligned to the vector defined by the O-X vector in that plane, scaled by the length of the O-X vector, and limited by
the extents of the shortest trajectory. If there are two or more trajectories and the spline that connects them (as a
profile) is tangent to the surfaces that contain the trajectory edges, then the spline not only scales and aligns to the
O-X vector, but also deforms to keep that profile tangent, at all points along the trajectories, to the neighboring
surfaces. The profile does not have to touch the trajectories, but the profile plane has to intersect with the trajectories.

You can also sweep with two closed trajectories:

Sweeping Along More than Two Trajectories
If the profile is composed of lines and circles, then guide curves will control the shape of the profile much the same
way a sketch is controlled by dragging the mouse. More specifically, there are three constraints: a line or circle that
touches a guide curve will maintain the connection throughout the sweep, a circle with a guide curve at its center
will stay centered on that guide curve through the sweep, and any members of the profile that are tangent will
remain tangent. If the profile contains splines, then any lines or splines attached to a guide curve will deform so
they remain attached throughout the sweep. In this case, neighboring faces that are tangent to the profile can be
Alt+selected to specify that the profile should remain tangent to the neighboring face throughout the sweep.
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When sweeping, cross-sections can be displayed as a preview for their sweep along the trajectories, also shown in
the figure above. You can control the display of the cross-sections with the Animate Full Pull Advanced SpaceClaim
option.

Sweeping Tangent to a Surface
If you select a sweep trajectory that is the edge of a surface, and the object being swept is tangent to that surface,
then the initial tangency is maintained along the entire sweep, as shown in the figure below.

Sweeping with a Trajectory and an Axis
If you sweep a profile along a trajectory with an axis as the secondary trajectory, then the profile normal is maintained
while the profile orientation changes as it is rotated around the axis.

4.4.1.12.2. Sweeping with an Axis to Set Orientation

1. Click Pull in the Edit group on the Design tab.

2. Select the object you want to sweep.

3. Alt+click the primary trajectory.

4. Ctrl+Alt+click the secondary trajectory.

5. Click the Rotate tool guide and click the axis or line that will set the orientation during the sweep.

6. Drag to create the sweep.
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The object being swept must be in the plane that contains the axis and an intersection with the baseline trajectory.

Examples

Setting the orientation of the selected object as it is swept along the trajectory.

Variable sweep with axis. Every section plane that is cut through a point on the origin trajectory and through the
selected axis has a profile section that is aligned to the vector defined by the O-X vector in that plane, scaled by the
length of the O-X vector, and limited by the extents of the shortest trajectory. This makes every section appear to
radiate around that selected axis.

4.4.1.13. Drafting Faces
You can draft faces around a plane or another face, edge, or surface with the Pull tool. Drafting changes the angle
of the selected contiguous faces. For example, a mold designer drafts faces to facilitate removal of parts from the
mold.
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Drafting a Face
1. (Optional) Insert a plane around which you want to draft faces.

You need to do this when you want to draft around a plane that doesn't already exist as geometry in the design.

2. Click
Pull in the Edit group on the Design tab. The Select tool guide on the right side of the Design window should be
active.

3. Select the face or contiguous faces you want to draft.

4. Alt+click the plane, face (including rounds), or surface about which you want to draft. When using a surface as a
neutral plane, you can select the surface in the Structure Tree.

You can also select the Draft tool guide

,
then click the face or surface. The draft plane, face, or surface is shown in blue.

Tip: When you need to select more than one face or surface for the Alt-reference (or after selecting the Draft tool
guide) then you have to hold the Ctrl and the Alt keys while selecting the additional references.

If you select one edge loop, you can create an edge-driven draft. If you select two edge loops, you can create a
split draft.

5. Click and drag in the direction of the Pull arrow to draft the selected faces.

To dimension the draft, type the rotation angle while you are pulling and press Enter.

The common pull options are described in Pull Options. Once you select the edge or face to pull, select these options
from the Options panel, or right-click and select them from the mini-toolbar:

Examples

Drafting a face about a round.

Drafting non-contiguous faces.
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Drafting around a plane that does not touch the faces being drafted.

Drafting faces around a plane. The drafted faces pivot around the face or plane you select as the draft plane.

Drafting both sides around the plane.

Drafting a face where a plane must be selected as the draft plane. See Inserting a plane for instructions to create a
plane.

Drafting the offset faces (inside and the outside) of a shelled solid.
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Drafting around a spline surface with the Draft both sides option selected

Drafting a set of surfaces about a planar surface not attached to the solid

4.4.1.14. Creating Slots
You can create slots from holes using the Pull tool. You can also edit slots. Slots maintain the relationship between
their faces.

If you pull a hole with a rounded or chamfered edge into a slot, the slot will have a rounded or chamfered edge.

Note: You must select the axis of the hole, rather than the axis of a round or chamfer on the hole. You will
not be able to pull the slot if you select the axis of the round or chamfer.

Creating a Slot

1. Click
Pull in the Edit group on the Design tab.

2. Select the axis of a hole.

If you have trouble selecting the axis, hover first over the inside face of the hole and the axis will appear.

3. (Optional) Hold Alt and click a face, edge, or vertex to set the direction or trajectory of the Pull.

4. (Optional) Select the Pull Both Sides option to create the slot in both directions.

5. (Optional) Select Full Pull to pull the slot along the full length of the trajectory, if you selected one.

6. Pull the axis or face of a hole to create a slot.

If you want to pull in a new direction, press the Tab key to change the direction of the Pull handles.

Creating a Curved Slot
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1. Select the axis or face of a hole.

2. Select the Rotate tool guide and click the axis of the driving cylinder.

You can also Alt+click the axis of the driving cylinder.

3. Pull the hole to create a curved slot.

You can pull a curved slot 360 degrees to make a round cut.

Creating a Radial Slot
1. Select the axis or face of a hole.

2. Do one of the following:

• Alt+click the face of the driving cylinder to set the direction of the Pull towards the axis of the driving cylinder.
Click the Pull Direction tool guide and pull the hole to create a radial slot.

• Ctrl+click the face of the driving cylinder to set the direction of the Pull towards the axis of the driving cylinder.
Click the Pull Direction tool guide and pull the hole to offset the cylinder and create a radial slot simultaneously.

• Select the Pull arrow that points toward the axis and pull.

If you want to lengthen a radial slot while keeping it the same distance from a radial face, Ctrl+click the radial
slot's axis and the face, then pull.

If you want to move a slot along with a radial face Ctrl+select the hole's axis and the face, then Ctrl+pull.

Creating an Offset of a Radial Slot
1. Select an axis of a slot.

2. Hold the Alt key and select the cylinder face or face to set the offset direction.

3. Hold the Ctrl key and pull or enter a radius value.

Creating a Swept Slot
1. Select the axis of a hole.
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2. Select the

Sweep tool guide.

3. Click the sweep trajectory.

A sweep mode arrow indicates the beginning of the sweep.

4. Click and drag in the direction of the Pull arrow to sweep the selected objects.

You can also select

Full Pull from the Options panel or the mini-toolbar to sweep the entire length of the trajectory. If you select
Full Pull and the face or surface being swept is in the middle of the trajectory, it will be swept in both directions.

Editing a Slot
You can modify a hole that was dragged to form a slot by pulling on any of the slot axes.

If the slot has a rounded or chamfered edge, double-click the round or chamfer to change its dimensions.

If you select Detach first in the Options panel, then the slot will become a solid if you use the Move tool to move it
off the body, as shown below.

Moving a Slot Radially
1. Select the Pull tool.

2. Select both axes of the slot.

3. Do one of the following:

• Alt+click the face of the driving cylinder to set the direction of the Pull towards the axis of the driving cylinder.
Click the Pull Direction tool guide and Ctrl-drag to move the slot radially.

• Ctrl+click the face of the driving cylinder to set the direction of the Pull towards the axis of the driving cylinder.
Click the Pull Direction tool guide and Ctrl+drag to offset the cylinder and move the slot.

You can also move a hole radially by pressing Shift while dragging it with the Pull tool.

Removing the Slot Relationship
Right-click a face of the slot and select Remove Association.
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Any changes you make to the slot's face will affect only that face.

Examples

Pulling mirrored holes to create slots

Creating a circular slot by entering an angle dimension with the Pull Both Sides option

Creating a radial slot by selecting an axis or edge parallel to the hole's axis as the Pull direction

Creating a slot using a vertex as the Pull direction

4.4.1.15. Scaling solids and surfaces
You can scale solids and surfaces with the Pull tool. You can scale multiple objects in different components.

Scaling a Solid, Surface or Mesh

1. Click Pull in the Edit group on the Design tab.
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2. Select a solid, surface, or mesh (meshes also have a Scale tool in the Facets tab).

3. Click the Scale Body tool guide.

4. Click a point, vertex, or origin to set the origin for scaling.

5. Pull to scale dynamically (a field appears to show the scale as you pull) or press the spacebar and enter the scale.

You can enter mathematical expressions to calculate a scale factor.

To scale using an annotation dimension, click the spark icon

next to the dimension and type a new value.

Note: Select the solid or surface, Alt+click a vertex to anchor the scale, and pull.

Scaling a Solid Asymmetrically

1. Click
Pull in the Edit group on the Design tab.

2. Select a solid body (Meshes can be scaled asymmetrically using the Scale tool in the Facets tab).

3. Click the Scale Body tool guide.

4. Click a point, vertex, or origin to set the origin for scaling.

5. Hold Alt and select an origin axis, or hold Alt and Ctrl and select a point and a line.
6. Drag in either direction of the line to scale the part in that direction.

You can press the Spacebar and enter a scale value while you are dragging.

Converting an Existing Solid or Surface fromMillimeters to Inches
1. Change the units to inches as described above.

2. Select the Pull tool in the Edit ribbon group on the Design tab.

3. Select the object you want to convert.

4. Scale the object by 25.4.

Scaling a Datum Plane or Axis

1. Click
Pull in the Edit group on the Design tab.

2. Select the datum plane and/or axis and select a curve, surface, or solid.

You must hold Ctrl and select the plane. Box-select will not select it.

3. Click the Scale Body tool guide.

4. Select an anchor point.

5. Drag in the direction of the Pull arrow.
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Examples

Scaling a solid asymmetrically

Scaling a plane and an axis with a solid

You can use annotation dimensions to scale an object. See Editing with annotation dimensions.

4.4.1.16. Copying Edges and Faces
You can copy edges and faces by selecting the Pull tool's Extrude Edge option. You can also copy edges and faces
with the Move tool.

When copying and pasting the edge of a surface as a curve or line, the lines are placed on the active layer and remain
selected until you clear the selection. This feature is useful if you need references to rebuild a surface.

Copying an Edge or Edges

1. Click
Pull in the Edit group on the Design tab.
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2. Select the edge or edges you want to copy. Double-click to select a chain of edges.

3. Select the Copy Edge option

in the Options panel or from the mini-toolbar.

You can also Ctrl+drag with the Pivot Edge or Extrude edge options selected to copy the edge.

The Pull arrow changes to show the two directions in which you can create copies of the edge. One arrow is
highlighted to show the primary direction.

4. If the arrow pointing the direction in which you want to copy the edge is not highlighted, click the arrow or press
Tab to change the direction.

5. Drag the edge in the direction of the highlighted Pull arrow.

During the pull, the distance between the copied edge and the new edge is displayed. When you create an external
edge, a surface is created between the copied edge and the new one.

Note: Press Ctrl and drag to copy the selected face.

Copying Mesh Edges
When you Copy and Paste mesh edges, the result is a polyline.

Examples

Copying edges to create new edges on a face
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When copying an edge, the edge adjusts based on the solid's geometry

Copying a round face

4.4.1.17. Pulling with the Select tool
You can pull with the Select tool or the Pull tool.

Drag the vertex of a selected face to another vertex to pull the selected face, as shown in the figures below.

Dragging a copy of a solid back into the solid
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4.4.1.18. Pivoting an Edge with the Select Tool
You can pivot an edge with the Select tool or the Pull tool.

Drag the vertex of a selected edge to another vertex to pivot the selected face, as shown in the figure below.

4.4.1.19. Using Measure to Drive Pull
Measurements can be made, and the results used, while in the Pull tool.

Using Measurements fromWithin the Pull Tool
1. Enter the Pull tool

2. Select an object to pull

3. Enter the Measure tool (shortcut is "e") and measure any single object or measure between two objects

4. Click the measurement result that will drive the Pull (hover over measurements to display a purple box). Once
selected, that single measurement will display on screen with arrows pointing to either object chosen for
measurement.

5. Click in the highlighted dimension box and modify the value for a one-time adjustment of the model.

6. (Optional) Create a Measurement Group which can be modified at any time.

a. Select a single measurement

b. Open the Groups panel

c. Click Create Group
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d. The measurement group is created

e. At any time, clicking on the group in the Group tree will open the Pull tool and put the measurement value
in edit mode. Simply enter a new value and complete the Pull.

Measurement groups can also be created from Area and Perimeter results. Modifying the group then adjusts the
model to produce a desired area. For example, create a Measurement group for the area of a side of a box. While
pulling the front of the box, you can enter a new area value for the side to complete the Pull.

4.4.2. Moving
Use the

Move tool to move any object in 2D or 3D, including drawing sheet views. The behavior of the Move tool changes
based on what you have selected.

• If you select an entire object, such as a solid, surface, or sketch, you can translate or rotate the object.

• You can move one side of a solid, surface, or sketch to enlarge or reduce the size of the object.

• If you move an object into another object in the same component, the smaller object is merged into the larger
one and receives the larger object's properties.

• Moving a component moves everything contained within the component.

• You can move a circular edge of a flat surface the same way you move a circular sketch curve.

• Mesh bodies, selected mesh facets, and mesh boundary loops can also be moved.
• Moving the apex of a cone changes the height. Anchor the Move tool to the outer face to scale the cone.
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When you move a component that has been assembled using assembly constraints, the Move handle is positioned
at the constraint and the axes that are constrained are disabled. If the assembly constraints only allow movement
in one direction, then that direction will be automatically selected. For example, if you move a component with a
Center Axes assembly constraint, the Move handle is positioned on the axis and you can only move the component
in directions that will keep the axes aligned.

Note: If the Move handle appears disabled, check the Structure tree to determine if an assembly condition
exists for the component you are trying to move.

Offset, mirror, and coaxial inferred relationships also affect Move.

Note: If you entered the Design tab with sheet metal features selected, the Move tool will work as it does
in Sheet metal. To work as usual, right-click the sheet metal part in the Structure tree and choose Suspend
Sheet Metal in the context menu.

Moving Objects

1. Click
Move in the Edit group on the Design tab.

2. Select the object(s) that you want to move.

3. Select the following options:
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• Move grid: Select this option to move the sketch grid.
• Ruler: Once you select an axis on the Move handle, select this option and click an edge or face to anchor the

ruler. The ruler is oriented along the selected Move handle axis. Specify a value to use the ruler to dimension
the move.

• Create patterns: Select this option if you want to create a pattern by dragging selected objects with the Move
tool. Dragging creates a copy of the selected object, moves it to a new location, and creates a pattern
relationship. Select theMaintain orientation option to keep the initial orientation of the original object when
you rotate or translate the pattern. See Creating a pattern.

• Detach first: Detach the selected protrusions and depressions, move them, and reattach them at the new
location.

• Maintain sketch connectivity: Keeps the connections between a sketch curve and other curves that share its
end points. If you deselect this option and move a sketch curve, the curve will move independent of other
curves.

• Rememberorientation: Sets the orientation of the Move tool for the object. The orientation is only remembered
for the current session. You can change the Move handle orientation by using the Direction tool guide, holding
Alt and selecting a reference object, or by dragging a ball on the Move handle's axes. You can select the following
options in the drop-down list to the right of the option:

• Default: The Move handle orientation is determined by the object(s) you select.
• Global: Saves the current Move handle orientation, and this orientation is used for all objects.
• Per Object: Saves the current Move handle orientation for the selected object. When you select the object

again with the Move tool active, the Move handle will be oriented at its saved orientation.

4. Click an axis and drag in that direction to move the selected object.

A line extends from the Move handle axis to indicate the direction you selected for movement.

If the move fails, the Move handle is repositioned to the last valid location and orientation. If you are trying to
move a protrusion surrounded by round faces, you may need to fill the rounds.

5. You can also Alt + select a plane between Move handles to invoke free drag movement within that plane. Place
the Move tool on any movable object and then hold the Alt key. Quarter circle planes appear between the Move
handles. Selecting one changes the cursor to a free drag cursor and allows free movement within the plane.
Select any Move handle to disable the free drag.

Note: The cursor does not need to be on the axis to move the selected object. In fact, you may find it easier
to control the move if you drag some distance from the entity and the Move handle.

Examples

Moving a protrusion with rounds that intersects with a stepped solid with the Detach first option
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Moving a circular edge along a surface

Moving an imprinted face off of a solid face creates a surface.

Moving imprinted edges on a face, and other intersecting imprinted edges are adjusted as needed. The examples
above show how the edges are adjusted when the imprinted areas are moved.

Moving the end point of a line segment that has a tangent arc on its other end changes the arc so that it remains
tangent to the line segment as you move its end point.

Moving Relative to Other Objects
• Snap to a co-planar face: Hold Shift while dragging to snap to co-planar faces when you have the Move handle

anchored to a planar face.

• Moveanobjectup toanotherobject: Click theUpTo tool guide to move objects so the center of the Move handle
is adjacent to the object.

• Orient an object to another object: Select the object to move and a Move handle axis, then click the Orient to
Object tool guide and select a second object. The selected object will be rotated so the selected Move handle axis
is aligned with the second object.

Changing the Anchor Location of the Move Handle
• Drag the yellow center sphere on the Move handle to snap it to other geometry

º Annotations have multiple Drag Points. The Move handle can be dragged near, and snapped to, any of these.
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• Click the Anchor tool guide and select the face, edge, or vertex on which to place the Move handle.

• You can also click the Origin

tool in the Design tab to insert an origin anywhere in your design that you want to anchor the Move tool.

The yellow center sphere turns into a blue cube when the Move handle is anchored.

Changing the Direction or Trajectory for the Move
• Drag one of the small balls on the rotational axis to reorient the Move handle, or dimension the orientation by

typing the rotation angle while you are dragging, then pressing Enter.

• You can also Alt+click a point or line, or click the Move Direction tool guide, then click a point or line, to orient
one of the Move handle's axes toward that point or along that line.

If you Alt+click a trajectory, you can move along the trajectory. Ctrl+Alt+click to add contiguous lines or edges to
the trajectory.

If you Alt+click a plane, the direction of movement is set perpendicular to the plane.

Example

Normal to Surface - While moving the diamond along the selected trajectory, Ctrl+Alt+click the face of the cylinder
to set the orientation of the diamond normal to the cylinder.

Dimensioning a Move
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1. Follow the steps to move an object.

2. After you click an axis on the Move handle, click Ruler in the Options panel.

3. Click an edge or face to anchor the ruler.

The ruler is oriented along the selected Move handle axis.

4. Type a distance and press Enter.

Copying an Object Using the Move Tool
• Press Ctrl to copy the object selected for movement and place it at the location at which you drag or dimension

the move.

You can press the spacebar to dimension the move.

• Double-click theUpTo tool guide to make multiple copies of the selected object. To exit this mode, select another
tool or click in empty space in the Design window.

Examples

Copying the red face multiple times by double-clicking theUpTo tool guide to keep it active for more than one move

Making copies by double-clicking the Up To tool guide also works with sketches

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. When this tool guide is active, you can select faces, surfaces,
solids, or components within the Move tool.
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Click any object with the Select Component tool guide to select the solid to which the object belongs. If
the solid is the only object in its component, the component will be selected.

Select a point, vertex, line, axis, plane, or planar face with the Move Direction tool guide to orient the
Move handle and set the initial direction of the move. (The object will not move until you drag.)

Select a set of lines or edges with the Move Along Trajectory tool guide to move the selected objects
along that trajectory. For best results, perform Moves along trajectories in small increments. If the object
to be moved is a protrusion, it will be detached, then reattached in the new location. When you move a
protrusion along a trajectory, rounds are automatically removed. Ctrl+Alt+click a face to control the
orientation of the object being moved or patterned along.

Select an object, then use the Anchor tool guide to select the face, edge, or vertex that will anchor the
move. You can anchor the Move handle to a temporary object, such as the intersection between two axes
by Alt+Shift+clicking the two objects.

Select an object, then use theFulcrum tool guide to move other objects around it. Select a pattern member
to anchor it, or select a component to explode an assembly. See Moving with the Fulcrum tool guide.

TheMove radially about axis tool guide allows you to select an axis to move the selected objects radially
about. Once you select an axis, the Move handle will reorient to have one axis parallel to the move axis
and one axis in the radial direction.

Once you select the object to move and a Move handle axis, use the Up To tool guide to select the object
you want to move up to.

If a Move handle axis is selected, the Move is limited to that direction. If no handles are selected, the object
is translated until the center of the Move handle lies on the selected reference. (A move handle must be
selected to move up to the axis of an origin.)

In a linear move to an intersecting object, the center of the Move handle is moved to the selected object.
If the two objects do not intersect, the first object is moved along the desired direction up to the closest
point to the second object. You can use this tool guide to:

• Select a point along a trajectory or the axis of an origin to move up to.

• Move the sketch grid in Sketch and Section modes.

• Move an axis so it is coincident with another axis in a body. If you move the axis of a pattern, all pattern
members will move together to the new location.

You can double-click theUpTo tool guide to keep it active. While the tool guide is active, it will copy faces
and surfaces instead of moving them. To deactivate the tool guide, click it again, select another tool guide,
or exit the Move tool.

Once you select the object to move and a Move handle axis, use the Orient to Object tool guide to click
an object. The selected object will be rotated until the selected Move handle axis is aligned with the clicked
object. You can also use this tool guide to rotate the sketch grid in Sketch and Section modes.

Options
The following options are available in the Move tool:

• Move grid: Select this option to move the sketch grid.
• Symmetric Move: Select this option to move symmetrically.
• Measure:Opens theMeasure tool. Selecting a measurement result returns you to theMove tool. When you select

move direction, the measurement value is displayed in a dimension box with an arrow pointing to the measured
object. Modify the value for a one-time adjustment of the model or create a Measurement Group which can be
modified at any time.
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• Ruler: Once you select an axis on the Move handle, select this option and click an edge or face to anchor the ruler.
The ruler is oriented along the selected Move handle axis. Specify a value to use the ruler to dimension the move.

• Maintain orientation: Select this option to maintain the orientation of the object when rotating or moving along
a trajectory.

• Create patterns: Select this option if you want to create a pattern by dragging selected objects with the Move
tool. Dragging creates a copy of the selected object, moves it to a new location, and creates a pattern relationship.

Select the Maintain orientation option to keep the initial orientation of the original object when you rotate or
translate the pattern. See Creating a pattern.

• Detach first: Select this option to detach selected protrusions and depressions, move them, and reattach them
at the new location.

• Maintain sketch connectivity: Keep the connection between a sketch curve and other curves that share its end
points. If you deselect this option and move a sketch curve, the curve will move independent of other curves.

• Keep beam fixed: This option is for beams and causes the beam to remain fixed while the profile becomes offset
from the beam. See Moving beams.

• Remember orientation: Sets the orientation of the Move tool for the object. The orientation is only remembered
for the current session. You can change the Move handle orientation by using the Direction tool guide, holding Alt
and selecting a reference object, or by dragging a ball on the Move handle's axes. You can select the following
options in the drop-down list to the right of the option:

º Default: The Move handle orientation is determined by the object(s) you select.
º Global: Saves the current Move handle orientation, and this orientation is used for all objects.
º PerObject: Saves the current Move handle orientation for the selected object. When you select the object again

with the Move tool active, the Move handle will be oriented at its saved orientation.

• Enter XYZ coordinates: This option allows you to enter X, Y, and Z distances to move relative to the World Origin.
When you select the option, the Move handle re-orients to be parallel to the World Origin and displays X, Y, and Z
input panels.

4.4.2.1. The Move Handle
You will use the Move handle to move objects in 2D and 3D. The Move handle allows you to translate and rotate
objects. You use the Move handle by clicking the axes of the Move handle and dragging to move the selected object.

When you select the object you want to move, and click one of the Move tools, SpaceClaim guesses at the anchor
point and orientation of the Move handle. If either of these is incorrect, you can change them.

You can adjust the size of the Move handle in Popular options.
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Translating Objects Using the Move Handle
1. Click the axis that is aligned with the direction you want to move the selected object.

2. Drag in the direction of the axis to move the object.

You can Ctrl+drag to create a copy of the object while moving.

Rotating Objects Using the Move Handle
Use the curved rotational axis that is aligned with the direction you want to rotate:

• Drag the axis to rotate the selected object.

You can hold the Ctrl key to create a copy of the object while moving.

• Double-click the axis to rotate the object 90°. You can hold the Ctrl key while double-clicking to create a copy of
the object at 90°.

Moving Freely Within a Plane Using the Move Handle
Use the planes between Move handles to move within a plane.

• Hold the Alt key
• Quarter circle planes display between the Move handles
• Select the plane to move within
• Release the Alt key and start dragging.

While dragging, the cursor changes to the free drag cursor.

• Clicking on any Move handle cancels free drag movement.

Realigning the Axes of the Move Handle
You can realign the Move handle in the following ways:

• Drag the small balls on each rotation axis of the Move handle to reorient it. While dragging, you can also press the
spacebar to enter the angle directly.

• Drag the center ball of the Move handle (or use the Anchor tool guide) to place it on another solid, face, edge, or
vertex. If you use this method, note that the selected object is still the one that is going to move.

• Alt+click a point or line (or use the Move Direction tool guide) to orient the closest linear axis toward that point or
along the line.
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Sizing the Move Handle

See Popular options to adjust the size of the Move handle.

To have all endpoints meet at a single point, use the Up To tool guide.

Moving Multiple Beam Endpoints to a Single Point
1. Click the Move tool and select the endpoints (you can also use box select).

2. Anchor the Move Handle by using the Anchor tool guide or by dragging the yellow ball.

3. Click the Up To tool guide and select the Up To reference.
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4. The endpoints will all snap to the single point.

4.4.2.2. Moving Symmetrically
Use the

Symmetric Move option in the Move tool to move objects relative to each other about a plane as if they are mirrored
objects but without the need to create a mirror association between the objects. Unlike the Mirror tool, the Symmetric
move option can be used to move dissimilar geometry as well as similar.

You can use this option with an automatically determined virtual mirror plane based on the Move handle location
or you can use the fulcrum tool guide to establish a fixed mirror plane.

With a fulcrum-selected mirror plane, geometry which is the same on both sides of the plane is found and moved
automatically when moving geometry on one side of the plane. The center of each selected object determines which
side of the plane the geometry lies on.

Faces, edges, vertices, section curves, datum planes, and sketch curves can be moved symmetrically. Curves that
partially overlap the symmetry plane can be moved. The symmetric move option is not available for moving objects
which have an established mirror association

Moving Objects Symmetrically About a Virtual Mirror Plane
1. Select two or more objects.

2. Click the Move tool.

3. Click
Symmetric Move in the Move Options panel.

4. Click one of the translation arrows and drag. As you drag, a ghost mirror plane appears at the center of the Move
handle, perpendicular to the direction you are dragging. Movements are mirrored about this plane. A ghost move
handle is displayed on the other side of the virtual mirror plane to indicate the mirrored translation or rotation.
Selected objects are moved symmetrically about the indicated plane.

To reset the virtual mirror plane, change selection or toggle the Symmetric Move option.
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Examples

Moving two solids symmetrically about a virtual mirror.

Moving two curves.

Moving Objects Symmetrically with a Fulcrum-selected Mirror Plane
1. Create a plane or planar face.

2. Select one or more objects.

3. Click the Move tool.

4. Click
Symmetric Move in the Move Options panel.

5. Click the

Fulcrum tool guide.

6. Click the plane or planar face to specify the symmetry plane.

Objects on the other side of the fulcrum plane with matching geometry are automatically detected and moved
symmetrically about the plane.

7. Drag a rotation or translation arrow on the move handle to modify the geometry symmetrically about the
fulcrum-selected mirror plane.

Examples

Pivoting an edge modifies the matching geometry on the other side of the fulcrum-selected mirror plane.
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Moving faces that are symmetric to each other but lie partially on either side of the mirror plane. The center of each
of the objects' bounding boxes is on either side of the plane, so the symmetric move tool can detect the symmetric
geometry and the angled faces can be moved

4.4.2.3. Creating a Pattern
You can create a pattern of protrusions or depressions (including slots), points, components, planes, origins, or axes.
You can also create patterns of sketch curves. You cannot create a pattern of threads. You can use the Undo button
Ctrl+Z or Redo button Ctrl+Y when creating a pattern.

You can also create a pattern from a mix of object types, such as a pattern of holes (faces) and bolts (imported
components). In SpaceClaim, any pattern member can be used to modify the pattern after you create it. If the change
cannot be made to all pattern members, the member that cannot change is still part of the pattern. Once you select
a Pattern Type, the fill displays to show a pattern preview.

When you select a member of a pattern, you will see fields for the pattern count and distances relative to the member
you have selected. Press Tab to move among the dimension and count fields.

• Icons next to the pattern's dimensions and counts show which will be changed if you change the value of the
highlighted field. The closed lock indicates that a dimension won't change and the open lock shows you it will
change. You can override a lock on a dimension by clicking its icon to toggle it between locked and unlocked.

• Dimension or count line placement, arrows, and value fields show you how the pattern will change if you change
the value of a field.

• Your selection determines how changes to the distance and count affect the pattern's position. If you select one
member of the pattern, the change is centered on that member. If you select all pattern members, the change is
centered on the entire pattern, with the distance between members locked by default. You can control which
direction the pattern will grow based on which member you select and which count or distance you change.

• Changing a pattern count in one direction does not change the distance between pattern members. Instead, the
overall distance of the pattern will change. This is indicated by the closed lock icon.

• Circular patterns are anchored at the opposite end by default when you move one end.

With a pattern node selected in the Structure tree, you can:

• Change fill pattern parameters in the Layout section of the Properties panel. Changes that you make automatically
update the pattern in the design window.

• Right-click and select Lightweight Pattern to toggle a pattern component between a lightweight pattern and
regular pattern. When selected, a check mark displays next to the Lightweight Pattern command. This also works
with sheet metal components: with a Pattern node selected in the Structure tree, right-click and select Make
Lightweight.

• To update lightweight fill patterns to fit the existing geometry of your design, select the lightweight pattern node,
then right-click and select Update Pattern.
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Note: Patterns of sketch entities and 3D curves are no longer patterns when they change into another form,
such as a surface or solid. For example, if you pattern a C-shaped curve, then it will remain a pattern when
you switch from sketch mode to 3D mode. But if you close off the curve to make a box before you switch to
3D mode, then the boxes will become surfaces and will no longer be a pattern.

Creating Patterns

Creating a One- or Two-Dimension Linear Pattern
1. Click the

Linear tool in the Insert group on the Design tab.
2. Select a protrusion, depression, body, sketch, points, axes, planes, origins, or 3D curves to be the first member

(leader) of the pattern. The Direction tool guide activates.

3. Select a line, edge, axis, or a set of points to set the direction of the pattern.

4. (Optional) Modify the Pattern options in the Options panel.

Pattern Type: One-dimensional or Two-dimensional.

Change X Count, or X Pitch values for One-dimensional

Change X, Y Count, or X, Y Pitch values for Two-dimensional

As you switch between pattern types, or change pattern values, the pattern preview displays your changes in
blue.

5. Select the Create Pattern tool guide, or press Enter, to complete the pattern.

The image below shows the preview for a two-dimensional pattern. For one-dimensional, only the X-direction is
displayed. Clicking the arrows flips their direction 180-degrees.

For through-all cuts, the preview is on the plane closest to the direction reference. For blind cuts, the preview is on
the face of the selected pattern leader.
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You can also create one-dimensional linear patterns on cylindrical faces as long as the pattern direction is either
the cylinders axis or parallel to the axis.

Creating a Pattern of a Pattern
Follow the steps for the linear pattern, but select a member of a linear pattern as the first member of the pattern.

Creating a Circular Pattern
1. Click the

Circular tool in the Insert group on the Design tab.
2. Select a protrusion, depression, body, sketch, points, axes, planes, origins, or 3D curves to be the first member

(leader) of the pattern. The Direction tool guide activates.

3. Select a line, edge, axis, or a set of points to set the direction of the pattern.

4. (Optional) Modify the Pattern options in the Options panel.

Pattern Type: One-dimensional or Two-dimensional.

Change Circular Count, or Angle values for One-dimensional.

Change Circular Count, Angle, Linear Count, or Linear Pitch values for Two-dimensional.

Note that a Circular Count of one will create a single radial pattern.

As you switch between pattern types, or change pattern values, the pattern preview displays your changes in
blue.

5. Select the Create Pattern tool guide, or press Enter, to complete the pattern.

The image below shows the preview for a two-dimensional pattern. For one-dimensional, only the Angular direction
is displayed. Clicking the arrows flips their direction 180-degrees.

You can create circular patterns on cylindrical faces, both around the face and along the axis.

Creating a Fill Pattern
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1. Click the

Fill tool in the Insert group on the Design tab.
2. Select a protrusion, depression, sketch, points, axes, planes, origins, or 3D curves to be the first member (leader)

of the pattern. The Direction tool guide activates.

3. Select a line, edge, axis, or a set of points to set the direction of the pattern.

4. Modify the options in the Options panel

Pattern Type: Grid or Offset

Modify the X Spacing or Y Spacing

Modify the Margin values. A dashed orange boundary line displays the pattern's marginal boundary.

As you switch between pattern types, or change pattern values, the pattern preview displays your changes in
blue.

5. Select the Create Pattern tool guide, or press Enter, to complete the pattern.

Creating a Radial Circular Pattern
1. Select all radial pattern members.

2. Click the

Move tool.

3. Re-anchor the Move tool on the circular axis.

4. Select the Create patterns check box in the Options panel.

5. Drag the radial pattern to form a circular pattern.

Create a Pattern of Points Along an Edge
1. Select a point to be the first member of the pattern.

2. Click the

Move tool.

3. Select the Create patterns check box in the Options panel.

4. Click the Move Along Trajectory tool guide.

5. Click one of the edges that connects to the vertex.

6. Click the Move handle axis.
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7. Drag to create the end pattern member and create the pattern.

8. Press Tab to change the count, length, and percent fields to edit the pattern of points.

All points are associated with the edge, so that when the edge changes, the points also change as shown in the
example below.

Editing a Pattern's Properties
1. Select one pattern member to display the pattern count and dimensions.

2. Edit the pattern's properties.

Press Tab to switch between the fields.

Click the lock icon to lock or unlock a value.

Note: By default, Pattern Length is locked.

3. Press Enter.

The result of editing the count and spacing is relative to the member of the pattern you select.

Note: To quickly increase or decrease the number of pattern members, press Tab until the count field is
highlighted, then hold the Alt key while you press the up or down arrow.

Moving a Pattern
1. Click the

Move tool.

2. Select a pattern member to move a linear pattern or the pattern axis to move a circular or arc pattern.

3. Move the pattern member with the Move handle.

If you move an interior member of a pattern and it is not anchored, all the pattern members move:
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If you move a member at one end of a pattern, the member at the opposite end is anchored and the pattern is
skewed:

If you anchor a different member than the member opposite the direction you are moving, Move skews the
pattern.

If you have a linear pattern in a radial direction and you move an interior member without setting an anchor,
then the entire pattern shifts in the selected direction

Use the Up To tool guide to move a pattern member up to another face or edge. Pattern dimensions (such as
Count and Length) display as expected.

You can also use theUpTo tool guide in the Move tool to create a circular pattern by rotating up to a linear entity
passing through the Move Handle origin.

Creating a Circular Pattern Using the Up To Tool
1. Relocate the Move Handle to the axis of the cylinder.a.

b. Choose the rotation handle about the cylinder's axis.
c. Click Up To and select the horizontal axis to create the pattern.

Moving a Radial Pattern in a Linear Direction
1. Click the

Move tool.

2. Right-click a pattern member and click Select > All Pattern Members.

3. Select the Direction tool guide.

4. Click an object to set the direction of the move.

5. Drag the pattern.
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Adjusting Pattern Distance or Spacing

1. Click
Select or

Move in the Edit group on the Design tab.

2. Select a pattern member.

This member will serve as the anchor, and other pattern members will move relative to this member.

3. Press Tab until the field you want to change is highlighted:

• Distance: This field is the overall distance of the pattern. The pattern member you select is anchored, and the
length will change relative to this member. The arrows indicate the direction of change. You can see this field
at the top of the image below.

• Spacing: This field is the spacing between pattern members. This field has arrows in both directions and is
located between two pattern members. The field is highlighted in blue in the image below.

• Radialpatterns: If you select a member of a radial pattern, you can change the angle between pattern members
and the distance from the pattern members to the center of the pattern.

4. Type a new distance or angle and press Enter.

The spacing between all pattern members will change.

Removing a Pattern Member from the Pattern
Right-click the face of the pattern member and selectUnpatternMember. Doing this makes the member independent,
so changes to the feature won't propagate to the pattern.

Creating a Pattern Group
1. Select a pattern or pattern member in the Design window.

2. Click the Groups tab in the Structure panel.

3. Click Create NS.

A group is created that displays the number of members in the pattern. You can click this group to select the
pattern and change its parameters in the Design window.

Assembling Components on a Pattern
You can assemble a component with a pattern member, then propagate the component to all of the pattern members.
The component will be copied and assembled to each pattern member.

1. Assemble a component to some geometry that is a pattern member using the Align, Tangent, or Orient tools.

2. Right-click the Assembly Condition in the Structure Tree and select Update Components on Pattern.
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The components will be propagated to the pattern, as shown below.

Creating a Pattern Along a Trajectory

1. Click
Move tool.

2. Select the object you want to pattern.

3. Click the Move Along Trajectory tool guide and select the curve to use as a trajectory.

You can also hold Alt and double-click the curve.

4. Check Create Patterns in the Move options.
5. Pull the trajectory arrow.
6. Release the mouse button to display pattern dimensioning options, then enter values by tabbing through the

options.
7. (Optional) CheckMaintainOrientation in the Move options to keep the patterned objects in the same orientation

as the original object.

Pattern along a trajectory without maintaining orientation.

Pattern along a trajectory with orientation maintained.
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Examples

Rectangular pattern

Changing spacing between pattern members changes the pattern's overall length when the length field isn't locked.

A pattern of sketch objects is no longer a pattern when you switch to 3D mode and the sketched objects are converted
to surfaces.

Sketch curve patterns can propagate in two dimensions. The pattern above contains three squares in the X direction
and two squares in the Y direction.
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Faceted bodies can be patterned after selecting the body to pattern and direction.

4.4.2.4. Pivoting and Pulling Solids
You can use the Move tool to pivot or pull a solid.

Pulling a Solid
1. Click the Move tool.

2. Select the face you want to move.

3. Use the Move handle to move the face.

The solid is extended in the direction of the move

Pivoting a Solid
1. Select an edge loop on the solid that you want to pivot.

2. Click a linear axis of the Move handle.

3. (Optional) Click the Fulcrum tool guide and click an alternate plane to pivot around.

4. Drag to pivot the solid around a plane drawn through a point opposite the selected edge loop or to pivot the
solid around the plane you selected with the Fulcrum tool guide.

If the Move tool cannot maintain a planar or cylindrical face while pivoting, it will create a blended face.
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4.4.2.5. Moving a Solid or Surface with the Select Tool
You can move solids and surfaces with the Select tool.

You can do any of the following:

• Select a vertex of a solid or surface, then drag it to move the solid or surface. (Surfaces on the same plane are
treated as a single surface and move together.)

• Alt+click a point, then drag the vertex to rotate in the plane of the screen.

• Alt+click an edge or two points, then drag the vertex to rotate the object around the axis defined by the line or
points.

• You can place the dragged vertex on a plane or edge by dragging until the plane or edge is highlighted.

You cannot drag unfolded sheet metal parts in the Unfolded window by dragging their vertices with the Select tool.

Examples

The blue edge was selected using the Alt key, then the green vertex was dragged in the direction of the arrow. The
part pivots around the blue edge.

The vertex highlighted in green was dragged down until the face shown on the right was highlighted. The triangular
part moves down so the vertex is in the same plane as the face.

When you hover and pre-highlight a vertex, the curve to which it belongs is highlighted. Using the mouse wheel, you
can scroll through other curves attached to the vertex.
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The cursor changes to the Move cursor when the mouse is over a vertex.

When the curve you want is highlighted, you can Alt-drag to move only the vertex of that curve.

Pressing the Alt key changes the Move cursor to the Detach-and-Move cursor.

You do not need to hold the Alt key throughout dragging. You can release it once you start dragging.

Drag a copy of the curve using Ctrl+Alt+drag.
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In the images above, notice the "source-generated dotted lines" extending from the other curve. This is similar to
the behavior in Sketch Mode for aligning and snapping the vertex. By default, the system generates them extending
from all curves that intersect at the selected-and-moving vertex.

Drag the vertex vertically. The extension line for the affected curve is shown as well as the extension for the vertical
curve.

Drag the vertex away from the vertical curve. The vertical extension line disappears, the affected curve extension
stays and the extension for the third curve appears.
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Sketch only allows snapping in the plane, but with Curve Dragging, you can snap in 3D.

When you hover over any straight line or edge while dragging a vertex, a dotted vector will be generated. This allows
you to snap to the extension of any existing line or edge.

Since you can drag a vertex without holding down the Alt or Ctrl keys, you can Shift-hover over other objects. This
displays extension lines for other lines or edges. The default, source-generated dotted lines are erased when you
Shift-hover over an object.
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Sequentially Shift-hovering on converging lines or edges lets you snap to their virtual intersection.

In the example below, the top horizontal line is a single curve, but with two "sub-curves" because the vertical curve's
endpoint lies somewhere along its length. Although there is only one horizontal curve, it can be treated as split, for
the purposes of dragging other vertices to these sub-curve endpoints or midpoints.
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Sub-curve midpoints are available for snapping if you Shift-hover over the parent curve.

Green points display at the endpoints of the sub-curve and a triangle displays at the midpoint. This helps to determine
what portion of the curve is being snapped to, in cases where it may be ambiguous.

The virtual intersection of the horizontal and slanted lines is available for snapping if you Shift-hover over both.
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Curve intersections (for both straight and arc-shaped curves) are available for snapping and displayed with a "+"
sign.

Face selection does not override edge extension snapping. In this example, the extension line is above the face. If
the face had a higher priority, you could not snap to the extension line without reorienting the view.
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You can snap a vertex to a 3D point.

You can also snap a vertex to the virtual intersections of extended solid edges.

4.4.2.6. Moving with the Fulcrum Tool Guide
The Fulcrum tool guide fixes a point, edge, or face in 3D space. Then selected objects are moved relative to the
fulcrum object. You can use this tool guide to pivot patterns or faces, or to create a simple exploded assembly.

1. Click
Move in the Edit group.

2. Select the objects you want to move. You can select surfaces, solids, or components in the Structure tree, or
select point(s), edge(s), or face(s) in the design window.

This object will be highlighted. Selected components will be highlighted with a bounding box.

3. Click the Fulcrum tool guide on the side of the Design window.

4. Select the object you want to use as the fulcrum. You can select surfaces, solids, or components in the Structure
tree, or a point, edge, or face in the design window.
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This object will be highlighted in blue.

5. Drag an arrow or radius on the Move handle to move the object(s).

Selected objects will move proportionally, relative to the fulcrum.

Examples
In the examples below, the object was dragged in the direction indicated by the red arrow.

Moving an edge using another edge as the fulcrum point.

Moving a pattern with one pattern member as the fulcrum point. You must select all the faces on the pattern member
that you move.

Creating a simple exploded view by using a face of one component as the fulcrum point. Select the components in
the Structure tree that are part of the assembly you want to explode.

4.4.2.7. Moving the Sketch Grid
Use the Move Grid tool to move the sketch grid. Make successive sketches by moving the grid after sketching closed
line regions. These closed lines turn into regions when you move the grid.

The icon at the center of the sketch grid

indicates the origin of the grid and moves with the grid as you move the grid.
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Moving the Sketch Grid
1. Click the Move Grid tool

on the mini-toolbar or click the Move tool and check the Move Grid option.

2. (Optional) Select any sketch entities that you want to move along with the sketch grid.

3. Select a Move handle axis.

4. Drag along the axis of the Move handle to move or rotate the sketch grid.

Press Shift while dragging to snap the move to angular and linear increments based on your snap settings as
well as to snap the move parallel to planes, edges, and axes. You can also right-click and select Use Ruler
Dimension, and enter a value or press Enter to drag the grid. You can also use the standard Move tool guides
when moving the grid.

The Move handle can be moved around by dragging the center ball onto appropriate entities on the sketch grid.

Moving the Center of the Sketch Grid

1. Insert an origin.

2. Select an axis of the origin.

3. Switch to Sketch mode.

You can also move the center of the sketch grid while sketching by using the Move Grid or Select New Sketch
Plane tools in the Sketch mini-toolbar.

4.4.2.8. Moving Protrusions and Depressions
You can move protrusions and depressions with the Select tool or the Move tool.

1. Select a protrusion or depression.

2. Drag the protrusion or depression.

If two faces connect at an angle greater than 90 degrees, you can drag the protrusion across the two faces, as
shown in the image below.
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4.4.2.9. Using Measure to Drive Move
Measurements can be made, and the results used, while in the Move tool.

Using Measurements fromWithin the Move Tool
1. Enter the Move tool.

2. Place the Move tool on a face, edge or vertex.

3. Click one of the Move tool handles to establish a direction.

4. Enter the Measure tool (shortcut is "e") and measure any single object or measure between two objects.

5. Click the measurement result that will drive the Move (hover over measurements to display a purple box). Once
selected, that single measurement will display on screen with arrows pointing to either object chosen for
measurement.

6. Click in the highlighted dimension box and modify the value for a one-time adjustment of the model.

7. (Optional) Create a Measurement Group which can be modified at any time.

a. Select a single measurement

b. Open the Groups panel

c. Click Create Group

d. The measurement group is created

e. At any time, clicking on the group in the Group tree will open the Move tool and put the measurement value
in edit mode. Simply enter a new value and complete the move.
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Measurement groups can also be created from Area and Perimeter results. Modifying the group then adjusts the
model to produce a desired area. For example, create a Measurement group for the area of a side of a box. While
moving the front of the box, you can enter a new area value for the side to complete the move.

Alternate Workflow
1. Enter the Move tool

2. Place the Move tool on a face, edge or vertex

3. Enter the Measure tool (shortcut is "e") and measure any single object or measure between two objects

4. Click the measurement result that will drive the Move (hover over measurements to display a purple box).

5. Select on a direction arrow to display the single measurement. Once selected, that single measurement will
display on screen with arrows pointing to either object chosen for measurement.

6. Click in the highlighted dimension box and modify the value for a one-time adjustment of the model.

7. (Optional) Create a Measurement Group which can be modified at any time.

a. Select a single measurement

b. Open the Groups panel

c. Click Create Group

d. The measurement group is created

e. At any time, clicking on the group in the Group tree will open the Move tool and put the measurement value
in edit mode. Simply enter a new value and complete the move.

Measurement groups can also be created fromArea results. Modifying the group then adjusts the model to produce
a desired area. For example, create a Measurement group for the area of a side of a box. While moving the front of
the box, you can enter a new area value for the side to complete the move.
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Other Group Examples

4.4.3. Fill
Use the Fill tool to fill in the selected region with the surrounding surface or solid. Fill can "heal" many cuts made
into geometry, such as chamfers and rounds, subtractive revolves, protrusions, depressions, and regions removed
by removing regions in the Combine tool. When using Fill to fill a gusset, the bend geometry on which the gusset is
defined remains intact.

The Fill tool can also be used to simplify surface edges and cap surfaces to form solids. You can select a combination
of faces and edges to replace them with a single new face.

You can use the Fill tool in Sketch mode to fill a loop of sketch curves that is almost closed, but that has multiple
small gaps. If the gaps are too large, multiple error messages appear to show you where the gaps are. You can also
use it to concatenate multiple sketched curves.

You can also use the Fill tool when editing a layout. Fill functionality is useful when you sketch faces across section
lines, but do not want the section lines to split the surfaces when you switch to 3D.
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When you change the geometry of a model, for example, the model's length, height, or width, the model's fill pattern
will automatically update to correctly re-fill to the model's new geometry.

Using the Fill Tool
Click one of the links below for detailed information about working with the Fill tool:

Sketch and Layout Curves
If you select one or more end points of sketch curves, the curves are concatenated into a single spline. Neighboring
sketch curves are merged into one selectable item with an underlying spline. The spline is not displayed until the
concatenated curve is modified:

Let's look at the following sketch curves:

One of the rectangles isn't closed. If you fill this rectangle, the loop is automatically closed and it becomes a surface:

The gap in this loop is small enough for the Fill tool to automatically close. Larger gaps will not be closed. If a gap
is less than 1.5 times the length of the minor grid spacing on the sketch grid, the edges are extended to close the
gap. If the gap is larger, a message appears in the status bar and the gap's endpoints flash.

The Fill tool also created surfaces from the other closed loops of sketch curves. The darker shaded areas in the image
above show where the surface parts overlap. If you move the rectangle, you can see the surface that was created
automatically:
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The result only has edges for the sketch curves that were not selected, because the selected curves were used to
create a separate surface.

Now let's go back and close the open rectangle, and let the Fill tool automatically create surfaces without selecting
any edges:

This surface has edges for every closed sketch curve. The same thing automatically happens if you go from sketch
mode to 3D mode.

If you select all the sketch curves, then click Fill, you get a surface without any interior edges:

You can also fill layout and sketch loops:

And a loop of non-tangent 3D curves:

Vertices
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You can select any number of edge points in any order. Each edge point is removed and a spline is created to make
a smooth curvature change between the neighboring edges to the point:

If you Fill a vertex on a solid, the system attempts to merge coincident edges into a single edge:

Edges on Surfaces
If you select one surface edge in the shape of a spline or arc, the edge is simplified into a straight line:

If you select two or more edges of a surface, the edges are simplified with a straight edge between the end points:

If you select an edge that is completely within a surface, the edge is removed:

If you select all the edges that enclose a surface, the surface is simplified into a rectangle based on its extents:
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If you select a single edge that lies on an analytic surface, Fill will simplify it with the neighboring edges:

You can fill irregular gaps on a circular surface, and the gap is simplified into a straight edge. Use Fill again on the
straight edge, and the edge becomes round:

Chamfers on Surfaces
Select a chamfer on a surface and then use the Fill tool to fill the chamfer.

Edges on More Than One Face
If you select a chain of open, planar surface edges, Fill creates faces based on the edges you select:

or
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If you select an open edge loop that belongs to multiple faces, Fill attempts to cap it with an analytic surface (cylinder,
cone, etc.):

If you select a series of planar edges, you will get a planar face:

If you select a series of surface edges that are not planar, Fill extends neighboring faces if the Patch Blend option is
off:

If the Patch Blend option is turned on,

If you select an edge loop and Alt+click to select neighboring faces, the new face will be tangent to any faces you
used Alt+click to select:
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You can also extend neighboring faces to fill sliver gaps (double-click to get loop):

If you select open edges of a self-intersecting surface, Fill tries to form a solid and remove excess (also works in
combine):

If you select an edge loop and use the Patch blend and Tangent extension options:

When you fill a loop of edges, you can use Alt and select curves and the new face(s) will pass through the curves:
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If you select an edge loop and guide curves, with or without the Tangent extension option (which applies to areas
not influenced by guide curves):

If you select an imprinted edge on the face of a surface or solid, the imprinted edge is removed. This works the same
as delete:

If you select laminar edge(s) of a solid or surface, Fill simplifies the edges by replacing them with a single edge with
the same geometry:

Solids
If you select faces, Fill deletes them and extends neighboring faces:
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If you select a chamfer or round, Fill removes them and adds them to a named group:

If you select rounds with neighboring rounds, Fill creates planar caps (because rounds should not be extended by
definition):

If you select rounds on shelled parts, both faces of the shell are filled:

If you select joint edges created in Sheet Metal, the joints are removed:

If you select two imprinted edges, as shown below, they are combined into one edge:

Faces and Edges or Sketch Curves
With at least one face selected and at least one edge or sketch curve selected, Fill will remove the selected faces
and create a single new face using the removed faces and the selected edges as inputs:

302Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



If you select two faces or surfaces that don't touch, you can replace them with a single face. You must double-click
to select the gap between the faces:

Any Combination of Sketch Curves, Layout Curves, Surface Edges, and Solid
Edges
When you select any combination of sketch curves, layout curves, surface edges, and solid edges that lie in the same
plane and form a closed loop, Fill creates a planar surface:

Meshes
Mesh internal loops and boundary loops can be filled with the Fill tool. The loops are filled with facets that consider
the curvature of the neighboring facets. This produces a very smooth and uniform fill. The newly created facets are
added to the selection set after the fill.

Multiple mesh loops can be filled at once in three cases.
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Separate loops on the Same mesh object that are NOT intended to be joined.

Separate loops on the Same mesh object that ARE intended to be joined

Separate loops on Different mesh objects that ARE intended to be joined

Loops on exterior and interior shells, when filled simultaneously, will create a wall thickness. Fill the interior and
exterior loops separately to continue the shell.

You can also use the Delete key to fill faces on a solid or surface.
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Filling a Region
1. Select the edges that define a surface region, or the faces that define a region within or on a solid.

You can select an object in the Structure tree to simplify it.

You can select faces and the Fill tool will automatically create a patch if you also select at least one edge.

2. Click the Fill tool

or press F.

Filling Sketch or Layout Lines
1. Select a closed or almost closed loop of sketch lines.

2. Click the Fill tool

or press F.

If a gap is 1.5 times the length of the minor grid spacing on the sketch grid or less, the edges are extended to
close the gap. If the gap is larger, a message appears in the status bar and the gap's endpoints flash.

The mode is switched to 3D mode, and the filled loop becomes a surface.

You can select the face of a solid when only the edge is displayed (such as in a drawing sheet view) using the
scroll wheel. The edge becomes a slightly thicker line when the face is highlighted. If you fill lines in a layout, you
can then pull the surface into 3D from the layout, but remain in edit layout mode after this action.

You can fill lines and edges whether or not the sketched lines you want to fill were sketched in the same plane
as the edges. (If the lines are imprinted on a face and become edges, filling those edges deletes them.)

Note: Click the Fill tool in Sketch mode to fill any closed or almost closed loops and switch to 3D mode.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. When this tool guide is active, you can select
edges and faces to be filled. You can click an edge loop or use box-select to select multiple
objects.

The Select Guide Curves tool guide allows you to select a guide curve.

The Complete tool guide generates the filled face.

Options
The following options are available in the Options panel:

• Extend Fill: Fills selected edges by extending the neighboring faces.
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• Patch Fill: Fills the selected edges using the initial tangency of neighboring faces to create a smooth patch.

• Tangent to all sides: Available for Patch Fill. Makes the patch tangent when possible to the neighboring faces.
• Show UV grid: Enabled for Patch Fill. Displays a grid on the Fill preview to help visualize the contours. Use the

dropdown slider to adjust the density of the grid.

• Show deviation: Enabled for Patch Fill. Shows a Deviation analysis of the patch. You can set the color and scale
used to display the analysis.

In theFill tool, using thePatchoption, fill multiple areas at once using Alt-selected tangency influences and preview
the changes. In the example, the two loops are being filled simultaneously and previewed. Notice the preview change
when a different Point is Alt-selected.
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Examples

Simplifying edges

Simplifying edges across multiple faces

Filling with straight and curved edges

Filling with curved edges as guides
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Capping a surface

Capping a surface that crosses multiple edges

Selecting lines to simplify a surface by filling. Internal
edges are removed.

Selecting internal edges to keep them after filling.

Filling edges to form a solid

Patch blend with and without tangent extension. The Tangent extension option is selected on the left, and not
selected on the right.

When selecting Guide Curves in the Fill tool, preview allows continued selection of multiple Guide Curves. This
enables you to understand how the Guide Curves influence the geometry.
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Fill works on multiple-selected, disconnected edge loops in surfaces. Use this as a shortcut instead of filling edge
loops individually.

4.4.3.1. Removing Rounds

Before You Begin
• You will have a greater chance of success if you remove only a few rounds at a time. If you spend a lot of time

removing rounds, you may want to review SpaceClaim's tutorials or technical support information for advanced
techniques you can use when removing rounds.

• Closely inspect your model from various angles and zoom levels, so you can best determine the areas of rounds
you want to remove. Each area of a model is unique, and different areas may require different approaches to round
removal.
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• To ensure accurate and complete round removal, remove the rounds in the reverse order in which they were
created, as shown in the example below of a model with colored rounds:

Filling a Round or Chamfer
1. Click the Select tool guide.

2. Select the round or chamfer.

3. Click the Fill tool

or press F to fill the round and create caps if necessary.

A Round Group is created in the Groups panel each time you fill a round.

You can fill any round created in SpaceClaim, even a round that removes the underlying face, until the round is
changed by some other action.

Removing a Round Face
1. Select the round face.

2. Click the Fill tool

or press F.

If removing a face makes an invalid solid, the solid is converted to a surface.

If a round face is difficult to remove, try Alt+clicking it with the Fill tool, or using the Replace tool.

Capping Multiple Round Faces
When multiple selected round faces are removed by the Fill tool, they are removed in a specific order so that they
can be restored by right-clicking and selecting Reattach Rounds for each group, in reverse order.

Usually you can select all the round faces and click the Fill tool to remove and cap them all. However, sometimes
this is not possible. In that case, select one round and fill it. If that works, undo and select that round and the next.
Undo. Continue adding rounds to your selection and trying to fill them until the fill fails. Now you have identified
one of the rounds that is causing the problem. Next, fill all the rounds that filled successfully. Finally, repeat this
process in the other direction of the round tangent chain. Once you have filled all the rounds except for the one or
two causing the problem, select the one causing the problem and its two neighbors. Then click Fill. This process
allows more options for the extension of neighboring edges to intersect and cap the round.

If you are experiencing difficulty filling a chain of round faces, first split the round faces, then fill the newly created
faces, then fill the remaining round faces.
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Examples

A difficult-to-remove round replaced before removing

Filling a corner round that was created as a surface - surface round in an imported design

About to fill imported geometry bounded by surface rounds
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Filling a rounded edge chain - the original chain to be filled, chain after splitting round faces, and filled chain

If a round cannot be removed, a "stop face" is added and round removal is discontinued (A stop face is a cap or vent
face).

You can fill a chain of round faces when only one end of the round chain has a stop face.

Removing Rounds with Replace Tool
As an option, when removing rounds, you can also use the Replace tool from the Edit group on the Design tab, to
replace one face with another. You can replace multiple faces with a single face, replace a single face with multiple
faces, or replace multiple faces with multiple other faces.
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Full round replaced with a face

Progression using a face to remove a round

Removing Rounds with Sphere Tool
• Try using the Sphere tool from the Insert group on the Design tab. Using this tool, you can create a round sphere

and place it at difficult geometry junctions. Once in place you can use the sphere to split the junction in order to
remove the round. In some cases, you may want to create a chain of two or more spheres to help with removing
larger or more complex rounds areas.

• To avoid trouble with removing spheres, it's good practice to fill the sphere immediately after you remove the
rounds on either side of a sphere or sphere chain.

Using the Sphere tool to split and partially remove a round
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4.4.4. Blending

You can create blends between points, edges, or faces.

Creating a Blend
• Enter the Blend tool
• Select a point, edge, or face
• Ctrl+Select a corresponding point, edge, or face

º You can select more than two objects

• The blend is previewed as you select
• Complete the blend

You can blend both closed and open sections to a single point as shown below.

Options
The following options are available in the Blend tool Options panel when you select the appropriate geometry for
a blend.

• Rotational blend: Create cylinders and cones whenever possible during the creation of a blend. You must have
selected faces, points, or edges that can be rotated around a common axis.

• Periodic blend: Go all the way around when blending. The blend will begin and end at the first selected object.
You must have selected three or more faces, points, or edges that can be rotated around a common axis, and that
also span an arc greater than 180 degrees. (Blending between 3 equal-radius circle faces creates a torus.)

314Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



• Ruled sections: Create straight edges when you blend. When you blend between faces, this option has the same
affect as selecting the face and its edges.

• Local guides: Selected guide curves only influence areas near to them.

• Clocked guides: Guide curves are oriented relative to the face edges instead being simply translated from vertex
to vertex.

Clocked guides CheckedClocked guides Unchecked

• Sheetmetalblend: Forces the tool to create developable surfaces. A developable surface is defined in mathematics
as a surface with zero Gaussian Curvature (that is, a surface that can be flattened into a plane). The tool attempts
to create planes, cylinders, and cones, in that order to maximize the planar areas. It is restricted to blending
between two parallel planes.

Sheet metal blend checkedSheet metal blend unchecked

• Normal to Centerline: When on by default, Normal to Centerline forces the Blend algorithm to keep sections
normal to the centerline. When off, the algorithm has more freedom to adjust sections so that a surface can be
created.
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Normal to centerline offNormal to centerline on

• ShowUV grid: This option is ON by default to help visualize contours by displaying a grid on the preview. Use the
dropdown slider to increase or decrease the density of the grid.

Example

When blending between colored objects, the blended geometry takes on the color of the object that was selected
first.

316Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



4.4.4.1. Blending Between Faces

You can blend between two or more faces with the Blend tool. Blended faces automatically simplify to analytic
geometry when possible.

Once you have created a blend, you can use the Tweak Face tool to edit the blended surfaces or faces.

Blending Between Two Faces

1. Click
Blend in the Design tab Edit group.

The Select tool guide is enabled by default.

2. Select the first surface or face.

3. Ctrl+Select the second surface or face.

A blend preview displays between the first two faces. Blend surfaces begin tangent to the edges of the initial face
and end tangent to the edges of the last face. You can Alt+Click these faces to reverse the tangent direction.

4. (Optional) Alt+click the edges or lines you want to use as guides for the blend. There is also a tool guide for
selecting guide curves. Guide curves must touch all blend profiles.

5. Continue selecting surfaces or faces.
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6. (Optional) Modify the blend by selecting from the following options:

• Rotational blend: Create cylinders and cones whenever possible during the creation of a blend. You must
have selected faces rotated around a common axis.

• Periodic blend: Go all the way around when blending. You must have selected three or more faces rotated
around a common axis, that also span an arc greater than 180 degrees. (Blending between 3 equal-radius circle
faces creates a torus.)

• Ruled segments: Create straight edges when you pull between three or more surfaces or faces.

• Local Guides: Selected guide curves only influence areas near to them.

UncheckedChecked

• Clocked guides: Guide curves are oriented relative to the face edges instead being simply translated from
vertex to vertex.

Clocked guides CheckedClocked guides Unchecked

• Sheet metal blend: Forces the tool to create developable surfaces. A developable surface is defined in
mathematics as a surface with zero Gaussian Curvature (for example, a surface that can be flattened into a
plane). The tool attempts to create planes, cylinders, and cones, in that order to maximize the planar areas. It
is restricted to blending between two parallel planes.
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Sheet metal blend CheckedSheet metal blend unchecked

7. Click
to create the blend.

Blending a Surface Tangent to a Face Along a Given Direction
Select two curved faces and Alt+click a linear object, such as an axis, datum axis, sketch curve, or edge to indicate
the direction for finding two tangent locations.

Where you click when selecting the surface determines the approximate location of the edge of the surface.

The Blend tool previews the edges and the resulting surface.

Blending a Surface Tangent to One Face and Through One Curve/Edge Along a
Direction
Select a face and a curve and Alt+click a linear object to set the direction.
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4.4.4.2. Blending Between Edges

Use the Pull tool in the Design tab Edit group to blend between two or more edges. You can select guide curves for
the edges to follow when creating the blend.

Blending Between Edges

1. Click
Blend in the Design tab Edit group.

The Select tool guide is enabled by default.

2. Select the first curve or edge.

3. Ctrl+Select the second curve or edge.

A blend preview displays between the first two edges.

4. (Optional) Alt+click the edges or curves you want to use as guides for the blend. Guide curves must touch all
blend profiles.

5. Continue selecting curves or edges.

6. (Optional) Modify the blend by selecting from the following options:
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• Rotational blend: Create cylinders and cones whenever possible during the creation of a blend. You must
have selected edges rotated around a common axis.

• Periodic blend: Go all the way around when blending. You must have selected three or more edges rotated
around a common axis, that also span an arc greater than 180 degrees.

• Ruled sections: Create straight edges when you blend between three or more curves or edges.

• Local Guides: Selected guide curves only influence areas near to them.

• Clocked guides: Guide curves are oriented relative to the edges instead being simply translated from vertex
to vertex.

Clocked guides checkedClocked guides unchecked

• Sheet metal blend: Forces the tool to create developable surfaces. A developable surface is defined in
mathematics as a surface with zero Gaussian Curvature (that is, a surface that can be flattened into a plane).
The tool attempts to create planes, cylinders, and cones, in that order to maximize the planar areas. It is
restricted to blending between two parallel planes.

Sheet metal blend checkedSheet metal blend unchecked

7. Click
to create the blend.

When a blend between splines will self-intersect, the splines are modified slightly to prevent this from happening.
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Adding Tangency
Make the blend tangent to adjacent faces by Alt+Selecting them. In the image below right, the blue face was
Alt+selected to make the blend surface tangent to it.

In the Blend tool, the system of Tangency and guide constraints sets up a system of equations that SpaceClaim
solves to produce the Blend result. Certain cases create a system of equations which is Inconsistent, meaning the
equations produce a contradiction and have no solution.

The example below is one example of this.

In some cases, when Blending with a combination of Tangency and Guide constraints, conflicts between the
constraints can occur. In these cases, the conflicted geometry will highlight and an error message will be displayed.
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Swept Blends
A Swept Blend is a blend between two or more edges without local guide influence. The entire blend is swept along
the guide curve, as shown below.

If you check the Local guide option, the guide curve has a local effect on the blend.
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Swept blends are different from sweeps. Swept blends need at least two profiles, while sweeps use a single profile.
Sweeps give you limited control over the orientation and angle of the section along the trajectory, or at the end cap,
because it is always determined by sweeping the profile along the trajectory.

With swept blends, you specify the section shape and orientation explicitly at the ends and at specific points along
the trajectory (guide curve).

When you select more than one guide curve, the additional guide curves give you more control over the final shape
of the blend. Each guide curve affects entities in the profile that are closest to the curve. Vertices between guide
curves are controlled by curves blended between the neighboring guide curves.

Centerline Blends
The Blend tool allows you to select a Centerline Path for the Blend to follow between two planar profiles. The
Centerline does not have to touch either of the profiles, but the extension of the curves must pass through the
profile. Also, although it is called a "centerline," the Path does not need to pass through the center of each profile.
Centerline distinguishes itself from Guide curves, which must touch the profile edges. Multi-segmented curves or
edges can be used as centerline blends provided the meet the following criteria:

• Meet end-to-end without gaps
• Are piece-wise continuous or tangent

Centerline Blends Example
The centerline consists of
three lines and two tangent
arcs.
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Select the oval and circle faces
to preview the default Blend.

Select the Centerline tool

and double-click the
centerline to select the curve
chain. The preview updates to
show the Centerline Blend.
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The centerline can pass
through the profiles.

Note: In these
examples, the
centerline has been
changed to a spline.

You can extend the spline
using the Pull tool to pull it
beyond the profile plane.
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The Blend can be created
using the extended spline.

The spline can be shortened
so it does not touch the profile
planes.

The centerline can be moved
normal to the original plane.
In this example, the spline was
moved to the right, which is
normal to its original sketch
plane.
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4.4.4.3. Blending Between Points

You can create a curve by blending between any combination of sketched Points, vertices, or endpoints. Blend
between any two points to create a line, or select multiple points to create a spline.

Blending Between Points
1. Enter the

Blend tool.

2. Select the first point or vertex.

3. Ctrl+click to select multiple points or vertices.
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A blend preview displays between the first two points.

4. Ctrl+Select more points or vertices.

5. To make the curve tangent:

• Ctrl+click neighboring edges of the vertices if you want the blend curve to begin tangent to one or more edges.

• Alt+click one or more neighboring faces if you want the blend curve to be tangent to the face(s).

6. (Optional) Modify the blend by selecting from the following options:

• Rotationalblend: Create arcs whenever possible during the creation of a blend. You must have selected points
rotated around a common axis.

• Periodic blend: Go all the way around when blending. You must have selected three or more points rotated
around a common axis, that also span an arc greater than 180 degrees.

• Ruled sections: Create straight line segments when you blend between three or more points.

7. Click
to create the blend.

4.4.5. Replacing faces
Use the

Replace tool in the Edit ribbon group on the Design tab to replace one face with another. You can replace multiple
faces with a single face, replace a single face with multiple faces, or replace multiple faces with multiple other faces.

The Replace tool also lets you manually simplify or align complex faces and curves into planes, cones, and cylinders.
(If you want to automate this process, use the Simplify tool in the Adjust group on the Repair tab to automatically
find problem areas.)

Replacing a Face

1. Click the

Replace tool in the Edit ribbon group on the Design tab.

2. Select the face you want to replace (that is, the target).

3. Select the face, surface, or plane you want to use to replace the target face (that is, the source).

You can select sources in the Design window or in the Structure tree.

Do it faster
1. Click the target face and Alt+click the source face, surface, or plane with the Select tool.

2. Click the Replace tool to replace the target face with the source face.
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Replacing Multiple Targets
1. Click the Replace tool.

2. Click the Target tool guide to make it sticky, then click each target face.

You can also use any multiple-face selection method.

3. Select the source face, surface, or plane.

You can select a source in the Design window or in the Structure tree.

Replacing a Target with Multiple Sources
1. Click the Replace tool.

2. Select the target face.

3. Click the Source tool guide to make it sticky, then click each source face, surface, or plane.

You can select sources in the Design window or in the Structure tree and can also use any multiple-face selection
method.

4. Click the Complete tool guide or press Enter to replace the target.

Replacing Multiple Targets with Multiple Sources
1. Click the Replace tool.

2. Click the Target tool guide, then click each target face.

Youcan also use any multiple-face selection method.

3. Click the Source tool guide twice to make it sticky, then click each source face, surface, or plane.

You can select sources in the Design window or in the Structure tree and can also use any multiple-face selection
method.

4. Click the Complete tool guide or press Enter to replace the targets.

Examples
Replacing a target split face with a source surface

Replacing multiple target faces (the protrusion) with a single source face (the surface)
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Replacing multiple target faces (in the depression) with multiple source faces (on the surface)

Aligning or Simplifying Faces

1. Click the Replace tool.

2. Click the Target tool guide, then click each face that you want to align or simplify.

You can also use any multiple-face selection method.

If the selected faces are candidates for alignment or simplification, they are highlighted in red. Faces can be
aligned or simplified by the Replace tool if they are within SpaceClaim 's alignment or simplification tolerance
of ±0.0001m.

3. Click the Complete tool guide or press the Enter key to align or simplify the highlighted faces.

Simplifying Curves
1. Click the Replace tool.

2. Ctrl+click each curve that you want to simplify.

If the selected curves are candidates for alignment or simplification, they are highlighted in red.

3. Click the Complete tool guide or press the Enter key to align or simplify the highlighted curves.

Example

Almost-planar faces highlighted for alignment
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Faces highlighted for simplification

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Select target faces using the sticky Target tool guide.

Select source faces, surfaces, or planes using the sticky Source tool guide.

Click the Complete tool guide to replace the target face with the source face, or to
simplify or align the target face.

4.4.6. Tweaking a Face
You can edit any face or surface with Tweak Face to change its surface geometry. This tool is available in 3D mode
and in drawings.

The degree (or complexity) of a primitive face is automatically increased when you edit it with the Tweak Faces tool.
This makes the editing process smooth and seamless, so curves are smooth when you add them.

Surfaces are checked for self-intersection when you modify the surface using its control points. You will receive an
error message if a change would create a self-intersecting surface.

If you save a selection in the Selection panel and it includes control points, the Face Edit tab will automatically open
when you load that selection.

Tweaking a Face

1. Click
Tweak Face in the Edit group on the Design tab.

The Face Edit tab appears in the ribbon bar.

2. Select an editing method:
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• Control Points to expose the control points for the face or surface so you can move them.

• Control Curves to expose the control curves for the face or surface so you can move them.

• Blend Curves to edit faces or surfaces that can be recreated as a blend.

• Sweep Curves to edit faces or surfaces created with sweep.

3. Select a control point or curve on the face.

Hold Ctrl or draw a box to select multiple points or curves.

4. (Optional) Use the controls in the Select group to expand or contract your selection:

The U direction is indicated by blue lines in the Design window, and the V direction is indicated by red lines.

• Click
or
to expand the selection so it includes all points in the U (blue) or V (red) direction.

• Click
or
to expand the selection so it includes the next point in the U (blue) or V (red) direction.

• Click
or
to reduce the selection by one point in the U (blue) or V (red) direction.

5. Select a tool to edit the face or surface:

• Add Control Curve

• Move

• Scale

• Or any other tool on the Design tab.

6. (Optional) Select Tweak face display options.

7. Click Close Surface Tools to close the tab and end your editing session.

Modifying a Control Curve by Creating a Group
You can modify a control curve by creating a group. The group you create will display a ruler dimension that you
can edit to modify your curve.
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4.4.6.1. Tweak Face Tool Editing Methods
You can think of the editing methods as modes. Different controls are displayed for each method, and these controls
allow you to adjust the face or surface differently.

You can choose from the following methods:

Control points

Use this method when you want to change a face by moving its control points.

Control curves

Use this method when you want to change a face by changing its control curves.

Blend curves

Use this method when you want to change a face by changing its blend curves.

Sweep curves

Use this method when you are editing a face or surface created by sweeping and you want to change a face by
changing its sweep curves. The sweep curves are shown in blue and the surface that was swept is shown in red. You
can use these curves to make new sweep faces, and then manually swap out the new faces for the old, but they can't
be used to change the original swept solid.
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4.4.6.2. Adding a Control Curve
You can add control curves to a face or surface when any editing method is active.

1. Click
Add Control Curve in the Edit group on the Face Edit tab.

The Tweak Face tool must be active for this tab to be visible.

2. Click the point on the face or surface where you want to add the control curve.

You can use temporary geometry to help you find the point where you want to add a control curve.

4.4.6.3. Tweak Face Display Options
These display modes can help you see the contours of a face or surface.

• Grid displays a grid on your face or surface. This is similar to the Grid tool on the Measure tab.

• Curvature displays a gradient on your face or surface. The curvature with the largest radius is shown in the
maximum color. The curvature with the smallest radius, or no radius, is shown in the minimum color. This is similar
to the Curvature tool on the Measure tab.

• Porcupine displays a fringe graph on your face or surface. This display shows you the tangency of your surface at
multiple points.

• ShowOff-Face Control Points displays all control points. If this option is not selected, you won't see control
points that don't affect the surface.

• ShowPeriodic Seams displays the beginning seam of the surface when you are editing periodic faces (cylinders,
cones, and other revolved surfaces). This may help you see of the characteristics or behavior of some periodic
faces as you edit.

Showing a Grid on Your Face or Surface
1. Select Grid in the Show section on the Face Edit tab.

2. (Optional) Change the Color and Scale of the grid.

Showing Curvature on Your Face or Surface
1. Select Curvature in the Show section on the Face Edit tab.

2. (Optional) Change the shading colors under Curvature in the ribbon group.

The maximum color is on the left and the minimum color is on the right.
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Showing a Fringe Graph on Your Face or Surface
1. Select Porcupine in the Show section on the Face Edit tab.

2. (Optional) Adjust the Density to change the number of fringes displayed along the curve.

3. (Optional) Adjust the Scale to change the length of the fringes relative to the amount of curvature.

4.4.7. Editing with Annotation Dimensions
You can use 3D annotation dimensions to change your design using the Pull and Move tools. Annotation dimensions
can be used in combination with ruler dimensions.

Using 3D Annotation Dimensions with the Pull or Move Tool

1. Click
Pull or

Move in the Edit group on the Design tab.

2. Select the objects you want to pull or move. You can select an edge, face, point, or surface.

3. If you are using the Move tool, select a direction on the Move handle.

4. Click the spark icon

next to the dimension you want to use to drive the change. The icon turns yellow when you hover over it with
your mouse, as shown in the image above.

The dimension field can be edited when you click the spark icon.

These icons appear when you use a tool that can be used with annotation dimensions to drive changes. The
annotation dimension must be associated with the face, edge, or point you want to change.

If you are using the Move tool and you don't see the spark icons, you need to select a direction on the Move
handle or you must create a ruler dimension. You get more predictable results if you re-anchor the Move handle
to the appropriate face, edge, or point.

5. Type a new dimension and press Enter.

The objects you selected will change based on the dimension.

If the dimension you change isn't associated with the objects you selected, nothing will change and you will see
an error message in the Status area on the lower right side of the SpaceClaim window.

If the tool can't make the change in the direction that the Pull or Move handle points toward, then it will try to
make the change in the opposite direction to achieve the dimension you enter.
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Examples

Selecting a dimension with the Pull tool active

Selecting a dimension with the Move tool active. You must select a direction on the Move handle before you can
select a dimension.

Changing the value of the dimension field

Using an angular dimension to Pull a face with a revolve axis set
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Using a linear dimension to offset a face with Pull

Using a linear dimension to change the angle of a face with Move

Note: Here the Move tool was re-anchored to the lower, horizontal edge of the face

Pulling with a radial dimension on a face that is offset with another cylindrical face. This also works when you select
both radial faces without an offset relation

4.4.8. Mathematical Expressions
The following expression elements are available:

• Infix (dyadic) operators: + - * / ^

• Prefix (monadic) operators: + -

• Functions: sin, cos, tan, asin, acos, atan, sqrt, log, log10, exp

• Constants: pi, e, root2, root3

• Units: m, cm,mm, yd, ft, ', in, ", deg, rad

Normal precedence rules apply:

1 + 2 * 3 ^ 4 = 1 + (2 * (3 ^ 4)) = 163

Parentheses are required for expression arguments and optional for simple arguments:

• sqrt 2 = sqrt(2) = 1.4142...
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• sqrt 2*2 = (sqrt 2) * 2 = 2.8284...

• sqrt(2*2) = 2

Missing operators are inferred:

• 1 1/2 = 1 + 1/2

• 1'6" = 1' + 6"

• 1ft 6in - 17in = 1ft + 6in - 17in

• 1 2 3 4 5 = 1 + 2 + 3 + 4 + 5 = 15

• (1)(2)(3)(4)(5) = (1) * (2) * (3) * (4) * (5) = 120

• 2(1 + 2) = 2 * (1 + 2) = 6

• sqrt 2 sqrt 2 = sqrt 2 * sqrt 2 = 2

• 4(4atan(1/5) - atan(1/239)) = 4 * (4 * atan(1/5) - atan(1/239)) = pi

Units are applied to previous terms if units were not specified and are applied to subsequent terms unless you
override them:

• 1 + 1cm = 1cm + 1cm

• 1cm + 1 = 1cm + 1cm

• 1cm + 1 + 1mm = 1cm + 1mm + 1mm

• 1cm + 1 1/2 mm = 1cm + 1mm + 1mm / 2

Trigonometry functions work in radians by default, but you can enter degrees:

sin(45 deg)

Numbers support standard form, but e is a built-in constant:

• 2e2 = 200 2e 2 = 2 * e * 2 = 10.873...

• 2e-2 = 0.02 2e - 2 = 2 * e - 2 = 3.436...

• 2e1 = 20 2e = 2 * e

4.5. Intersecting
You can use the intersect tools to merge and split a solid or surface in your design with another solid or surface. You
can merge and split solids or surfaces with other solids or surfaces, split a solid with a face, and split a face with
another face. You can also project the edges of a face onto other solids and surfaces in your design.

SpaceClaim's intersection capabilities include the full suite of geometry combination, all done with one major tool
(Combine) and two minor ones (Split Solid and Split). Combine always takes two or more objects. The split tools
always act on one object and that object is automatically selected from the cutter or projection face.

To understand what the Combine tool can do, the first step is to know which objects can be handled. Solid objects
have faces that meet at corner edges. Edges that lie on faces can be deleted, but corners cannot. Surface objects
have faces that come together at internal edges, and are surrounded by outside edges. Outside edges can be
extended. Internal edges can be deleted if they are bounded by planar faces. For the purposes of combine, planes
can be thought of as surface faces that extend across the design.
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When surfaces enclose a volume, they automatically change into solid objects. When edges of the same surface
become coincident, they will automatically merge. Planes cannot be split by any combine operation, but they can
be used to split with. In general, layer, color, and visibility in the structure tree propagates from the first selected
item (the target) to the result. What happens as a result of the combination can be overridden with the options (both
in the panel and the mini-toolbar). When you use the Combine or Split tools, the newly created objects have the
layer properties of the previous objects.

You have complete control over the pieces that solids and surfaces get cut into. When appropriate, SpaceClaim
prompts you to remove regions, but you can choose to keep or remove those regions.

When using the intersect tools, the original, individual layers and colors of the objects are maintained.

Intersect Ribbon Group
The Intersect ribbon group contains the following tools:

Use the Combine tool to merge and split solids and
surfaces.

Use the Split Solid tool to split a solid by one or more of
its faces or edges. Then select one or more regions for
deletion.

Use the Split tool to create an edge on a face by splitting
it with another face or surface.

Use the Project to Solid tool to create edges on a solid's
face by extending the edges of another solid or surface.

4.5.1. Combine and Split Tools

The Combine tool is used to make combinations of objects. You can add (or merge) objects together and you can
subtract (or split) objects from each other. These actions are also known as Boolean operations.

Tool guides for the Combine tool are sticky, and appear with a double outline when you click them. The tool guide
remains selected so you can perform the same action repeatedly without holding the Ctrl key. To unstick a tool
guide, click it again, click another tool guide, or click an empty place in the Design window.

When you use a pattern with the Combine tool, the entire pattern is merged or used to cut the target.

Splitting Solids and Surfaces
1. Click Design > Intersect > Combine

.

2. Select the target solid or surface that you want to split.

You can select objects for Combine in the structure tree.

You can use temporary geometry to split an object.
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You can use a locked body as a cutter with the Combine tool, but you cannot use it as target. See Locking and
unlocking objects.

3. (Optional) Select the following options:

• Merge when done: Merge all newly-created, touching solids or surfaces when you exit the Combine tool.

• Imprint curves: Create edges at intersections instead of selecting regions.

• Keep cutter: Keep the cutting surface in your design. If this option is not selected, then the cutting surface is
automatically deleted as soon as you select it.

• Make all regions: Cut the target object with the cutter object and the cutter object with the target object. The
target and cutter must be the same type of object.

4. Select one or more object to use as the cutter.

Depending on the option you chose, the cutting surface will be kept or deleted. You can see the solids or surfaces
created by the cut in the Structure panel.

Move your mouse over the target solid to see the regions created by the cut.

5. (Optional) Select the split region(s) that you want to delete.

Merging Solids and Surfaces
1. Click Combine

.

2. Select the target solid or surface.

You can select objects for Combine in the structure tree. You can also box select multiple solids or surfaces to
merge them in one operation.

Solids can be merged with solids, and surfaces with surfaces. Solids and surfaces can only be merged if the
surfaces make a region that can be added to or cut out of the solid.

3. Click the Select Bodies to Merge tool guide or hold the Ctrl key.

4. Select the solid(s) or surface(s) that you want merged with the target.

Do it faster
Hold Ctrl and select the solids or surfaces you want to combine, and then click the Combine tool to merge them.

Making 3D Curves at the Intersection Between Faces
1. Click Combine

.
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2. Select the target solid or surface.

Combine Tool Guides
Tool guides for theCombine tool are sticky, and appear with a double outline when you click them. The tool guides
remain selected so you can perform the same action repeatedly without holding the Ctrl key. To unstick the tool
guide, you can click it again, click another tool guide, or click an empty place in the Design window.

The Select Target tool guide is active by default. If you
did not pre-select the target solid or surface, you can
select it from within the Combine tool using the Select
tool guide.

Click the Select Bodies to Merge tool guide to select
multiple solids or surfaces to merge together.

The Select Cutter tool guide activates once you select a
target. When this tool guide is active, click to select the
solid or surface you want to use to cut the target. You can
Ctrl+click when this tool guide is active if you need to add
other bodies to your cutter selection.

The Select Regions tool guide activates once the target
is cut. When this tool guide is active, mouse over the
target to preview the regions created by the cut. Click a
red region to delete it.

Combine Options
The following options are available for the Combine tool. Select one or more of these options from the Options
docking panel, or right-click and select them from the mini-toolbar:

• Make solids: Solids are made when possible where the target and cutter objects intersect. When you select this
option, you can choose any of the following:

º Mergewhen done: Select this option to merge all newly-created, touching solids or surfaces when you exit the
Combine tool. You can also click white space anywhere in the Design window to complete the merge. Hidden
objects are not merged. This saves you the extra step of selecting all the cut-up regions after you are done with
a complicated slice-and-dice session, and manually merging them all back together.

º Keep cutter: SpaceClaim assumes that you created a cutter object to be used only for cutting. If you want to
keep the cutting surface in your design, select this option. If this option is not selected, then the cutting surface
is automatically deleted as soon as you select it. In other words, cutter objects are normally "used up" unless
you select this option. A kept cutter can be a surface or solid, but either way only the regions of the target can
be removed.

If you are splitting surfaces, check this option to prevent the cutter object from being split by the target object.

This option is automatically selected if the cutter object is locked.

º Make all regions: Select this option to cut the target object with the cutter object and the cutter object with
the target object. Target and cutter must be the same type of object, either both solids or both surfaces. Because
this option can create a large number of regions, it can be helpful to use this option along with theMergeWhen
Done option to quickly merge all remaining regions when you click another tool or press Enter to finish using
Combine.

• Make curves: Select this option to make 3D curves where the target and cutter object intersect. The curves are
created in the active part, rather than the part that the first body belongs to.
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º Imprint curves: Select this option to create edges at intersections instead of creating 3D curves. You will not
be able to preview regions for deletion. As soon as a region is selected for deletion, this option is disabled. The
edges are created on the first body you select.

• Extend intersections: Select this option to extend the intersection of partially intersecting surfaces so the
underlying surface is completely split.

Combine Examples

You can use Combine to cut or merge coincident surfaces. (The delete region step is not shown in the first illustration.)

4.5.1.1. Merging Solids and Surfaces
Use the Combine tool to merge solids and surfaces.

1. Select Design > Intersect > Combine

or press I.

2. Click the first solid or surface.

3. Ctrl+click additional solids or surfaces to merge them.

The Structure tree shows the merge.

Note: Ctrl+click the solids or surfaces you want to combine in the Structure tree, then click the Combine
tool to merge them.

Solids can be merged with solids, and surfaces with surfaces. Solids and surfaces can only be merged if the surfaces
make a region that can be added to or cut out of the solid. For example, if you select the face of a cylinder, copy and
paste it, then you can merge it with the solid used to create it.
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4.5.1.2. Merging Solids
You can merge two or more solids with the Combine tool.

Merging Two Solids

1. Select Intersect > Combine .

2. Click the first solid.

3. Ctrl+click the second solid to merge it with the first solid.

The second solid takes on the color and visibility properties of the first solid. The Structure tree shows the merge.

Merging Multiple Solids

1. Select the solids you want to combine using box selection.

2. Select Intersect > Combine .

The solids take on the color and visibility properties of the merged solid that appeared top-most in the Structure
tree. The Structure tree shows the merge. You can also select the Combine tool, select the first solid, then Ctrl+click
each individual solid you want to merge.

Notes on merging multiple solids:

• When there are two bodies selected, and the second body selected (the tool) has multiple instances, the tool is
made independent before being merged with the target.

• When more than two bodies are selected, all instances that are consumed by the Merge are made independent.
Those that are not merged are left as instances. The merge result is in the first non-instanced body of the selection.

• When all the bodies in an instance of a component are merged, the merged body is made in that component. The
component is Not made independent.

• If all bodies of a component are consumed by the Merge, the empty components are now removed.

4.5.1.3. Merging Surfaces
You can merge surfaces with theCombine tool. Surface must share edges to be merged. If surfaces enclose a volume,
you can use the Combine tool to quickly convert the enclosed volume into a solid and trim the extra.
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Sometimes, if you manipulate a surface so that it becomes self-intersecting, you may need to create a solid from
the surface that remains.

Merging Surfaces That Share Edges

1. Select Intersect > Combine .

2. Click the first surface.

3. Ctrl+click the second surface to merge it with the first surface.

The second surface takes on the color and visibility properties of the first surface. The Structure tree shows the
merge.

Merging Surfaces That Enclose a Volume
1. Select the surfaces that intersect to form an enclosed region using box selection.

2. Select Intersect > Combine .

The enclosed region becomes a solid and takes on the color and visibility properties of the merged surface that
appeared top-most in the Structure tree. The Structure tree shows the merge.

Creating a Solid from a Self-Intersecting Single Surface
1. Click Edit > Select.

2. Select the "open" edge of the set of surfaces, shown in black.

3. Click the Combine tool.

Repairing a Self-Intersecting Surface
1. Click Edit > Select.

2. Double-click the edge loops.

3. Click the Combine tool.

Merging Surfaces Examples
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Six surfaces enclosing a volume, box-selected and combined with the Combine tool

Repairing a self-intersecting surface with the Combine tool

Ctrl+click to select an open edge loop of a surface, then close the surfaces with the Combine tool

4.5.1.4. Merging Surface Protrusions
You can merge a surface that forms a protrusion to a solid.

To merge a surface protrusion:

1. Select Intersect > Combine .

2. Click the first solid.

3. Ctrl+click a surface that could create a protrusion on the solid to merge it with the solid.

The surface becomes a protrusion on the solid and takes on the color and visibility properties of the first solid.
The Structure tree shows the merge.

4.5.1.5. Capping a Surface with a Plane
Ctrl+click a surface and a plane to cap the surface.
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4.5.1.6. Removing Material From a Solid
Use the Combine tool to remove material from a solid based on the intersection of a solid or surface. You can remove
the material defined by a surface that forms a depression, or remove a solid completely enclosed within another
solid.

Removing Material From a Solid with a Surface That Forms a Depression

1. Select Intersect > Combine .

2. Click the solid you want to cut.

3. Click the surface you want to use to create a depression.

4. Mouse over the solid to see the regions created by the cut.

5. Click the region you want to delete.

The regions you can delete are highlighted in red.

Removing an Enclosed Volume From a Solid
1. Create the exterior solid and interior solid in two different components.

2. Select Intersect > Combine .

3. Click the exterior solid.

4. Click the interior solid to use it as the cutter.

5. Click the interior solid to delete it.

The regions you can delete are highlighted in red.

4.5.1.7. Splitting Bodies and Surfaces
Use the Combine tool to split bodies and surfaces.

1. Select Intersect > Combine or press I.
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2. Select the body or surface you want to cut.

The Select Cutter tool guide is activated.

3. (Optional) Control the behavior of the cut by selecting options.

4. Click the surface you want to use to cut the body.

Depending on the option you chose, the cutting surface will be kept or deleted. Review the information in the
Structure panel to see the bodies or surfaces created by the cut.

Mouse over the target body to see the regions created by the cut.

5. Click each region you want to delete.

When you are finished selecting the areas to be deleted, click the Select Target tool guide to combine some more,
or select another tool.

Note: If you want to split a body by a face of the body, select the Split Body tool.

If you want to create an edge on a face, select the Split tool.

Splitting the Target Object with the Cutter Object and the Cutter Object with
the Target Object

1. Select Intersect > Combine .

2. Select the Make all regions option.

3. Click the objects you want to cut.

Target and cutter must be the same type of object, either both bodies or both surfaces.

4. Mouse over the surface to see the regions created by the cut.

Because this option can create a large number of regions, a best practice is to use this option along with the
MergeWhen Done option to quickly merge all remaining regions when you click another tool or press Esc to
finish using Combine.

5. Click the region you want to delete.
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Example of Splitting Bodies and Surfaces

Using two surfaces as the cutter, when the surfaces can't be merged outside of the region where they intersect the
target. The two surfaces are merged to create a cut in the target.

4.5.1.8. Splitting a Surface
Use the Combine tool to split solids. Surfaces can be split by solids, planes, patterns of planes, and other surfaces.

Splitting a Surface by a Solid or Plane

1. Select Intersect > Combine .

2. Click the surface you want to cut.
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3. Click the solid, plane, or patterns of planes you want to cut the surface with.

4. Mouse over the surface to see the regions created by the cut.

5. Click the region you want to delete.

Splitting a Surface by Another Surface

1. Select Intersect > Combine .

2. Click the surface you want to cut.

3. Click the surface you want to cut the surface with.

You can Ctrl+click multiple surfaces that together completely intersect the target surface to fully cut the surface.
You can box-select surfaces that only partially intersect the target surface to partially cut the surface.

4. Mouse over the surface to see the regions created by the cut.

5. Click the region you want to delete.

4.5.1.9. Splitting a Solid with a Surface, Plane, or Another Solid
Use the Combine tool to split solids. Solids can be split by surfaces, planes, patterns of planes, and other solids.

Splitting a Solid with a Solid

1. Select Intersect > Combine .

2. Click the solid you want to cut.

3. Click the solid you want to cut with.

4. Mouse over the solid to see the regions created by the cut.

5. Click the region you want to delete.

The regions you can delete are highlighted in red.
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Splitting a Solid with a Surface or a Plane

1. Select Intersect > Combine .

2. Click the solid you want to cut.

3. Click the surface you want to cut the solid with.

You can Ctrl+click multiple surfaces that together completely intersect a solid.

If available, you can select a pattern of planes from the structure tree to cut the solid.

4. Mouse over the solid to see the regions created by the cut.

5. Click the region you want to delete.

The regions you can delete are highlighted in red.

4.5.2. Split Body Tool
The Split Body tool works in two modes:

• Slowmode is activated by clicking a Split Body tool guide. In this mode, once a tool guide is clicked, it remains
selected until another tool guide is clicked. This mode works just like any other tool.

• Fastmode automatically activates tool guides and moves you through the workflow. This predictive mode allows
you to box-select multiple cutters to add even more efficiency.

You can use the Split Body tool to:

• Split a body by its edges

• Split a body by its faces

• Split a body by a plane

• Split a body by patterns of planes

You can select a body or surface from the Structure tree as the target and a plane or patterns of planes from the
Structure tree as the cutter. When selecting patterns of planes as a cutter, you can also use Shift-Select or box select
to select specific planes within the pattern.

Splitting a Body by One of its Faces
1. Click Design > Intersect > Split Body .

2. Select the body to be split.

3. Select the faces or edges you want to use to cut the body.
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Hold Ctrl and click or draw a box to select multiple faces or edges.

You can create temporary geometry and select it to cut the body.

4. Mouse over the body to see the regions created by the cut.

5. (Optional) Click a region to delete it.

When you are finished deleting regions, select another tool.

If the selected edges do not completely encircle a portion of a body or surface, no region selection can occur.

Note: Select a face with the Select tool, then select the Split Body tool to cut the body with the face.

Splitting a Body Selectively
1. Click Design > Intersect > Split Body .

2. Select the body.

3. Check ON the Local Slicing option.

4. Click the cutter plane to see a blue outline which previews local slicing locations for splitting the body.

5. Click the blue outline preview to cut the body. The Select Regions tool guide is then activated however, holding
the Ctrl key or clicking the Select Cuts tool guide allows you to create additional cuts.

6. Click a region to delete it.

If you need to make multiple cuts on the same target body, manually click the Select Cuts tool guide to make it
sticky before step 5.

A cylindrical surface can also be used for Local Slicing.
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Use the Create Split Surfaces option to create surfaces at the intersection of the target and cutter.

Split Body Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Target tool guide is active by default. When this tool guide is active, click to select the body
to split.

TheSelect Cutter tool guide is active by default. When this tool guide is active, click to select the face you
want to use to cut the body.

TheSelectCuts tool guide activates when theLocalSlicingoption is selected. Possible cuts are highlighted
where the plane intersects the body. Mouse over the cuts to highlight them for selection.

The Select Regions tool guide activates once you once the body is cut by the face. When this tool guide
is active, mouse over the target to see the regions created by the cut. The regions you can delete are
highlighted in red.

Split Body Options
The following options are available in the Split Body tool. Once you select the edge or face to pull, select these
options from the Options docking panel, or right-click and select them from the mini-toolbar:
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Select this option to merge all touching bodies or surfaces
when you exit the Split Body tool. Hidden objects are not
merged.

Merge when done

Extends the selected cutter face to cut through the target
body.

Extend faces

Select this option with the Select Cuts tool guide to
choose specific cuts made by a plane passing through
the entire body, including those with a cylindrical surface.
To Create split surfaces

Local Slicing

Split Body Example

Body split by a spline face

4.5.3. Splitting Faces or Edges
Use Split

to
split faces and edges. To create an edge on a face:

1. Click Design > Intersect > Split
.

The Select Target tool guide is enabled.

2. Select the face you want to split.

3. (Optional) Select a tool guide.

Mouse over faces or edges in your design to preview the edge that will be created on the target. Dimensions are
displayed along the U and V edge of the face.

Tip: You can use the Tab key to cycle through the tool guide options, or with the pointer over the selected face,
cycle through the dimensions.

4. Click to select the face, plane, or edge you want to use to split the selected face. You can select multiple faces
and use box select.

You can hold Shift and hover over an edge while selecting the cutter points. The midpoint on the edge will be
marked with a yellow ball in parentheses. The x and y dimensions will emanate from that point.

5. The Select Results tool guide remains active until there is only one split line remaining, so you can remove all
but one split line without reactivating the tool guide
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Creating an Edge on a Face Example

Dimensioning from the midpoint of an edge to split a face.

Splitting With Curves Outside of the Face
You can Split faces using Curves, whether they are touching the face or not. Connected curves can be used as the
cutter by holding the Shift key. An example is shown below.

Splitting a Face With Another Face, Plane, or Patterns of Planes
1. Click Design > Intersect > Split

.

2. Click the face to be split.

3. Click the Select Cutter Face tool guide.

4. Mouse over the faces and planes in your design to preview the edge that will be created on the target. You can
also select a patterns of planes in the structure tree to split the face. When selecting patterns of planes as a cutter,
you can also use Shift-Select to select specific planes within the pattern.

5. Click the face, plane, or patterns of planes to split the selected face with an edge.

Splitting a Face Using a Point on an Edge or Surface
Surfaces are parameterized using two variables labeled U and V. The location of each point on a surface can be
described with coordinates (u, v). With the Select UV Cutter Point tool guide, you select a UV point on the surface
or one of it's edges.
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1. Click Design > Intersect > Split
.

2. Click the Select UV Cutter Point tool guide.

3. Mouse over a surface or it's edges to preview the split edges that will be created.

4. Click a point on the surface or edge to split the selected face.

Clicking a UV point on a surface splits
it into four pieces.

Clicking a UV point on an edge splits it
into two pieces, along a constant U or
V coordinate.

For a chain of tangent faces, the split
propagates across all tangent faces at
the constant U or V coordinate.

Splitting a Face Using Two Points
1. Click Design > Intersect > Split

.

2. Click the Select Two Cutter Points tool guide.

3. Click a point on an edge.

4. Mouse over the face or edges to preview the edges that will be created.

5. Click a point on another edge or on the face to split the selected face.

Examples
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Previewing edges that can be created using the Select Cutter Point and Select Two Cutter Points tool guides

Splitting a face in section mode by selecting points on a section line

Splitting multiple faces with the Select Two Cutter Points tool guide

Splitting a Face Using a Perpendicular Line From a Point on an Edge
1. Click Design > Intersect > Split

.

2. Click the Select Perpendicular Cutter Point tool guide.

3. Click a point on an edge.

4. Mouse over edges of the face to preview the edges that will be created.

5. The distance and percentage along the edge is displayed. You can Press the Space bar and Tab key to change
these values.

Splitting a Periodic Face
1. Click Design > Intersect > Split

.

2. Click the Select Target tool guide.
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3. Select the periodic face you want to split.

4. Click the point of the face where you want it split, as shown below.

5. The Select Results tool guide is now active, so you can click edges that you don't want to keep, as shown on the
left of the image below. The result after the two straight edges have been removed is shown on the right.

Splitting an Edge, Curve or Beam
1. Click Design > Intersect > Split

.

2. Click the Split Edge tool guide.

3. Select the edge, curve, or beam you want to split.

4. The edge highlights and the split is previewed with dimensions (length and percent) and a count. The count is
the number of pieces the edge will be split into. The default count is two.

5. Click the point where you want to split, as shown below (left image) or select a plane (right image).
6. The Select Results tool guide is now active, so you can click edges that you don't want to keep, as shown on the

left of the image below. The result after the two straight edges have been removed is shown on the right.

Split Face Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Target tool guide is active by default. If you did not pre-select the target face or surface, you
can select it from within the Split tool using the Select tool guide. Ctrl+click multiple surfaces or solid
faces in the same plane to split them all.
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Use the Split Edge tool guide to split edges, curves, or beams.

The Select Cutter Face tool guide activates once you select a target. When this tool guide is active, click
to select the face or surface you want to use to create an edge on the target.

The Select UV Cutter Point tool guide activates once you select a target. Mouse over an edge to preview
the new edges that will be created. Click to create the edge on the selected face. You can mouse over an
edge with this tool guide to display and edit the length along the edge, and the percentage of the edge
that is between the first point and the end point.

The Select Perpendicular Cutter Point tool guide activates once you select a target. Select an edge to
preview where the perpendicular split will be made. Click to create the edge on the selected face. The
face is split perpendicular to the edge you select.

The Select Two Cutter Points tool guide activates once you select a target. Click to select the first point
on an edge, then mouse over another edge to preview the new edge that will be created. Click to create
the edge on the selected face. The shortest line is drawn between the two points. You can mouse over an
edge with this tool guide to display and edit the length along the edge, and the percentage of the edge
that is between the first point and the end point.

Select the Select Results tool guide, then click newly created edges to remove any edges you don't want
to keep.

Split Face Options
The following option is available in the Split tool:

Select this option to create sketch lines instead of
splitting the face.

Make Curves

4.5.4. Project Tool
Use the

Project tool to create edges on a solid's face by extending the edges of another solid, surface, sketch, or note text.

When you project onto a face, the tool makes a new surface to hold the projected edges, if possible.

Projecting the Edges of a Face, Surface, Sketch, or Note Text to a Solid
1. Click Design > Intersect > Project

.

2. Select the edges, face, surface, sketch, or note text whose edges you want to project.

Select an object in the Structure tree to project all the edges of the object.

The projection occurs perpendicular to the selected object onto the nearest solid faces. The nearest solid faces
are determined automatically.
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3. (Optional) Click theSelectDirection tool guide and select a face or edge to change the direction of the projection.

4. (Optional) Click theSelect Target Faces tool guide and select the face(s) on which you want the edge projected.

5. Select from the following options in the Options panel:

• Project through solids: Project the edges on all faces through the entire solid instead of just the faces closest
to the object you project.

• Project silhouette edge: Projects the outline, or silhouette, of a part. You must set the direction using the
Select Direction tool guide.

• Extend projected edges: Extend the projected curves to the edge of the face(s) they are projected on.

• Extend target faces: Extend the target face when the projected face is larger than the target. See the example
below.

The projection preview is shown in purple, and will be updated based on the options and tool guides you use.

6. Click the Complete tool guide or press Enter to project the edges.

Projecting Points
Sketched 3D Points can also be projected onto surfaces using the Project tool. The projected points are created as
Datum Points so that they can be pinned.

In the example below, points were sketched to trace out the shape of a mouse button and then projected down
onto the top surface of the mouse. The workflow is the same as projecting Faces, Surfaces, Curves, Edges, or Note
Text.

Project Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Curves tool guide allows you to select the
curves you want to project.

The Select Direction tool guide allows you to select the
direction in which the curves will be projected. If you
don't use this tool guide, the curves will be projected in
both directions.

The Select Target Faces tool guide allows you to select
the face(s) that the curves will be projected upon.

The Complete tool guide projects the edges.
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Project Tool Options
The following options are available in the Options panel:

Project the edges on all faces through the entire solid
instead of just the faces closest to the object you project.

Project through solids

Projects the outline, or silhouette, of a part. You must set
the direction using the Select Direction tool guide.

Project silhouette edge

Extend the projected curves to the edge of the face(s)
they are projected on.

Extend projected edges

Extend the target face when the projected face is larger
than the target. See the example below.

Extend target faces

Projecting Examples

Projecting a sphere onto a planar face. Because a sphere has no edge to project, you must chooseProject silhouette
edge in the Options panel.

Projecting an edge with the Extend target faces option enabled. The rectangular face was chosen with the Select
Target Faces tool guide.

4.6. DatumObjects and Relationships
This section contains the following topics:

4.6.1. Inserting a plane
You can define a plane by selecting various faces, edges, axes, or lines in your design. You can select any combination
of coplanar axes, curves, edges, and coordinate axes.

The plane will extend a small amount beyond the edges of the face to make it easier to work with. The plane will
maintain this margin around all the objects in your design, extending and trimming itself as you add, remove, or
move solids within your design.
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Planes are useful for creating layouts and annotations. Planes are not linked to the geometry used to create them.
They must be explicitly selected to move along with other items. You can also use a plane to quickly clip your design
to show only the geometry behind the plane.

Datum planes adjust their extent based on zoom level and objects within the plane, including curves. The Include
Curves property, set to true by default, is especially useful for beam-centric models with many curves.

Inserting a Plane
1. Click

Plane in the Create group on the Design tab.

2. Select one of the following:

To insert a plane:Select a:

That contains the facePlanar face

Through the point and parallel to the facePlanar face and point

Through the edge and perpendicular to the face (useful
when creating a sweep path)

Planar face and edge

At the midpoint between the two facesTwo parallel planar faces

Tangent to the face at the selection pointAxial or cylindrical face

Tangent to both faces as close as possible to the
selection points

Two axial faces with parallel axes

That contains the edgesPlanar edges

That contains the axisAxis

That contains the axesTwo axes

That contains the axesTwo origin axes

Three orthogonal planesAn origin

That contains the axis (or line) and the pointAxis (or line) and one point

Through the end point and normal to the line at the
end point

End point of any line

Through the selected point and perpendicular to the
plane that contains the spline

Control point of a spline

That contains those three pointsThree points

Through the line and normal to the planeLine sketched on a plane

Through the line and the pointLine and point on the line

That contains those two linesTwo planar lines

Through the two pointsTwo points

Through the two points and perpendicular to selected
plane or planar face

Two points and a Plane or planar face

3. (Optional) Click the Build Plane tool guide to select reference objects, then select a temporary (dotted) plane
to create the one that you want from the possible planes. See Inserting temporary points, axes, and planes for
detailed information about creating temporary planes.
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4. An error message is displayed in the status bar if your selection does not define a plane.

Inserting a Plane Tangent to a Cylinder and Parallel to a Plane
Select a plane, Ctrl+click a cylinder, then click the Plane tool.

Inserting a Plane Tangent to a Cylinder and Perpendicular to a Plane
Select a cylinder, Ctrl+click a plane, then click the Plane tool.

Inserting a Plane Through the Mid-point Between Two Points
1. Select the Plane tool.

2. In 3D mode or Section mode, Alt+Shift+click two points to create a temporary plane that includes the midpoint.

3. Click the temporary plane.

Inserting a Plane Parallel to the Screen
1. Select the Plane tool.

2. Activate the Align to Screen tool guide

3. Hover over geometry to preview the plane through the selected geometry and parallel to the screen.

4. Select the geometry to create the plane.

Clipping Your Design with a Plane
Right-click a plane and select Clip with Plane. To restore the view of your design, right-click the plane and select
Clip with Plane again.

Planes, axes, and annotations are not clipped.
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Examples

An edge and the axis of a coordinate object selected to create a plane.

Changing the Appearance of a Plane
You can use the Fill, Outline, and Clipface options to change the appearance of a plane.

• Fill: Set to Automatic by default. Automatic causes geometry behind the plane to look lighter than geometry
outside the plane boundaries. If you change to No Fill, all geometry will have the same opacity.

• Outline: Set to Automatic by default. Automatic you see the outline of the plane. If you change to No Outline, the
plane is invisible unless selected.

• Setting planes to No Fill and No Outline is useful when dimensioning parts. It is easier to see annotations when
planes are less visible.

• Clipface: Sets the Clipface color override for each clipping plane in the design window. It does not change the
color of the plane itself, just the color of the face the plane is touching.

4.6.2. Inserting an Axis
You can extend any axis in your design to make it available for revolves or rotations. The axis will extend a small
amount beyond the edge of the space containing your design. It will maintain this margin extending and trimming
it as you add, remove, or move objects in your design. Axes are not linked to the geometry used to create them
(unless they are an extension of existing axes); they must be explicitly selected to move along with other items.

Inserting an Axis
1. Click

Axis in the Create group on the Design tab.

2. Select one of the following:

To insert an axis:Select:

That contains the face's axisAxial face

At the intersection of the theoretical planes containing
the two faces

Two, non-parallel planar faces

That contains the edgeLinear edge

At the intersection of the cylinder and planeCylinder and tangent plane

That contains the lineLine

Along the origin's axisOrigin axis

That contains the center point and is normal to the lineCircle or arc
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To insert an axis:Select:

Through the point and normal (perpendicular) to the
plane

Point and a plane

Through both pointsTwo points

At the point where a cylinder's axis would be positioned
between the three axes

Three axes

3. (Optional) Click the Build Line tool guide to select reference objects, then select a temporary (dotted) line to
create the one that you want from the possible axes. See Inserting temporary points, axes, and planes for detailed
information about creating temporary lines.

Inserting an Axis Through the Mid-point Between Two Points

1. Click
in the Edit group on the Design tab.

2. Hold Alt+Shift and select two points to create two temporary axes that cross at the midpoint.

3. Click the temporary axis.

4. Click
Axis in the Insert group on the Design tab.

Examples

Creating an axis by selecting the axes of three cylinders

4.6.3. Inserting Points
You can create 3D points anywhere on the 3D geometry.

1. Click
Point in the Create group on the Design tab.

2. Select a point, vertex, or location on a face, surface, curve, or edge.

World Origin coordinates are shown for selected Datum Points in the Status Bar.

365Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Points can be Patterned in the Move tool and Linear and Circular Pattern tools.

Points can be dragged and dropped in the Structure Tree.

Move to New Component and Move Each to New Component work for selected Points.

4.6.4. Inserting an Origin
You can insert an origin at any location in your design where you can anchor the Move tool. You can anchor a ruler
to an origin, and snap to origins while in Sketch mode. This allows you to dimension from an origin and quickly move
the sketch grid to an origin. You can also insert an origin at a solid's center of mass or volume.

Inserting an Origin
1. Click Origin

in the Create group on the Design tab.
2. An origin is previewed attached to the cursor.
3. Move the cursor to position the origin. The origin will adjust its orientation based on the type geometry it is on.
4. Click to place the origin.

Inserting an Origin Based on Selected Faces
1. Select one, two, or three faces.
2. Click Origin

in the Create group on the Design tab.
3. The origin is created based on the following:

a. If one planar face is selected, the origin is created at the center of the face.
b. If two intersecting faces are selected, the origin is created with XY in the first plane, Y aligned in the intersection

of the two planes.
c. If three intersecting faces are selected, the origin is created with XY in the first plane, Y aligned in the second,

and Z placed at the intersection of the third plane with Y.

Inserting an Origin Using the Move Tool
1. Click Move

in
the Edit group on the Design tab.

2. Position the Move handle where you want the origin to appear.

3. Select the Origin tool

in the Insert ribbon group to insert an origin.
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The origin appears in the Design window and in the Structure tree.

Inserting an Origin at the Mid-point Between Two Points
1. Select the Move tool.

2. Alt+Shift+click two points to create a temporary point at the mid-point.

3. Click the temporary point to place the Move handle there.

4. Select the Origin tool

in the Insert ribbon group.

The origin appears at the midpoint.

Inserting an Origin at the Center of Mass or Volume
1. Click Mass tool

from the Analysis group on the Measure tab.

2. Select the solid at whose center you want to place the origin.

Axes appear at the center of mass or volume.

3. Select the Origin tool

in the Insert ribbon group..

The origin appears at the center of mass or volume.

Placing the Sketch Grid on an Origin
1. Select the vertex of an origin.
2. Enter sketch mode.

The sketch grid is now located on the x and y axis of the selected origin.

Defining the Origin for a Newly Created Component
1. Insert an origin.
2. Alt+click the origin.
3. Right-click a solid and select Move to New Component from the context menu.

You can also create a new component and then drag and drop the solid into that component while the origin is
Alt-selected.

4. Right-click the component in the Structure tree and select Open Component.

The component opens in a new design window.

5. Display the world origin.

The world origin in the new design window is positioned at the same location as the alt-selected origin.
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Example

Alt+selecting an origin when creating a new component. The image on the left shows the World Origin and an origin
created on the solid. The image on the right is the component opened in a new design window with the world origin
in the location it was placed on the object.

4.6.5. Pinned Datums
Datums can be Pinned to the location at which they were created using RMB > Pinned.

Pinned Datums will move if their creation references are moved.

If a Datum is created and subsequently moved from its original (created) position (with respect to its creation
references) RMB > Pinned will be grayed out.

The following apply to all pinned datums:

• Pinned datum icons in the tree are highlighted to distinguish them from normal

• Ctrl+drag to copy in the Move tool works for all pinned datums. The original datum remains pinned but the new
copy is unpinnable.

• Datum Planes and Axes are now automatically unpinned when they can no longer be constructed from the reference
objects. For example, when a reference face is changed from a plane to a cylinder.

• The Datum Plane, Line, and Point tools are sticky (they stay on until you enter another tool) like normal tools.

• If any of a Pinned Datum's references are deleted, the system forces the datum to be unpinned. The datum will
not be placed with respect to the remaining references. This applies to Planes, Lines, and Points.

• Datum Planes, Lines, and Points that are constructed exclusively from other pinned datums become pinned by
default. For example, a datum axis will be pinned by default if it is constructed from a point pinned to a face.

• The Move handle is disabled when all selected objects are pinned datums (axes, planes). Since they are pinned,
these objects cannot be Moved. If unpinned datums, or other objects, are included in the selection, the Move
handle is enabled, but the pinned datums will not Move. To allow copying, the Move handle becomes enabled
when the Ctrl key is pressed.

The following apply to pinned datums in components:

• You can Cut/Copy/Paste by parent component.
• You can set the Visibility by parent component.
• Note that when pinned datums are moved to a new component, they become unpinned and subsequently

unpinnable
• Datums can only be pinned if All of the references are in the same component. Allowing references from multiple

components can result in unintentional Assembly-like constraints.
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Pinned Planes
• In the graphics area, Pinned Datums are also given a green color and they have their corners rounded. The image

here shows the plane selected to emphasize the color.
• The pinned datum Reference is also highlighted when the plane is selected.
• If any of the pin references are deleted, the plane is automatically unpinned.
• You can NOT pin datum planes created from temporary references (using ALT+SHIFT.)
• Only Datum Planes that are NOT moved from their original position can be pinned. Planes moved away, and then

back to their creation references, CANNOT be pinned.
• Planes created using the Build Plane tool guide cannot be pinned. The references used in creating these planes

are temporary and are not remembered outside of the tool.

Pinned Axes
• Un-pin a Datum Line if any of the references are deleted.
• Pinned axes are given a green color to distinguish them from normal axes.
• Pinned Axes attached to pinned datum points on faces will adjust when the faces are edited with Tweak Face,

Pull>Offset, Move, Bend, etc.
• Axes created using the Build Line tool guide cannot be pinned. The references used in creating these planes are

temporary and are not remembered outside of the tool.

Pinned Points
• Currently pin to an existing point/vertex, or to the midpoint between two other points.
• Face and Edge point connections have been added.
• You can now box-select Points
• Pinned Datum Points now store their latest location to ensure proper placement if the pin reference becomes

invalid by deletion or geometry change.
• 3D Datum Points can now be moved with the Move tool if they are not pinned.
• When you Bend a face that has pinned datum points, the points follow the face at a well-chosen location.

4.6.6. Inserting Temporary Points, Axes, and Planes
You can create temporary points, axes, and planes while working with other tools. Temporary objects can be used
to dimension to and create other objects. For example, you can use them to create a ruler dimension, or anchor the
Move handle on them.

To clear a temporary object, select the object and press Delete. A temporary object also disappears when you click
in an empty space with the Selection tool or create another temporary object.

3D example:2D example:Alt+Shift+click:

For solids: A plane that is normal to
the view direction (or parallel to the
plane of the screen)

For curves: A tangent line and a
perpendicular plane.

A point
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3D example:2D example:Alt+Shift+click:

2D and 3D: A midpoint between two points and a bisecting lineTwo points

A plane(not applicable in 2D)Three points

A line midway between two edges and
planes that intersect the edges and
the line (3D)

A line midway between two lines (2D)Two parallel lines or edges

A plane midway between two planes(not applicable in 2D)Two parallel planes

An axis between the two points at the
closest approach between each other,
and a point and a midplane at the
middle distance along that axis (3D)

Two bisector lines and the
intersection point (2D)

Two non-parallel lines, edges, or axes
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3D example:2D example:Alt+Shift+click:

Two bisecting planes and the edge
where the planes intersect

(not applicable in 2D)Two non-parallel planes

The point where the three planes
intersect

(not applicable in 2D)Three planes

2D and 3D: A circle that completes the arcAn arc

The point where the conical face
would come to a point

(not applicable in 2D)A conical face and its axis
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3D example:2D example:Alt+Shift+click:

2D and 3D: The major and minor fociEllipse

2D and 3D: Axis from the point normal to the edge and a second axis parallel
to the edge through the point

A line or edge and a point that is not
in line with the line or edge

The point at the intersection of the
axis and the plane of the face

(not applicable in 2D)An axis and an intersecting face or
surface

The points where the face would
intersect the curve, and the axes that
pass through the points, are tangent
to the curve, and are on the same
plane as the curve. One point and axis
are created if the face would only
intersect the curve at one point.

(not applicable in 2D)A curve and an intersecting face or
surface

Plane that is tangent to the face and
a point that is normal to the axis from
the face to the point

(not applicable in 2D)A point and a face or surface
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3D example:2D example:Alt+Shift+click:

2D and 3D: A plane through the line or edge, or a plane that is normal to the
plane that goes through the point. If a line is chosen at a particular point,
then that location on the line can also be used as a point reference.

A point and a line or edge

(2D and 3D produce the same result,
shown on the right)

2D and 3D: Planes that are perpendicular to the face and go through the line
or edge.

A line or edge and a planar face

(not applicable in 2D)

4.6.7. Linear Patterns

You can create patterns of:

• Protrusions or depressions (including slots)
• Points, planes, origins, or axes
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• Sketch curves
• Notes
• Lightweight text
• Components

Patterns can be made from a mix of object types, such as a pattern of holes (faces) and bolts (imported components).
You cannot create a pattern of threads. You can use the Undo button,Ctrl+Zor Redo button,Ctrl+Ywhen creating
a pattern.

Creating a One- or Two-dimensional Linear Pattern
1. Click the

Linear tool in the Create group on the Design tab.

2. Select a protrusion, depression, body, sketch, points, axes, planes, origins, or 3D curves to be the first member
(leader) of the pattern. The Direction tool guide activates.

3. Select a line, edge, axis, or a set of points to set the direction of the pattern.

4. (Optional) Modify the Pattern options in the Options panel.

Pattern Type: One-dimensional or Two-dimensional.

Change X Count, or X Pitch values for One-dimensional

Change X, Y Count, or X, Y Pitch values for Two-dimensional

As you switch between pattern types, or change pattern values, the pattern preview displays your changes in
blue.

5. Select the Define Pattern tool guide.
6. Select the Create Pattern tool guide, or press Enter, to complete the pattern.

When the pattern is previewed, any members which cannot be created are shown in red. Members that can be
created are shown in blue.

The image below shows the preview for a two-dimensional pattern. For one-dimensional, only the X-direction is
displayed. Clicking the arrows flips their direction 180-degrees.

For through-all cuts, the preview is on the plane closest to the direction reference. For blind cuts, the preview is on
the face of the selected pattern leader.
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You can also create one-dimensional linear patterns on cylindrical faces as long as the pattern direction is either
the cylinders axis or parallel to the axis.

In SpaceClaim, any pattern member can be used to modify the pattern after you create it. If the change cannot be
made to all pattern members, the member that cannot change is still part of the pattern.

When you select a member of a pattern, you will see fields for the pattern count and distances relative to the member
you have selected. Press Tab to move among the dimension and count fields.

• Icons next to the pattern's dimensions and counts show which will be changed if you change the value of the
highlighted field. The closed lock indicates that a dimension won't change and the open lock shows you it will
change. You can override a lock on a dimension by clicking its icon to toggle it between locked and unlocked.

• Dimension or count line placement, arrows, and value fields show you how the pattern will change if you change
the value of a field.

• Your selection determines how changes to the distance and count affect the pattern's position. If you select one
member of the pattern, the change is centered on that member. If you select all pattern members, the change is
centered on the entire pattern, with the distance between members locked by default. You can control which
direction the pattern will grow based on which member you select and which count or distance you change.

• Changing a pattern count in one direction does not change the distance between pattern members. Instead, the
overall distance of the pattern will change. This is indicated by the closed lock icon.

Note: Patterns of sketch entities and 3D curves are no longer patterns when they change into another form,
such as a surface or solid. For example, if you pattern a C-shaped curve, then it will remain a pattern when
you switch from sketch mode to 3D mode. But if you close off the curve to make a box before you switch to
3D mode, then the boxes will become surfaces and will no longer be a pattern.

Creating a Pattern of a Pattern
Follow the steps for the linear pattern, but select a member of a linear pattern as the first member of the pattern.

Editing Linear Pattern Properties
1. Select one pattern member to display the pattern count and dimensions.

2. Edit the pattern's properties.

Press Tab to switch between the fields.

Click the lock icon to lock or unlock a value.

3. Press Enter.

The result of editing the count and spacing is relative to the member of the pattern you select.
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Note: To quickly increase or decrease the number of pattern members, press Tab until the count field is
highlighted, then hold the Alt key while you press the up or down arrow.

Moving a Pattern
1. Click the

Move tool.

2. Select a pattern member to move a linear pattern or the pattern axis to move a circular or arc pattern.

3. Move the pattern member with the Move handle.

If you move an interior member of a pattern and it is not anchored, all the pattern members move:

If you move a member at one end of a pattern, the member at the opposite end is anchored and the pattern is
skewed:

If you anchor a different member than the member opposite the direction you are moving, Move skews the
pattern.

If you have a linear pattern in a radial direction and you move an interior member without setting an anchor,
then the entire pattern shifts in the selected direction

Use the Up To tool to move a pattern member up to another face or edge. Pattern dimensions (such as Count
and Length) display as expected.

Adjusting Pattern Distance or Spacing

1. Click
Select or

Move in the Edit group on the Design tab.

2. Select a pattern member.

This member will serve as the anchor, and other pattern members will move relative to this member.

3. Press Tab until the field you want to change is highlighted:
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• Distance: This field is the overall distance of the pattern. The pattern member you select is anchored, and the
length will change relative to this member. The arrows indicate the direction of change. You can see this field
at the top of the image below.

• Spacing: This field is the spacing between pattern members. This field has arrows in both directions and is
located between two pattern members. The field is highlighted in blue in the image below.

• Radialpatterns: If you select a member of a radial pattern, you can change the angle between pattern members
and the distance from the pattern members to the center of the pattern.

4. Type a new distance or angle and press Enter.

The spacing between all pattern members will change.

Removing a Pattern Member from the Pattern
Right-click the face of the pattern member and selectUnpatternMember. Doing this makes the member independent,
so changes to the feature won't propagate to the pattern.

Creating a Pattern Group
1. Select a pattern or pattern member in the Design window.

2. Click the Groups tab in the Structure panel.

3. Click Create NS.

A group is created that displays the number of members in the pattern. You can click this group to select the
pattern and change its parameters in the Design window.

Assembling Components on a Pattern
You can assemble a component with a pattern member, then propagate the component to all of the pattern members.
The component will be copied and assembled to each pattern member.

1. Assemble a component to some geometry that is a pattern member using the Align, Tangent, or Orient tools.

2. Right-click the Assembly Condition in the Structure Tree and select Update Components on Pattern.

The components will be propagated to the pattern.

Examples
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Rectangular pattern

Changing spacing between pattern members changes the pattern's overall length when the length field isn't locked.

A pattern of sketch objects is no longer a pattern when you switch to 3D mode and the sketched objects are converted
to surfaces.

Sketch curve patterns can propagate in two dimensions. The pattern above contains three squares in the X direction
and two squares in the Y direction.
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4.6.8. Circular Patterns

You can create patterns of:

• Protrusions or depressions (including slots)
• Points, planes, origins, or axes
• Sketch curves
• Notes
• Lightweight text
• Components

Patterns can be made from a mix of object types, such as a pattern of holes (faces) and bolts (imported components).
You cannot create a pattern of threads. You can use the Undo button,Ctrl+Zor Redo button,Ctrl+Ywhen creating
a pattern.

Creating a One- or Two-dimensional Circular Pattern
1. Click the

Circular tool in the Create group on the Design tab.

2. Select a protrusion, depression, body, sketch, points, axes, planes, origins, or 3D curves to be the first member
(leader) of the pattern. The Direction tool guide activates.

3. Select a line, edge, axis, sheet metal marker, or a set of points to set the direction of the pattern.

4. (Optional) Modify the Pattern options in the Options panel.

Pattern Type: One-dimensional or Two-dimensional.

Change Circular Count, or Angle values for One-dimensional.

Change Circular Count, Angle, Linear Count, or Linear Pitch values for Two-dimensional.

Note that a Circular Count of one, in a two dimensional pattern, will create a single radial pattern.

As you switch between pattern types, or change pattern values, the pattern preview displays your changes in
blue.

5. Select the Define Pattern tool guide.

6. Select the Create Pattern tool guide, or press Enter, to complete the pattern.

When the pattern is previewed, any members which cannot be created are shown in red. Members that can be
created are shown in blue.

The image below shows the preview for a two-dimensional pattern. For one-dimensional, only the Angular
direction is displayed. Clicking the arrows flips their direction 180-degrees.
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You can create circular patterns on cylindrical faces, both around the face and along the axis.

In SpaceClaim, any pattern member can be used to modify the pattern after you create it. If the change cannot be
made to all pattern members, the member that cannot change is still part of the pattern.

When you select a member of a pattern, you will see fields for the pattern count and distances relative to the member
you have selected. Press Tab to move among the dimension and count fields.

• Icons next to the pattern's dimensions and counts show which will be changed if you change the value of the
highlighted field. The closed lock indicates that a dimension won't change and the open lock shows you it will
change. You can override a lock on a dimension by clicking its icon to toggle it between locked and unlocked.

• Dimension or count line placement, arrows, and value fields show you how the pattern will change if you change
the value of a field.

• Your selection determines how changes to the distance and count affect the pattern's position. If you select one
member of the pattern, the change is centered on that member. If you select all pattern members, the change is
centered on the entire pattern, with the distance between members locked by default. You can control which
direction the pattern will grow based on which member you select and which count or distance you change.

• Changing a pattern count in one direction does not change the distance between pattern members. Instead, the
overall distance of the pattern will change. This is indicated by the closed lock icon.

• Circular patterns are anchored at the opposite end by default when you move one end.

• In patterns of patterns, associations of children of the first pattern are maintained. An example is shown below.
The height of all the bosses is changed by changing one. You can do this by using theMove tool to pull up, adjusting
the height.

• Patterned curves can now be moved. Previously, you could move one of the members and the rest would not
follow. The example on the right shows the previous behavior. The line on the left was used to create a six member
pattern. When the line is later moved, the other members do not follow.
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• Pattern dimension display now remains when you enter the Move tool. Previously, the pattern dimensions
disappeared and only the faces were displayed. This led to confusion about what was selected for the Move. The
images below show the new, correct behavior.

Note: Patterns of sketch entities and 3D curves are no longer patterns when they change into another form,
such as a surface or solid. For example, if you pattern a C-shaped curve, then it will remain a pattern when
you switch from sketch mode to 3D mode. But if you close off the curve to make a box before you switch to
3D mode, then the boxes will become surfaces and will no longer be a pattern.

Creating a Radial Circular Pattern
1. Select all radial pattern members.
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2. Click the

Circular pattern tool.

3. Set the Pattern type to One-dimensional.

4. Enter the Circular count and Angle.

5. Click the circular axis.

To create a single radial pattern, set the Pattern type to Two-dimensional and enter a Circular Count of 1.

Editing Circular Pattern Properties
1. Select one pattern member to display the pattern count and dimensions.

2. Edit the pattern's properties.

Press Tab to switch between the fields.

Click the lock icon to lock or unlock a value.

3. Press Enter.

The result of editing the count and spacing is relative to the member of the pattern you select.

Note: To quickly increase or decrease the number of pattern members, press Tab until the count field is
highlighted, then hold the Alt key while you press the up or down arrow.

Moving a Pattern
1. Click the

Move tool.
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2. Select a pattern member to move a linear pattern or the pattern axis to move a circular or arc pattern.

3. Move the pattern member with the Move handle.

If you have a linear pattern in a radial direction and you move an interior member without setting an anchor,
then the entire pattern shifts in the selected direction

Use the Up To tool to move a pattern member up to another face or edge. Pattern dimensions (such as Count and
Length) display as expected.

Moving a Radial Pattern in a Linear Direction
1. Click the

Move tool.

2. Right-click a pattern member and click Select > All Pattern Members.

3. Select the Direction tool guide.

4. Click an object to set the direction of the move.

5. Drag the pattern.

Adjusting Pattern Distance or Spacing

1. Click
Select or

Move in the Edit group on the Design tab.

2. Select a pattern member.

This member will serve as the anchor, and other pattern members will move relative to this member.

3. Press Tab until the field you want to change is highlighted:

• Distance: This field is the overall distance of the pattern. The pattern member you select is anchored, and the
length will change relative to this member. The arrows indicate the direction of change. You can see this field
at the top of the image below.

• Spacing: This field is the spacing between pattern members. This field has arrows in both directions and is
located between two pattern members. The field is highlighted in blue in the image below.

• Radialpatterns: If you select a member of a radial pattern, you can change the angle between pattern members
and the distance from the pattern members to the center of the pattern.

4. Type a new distance or angle and press Enter.

The spacing between all pattern members will change.

Removing a Pattern Member from the Pattern
Right-click the face of the pattern member and selectUnpatternMember. Doing this makes the member independent,
so changes to the feature won't propagate to the pattern.
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Creating a Pattern Group
1. Select a pattern or pattern member in the Design window.

2. Click the Groups tab in the Structure panel.

3. Click Create NS.

A group is created that displays the number of members in the pattern. You can click this group to select the
pattern and change its parameters in the Design window.

Assembling Components on a Pattern
You can assemble a component with a pattern member, then propagate the component to all of the pattern members.
The component will be copied and assembled to each pattern member.

1. Assemble a component to some geometry that is a pattern member using the Align, Tangent, or Orient tools.

2. Right-click the Assembly Condition in the Structure Tree and select Update Components on Pattern.

The components will be propagated to the pattern, as shown below.

4.6.9. Fill Patterns

You can create Fill patterns of:

• Protrusions (including sheet metal forms)
• Depressions (including slots and standard holes)
• Faces (Closed curves on a face)

Components can be assembled to a Fill pattern. For example, a bolt component assembled into a pattern of holes.

Threads cannot be patterned.

You can use the Undo button, Ctrl+Z or Redo button, Ctrl+Y when creating a pattern.
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Creating a Fill Pattern
1. Click the

Fill tool in the Create group on the Design tab.

2. Select a protrusion or depression to be the first member (leader) of the pattern. TheDirection tool guide activates.

3. Select a line, edge, axis, or a set of points to set the direction of the pattern.

4. Modify the options in the Options panel

Pattern Type: Grid, Offset, or Skewed

Modify the X Spacing or Y Spacing for Grid or Offset patterns.

Modify Row X Offset, Row Y Offset, Column X Offset, and Column Y Offset for Skewed patterns.

Modify the Margin values. A dashed orange boundary line displays the pattern's marginal boundary.

As you switch between pattern types, or change pattern values, the pattern preview displays your changes in
blue.

5. Select the Create Pattern tool guide, or press Enter, to complete the pattern.

When the pattern is previewed, any members which cannot be created are shown in red. Members that can be
created are shown in blue.

In SpaceClaim, any pattern member can be used to modify the pattern after you create it. If the change cannot be
made to all pattern members, the member that cannot change is still part of the pattern.

Grid Patterns
Grid uses the X and Y Offset values to produce a simple grid pattern.

Offset Patterns
Offset uses the X and Y Offset values to produce a grid but also offsets alternate rows.

385Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Skewed Patterns
Skewed allows you to get a tighter nesting of pattern members using individual X and Y offsets for rows and columns.

The meaning of the offsets is shown graphically below.
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Editing Fill Pattern Properties
With a fill pattern node selected in the Structure tree, you can:

• Change fill pattern parameters in the Layout section of the Properties panel. Changes that you make automatically
update the pattern in the design window.

• For hole patterns in Sheet Metal, right-click and select Lightweight Pattern to toggle a pattern between a lightweight
pattern and regular pattern. When selected, a check mark displays next to the Lightweight Pattern command.
This speeds up the display of hole patterns in Sheet Metal which can contain hundreds or thousands of members.

• To update lightweight fill patterns to fit the existing geometry of your design, select the lightweight pattern node,
then right-click and select Update Pattern.

Moving a Pattern
1. Click the

Move tool.

2. Select a pattern member to move a linear pattern or the pattern axis to move a circular or arc pattern.

3. Move the pattern member with the Move handle.

If you move an interior member of a pattern and it is not anchored, all the pattern members move:

If you move a member at one end of a pattern, the member at the opposite end is anchored and the pattern is
skewed:

If you anchor a different member than the member opposite the direction you are moving, Move skews the
pattern.

If you have a linear pattern in a radial direction and you move an interior member without setting an anchor,
then the entire pattern shifts in the selected direction

Use the Up To tool to move a pattern member up to another face or edge. Pattern dimensions (such as Count
and Length) display as expected.

Removing a Pattern Member from the Pattern
Right-click the face of the pattern member and selectUnpatternMember. Doing this makes the member independent,
so changes to the feature won't propagate to the pattern.

Creating a Pattern Group
1. Select a pattern or pattern member in the Design window.
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2. Click the Groups tab in the Structure panel.

3. Click Create NS.

A group is created that displays the number of members in the pattern. You can click this group to select the
pattern and change its parameters in the Design window.

Assembling Components on a Pattern
You can assemble a component with a pattern member, then propagate the component to all of the pattern members.
The component will be copied and assembled to each pattern member.

1. Assemble a component to some geometry that is a pattern member using the Align, Tangent, or Orient tools.

2. Right-click the Assembly Condition in the Structure Tree and select Update Components on Pattern.

4.6.10. Shelling a Solid
Use the

Shell tool in the Insert ribbon group on the Design tab to remove one of the faces of a solid and create a shell of a
specified thickness. You can then use the Shell tool to remove other sides of the shell. SpaceClaim automatically
creates an offset relationship between the sides of the solid for you.

You can also create a closed shell without removing a face.

Shelled solids can have chamfers and rounds, and the faces can be drafted. The chamfer or rounded edge will be
created and maintained on both offset faces. A shelled solid with a chamfer is shown in cross-section below.

Creating a Shell
1. Click the

Shell tool in the Create ribbon group on the Design tab.

Mouse over the solids in your design to highlight the faces that could be removed.

2. (Optional) Enter a value into the dimension field to change the thickness of the shell.

Enter a negative number to create the shell thickness from the outside of the solid.

3. Select the face you want to remove.

The face is removed and a shell is created. The baseline of the offset is shown in blue. If you did not change the
thickness, the default thickness is set by the minor grid spacing.

4. (Optional) Continue clicking to remove additional faces.
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Creating a Closed Shell
1. Select the solid.

2. Click the Shell tool.

An internal shell is created.

Editing a Shell
Right-click the shell to change its thickness.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Remove Faces tool guide is active by default. Select a face of the solid to remove it and create a shell.
Ctrl+click to remove multiple faces.

If you create a shell, then add a protrusion onto it, you can extend the shell through the protrusion by clicking
the More Shell tool guide, then clicking the newly added protrusion.

The Complete tool guide creates the shell and reactivates the Remove Faces tool guide so you can create
another shell.

Examples

An open shell and a closed shell

Adding and changing a rounded edge on a shelled or offset part changes the inside faces.

4.6.11. Creating an Offset Relationship
Use the Offset tool to create an offset relationship between two faces. This relationship will be maintained in the
other 2D and 3D editing tools. For example, when you select an offset face with the Pull tool, the offset dimension
is displayed. Baseline faces do not display a dimension.
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Creating an Offset Relationship
1. Click the Offset tool

in the Create ribbon group.

Mouse over your design to see the faces eligible for offset relationships.

2. (Optional) Select options.

Select the Find All Same Offset option if you want to select all contiguous face pairs that have the same offset
distance as the pair you selected. If this option is not selected, the offset relationship is only created for the
selected pair of faces.

3. Click the first face.

4. Click the second face.

You have now established an offset relationship between the face pair and other contiguous face pairs with the
same offset distance (if the All the Same option is selected). The Toggle Baseline tool guide activates.

5. (Optional) Click to select the baseline face(s).

When you move one of the faces with a design tool, the other face in the offset pair moves to maintain the offset
relationship. When you fill one face of an offset pair, the other face is also filled.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Face Pair tool guide is active by default.

When the Toggle Baseline tool guide is active, click the faces that you want to be the baseline of
the offset.

Example

An offset relationship between two cylindrical faces causes both to change when you change the diameter of either
cylinder

4.6.12. Creating Mirror Relationships
Use the

Mirror tool in the Insert ribbon group on the Design tab to mirror any geometry that can be moved with the Move
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tool. You can insert a mirror plane between two faces, associating the faces so you can edit them together. You can
copy a solid, surface, face, or curve from one side of a mirror plane to the other.

You can mirror curves, points, and axes without leaving sketch mode or cross section mode. When you mirror a
curve, changing its geometry does not propagate to the other side.

You can mirror solids that contain patterns of features on a face, and the pattern will be updated on both sides. The
pattern must be created before the solid is mirrored.

The plane becomes a persistent mirror once you create geometry using the mirror. The mirror relationship is
maintained when you use other 2D and 3D tools to edit your design.

Mirrored components have a mirrored icon in the Structure Tree and maintain their mirror relationships when they
are exported.

Mirrored objects are created on the same layer as the original object. Mirrored points do not maintain their mirror
relationship.

Mirroring an Object
1. (Optional) Create the plane you want to use as a mirror using the Insert Plane tool and position it with the Move

tool.

2. Click Mirror

in the Create group.

The Select Mirror Plane tool guide is enabled.

3. Click the plane to use as a mirror.

4. Click the Mirror Body or Mirror Face tool guide.

5. Mouse over the solids or faces in your design to preview the solid, surface, or face that will be created on the
other side of the selected mirror plane.

6. Click the object you want to mirror.

7. The mirror plane is created and will persist in other tools.

You can click objects in your design or click a component in the Structure tree.

If you enclose a volume by mirroring faces, a solid is created.

Removing a Mirror Face or Plane
1. Click Mirror

in the Create group.

The Select Mirror Plane tool guide is enabled.

2. Click the Remove

Mirror
tool guide.

3. Click the face from which you want to remove the mirror relationship. You can also Box-select any number of
faces.
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You can temporarily disable a plane in any tool. Select a mirrored face to display the mirror plane, then click the
mirror icon to disable the mirror. Click the mirror icon again to enable the mirror.

Options
• Mergemirrored objects: When you use a face as the mirror plane, or when the mirror plane lies on a face of the

source object, the two mirrored objects will be merged. Deselect this option to make a new object, as shown
below.

• Createmirror relationships: If you deselect this option, only the geometry is created and not the mirror
relationship. Changes to either object will not be reflected in the other, as shown below.

You can create a mirror plane between two symmetrical faces in your design.

Setting Up a Mirror Relationship
1. Click the Mirror tool in the Create ribbon group.

2. Click the Setup Mirror tool guide.

As you mouse over the faces in your design, the eligible faces are highlighted. A face is eligible if it is symmetrical
to another face in your design.

3. Click a face.

4. Click a parallel face.

The second face is highlighted in blue and the mirror plane appears halfway between the two faces. Edits to one
face will now be mirrored on the other face. Geometry in between the two faces will be updated accordingly.

You can create mirror relationships by finding similar faces on the other side of an existing mirror.

Finding Similar Faces on the Other Side of a Mirror
1. Click the Setup

Mirror
tool guide.

2. Click a face.
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Ctrl+click to select multiple faces.

3. Alt+click a mirror plane.

Identical faces equidistant from the mirror plane are highlighted in blue, and a mirror relationship is created.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Mirror Plane tool guide is active by default. Select a face or plane to use it as a mirror. (You can also
use this tool guide to select another mirror plane to use if one is already selected.

The Mirror Body tool guide activates automatically once you select a mirror face or plane. Mouse over
the solids in your design to preview the solid that will be created by the mirror. Click a solid to mirror it.

Once you select a face or plane to use as a mirror, use the Mirror Face tool guide to select the faces you
want to mirror. Mousing over the faces before you click them previews the face that will be created by the
mirror. Click a face to mirror it.

The Mirror Component creates a left-hand transform and does not create a mirror relationship between
the two components or subassemblies.

The SetupMirror tool guide can be used any time to create a mirror plane between two faces. Only those
two faces will be affected by the mirror. To create a relationship among many faces, Ctrl+select faces and
then select a mirror plane to auto-detect identical faces equidistant from the mirror plane.

Use theRemoveMirror tool to remove the mirror relationship between faces. You can select to faces with
a mirror relationship, or use box-selection to select any number of mirrored pairs.

Examples

A mirrored solid with a pattern of features is updated when the count is changed from 7 to 5 on one side.

Mirroring a sketched circle. Modifying the circle does not change the geometry of the mirrored circle.

393Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



Mirror associations are maintained in the Pull tool using the Copy Edge and Extrude Edge options. The behavior
for Copy Edge is on the left and Extrude Edge is on the right.

A mirrored surface body that becomes a closed body after the mirror now becomes a closed body. Start with a solid
body, detach a face to make two surface bodies, and create a plane at the opening.

Mirror the surface body to see a solid body with the detached surface in the mirror plane.
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4.7. Bodies
This section contains the following topics:

4.7.1. Geometry from Equations
You can select from a number of preset 3D equations or write custom equations in the tool.

The image below shows a Helicoid surface.

The equation is constructed in the Options panel. The image below shows the equation for the Helicoid shown
above.

You can enter an equation in the input fields for X, Y, and Z is for 3D equations.
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Clicking the icon to the right of the X, Y, or Z input fields opens an editor for more complex equations.

Use the ShowUV grid option to display a grid on the surface and adjust the grid density using the dropdown slider.
The grid helps visualize the surface contours.

Use Design > Equation tool

to create 2D curves based on mathematical equations.

Creating a Preset Equation
1. Click the Design > Equation

tool.
2. (Optional) Click the Select Origin in tool guide

and select an equation origin
3. Choose an equation from the Curve Types dropdown list in the Options panel
4. Edit the equation as needed in the Options panel
5. Click Complete to create the equation surface

Creating a Custom Equation
1. Click the Design > Equation

tool.
2. (Optional) Click the Select Origin tool guide

and select an equation origin
3. Choose Custom in the Curve Types dropdown list in the Options panel
4. Enter the equation in the input panels
5. To create a parameter to use in the equation enter it in square brackets "[ ]"

• For example: [L]
• The parameter is added to the Parameters list in the Options panel

6. Click Complete to create the equation surface

Saving a Custom Equation
The Save Custom Equation button next to the Curve Types dropdown menu allows you to save your custom
equations. They are saved to an XML file in the following location:

%APPDATA%\Roaming\SpaceClaim\SurfaceEquationCustoms.xml

Saved equations are added to the Curve Types dropdown menu and can be used in other documents and across
multiple sessions. If you do not see a newly saved equation in the list, open/create a new document or close and
re-open the current document.
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Editing an Equation
1. Click the Design > Equation

tool.
2. The Select Body tool guide

is active
3. Select the body to edit its equation
4. (Optional) Click the Select Origin tool guide

and select a different origin
5. Edit the equation as needed in the Options panel
6. Click Complete to create the equation surface

Scaling an Equation Surface
Use the Scale parameter and slider in the Options panel to scale an equation surface.

3D scaling with the Pull tool also works on equation surfaces.

Syntax and Predefined Functions
• Parameters include a name and are enclosed in square brackets [L]
• Functions include a function name followed by parenthesis containing any values as arguments

º For example: Sine([t]-[r])

• The table below shows common predefined functions included

DescriptionName

Returns the absolute value of a specified numberAbs

Returns the angle whose cosine is the specified numberAcos

Returns the angle whose sine is the specified numberAsin

Returns the angle whose tangent is the specified numberAtan

Returns the cosine of the specified angleCos

Returns the sine of the specified angleSin

Returns the square root of the specified numberSqrt

Returns the tangent of the specified angleTan

Preset Curve Examples
The preset equations include those shown in the following table.
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One Sheet Hyperboloid

(Two sheets consists of separate
top and bottom Hyperboloid
surfaces, and can be made with
two equations with inverted
ranges)

Catenoid

ParaboloidHelicoid

Radial WaveHyperbolic
Paraboloid

4.7.2. Creating a Cylinder
Use the Cylinder tool to sketch the cylinder's axis in 2D and create its diameter in 3D.

The sketch grid must be visible in the workspace before you can draw.

If you select a 3D curve or edge before you click the Cylinder tool, the cylinder is created as a swept pipe.
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Drawing a Cylinder
1. Click Design > Body > Cylinder >

.

2. (Optional) If you want to dimension the first end point of the axis, press Shift and hover the mouse over a line
or point to create a dimension relative to that line or point.

3. Click or press Enter to set the first end point of the axis.

4. (Optional) Dimension the axis.

5. Click or press Enter to set the other end point of the axis.

By default, the axis is dimensioned to its first end point. You can also press Shift and hover the mouse over
another line or point to create a dimension relative to that line or point.

6. (Optional) Dimension the cylinder's diameter.

7. (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar.

8. Click or press Enter to set the diameter of the cylinder.

Creating a Swept Pipe
1. Select a 3D curve or edge.

If the curves or edges include angles, a spherical surface is added at the angle. If you use the Fill tool on the
spherical joints, the corners are converted to sharp corners. See the examples below.

2. Click Design > Body > Cylinder >
.

3. Click in the Design window to set the diameter of the cylinder.

Options
The following options are available in the Cylinder tool.

Add material to create a solid cylinder.
Add

Remove material when the cylinder intersects another object.Cut
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Creates a cylinder without merging into other objects even when the cylinder intersects
with an existing object.

No
Merge

Add material only on the near side when the cylinder intersects another object.Near-side body only

Examples

Tube with Nubs

Using the Near-side body only option to add cylinder material only on the near side of a thin placement wall
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Creating a swept pipe with the Cylinder tool

Creating a swept pipe with the Cylinder tool, then using Fill on the spherical joint to create a sharp corner

4.7.3. Creating a Sphere
You can quickly create a sphere using the Sphere tool.

1. Select the Design > Body > Sphere
.

2. (Optional) Click NoMerge in the Properties panel if you don't want the sphere merged with existing bodies.

3. (Optional) Click Cut in the Properties panel to remove material from existing bodies where they overlap the
sphere.

4. Click to set the center of the sphere and the plane in which the sphere's radius is dimensioned.

As you move the mouse, you can see a preview of the sphere. Sphere creation works best when you move the
cursor in the x-y direction of the plane indicated by the first click.

5. Click to set the radius of the sphere.

Creating a Sphere Over a Face or Edge
1. Select one or more faces or edges.

2. Select the Design > Body > Sphere
.

A sphere is created that minimally covers the selected faces and/or edges.

Options
The following options are available in the Sphere tool.

Add material to create a solid sphere.
Add

Remove material when the sphere intersects another object.
Cut
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Creates a sphere without merging into other objects even when the sphere intersects
with an existing object.NoMerge

Add material only on the near side when the sphere intersects another object.Near-side body only

Examples

Using the Near-side body only option to add sphere material only on the near side of a thin placement wall

Creating a sphere over a face or edge

Selecting faces and clicking the Sphere tool to create a sphere, then clicking the Sphere tool multiple times to enlarge
the selected sphere

4.8. Dimensions
You can dimension every element in your design, from lines in sketches to faces of solids. In SpaceClaim, dimensions
are not constraints. Rather, they are tools for precise control during the creation or modification of a design. In
SpaceClaim, if you do want to save a dimension with your design, use the Ruler Dimension option when pulling or
moving. You can save the ruler dimensions as Groups for later edits.

Whenever a dimension field appears, you can press the spacebar or click it to enter a value, and press Tab to switch
between fields.
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You can use mathematical expressions in a dimension.

Dimensioning a Sketch Line During Creation

1. Press the spacebar (or just type) to enter a value in the highlighted field.

2. Press Tab to switch between dimension fields.

3. Repeat step 2 until you have entered all the dimensions.

4. Press Enter to accept the values and return to sketching.

The dimensions persist until you select another tool or begin drawing another sketch object.

Dimensioning the Start, End, or Middle point of a Sketch Line from Another
Point in Your Sketch

1. Hover the mouse over the point from which you want to dimension.

2. Press Shift.

As you move your mouse around the sketch grid, a dimension will appear from the point you indicated to the
mouse location.

3. Press the spacebar (or just type) to enter a value in the highlighted field.

4. Press Tab to switch between dimension fields.

5. Repeat step 4 until you have entered all the dimensions.

6. Press Enter to accept the values and place the point that begins or ends your line.
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Dimensioning Existing Sketch Lines

1. Click the Select tool.

2. Select the sketch object you want to change.

3. Dimension the item's size or location by doing one of the following:

• Press the spacebar (or just type) to enter a value in the highlighted field.

• Drag the selected item to change its size or location.

• Hover over a point in your design and press Shift to dimension between the selected object and that point.

• Press Shift while dragging to dimension from the current mouse location.

Dimensioning While Moving or Pulling

1. Select a direction for the move or pull.

2. Press the spacebar (or just type) to enter a value in the highlighted field.

3. Press Tab to switch between dimension fields.

4. Repeat step 3 until you have entered all the dimensions.

5. Press Enter to accept the values and move or pull the selected object the distance you entered.

Creating a Ruler Dimension
1. Click Design > Edit > Pull

or press P.

2. Select the faces or edges whose location you wish to specify.

3. Select a direction for the dimension.

4. Select Options > Create Ruler Dimension or right-click and select it from the mini-toolbar.

The start point of the dimension is set as the location of the Pull arrow or Move handle.

5. Click an object to set the end point of the dimension.
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Use the scroll wheel if multiple objects appear at the same point in the Design window.

6. Enter a value.

7. Press Enter to accept the value and complete the move or pull.

Press Esc to hide the ruler dimension.

You can make more than one change per ruler dimension.

Creating an Angular Ruler Dimension

1. Select the Move tool and switch to Section mode.

2. Select the section line (that represents a face) that you want to rotate.

3. (Optional) Anchor theMovehandle to the object around which you want to rotate by dragging the center sphere
or using the Anchor tool guide.

4. Select the rotational axis of the Move handle.

5. Select Create Ruler Dimension from the Options panel or right-click and select it from the mini-toolbar.

An angular dimension indicator appears from the red linear axis of the Move handle.

6. Select the end reference for the angular dimension.

7. Enter a value for the dimension.

4.9. Detach
You can detach individual pieces of a sketch, or detach objects or faces in 3D. You can detach protrusions to move
them with the Move tool's Detach First option.

Detaching in 2D
Alt+drag with the Select tool to detach the selected item when sketching. Use the 2DMove tool to detach items
and move them.

Detaching in 3D
1. Click the Edit > Select tool.

2. If you want to detach an object, Ctrl+click all its faces to select them.

3. Right-click the object and select Detach from the context menu.

Detaching a Cylinder
1. Click the Edit > Select tool.
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2. If you want to detach a cylinder, Ctrl+click the cylinder surfaces to select them.

3. Right-click the object and select Detach from the context menu.

4.10. Checking Geometry
You can check the geometry for solids and surfaces. The geometry is checked for all possible ACIS errors. Select
errors and warnings in the Check Geometry dialog to highlight the associated geometry in the Design window.

To check an object's geometry:

1. Right-click a solid or surface in the Structure tree.

2. Select Check Geometry.

You can click Stop in the status bar or press Esc to cancel the operation if necessary.

A dialog will open that lists any errors or warnings found.

3. Select errors and warnings in the dialog to highlight the associated geometry in the Design window.

a. Select Zoom to fit selection to automatically zoom in to the problem area in the Design window.

b. Select Hide Others to focus on a particular problem and hide other geometry.

c. Select Create NS to create a Named Selection for the problem geometry.

d. Select Delete Face to delete problem faces.

4. Click Close when you are finished.

4.11. Recording
The recording modes available in SpaceClaim are as follows:

Use the Block Recording tool to capture all the changes you make to your model in blocks of
script. Each block represents a block-of-script that can be used to recreate that part of the model
design.

Use theScriptRecording tool to create and run scripts to perform repetitive tasks and work with
models and geometry.
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4.11.1. Recording Blocks
The Block Recording feature enables you to use SpaceClaim to record and play back operations.

You can import models with existing parameters. You can also create 2D sketches of lines, arcs, and splines and
convert them into 3D models.BlockRecording captures all the changes you make to your model in blocks of script.
As you perform operations, they are recorded in script blocks. Each block represents a block-of-script that can be
used to recreate that part of the model design.

Hovering over a block shows a preview of the operation.

An example of a block for the Extrude Face operation is shown:

• View and edit the options for the operation by clicking the Options drop-down.
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• Click
to create a variable for the selection. You can also expand the drop-down and select Create Variable to set a
variable.

• Click
to create a parameter. You can also expand the drop-down and selectCreateVariableorAddParameter to create
a variable or add an existing parameter.

Note: Block recording tracks model history and should not be used with Group parameters, which are
intended to be used with direct modeling. Either block recording parameters or group parameters will be
published to Workbench if connecting SpaceClaim to other applications.

Each parameter has a unique label and is added to the Parameters list.
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You can use the parameters to define other variables using basic mathematic expressions.

Note: When working with expressions, you must be careful with units.

• Create output parameters by clicking the Output Parameters

drop-down.

For example, you can create a parameter for the bodies, edges, or faces created by clicking the

icon next to the appropriate selection.

You can also choose from the Convert, Filter, and Properties methods available. For example, you can convert
selections to types (such as faces or edges), or convert by shape, size, etc. You can choose to filter faces, edges,
parts, bodies, or components or select based on properties such as plane, normal, smart variables, area, perimeter,
etc. Click the

icon next to the appropriate selection.
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• Click Edit Script

to view and edit the block snippet in the Script Editor.

You can insert a code snippet or a selection snippet, step through or debug the script, and cancel or accept your
script changes.

Refer to Scripting on page 412 for detailed descriptions of the Script Editor functions.

Edit block properties for changing dimensions, options, etc. Individual parameters can be changed in each script
block and applied to the overall design of the model. Once you rerun Block Recording, the model is updated with
the new parameters, options, etc.

When you edit a block, the blocks that require updates will be indicated by

.

The direct modeling operations can be replayed, similar to recording and replaying a script in SpaceClaim.

• Click Next Feature

to move to the next feature block.

• Click Continue

to move to the end feature block.

You can also work with the script blocks to:

• Reorder blocks - Select a block and drag it to a different position to reorder the blocks.

• Move to the state defined by a specific block - Right-click a block and select Move to from the menu.

• Force Regenerate the selected block - Right-click a block and select Force Regenerate from the menu.

• Delete the selected block - Right-click a block and select Delete from the menu.
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• Suppress the selected feature state - Right-click a block and select Suppress from the menu.

• Insert blocks - Right-click a block and select Insert Custom Block from the menu.

• Group blocks to combine operations - Select the blocks to be grouped, right-click and selectGroup from the menu.

• Hide non-model changing blocks - Right-click a block and select Hide Non-Model Changing Blocks to hide
non-model changing blocks, for example changing the visibility of objects. This option is enabled by default.

• Collapse all blocks - Right-click a block and select Collapse All from the menu.

Block Recording for Meshing
Block recording is available for Meshing workflows.

Note: Block recording cannot be enabled midstream in the meshing process. Hence, if you have a model
that already has geometry and mesh, the block recording button will be greyed out.

Block recording can drive persistent and parametric design changes in SpaceClaim and/or be used to create input
parameters for Workbench where tools like DesignXplorer can drive the design studies from the Workbench schematic.

• Block recording has some limitations when using models with shared topology. Even though the block recording
may work the first time around, the topology IDs could change when the block recording is replayed. For example,
when replaying block recording, the interface between shared bodies can reference either of the 2 face IDs at a
shared interface which could lead to problems with persistence if the face ID changes when updating the block
recording.

• Block recording has some limitations when setting up design studies where the topology IDs need to persist from
one design point to the next design point. See Transferring a Mesh to Downstream Systems in Ansys Workbench
on page 1082 for details about the approach to be used in these cases.

• Mesh quality metrics are not supported with block recording.
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4.11.2. Scripting

Note: Refer to the Class Library for a detailed description of the API. A copy of the Class Library compiled
help file (.chm) is included in the installation. The path will be similar to the paths shown below and will
change according to the version you are using and where SpaceClaim is installed.

For SpaceClaim: C:\Program Files\SpaceClaim <version
number>\SpaceClaim.Api.<version number>

For SCDM: C:\Program Files\ANSYS Inc\<version
number>\scdm\SpaceClaim.Api.<version number>

You can work with SpaceClaim programmatically using Python. A built-in script editor allows you to create and run
scripts to perform repetitive tasks and work with models and geometry.

Use File > New > Script to begin a new script.

Use File > Open to open an existing script file (*.scscript, *.py).

When you exit SpaceClaim with an open script, you are asked if you want to save the existing script.

Script Editor
The Script Editor has the following functions.

• Open Script - Loads a script from a file
• Save Script - Saves the current script to a file
• Save Script As - Saves the current script by specifying a destination
• Insert Selection - Pastes the current selection as script in the script window. The selection can be identified by:

º Index - The internal index of each selected entity
º Ray - The internal ray fire point and direction
º Smart Variable - Combines the other methods to make selections persist better when replaying scripts

Smart Variable selection is needed to make selections more stable for replaying changes. A Smart Variable
selection stores more information than any of the other types and is much more robust in matching the
selected entity during geometry changes.

The image below shows how each selection is scripted for the same selected face. Notice that the Smart
Variable selection uses a variable called "Face1".

Smart Variables have a dropdown GUI, on mouse-over, for investigating references beyond the in-graphics
highlighting.
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• Record - Code for scriptable actions performed in SpaceClaim is written in the script window. Choose theNormal
or Verbose mode.

• Insert Code Snippet - Presents the Snippet dropdown at the cursor in the script window
• Find/Replace - Opens a Find and Replace dialog
• Run Next Line - Executes the next line of the script

TheStepOver,Step In, andStepOutoptions in the drop-down forRunNext Lineonly apply to functions defined
in the script, not native SpaceClaim function calls.

º Step Over - The debugger executes the function call and then pauses after the function returns.
º Step In - The debugger executes the function call statement and then pauses execution at the first line of the

function called.
º Step Out - Only applies if execution is first stopped inside a function (by a breakpoint inside function or when
Step In is activated). The debugger executes the rest of the function without pausing, and then returns to the
line after the function call and pauses.

Note: Step Over and Step In will work even if breakpoints are not defined.

• Run Script - Executes the entire script from the top. Select Debug or Run mode from the drop-down.

º Debug - Debug mode enables you to use the Step Over, Step In, or Step Out features to debug your script as
you work through it.

º Run - Run mode ignores breakpoints and is quicker since it runs on the same thread.

Note: Debug runs on a background thread so there is a performance cost. Using Run is faster, since it
runs on a single thread, but breakpoints will not work when you run your code.

• Breakpoints - You can left or middle click the grey column to the left of the line numbers to create a breakpoint,
which is displayed by a big red circle.
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When you click the Run Next Line or Run Script button in Debug mode, script execution stops the first time it
reaches the breakpoint line. Clicking either button again after this forces it to run the breakpoint line. The Run
Script will continue to the next breakpoint line.

The editor supports the following shortcuts:

• Ctrl+K = Comment
• Ctrl+Shift+K = Uncomment
• Ctrl+ Insert = Insert Code Snippet
• Ctrl + F / Ctrl + H = Find/Replace
• F10 = Run Next Line
• F5 = Run Script
• For Debug:

º F10 = Step Over
º F11 = Step In
º Shift + F11 = Step Out

Script is written in the main Script window but can also be entered as single commands in the command line.

Results of running a script, including error and warnings, are written to the Output window.

Intellisense
Intellisense, or intelligent code completion, is included in the editor to assist with entering commands. It is a
context-aware code completion feature that improves the process of coding applications by reducing typos and
other common mistakes. The code completion and related tools serve as documentation and disambiguation for
variable names, functions, and methods using reflection.

• When you type in the Script Editor, you can see suggestions for commands, helper functions, variables (created
or with Smart Variable Selection).

• Auto complete features add parentheses when writing functions in the Script Editor. For-loops can be created
automatically.

• You can also search for existing APIs from the Script Editor and select it to automatically add the code to import
it into the script.

º The example shows the import of the CustomProperty API. Start by typing in the Script Editor and click the All
tab to see all suggestions.

º Select CustomProperty from the list. The API is then imported into the script as shown.

414Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing



• Use Cast and CastCheck with expressions or variables.

º Cast enables you add a type to an expression. For example, you can declare a variable and set its type in the
Scripting Tool.

Note that when you cast a variable inside of a method, it is only cast to that type inside the method.

º CastCheck enables you to check the type of expression by surrounding it with an if-statement. Once a variable
is cast, you can choose to add a CastCheck, which adds an if-statement to the code. This if-statement allows
you to confirm the variable's type before performing additional calculations or modifications.
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Selection Converting and Filtering
To improve selection in scripting, created selections can be converted or filtered based on size, geometry, or other
requirements.

For each of the selections, you can choose from the Filter and Convert methods available. For example, you can
choose to filter faces, edges, parts, bodies, or components. You can convert selections to types (such as faces or
edges), or convert by shape, size, etc.

For example, you can get the root part of the assembly, convert that selection to edges, and then filter by size:

Power Selection and Smart Variables
Power Selection is recorded and, when using Smart Variables, can be used to perform similar operations on multiple
bodies.

For example, you can record the power-selection of holes with a certain diameter, and then the filling of those holes
with the Fill tool. That script can then be used to fill holes of the same size in other models, even if the number of
holes is different.

The example below shows six holes power-selected, filled and recorded.
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The script is then run on a different model and 12 holes with the same diameter are filled.

Re-importing Models
Scripting supports recording and playback for imported models with persistent ID maps. This allows the following:

1. Start recording
2. Import a model from another CAD system
3. Make changes to the imported model
4. Save the script
5. Import a new version of the model (that is. it was changed and saved in the source system)
6. Playback the script on the new version

Notes:

• The import of the model must be recorded so that the ID Map is inserted in the script
• The ID Map makes the script binary so that it can only be edited in SpaceClaim
• To import a new version, you need to make sure that the correct version number is called for in the script

Limitations:

• Assembly hierarchy in the source system cannot change between imports
• Part names in sub-assemblies cannot change between imports
• The following file types are currently supported

º Spatial IOP Translators
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NX
Creo Parametric
CATIA V5
Inventor

º Part Manager Plugin Translators

NX
Creo Parametric
CATIA V5
Inventor
DesignModeler

Snippets
Snippets are chunks of code that can be inserted into your script. They are presented in a dropdown folder browser
with tooltip help describing the function of each snippet.

Snippet Example
This example shows how to use a Code Snippet to create a simple gear.

The model already contains a cylindrical shaft, which could also be constructed using a script.

Open the Constructing Geometry folder and select the gear Snippet.

The Snippet code loads into the Script Editor window.
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Click the Run Script button to build the gear.

Script Groups
Scripts can be saved to Groups to store them in the model. In the Script Editor, open the dropdown menu on the
Publish Script button and select Publish as Group.
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Click the Publish Script button to create the group and add it to the Script folder in the Groups Panel.

Script Parameters
Variables used in scripts can be saved to Parameter Groups. This allows you to modify the values without editing
the script.

Note: SpaceClaim rebuilds the model from nothing when replaying scripts and assigns new IDs to all the
entities. If you are generating the geometry via script, you should not declare design parameters to individual
parts in downstream applications (for example, Mechanical). To properly scope loads and boundary conditions
for geometries generated via script, you should generate Named Selections for them in the script itself, and
then scope the loads or boundary conditions to the Named Selections downstream.

Creating a Parameter Group
1. Create a Script group
2. Right-click in the Groups Panel and choose Create Parameter from the menu
3. The parameter is created with a default name and a default value of zero
4. Rename the Parameter

Script Group and Parameter Example
This example shows how Parameter Groups can be used to modify the parameters of the Gear script.

1. Insert the Gear snippet into an empty script.
2. Save the script to a Script Group.
3. Create a Parameter group as described above and name it "Teeth".
4. Look for the variable "nTeeth" in the script and edit it as shown below.

5. Click the 'Teeth' Parameter in the Groups Panel and change it to the original value of 20.
6. Right-click the Script Group and choose Run Script from the menu to create a 20-tooth gear.
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7. Expand the Script Group node in the Groups Panel and see that it displays the current value of the Teeth parameter.

8. By default, scripts run after you change a parameter value. Right-click the Script Group and choose Pause from
the menu keep the script from running until you explicitly run it. The script icon in the Groups Panel now has a
'paused' icon.

9. Change the Teeth parameter to 40 and see that the script group now has a yellow triangle in the Groups Panel
to indicate that the Teeth parameter has changed.

10. The snippet does not delete the current gear before it creates a new one. So, delete the current gear and rerun
the script to create a 40-tooth gear.

11. Right-click in the Groups Panel and create a new Parameter named "oRadius".
12. Find the 'oRadius' variable in the script and edit as you did for the Teeth parameter.
13. Change the parameter value to 0.02 to match the initial value in the script.
14. Right-click the parameter and change the units to Length.
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15. Notice that the Parameter value changes to "20mm", indicating that the script assumes length units of Meters.

16. Change the value to 30mm and change the number of teeth back to 20
17. Delete the current gear
18. Run the script to create a gear with 20 teeth and an outside radius of 30mm.

Publishing Scripts to the Ribbon

You can publish a script to create a tool button in the ribbon.

To publish a script:

1. Write a script.

2. In the Publish Script dropdown, check Publish as Tool.
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3. Click Publish Script.
4. In the Publish Script Tool dialog:

a. Enter a Name.
b. Enter a Description.
c. Enter an Icon Path or browse to select an icon.
d. Click OK.

The tool is added to a Scripts group in the Tool ribbon.

Using the InputHelper
The InputHelper enables you to pause the execution of the script to get various inputs from interactive tools, before
continuing to run the script. You can set up custom workflows using the InputHelper functions, including creating
widgets and tool guides for user input.

• You can create tool guides and specify selections which can also be filtered based on type. For example, you can
choose to filter faces, edges, or bodies. You can also specify if the selections are mandatory or optional.

• Script variables can be added to the Options panel as buttons, check boxes, drop-downs, or groups of such controls.
You can also add tool tips for the controls created.

Example - Creating Tool Guides for Selection
This example shows how you can select a body to be moved and select edges to be rounded.

s1 = InputHelper.CreateSelection('Body (Required)', SelectionFilter.Body,True)
s2 = InputHelper.CreateSelection('Edge (2 Required)', SelectionFilter.Edge, 2,
[True])
s3 = InputHelper.CreateSelection('Edge or face (optional)',
SelectionFilter.Edge|SelectionFilter.Face)

InputHelper.PauseAndGetInput('Select body to move. Select edges for rounding.',
s1, s2, s3)

# Translate Along X Handle
selection = s1.Value
direction = Direction.DirX
options = MoveOptions()
result = Move.Translate(selection, direction, MM(30), options)
# EndBlock

# Create 1 Round
selection = s2.Value
options = ConstantRoundOptions()
result = ConstantRound.Execute(selection, MM(1), options)
# EndBlock

The script pauses to start the interactive tool, where you can select a body to be moved and two edges to be rounded.
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When you finish selecting the entities, you can click Complete

or Abort

and resume the script.

Example - Creating Input Options
This example shows how you can specify variables as options to be displayed in the options panel.

def Test(item):
if x==1 :

return True
else:

return False

# User defined function validation method for a selection
function = InputHelper.CreateSelection(Test, 'test')

#Examples of the options for the InputHelper
box = InputHelper.CreateButton(CreateBox, 'Create Box', 'Creates a box of unit
dimensions')
prompt = InputHelper.CreateCheckBox(False, 'Quick Actions', 'Enable Quick
Actions')
color = InputHelper.CreateColorDropDown(Color.Aqua, 'Color', 'Set color ')
list = InputHelper.CreateComboBox("Options", "Choose One", "a", "b", "c")

# Options Group Creation
name = InputHelper.CreateTextBox('abc', 'Name', 'Enter Name')
angle = InputHelper.CreateTextBox(1, 'Angle', 'Enter Angle', ValueType.Angle)
length = InputHelper.CreateTextBox(0.001, 'Length', 'Enter Length',
ValueType.Length)
settings = InputHelper.CreateOptionsGroup('Settings', name,angle,length)

InputHelper.PauseAndGetInput('Select object', box,
prompt,color,list,settings,selection)

The script pauses to start the interactive tool, where you can select an object (a face or edge in this example) and
specify variables in the Options panel.
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When you finish specifying the variables, you can click Complete

or Abort

and resume the script.

Scripting for Meshing
Meshing commands are recorded like other SpaceClaim operations, allowing for the creation of geometry and mesh
in the same script. The easiest way to learn the scripting API is to use the record option

while performing your operations and then modify the recorded script as appropriate.

The example shows the script for the Create/Edit Mesh operation:

Use the validate helper functions to validate the blocking and the body mesh generated.

425Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Designing





5: Changing the Display

The tools you use to customize the appearance of your design within the design window are found in SpaceClaim's Display
tab.

• Customize your design by modifying which objects are displayed, the style in which solids and edges are displayed, and
the color in which solids appear in your design.

• Paint display properties from one object to another.

• Create layers to save different customizations and display characteristics.

• Customize the workspace by creating windows or splitting the window to display multiple views of your design.

• Show or hide workspace tools.

• Configure the docking/detached location of all your workspace windows.

• Create views to save the camera perspective and assign the view to a hotkey.

Display tools are grouped into the following ribbon groups:

Quickly display a particular view of your design.Orient

Determine how the solids in your design will be displayed.Style

Open the Camera options for Flythrough and set perspectiveCamera

Create new design windows, split windows, and quickly switch between windows.Window

Determine how the sketch grid and the geometry above or below the grid is displayedGrid

Display or hide tools in the Design window.Display

5.1. Orienting Designs
Select a tool from the Orient ribbon group to orient your design in the workspace. You can use these tools at any
time, even when you are designing with other 2D or 3D tools.

Note: Drag the middle mouse button to spin, Shift+drag it to pan, and Ctrl+drag it to zoom. You can switch
between spinning, panning, and zooming by pressing and holding Ctrl (to zoom) or Shift (to pan). When you
release the key, you will return to spinning.

Orient Ribbon Group
The Orient ribbon group contains the following tools:

Use the Home tool to return the orientation of your design to the default, trimetric view.
You can customize the Home view to show your design with any orientation, location, and
zoom level.
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Click the Plan View tool to display a head-on view of the sketch grid or the select plane or
planar face. Alt+select an edge to orient the plan view horizontally or vertically.

You can use the Spin tool to re-orient your design in any direction. Spinning your design
allows you to view it from any angle.

Use the Pan tool to move your design within the Design window.

Use the Zoom tool to display your design closer or farther away in the Design window. You
can zoom the design to fill the Design window, zoom into an area, or zoom in or out a preset
amount.

Use the View tool to display a trimetric or isometric view of your design. You can also display
a head-on view of the top, bottom, front, back, right, or left side.

Use the Snap View tool to display a head-on view of a face. You can also use the tool to
"throw" the highlighted face to the top, bottom, right, or left by dragging it toward the edge
of the Design window.

Use the Rotate tool to rotate your design 90 degrees in the plane of the screen. You can
rotate your design clockwise or counterclockwise.

Use the Next and Previous arrows (or left/right arrows on your keyboard, or browser
next/previous buttons) to change your view to the previous or next orientations.

Orient Modes
When you click the Spin, Pan, and Zoom tools, they stay enabled until you click them again, pressEsc, or click another
tool.

Undoing and Redoing Views
You can undo and redo views using the Previous View and Next View tools

on the status bar. You can also use the left and right arrow keys, or any system-defined browser forward or back
method such as special keyboard buttons.

5.1.1. Orienting Your Home View
Use the Home tool to return the orientation of your design to the default, trimetric view. You can customize the
Home view tool so that it displays your design with a specific orientation, location, and zoom level.

Compared to the isometric view, the trimetric view orients your design so that the front face is angled slightly towards
you and less of the top is shown. The isometric view is on the left and the trimetric view is on the right.
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Displaying the Home View
Click the Home tool

in the Orient ribbon panel or press H.

Customizing the Home View
1. Use the other Orient tools to set up a view of your design in the workspace.

2. Select Home > Set As Home View to make the view in the active Design window the Home view.

Now, when you click the Home tool, your custom view is displayed. Your home view is saved with your design.

Click Home > Reset Home View to return the Home view to the default, trimetric view.

5.1.2. Displaying a Head-on View of the Sketch Grid
Click the Plan View tool

in the Orient ribbon group or in the Sketching mini-toolbar to display a head-on view of the sketch grid or the selected
plane or planar face.

If this tool is disabled, select a plane or planar surface or display the sketch grid.

5.1.3. View Selection
Use the View tool to display a trimetric or isometric view of your design. You can also display a head-on view of the
top, bottom, front, back, right, or left side. Your design's orientation in the head-on views is determined by
SpaceClaim's default coordinate system.
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Compared to the isometric view, the trimetric view orients your design so that the front face is angled slightly towards
you and less of the top is shown. Compare the two views in the image below. The isometric view is on the left and
the trimetric view is on the right.

Selecting a View
Select the view you want from the View tool menu

in the Orient ribbon group.

When you hover over a view name in the list, a preview of the view is displayed.

If you have Animate changes to viewprojection selected in the Advanced SpaceClaim options, the change in view
state is animated.

Displaying a Trimetric or Isometric View of Your Design
Select Trimetric or Isometric from the View tool menu.

Displaying a Head-on View of Your Design
Select Top, Bottom, Front, Back, Right, or Left from the View tool menu.

5.1.4. Snapping to a View
Use the Snap View tool to display a head-on view of a selected face or plane. You can also use the tool to throw the
highlighted face or plane to the top, bottom, right, or left. On a drawing sheet, flipping one view also flips all related
views.

Snap View works on objects with a direction: planes, datums, cones, torii, curves and edges. For non-linear curves,
the direction is determined by the direction between the endpoints.

You can only use this tool in 3D mode. It is disabled in Sketch and Section modes.
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Snapping the View

1. Click
Select or press S.

2. Click
Snap View in the Orient group.

3. Use objects in the Design window to orient your view:

• Click and release on a plane, point, cone, torus, curve, or edge.

If the object is not oriented head-on, then it will rotate so the face you click is viewed head-on, like this:

If the object is already oriented head-on, then it will rotate 90° counter-clockwise or it will rotate so it is square
with the Design window, like this:

• Click, drag, and release a plane, point, cone, torus, curve, or edge to throw it up, down, left, or right.

If the object is not oriented head-on, then it will rotate so the face you click is viewed head-on and square with
the Design window, like this:

If the object is oriented head-on, it will rotate 90° in the direction you drag, like this:

• Click anywhere in empty space to rotate the view 90° counter-clockwise, like this:
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4. Repeat until you see the view you want.

5.1.5. Customizing a View
You can change the shortcut keys for standard views and create your own custom views to save settings for object
orientation and visibility.

User-created views will not auto-scale when they are moved.

Clicking the Name column header in the Views panel toggles through ascending, descending, and user defined order.

Changing View Shortcut Keys
1. Select the View tab in the Structure panel.
2. Select a shortcut key combination in the Shortcut drop-down list for the view you want to change.

Adding a Custom View
1. Position the view in the design window as you want it saved.
2. Select the View tab in the Structure panel.
3. Click Create View at the top of the panel.
4. Select from the following options:

• Name: Enter a unique name for the view. The name will appear in the Structure tree.
• Shortcut: Select a key combination from the drop-down list.
• Orientation: Select if you want the current orientation to be saved in the view.
• Object visibility: Select if you want the visibility of objects in the current view to be saved in the view. Objects

that are hidden when you create the view will be hidden when you apply the view. Visibility is applicable to all
types of geometry, planes, and curves.
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• Visibilitybehavior fornewobjects: Select the visibility behavior you want to apply to objects you create after
you create the view.

• Leave Unchanged: New objects will retain their visibility when you apply the view.
• Visible: New objects will be visible when you apply the view.
• Hidden: New objects will be hidden when you apply the view.

5. Click OK.

Your custom view is added to the View tool menu.

Using Custom Views
The options that are available for custom views are:

You can change the current view to a custom view in the following ways:

• Select the View tab in the Structure panel, right-click the view, and select
Apply view from the context menu.

• Use the shortcut key (if assigned).
• Select the view from the View tool menu

in the Orient ribbon group.
• Double-click the view.
• Select the view and click enter.

Applying a Custom View

Position the view in the design window as you want it saved.

Right-click the custom view you want to replace and select Replace from the
context menu.

The custom view is replaced with the current view.

Replacing a Custom View

Right-click the custom view you want to rename and select Rename from the
context menu.

Enter a new name for the view.

Renaming a Custom View

Right-click the custom view you want to edit and select Properties from the
context menu.

Edit the view properties.

Editing Custom View Properties

Select the view you want to delete and clickDelete View at the top of the panel.

You cannot delete standard views.

Deleting a Custom View

5.1.6. Spinning Your Design
When you click the Spin tool, it stays enabled until you click it again, press Esc, or click another tool.
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Spinning Your Design
1. Click

Spin in the Orient group on the Design tab or in the status bar.

You can also select one of the following from the Spin drop-down:

• On Center to spin around the center of your design.

• On Cursor to spin around the cursor location.

• Rotate 90 Clockwise to rotate your design 90° in a clockwise direction.

• Rotate 90° Counterclockwise to rotate your design 90° in a counterclockwise direction.

2. Click and drag to spin your design.

If you start dragging on a highlighted line, edge, or axis, you can rotate your design around it. You can remove
this feature by setting the advanced SpaceClaim option Rotate about pre-selected object in spin. (Press Alt
and drag to rotate around a highlighted object whether or not this option is selected.)

Note: Set theRotateaboutpre-selectedobject in spinoption. Then, when working in any tool, position
the middle mouse button on the face, edge, plane, or axis about which you want to spin your design,
and drag to spin.

You may find it easier to reach a desired orientation if you use short mouse drags to spin the design a little bit at
a time.

If you double-click a face while using the Spin tool, the face is zoomed so that it fills the design window. You can
also switch to the Zoom tool temporarily by holding down the Ctrl key while turning the mouse wheel.

Switching Between the Spin, Pan, and Zoom Commands
While one of the Spin, Pan, and Zoom commands in the status bar is active, you can switch to any of the others using
the Ctrl and Shift keys.

Press and HoldActive Command

Ctrl to ZoomSpin

Ctrl+Shift to PanSpin

Ctrl to ZoomPan

Ctrl+Shift to PanZoom

While holding Ctrl to Zoom, you can use the LMB or the mouse wheel for zooming in and out.
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Setting the Spin Center
Right-click anywhere in the Design window, select Spin Center, and select one of the following:

• Set: Sets the spin center to the center of the object you have selected. If you don't have an object selected, the
spin center is set to the spot where you right-click. If you previously set the spin center, setting it again will change
it to your current selection. You don't need to clear the spin center to set it again.

• Clear: Clears the spin center. When you rotate your view in 3D, the spin will be centered based on the option you
select in the Spin tool.

• Locate: Centers the view on the spin center, if one is set.

Displaying the Spin Center Indicator
SelectSpinCenter in the Show group on the Display tab to see an indicator of your spin center in the Design window
when you spin your view. The indicator only appears while you spin, and it changes when you have a spin center
set. The default indicator is shown below on the left. The indicator below is shown when you have the spin center
set.

Orientation Shortcuts
An orientation indicator is located in the lower left corner of the Graphics window. You can use it to snap to views
and rotate the view.

Click an axis or one of the colored balls to snap the view to snap that axis normal to the screen. The balls are the
intersection of an axis on the opposite side of the block from it's label. The image below shows the result of clicking
on the Z-axis.

As the mouse gets near the indicator, arrow arcs appear.

Click an arrow to rotate it 90° in that direction.

435Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Changing the Display



You can also drag on the arrow to rotate the view. As you drag, the view rotates in 5° increments. To rotate smoothly,
press and hold the Shift key while dragging.

Turntable Spin Mode
Turntable spin mode is enabled in the Navigation pane of SpaceClaim Options. It rotates the view using the top of
your design as the up direction and the location of your mouse as the rotation axis. This is the spin method commonly
used in architectural CAD packages.

The cursor changes to indicate when you are in Turntable Spin mode.

To understand Turntable spinning, picture the World Origin as a turntable

• The model sits on the XY-plane.
• The Z-axis is the axis of rotation.
• Spinning is based on cursor movement as follows:

º Left-to-Right movement spins about the Z-axis
º Up-and-Down movement spins the XY-plane.

You can see the difference by orienting the World Origin with the Z-axis horizontal.

Cursor movement Left-to-Right spins the model only about the Z-axis

Cursor movement Up-and-Down Also spins the model only about the Z-axis

A combination of both movements Also spins the model only about the Z-axis

5.1.7. Panning Your Design
Use the Pan tool to move your design within the Design window.

When you click the Pan tool, it stays enabled until you click it again, press Esc, or click another tool.

436Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Changing the Display



Panning
1. Select the Pan tool

from the Orient ribbon group or status bar.

2. Drag to move your design around the Design window.

If you double-click a face while using the Pan tool, the face is zoomed so that it fills the design window. You can
also switch to the Zoom tool temporarily by holding down the Ctrl key while turning the mouse wheel.

Note: When working in any tool, Shift+click the middle mouse button and drag to move your design.

In SpaceClaim Options, you can add panning scroll bars to the Design window. Go to Popular Options and check
the Show scroll bars in the design window option ON.

5.1.8. Zooming Your Design
Use the Zoom tool to display your design closer or farther away in the Design window. You can zoom the design to
fill the Design window, zoom into an area, or zoom in or out a preset amount.

When you click the Zoom tool, it stays enabled until you click it again, press Esc, or click another tool.

Zooming In and Out
1. Select the Zoom tool

from the Orient ribbon group or status bar.

2. Click where you want to center the zoom.

3. Drag down to zoom into your design; drag up to zoom out.

You can also use the scroll wheel to zoom in and out.

Note: When working in any tool, Ctrl+click the middle mouse button, then drag up and down to zoom. You
can also press Ctrl+ or Ctrl- to zoom in or out a preset amount.

Using the Zoom Legend
You can toggle the Zoom Legend on and off using the Show menu in the Display ribbon group.

The Zoom Legend highlights when you hover over it, indicating you can click and drag it to a new location.
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Switching Between Spin, Pan, and Zoom Commands
While one of the Spin, Pan, and Zoom commands in the status bar is active, you can switch to any of the others using
the Ctrl and Shift keys.

Press and HoldActive Command

Ctrl to ZoomSpin

Ctrl+Shift to PanSpin

Ctrl to ZoomPan

Ctrl+Shift to PanZoom

While holding Ctrl to Zoom, you can use the LMB or the mouse wheel for zooming in and out.

Zooming the Design or a Selected Face or Edge to Fit the Design Window
Select Zoom > Extents or press Z.

The design or selected face or edge is zoomed so that it fills the Design window. When working with a drawing sheet,
it will fit the drawing sheet to the Design window. If you resize the Design window, the design will also be resized
until it again fills the Design window.

Zooming into a Selected Area
1. Select Zoom > Zoom Box In.

You can also right-click in the Design window and select View > Zoom Box In from the menu.

2. Click and drag to select the area.

Two rectangles appear as you draw. The dotted rectangle shows your selection; the solid rectangle shows what
will be displayed in the Design window. When you mouse-up, the design pans and zooms until it fits within the
area.

Zooming In and Out a Preset Amount
Select Zoom > Zoom In to bring your design closer. Select Zoom > ZoomOut to move your design further away.

When working in any tool, press Ctrl and + or Ctrl and - to zoom in and out a preset amount.
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5.1.9. Rotating Your Design
Use the Rotate tool to rotate your design 90 degrees in the plane of the screen. You can rotate your design clockwise
or counterclockwise.

Rotating Your Design 90 Degrees
Click the Rotate tool

.

Changing the Rotation Direction
Select Rotate > Rotate 90 Counterclockwise.

Your design rotates 90 degrees counterclockwise and the Rotate tool icon changes to
.

Clicking the Rotate tool will continue to rotate in the counterclockwise direction.

Select Rotate > Rotate 90 Clockwise to rotate your design in the clockwise direction and set the Rotate tool to
rotate clockwise.

5.2. Styles
This section contains the following topics:

5.2.1. Applying Colors
The color of solids, surfaces, and components are normally determined by the layer color; however, you can override
the layer colors for objects. By default, all objects are placed on Layer0, which is green. You can modify the color of
edges, faces and bodies when selecting an object.

See Working with Layers to change the layer color or move an object to a different layer.

See Changing object transparency to change the transparency of an object.

Use the Color tool in the Style ribbon group of the Display tab to override the layer color for solids, surfaces, faces,
and curves, or the color of individual faces on a 3D markup slide. When you add a Custom Color in the color palette,
it is added to the bottom of the menu and it is saved between SpaceClaim sessions.

If you change the color when nothing is selected, the color will become the default for new objects. This allows you
to set the color for things you haven't created yet, without using layers and default layer colors.
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Overriding the Layer Color of a Solid, Surface, Face, or Curve
1. Select one or more solids, surfaces, faces, curves, or components in the Design window or Structure tree.

You can select a body by selecting one of its faces or edges, then selecting Body as the Target.

If you select a component, then the color of all of the component's children will be changed.

2. Click Color in the Style group on the Display tab.

3. Select a color.

If the color you want is not in the list, click More Colors and select a color or create a new custom color.

4. Choose Randomize Colors to let the system assign colors to the selected objects

5. (Optional) Set the transparency of the object. See Changing object transparency.

Overriding Edge Color
1. Select any edge on a solid or surface.

2. Click Color in the Style group on the Display tab.

3. Select a color.

This color will be used for all edges of the solid.
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Removing Color Overrides and Returning the Object to the Layer Color and
Transparency
1. Select one or more solids, surfaces, faces, curves, or components in the Design window or Structure tree.

You can select a body by selecting one of its faces or edges, then selecting Body as the Target.

If you select a component, the color of all of the component's children will be changed.

2. Click Color in the Style group and select Remove Color Override.

Viewing an Object's Color Properties
1. Select the object in the Design window or Structure tree.

2. Look for the Style attribute in the Appearance section of the Properties panel.

This property shows how the appearance of an object is overridden in the Style group:

• ByLayer indicates that the object is assigned to a layer other than Layer 0, which affects its default appearance.

• By Color indicates that the object's color has been set via the Color tool.

• By Style indicates that the Transparent or Opaque buttons in Style Override have been toggled for the object.

5.2.1.1. Changing Object Transparency
By default, the transparency of an object is determined by its layer color and whether or not the object is a surface.
Surfaces are displayed as semi-transparent to visually distinguish them from solids. You can override the transparency
of objects using the Color tool.

In a graphics editing application, color is assigned to an Alpha channel (ARGB, for example). SpaceClaim follows this
standard convention and also treats transparency as a property of the object's color.

The hierarchy of rendering overrides is as follows:

• The opacity setting for the layer is used if no other transparency is set for the object.
• The transparency setting from the Color tool or Style Painter overrides the transparency of the layer.
• Style Override makes the object opaque or transparent, regardless of face or layer settings. These overrides are

automatically deselected when you change the transparency of an object using the Color tool or Style Painter.

Changing an Object's Transparency
1. Select one or more solids, surfaces, faces, curves, or components in the Design window or Structure tree.

Hold the Ctrl key to select more than one object.

If you select a component, then the color of all of the component's children will be changed.

2. Click Color in the Style group on the Display tab.

3. Choose the Opacity box.

Overriding an Object's Transparency
1. Select one or more solids, surfaces, faces, curves, or components in the Design window or Structure tree.

Hold the Ctrl key to select more than one object.
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If you select a component, then the color of all of the component's children will be changed.

2. Click
Style Override in the Style group on the Display tab.

3. Select one of the options:

• Transparent to make the object 35% transparent.

• Opaque to make the object completely opaque.

Deselect so neither override is selected if you want to use the object's transparency setting.

Note: If any subset of the body's faces is made transparent, Style Override is disabled, because there
is a mix of opaque and transparent faces.

Reapplying the Layer Color and Transparency
1. Select one or more solids, surfaces, faces, or curves in the Design window or Structure tree.

Hold the Ctrl key to select more than one object.

2. Select Remove Color Override from the Color tool on the Display tab's Style ribbon group. You can see this
option in the image of the Color tool above.

Applying Per-face Transparency
1. Select a face.

2. Open Color in the Display tab and set the Transparency for the selected face.

3. Review the properties for the selected face. By default, theStyle property will beByColor,ByStyle so theBody
Style overrides the Face style and the Transparency is overridden.
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4. Open Style Override in the Display tab and note that Opaque is the active Body Style.

5. Click the active style (Opaque) to disable it.

Note: Style Override

appears disabled.

The face transparency displays.
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5.2.2. Line Styles
You can apply a custom line style and line weight to the lines in your designs and drawing sheets. The line styles you
choose apply to annotations, center marks, center lines, and drawing sheet cross-section view arrows, hatching,
hatched area borders, and detail view boundaries. You can apply line styles to individual objects or to all the objects
on a layer. The width that you set is exactly the width that will be printed when you print an unscaled drawing sheet.

You can set the default line styles for various objects in the SpaceClaim options. Setting the line styles individually
overrides the default setting.

Line styles can be assigned to layers so that you can have different line styles for sketch and layout lines.

Applying a Line Style
1. Select the objects or layer to which you want to apply the line style.

2. Select the line style from the Line Style tool menu.

3. Select the line weight from the Lineweight menu in the Style group on the Display tab.

5.2.3. Layers Panel
Layers can be thought of as a grouping mechanism based on visual characteristics. Visual characteristics include
visibility, color and line style. Layers are managed in the Layers panel and accessed and modified with the Layer
tool in the Display tab Style group.

The default layer color for new documents can be set in the Appearance section of SpaceClaim Options.

Layers are especially useful when you want to hide annotation planes.

Sheet metal parts have a set of default layers when the part is in an unfolded state. They are:

• Dimension
• Bend Lines Up
• Bend Lines Down
• Bend Dimensions
• Forms

Creating a Layer
Right-click in the Layers panel and select New.

This layer becomes the activate layer. Any objects created are automatically placed on this layer.

Placing an Object on a Layer
1. Select one or more objects to assign to the layer.

2. Right-click a layer to open the context-sensitive menu.
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3. Choose Assign to layer.

Renaming a Layer
Right-click the layer in the Layers panel and select Rename or click the layer name and slowly drag to the right.

Layer0 cannot be renamed.

Deleting a Layer
Right-click the layer in the Layers panel and select Delete.

Layer0 cannot be deleted.

Deleting Empty Layers
Right-click in the Layers panel and select Remove Empty Layers.

Activating a Layer
1. Right-click a layer to open the context-sensitive menu.

2. Choose Make Active.

3. New objects created are assigned to the active layer.

Setting Layer Visibility
1. Select a layer in the Layers panel.

2. Click
to show the objects on the layer. Click

to hide them.

If an object is located on a layer with the visibility turned off, and the object in the Structure tree is set to show
visibility by layer, the object is not visible in the Design window, and cannot be acted on by the design tools.
Layer visibility can be overridden in the Structure tree.

You cannot hide the active layer.

Use Hide Others on an inactive layer to make it active and hide the other layers.

You can make a hidden layer active which automatically makes it visible.

Setting the Visibility of Layout Lines and Imported, DWG and DXF Lines
Select Solid or Hidden from the layer's line drop-down in the Layers panel.

Modifying the Layer Color
1. Select a layer in the Layers panel.

2. Select a color from the

drop-down.
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You can also specify a custom color by selecting Custom Color and using the Color window.

You can override the layer color for solids, surfaces, faces, or curves. See Applying colors to design elements.

5.2.4. Applying a Graphics Style
SpaceClaim offers several different styles to view your design. You can apply styles to your entire design or drawing
sheet, to individual layers, or to individual views in your drawing sheet.

Applying a Graphics Style to Your Design

1. Click
Graphics in the Style group on the Display tab.

2. Select a graphics option:

• Shaded: Displays solids and surfaces as three-dimensional, shaded objects.

• Enhanced Shaded: Solids and surfaces are displayed as three-dimensional, shaded objects (the default). The
shading represents the exposure of the scene to ambient lighting, with shadows and highlights to improve
rendering.

• Wireframe: Only the edges of objects are displayed. The wireframes are the same color as the edges.
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• Hidden Line: Objects are displayed as wireframes with hidden lines displayed in a light gray.

• Hidden Line Removed: Objects are displayed as wireframes and hidden lines are not shown.

All objects in the Design window will be displayed in the style you select.

5.2.5. Applying a Rendering Style
The Rendering Style tool, in the Style group of the Display tab, allows you to change how solid faces are rendered.
You can choose between a shiny, light reflective finish (Metallic), a matte finish (Plastic), a sketched finish (Brushed),
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or a hatch line finish (Hatched). Assigning different rendering styles to a model helps you to better visualize parts,
assemblies, or components as you develop your design.

In the images below, all four rendering styles are used: the top of the pitcher is set to plastic. The handle and pitcher
are brushed. The blade base is hatched, and the base of the pitcher is set to metallic:

Changing the Rendering Style of a Solid or Surface
1. Select the solid or surface.

2. Click
Rendering Style in the Style group on the Display tab.

This icon changes to reflect the current setting, but always appears as a shaded sphere.

3. Select Hatched, Brushed, Metallic or Plastic to apply that surface style to the selected solid or surface.

5.2.6. Displaying Edges
Use the

Edges option tool in the Style group on the Display tab to customize which edges are displayed. These settings are
saved with the document, but are only used for 3D display. The edge display options apply to the design in the
current Design window tab, and not other designs you may have open in other tabs in the Design window.

See Applying colors to change the color of edges.
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Changing Edge Display Options
1. Click

Edges in the Style group on the Display tab.

2. Select any combination of the following options:

The examples below show each option disabled and then enabled.

• Tangent: Display lines indicating tangent edges and edges that do not span a face.

• Surface: Display all edges on surfaces.

• Solid: Display all non-tangent edges on a solid.

• Silhouette: Display the lines that indicate the silhouetted edges of all curved surfaces. This option affects only
Wireframe, Hidden Line, and Hidden Line Removed graphics styles.

• Mesh: Display facet edges on an STL model. You can toggle the display of internal mesh edges and open meshes
edges on boundaries. You can sketch on the mesh object and your sketch tools will snap to the facets.

• Soft: Display the soft edges of imported SketchUp models. This option is ON by default.

5.2.7. Painting Display Properties fromOne Object to Another
Use the Style Painter tool to apply the display properties of one object to another object. The tool applies color
and transparency intelligently from one object type to a different object type.

You can select a component in the Structure tree as the target for the Style Painter tool. The color and transparency
are applied to all solids in a component. You cannot select a component as the source object, and only the solids
in the target component are changed.
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In the example below, the red part is semi-transparent and has blue edges. The style from the red block was painted
to the green block and to the note. The color, transparency, and edge color of the red block was copied to the green
block. Only the color of the red block was copied to the note, because a note doesn't have transparency or edge
color.

Painting Display Properties fromOne Object to Another
1. Click

Style Painter in the Clipboard group on the Design tab.
2. Select the source object that you want to copy the display properties from.

3. Select the target object that you want to copy the display properties to.

The Select Target tool guide automatically becomes active so you can paint the properties of the source to as
many targets as you like by simply clicking on them.

If you can't select the object you want, such as an edge, try scrolling the mouse wheel over the object.

4. If you want to paint properties from a different source object, click the Select Source tool guide or holdCtrl and
select a different source object.

The Select Target tool guide automatically becomes active again so you can click as many targets as you want.

5.3. Flythrough
Flythrough is a display mode intended to give you the impression you are inside the model looking around.

When setting up a flythrough mode, typically the screen is split with one viewport to show the camera position and
one for flying through.
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Flying Through Your Design
1. Click the Show Camera Options button in the Display tab

• Camera settings are per scene, not per window

2. Click the

button to activate Flythrough in Viewport 1

• Camera type will change to Perspective
• You can choose a camera type

• Orthographic - Parallel lens
• Perspective - Divergent lens

3. In the Flythrough viewport, spin and zoom to fly through the model

• MMB positions the spin center where you clicked the MMB

• MMB+Alt rotates around the Camera position

4. (Optional) Open a second viewport to control the camera position or trajectory.

Positioning the Camera
1. Click the Identify Viewport button

to show viewport numbers
2. In the Options Panel, click the Show Camera button

3. Choose a viewport for the camera in the Show Camera dialog box
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The camera position is shown in the selected viewport (default is 0) and your model as seen from the camera
position is shown in the active viewport (default is 1)

•

• You can change the activate viewport by clicking in them or selecting them from theActiveViewportdropdown
in the Options panel

4. (Optional) Adjust the Width or Height of the camera film

• This adjusts the zoom level in the camera viewport
• When you click in either the Width or the Height inputs, the corresponding film edges highlight in the scene
• You can also hold the ALT key while zooming IN/OUT in the Flythrough window to increase/decrcease the

width and height

5. (Optional) In the camera viewport, position the camera using the Move tool

Moving the Camera with the Move Tool
1. Turn the Camera ON in a viewport
2. Turn Flythrough ON in another viewport

• If Flythrough is OFF, you cannot select the camera to move it

3. Enter the Move tool
4. Select a part of the camera to move. Referring to the image below, you can select either the Sight Line (light blue

line), Target End (blue dot), or Camera End (green dot).

5. Use the Move Handle to position the camera
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6. Moving the green dot moves the Camera End. The Target End remains fixed as if you are walking around the
Target End while keeping your eyes pointed at the Target End.

• The Move Handle reorients after the move to show that it remained pointed at the Target End during the drag.

7. Moving the blue dot moves the Target End while maintaining the Camera End position. This has the effect of
moving the object in space while keeping the Camera fixed (like moving the object while keeping your eyes
pointed at the camera).

• The Move Handle reorients after the move to show that it remained pointed at the camera during the drag.

8. Moving the Sight Line moves the Camera as a whole

• Dragging linear directions maintains the camera orientation during the move
• Dragging rotational directions pivots the camera about the sight line midpoint

9. Use the Up To tool guide to attach the camera to selected geometry

• Attaching the Camera End and then moving the Target End linearly rotates the camera while it is fixed to the
selected geometry

• Attaching the Target End and then moving the Camera End linearly is like walking around while keeping the
camera fixed on the target

Moving the Camera along a Predefined Tragectory
With the Camera attached to a curve, you can use the Move Along Trajectory tool guide to move the camera along
a predetermined path.

1. Select the Sight Line to Move
2. Click the Up To tool guide
3. Select the curve endpoint
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4. Orient the camera to establish the viewing direction

5. Click the Move Along Trajectory tool guide
6. Select the curve

7. Start dragging along the curve
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8. The camera follows the curve and the view direction moves accordingly

9. Continue dragging until the end of the curve

5.4. Workspace Windows
This section contains the following topics:

5.4.1. Displaying Your Design in Multiple Windows
Use the New Window tool to create new workspace windows. Creating multiple windows allows you to set up several
views of your design. Each window has a numbered tab at the bottom of the workspace.

Creating a NewWorkspace Window
Select the New Window tool

on the Display tab's Window ribbon group.

455Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Changing the Display



A new tab appears at the bottom of your workspace and a number is appended to the design, drawing sheet, or 3D
markup name. You can click the middle mouse button on the tab of any design, drawing sheet, or 3D markup window
to close that window.

5.4.2. Splitting the Workspace Window
Use the

Split Window tool in the Window ribbon group on the Display tab to divide the workspace window into multiple
windows. Splitting the window allows you to see multiple views of your design simultaneously.

Select how you want to split the workspace window from the Split Window tool menu. The window is split based
on your selection. The active window is indicated with a yellow border.

5.4.3. Switching BetweenWindows in the Workspace
If you have more than one window open, you can select the window you want to display from the tabs at the bottom
of the workspace.

If you have many windows open and the tabs do not fit in the workspace, you can use the Next Window and Previous
Window arrows

at the bottom of the workspace to switch between windows.

You can also use the Switch Window tool to select the window you want to display. Select the window you want to
display from the Switch Window tool

menu on the Display tab's Window ribbon group.
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5.4.4. Maximizing the Design Window
Press F11 to maximize the design window to full screen. You can still switch between windows and use the tool
guides when the window is maximized.

Press F11 to return to the standard user interface.

5.5. Sketch Grid Styles
You can modify whether the sketch grid is displayed, and how the geometry above or below the grid is displayed in
each Design window. You may want to use one style when you are examining a component, and another when you
are creating new geometry within a component. You can further customize the sketch grid by hiding section lines
and faces using SpaceClaim options.

Showing or Hiding the Sketch Grid
Check the Show Sketch Grid box in the Grid ribbon group on the Display tab to display the sketch grid. The sketch
grid appears in all the sketching tools. Displaying the sketch grid allows you to snap to grid lines and provides a
visual cue to the orientation of your sketch within your design

Determining How Geometry Above or Below the Grid Is Displayed
• Check the Fade Scene Under Grid box to make the geometry under the sketch grid more transparent.

Sketch curves outside the current sketch plane appear faded, while layout curves are unaffected.

• Check the Clip Scene Above Grid box to hide the geometry above the sketch grid.

Clipping Your Design with a Plane
Right-click a plane and select Clip with Plane. To restore the view of your design, right-click the plane and select
Clip with Plane again.

Planes, axes, and annotations are not clipped.

Examples

Fading the scene below the grid makes it easier to see when you sketch in section mode.
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Examining a section with the scene clipped above the grid

5.6. Displaying Workspace Tools
You can adjust the display of workspace tools and the display of your design in the Design window using the Show
drop-down list of tools in the Display ribbon group on the Display tab, and by modifying SpaceClaim options.

Customizing the Tools Displayed
SpaceClaim offers the following tools on the Display ribbon group on the Display tab to assist you while creating,
editing, and detailing your designs:

Check the World Origin box to display the axes that set the default orientation
of the design in the Design window.

World Origin

Check the Spin Center box to mark the center of the spin when using the Spin
tool. (This is the same as the Show Spin Center SpaceClaim option.)

Spin Center

Check the ZoomLegend box to display the zoom legend in the Design window.Zoom Legend

Check the Lineweight box to change the line style to the thickness set by the
Lineweight tool in the Style ribbon group.

Lineweight

Check the Face Highlight box to enable pre-highlighting of faces.Face Highlight

Check the Face Spotlight box to show a spotlight attached to the cursor when
passing over faces.

Face Spotlight

Check theBodyGlowbox to enable highlighting for pre-selection and selection
of bodies. This setting applies to all windows.

Body Glow

Check theVerticesbox to show all vertices in the model. Vertices are not shown
on closed periodic edges (for example, on a cylinder). This setting works on a
per-window basis, enabling it in one window has no effect on other windows.

Vertices

Check theBody Interferencebox to show any bodies that are intersecting. This
setting works on a per-window basis, enabling it in one window has no effect
on other windows.

Body Interference
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Check the Ambient Occlusion Only box to render the display with a diffuse,
non-directional shading effect that approximates how light should be shining
on any specific surface based on the light source and, if included, the
environment. The shading represents the exposure of the scene to ambient
lighting, for example, interior surfaces of a model are typically more occluded
and will appear darker than the exposed outer surfaces. This option can be used
when the Enhanced Shading option is enabled.

In the example, the image on the left is rendered with Ambient Occlusion and
shows the shadows and highlights that are missing in the image on the right.

Ambient Occlusion Only

Check the Adjacent Entities box to display faint highlighting on adjacent faces
when you hover over an edge and on adjacent edges when you hover over a
vertex. Scrolling the mouse wheel switches between adjacent entities. This
feature is useful in selecting the correct edge or face to extrude.

Adjacent Entities

Check the Offset Baseline Faces box to display offset relationships with blue
shading.

Offset Baseline Faces

Check theStandardHolesbox display Standard Holes in blue. When unchecked,
Standard Hole faces display in the normal face color.

Standard Holes

Check the Lightweight Components box to display Lightweight components.
This also has a flyout for setting Lightweight component transparency.

Lightweight Components

Check the Environment box to display according to the settings in the
Appearance panel.

Environment

To display other workspace tools, modify the settings in the Popular SpaceClaim options.

You can also display journal-related tools by checking the Show Journal Tab option in the Popular SpaceClaim
options.
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Examples

Hovering over an edge with Adjacent Entities highlights the faces shared by the edge

5.7. Showing and Hiding Objects
You can use any of these methods for setting the visibility of objects in the Design window:

• Right-click an object in the Design window and select Hide Others to view only that solid, surface, or curve.

• Right-click anywhere in the Design window and select Show All to make all objects visible.

• Right-click an object in the Structure tree and selectAlwaysVisible from the context menu. The object will remain
visible if you hide its layer, but this setting has no effect on other visibility commands such as Isolate or hiding its
parent component by deselecting its check box it in the Structure tree.

• Right-click a face and select the Face context menu.

º Hide Face hides the selected faces. Hidden faces allow objects behind them to be selected without using the
scroll wheel.

º Hide Other Faces hides all faces except for the selected faces.

º Inverse FaceVisibility inverts the current visibility state for all faces. Hidden faces (even those hidden By Body)
become Visible. Visible faces become hidden.

º Show All Faces shows all faces, whether they were hidden By Face or By Body.

• Deselect the check box in the Structure tree to hide the object in the Design window. The object icon is displayed
in gray. You can also right-click an object in the Design window and select Hide (or select it in the Design window
and press Ctrl+H) to turn the visibility of the object off.

• Select the check box next to the object in the Structure tree to set the visibility of the object to the layer visibility.
If the layer is hidden, then the object will be hidden. If the layer is visible, then the object will be visible.

If the layer visibility is on, the icon appears normally. If the layer visibility is off, the icon appears like the
Solid_LayerHidden icon in the figure above. You cannot work with hidden objects in the Design window.

Note: Shift+click and Ctrl+click multiple objects to work with them as a group.
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5.8. Displaying Lightweight Components
Lightweight components are a graphics-only representation of a design. You can adjust the transparency of the
lightweight components in your design. If you do not see lightweight components when you open or insert a design,
make sure your settings are configured to display them.

See also Lightweight components.

Adjusting the Transparency of Lightweight Components
1. Click the Transparency icon

on the status bar.

2. Adjust the slider to set the opacity of the lightweight components in the Design window. All lightweight components
are displayed with this opacity.

Making a Lightweight Component Appear Solid
Select a lightweight component and press Ctrl+Shift+F8 to make the component appear solid. All other lightweight
components still appear dim.

Before dimming, the lightweight components appear slightly transparent and their edges aren't displayed.

After dimming, all components regardless of lightweight status, become dim except the selected lightweight
component.

461Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Changing the Display



6: Assemblies

This section contains the following topics:

6.1. Parts
This section contains the following topics:

6.1.1. Inserting Another Design
You can insert another design created in SpaceClaim or another application as a component of your design. The
design is inserted as an external component, linked to the external file. You can make this component internal to
your own design. Lightweight components are displayed with solid edges and transparent faces until you right-click
the component and select Load component from the context menu.

You can also insert an image file or a video file.

Inserting Another Design as a Component
Drag and drop a file from outside SpaceClaim into the Design window, or follow the steps below.

1. Select Open from the File menu or click

in the Quick Access toolbar. You can also insert into an existing design using the File tool in the Part group on
the Assembly tab.

2. Navigate to and select the design you want to include as a component, then click Open on the Open Design
window. You can select more than one SpaceClaim document, and they will be inserted as components.

You can select from the Files of type drop-down menu to filter the files list.

Progress is displayed on the status bar until the design is inserted as an external component. You can insert
multiple copies of the same component. Modifying one of these components will modify every copy unless you
make them internal to your design.

If the design consists of multiple files and some files can't be found, you will get the Missing Files dialog which
allows you to browse to locate these files.

Replacing One Component with Another
1. Right-click the component in the Structure tree.

2. Hover over the Source option then select Replace Component from the context menu.

3. Navigate to and select the design you want to use as a replacement.

4. The component is replaced.
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Making an External Component Internal to Your Design
1. Right-click the external component in the Structure tree.

2. Hover over the Source option then select Use Internal Copy from the context menu.

If your design includes multiple copies of an external component, making one of them internal does not affect
the other copies. Making another copy of the same external component internal creates a second instance of
the same internal component.

6.1.2. Inserting an Image
You can insert an image into your design or onto a drawing sheet. Inserted images and their transparency colors,
aspect ratio, and placement information are saved with the design.

After you insert an image, you can select the image to display control handles for image editing. The control handles
highlight when moused over and selected. If Show cursor arrows is selected in SpaceClaim Popular Options ,
arrows also appear next to your cursor that indicate the directions in which you can move your mouse to manipulate
the image.

When placing the image, all the normal orientation shortcuts work, as well as Ctrl+Alt dragging the middle mouse
button to scale/zoom the image itself. This keyboard shortcut provides an way to quickly scale the image to the size
of the face.

When you insert an image with the File tool and wrap it onto a face with the Place Wrapped Image tool guide:

• You can select Location, Size or Location and Size from the Lock property to prevent changes to the size and
location of an image wrapped to a face.

• You can select both inserted and wrapped images.

• Once you select a wrapped image, you can drag it around the face it is wrapped onto, resize it, and rotate it with
the image control handles.

• Multiple images can be wrapped onto the same face or surface.

• Images wrapped onto a face or surface move with the face or surface.

Inserting an Image

1. Click
File in the Part group on the Assembly tab.

2. Select the BMP, GIF, JPG, PCX, PNG, or TIF image file you want to insert and click Open.
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You can select Image files from the Files of type drop-down menu to filter the files list.

3. (Optional) Zoom the image in or out by Ctrl+Alt+dragging with the middle mouse button.

4. Mouse over the design to align the image with the highlighted object.

To place an image on a curved face, select the Place Wrapped Image tool guide if you want the image to flow
over the curved face. Otherwise, the image will be placed tangent to the curved face. You may also use this tool
guide to place a wrapped image on a planar face. The edges of the image are clipped to accommodate the size
and shape of the planar face.

5. Click the face that defines the plane on which you want to insert the image. You can place an image on a datum
plane.

The image appears in the Structure tree. The image's name is based on the file name from which the image was
created. Removing or altering the image in SpaceClaim does not affect the original file.

Re-sizing an Image
Select the image and drag the blue control handles.

Hold the Shift key to maintain the aspect ratio while resizing. Hold the Alt key to scale the image around the center
handle.

You can right-click the image and selectProperties to lock the aspect ratio in theKeep aspect ratio property in the
Properties panel.

Rotating an Image
Drag the green control handle at the top of the image to rotate the image.

You can also drag the red control handle which is not connected to the image edge to change the center of rotation.

Rotating a Wrapped Image
With a planar image, there is a green rotation control handle located outside the top of the image. This does not
exist with a wrapped image.

Hover over one of the blue control handles at the edges of the image and query select to change it to a green control
handle. You can then select the green control handle and rotate the image about the red control handle.

Flipping an Image
Drag handle across the other side of the image to flip the image.

Moving a Planar Image with the Move Tool
1. Click the Move tool.

2. Select the image.

You can Ctrl+click to select the image along with other objects.

3. Use the Move handle to move the line or point.

Moving a Planar or Wrapped Image with the Select Tool
1. Click the Select tool.
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2. Select the image.

You can Ctrl+click to select the image along with other objects or to select multiple images.

3. Use the mouse to drag to move the image(s).

Replacing an Image
1. Right-click the image.

2. Select Replace image.

Copying an Image
1. Select the image.

2. Press Ctrl and drag the image to create a copy of the image.

To copy and paste an image, see Cutting, copying, and pasting.

Setting Transparency of the Image
Enter a value or move the slider in the Transparency property.

Setting a Color in the Image to be Transparent
1. Click

in the Advanced property to display the Image Preview window.

2. Mouse over the pixels in the image to display their RGB values.

3. Click the eyedropper

and select a pixel in the image that is the color you want to become transparent.

You can use the zoom slider to resize the image and you can drag to pan the image within the window.

The color you selected appears in the drop-down next to the eyedropper icon. You can add multiple transparent
colors by repeating this process, and remove colors by clicking Delete Selected Color or Delete All Colors icons.
The image window previews the image with the transparency you selected.

Locking an Image
Set the Lock property to Location, Size, or Location and Size.

The image cannot be edited while it is locked depending on the option set. Set Lock property to No to unlock.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Place Planar Image positions the image on a plane or
planar face.
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Place Wrapped Image wraps an image onto a non-planar
surface or face. Images are clipped to accommodate the
size and shape of the face the image is being placed on.

6.1.3. Inserting a Video
You can insert video files in your design. Videos can be inserted on curved or planar faces, and can be played from
within SpaceClaim.

Supported formats are:

• .wmv, .avi, .flv, .mkv, .mov, .mp4, .mpg, mpeg, .ogm, .vob

• Proper codec(s) are required for all but WMV and AVI

Videos are added to the Structure tree. If you place a video on a face or surface, you will still see the video if you hide
the face or surface.

Inserting a Video

1. Click
File in the Part group on the Assembly tab.

2. Select the AVI, WMV, FLV, MKV, MOV, MP4, MPG, MPEG, OGM, and VOB video file you want to insert and click
OpenYou can select Video files from the Files of type drop-down menu to filter the files list.

3. Position the video:

Select the Place Planar Image tool guide to put the video on a planar face or a plane.

Select the Place Wrapped Image tool guide to put the video on a curved face.

Resizing or Repositioning a Video
1. Click the

Select tool or press the S key.

2. Select the video in the Design window or Structure tree.

3. Resize or reposition the video:

• Use the blue knobs to resize the video.

• Use the green knob to rotate the video.

• Drag the video to move it.
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To copy and paste a video, see Cutting, copying, and pasting.

Playing a Video
1. Click the

Select tool or press the S key.

2. Right-click the video in the Design window and select the playback options:

• Play to play the video once.

• Loop to play the video indefinitely.

3. When the video is playing, right-click and select Pause or Stop.

Changing the Transparency of a Video
1. Click the

Select tool or press the S key.

2. Select the video in the Design window or Structure tree.

3. Click Transparency in the Properties panel and move the slider or press - or + to decrease or increase the
transparency.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Place Planar Image positions the video on a plane.

Place Wrapped Image wraps an video onto a curved
surface.

6.1.4. Standard Parts
This section contains the following topics:

6.1.4.1. Downloading TraceParts
SpaceClaim connects you directly to the TraceParts Web, where you can choose from millions of modeled parts.
This service is free of charge with a valid SpaceClaim license.
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Downloading a Part from the TraceParts Web
1. Select TraceParts Web from Standard Part of the Part group of the Assembly tab.
2. Select a part from the categories on the left side of the web page.

A technical drawing is displayed along with a description, PDF documentation, and available part sizes.

3. Select the part you want to download, then choose a CAD format (2D AutoCAD, 3D Acis 6.3, or 3D SpaceClaim )
and click Add to Caddy.

TraceParts directs you to a page with your caddy displayed at the top of the page.

4. (Optional) Select "version for CAD direct export" or 2009+.
5. When the part becomes available in the caddy, click Download.
6. Choose an option for opening or saving the zip file and click OK.

The zip file downloads to your machine. Unzip the file to extract an scdoc and a text file of the part. You can then
open the part in SpaceClaim.

6.1.4.2. Downloading CADENASmodels
You can access and download models from the CADENAS website. Unlike TraceParts, you cannot insert CADENAS
models directly into SpaceClaim.

Using the CADENAS 3DModels button in Standard Part of the Part group of the Assembly tab, you to access their
website, where you can select and download files onto your computer. You can download models in any of their
supported formats.

6.2. Assemble
This section contains the following topics:
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6.2.1. Making Objects Tangent
The Tangent tool enables if a model is loaded, and it aligns two faces so they are tangent or aligns a face tangent
with a line, point, or plane. Possible face types include planes, cylinders, spheres, and cones.

See the printable Assembly constraints reference chart

for descriptions of all assembly constraints.

Click to replay

Note: You can use the Tangent tool to move objects without assigning assembly conditions. If the objects
belong to different components, uncheckCreate conditions in the Assembly Options panel before moving.

Defining a Tangent Condition
1. Click

Tangent in the Assembly group on the Design tab.

The Align tool guide is enabled by default.

2. Select an edge or face of the component that you want to move.

You can Ctrl+click to select multiple objects.

The Reference tool guide is enabled.

3. Select an edge or face of the component that you want to remain stationary.

The components align. You can control the alignment animation with theAnimateFullPullAdvanced SpaceClaim
option.

The constraint is added to the components in the Structure tree.

If you want to align to the other side of the plane, right-click the assembly condition in the Structure tree and
select Reverse Sense.

Doing It Faster
HoldCtrl and select the component that you want to move and the component that you want to remain stationary,
then click

Tangent in the Assembly group on the Design tab.
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To reverse the sense of a tangent condition
Right-click a Tangent condition in the Structure tree and select Reverse Sense to align the components to the
opposite side of the alignment plane.

You can also modify theReversed value to True or False in the Assembly Condition section of the Properties panel.

Defining an Offset Distance for a Tangent Condition
1. Select the Tangent condition in the Structure tree.

2. Change the angle value in the Offset property in the Properties Panel.

Making Objects Tangent without an Assembly Condition
1. Click

Tangent in the Assembly group on the Design tab.

The Align tool guide is enabled by default.

2. Uncheck Create conditions in the Options panel.

3. Select an edge or face of the object that you want to move.

You can Ctrl+click to select multiple objects.

The Reference tool guide is enabled.

4. Select an edge or face of the object that you want to remain stationary.

The components align. You can control the alignment animation with theAnimateFullPullAdvanced SpaceClaim
option.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheAlign tool guide allows you to select the component
to move.

The Reference tool guide allows you to select the
component to remain stationary.

6.2.2. Aligning Objects
TheAlign tool aligns two points, lines, planes, origins, or a combination of these elements. If you select a cylindrical
or conical face, then the axis is aligned. If you select a spherical face, then the center point is aligned. You can define
a ball joint assembly condition using Align by selecting the face of the ball and then the face of the socket. The ball
rotates within the socket no matter where you place the move handle on the ball part.

See the printable Assembly constraints reference chart

for descriptions of all assembly constraints.
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Click to replay

Note: You can use the Align tool to move objects without assigning assembly conditions. If the objects
belong to different components, uncheckCreate conditions in the Assembly Options panel before moving.

Aligning Objects
1. Click

Align in the Assembly group on the Design tab.

The Align tool guide is enabled by default.

2. Select an edge or face of the component that you want to move.

You can Ctrl-click to select multiple objects.

The Reference tool guide is enabled.

3. Select an edge or face of the component that you want to remain stationary.

The components align. You can control the alignment animation with theAnimateFullPullAdvanced SpaceClaim
option.

The constraint is added to the components in the Structure tree.

Note: The Align tool aligns objects within a tolerance of 0.1 mm. This tolerance cannot be modified.

Doing It Faster
Use the Select tool to click the component you want to move, then Ctrl+click the component you want to remain
stationary. Then click

Align in the Assembly group on the Design tab.

Reversing the Sense of an Align Condition
Right-click an Align condition in the Structure tree and selectReverseSense to align the components to the opposite
side of the alignment plane.

You can also modify theReversed value to True or False in the Assembly Condition section of the Properties panel.

471Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Assemblies



Defining an Offset Distance for an Align Condition
1. Select the Align condition in the Structure tree.

2. Change the angle value in the Offset property in the Properties Panel.

Aligning Objects without an Assembly Condition
1. Click

Align in the Assembly group on the Design tab.

The Align tool guide is enabled by default.

2. Uncheck Create conditions in the Options panel.

3. Select an edge or face of the object that you want to move.

You can Ctrl+click to select multiple objects.

The Reference tool guide is enabled.

4. Select an edge or face of the object that you want to remain stationary.

The components align. You can control the alignment animation with theAnimateFullPull Advanced SpaceClaim
option.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheAlign tool guide allows you to select the component
to move.

The Reference tool guide allows you to select the
component to remain stationary.

Examples
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Clicking on the Align assembly condition in the Structure tree highlights the faces.

Pulling one face of the aligned pair changes one object and moves the other.

Pulling an adjacent face has no affect on the aligned pair.

Defining a ball socket using align.

6.2.3. Orienting Objects
The Orient tool enables if a model is loaded, and it rotates components so the selected elements are oriented in
the same direction.

See the printable Assembly constraints reference chart

for descriptions of all assembly constraints.

Click to replay
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Note: You can use the Orient tool to move objects without assigning assembly conditions. If the objects
belong to different components, uncheckCreate conditions in the Assembly Options panel before moving.

Defining an Orient Condition
1. Click

Orient in the Assembly group on the Design tab.

The Align tool guide is enabled by default.

2. Select an edge or face of the component that you want to move.

You can Ctrl+click to select multiple objects.

The Reference tool guide is enabled.

3. Select an edge or face of the component that you want to remain stationary.

The components align. You can control the alignment animation with theAnimateFullPullAdvanced SpaceClaim
option.

The constraint is added to the components in the Structure tree.

Doing It Faster
HoldCtrl and select the component that you want to move and the component that you want to remain stationary,
then click

Orient in the Assembly group on the Design tab.

To reverse the sense of an orient condition
Right-click an Orient condition in the Structure tree and select Reverse Sense to align the components to the
opposite side of the alignment plane.

You can also modify theReversed value to True or False in the Assembly Condition section of the Properties panel.

Defining an Offset Angle for an Orient Condition
1. Select the Orient Direction condition in the Structure tree.

2. Change the angle value in the Offset property in the Properties Panel.

Orienting Objects without an Assembly Condition
1. Click

Orient in the Assembly group on the Design tab.

The Align tool guide is enabled by default.

2. Uncheck Create conditions in the Assembly Options panel.

3. Select an edge or face of the object that you want to move.

You can Ctrl+click to select multiple objects.
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The Reference tool guide is enabled.

4. Select an edge or face of the object that you want to remain stationary.

The components align. You can control the alignment animation with theAnimateFullPullAdvanced SpaceClaim
option.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Align tool guide allows you to select the component to move.

The Reference tool guide allows you to select the component to remain stationary.

Examples

Orienting two components that have an Align constraint on their axes turns the second part you select.

6.2.4. Locking the Orientation and Position of Components
The Rigid tool locks the orientation and position of two components to each other.

See the printable Assembly constraints reference chart

for descriptions of all assembly constraints.

Note: The Rigid tool is enabled when you select appropriate objects that belong to different components.

Defining a Rigid Condition
1. Hold Ctrl and select an edge or face of the two components that you want to remain stationary with each other.

You can also select two components in the Structure tree.

2. Click
Rigid in the Assembly group on the Design tab.

The constraint is added to both components in the Structure Tree.
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6.2.5. Creating Gear Conditions
The Gear tool constrains two objects so one of the objects rotates in response to the rotation of the other object.
Gear conditions can be created between two cylinders, two cones, a cylinder and a plane, or a cone and a plane.

See the printable Assembly constraints reference chart

for descriptions of all assembly constraints.

Note: The Gear tool is enabled when you select appropriate objects that belong to different components.

Defining a Gear Condition
1. Hold Ctrl and select an edge or face of the two component that you want to define as gears.
2. Click

Gear in the Assembly group on the Design tab.

The constraint is added to the components.

Reversing the Sense of a Gear Condition
Right-click a Gear condition in the Structure tree and selectReverse Sense to align the components to the opposite
side of the alignment plane.

You can also modify theReversed value to True or False in the Assembly Condition section of the Properties panel.

Reversing the Rotation Direction of a Gear Condition
1. Select the Gear condition in the Structure tree.

2. Right-click and select Reverse Rotation Direction.

By default, gears rotate in the opposite direction to the gear turning them. You can reverse this to simulate a belt
or chain drive, in which both gears spin in the same direction.
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Examples

Several examples of gear constraints

The animated example shows how anchoring different parts in the assembly affects the behavior of the gears. First
the gray component is turned without anchoring it or the rose components. Then the rose component that is
highlighted is anchored and the gray component is turned. Watch the purple buttons on the rose components to
see the difference.

6.2.6. Anchoring components
The Anchor tool fixes the position of a single component in 3D space.

See the printable Assembly constraints reference chart

for descriptions of all assembly constraints.

Note: The Anchor tool is enabled when you select an appropriate object that belongs to a component.

Defining an Anchor Condition
1. Select an edge or face of the component that you want to remain stationary.

You can also select the component in the Structure tree.

2. Click
Anchor in the Assembly group on the Design tab.
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The constraint is added to the component. If the component is selected with the Move tool, the move handle is
disabled.

To remove the anchor condition, right-click the Anchor object under the component in the Structure tree.

6.3. Edit
The Edit ribbon group contains the following tools:

Use the Select tool to select components for editing. See Selecting Components on page 132 for details.

Use the Move tool to move components. See Moving Parts in an Assembly on page 478 for details.

6.3.1. Moving Parts in an Assembly
You can set up virtual mechanisms by defining mating conditions in your assembly. These relationships are solved
when you move any related part in the assembly.

The example shows a slider mechanism. The purple component is moved in the direction of the black arrow shown
on the left in the image below.

When you move a component that has a mating condition, the Move handle is positioned at the constraint and the
axes that are constrained can't be moved. If the assembly constraints only allow movement in one direction, then
that direction will be automatically selected. For example, if you move a component with a Center Axes assembly
constraint, the Move handle is positioned on the axis and you can only move the component in directions that will
keep the axes aligned.

You can solve assembly mechanisms by changing ruler dimensions or annotation dimensions, and they can be saved
as groups for modification. The images below show movement of the Slider Mechanism assembly that is driven by
a change to the annotation dimension.
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6.4. Managing Configurations
The Configurations group of the Assembly tab allows you to create, copy, and remove views of your models. In
addition to these configuration options, you can use theExplode tool to see views of individual components of your
model and add tracelines between components using the Traceline tool.

Note: Only the default configuration will be passed into Workbench.

Adding a Configuration
1. Click

Add in the Configurations group of the Assembly tab.

If a Configuration other than Default is selected in the drop-down list, the default selection for the Move tool
changes to Component.

2. Rename the Configuration, as desired.

Removing a Configuration
Select a Configuration from the drop-down list in the Configurations group of the Assembly tab, and then click

Remove. Configuration is removed from the drop-down list.

To copy a configuration
1. Select aConfiguration from the drop-down list in theConfigurations group of theAssembly tab, and then click

Copy.

Configuration is copied and added to the drop-down list. By default, the copy is now selected.

2. Rename the copied Configuration, as desired.

Toggling a Configuration as Explodable
1. When a configuration is added, by default it isExplodableas indicated by the open lock icon next to the drop-down

list

.In
explodable mode, any assembly mating constraints are disabled to allow the exploded view.

2. Click the lock icon to disable Explodable and enable assembly mating constraints. The icon changes to a closed

lock .
3. Clicking the lock icon toggles between explodable and not explodable.

Exploding an Assembly
1. Select a Configuration other thanDefault from the drop-down list in theConfigurations group of theAssembly

tab. Be sure the configuration is Explodable.If no such configuration is available, click
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Add to create a Configuration.The name of the top-level assembly in the Structure tree will be renamed to
indicate an exploded view.

2. Click
Explode.The tool guides for selecting an assembly is enabled.

3. With theSelectSubassemblyToExplode tool guide, select the assembly to be exploded. The selected assembly
will be highlighted with a shaded bounding box in the Design window. Hidden components are ignored when
exploding.

The tool guide for setting the direction of explosion is enabled.

4. With Select Explosion Direction

selected, select an edge, axis, or origin axis to set the direction of the explode.

An exploded preview is displayed using bounding boxes.

Tool guides to reposition the exploded view (optional) or complete the explosion are enabled.

5. (Optional) Use the arrows or the anchor to reposition the exploded components relative to the rest of the model.

Use the Move Exploded Components tool guide

to drag the exploded view in the direction of the arrows.
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Use the Anchor Component tool guide

to lock the position of one component. All others will be moved relative to the anchor in the exploded view.

6. Set the spacing for the exploded view in the Options-Explode panel. The default Spacing is Normal, but other
options are available : Custom, Close, Normal, and Wide.

Custom uses the slider in the Options panel to set the spacing visually for your exploded components.

7. Click Complete

.

NOTE: You cannot disable the exploded view and reapply any assembly mating constraints using the Exploded
lock tool on an exploded configuration. You should create a new configuration in that case.

(Optional) Use the Level option in the Options-Explode panel to set the number of assembly levels to explode.

The default Level 1 will explode only the selected assembly. Selecting a higher Level will explode sub-assemblies,
if they exist, under the selected assembly in the Structure tree.
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Bodies need to be inside components in order to be exploded. In this example, each body in the Shaft assembly was
in its own component whereas all bodies in the Housing assembly were in a single component.

Explode Tool Group Items Together
The Explode tool will automatically group certain items together during an explode. This option automatically
groups items by centers, ensuring that components that share the same axis are moved together. In the example
below, the wheels and axles are not in subassemblies, but you would want them to explode together.
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Changing Configurations for Individual Drawing Views
1. Select an individual Drawing View in the Structure Tree.
2. Select a Configuration in the Configurations section of the Assembly tab for the selected view.

Note: Drawing Views and Sheets with active configurations can be deleted.

Section and Detail Views, which are created based on an existing view, will synchronize with the
Configuration assigned to the parent view.
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Tracelines can be added to the exploded views of your model.

Adding Tracelines

1. Click
Traceline in the Configurations section of the Assembly tab.

2. Use Select 1st reference face

to select the reference face to start the traceline.

3. Use Select 2nd reference face

to select the reference face to end the traceline.
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4. Click Complete

.
Traceline is drawn between the two closest points of the two selected faces.

Note: To delete a traceline, click it and click Delete.

Controlling Traceline Appearance
You can control how tracelines appear in your model by setting affiliations.

The following affiliation behaviors occur by default.

• New Tracelines are affiliated with all existing Configurations.
• Existing Tracelines are automatically affiliated with new Configurations.
• Copied Configurations inherit Traceline affiliations.

Traceline affiliations are controlled in the Properties panel.

1. Select a traceline.

2. Change its affiliation using the drop-down in the Properties panel.

When set to False, the selected traceline is hidden in that configuration.

3. When in the Traceline tool, all tracelines are shown. Tracelines not affiliated with the current configuration are
dimmed.
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Moving a Traceline
When you select a traceline, the highlighting is more pronounced and drag handles appear at the ends and corners.

Click and drag a corner handle to move a segment.

Click and drag an end to move it to a new face.

Note: For cylindrical faces, the end point appears on the traceline at the point that is closest to the other
selected face.
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Move Tool in the Assembly Tab
When a non-default Configuration is active,

Move in the Edit group of the Assembly tab is enabled. Its icon indicates that it is in Select Component mode.

Also, while a non-default configuration is active,

Move in other ribbon tabs has the Select Components tool guide active.
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7: Facets

SpaceClaim has tools that allow you to prepare models for Additive Manufacturing, that is, 3D Printing.

3D Printers use STL files to build up a model in layers. The Facets tab contains tools for working with facets and preparing
them for export to a 3D printer.

• Working with faceted bodies describes the options available for working with faceted bodies.

• Selecting Facets describes the options available for selecting facets and modifying the selection.

The ribbon is organized in groups of tools that, from left to right, step through the process of creating a Faceted body for
the printer.

• Cleanup has tools that remove defects which can cause problems for downstream operations.
• Organize has tools for separating and joining disconnected facet regions (for example, shells).
• Modify has tools for working with facet geometry.
• Adjust has tools for smoothing facets, reducing the number of facets, and making the facets more uniform.
• Inspect has tools for measuring thickness and finding overhangs.
• Create has tools for previewing the faceted body.
• Edge Display has toggles for displaying:

º Internal facet edges are shared by two connected facets
º Open facet edges belong to one facet
º Over-connected facet edges are connected to three or more facets and cannot be resolved by 3D printers

7.1. Selecting Facets
You can select facets and then modify the selection using the following tools in the Select group in the Facets tab.
The drop-down menu on theSelectoption also allows you to select facetsUsingBox,Using Lasso,UsingPolygon,
or by Using Paint. You can also choose to Extend Facets Selection or Select Facets by Geometry, which enables
the transfer of selections from one body to another.

Use the Expand tool to add an additional row of facets around the current selection.
Clicking this tool multiple times allows you to expand the selection by one row each
click.

Use the Shrink tool to reduce the current selection by one row of facets. Clicking this
tool multiple times allows you to shrink the selection by one row each click.

Use the Fill tool to select all remaining facets that are bounded by the current selection.

Using the Expand Tool
The Expand tool lets you select additional rows of facets around the current selection.

To expand facets:

1. Select facets.
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2. Click Expand

to select a row of facets around the current selection.

Using the same steps above, facet edges can be expanded to adjacent triangles.
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Facet vertices can also be expanded to adjacent triangles.

Using the Shrink Tool
The Shrink tool lets you reduce the current selection by one row of facets.

To shrink facets:

1. Select facets.
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2. Click Shrink

to reduce the current selection by one row of facets.

Using the Fill Tool
The Fill tool selects all remaining facets that are bounded by the current selection.

To fill facets:

1. Select facets.

2. Click Fill

to select all remaining facets.
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Note: If the Fill adds less than five facets, a warning is issued.

Using a Slider to Adjust Selection
After double-clicking a facet, a slider can be used to adjust the initial selection.

1. Double-click facets.

2. Move the slider up and down to adjust the initial selection.

The selected facets can be added to a group. The slider will be dismissed after triple-clicking the facet selection.

To deselect facets, select facets with Box-Select or the Double-Click Slider.
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While holding Ctrl, use the Double-Click Slider to unselect facets.

Selecting Facet Edges
In addition to selecting facets, you can select facet edges and edge loops.

Use Shift+Double-click on sharp (>60°) internal edges that form an isoline (edges that are nearly continuously
tangent to each other as the line propagates).
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The selection will be the best polyline found and not necessarily a complete loop. As you can see in the image below,
the selection stops at the cylinder because adjacent edges are not within the tolerance (<10°) to be considered
tangent.

Use Ctrl+Shift+Double-click on sharp edges to select multiple mesh edge isolines.

Double-click the Boundary mesh edges to highlight and select the boundary edges

7.2. Faceted Body Cleanup
3D Printing requires that the faceted body be watertight and free of self-intersecting facets, or other defects. The
Cleanup tools identify and fix facet defects.

The Cleanup group in the Facets tab contains the following tools for finding and fixing problems in faceted bodies.

Use the Check Facets tool to list problems with the faceted body that will adversely affect
the 3D Printing process.
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Use the Auto Fix tool to automatically search for, and fix any facet defects.

Use the Shrinkwrap tool to create a faceted wrapper that closes gaps, around the model.

Use the Holes tool to find and fix holes in faceted bodies.

Use the Intersections tool to highlight areas of self-intersection.

Use the Fix Sharps tool to find and fix sharp spikes that need to be flattened.

Use the Over-Connected tool to find and fix facets connected to too many other facets.

Note: Additive Manufacturing technology is capable of producing interior voids (enclosed, hollow spaces)
that would not be possible with traditional manufacturing methods. Depending on the additive process
used, the void may contain unused resin, powder, or support materials. If voids need to be in the finished
part, it is good practice to build it in halves or add access holes to remove the unused materials.

7.2.1. Automatically Cleaning up Faceted Bodies
The Check Facets and the Auto Fix tools are quick ways to find and fix problems in faceted bodies.

Using the Check Facets Tool
Use the Check Facets

tool to list problems with the faceted body that will adversely affect the 3D Printing process.

Problems detected include the following:

• Multiple pieces (facet regions or shells)
• Non-watertight facets
• Self intersections
• Over-connected (non-manifold) edges

To check facets:

1. Select a Faceted body in the Structure tree.

2. Click the Check Facets tool.

A dialog appears listing any issues found.

3. Click Zoom to fit in the dialog to zoom in on selected problems in the list.

The Check Facets tool can also be used in an Action-Object workflow by entering the tool and then selecting the
faceted body.
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Using the Auto Fix Tool
Use the Auto Fix

tool to automatically search for, and fix any facet defects. Geometry operations performed by the tool do not remove
Named Selections. The Auto Fix tool performs the following sequence:

1. Fix self-intersections
2. Close holes using the methods described the find and fix example below.

• If there is surrounding curvature, the hole is closed using the Patch method.
• If the surrounding edges are approximately planar, the hole is closed using the Cap method.

3. Recheck for self-intersections
4. Fix self-intersections
5. Remove void shells
6. Fix inverted normals
7. Fix non-manifold edges and vertices

To use Auto Fix on a faceted body:

1. Click the Auto Fix tool.

2. Select a faceted body in the Graphics window.

The problem areas are fixed.

7.2.2. Shrinkwrapping
The Shrinkwrap tool creates a faceted wrapper around the selected solid or faceted bodies. You can wrap a single
body or several bodies. For example, if you have an assembly with multiple parts fastened together but there are
small gaps between the component parts, the Shrinkwrap tool allows you to create a single, faceted model that
closes such gaps.

Creating a Shrinkwrap
1. Select the Shrinkwrap tool

and select a solid or faceted body. The initial size is chosen based on the size of the selected body.

The foot model used in this example, is a faceted model from scanned data. Notice that there are many tiny facet
regions and small gaps between the bones of the foot.
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2. Change the Shrinkwrap Options as desired.

3. (Optional) Select faces where the shrinkwrap will fit tightly using theSelectTight-Fit FacesorFacets tool guide.

4. Click Complete to create the Shrinkwrap.

The completed shrinkwrap is shown below. Notice how the tiny facet regions have been wrapped into a single
faceted body.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Bodies tool guide is active by default. It allows you to select solid or
faceted bodies to shrinkwrap.

The Select Tight-Fit Faces or Facets tool guide allows you to select faces where
the shrinkwrap will fit tightly.

The Complete tool guide completes the shrinkwrap.

Zoom Legend
The Zoom Legend appears at the lower-right of the screen. If the zoom legend is on before entering this tool or is
enabled while using this tool, it will remain on when exiting the tool.

Tool Options
The following options are available for shrinkwrapping:

Enter a value for the average facet size that will be used for shrinkwrapping.
Distances under this size may be walked over, while distances above this size will
be considered acceptable and will not be closed.

Size

When enabled, the original faceted bodies will not be removed after the Shrinkwrap
is created.

Keep original bodies
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When enabled, this keeps hard edges and doesn't smooth them. Set the Angle
threshold which decides which edges to keep.

Preserve features

Enter an angle, in degrees, that determines the smoothness of the shrinkwrap.
Facet angles above the threshold will not be smoothed by the shrinkwrap.

Angle threshold

Specify a facet size (smaller than the Size) to apply to selected facets. This allows
you to refine the shrinkwrap locally.

Secondary size

Enable this option to make the triangles conform more to the shape with different
sized triangles based on curvature. Specify the maximum triangle size for curvature
dependent faceting.

Max size

Specify the curvature angle for curvature dependent faceting. The curvature angle
sets the facet-to-facet angle limit for the facets to conform to the curvature.

Curvature angle

Shrinkwrap - Examples

Using the Select Tight-Fit Faces or Facets tool guide
Use the Select Tight-Fit Faces or Facets

tool guide to control shrinkwrap facets in selected areas.

The following simple example shows how the tool guide works.

Click the Select Tight-Fit Faces
or Facets tool guide and
double-click the top face. This face
will be tightly fit in the shrinkwrap.
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Notice that the facets fit tightly on
the selected face. It is important
to note that the controlling effect
falls off as a function of distance
from the selected area.

Using a Secondary Facet Size
Secondary size is more useful for refining the shrinkwrap to preserve the initial shape. An example is shown below.

This faceted model has a distinct profile shape.

Using the default size and no Secondary size specified,
Shrinkwrap produces a very rough approximation of the profile.

1. Enable theSecondarysizeoption and specify a smaller value
for Secondary size.

2. Click the Select Tight-Fit Faces or Facets tool guide and
select facets around the profile to apply the secondary size.
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Click Complete and see that the secondary size follows the
profile.

Using Shrinkwrap for Curvature Dependent Faceting
Use the Shrinkwrap options to make the triangles conform more to the shape with different sized triangles based
on curvature.

Original faceting
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Faceting after shrinkwrap using Max
size and Curvature angle. Larger
triangles can be seen on the forearm
and smaller triangles by the nails where
curvature is greater.

7.2.3. Fixing Facet Intersections
Self-intersecting facets can cause problems for 3D printing. Use the Intersections tool to highlight areas of
self-intersection.

Checking for Intersections

1. Select the Intersections tool.

2. Select a Faceted body in the Graphics window.

Areas of self-intersection are highlighted. The model is also made transparent if any intersections are found.

3. Click Complete to fix the intersections.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Complete tool guide fixes any intersections found.

7.2.4. Fixing Over-Connected Facets
Over-connected facets cannot be 3D printed. There can be over-connected edges and over-connected vertices.
Over-connected edges are facet edges that are shared by more than two facets. In the image below, two bodies
share a single edge which means the shared edge belongs to four facets. In this case, the vertices at the end of the
edge are also over-connected because there is no volume beneath them.

Finding and Fixing Over-Connected Facets
1. Select the Over-connected

tool.

The tool finds any over-connected facets and highlights them.

2. Select highlighted areas to fix using the Select Problem tool guide.

3. Exclude problem areas using the Exclude Problem tool guide.

4. Use the Select Geometry tool guide to select geometry that is not a problem.

5. Click Complete to fix all remaining areas.

When the Over-connected tool is used on the example shown above, it creates a small faceted volume around the
over-connected edge. The image below shows the result when zoomed-in to the edge.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelect Problem tool guide is active by default. This tool guide allows you to select and fix problem areas
that are automatically found by the tool.

The Select Geometry tool guide allows you to select geometry that was not found as a problem area.

The Exclude Problem tool guide allows you to exclude areas from selection and fixing.

The Complete tool guide fixes all remaining problem areas.

7.2.5. Fixing Holes
You can find and fix holes using the Holes tool. It works like other Find-and-Fix tools in the Repair tab.

Finding and Fixing Holes in Faceted Bodies

1. Select the Holes tool to find and highlight holes.

The tool highlights holes that can be filled.

2. Set any of the Options described below as needed.

3. Use the Select Problem

tool guide to holes to fill.

4. Click Complete

to fill all holes or the selected holes.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
geometry not highlighted by the tool

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Select Guide Curves tool guide allows you to select
curves to influence the shape of the patch.

The Exclude Regions allows you to exclude regions in
multi-region patches.

The Complete tool guide fixes all remaining problem
areas.

Tool Options
The following options are available to control how holes are filled:

Attempts to match the contour of the surrounding facets.Patch

Creates a simple cap over the opening.Cap

Considers multiple openings together.Together

Considers multiple openings separately.Separately

Examples - Fixing Holes
The following example shows the use of a few of the tool guides and the Cap option.

Click the Select Geometry tool guide and select the
contour.
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The preview shows that the default patch will not
produce an angled face.

Click the Select Guide Curves tool guide and select
the curves, or Alt-select them. notice that the preview
now goes through the curves.

With the Select Guide Curves tool guide active, it is
considered sticky (as if the Ctrl key were being held
down) to allow multiple selection and selection
toggling.

Clicking Complete shows that the face is not flat.

To make it flat, Undo the fill and use the Exclude
Regions tool guide to exclude the angled face.

Notice that the excluded region is shown in a dim gray
to indicate it will not be included.
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In the Options panel, set the Cap option. Then click the
SelectProblem tool guide and the select the remaining
loop.

Click Complete.

The following examples show the use of the Together and Separately options.

Two loops on the outside of a sphere is a case that should be
filled together, as they are both intended to be occupying the
same physical space (that is, the outside of the sphere).
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The Together option ensures that the patch completes the
shape.

If the Separately option is used, the gap is closed (one at a
time) so a loop and a separate surface remains.

This shelled bowl is an example where theSeparatelyoption
is more likely to be used.
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The Separately option ensures that each patch completes
the surrounding shape both outside and inside.

TheTogetheroption considers the surrounding shape of both
holes at the same time and transitions between the two holes.

7.2.6. Fixing Sharps
Faceted bodies may contain sharp spikes that need to be flattened. You can use the Fix Sharps tool to find and fix
any sharps in the mesh. It works like other Find-and-Fix tools in the Repair tab.

Finding and Fixing Sharps
1. Select the Sharps tool

.

2. Based on the options settings, if any sharps are found, they are highlighted.
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Convex and concave sharps are found.

3. (Optional) Change the option settings as needed.

4. Use the Select Problem tool guide to select and fix individual sharps.

The concave sharp is flattened.

5. Use the Exclude Problem tool guide to exclude problem areas.

6. Use the Select Geometry tool guide to select geometry not found as a problem area.

7. Click Complete to fix all remaining highlighted sharps.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.
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The Select Geometry tool guide allows you to select
geometry that was not found as a problem area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide fixes all remaining problem
areas.

Tool Options
The following options are available to control how sharps are fixed:

This applies to the angle between normals of facets that share an edge. Any edges
with an edge angle greater than the specified angle will be found.

Sharp edges

This applies to the angle between normals of any two facets that share a vertex. Any
vertices with an angle greater than the specified angle will be found.

Sharp vertices

Convex sharps are found. These are sharps that point outward.Convex

Concave sharps are found. These are sharps that point inward.Concave

7.3. Organizing Faceted Bodies
The Organize group has the following tools for organizing faceted bodies and regions.

Use theSeparate tool to separate each disconnected faceted region of a faceted body into individual faceted
bodies. A typical use of this tool is to separate the inner and outer regions of a shelled faceted body.

Use the Separate All tool to separate all of the faceted bodies in the design that have multiple disconnected
regions into individual faceted bodies. This would be used for designs with multiple shelled faceted bodies.

Use the Join tool to combine multiple faceted bodies into a single body and stitch them together when
possible..

A single faceted body can have any number of regions. A common example is a shelled faceted body which has both
an inner and an outer faceted region in one body. Another example can be created by saving a SpaceClaim model,
which contains several separate solid bodies, as an STL file. It gets imported in SpaceClaim as a single faceted body
but has several separate facet regions.

Using the Separate Tool
1. Select the Separate tool

.

2. Use the Select Shells tool guide to select a shelled faceted body and separate it.

3. Use the Select Meshes tool guide to select a faceted body with disconnected regions and separate them.

4. Select a facet shell or facet region.

The selection is then converted to a separate faceted body.
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Example
The image below shows a shelled faceted body. The section view shows the interior and exterior regions.

After separation, there are two faceted bodies. The image below shows the interior faceted body highlighted.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Shells tool guide is active by default. Use it
to select a shell and separate it from its faceted body.

Use the Select Faceted Bodies tool guide to select a
faceted body and separate it into pieces.

Tool Options
The following options are available to set the type of regions to include:

Include over-connected facet regions (regions joined at
a single edge or point)

Over-connected

Include only normally connected facet regionsConnected
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Using the Separate All Tool
Click the Separate All tool

or right-click a faceted body in the Structure Tree and click Separate All.

All facet regions, in all facets bodies, are converted to separate facets bodies.

The image below shows a simple example of a single faceted body with multiple disconnected regions.

Using the Join Tool
1. Click the Join tool

.

2. Use the Select Faceted Bodies tool guide to join selected bodies one-by-one.

a. Select a body to serve as the target. All subsequently selected bodies will be joined to the target.

b. Select bodies to join to the target.

3. Use the Select Target Mesh tool guide to join all facets bodies to the selected target body.

a. Select the target body.

b. All other faceted bodies are automatically joined to the target.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelectFacetedBodies tool guide is active by default.
Use it to select faceted bodies to join one-by-one. The
first body selected is the target to which all other selected
bodies are joined.

Use theSelectTargetFacetedBodies tool guide to select
a target faceted body. All other faceted bodies are then
automatically joined to the target body.
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7.4. Modifying Faceted Bodies
TheModify group contains tools for combining, splitting, shelling, scaling, and thickening faceted bodies. The table
below summarizes the tools.

Use the Merge tool to combine two faceted bodies into
a single body.

Use the Subtract tool to subtract an intersecting region
from one faceted body using the other intersecting
faceted body.

Use the Intersect tool to create a new faceted body from
the intersecting region of two faceted bodies.

Use the Split tool to split a faceted body using a cutter.

Use the Shell tool to create a thin wall on a closed faceted
body.

Use the Scale tool to scale the selected faceted body
relative to a selected point.

Use the Thicken tool to add thickness to a faceted surface
body.

7.4.1. Merging Faceted Bodies
The Merge tool combines two faceted bodies, or a faceted body and a solid body.

Merging faceted bodies is a boolean operation similar to the Combine tool in the Design tab.

For Boolean tools, ensure that:

• The first faceted body you select is altered by the second
• The second faceted body is "consumed" by the first
• After the operation, the first faceted body is still in the Structure tree but the second is not
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Using the Merge Tool
1. Select the Merge tool

.

2. Select the first faceted body.

The first faceted body is highlighted in blue

3. Select the second faceted body or a solid body.

The two bodies are merged into one.

If a solid body is merged with a faceted body, the solid body is converted to a faceted body

The Merge tool also works on two Open faceted bodies to automatically create the union that produces a single,
closed faceted body. An example would be two halves of a shelled body merged into a closed shelled body.

Patterned components are up-selected in the Boolean tools. In the example below, the cylinders were made as a
pattern. Highlighting one pattern member highlights the entire pattern.

Tool Options
The following options are available to control how bodies are merged:

Retain the original bodies after the intersection.Keep original bodies

7.4.2. Subtracting Faceted Bodies
The Subtract tool removes the intersecting region between two faceted bodies, or a faceted body and a solid body.
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Subtracting faceted bodies is a boolean operation similar to the Combine tool in the Design tab.

For Boolean tools, ensure that:

• The first faceted body you select is altered by the second.
• The second faceted body is "consumed" by the first.
• After the operation, the first faceted body is still in the Structure tree but the second is not.

Using the Subtract Tool
1. Select the Subtract tool

.

2. Select the first faceted body.

The first faceted body is highlighted in blue.

3. Select a second faceted body or a solid body to use as a cutter, or box-select multiple cutters.

The second body is subtracted from the first.

Patterned components are up-selected in the Boolean tools. In the example below, the cylinders were made as a
pattern. Highlighting one pattern member highlights the entire pattern.

Tool Options
The following options are available to control how bodies are subtracted:
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Retain the original bodies after the intersection.Keep original bodies

Retain the cutter body after the operation is complete.Keep cutter

7.4.3. Intersecting Faceted Bodies
The Intersect tool creates a new faceted body from the intersecting portion of two faceted bodies, or a faceted body
and a solid body.

Intersecting faceted bodies is a boolean operation similar to the Combine tool in the Design tab.

For Boolean tools, ensure that:

• The first faceted body you select is altered by the second.
• The second faceted body is "consumed" by the first.
• After the operation, the first faceted body is still in the Structure tree but the second is not.

Using the Intersect Tool

1. Select the Intersect tool .

2. Select the first faceted body.

The first faceted body is highlighted in blue.

3. Select the second faceted body, or a solid body.

The two bodies are intersected.

Patterned components are up-selected in the Boolean tools. In the example below, the cylinders were made as a
pattern. Highlighting one pattern member highlights the entire pattern.
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Tool Options
The following options are available to control how bodies are intersected:

Retain the original bodies after the intersection.Keep original bodies

7.4.4. Splitting Faceted Bodies
Faceted bodies can be split using a plane or surface as a cutter.

Splitting a Faceted Body
1. Click the Split tool.

2. Select a faceted body.

The selected faceted body highlights in blue.

3. Choose a Cap option (see images below).

4. Select a plane, or surface, to use as a cutter.

5. The faceted body is split into two separate faceted bodies.
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The images below show examples of the different options.

Cap With Internal PointsCapNo Cap

Tool Options
The following options are available to control how bodies are split:

Leave an opening after the split.Don't cap

Cap the opening that results from the splitCap

Cap the opening that results from the split but use extra
points in the interior of the cap to produce better
triangles.

Capwith internal points

7.4.5. Shelling Faceted Bodies
Use the Shell tool to add thickness on the inside or outside of a faceted body.
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Shelling a Faceted Body
To shell a faceted body:

1. Click the Shell tool .

2. Select a faceted body.

3. Click Complete.

The Shell is added and a new faceted body is shown in the Structure Tree

Tool Guides - Simple Shell
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelect Solid or FacetedBody tool guide is active by
default. It allows you to select solid or faceted bodies to
shell.

The Select Geometry tool guide allows you to select
geometry or facets to be removed when shelling.

The Complete tool guide completes the shell.

Zoom Legend
The Zoom Legend appears at the lower-right of the screen. If the zoom legend is on before entering this tool or is
turned on while using this tool, it will remain on when exiting the tool.

Tool Options
The following options are available to control how bodies are shelled:

Remove material inside and leave a thin wall to the inside
of the original body.

Inside

Remove material inside and leave a thin wall to the
outside of the original body.

Outside

Enter a value for the shell thickness in model units.Thickness
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Create a new shelled faceted body and retain the original
body.

Keep original bodies

Choose the type of infill structure to be created for adding
strength to the shelled body when it is 3D printed.

Infill Type

Allows you to create variable Lattice Infills that distribute
material based on the Density Attributes from lattice
optimization workflows in Workbench. More material is
concentrated in regions of high density and less material
is in low density regions.

Note: This option is only available when the
model contains Density Attributes from
Workbench.

Use density attributes

Example using the Select Geometry tool guide
A simple block will be shelled.

Using the Select Geometry tool guide, the top face is
selected for removal.
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ClickCompleteand the block is shelled with the top face
removed.

You can also select facets to remove from the shell. Here,
instead of removing the face, only the selected facets
will be removed.

Now the shell is a little more interesting.

Tool Guides - Basic Infill
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelect Solid or FacetedBody tool guide is active by
default. It allows you to select solid or faceted bodies to
shell.

The Select Geometry tool guide allows you to select
geometry or facets to be removed when shelling.

The Complete tool guide completes the shell.
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Basic Infill Tool Options
When you set the Infill Type to be Basic, the following options are available to control the infill:

The infill shape options are separated into three groups,
with multiple options in each. See Extrusions, Lattices,
andMinimalSurfacesbelow for descriptions of the infill
shapes available.

Shape

The sizing options are linked. Changing one will adjust
the others.

Sizing Options

Percentage of the shell volume filled by materialFill %

Determines the size of the basic shapes used in the infill
pattern

Length

Sets the infill wall thicknessThickness

Allow you to control how the preview is displayed and
positioned

Preview Options

Choose the X, Y, Z axis, or the Screen to set the preview
direction.

Direction

Use the dropdown slider to drag the preview along its
normal direction. Use the Reset button to go back to the
previous location.

Offset

Shelling and Adding Infill Using Basic Shapes
Printing the model could take a long time and a lot of material, if the entire volume is filled.

Infill lets you shell the interior of a model and add an internal support structure. This provides strength while reducing
material costs and printing time.

The tool has several options for controlling the size, shape and percentage of the volume filled.

To shell by adding an infill using basic shapes:

1. Select the Shell tool.
2. Set the Thicken direction to Inside.

3. Set the Thickness of the shell wall.

4. Choose whether or not to keep the original Faceted Body after it is shelled.

5. Choose the Basic option.

6. Select the Faceted Body to shell.

7. Choose an Infill Shape.

• Use the drop-down list to select a group - Extrusions, Lattices, or Minimal Surfaces.

• Select a desired infill shape.

8. Set the Infill Size options.

9. Adjust the Preview.

• Choose a Preview Direction (X, Y, or Z).
• Use the Offset slider to move the preview section along the Preview Direction.
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• Click the Reset button to go back to the original Offset location.

10. Click Complete.

The Shell is added and a new Faceted Body is shown in the Structure Tree.

The images below show preview for Square and Hex Infill shapes.

The Y-axis is chosen for the preview Direction and the Offset was adjusted to place the preview near the middle of
the model along the Y-axis.

The image below shows the model shelled with a Hex infill. The body was split and moved to expose the Infill.

The image below shows the model shelled with a 3D lattice infill.
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Note: Lattice infills are sensitive to the coarseness of the faceting. Coarse facets produce lattice infills faster.
Coarseness is controlled when you convert a solid body to a faceted body using the Convert tool. When
converting, use a Maximum Angle in the neighborhood of 30° to get fewer facets and speed up the lattice
calculations.

Basic Infill Shapes

Extrusions
Square

Extruded square grid.
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Triangle

Extruded triangle grid.

Hex

Extruded hexagonal grid.

3D Hex

3D hexagonal grid similar to honeycomb
structures. Cross-sections alternate between
hexagons and square.

Lattices
Select a Lattice structure and Lattice trimming option.
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Lattice

Three dimensional lattice infill pattern

Regular Cube Lattice

Simple cube lattice infill pattern

Cube Lattice With Center Supports

Cube lattice with supports from all corners of the
cube intersecting at the center of the cube
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Cube Lattice With Side Cross Supports

Cube lattice with cross supports between edges
on each face of the enclosing cube

Cube Lattice With Side Diagonal Supports

Cube lattice with diagonal supports between
vertices on each face of the enclosing cube

Cube Lattice With Bottom Center

Cube lattice with supports that meet at the bottom
face center of the enclosing cube
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Cube Lattice With Bottom Center Without
Vertical Supports

Cube lattice with supports that meet at the bottom
face center of the enclosing cube but without
vertical supports

Double Pyramid Lattice

Double pyramid lattice with lateral supports

Double Pyramid Lattice With Cross

Double pyramid lattice with internal cross
supports
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Diamond Lattice

Double pyramid without the lateral supports

Double Pyramid Lattice And Face Diagonals

Double pyramid in the center of the lattice with
diagonals on faces of the enclosing cube

Octahedral-1
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Octahedral-2

Tetrahedral Faceted Lattice

Boundary conforming lattice structure, where the
lattice elements follow the edges of tetrahedra.

Triangle Surface Faceted Lattice

Uniform surface lattice, smoothly connected at
the vertices with triangular holes.
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Hexagon Surface Faceted Lattice

Smoothed Voronoi dual to the triangular surface
mesh. Holes are on average hexagonal.

Select a lattice trim option:

None: No explicit trimming is done. The
internal lattice structure is trimmed by
the original part, which may leave
dangly lattice pieces that are not
connected to other lattice pieces
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Remove partial segments: trims the
dangling pieces back so that every
lattice has at least two lattice edges
ending in it.
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Boundary conforming: builds a
Triangular Lattice between the surface
of the geometry shell and the interal
lattice structure.

NOTES:

• The Boundary conforming and Remove partial segments options are not available for the following lattice
types, since they are already boundary conforming by design.

º Tetrahedral Faceted Lattice
º Triangle Surface Faceted Lattice
º Hexagon Surface Faceted Lattice

• Lattice trimming is not available for the three dimensional infill pattern "Lattice".

Minimal Surfaces
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Gyroid

Belongs to Triply Periodic Minimal Surfaces.

Schwarz P

Two intertwined congruent labyrinths, each with
the shape of an inflated tubular version of the
simple cubic lattice.

Schwarz D

Two intertwined congruent labyrinths, each
having the shape of an inflated tubular version of
the diamond bond structure.
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Neovius

A triply periodic minimal surface, dividing space
into two infinite non-equivalent labyrinths.

Lidinoid

A triply periodic minimal surface similar to a
gyroid.

You can choose to add a smooth transition from the minimal surface infills to the boundary of the original part.
Select Boundary transition and specify an appropriate value for Radius to add a smooth blend to the boundary.

Tool Guides for a Shell with Custom Infill
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelect Solid or FacetedBody tool guide is active by
default. It allows you to select solid or faceted bodies to
shell.

The Select Geometry tool guide allows you to select
geometry or facets to be removed when shelling.
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TheSelectSketch tool guide allows you to select a sketch
to be used as the custom infill shape.

The Complete tool guide completes the shell.

Custom Infill Options
When you set the Infill Type to be Custom, the following options are available to control the infill:

Choose a Square Grid pattern or Rectangular Grid patternPattern

Sizing Options

When you choose this option, you enter a length for
scaling the selected custom infill shape. This allows you
to increase or decrease the size of the custom shape. The
option is Off by default, which uses the custom shape
as-is.

Scale to Fit

Sets the infill wall thicknessThickness

Fill Options

The selected shape will be filled with material leaving
voids between the shapes.

Fill Shape

The space between the shapes will be filled leaving a void
in the interior of the selected shape.

Fill Spaces

Shelling and Adding Infill Using Custom Shapes
You can also use Custom shapes for the Infill. In the examples below, the "X" shape will be used as a Custom Infill.

1. Click the Shell tool.

2. Set the Thicken direction to Inside.

3. Set the Thickness of the shell wall.

4. Choose whether or not to keep the original Faceted Body after it is shelled.

5. Choose the Custom option.
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6. Select the Faceted Body to shell.

7. Click the Select a Sketch tool guide.

8. Select the sketched shape to use as the infill.

9. Choose an Infill a Square Grid or Rectangular Grid pattern.

10. Set the Sizing.

11. Choose what to Fill (void between shapes or the shape itself).

12. Click Complete.

The Shell is added and a new Faceted Body is shown in the Structure Tree.

The images below show some examples.

The "X" shape in the lower left corner is chosen as the
custom infill.

Scaled to fit is used with a larger dimension to create a
larger space between shapes.

Fill Shapewas chosen to fill the custom shape and leave
a void between shapes.

The "X" shape in the lower left corner is chosen as the
custom infill.

Scaled to fit is NOT used so the shape is applied as-is,
which creates and a smaller space between shapes.

Fill Shapewas chosen to fill the custom shape and leave
a void between shapes.

7.4.6. Scaling Faceted Bodies
Faceted bodies can be scaled smaller or larger relative to a selected point.
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Scaling a Faceted Body
1. Click the Scale tool

.

2. (Optional) Toggle on/off the scaling directions in the Options panel to scale non-uniformly.

3. Select the faceted body (or bodies) in the Graphics window.

4. Select a point on the faceted body to scale about.

5. Drag to change the scale, or press the Spacebar and specify a scale value.

You can also scale the faceted body using the Pull tool.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Scale faceted body tool guide is active by default.
This tool guide allows you to select faceted bodies to be
scaled.

The Select point tool guide allows you to select a point
to scale about.

Tool Options
The following options are available to control scaling:

You can toggle On/Off the X, Y, and Z directions to scale
non-uniformly. All directions are On by default for uniform
scaling.

Scaling directions

7.4.7. Thickening Faceted Bodies
Use the Thicken tool to add thickness to a surface faceted body.
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Thickening a Surface Faceted Body
1. Create or import a surface faceted body.

2. Select the Thicken tool

.

3. Choose a thickening Direction in the options panel and enter a thickness value in the options panel.

4. Select the surface faceted body.

5. Exit the tool or Undo, change the options, and reselect the surface faceted body.

Tool Options
The following options are available to control thickening:

Add thickness to the inside.Inside

Add thickness to the outside.Outside

Add thickness in both inward and outward directions.Both

Enter the total thickness value in model units.Thickness

Fix intersections that occur because of the thickening.Fix intersections

Zoom Legend
The Zoom Legend appears at the lower-right of the screen. If the zoom legend is on before entering this tool or is
turned on while using this tool, it will remain on when exiting the tool.

7.5. Adjusting Facets
The Adjust group contains tools for smoothing facets, reducing the number of facets, and making facets more
uniform (Regularize).

Use the Smooth tool to smooth out rough facet regions.

Use the Reduce tool to reduce the number of facets in a
faceted body.
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Use the Regularize tool to make the aspect ratios of
selected facets more consistent.

Smoothing Facets
The Smooth tool is typically used on imported faceted bodies.

Smoothing Facets or a Faceted Body
1. Select the Smooth tool

.

2. Change the Smooth Options if desired.

3. Select facets or a faceted body.

4. Click Complete to smooth the selection.

5. You can continue to click Complete to further smooth the facets.

You can also select facets or a faceted body and then select the Smooth tool.

Tool Options
The following options are available for smoothing facets:

Determines if an angle stays sharp or gets smoothed.Angle threshold

Determines which of the following algorithms is used for
smoothing.

Smooth type

Flatten Peaks works locally on slightly rough areas.
Topology is maintained and local spikes are reduced.

Flatten Peaks

The Add Facets option allows vertex positions to move,
achieving generally smoother results but possibly with
significant changes in volume and triangle count.

Add Facets

Volume Aware smoothing keeps the triangle count the
same and tries to maintain the original volume.

Volume Aware

Angle threshold
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This option determines if an angle stays sharp or gets smoothed. Vertices on edges with faces coming together at
angles above the Angle threshold will not be moved or changed. The example below shows a block that has all 90°
edges except for two which are 45°. With an angle tolerance of 60°, only the two 45° edges get smoothed and the 90°
edges are left alone.

Smooth type

Determines which of the following algorithms is used to do the smoothing.

• Flatten Peaks:

º Flatten Peaks keeps the triangle count the same.

º It mostly knocks down spikes.

º The example below shows how repeated application of Flatten Peaks smoothing works on slightly rough areas.
The number of facets remains the same and the spiked areas are brought down closer to the surroundings.

• Add Facets:

º The original vertex positions and the new vertex positions are permitted to move.

º The amount of movement depends on how smooth the surroundings are.

º In sharp areas, the amount of movement will be large.

º In smoother areas, the amount of movement may be barely noticeable.

º Because of the movement, the Add Facets option will, in general, produce smoother results.

º The Add Facets option can produce results that are noticeable as shown in the example below. The final result
is achieved with several smoothing passes.
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• Volume Aware:

º Volume Aware does not change topology.

º It tries to maintain the sharps and minimize volume loss.

º The example below shows how Volume Aware smoothing works on the rough faceted body.

Reducing Facets
This tool reduces the number of facets, which influences 3D printing time. You can control the amount of reduction
through the Reduce Options.
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Reduced meshOriginal mesh

Reducing the Number of Facets
1. Click the Reduce tool

.

2. Change the Reduce Options if desired.

3. Select a faceted body or box-select facets.

4. Click Complete.

The model or selection is re-faceted with fewer triangles based on the Triangle reduction and Maximum
deviation specified.

5. You can continue to click Complete to reduce further.

You can also make your selection and then select the tool.

Tool Options
The following options are available for reducing the number of facets:

The percentage reduction you want to achieve. The
default is 20%.

Triangle reduction

Controls the distance between triangle edges and the
actual edges of the part. It influences the number of
triangles used to approximate curved edges. See the
images below.

Maximum deviation

The following images show how the maximum deviation specified influences the number of triangles used to
approximate curved edges.
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Smaller Maximum DistanceLarger Maximum Distance

Regularizing Facets
The Regularize tool improves the quality of selected facets by making their aspect ratios more consistent. You can
control the process with the Regularize Options. Geometry operations performed by the tool do not remove Named
Selections.

Regularizing Selected Facets
To regularize a selection of facets:

1. Select the Regularize tool

.

2. Change the Regularize Options if desired.

3. Select a faceted body or box-select facets.
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Note: The default value for regularize is determined based on the selected facets on the body.

4. Click Complete.

The model or selection is re-triangulated.

5. You can continue to click Complete to regularize further.

You can also make your selection and then select the tool.

Tool Options
The following options are available for regularizing facets:

Sets the maximum edge length.Max edge length

Determines if an angle stays sharp or gets smoothed.Angle threshold

Specifies the maximum distance between the new and
old faceting.

Deviation

Varies the facet size based on curvature. Enabling this
option makes the triangles conform more to the shape
with different sized triangles.

Curvature dependent

The Angle threshold option sets the facet-to-facet angle limit when regularizing the selected facets. Vertices on
edges with faces coming together at angles above the Angle Threshold will not be moved or changed.

Examples - Regularize Tool
The following examples show the use of the Regularize tool:
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Original Faceting

Faceting after applying Angle threshold and Max edge length.
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Faceting after applying Angle threshold and Deviation, with Curvature dependent enabled.

Zoom Legend
The Zoom Legend appears at the lower-right of the screen for the Regularize tool. If the zoom legend is on before
entering this tool or is turned on while using this tool, it will remain on when exiting the tool.

7.6. Inspecting Faceted Bodies
The Inspect group contains tools for checking faceted bodies for overhangs, thickness, and cavities. These items
need to be considered for 3D printing.

Use the Overhangs tool to detect and highlight areas
of the faceted body that protrude out at angles up to 90°

Use the Thickness tool to check the minimum thickness
of a faceted body.

Use the Cavity tool to find cavities that are completely
enclosed inside a faceted body.

7.6.1. Facet Overhangs
Overhanging geometry is an important consideration in 3D printing because it may require special supports. This
can add cost and setup time to the process.

The Overhangs tool detects and highlights areas of the mesh that protrude out at angles up to 90°. You can set the
Overhang Angle option to look for any angle up to 90°.
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The Overhangs tool works on both faceted and solid bodies. You can choose to select highlighted overhangs for
additional processing or to modify the body to minimize the overhang area.

Checking a Body for Overhangs
1. Click the Overhangs tool

2. Select a body.
3. Click the Select Direction tool

and select a solid or facet edge to set the direction to look for overhangs. ALT-select also works for selecting a

direction.

Tool Options
The following options are available for detecting overhangs:

• Overhang Angle Enter a value in degrees. Faces that overhang by More Than the specified angle will be detected
and highlighted. In the example below, the overhang is at 65°. The Overhang Angle is set to 64°.
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• Ignore Small Areas Enter a value. Overhangs with areas Smaller Than the specified value will be ignored. In the
example below, there is a small overhang with an area of 20 mm2. It is found when Ignore Small Areas is checked
OFF, but ignored when the option is checked ON and set to 30 mm2.

Converting the Highlighted Overhang(s) to a Selection
When the Overhangs tool finds overhanging facets or geometry, click the Convert to Selection tool guide

to add them to a selection.

Minimizing the Overhang
When the Overhangs tool finds overhanging facets or geometry, click the Minimize Overhang Area tool guide

.
This creates a copy of the Facets body and then orients it to a position that minimizes the Overhang area. This
orientation could be used in 3D printing to have minimal overhang.

7.6.2. Facet Thickness
Thickness is important for planning 3D printing. The Thickness tool lets you measure the thickness based on facet
normals or relative to the printer vertical direction.

Checking Faceted Body Thickness
1. Select the Thickness tool

.

2. Enter a Minimum thickness in the Options panel or use the default value.
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You can also click the arrow to open a slider for setting the Minimum thickness. The Thickness display changes
dynamical as you drag the slider.

3. (Optional) Click the3DPrintingDirection tool guide and select an face, edge, point or axis parallel to the printer
vertical direction.

4. Select a faceted or solid body.

Although solid bodies can be selected in the Thickness tool, they will produce no results.

The results are shown shaded with areas that are less than the Minimum thickness shown in red. An example is
shown below.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Faceted Body tool guide is active by default.
Use it to select a faceted body to analyze.

Use the 3DPrintingDirection tool guide to select a line,
edge, or axis for the 3D printing direction.

Tool Options
The following options are available:

Enter a value in model units. Any areas that have a
thickness Less Than the minimum thickness will be
detected and highlighted.

Minimum thickness

Controls the maximum distance between sample points.
Smaller values will create more samples and better
visualization, but will also increase the computation time
of the tool.

Sample spacing

Zoom Legend
The Zoom Legend appears at the lower-right of the screen. If the zoom legend is on before entering this tool or is
turned on while using this tool, it will remain on when exiting the tool.
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Examples - Thickness
The Sample spacing tool is intended for solid bodies. The images below show the tool applied to a solid body and
faceted body.

7.6.3. Facet Cavities
The Cavity tool finds cavities that are completely enclosed inside faceted bodies. It's important to identify cavities
because they can trap excess 3D printer material. The Cavity tool works on both faceted and solid bodies.

Checking a Body for Cavities
1. Select the Cavity tool

.

2. Optional: Check Max Opening and enter a value for finding small openings.

• Solid bodies can have small openings used for draining excess material
• These small holes can prevent cavities from being found in these areas.

3. Select a body.

Cavities are detected.

Examples - Cavities
In this example, three bodies will be checked for cavities. The left solid body is a shelled block, the faceted body in
the middle is shelled with a Basic Hex Infill, and the right solid body is shelled with a 1 mm diameter hole through
the top and bottom walls.
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A clipping plane is used to show the interior details.

The Cavity tool gives the following results.

The left solid body has one cavity.

The middle faceted body has 42 cavities due to the Hex
Infill.
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The right solid body has a through hole so no cavities are
found. However, the through hole is small (1 mm) and
small openings can cause problems for draining the
excess material.

Click the Max Opening option and enter "1".

One cavity is now found and the small openings are
highlighted in red.

7.7. Creating a Faceted Body
Use the Convert tool to convert solid bodies into facets bodies.

The Convert tool has a Progress Bar and a Stop button for meshes that take longer to generate.

Converting a Solid Body to a Faceted Body
1. Click the Convert tool

2. Select a faceted body

The selected faceted body highlights in blue

3. Choose a Cap option (see images below)

4. Select a plane, or surface, to use as a cutter

5. The faceted body is split into two separate faceted bodies

When converting a B-Rep model to a faceted model, you can double-click a face to select the underlying topology.
In this example, the first image shows the original model. The second image shows the faceted model with faces
selected (shown in orange). The selected faces correspond to the colored faces in the original model.
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Tool Options
The following options are available for converting solid bodies to faceted bodies:

Retain the original solid bodies after conversionKeep original bodies

Controls how far facet edges are away from model edges.Max distance

Controls how far facet edges are away from model edges.Max angle

Enter a number from 1 to 10. Facets will be created with
aspect ratios near the specified value.

Aspect ratio

Generated facets will have edge lengths less than or equal
to the value entered.

Max edge length

• Use the Keep original bodies option if you want to retain the original solid bodies. Converting a solid body to a
faceted body consumes the original solid.

These are the same options (geometrically-speaking) as the ones that control STL export.

Regardless of the context in which these options are used, they control the facet creation required by facet modeling
tools, whether it is for the explicit, user-directed Convert, or the behind-the-scenes conversion required by other
facet modeling tools.

• Max distance controls how far facet edges are away from model edges. The images below show the effect of Max
distance on the mesh of a cylinder. These examples keep the Aspect ratio fixed at 3 and the Max edge length set
to 4 mm.

Max Distance = 0.01 mm

Max angle = 20-degrees

Max Distance = 0.75 mm

Max angle = 20-degrees

Notice how the settings change the facets along the edge of the circle. The interior is a flat plane, so 45-degree
triangles are the most efficient facets.

The example on the left shows the default Max distance of 0.75 mm. This refers to the gap seen in the zoomed-in
(top) image. Decreasing the Max distance to 0.01 mm results in more facets along the edge, which brings the facet
edges closer to the cylinder edge, as seen in the example on the right.
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• Max angle also controls how far facet edges are away from model edges. Decreasing the Max angle will result in
more facets along curved edges. This example shows the result of decreasing the Max angle from 20 degrees to 1
degree.

Max Distance = 0.75 mm

Max angle = 1-degree

• Aspect ratiowill prevent distorted triangles. Without a fixed Aspect ratio and without a Max edge length, you can
get more distorted triangles as shown in the following images.

No set Aspect Ratio or Maximum
Edge Length

Max Distance = 0.01 mm

Max angle = 20-degrees

No set Aspect Ratio or Maximum
Edge Length

Max Distance = 0.75 mm

Max angle = 1-degree

No set Aspect Ratio or Maximum
Edge Length

Max Distance = 0.75 mm

Max angle = 20-degrees



8: Detailing

You can detail your designs to communicate with others or to submit your designs for review with the tools on SpaceClaim's
Detailing tab. With the detailing tools, you can annotate your designs, create drawing sheets, and review changes to
designs. You can customize detailing options to conform to standards or create your own custom style.

Detailing tools are grouped into the following ribbon groups:

Quickly display a particular view of your design.Orient

Format note text by adjusting the font characteristics.Font

Create notes on your design with text, dimensions, geometric
tolerances, tables, surface finish symbols, and datum
symbols, center marks, center lines, and threads.

Annotation

Add views to a drawing sheet.Views

Format a drawing sheet.Sheet Setup

Create markup slides to illustrate the changes made to a
design.

3DMarkup

Press Esc, then S to end any detailing action and return to the Select tool.

8.1. General Detailing Options
You can customize the style of your annotations in a single design or set a custom style as the default for all designs.
You can quickly customize the style to conform to ASME or ISO/JIS standards, or you can create a style by customizing
note leaders, dimensions, and geometric tolerances.

Changing Detailing Options
Application Defaults

Choose any font installed on your system. This font will be used as the default
font for all new windows. This font will be used when a new window is created
for an old or new document. It will also be used for new SpaceClaim sessions.

Newwindow font

The default graphics style used for new drawings.Default drawing graphics style

Check this option to have the scale automatically determined based on model
size. Uncheck the option to set a default custom scale.

Autoscale drawing sheets

Check this option to have new sections created as Total sections. Uncheck the
option to have new sections created as Area sections.

Create total cross sections

Choose either Hatch or None.Default section fill style

Document Options
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Select one of the following from the Detailing options for drop-down list:

• All New Documents to create a default detailing style for all your designs.
These settings will not affect any currently open documents.

• This Document to set options for the current design only.

Detailing options for

To reset all options to predefined defaults, click one of the Defaults buttons to
set all document options to the default.

• Reset to ASME Default
• Reset to ISO Default
• Reset to JIS Default
• Reset to GB Default

Predefined Defaults

View Options
Choose the default view projection :

• First Angle to label the view by the direction you are looking. For example, if
you are looking front, you see the back of an object. Therefore, the back of
the object is the "Front view."

• ThirdAngle to label the view by the object. For example, the front of the object
is the "Front view."

Default view projection

Choose the default front view position:

• Top left to place the front view at the top left corner of the drawing sheet.
This is the ISO standard.

• Top right to place the front view at the top right corner of the drawing sheet
• Bottom left to place the front view at the bottom left corner of the drawing

sheet. This is the ASME and JIS standard.
• Bottomright to place the front view at the bottom right corner of the drawing

sheet. If you use third angle projection, ISO standards also allow this position.

Default front view position

Specify the length of the arrow on section lines.Section line arrow size

Specify the length of section lines.Section line length

Set the ratio of a character's height to width. For example, a value of 1.4 sets the
character height to 140% of its width.

Detail view name text height
ratio

Select One Line to display the detail name and scale on one line. Select Two
Lines to display the scale below the detail name.

Default view note layout

Select how you want the detail label to appear on the drawing sheet.Default detail namenoteprefix

Select how you want the scale label to appear on the drawing sheet.Default view scale note prefix

Select how you want the detail name and scale information to be positioned
relative to the detail boundary.

Detail view boundary note
placement

Specify the length.Section cut line extension
distance

Choose either Away from cut line or Toward cut line.Section line arrow direction
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Select a value from the drop-down.

• ISO Conventional
• ASME Simplified
• JIS Conventional
• GB Conventional
• ASME Simplified is the same as ISO and JIS Conventional display standards.

Cosmetic thread display
standard

Select the style you want to use for the projected view arrowheads from the
drop-down list.

Default projected view arrow
style

Check whether or not to show the projected view name.Show projected view name

Check whether or not to show the projected view arrow.Show projected view arrow

Specify a new prefix or choose one from the dropdown list.Default projected view name
prefix

Check whether or not to show the auxiliary view name.Show auxiliary view name

Check whether or not to show the auxiliary view arrow.Show auxiliary view arrow

Specify a new prefix or choose one from the dropdown list.Default auxiliary view name
prefix

Specify the length of the arrow on projected and auxiliary views.Projected/auxiliary viewarrow
length

Annotation Options
Specify the height of the annotation text.Default text height

Specify the size of the circle that connects note leaders to faces.Leader circle size

Specify the length of the arrow on note leaders.Leader arrow length

Specify the size of the arrowhead on note leaders.Leader arrowwidth

Specify the length of the line from the note text to the note leader arrow.Leader shoulder length

Specify the size of the margin between the note text and the beginning of the
note leader.

Leader textbox gap

Specify the length that a center line will extend past the edge of the object.Center line extend

Select the style you want to use for the arrowheads on note leaders from the
drop-down list.

Default arrow fill style

Select the shape you want to use for the arrowheads on dimensions and leaders
from the drop-down list.

Defaultdimensionarrowshape

Select how you want to align the note leader text with the note leader line from
the drop-down list.

Defaultdimensiontext location

Select the font you want to use if the new window font is not available.Fallback font
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Select the default space for adding notes. The options available areView space
(default) andModel space. Notes in theModel space are their true size and are
not scaled based on the Detail scale setting.

Default note space

Select the symbol you want to use to indicate the virtual sharp.Virtual sharps rendering style

Select the frame style for datum symbols.Datum symbol frame

Select the attachment style for datum symbols.Datum symbol attachment

Choose whether thread designations are shown instead of thread diameters:

• Never: Show the diameter and not the thread designation.

• Always: Show the thread designation instead of the diameter.

• Per thread table: Use the value for
ShowThreadDesignationInDiameterDimensions in the thread table
XML file. The value can be set to true or false.

• If units match: Show the thread designation if the system units match the
units from the thread table.

• Per thread table if units match: Show the thread designation if the units
match and if the ShowThreadDesignationInDiameterDimensions
value is true.

Show thread designation in
thread diameter

Controls how many times larger the callout circle should be compared to the
text height.

DatumCallout text height ratio

Controls the point size used by datum target points, lines, and circles. Default
point size can be overridden on a per object basis.

DatumTargetdefaultpoint size

Controls the hatch spacing for circular and rectangular datum targets. Default
spacing can be overridden on a per object basis.

Datum Target area default
hatch spacing

Controls the hatch angle for circular and rectangular datum targets. The default
angle can be overridden on a per object basis.

Datum Target area default
hatch angle

Controls the arrow shape of leaders connected to datum targets.Datum callout leader arrow
shape

Choose either AWS or ISO.Welding symbols standard

Check the box to use the European standard of keeping the dimension line when
the extension lines are shown.

Enforce dimension line

Check the box to shrink the gap between the dimension text and witness lines.Tight gap between dimension
line and text

Check the box to keep all annotation text oriented horizontally.Horizontal dimension text

Check the box to set all annotation text to the color selected shown in the
Annotation color control. If you choose to override the layer color, select the
color used for the override from the Annotation color control.

Override layer color for
annotations

Specify the size of the margin between geometry and the end of dimension lines.Extension line gap

Specify the length that the dimension lines cross each other.Extension line extent
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Specify the length of the arrow that appears outside the dimension lines.Dimension line extent

Specify the distance between the dimension text and its leader line.Dimension text offset

Specify the size of the cross shown to represent the center.Foreshortenedradialdimension
center size

Choose either Linear or Normal to chamfer.Default chamfer dimension
style

Choose between:

• <length> X 45
• C <length>

Defaultchamferdimensiontext
format

Display the baseline dimension as a 0.Show zero value for base
ordinate dimension

Display all dimensions along the same line.

Check Rotate text if you want the dimensions to be displayed along the line
instead of perpendicular to the line.

Show common dimension line
for ordinate dimensions

Show or hide the endpoint.Show datum target endpoints

Allow solid geometry to hide annotations that are behind the geometry. For
printing, set the Print as image to Yes in the Printing Options to show
annotations as hidden in the print.

Hideannotationsbehindmodel

Linestyle Options
Specify the default width for thick lines.Default thick lineweight

Specify the default width for medium lines.Default medium lineweight

Specify the default width for thin lines.Default thin lineweight

From the drop-down, select an object type, then select the Line style and
Thickness for that object.

• Only a Thickness option is available for Cross hatching.

• Options for Detail view clipping edges apply to all clipping edges of partial
views. You can also set a Color for the clipping edges.

• Only a Thickness option is available for Area cross section border lines.

• Only a Thickness option is available for Cross section arrow tips.

Type of object
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Select a line style for the object. For example, when working with Wireframe,
Hidden Line, or Hidden Line Removed visibility modes, you can select a line style
to show the edge(s) of a design's partial view. This feature enables you to easily
identify which parts of the model are cut by the partial clipping boundary.
Non-solid line styles can help to differentiate a detail view with clipped edges
when in wireframe mode.

To enable the display to view while working with your design:

• Select Lineweight in the Show group in the Display tab

• SelectHidden Line, Hidden LineRemovedorWireframe from theGraphics
drop-down in the Style group in the Display tab

Line style

Thick-Empty-Thick lines look like this:

Thick-Thin-Thick lines look like this:

Thickness

The values in theTrimback section control the line weight for side offset handles.Trim back

Note: If you try to specify a value that is out of the permitted range in the Options panel or the SpaceClaim
Options dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to
see a tooltip that will explain the valid values for the option.

8.2. Drawing Sheet Size and Format Options
The drawing sheet size and format options allow you to choose a drawing sheet layout.

To use a pre-defined drawing format that has been saved as an .scdoc file, select
Useexternal formatand select a format from the list or clickBrowse to choose
a file.

Use external format

To create drawings without a format, select No format and select a size and
orientation, or set a custom width and height.

No format

Deselect Show SpaceClaim -provided default formats in the user interface if
you don't want to list drawing sheet formats that were installed with SpaceClaim
in the external formats selection list.

Show SpaceClaim -provided
default formats in the user
interface

8.3. Modular Grid Options
Modular grid options allow you to change how modular grids appear by default in your drawings. When you change
these options, all new modular grids will use these settings; existing grids in your drawings will not change.

Most of these options are also found in the properties for a grid. To change one instance of a modular grid, see
Displaying a modular grid.
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Setting Modular Grid Options
The color of the grid, labels, and the legend axis.Color

The height of all text labels for the grid.Grid text height

The font and text height used for grid labels. Type the complete name for a font,
followed by a comma and the font height in units (mm, in, etc.). You can also
click the ...button and select a font and a size in points. The size will be converted
to the current units.

Font

The distance between grid lines.Grid interval

The number of rows between each grid line.Intervals per grid line

The type of line used for grid lines.Line style

The thickness of grid lines.Thickness

Show labels for the bottom of grid lines, the top of grid lines, both, or neither.Horizontal text location

Show labels for the left end of grid lines, the right end of grid lines, both, or
neither.

Vertical text location

Override X, Y, or Z with your own labels.Axis labels

A prefix shown before the distance on a grid label.Negative and positive prefixes

A suffix shown after the distance on a grid label.Negative, positive, and zero
suffixes

A label shown next to the section line when you show a modular grid on a cross
section view.

Modular grid description label

Select an option for displaying modular grids for all new views in drawing sheets.

• Automatically showmodular grid when two grid directions are parallel
to the sheet: Two of the X, Y, or Z axes in the view must be parallel to the
drawing sheet to display the modular grid.

• Automatically showmodular grid when at least one grid directions are
parallel to the sheet:The X, Y, or Z axis in the view must be parallel to the
drawing sheet to display the modular grid.

• Do not automatically show themodular grid

Automatic creation for new
views

If selected, then the description label is displayed next to the section line for a
cross section view.

Automatically showmodular
grid description

Show circles around grid labels.Show balloons around grid
labels

Show the legend axis on the lower left corner of the view.Automatically show origin
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8.4. Formatting Note Text
You can adjust the font, size, style (bold, italic, underline), alignment of the text within the box, and create superscripts
and subscripts using the tools in the Font ribbon group, or by right-clicking the annotation and selecting from the
mini-toolbar.

You change the text characteristics for notes, dimensions, and tables at the same time.

Font Ribbon Group
The Font ribbon group contains the following tools:

Select the font family (Ctrl+Shift+F)Font

Select or enter a font size.(Ctrl+Shift+P)Font Size

Drop down menu and select from the width factor
options.

Width Factor

Button to increase the width in 0.1 increments.Increase Width Factor

Button to decrease the width in 0.1 increments.Decrease Width Factor

Superscript or subscript the note text.Vertical Text Offset

Make the text bold (Ctrl+B), italic (Ctrl+I) the text,
underline (Ct+U), or strikethrough the note text.

Left, center, or right-justify the note text.

Set the text direction from left-to-right or right-to-left.

Formatting Text
All text within a note boundary - singular or multiple lines of text - aligns to the format you set.

1. To change the text formatting for an entire note, dimension, or table, select one or more in the Design window.
Hold Ctrl to select more than one or draw a box in the Design window.

Place your cursor at the location in the text where you want to change the formatting. To change the text
formatting for only some of the text in a note, dimension, or table, select only the text you want to change.

2. Use the tools in the Font ribbon group to format the text.

To create a superscript or subscript, select a preset amount from the Vertical Text Offset

drop-down, or select Custom and enter a custom amount to raise or lower the text.

8.5. Annotation
You can annotate your designs, drawings, and 3D markups with notes, dimensions, geometric tolerances, surface
finish and datum symbols, as well as center marks, center lines, and threads. When you create annotations that are
attached to the objects in your design, they stay attached, even when you modify those objects using the Design
tools. Annotations created on a drawing sheet or 3D markup slide are part of that sheet or markup only--they do
not appear on your design.
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Each annotation has properties which you can modify in the Properties panel. When you create the first annotation,
it is scaled so that it will be visible when your design is zoomed to its extents in the Design window. All other
annotations use the same scale.

Annotation Ribbon Group
The Annotation ribbon group contains the following tools, from left to right:

Use the Select tool to choose Using Box, Using Lasso,
Using Polygon, or Using Paint to select the highlighted
object.

Use the Dimension tool to create a measured dimension.

Use the Note tool to select an annotation plane and enter
text onto the plane.

Use the Note Leader tool to connect a note to an object.

Use the Thread tool to create a threaded surface on any
cylinder, cone, or hole.

Use the Center Line tool to add a center mark on any
circle, arc, cylinder end, or sphere, and put center lines
on any cylindrical face.

Use the Geometric Tolerance tool to create a geometric
tolerance.

Use the Datum Symbol tool to insert a datum symbol.

Use the Datum Target tool to insert datum targets onto
your design, drawing sheet, or 3D markup slide.

Use the Table tool to insert a table.

Use the Hole Table tool to create a hole table.

Use the Bolt Circle tool to view information about
diameter, angular, and radial dimensions for a circular
pattern.

Use the Welding Symbol tool to create a weld symbol.

Use the Barcode tool to create a barcode symbol.

Use the Bill of Materials tool to create and insert a BOM.

Use the Balloon tool to add BOM balloon notes.

Use the Surface Finish tool to create a surface finish
symbol.

UpdateAnnotationsReadingDirection flips annotations
that are backwards in the current viewing direction.

Click to display SpaceClaim's detailing options.

Use the Track Encoding tool to see the model's encoding
status.
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Press Esc, then S to end any detailing action and return to the Select tool.

8.5.1. Creating Dimension Annotations
Use the Dimension tool to add a measurement to your design, drawing sheet, or 3D markup.

You can use annotation dimensions with the Pull and Move tools to change your design. See Driving modifications
with annotation dimensions.

An annotation plane cannot be moved to a sub-component after you add dimensions because the references would
be lost.

You can enable dual dimensions, which will display each dimension in both Metric and Imperial units. See Units
options.

Creating a Dimension Annotation
1. Click the arrow under the

Dimension tool and select Dimension.

2. If you are creating a dimension in 3D, click a face to create an annotation plane on which to place the dimension.

Mouse over the faces of your design to preview the eligible annotation planes. (In Sketch and Section mode, the
sketch grid defines the annotation plane.) If multiple objects occur at your cursor location, use the scroll wheel
or arrow keys to highlight each one.

To create an annotation plane for a cylindrical face, select the cylinder's axis.

If you need to change the annotation plane, right-click and clickSelectNewAnnotationPlane from the context
menu and select a new annotation plane.

3. Click an edge or face.

Where you click a circle determines whether you will measure from the circle's center, near, or far edge. To select
the center click the top, bottom, left, or right side of the circle.

4. Mouse over your design to preview the possible dimensions.

5. Click a second object if you want to dimension between two objects.

6. (Optional) Select a dimension orientation in the Options panel. You can also select the orientation for the first
and second reference.
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7. Click to create the dimension.

Dimensioning to and from Center Lines

1. In a drawing view, add a center line using the

Center Line tool.

2. Click the arrow under the

Dimension tool and select Dimension .
3. Click either the horizontal or vertical center line

4. Click an edge or face.

5. Click to create the dimension.

Creatign an Arc Length Dimension

Two methods:

• Hold the Ctrl key down and click the arc.
• Click the arc first and hold the Ctrl key down while dragging the dimension.

Creating a Chamfer Dimension
1. Click the arrow under the

Dimension tool and select Dimension .

2. If you are creating a dimension in 3D, click a face to create an annotation plane on which to place the dimension.

If you need to change the annotation plane, right-click and clickSelectNewAnnotationPlane from the context
menu and select a new annotation plane.

3. Click an edge or face that belongs to the chamfer.
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4. Mouse over your design to preview the possible dimensions.

5. Click to create the dimension.

Dimensions for planar and cylindrical chamfers.

You can flip the orientation of chamfer dimensions by setting the Flip Chamfer Dimension property to True.

Flipped chamfer dimensions

Annotation options in the General page of Detailing option in SpaceClaim Options offers choices for how chamfer
dimensions are displayed.

• Default chamfer dimension style:

º Linear: Displays the dimension with extensions lines as in the images above.
º Normal to chamfer: Displays the dimension with a leader pointed normal to the chamfer as shown in the image

below.

• Default chamfer dimension text format:

º <length> X 45: Text is displayed as in the images above.
º C<length>: Text is shown as in the image below.

568Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



Creating Ordinate Dimensions
1. Click the arrow under

Dimension in the Annotation group on the Detailing tab and select

Ordinate Dimensions.

2. If you are creating a dimension in 3D, click a face to create the plane on which to place the dimension.

Mouse over the faces of your design to preview the eligible annotation planes. (In Sketch and Section mode, the
sketch grid defines the annotation plane.) If multiple objects occur at your cursor location, use the scroll wheel
or arrow keys to highlight each one.

To create an annotation plane for a cylindrical face, select the cylinder's axis.

If you need to change the annotation plane, right-click and clickSelectNewAnnotationPlane from the context
menu. Then right-click the new place and click Set As Annotation Plane.

3. Click a line, edge, or Center Line to set the baseline dimension.

You can use an existing extension line as a dimensioning reference. An extension line is the line that connects
the point to the dimension text. If you select an extension line, the baseline dimension for the extension line's
dimension is used.

4. Mouse over the face to see all the possible dimensions.

In cases with many ordinate dimensions, the preview may be slow. Start SpaceClaim using the following command
line option to limit the number of dimensions that are shown in the preview. The example specifies '10' but you
can set it to any number you wish.

MaxOrdDims=10

The plate shown below has 400 holes but only 10 are shown in the preview.
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5. Click a point to place the dimension line.

If you select a face, all of the possible ordinate dimensions will be created.

You can click multiple points to use the same baseline for those dimensions.

The baseline dimension (0) is displayed or hidden based on which detailing standard is selected in the Detailing
options.

Automatic jog points are included if ordinate dimensions are too closely spaced. This helps make them easier
to read.

Using an Angled Baseline

First, establish a simple, oriented dimension. Then use one of the witness lines to set the baseline and orientation
of the ordinate dimensions.

In the example above, the leftmost witness line of the existing circle-to-circle dimension was selected to define the
baseline.

Creating Foreshortened Dimensions
1. Start with a radius dimension

2. Optional - Set the Foreshortened radial dimension center size in SpaceClaim Options

3. Right-click and select Foreshortened
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4. Move the endpoint and jog points as needed.

5. Dimensioning to the center produces a foreshortened length dimension.

Dimensioning Bodies
1. Click the arrow under the

Dimension tool and select Dimension .

2. Click the Select bodies tool guide on the right side of the Design window.

3. Select the solid body or bodies you want to dimension:

• If you select a single body, then the maximum horizontal or vertical dimension is created, as shown below.
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• If you select more than one body, then the dimension is created for both solids and is anchored on the side
closest to where you click the solid. You must click the Select bodies tool guide before you select each solid,
so you click the tool guide and select the first part, then click the tool guide again and select the second part.

In both of the examples below, the upper part was selected near its top. The lower part was selected near its
top in the example on the left and near its bottom in the example on the right. The mouse arrows indicate
where the lower part was selected. You will see a preview of the dimension when you click the tool guide and
hover over the second part.

• If you create the dimension in a section view of a drawing sheet, then the dimension is created on the extents
of the body that is visible in the section plane, as shown below.

Editing a Dimension Annotation
1. Select the dimension annotation to move, size, or rotate it.

To move the dimension note, mouse over the edge of the box with the Select tool until the cursor changes to
,

then drag the note.

To size the box that contains the dimension note, drag the handles of the note box (the white circles).

2. Select the text of the note to reformat it.

3. (Optional) Right-click the dimension and select text formatting options from the mini-toolbar.

Click
to select a tolerance format, then edit the text of the tolerance.

• See the Limits and Fits Tolerances section below for a description of using Limits and Fits.

Click
to insert a field. You can select a field type and format from the Insert Field window.

Select from the

drop-down to insert a symbol.

4. Click an arrowhead to cycle through alternative leader styles.

You can also right-click an arrowhead and select Arrow Style to select a style for that arrowhead, or select the
arrowhead, then select the style for the head in the Properties panel.

5. Click the note leaders to modify them.

You can right-click a leader and select Add Jog Point to add a new point.
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6. To change the distance between a dimension extension line and its reference point on the object, click the
extension line, then hover over the end closest to the object. Drag the red dot to change its distance from the
object.

If you cant' see the extension line, hover over the end of the dimension leader, where the line would be. You will
see two red dots that you can drag:

7. Modify the dimension note properties in the Properties panel. Modify the:

• Arrow Length and Width properties to set the length and width of the arrowheads

• Measurement property to change the measurement type. For example, you may want to display the radius
of a hole instead of the diameter.

• Precision property to change the number of decimal places.
• Upper Limit, Lower Limit, and Type of tolerance property to change the format of the dimension and enter

upper and lower tolerance values.

8. To fit a dimension within the text box

• Right-click the note and open the Autofit drop-down menu.
• Choose one of the following options:

• Do not autofit: The text box adjusts to the size of the text and grows as you type. There is no blank space
around the note and making the text larger or smaller adjusts the box accordingly.

• Resize text height on overflow: The text always fits the width of the box. If you make the box wider, text
from the second line will move up to the first line.

• Shrink text on overflow: The text adjusts uniformly (width and height) and scales to fit in the text box.
• Shrink text horizontally on overflow: The width of the text changes but the height remains the same.

Limits and Fits Tolerances
Limits and Fits tolerances are supported for Metric units using the ISO 286-1 and ISO 286-2 standards. Refer to these
standrads for a complete description of Limits and Fits tolerances.

You can apply Limits and Fits to metric dimensions for Holes, Shafts, and opposing planar faces (that is, face normals
point toward each other).

Note: If the dimension is created by selecting an edge, the Limits and Fits tolerance type will be available
ONLY IF the system can uniquely determine the parent faces. If there is ambiguity, Limits and Fits may not
be available as a tolerance type.

Note: Limits and Fits will NOT be available if the dimension (that is, Basic Size) is outside the range of sizes
covered by the standard.

Limits and Fits tolerances are specified with a letter and a number that refer to a table in the standard.
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Applying a Limits and Fits Tolerance
1. Select one of the dimensions listed above
2. In the Properties panel, change the Tolerance Type to Limits and Fits, or click

in the mini toolbar
3. Based on the dimension size, the following tolerance properties are set to default values:

• Upper Limit - The largest allowable value for the dimension
• Lower Limit - The smallest allowable value for the dimension
• System of Fits - Sets the fixed datum used to calculate the tolerances. This can be either Hole Basis (shaft is

assembled into the hole) or Shaft Basis (hole is assembled onto the shaft).
• Hole Fundamental Deviation - Fundamental Deviation establishes the location of the tolerance zone with

respect to the Basic Size. When System of Fits is set to Hole Basis, this will be "H". When System of Fits is set
to Shaft Basis, this can be any of the allowed letter designations (A thru ZC)

• Hole IT - "IT" refers to International Tolerance Grade. It is a group of tolerances which vary depending on the
Basic Size of the dimension, but which provide the same relative accuracy within a given grade .Any of the
allowed numeric designations (IT01 thru IT18)

• Shaft Fundamental Deviation - Fundamental Deviation establishes the location of the tolerance zone with
respect to the Basic Size. When System of Fits is set to Hole Basis, this will be any of the allowed letter
designations (a thru zc). When System of Fits is set to Shaft Basis, this will be "h".

• Shaft IT - Any of the allowed numeric designations (IT01 thru IT18)
• Method of Designating - The display format for the tolerance

4. Change any of the properties as appropriate

In the Limits and Fits section of SpaceClaim Options > Detailing, you can set defaults for the properties.

Limits and Fits symbols combine the IT Grade Number and the Fundamental Deviation letter. "IT" is dropped from
the Grade Number so only the number is shown. The tolerance size is therefore defined by the Basic Size of the part
followed by a symbol containing a letter and a number. A Fit is indicated by the Basic Dimension common to both
components, followed by a symbol corresponding to both components with the Internal part symbol preceding the
External part symbol.

The table below shows examples.

Internal (hole) component

External (shaft) component
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Fit between a hole and shaft
with a basic size of 40

Set the Method of Designating property to change the symbol's display format. The table below illustrates the
choices.

40H8

40H8 (40.039/40)

40.039/40 (40H8)

40.039/40

40H8/h7

When you change the size of a dimension that has Limits and Fits tolerances, the Upper and Lower Limits will change
according to the limits and Fits tolerance tables.

If you modify the IT number, the tolerance symbol updates accordingly.

The dimension color is changed to Red if it has Limits and Fits tolerance and some of the input parameters are
invalid. An example is shown below.
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The tolerance has a Fit for
H01/n01

The Fit was changed to
H01/a01, which is invalid

Displaying the Annotation and Hiding the Plane
1. Create two layers, one for notes, and one for the annotation planes.

2. Place the note on one layer and the annotation plane on another layer.

3. Turn off the visibility of the layer that contains the annotation plane.

Aligning Multiple Dimensions
1. Select multiple dimensions.
2. In the RMB menu, choose from the following:

• Align Lefts - Align the left side of each dimension.
• Align Centers - Vertically align the center of each dimension.
• Align Rights - Align the right side of each dimension.
• Align Top Lines - Align the bottom of the first line of text in each dimension.
• Align Middles - Horizontally align the middle of each dimension.
• Align Bottom Lines - Align the bottom of the last line of text in each dimension.
• Make Samewidth - Make each dimension the same width based on the first note selected. Some text may be

scaled accordingly.
• Make Same Height - Make each dimension the same height based on the first note selected. Some text may

be scaled accordingly.
• Make Same Size - Make each dimension the same size (height and width) based on the first note selected.

Some text may be scaled accordingly.
• Distribute Horizontally - The space between each dimension is distributed evenly horizontally.
• Distribute Vertically -The space between each dimension is distributed evenly vertically.
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• RemoveHorizontalSpacing - The even horizontal spacing is removed and any significant overlap is equalized.
• Remove Vertical Spacing - The even vertical spacing is removed and any significant overlap is equalized.

Any notes rotated differently are not affected by the above commands.

Displaying Dimensions for an Annotation Plane
Right-click an annotation plane and select:

• Show all dimensions to display dimensions on all annotation planes.
• Show dimensions to display the dimensions for only the annotation plane you right-clicked.

Examples

Annotations with orientation changed in the Options panel

1. Dimension Orientation set to Aligned

2. Dimension Orientation set to Horizontal

3. Dimension Orientation set to Vertical

4. 1st Reference Orientation set to Horizontal, 2nd Reference Orientation set to Vertical

A dimension annotation with dual dimensions enabled in the Units options

Ordinate dimension annotations
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Ordinate dimensions for a planar face

Automatic jog points with closely spaced ordinate dimensions

8.5.1.1. Dimensioning Between Virtual Points
You can create dimensions from the line between two points or the mid-plane between two lines, even when that
line doesn't exist as an edge.

1. Click
Dimension in the Annotation group on the Detailing tab .

2. Select a point (A) as your starting point.

3. Hold Ctrl and select a second point (B).

This creates a virtual line between points A and B, which will be the baseline of your dimension.

4. Select a third point (C).

Now you have a dimension between line AB and point C:

If you hold Ctrl when you select point C, the dimension is created between line AB and line BC:
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5. (Optional) If you select point C without holding Ctrl, and hold Ctrl to select a fourth point (D), the dimension is
created between line AB and line CD:

6. Click anywhere in the annotation plane to place the dimension.

Dimensioning to a Virtual Sharp

1. Click
Dimension in the Annotation group on the Detailing tab .

2. Hold Ctrl and select a line.

3. Hold Ctrl and select a converging line.

The head of the note leader is attached to the virtual sharp. You can also drag the virtual sharp's end point, draw
another leader to the virtual sharp, create virtual sharps in cross-section, for rounds, and between an angled
and straight edge.

4. (Optional) To end the dimension at another virtual sharp,

a. Hold Ctrl and select a line.

b. Hold Ctrl and select a converging line.

5. Click anywhere in the annotation plane to place the dimension.

Dimensioning to a Mid-plane Line

1. Click
Dimension in the Annotation group on the Detailing tab .

2. Define the mid-plane line:

a. Select a face or edge:
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b. Hold Ctrl and select a second face or edge:

The mid-plane line is displayed as a gray line, and the beginning of the dimension is attached to this line.

3. Select the face, edge, or point you want to dimension to.

The end of the dimension is attached to the face, edge, or point.

4. Click to place the dimension annotation.

Note: You can reverse these steps to begin the dimension with an existing line or point and end the dimension
with a mid-plane line. You can also dimension between two mid-plane lines.

Examples

A dimension between virtual points

A dimension from a mid-plane line to an edge
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A dimension between two mid-plane lines

A dimension to the virtual sharp of a chamfered edge

A virtual sharp

8.5.1.2. Editing with Annotation Dimensions
You can use 3D annotation dimensions to change your design using the Pull and Move tools. Annotation dimensions
can be used in combination with ruler dimensions.
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Using 3D Annotation Dimensions with the Pull or Move Tool

1. Click
Pull or

Move in the Edit group on the Design tab.

2. Select the objects you want to pull or move. You can select an edge, face, point, or surface.

3. If you are using the Move tool, select a direction on the Move handle.

4. Click the spark icon

next to the dimension you want to use to drive the change. The icon turns yellow when you hover over it with
your mouse, as shown in the image above.

The dimension field can be edited when you click the spark icon.

These icons appear when you use a tool that can be used with annotation dimensions to drive changes. The
annotation dimension must be associated with the face, edge, or point you want to change.

If you are using the Move tool and you don't see the spark icons, you need to select a direction on the Move
handle or you must create a ruler dimension. You get more predictable results if you re-anchor the Move handle
to the appropriate face, edge, or point.

5. Type a new dimension and press Enter.

The objects you selected will change based on the dimension.

If the dimension you change isn't associated with the objects you selected, nothing will change and you will see
an error message in the Status area on the lower right side of the SpaceClaim window.

If the tool can't make the change in the direction that the Pull or Move handle points toward, then it will try to
make the change in the opposite direction to achieve the dimension you enter.

Examples

Selecting a dimension with the Pull tool active
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Selecting a dimension with the Move tool active. You must select a direction on the Move handle before you can
select a dimension.

Changing the value of the dimension field

Using an angular dimension to Pull a face with a revolve axis set

Using a linear dimension to offset a face with Pull

Using a linear dimension to change the angle of a face with Move

Note: Here the Move tool was re-anchored to the lower, horizontal edge of the face

583Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



Pulling with a radial dimension on a face that is offset with another cylindrical face. This also works when you select
both radial faces without an offset relation

8.5.2. Creating Notes
Use the Note tool to annotate your designs, drawing sheets, and 3D markups. You can use this tool to create and
edit notes. You can also project the note onto a sketch or onto a solid. Place the annotation plane on one layer and
the note on another layer, then turn off layer visibility for the annotation plane to hide it. You can also create circular
note text.

Notes are shown in the Structure Tree. Like curves, Notes can live in datum planes or drawing sheets. Unlike curves,
they do not live directly in a part. So, in a part, you will not see a Notes folder.

Creating a Note
1. Select the Note tool

from the Annotation ribbon group in the Detail tab.

Mouse over the faces of your design to preview the eligible annotation planes. (In Sketch and Section mode, the
sketch grid defines the annotation plane.)

2. Click a face to create the plane on which to place the note.

To create an annotation plane for a cylindrical face, select the cylinder's axis.

If you need to change the annotation plane, right-click and clickSelectNewAnnotationPlane from the context
menu and select a new annotation plane.

3. Click to place the note on the plane.

4. Enter the text of the note.

• Click
in the mini-toolbar to insert a symbol into your note at the cursor location.

• Click
in the mini-toolbar to insert a dynamic field. Dynamic fields include current values from a variety of properties.

• You can format the note text, and enter the text by cutting, copying, and pasting the text from other notes or
dimension annotations.

• SpaceClaim recognizes many fonts stored on your computer. If you paste text from outside of SpaceClaim,
and the font is not recognized, the default font will be used.

5. Adjust the orientation of the note by dragging the rotation handles.
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For vertical notes, set the Stacked property to True.

Creating a Note Field
Field codes can be included within a note. Because the text in field codes is variable text (the text within a field is
tied to code), when you change a field code in your note or drawing sheet, for example, a date format, the field
automatically updates.

Some field codes are bi-directional. For example, adding the Scale field code to a drawing sheet enables you to
change the scale by editing the note, or, change the scale by changing the value from the Scale drop-down in the
Sheet Setup group in the Detail tab.

1. Click within the text of the note and place the cursor where you want the field to appear.

2. Right-click to display the mini-toolbar.

3. Click
in the mini-toolbar to display the Insert Field window.

The Fields tab displays the properties available for insertion. (Document properties are those that appear in the
Properties panel when you click the top-level design in the Structure tree.)

4. Select a value from the Category drop-down to filter the properties displayed in the Fields list.

If you clickSelectedObject, you can click any object in the Design window or Structure tree to make its properties
available.

If you select Formula, you can enter an expression, and include any numeric fields within the expression.

5. Click a property in the Fields list.

6. Click the Format tab to format the text within the field.

The formatting options are based on the type of the property value. For example, strings can be formatted with
upper case, lower case, initial capitals, or title case.

7. Click OK to insert the formatted, dynamic field into the note at the cursor location.

If the field is empty, check to make sure that the property you selected has a value by selecting the appropriate
object and viewing the Properties panel.

Copying a Note
Ctrl+drag a note to copy it.

You can also do the following:

• Click a note.
• The note displays inside the text box border.
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• Click the border.
• Press Ctrl+c
• Press Ctrl+v
• The note copy displays below and to the right of the original note.

• If you paste the note on a different sheet, it will paste in the same location as in the original sheet. It does not paste
at the cursor location.

• If you are zoomed in, the note will paste in the center of the view. If there is another note at that location, the new
note will paste below and to the right of that note.

Editing a Note
1. Select the note to move, size, or rotate it.

If you select a single note, you can edit, resize, and rotate the note. If you select multiple notes, you can only
move or change formatting.

To move the note box, mouse over the edge of the box until the cursor changes to
,

then drag the note.

To size the box containing the note, drag the handles of the note box (the white circles).

To rotate the note, drag the rotation handle (the green circle). Press Shift to snap to angular increments.

2. Select the text of the note to reformat it.

Click a field to edit it. Changing the value of a string also changes it in the Properties panel.

3. Modify the note's properties in the Properties panel.

• Circular Text

• Type - Choose from:

• None

• Clockwise

• Counterclockwise

• Radius - Enter a radius for the note circle.

• Cosmetic

• Space - Choose from:

• Model Space sizes the text based on the actual measurements of the objects in your design.

• View Space sizes the text based on the view of the design in the Design window.

• Mirrored - Set this property to True to display the text as if it is seen in a mirror. Notes seen from behind can
appear 'backwards,' which can be confused as 'mirrored.' Setting this property confirms the Note is mirrored
intentionally.
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• Stacked - Set this property to True to stack the text vertically instead of horizontally.

• Flagnote

• Flagnote is a drop-down menu of border shapes to put around the text.

• Minimumwidth prevents the border from resizing automatically to fit the content of the note.

• Position

• Anchor influences the position and size of a note within a plane. Where you anchor a note determines the
direction that the text will fill the note. For example, if you select the Left Top position, as you type, the
expanded text box flows from left to right and top to bottom. The choices are:

• Left Top

• Left Bottom

• Right Bottom

• Right Top

• Left Center

• Right Center

• Top Center

• Bottom Center

• Center

When moving a note or circular note, the note's anchor (or circular note's text center) now snaps to an
edge, a sketch point, or an axis. Select the Move tool, and then select the note's red anchor and drag it to
an edge, sketch point, or axis. The red anchor will snap to the note's anchor location that is closest to the
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drag point. The Anchor position updates in the Position group of the Properties panel as you move the
anchor to a new location.

Fitting Text Within a Note Box
• RMB Click the note and open the Autofit drop-down menu.
• Choose one of the following options:

º Donot autofit:The text box adjusts to the size of the text and grows as you type. There is no blank space around
the note and making the text larger or smaller adjusts the box accordingly.

º Resize text height on overflow: The text always fits the width of the box. If you make the box wider, text from
the second line will move up to the first line.

º Shrink text on overflow: The text adjusts uniformly (width and height) and scales to fit in the text box.
º Shrink text horizontally on overflow: The width of the text changes but the height remains the same.

Adjusting the Text Width
The Font group in the Detail tab has tools for increasing and decreasing text width.

• Click the Width Factor drop-down menu and select from the width factor options.
• Click the Increase Width Factor button to increase the width in 0.1 increments.
• Click the Decrease Width Factor button to decrease the width in 0.1 increments.

Adjusting Line and Character Spacing
Character and Line spacing can be changed in Notes.

• Click the character spacing drop-down menu and select from the character spacing options.

• Click the line spacing drop-down menu and select from the line spacing options.
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Aligning Multiple Notes
1. Select multiple notes.
2. In the RMB menu, choose from the following:

• Align Lefts - Align the left side of each note box.
• Align Centers - Vertically align the center of each note box.
• Align Rights - Align the right side of each note box.
• Align Top Lines - Align the bottom of the first line of text in each note box.
• Align Middles - Horizontally align the middle of each note box.
• Align Bottom Lines - Align the bottom of the last line of text in each note box.
• Make Samewidth - Make each note box the same width based on the first note selected. Some text may be

scaled accordingly.
• Make SameHeight - Make each note box the same height based on the first note selected. Some text may be

scaled accordingly.
• MakeSameSize - Make each note box the same size (height and width) based on the first note selected. Some

text may be scaled accordingly.
• Distribute Horizontally - The space between each note box is distributed evenly horizontally.
• Distribute Vertically -The space between each note box is distributed evenly vertically.
• RemoveHorizontalSpacing - The even horizontal spacing is removed and any significant overlap is equalized.
• Remove Vertical Spacing - The even vertical spacing is removed and any significant overlap is equalized.

Any notes rotated differently are not affected by the above commands.

Attaching and Detaching Notes to Other Notes
You can attach notes to other notes using the Attach Notes option in the RMB menu. The first note selected is the
parent note (highlighted in blue) and any other notes you select become child notes (highlighted in dark blue).

1. Select two or more notes
2. RMB click
3. Select Attach Notes
4. To detach a note RMB select it and choose the Detach option.

When notes are attached, moving the parent note moves all the notes as one. However, moving a child note will
move that note individually.

You can attach a note to the note fields of objects created with tools in the Detail tab. For example, Surface Finish
symbols, Welding symbols, Datum Targets, Datum symbols, notes within a Symbol, and Dimensions are some tools
that have note fields. Any notes can be attached to any other notes. Dimensions, however, can only be parent notes
since they are attached to the model.
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Attaching and Detaching Free Notes to Drawing Views
Free notes (those Not attached to the model with a leader) can be attached to a drawing view.

1. Select a drawing view
2. Ctrl-select one or more Free Notes
3. RMB click
4. Select Attach Notes
5. To detach a note RMB select it and choose the Detach option.

Moving a drawing view also moves any attached Free Notes.

Deleting a drawing view also deletes any attached Free Notes.

Displaying the Text of an Annotation and Hiding the Plane
1. Create two layers, one for notes, and one for the annotation planes.

2. Place the note on one layer and the annotation plane on another layer.

3. Turn off the visibility of the layer that contains the annotation plane.

8.5.2.1. Creating Circular Notes
Use the Note tool to create and edit circular Note text. This text type can orient either clockwise (CW) or
counterclockwise (CCW). The circle center is indicated by a cross-hair marker. The circle radius displays as a visual
guideline. Use the size handle to size the circle. You can adjust the orientation of the note by dragging the rotation
handle. Enter or change new radius settings in the Options panel.

With circular text you can create:

• Single line text
• Multi-line text. Type the first line of text, and then press Enter to create an additional line of text.
• Formatted single or multiple line text. Use the mini-toolbar to format circular note text. You can change the font,

font size, and style of all or some of the text; however, you cannot underline circular text.
• A note with a True Type or a Microsoft Windows 3.1 font (Modern, Roman, and Script). True Type fonts may be

used when etching or laser-cutting in sheet metal, where the width of the character is determined by the width
and/or focus of a laser beam.

Creating a Circular Note
1. Select the Note tool

from the Annotation ribbon group in the Detail tab.
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Mouse over the faces of your design to preview the eligible annotation planes. (In Sketch and Section mode, the
sketch grid defines the annotation plane.)

2. Click a face to create the plane on which to place the note.

To create an annotation plane for a cylindrical face, select the cylinder's axis.

If you need to change the annotation plane, right-click and clickSelectNewAnnotationPlane from the context
menu and select a new annotation plane.

3. Click to place the note on the plane.

4. Enter the text of the note.

5. In the Properties panel, select Clockwise or Counterclockwise from the Type drop-down.

6. Click the fact to update the note.

Once you create the circular note text, you can:

• Click
in the mini-toolbar to insert a symbol into your note at the cursor location.

• Click
in the mini-toolbar to insert a dynamic field. Dynamic fields include current values from a variety of properties.

• Format the note text, and enter the text by cutting, copying, and pasting the text from other notes or dimension
annotations.

• Position the note text relative to the note's anchor by using theAnchordrop-down in the Properties panel. Adjust
the note's diameter by dragging the note's anchor.

• Adjust the orientation of the note by dragging the rotation handles. Drag the center cross-hair marker to move
the text.

• Use leading spaces (inserted before text or within text) and trailing spaces (inserted after text) to position text
around the circle radius as needed.

• Convert the text to lightweight text in sheet metal. Lightweight text is transparent, and is used to represent text
objects in a virtual way (so that further operations on the part do not have to recalculate all the new graphics data
dealing with text). In lightweight mode, the text cutouts seen by the user are only recreated when the text is edited,
as opposed to every time any other action is performed on the model.

• Move the note: Simply drag a red anchor point to snap to an edge, a sketch point, or an axis. The red anchor will
snap to the note's anchor location that is closest to the drag point.

8.5.3. Adding Hyperlinks to Annotations
Hyperlinks allow access to more content in your notes and dimensions. Some examples are:

• Images
• Web pages
• Word documents
• .scdocs

Once a Hyperlink is established, you can hover over the annotation text to display the link in the status bar and
Ctrl+Click to go to the link.

Adding a Hyperlink to a Note
1. Highlight the annotation text.
2. RMB click
3. Select the Hyperlink option.
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4. The Insert Hyperlink dialog box opens.
5. Enter an existing file path or web page link. You can also click the Browse for File button or Browse the Web

button.
6. Click the OK button.

Editing a Hyperlink
1. Highlight the annotation text.
2. RMB click
3. Select the Edit Hyperlink option.
4. Edit the link in the Edit Hyperlink dialog box.

Opening a Hyperlink
1. Highlight the annotation text.
2. RMB click
3. Select the Open Hyperlink option.
4. The link opens in the appropriate media.

You can also hover over the annotation text and Ctrl+Click to open the link in the appropriate media.

Removing a Hyperlink
1. Highlight the annotation text.
2. RMB click
3. Select the Remove Hyperlink option.

You can also edit the Hyperlink and click the Remove Hyperlink button in the dialog box.

8.5.4. Creating Note Leaders
Use the Note Leader tool to create an arrow from your note.

Creating a Note Leader
1. Click

Note Leader in the Annotation group on the Detailing tab.

Mouse over notes on the active annotation plane to see the possible ways to connect the note leader to the note.

2. Click a note's connection point to draw the first segment of the note leader.

Mouse over your design to highlight the geometry to which you can attach the end of the note leader. You can
also attach leaders to temporary objects.

3. For a segmented line, click to set each point of the note leader line.
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4. End the note leader by clicking a vertex, edge, or face to attach the end of the note leader, or double-click to end
the note leader at any point.

The end of the note leader is an arrow unless you attach it to a face.

Snapping a Leader to 45° Increments
While creating a Leader, hold the Shift key to snap the Leader to the nearest 45° increment.

1. Click to set the start point of the Leader.
2. Start dragging to get near the desired orientation.
3. Press and hold the Shift key.
4. The Leader snaps to the nearest 45° increment.
5. Continue holding Shift down and dragging to set the length.
6. Click to set the endpoint of the Leader.

Underlining Note Text with a Leader
1. Create a Note
2. Enter the Leader tool
3. Attach a Leader to the underline location
4. Complete the Leader
5. Select the Leader
6. RMB > Underline
7. The text is underlined

When you start the leader, hovering near the note text displays attachment points. The image above shows the
underline location highlighted.

Select the leader and use the context menu to select Underlined. This toggles the leader to an underlined leader.

Inserting an All-Around Symbol
Right-click the note leader and select All Around.

Changing a Note Leader's Segments
Drag a segment of the note leader line to move it and its surrounding boundary points. Right-click the note leader
and select Add Jog Point to create a new segment.

You can delete note leader line segments by deleting the jog points that border the segment.
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Changing a Note Leader's Properties
1. Right-click the note leader and select Properties.

2. Modify the Arrow Style, Length, and Width values.

3. Set the All Around value to True to display an all-around symbol. Select False to hide it.

Attaching a Note Leader to a Virtual Sharp
1. Select the Note Leader tool

from the Annotation ribbon group in the Detailing tab.

2. Ctrl+click a line.

3. Ctrl+click a converging line.

The head of the note leader is attached to the virtual sharp. You can also drag the virtual sharp's end point, draw
another leader to the virtual sharp, create virtual sharps in cross-section, for rounds, and between an angled
and straight edge.

Examples

A virtual sharp

Attaching to the bottom connection point of a note to create a leader with a jog or shoulder.

Attaching to the center connection point of a note to create a straight leader.
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Use the center connection point to create circle flag notes or BOM balloon notes according to the JIS standard,
without a jog or shoulder.

8.5.5. Threads
Use the Thread tool

to create a threaded surface on any cylinder, cone, or hole. Select a thread edge or face to view its properties in the
Properties panel.

The depth of a threaded blind hole on a curved surface is defined as the measured distance from the end of the
thread to the closest point on the outer contour of the thread.

Creating a Threaded Surface
1. Click the Thread tool

in the Annotation ribbon group on the Detailing tab.

2. Click the edge of a cylinder, hole, or cone.

The threads are indicated as a spiral, not circular, texture on the surface, and the thread depth is shown when
you view the threaded object in Section mode. An inner thread

or outer thread

object also appears in the Structure tree. (Broken threads appear with a small yellow triangle over the icon.)

3. Click the surface to edit the properties of the threaded surface in the Properties panel.

• Type: Controls whether threads are selected from a table or entered manually. For cylinder threads, select
Standard to select values for the other properties from a drop-down list. The most likely values are selected
by default (next smaller size for external threads, and the next larger size for internal threads). Select Custom
to enter offset values. For tapered threads (threads made on conical surfaces) you can only use the Offset
option.

• Series: You can select ISO or UNC.

• Size: Select from a list of available sizes in the series you select.

• Thread Depth Type: Can be Blind or Full Thread. Full Thread is the default for through holes and Blind is
chosen automatically when the thread placement cylinder or cone ends in a plane at a convex edge.

• Minor Diameter: The smallest, or inner, diameter of a thread.
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• Major Diameter: The largest, or outer, diameter of a thread.

Changing the Depth of a Threaded Hole
1. Click the thread edge or hole in the Design window or select the thread in the Structure tree.

2. Press the Tab key or click the dimension field.

3. Type a new value for the depth.

Customizing the Thread Properties
The thread data XML files that drive the drop-down menus for Standard thread properties are located in the
SpaceClaim Library/Threads directory. You can:

• Add files to the directory to display the name in the Series property drop-down when you click the threaded
surface with the Thread tool. Remove files to remove them from the property.

• Add rows to an individual file to display them in theSizeproperty drop-down. Remove rows to remove them from
the property.

• Specify a different directory for thread files by adding a different directory to the support file options.

This is an example of the XML file used for threads:

<?xml version="1.0" encoding="utf-8"?>
<thread:ThreadSizeTable
xmlns:thread="http://www.spaceclaim.com/threadSizeTableVersion2">
<thread:Units>in</thread:Units>
<thread:ShowThreadDesignationInDiameterDimension>false</thread:ShowThreadDesignationInDiameterDimension>
<thread:ThreadSizes>
<thread:ThreadSize><thread:Name> 1 - 64 </thread:Name>
<thread:Size> 0.073 </thread:Size>
<thread:MinorDiameter> 0.0544 </thread:MinorDiameter>
</thread:ThreadSize>
</thread:ThreadSizes>
</thread:ThreadSizeTable>

To use the example above,

1. Copy the text inside the gray box and paste it into a text file.

2. Save the file with a .xml extension in the SpacClaim Library/Threads folder.

For example, your file could be named MyThreads.xml.

3. Change the text shown in red to your values.

Note: You should add your own custom files instead of changing the default files.
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8.5.6. Center Marks and Lines
You can put a center mark on any circle, arc, cylinder end, or sphere, and you can put center lines on any cylindrical
face on a drawing sheet.

Adding a Center Mark or Center Line
1. Click the Center Line tool

.

2. Click an:

• Edge of the end of the cylinder or hole to add a center mark.

• Cylindrical face to add a center line.

• Sphere to add a center mark.

Examples

Center mark on the end of a cylinder and center line along the face of a cylinder

Center mark on a sphere

8.5.7. Geometric Dimensioning and Tolerancing
ASME Y14.5 (2009) provides the standards for Geometric dimensioning and tolerancing (GD&T).

ASME Y14.41 contains additional requirements for tolerances defined in digital models.

SpaceClaim provides functionality for GD&T symbol creation based on this standard.

Help topics for symbol creation focus on functionality and workflow only.

For help with terminology, interpreting GD&T symbols, and understanding the motivations behind them, refer to
ASME Y14.5 (2009) and related publications.
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You can create both Encoded GD&T and GD&T Annotations.

GD&T Annotations:

• Simply annotations using GD&T symbols and tolerance values
• You manually build them up by selecting the symbols, entering values, and adding leaders

Encoded GD&T:

• Built into the model using geometric references.
• Contain logic based on the ASME Y14.5 (2009) standard
• Creation workflow assists in building the symbol
• Only geometry applicable to the selected characteristic symbol is selectable
• Tool guides step you through symbol creation
• Update according to geometry changes
• If changes cause symbols to become invalid they are flagged in the Structure Tree

8.5.7.1. Encoding Geometric Tolerances
Encoded GD&T symbols understand their dimensional and situational context within the model. So, when their
attachment references change in space or in type, the symbols update accordingly or become invalid.

GD&T is part of the Product and Manufacturing Information (PMI) exchanged between CAD systems. The PMI Working
Group recognizes two levels of information that can be exchanged in the context of explicit 3D geometric shape
representation and associated PMI.

• Representation: Describes the exchange of reusable, associative PMI that is not visible in the 3D model. It is used
"behind the scenes" by the CAD system and downstream applications.

• Presentation: Describes the exchange of information in a way that is user-visible in the 3D model.

Representation information is pointed to by the definitions shown in the Structure Tree. The geometry that the
definitions apply to are recognized as features which are displayed in the tree. Definitions which apply to the features
are shown as sub-nodes of the features in the tree. This includes dimensions for features of size. All GD&T items in
the Structure Tree are contained in the 'GD&T' folder as shown in the image below.

GD&T has its own Structure Tree folder.

Presentation information is the actual symbol shown in the graphics area and attached to geometry.
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Representation stays with the object because it is part of its Structure. Presentation information is built from the
representation.

So, when a solid with associated encoded GD&T is moved to a new component:

• Representation information is moved to the new component.
• Presentation information is not moved to the new component. Create new symbols in the component using the

Representation information in the Structure Tree.

ASME and ISO Standards
Both the ASME and the ISO standards are supported for GD&T. Set the standard in the General Detailing page of
SpaceClaim Options. You can apply the standard to the current document or to all new documents.

The descriptions in this topic are based on the ASME standard.

What You Need to Encode a GD&T Symbol
To encode a GD&T symbol, you construct a Feature Control Frame, which consists of a rectangle divided into
compartments containing:

• Geometric Characteristic Symbol
• Tolerance value or description
• Modifiers
• Applicable Datum Feature references

The image below shows an example Feature Control Frame with modifiers.

Prior to creating the symbol, you need to have the appropriate Datum Features

in the model.

The geometry to which a GD&T symbol is applied is usually called a "Feature". Features may be specified by:

• Directly selecting a part's faces
• Selecting an existing datum feature
• Selecting an existing Feature Control Frame in the structure tree or graphics window
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After choosing a Characteristic Symbol and the geometry (usually called Features) to which the tolerance will apply,
you will select the relevant Datum Feature references.

An exception is Form tolerances, which do not use Datum Feature references.

When you first create a GD&T symbol, the default Characteristic Symbol is Position. Once you choose a different
symbol, that becomes the default until you select another one.

Characteristic Symbols are shown in the table below.

Applied ToSymbolsTolerance Type

Individual
Features

CylindricityCircularityFlatnessStraightness

Form

Individual or
Related Features

SurfaceLine

Profile

Related Features

ParallelismPerpendicularityAngularity

Orientation

Related Features

SymmetryConcentricityPosition

Location

Related Features

Total RunoutRunout

Runout

Once you have selected the Datum Feature references, you are put in placement mode where:

• In 3D, you choose an annotation plane and then place the symbol somewhere within that plane
• In a drawing you place the symbol somewhere in the sheet

Encoding a GD&T Symbol
1. (Optional) Use the Datum Symbol

tool to create any Datum Features to be referenced by the symbol. (Datum Symbols are encoded as well)

• This is optional because the Form characteristics (Straightness, Flatness, Circularity, and Cylindricity) do not
require Datum Feature references

• For a single Feature Control Frame, you can select up to three Datum Symbols

• There are up to three Datum Feature references
• Each of these references may use a datum established by more than one Datum Feature (separated by "-"

as in the image below)
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• See ASME Y14.5 Paragraph 4.12 and Figure 4-22

• Each Datum Symbol can be used only once in a single frame

2. Select the desired Characteristic Symbol in the Options panel (see the table below)
3. Choose an Attachment Technique in the Options panel

• Size Callout (Attached to a dimension)
• Directed leader (Attached to a note leader)

4. Follow the prompts to select the necessary references

• You can Ctrl+select multiple faces for the following tolerances

• Profile
• Flatness
• Position for Planar Feature of Size (that is, Middle Plane)
• Coaxial cylinders (ASME Y14.5 Figure 4-34)
• For multiple faces:

• The symbol will show the number of faces by including "3X" for example to say the tolerance applies to
three faces

• Number of faces is not shown for Coaxial Cylinders or Middle Plane
• After creation, selecting the symbol will highlight all the faces

5. Click Complete to place the symbol
6. An annotation plane appears
7. Drag the plane to a desired placement

• As you drag the plane

• It will change orientation to other valid orientations based on the geometry under the cursor
• Existing annotation planes will pre-highlight for selection

8. Click to place the plane
9. The symbol appears

601Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



10. Drag the symbol to a desired placement
11. Click to place the symbol

After the symbol has been placed, you can add any appropriate modifiers by

1. Selecting the tolerance value or Datum Reference compartments to be modified
2. Choosing a Modifier from the mini-toolbar

Modifiers
When you select a symbol element, the mini-toolbar will present all relevant modifiers.

Their meaning and applicability are described in the relevant sections of ASME Y14.5 (2009) and ASME Y14.41.

Available Modifiers are shown below.

ModifierSymbol

At MaximumMaterial Condition (When applied to a
tolerance Value)

At MaximumMaterial Boundary (When applied to a
Datum Reference)

AtLeastMaterialCondition (When applied to a tolerance
Value)

At Least Material Boundary (When applied to a Datum
Reference)

Translation

Projected Tolerance Zone

Free State

Tangent Plane

Unequally Disposed Profile

Statistical Tolerance

Between

All Around

All Over

Some notes about Modifiers:

• Translation is applied to Datum References (A, B, C, etc.) to indicate the datum can translate within the specified
tolerance.

• Projected Tolerance Zone is applied to positional tolerances and includes a minimum projected tolerance zone
height. This is typically used to control variation in perpendicularity of threaded or press-fit holes where fasteners
could interfere with mating parts.

• Free State is applied to features or datum references that are subject to Free-State Variation. This is the distortion
of a part after manufacturing forces are removed. Free State tolerances apply after the removal of manufacturing
forces.

• Tangent Plane is applied to tolerances of Form only.
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• Unequally Disposed Profile is applied to Profile tolerances to indicate that the tolerance is not equally applied to
the profile. For example, the symbol below the modifier is between 0.3 and 0.1. This means the total tolerance is
0.3 and 0.1 liesOutside the profile andAddsmaterial. The remaining 0.2 lies Inside the profile andRemovesmaterial.

• Statistical Tolerance is used to assign tolerances to related components of an assembly based on sound statistical
data.

• Between indicates that the tolerance applies across multiple features or to a limited segment of a feature between
designated extremities.

The example below shows a profile tolerance between D and E. The system prompts you to select a direction and
a first and last face to include (first and last can be the same face). It places labels based on the next available
letters but you need to create notes pointing to the locations on the faces.

1. Select the Profile tolerance to modify

2. Choose Between from the mini-toolbar

3. Select an edge to set the direction of the limited region or group of features

4. Select the first face

5. Select the last face

6. Complete

• All Around and All Over apply to Profile of Surface symbols attached to dimensions (Attachment Technique = Size
Callout)

Diameter and width dimensions for Features of Size can have the Independency modifier added to the Dimension.
This revokes Rule #1 in the ASME standard. Rule #1 establishes a boundary of perfect form at the MMC size limit.
Rule #1 is also called the Envelope Rule.

To add the Independency modifier, select the dimension, and set the Suspend Envelope Rule property to True in
the Properties panel.

An example is shown below.
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In the ISO standard, the Envelope Rule is not applied by default. So, if you are using the ISO standard and want to
apply the Envelope Rule, you need to set the Impose Envelope Rule property to True in the Properties panel.

Multi-Segment Feature Control Frame

You can add segments to GD&T symbols in much the same way as they are initially created. This creates an FCF
stack.

Instead of selecting geometry, you select the Characteristic Symbol of an existing GD&T symbol.

Based on which Characteristic symbol you wish to add, the system will limit which existing symbols are available.

For example, adding Concentricity to the position tolerance of a hole is invalid.

FCF stacks are sorted by tolerance value. The largest value is always in the first FCF and the values decrease as you
go down the stack.

Feature-Relating Tolerance Zone Framework

A Feature-Relating Tolerance Zone Framework (FRTZF) contains a single entry of a Characteristic Symbol followed
by each tolerance and datum requirement, one above the other.

FRTZF applies to Position and Profile tolerances used with Patterns.

Each segment can have the same number of Datum Feature References or Less than the segment above it.

To create a FRTZF:

1. Select an existing Position or Profile tolerance value
2. The mini-toolbar appears

3. Select Add Feature-Relating Tolerance Zone Framework
4. A second tolerance segment is added below the first
5. Repeat as many times as needed

To set the FRTZF Datum Feature References:

1. Select the first secondary tolerance value

2. The mini-toolbar appears

3. Choose one of the following:

• Remove Feature-Related Tolerance Zone Framework - to remove the segment
• Show one repeated datum reference
• Show two repeated datum references
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• Show three repeated datum references

The mini-toolbar options will adjust depending on which segment tolerance is selected.

Datum Features Symbols for Patterns
For patterns, you can create a Datum Feature Symbol that applies to a single member only, or the whole pattern.

In the Options panel, check the Use One PatternMember Only option On to apply the symbol only to the selected
pattern member. Check it Off to apply the symbol to the entire pattern.

The image below shows an example. For the entire pattern, the number of pattern members is included in the
symbol.

Datum Reference Frame
The Datum Reference Frame (DRF) consists of three mutually perpendicular planes inferred from three Datum
Features.

Datum Features that comprise the DRF can be a combination of planes and cylinders.

The DRF is inferred from the Datum Feature References. This does not mean the references have to be three orthogonal
planar features.

The XYZ coordinate system in the image above is the Datum Reference Frame formed by the three Datum Features
A, B, and C.
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When you select a DRF in the Structure Tree, it highlights in the Graphics Window. If the DRF has any unconstrained
degrees of freedom (DOF), the DRF display in the graphics window is animated to show movement in the unconstrained
DOF's.

DOF information is displayed in the Properties panel for a selected DRF. The constraints are established by default
rules when the DRF is created. In some cases, you may want to override the defaults. Each Datum of the DRF can
have it's constraints modified with a dropdown menu in the Properties panel of the DRF.

Selecting a DRF in the Graphics Window highlights it in the Structure Tree.

The DRF may not be valid if changes have been made to invalidate any of the symbols. Invalid Datum Features are
marked with a Red 'X' in the Structure Tree.

You can Delete a DRF by selecting it in the Structure Tree like other SpaceClaim objects.

Datum Targets
Datum Targets are Points, Lines and axes, or Areas used for establishing a datum. Because of inherent surface
irregularities, the entire surface of certain features cannot effectively define a datum. Some examples are:

• Nonplanar or uneven surfaces produced by casting, forging, or molding
• Weldment surfaces
• Surfaces with thin sections subject to bowing, warping, or other distortions

You can think of Datum Targets as representing contact between the part and a measuring gage or fixture. points
represent contact with a pointed pin, or a pin with a spherical end. lines represent contact between a cylindrical
part and a cylinder on the fixture. Areas represent contact with a flat-ended pin (either rectangular or circular).

The image below shows the different Datum Targets. From left to right they are, Point, Line, Area (rectangle and
Circle), and the three points on the cylinder define a Datum Axis.

Datum targets are all created with a single pick point on a surface. The pick point locates the Datum Target as follows.

• Point - The point
• Area - The centroid of the area
• Line - The midpoint of the line
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• Axis - The surface must be cylindrical or conical. The pick point locates a plane defined by three equally spaced
points. The axis is perpendicular to the section and passes through the center.

Datum Target Lines are created with a default Length and Orientation. To change either one, select the line and edit
its Length or Orientation properties in the Properties Panel.

Datum Targets as Datum Features
Datum Targets can be encoded into the model as Datum Features. Select the Datum Symbol tool

and select Datum Targets. They establish Datum Features when selected as follows:

• 1 Point or Area = Datum Point
• 2 Points or Areas = Datum Line
• 1 Line = Datum Line
• 2 Lines = Datum Plane
• 3 Points or Areas = Datum Plane

Basic Dimensions
Basic Dimensions locate the controlled features back to the Datum Reference Frame. They are generated automatically
once the DRF is established. All you need to do is place them.

1. Right-click a GD&T Feature in the Structure Tree.
2. Choose Create basic dimensions from the context menu.
3. Mouse over the design to drag each dimension and click to place them.

• Tool guides are available to switch between the different directions (X, Y, Z) and to change annotation plane.
• The tool guides and hints will be different based on the type of feature being dimensioned.

The image below shows Basic Dimensions for a Surface Profile tolerance.
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Creating Symbols from Items in the Tree
You can recreate Datum Feature symbols and Feature Control Frames in the graphics window and drawing views
from symbols listed in the Structure Tree.

1. Select a GD&T in the Structure Tree
2. RMB > Create Feature Control Frame Symbol
3. Select or place an Annotation plane
4. Drag the symbol to place it

If you select a Datum Feature in the tree, follow the same procedure but use RMB > Create DatumFeature symbol

Locking Encoded Features
Features that have encoded GD&T can be locked. Once a feature is locked, it can't be modified in any way that
violates the encoded tolerance.

To Lock an encoded feature, select the feature in the Structure Tree and use RMB > Lock feature.

When a feature is Locked, the system runs checks after any modifications are performed to verify that the encoded
tolerance is not violated. The modifications will preview but will snap back to the original geometry if any of the
following are changed or removed.

• Basic Dimensions
• Size Dimensions
• Implicit Dimensions:

º Zero distance from a DRF axis (that is. coincident with the axis)
º Parallelism
º Perpendicularity

To Unlock an encoded feature, select the feature in the Structure Tree and use RMB > Unlock feature.

Track Encoding
Track Encoding

allows you to see the encoding status of your model as you add GD&T. The button has two parts. The top part of the
button is a global ON/OFF switch to turn tracking On and Off. The bottom part of the button is a dropdown menu
with two choices, which are both ON by default.

• Dim Encoded Faces shows faces as dimmed when they have GD&T encoded in them.
• Dim Encoded Symbols shows GD&T symbols as dimmed when they are encoded in the model and not simply

annotations.
• Showall annotations shows all annotations, including non-root parts. Use this option for components imported

from other CAD systems to make sure that all annotations are shown.

Reasons to use Tracking include the following.

• You want to see how much of the model geometry is currently controlled with encoded GD&T.
• The model is imported and you do not know how the GD&T was created, or you not know the quality.

º If you include PMI on import, it may all come in fine
º Some GD&T may not import correctly
º PMI is not available for all imported file types

• The model may have been created in an earlier version of SpaceClaim, before PMI was supported
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Track Encoding Example
When the model is opened it looks like
this. There is some GD&T already applied
to the model but you do not know if it is
encoded or not.

Turn Tracking ON to immediately see
what is encoded. In this example, all but
one symbol is encoded. The
non-encoded symbol is NOT dimmed.

If you turn Faces OFF, you can focus on
just the symbols as shown here.

8.5.7.2. Geometric Tolerance Annotations
Use the Geometric Tolerance tools in the Annotation ribbon group in the Detailing tab to add a tolerance to your
design, drawing sheet, or 3D markup slide. Geometric Tolerance Annotations are not created automatically. You
can enter anything in a geometric tolerance annotation, so read the geometric tolerance tooltips carefully to create
intelligent geometric tolerance annotations.
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Creating a Geometric Tolerance Annotation
1. Click the Geometric Tolerance tool

2. Select Annotate GD&T from the dropdown menu

3. Click to place the geometric tolerance annotation on the appropriate annotation plane and display the Format
tab.

4. Select the characteristic symbol from the Symbol drop-down in the Geometric Tolerance ribbon group.

5. Click in one of the Tolerance fields and enter any combination of text and modifying symbols from the Symbols
ribbon group.

To create multi-row geometric tolerance annotations, select a characteristic symbol, then enter text and modifying
symbols in the second row. To combine the two rows so that they have one characteristic symbol, check the
Composite Frame option.

6. Press Esc to exit the annotation and close the Format tab.

Displaying the Text of an Annotation and Hiding the Plane
1. Create two layers, one for notes, and one for the annotation planes.

2. Place the note on one layer and the annotation plane on another layer.

3. Turn off the visibility of the layer that contains the annotation plane.

610Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



8.5.7.3. Datum and Surface Finish Symbols
You can insert datum symbols onto your design, drawing sheet, or 3D markup slide. Datum symbols are encoded
in the model, which means they update to changing attachment objects.

Datum symbols appear in the tree and show their attachment objects when selected.

Adding a Datum Symbol
1. Select the Datum Symbol tool

.

Mouse over the faces of your design to preview the eligible annotation planes.

2. Click to attach the datum symbol.

3. Drag and click to place the symbol.

Replacing a Dimension with a Datum
1. Click the Datum Symbol tool

.

2. Click the dimension text.

Displaying the Text of an Annotation and Hiding the Plane
1. Create two layers, one for notes, and one for the annotation planes.

2. Place the note on one layer and the annotation plane on another layer.

3. Turn off the visibility of the layer that contains the annotation plane.

8.5.7.4. Datum Targets
Use the

Datum Target tool in the Detail tab Annotations group to create datum targets in your design, drawing sheet, or 3D
markup slide. As shown below, you can insert the following datum target types:

• Point
• Circular Area
• Axis (cylindrical or conical only)
• Line
• Rectangular area
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The top field of a datum target is the dimension (target area size or the diameter of the datum target point); the
bottom field is the reference letter (target identifying letter), as shown in the image below:

When you create a datum target, by default, the datum callout height ratio is 3.5. This setting controls how many
times the current text height the callout circle size should be, for example, the setting of 3.5x is for ASME, and ISO
and ISO-based models use a 4x setting.

Inserting a Datum Target
1. Select the Datum Target tool.

2. In the Options panel, choose the target type.

• Point

• Circular area

• Rectangular area

• Line

• Axis

3. Hover over the faces of your design to preview the eligible annotation planes.

4. Move the cursor to where you want to place the target.

5. Click and drag the target leader to a position inside or outside the annotation plane.

6. Click the top field to enter (or to change an existing) number or letter for the callout, as shown in the image set
below:
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Editing a Datum Target
Datum targets have three components. You can change the properties of each in the Properties panel.

• With a callout selected, you can change the following properties:

º Hidden - True or False
º Layout - If Number of Callouts is greater than 1, they can be stacked Top, Bottom, Left, or Right.
º Number of Callouts - Greater than or equal to 1
º Text Height - Based on model units
º Text Position - Inside or Outside the callout

• With a leader selected, you can change the following properties:

º Arrow Style - Choose from the drop-down list of available styles.
º Arrow Length - Choose the Default or enter a value in model units.
º ArrowWidth - Choose the Default or enter a value in model units.

• With a target selected, the available properties depend on the type of target.

º Point

Type - Choose from Point, Circular, or Rectangular.
Point Size - Enter a value in model units.

º Circular area

Type - Choose from Point, Circular, or Rectangular.
Radius - Enter a value in model units.
Rotation - Enter a number of degrees to rotate the circle.
Hatch Angle - Enter a number in degrees.
Hatch Spacing - Enter a number in model units.

• Rectangular area

º Type - Choose from Point, Circular, or Rectangular.
º Width - Enter a number in model units.
º Height - Enter a number in model units.
º Rotation - Enter a number of degrees to rotate the rectangle.
º Hatch Angle - Enter a number in degrees.
º Hatch Spacing - Enter a number in model units.

• Line

º Length - Enter a number in model units.
º Point Size - Enter a number in model units.
º Rotation - Enter a number of degrees to rotate the line.
º Show Points - True or False

• Axis

º Point Size - Enter a number in model units.
º Rotation - Enter a number of degrees to rotate the line the point and leader attachment locations.
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º Show Points - True or False

You can change default settings for datum callouts and targets from the Annotation group in General SpaceClaim
Options.

• Showdatum target end points: Checkbox to control whether or not datum target lines should show their end
points.

• Datum Callout text height ratio: Controls how many times larger the callout circle should be compared to the
text height.

• Datum Target default point size: Controls the point size used by datum target points, lines, and circles. Default
point size can be overridden on a per object basis.

• DatumTargetareadefaulthatchspacing:Controls the hatch spacing for circular and rectangular datum targets.
Default spacing can be overridden on a per object basis.

• Datum Target area default hatch angle: Controls the hatch angle for circular and rectangular datum targets.
The default angle can be overridden on a per object basis.

• Datum callout leader arrow shape: Controls the arrow shape of leaders connected to datum targets.

• Linestyle options:

º Set line style and thickness for Datum target area borders
º Set line style and thickness for Datum target area lines

Dimensioning Datum Targets
You can dimension in the following ways:

• To or from the circular area of a datum.
• To or from the center of a rectangular datum or any of its edges.
• To the endpoints of a datum target line or the entire line.
• The diameter of a datum target axis by clicking on the circle.
• From each point of the datum target axis.

Assembly Considerations
Datum targets only appear in the root document of the current design window. If they appeared in the component
itself, they would be shown in every occurrence of the component in an assembly. Having them in the root document
of the design window provides flexibility and prevents multiple, unnecessary duplicates.

For example, in a table with four legs, each leg is the same component, but each leg in the table assembly may need
a different datum target, or no target at all. See the image below.

614Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



8.5.8. Welding Symbols
You can insert Welding Symbols into your design, drawing sheet, or 3D markup slide. They can be created with or
without geometry in the design window.

Symbols can be made to either the AWS or ISO standard.

• AWS follows the specification titled "AWS A2.4:2007 Standard Symbols for Welding, Brazing, and Non-Destructive
Examination."

• ISO follows "ISO 2553:1992 (E) Welded, Brazed, and Soldered Joints - Symbolic Representation on Drawings - p.193
of ISO Drawings."

SpaceClaim defaults to the AWS standard. You can change this in theAnnotationoptions in theDetailing>General
section of SpaceClaim options. The setting is independent of the standard chosen for font.

The basic procedure for creating Welding symbols is to build up the symbol, adding progressively more detail while
the UI adapts intelligently based on your choices. There are tooltips available for every possible input value or
symbol. Box-selecting the entire symbol will show all possible places to input values. Weld symbols can be created
and edited while in the Welding Symbol tool.

The image below shows a blank welding symbol. As you move the cursor over the highlighted areas, tooltips will
guide you in building the symbol.

Welding symbols have an Arrow side and an Other side. The Reference line divides the symbol into the Arrow Side
and the Other Side. In AWS, the Arrow Side is always on the bottom of the Reference line. In ISO, the Arrow Side is
identified by a dotted line as shown in the image below.

Creating a Welding Symbol
1. Select a Welding Symbol Standard in the Annotation options in the Detailing>General section of SpaceClaim

options.
2. Click the Welding Symbol.
3. Click to place the arrow
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4. Click to place the Reference Line.
5. The symbol is now placed and ready to be built.

a. You can add or remove a Jog Point to a Welding Symbol leader while in the Welding Symbol tool. RMB click
the symbol leader to display this option.

b. You can press the ESC key after beginning symbol placement to delete the leader and cancel the tool.

6. As you move the cursor over the symbol, highlighting will indicate where you can add symbol elements or input
values.

Do any of the following in any order to build up the symbol.

• Click either the Arrow Side or the Other side box to display the symbol palette (see images and details in the
sections below).

AWS Symbols
The AWS symbol palettes are shown below. Some symbols are only available for Arrow side.

Arrow Side

Other Side

The symbols are described in the following table.

Weld TypeAWS SymbolWeld TypeAWS Symbol

StudGroove square

Spot or projectionGroove scarf

616Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



SeamGroove V

Back or backingGroove bevel

SurfacingGroove U

EdgeGroove J

Joint geometry not
specified, groove weld size
specified

Groove flare V

Melt-throughGroove flare bevel

Consumable insert squareFillet

Backing rectanglePlug

Slot

ISO Symbols
The ISO symbol palettes are shown below. Some symbols are only available for the Other side.

Arrow Side

Other Side
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The symbols are described in the following table.

Weld TypeISO SymbolWeld TypeISO Symbol

Spot weldButt weld between plates
with raised edges

Seam weldSquare butt weld

Steep-flanked single-V butt
weld

V butt weld

Steep-flanked single-bevel
butt weld

Bevel butt weld

Edge weldV butt weld with broad root
face

SurfacingBevel butt weld with broad
root face

Surface jointBevel butt weld (parallel or
sloping sides)

Inclined jointJ butt weld

Fold jointBacking run: back or
backing weld /USA/

Backing stripFillet weld

Plug weld: plug or slot weld
/USA/
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• Click the Reference line to display the Reference line mini-toolbar (see images and details in the section below).

Reference Line Mini-Toolbar Options
OptionSymbol

Stagger intermittent welds

Weld all around

Field weld

Swap arrow and other sides

Joint with spacer

Show tail even if reference is not used

Add welding reference line

Add welding symbol leader

• Click the Tail text box to enter a specification process or other reference. If there is no reference, the tail will be
omitted. You can choose to show the tail regardless of reference by clicking on Show tail even if reference is not

used

1. As you select symbols from the palette and choose options from the mini-toolbars, the available symbols and
options will change to present only those that make sense for the current symbol configuration. Tooltips are
provided to describe possible symbols and inputs.

2. Selecting symbols after they are placed will display the symbol mini-toolbar, which contains options to:

• Open the symbol palette and change the symbol

• Add secondary symbols appropriate for the selected symbol. For example, a backing symbol can has the option
to add a Removable backing symbol

• Add contour symbols for (left to right): No contour symbol; Flush or flat; Convex; Concave

• If you add a Contour symbol, you can add a Finishing symbol for:Nofinishing;Chipping;Grinding;Hammering;
Machining; Planishing; Rolling; Unspecified
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Some Notes About Welding Symbols
• Welding symbols can have multiple leaders.
• To delete a welding symbol, select the leader and press the Delete key. If there are multiple leaders, you need to

delete them all to delete the symbol.
• You can CTRl+drag to copy a welding symbol.
• You can only input one line of text in the symbol text blocks.
• If you need to resize the Reference Line, change the font size to change the size of the Welding Symbol.
• Newly inserted symbols are placed in the current active layer.

8.5.9. Barcodes
You can place Barcode annotations in your design, drawing sheet, or 3D markup slide. Barcodes are placed on
Annotation planes and are shown in the Structure Tree. If there are also Notes in the design, Barcodes and Notes
each get their own folder in the tree. Barcodes can be patterned in the same manner as Notes.
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Adding a Barcode
1. Select the

Barcode tool in the Annotation group of the Detail tab
2. (Optional) Change the Display options

• Type: Choose one of the many standard types from the dropdown list (default is 'Code 2 of 5')
• Show Text: Checkbox displaying or hiding Barcode text

3. Place the Barcode on an annotation plane
4. You can continue to place more Barcodes or exit the tool

Modifying a Barcode
Select a Barcode and modify any of the following properties

• Type: Choose one of the many standard types from the dropdown list (default is 'Code 2 of 5')
• Data: This is the text that gets displayed (default is '123456')
• ModuleWidth: Enter a value for the module width. This is the smallest width and/or length of a space, bar, or dot

in the barcode symbol.
• Width: Enter a value for the width
• Height: Enter a value for the height
• Show Text: True or False

Module Width and Width are coupled. Specifying one will determine the other.

Additional properties are available for the following:

• Data Matrix

º Size: Choose one of the many standard sizes or Compute size
º Rectangular: False (default) or True

• PDF417:

º Error Correction: Choose one of the Levels or retain Default
º Rows, Columns: Auto (default), or choose an appropriate number

• QR-Code:

º Redundancy: Default is Medium (15%), choose from the options available
º Encoding: Choose from the options available

• Aztec Code:

º Error Correction: Default is 23%, choose from the options available
º Size: Choose one of the many standard sizes or Compute size
º Enforce Binary Encoding: False (default) or True
º Rune: Default None, or choose from the options available

Displaying a Barcode and Hiding the Plane
1. Create a layer, for annotation planes.

2. Place the annotation plane on the layer.

3. Turn off the visibility of the layer that contains the annotation plane.
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8.5.10. Bolt Circles
• You can create a Bolt circle for either one- or two-dimension circular patterns.
• A Bolt circle displays in the Structure tree as an Annotation Plane. You can deselect the Annotation Plane check

box to hide the Bolt circle.
• Bolt circle information does not update if you modify the options for your pattern, such as Circular count or Angle.
• The count and angular dimension are separate and can be deleted individually.

Creating a Bolt Circle
1. Select the Bolt Circle

tool from the Annotation ribbon group in the Detail tab.
2. In your circular pattern design, click the face of your design that holds the pattern member to create a datum

plane on which to place your Bolt circle.

SpaceClaim creates a datum plane for the Bolt circle.

3. Select a pattern member.

SpaceClaim automatically adds dimension call outs, arrows, and lines to the annotation plane. You can click an
arrow or line to view or modify each dimension's values in the Properties panel.

8.5.11. Bills of Materials (BOMs)
You can insert a Bill of Materials (BOM) onto your design, drawing sheet, or 3D markup slide. BOM values are
automatically populated for both internal and external components that are part of an assembly. SpaceClaim only
itemizes components. If the design only has solids in the structure tree, they will not be included in the BOM. The
QTY column in a design's BOM table shows the number of sub-components, not items, that are included in an
assembly.

When a drawing includes a BOM table that contains data added with a newer service pack of SpaceClaim than you
are using, the new columns are displayed in red. This indicates that the data cannot be changed, and can only be
viewed.

You can include X, Y, and Z dimensions of components in a BOM table. The extents shown are the exact extents of
all solid and surface geometry in the component, for both visible and hidden solids and surfaces. Sketch curves,
bitmaps, and other entities are not included in the extents. Use these dimensions to create a cut list of parts in an
assembly of panels in the BOM, along with their number and dimensions. See the instructions for adding a column
to a BOM table below.
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Adding a Bill of Materials to a Document
1. Click the arrow next to the

Bill of Materials tool in the Annotation group on the Detailing tab and select a type:

• Top level: Creates a table that includes only parent components (or parts):

• Parts only: Creates a table that includes all child components:

• Indented: Creates a table that includes all components, with child components indented:

The last type of BOM you created is remembered and will be automatically chosen if you click the BOM icon
instead of the drop-down arrow.
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2. (Optional) If you created a view of a component on the drawing sheet, select the component on the Options
panel to create a BOM for just that component.

3. (Optional) Modify the Bill of Material's properties in the Properties panel.

• The Hidden components option allows you to control whether or not hidden components will be included in
the BOM.

• There are many other options for controlling the cosmetics of the BOM.

4. Click to place the Bill of Materials on the design, drawing sheet, or 3D markup slide. The table appears in gray
until you place it, and it changes to black after it is placed.

To cancel, press the Esc key before you click to place the table.

The BOM appears in the Structure tree.

You can copy and paste a BOM, and you can copy the contents from a BOM table and paste them into Microsoft
Excel.

Editing a Bill of Materials
• When you change a value in a BOM table, the property is changed. You can also select the BOM and edit its properties

in the Properties panel.

• Select a row or column, right-click, and select from the menu to Insert rows or columns.

• Select a row or column, right-click, and select from the menu to Delete rows or columns.

º You can only delete rows that you insert

º You cannot delete all columns. If there is one column left, it cannot be deleted.

• Select a row, right-click, and select Split Table from the menu to divide the BOM into two tables, for example, if
necessary to fit on the drawing sheet.

• Re-size a table by dragging the circles at its corners or edges.

• Rotate a table by dragging the green circle at the top of the table.

Adding Columns to a BOM Table
1. Right-click an existing column and select Insert > Insert Columns to the Left or Insert Columns to the Right.

2. Select the new column by clicking above the first row of the column, like this:

3. Select a Column Type in the Properties panel.

4. Select aColumnValue if you selected Document Property, Material Property, or Custom Property for the column
type. The values in the column will be automatically filled-in.

If you select Material Property for the column type and Mass or Volume for the column value, then the column
data will only be filled-in when a material has been assigned to the object.
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Exporting a Bill of Materials
1. Select a BOM table, then click its edge to select the entire table. The edge will change from a dashed line to a

solid line when you have the entire table selected.

2. Right-click the table and select Save Table As.

3. Select HTML, XML, BOM Template (.scbomtemplate) for the Save as type.

If you choose 'BOM Template' as the type, all the formatting, header, table properties, and contents are saved to an
.xml file which you can edit.

Using a BOM Template
1. Click the arrow on the BOM tool.
2. Select Template from the drop-down list.
3. Select the .scbomtemplate document and click the Open button.
4. Place the BOM table.

Sorting a Bill of Materials
You can sort the columns in a BOM table.

1. Select a column.
2. Choose Sort by column in the RMB menu.
3. The values are sorted numerically and then alphabetically in ascending order.
4. Sort the column a second time to sort in descending order.

You can manually edit any values in the BOM but any sorts have to be re-done to update the table.

Sorting works with indented and regular BOM's.

Sequential sorting is remembered across columns. Below is an example of two sequential sorts:

1. First sort items alphabetically by name.
2. Then sort numerically by Quantity.
3. Result:

a. Rows are put in ascending order according to Quantity
b. Items with duplicate quantities are then put in alphabetical order according to their names. In the image

below, items are sorted by Quantity (1, 2, 3). Then all items with a Quantity of 1 are sorted alphabetically.
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Grouping Rows in a Bill of Materials
You can group rows in a BOM table based on a selected Custom Property.

1. Add a column to the BOM
2. Select the column and set the Column Type property to Custom Property
3. Set the Column Value property to be the Property that you want to group
4. Set the Group Using property to be the Property that you want to group
5. You can control the row numbering for the grouped rows using the Start groups from property

• Number items sequentially
• 102, 102, ...
• 1001, 1002, ...
• 10001, 10002, ...

Notes on row grouping:

• Top Level and Parts Only BOM's only (not Indented)
• Only one grouping is allowed per BOM
• Sorted by Custom Property Values in alphabetical order (inside groups, normal sorting order applies)

Example:

BOM with "Part Type" custom property
column added
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Group Using property set to "Part
Type" and default row numbering

Start groups from property set to
Number rows sequentially

8.5.12. Balloons
Use the Balloon tool

to add BOM balloon notes. The content of the balloon updates when changes are made to the BOM table.

The document must contain a BOM table for the Balloon tool to be enabled.

Adding BOM Balloon Notes
1. From the drop-down menu on the Bill of Materials tool in the Annotation ribbon group, select a type:
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• Item number

• Part number

• Item number and quantity

2. Click a face or edge in the drawing sheet or Design window to attach a balloon to the object.

3. Click again to place the balloon.

Automatically Adding BOM Balloon Notes to a View
1. Right-click a view.

2. Select Autoballoon and then Item Number, Part Number, or Item Number and Quantity.

These menu options are only available when a view has a BOM.

8.5.13. Surface Finish Symbols
You can insert surface finish symbols onto your design, drawing sheet, or 3D markup slide. Surface finish symbols
move along with the surface they are attached to.

Adding a Surface Finish Symbol
1. Select the type of symbol you want to use from the Surface Finish tool

drop-down.

Mouse over the faces of your design to preview the eligible annotation planes. If an annotation plane already
exists, right-click and select Select New Annotation Plane to choose a different plane.

2. Click a face to place a leader on the plane.

You can click as many faces as you'd like to add leaders to those faces.

3. Click in an empty area of the Design window to place the surface finish symbol.

4. You can continue to place empty symbols of different types
5. When you have placed the number of symbols you want, click Select
6. Select a symbol to edit it's parameters. Depending on the symbol Type and Template, different parameters will

be available. The image below shows a Material Removal Required type using the Standard Template.
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7. Click in a parameter block and enter text or symbols

You can press Tab to switch between the fields. Right-click and select

from the mini-toolbar to insert a symbol.

8. In the Properties panel, you can also modify:

• Font Size to change the font size for all the text parameters on the symbol.

• Template to change the number of fields.

• Show All Around Symbol to add that symbol to the surface finish symbol.

• Type to change the type of surface finish symbol.

Displaying the Text of an Annotation and Hiding the Plane
1. Create two layers, one for notes, and one for the annotation planes.

2. Place the note on one layer and the annotation plane on another layer.

3. Turn off the visibility of the layer that contains the annotation plane.

Example

Surface finish symbols using the Standard, Standard 2, and Standard 3 templates

Surface Finish symbols can be Copied and Pasted within, and between, drawing sheets.

8.5.14. Tables
You can place a table on an annotation plane using the Table tool in the Annotation ribbon group.

You can copy annotation dimensions from drawings and paste them into tables, and their values will be updated
when the dimensions change.

Adding a Table
1. Add an Annotation plane or activate an existing plane.

2. Click the Table tool
.
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3. Drag to create the table with as many columns and rows as you need. The default cell size is determined by the
font size in the Detailing tab.

Table Editing Operations
• Select the table, then drag to select multiple cells. Once multiple cells are selected, you can right-click and select
Merge Cells or Unmerge Cells.

• Right-click a cell and insert columns and rows.

• Select one or more cells and right-click to access the other context menu functions, which allow you to add and
remove columns and rows.

• Click within a table cell to edit its contents.

• Drag a column or row boundary to resize the column or row.

• Select rows, columns and cells by positioning the cursor to the left of the row, to the top of the column, and in the
internal left side of the cell.

• Select and then drag a row or column to move it within the table.

• Apply font and paragraph properties to selected text.

• Press Tab to navigate through table cells.

• Resize a table by dragging the circles at its corners or edges.

• Rotate a table by dragging the green circle at the top of the table.

• Copy an annotation dimension and paste it into a table cell. The dimension value will be updated automatically
if the dimension changes.

Moving or Rotating a Table
1. Click the outer, dotted border of the table to select it.

2. Use the:

• Arrow keys to move the table.

• Ctrl+arrow keys to move the table by a very small amount.

• Round handle at the top of the table to rotate the table.

Deleting Text Within a Table
1. Select all the cells in the table.

2. Press Delete.

Deleting a Table
1. Select the table.

2. Select the rectangular border.

3. Press Delete.
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Modifying Table Properties
1. Click the outer, dotted border of the table to select it.

2. Enter values in the Properties panel.

You can modify:

• Cell alignment and margins.

• Position of the table anchor.

• Number of rows and columns, column width, and row height.

Copying Table Contents
Press Ctrl+C or right-click and select Copy. You can paste the data from a table into Microsoft Excel.

8.5.15. Hole Tables
A Hole table displays in the Structure tree as an Annotation Plane. You can deselect the Annotation Plane check box
to hide the Hole table. A Hole chart displays the quantity of holes in your design that have similar diameters. Once
you create a Hole table, origin points, and X and Y axis labels, display as shown in the image below, and you can
create a Hole chart:

Creating a Hole Table
1. Click a planar face that includes holes. SpaceClaim creates a datum plane for the Hole table.
2. Click and drag the Hole table to an empty space in the design window. X and Y axis labels, and an origin point,

display.

Holes with counterbores, countersinks, or fillets are shown in the table. Dimensions are taken from the intersection
with the top plane and the hole.

SpaceClaim uses all faces of the solid with the same orientation to collect holes for the table. Label editing works
for holes that appear on multiple faces as shown in the image below.
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Moving a Hole Table Origin
You can drag a Hole Table origin to move it. As shown in the image below, an origin displays as a red circle:

• To view the origin, hover over the two perpendicular axes for the X and Y coordinates (with extension lines).
• When you select an origin, its size increases and all valid origin positions display as red origin points. These origin

points remain visible until you begin to drag the origin to a different position. As you drag the origin, the X and/or
Y coordinates data in the Hole Table immediately updates to provide a preview of X and Y coordinates data for
the various origin positions.

• When you release an origin to set the new location, the origin points no longer display, and the Hole Table updates
to reflect the X and Y coordinate position of the new origin location. When moved close enough to another valid
origin position, the X and Y coordinate display in the new position, and the origin snaps to the new location. as
shown below:

•
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Formatting Font Text Properties for Hole Table Elements
You can use the Font options in the Font group of the Design tab to format the font text properties of the X/Y labels
and all hole labels, as shown in the image set below. For example, you might prefer text to display in a non-default
font, or a Microsoft Windows 3.1 font, such as Modern, Roman, or Script. You can also change font text properties
of hole tables that display for either single or multiple faces.

1. Select and an origin axis or extension line.
2. Click the Detail tab, and, from the Font group, choose your Font options.

The axis or line font changes automatically to update to your selection.

The images below show samples of hole tables with different fonts used for hole labels and X and Y axis coordinates:

Working with Hole Tables
• Use the pull handles on the table or chart to size as needed. Use the round handle at the top of the table to rotate

the table or chart.
• Just like a regular table, you can change the values in the Rows and Columns cells in the Properties panel to adjust

the number, width, or height of a table element.
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• You can change individual axis label text and text properties (text is a single line). For example, you could have
X-A coordinates instead of X-Y.

•
• If you make changes to your design, select the table ( or X or Y axis) and use the RMB to:

º ShowHole Chart to create another chart.
º ShowHole Tableto create an updated table.
º Save Table As a Web (.htm, .html) or XML file.

• When you change the size of a hole, the values in the table update, and the table re-orders and re-classifies the
holes and rows of the table.

• When you copy and paste a hole, the table updates to display a new row with the hole's X, Y, and Description
values.

• After you drag a label to another position on the design, the table updates to the size and position of the new hole.
To display your changes in a new table, right-mouse click and select ShowHole Table.

• To remove a table or chart, select the table, right-mouse click, and select Cut.

8.5.16. Curve Table
Curve Tables contain information about selected curves. They apply to:

• Sketched curves
• Turn Profile curves
• Deburring curves

The image below is an example of Turn Profile curves.
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Curve tables are similar to Hole Tables.

• They require an origin
• Are stored with the model
• Are shown in the Structure Tree

The following information is included in the table.

• Curve Type: Line or Arc
• Start: The starting point of a curve
• End: The end point of a curve
• Center: The center point of arcs
• Rotation: The rotation direction (CW or CCW)

Creating a Curve Table
1. Open the Detail tab.
2. Click Curve Table in the Annotation group.
3. Choose the Table Type in the Options Panel.

• Interactive: The curve information in the table updates when the curves are changed. An example is shown
above.

• Snapshot: Creates a table of curve points that does not update when the curves change. Snapshot tables are
described in a later section.

4. Select an Origin for locating the curves.
5. Select one or more curves to include in the table.

Box-selection is available.

6. Click Complete.
7. Place the table.

If all the curves are in the same plane, that plane is used for placement by default. If the curves are in multiple
planes, drag the cursor over the model to highlight planes and select one.

Manufacturing-focused Curve Tables
Manufacturing-focused tables are created for Turn Profile curves. They contain information that is useful for
programming the turning machine.
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Note: When working withTurnProfile curves, make sure youAlt-select an origin when you create the Turn
Profile. This ensures that the curves are in-plane and will generate rotations properly for
Manufacturing-Focused Tables.

The following information is included in the table.

• Curve Type: Line or Arc
• Start: The starting point of a curve
• End: The end point of a curve
• Center: The center point of arcs if I, J, K values is used.
• Radius: If I, J, K values are not used.
• Code: The rotation direction in machine code

º G02 = CW
º G03 = CCW

• Feedrate: Feedrate is not generated automatically. It is an editable field where you can enter a machine feedrate.

Creating a Curve Table for Manufacturing
1. Open the Detail tab.
2. Click Curve Table in the Annotation group.
3. Click Interactive in the Options panel to enable the manufacturing options.
4. Check the Create table for manufacturing option.

• Check the Use diameters about axis option and choose a Turning Axis if you want to list arc radius in the
table.

• Check Use IJK values for radius centers if you want to list arc Center in the table.

• CheckAbsolute IJK if you want to measure arc centers from the machine origin, which you select in the next
step.

• Uncheck Absolute IJK if you want to measure arc centers relative to the arc start point.
• I, J, and K are defined as follows:

• I - The distance with direction measured from the start point to the center of the arc parallel to the X-axis
• J - The distance with direction measured from the start point to the center of the arc parallel to the Y-axis
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• K - The distance with direction measured from the start point to the center of the arc parallel to the Z-axis

5. Select an Origin for locating the curves.
6. Select one or more curves to include in the table.

Box-selection is available.

7. Click Complete.
8. Place the table.

If all the curves are in the same plane, that plane is used for placement by default. If the curves are in multiple
planes, drag the cursor over the model to highlight planes and select one.

The image below shows a Curve Table using I, J, K values.

Snapshot Curve Tables
A Snapshot table breaks a 3D curve or curves into straight line segments and reports the endpoints of the segments.
An example is shown below.
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Creating a Snapshot Curve Table
1. Open the Detail tab.
2. Click Curve Table in the Annotation group.
3. Choose Snapshot in the Options panel.
4. Set a MaximumDeviation. this is the distance from the straight line segment of the curve to the actual curve in

areas of curvature. Its analogous to the deviation used for creating 3D triangles in STL conversion.
5. Select an Origin for locating the curves.
6. Select one or more curves to include in the table.

Box-selection is available.

7. Click Complete.
8. Place the table.

If all the curves are in the same plane, that plane is used for placement by default. If the curves are in multiple
planes, drag the cursor over the model to highlight planes and select one.

Curve Ordering
The default ordering scheme comes from manufacturing turning operations, where the workpiece is set up as shown
in the image above. The Z-axis is aligned with the turning axis and the tool bit moves from the most positive Z location
to the most negative Z location. The start and end points in curve chains begin at the largest positive Z value and
move toward lesser Z values.

The default ordering scheme is used when you box-select the curves.

Individually selected curves (using the Ctrl key), or curves selected by range (select the start curve then Shift-select
the end curve), are ordered in their selection order.

Randomly selected curves, that were selected without curve order in mind, will be ordered using the default scheme.
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Working with Curve Tables

• Pre-selecting a curve in the Graphics Window highlights the curve's row in the table.
• Selecting a Curve Table displays handles for modifying the table size and orientation.

º Use the pull handles on the table to size as needed.
º Use the round handle at the top of the table to rotate the table.

• If you make changes to the curves, the Curve Table updates accordingly.
• Select the table and use the RMB to Save Table As a Web (.htm, .html), XML file, or CSV file.
• When you change the size of a hole, the values in the table update, and the table re-orders and re-classifies the

holes and rows of the table.

• To remove a table, select the table, right-mouse click, and select Cut, or press the Delete key.

8.6. Drawing Sheet Views
You can add and remove views from the drawing sheet, move them around the sheet, and modify their properties.
You can create general views, projected views, cross-section views, and detail views. These views are all related to
the view used to create them, and inherit properties from that view.

Adding a View to the Drawing Sheet
1. Select one of the following tools from the Views ribbon group on the Detailing tab:

• General View tool

to add a new, independent view.

• Projected View tool

to create a view projected from one of the other views on the drawing sheet.

• Cross Section tool

to create a cross-section view using one of the other views on the drawing sheet.

• Detail View tool

to create an enlarged view of a particular area.

• Broken View tool

to create a shortened view of a long model.
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• Broken-out Section View tool

to create a localized section.

2. Click to place the view on the drawing sheet.

3. Press Esc or S to exit the tool.

Selecting a View on the Drawing Sheet
1. Press S to activate the Select tool.

If you are in another tool, pressEsc to cancel the current action, then pressEsc again to exit the tool and activate
the Select tool.

2. Mouse just outside the view on the drawing sheet, or scroll over the design shown in the view until a dashed box
around the view is displayed.

3. Click the box to select the view.

Moving a View on the Drawing Sheet
1. Select the view.

2. Drag the view with the Select tool to move it or click the Move tool and move it with the Move handle.

Projected and cross-section views move together as a group.

Orienting the Design Shown in a View
1. Select the component shown in the view.

2. Select the Move tool on the Design tab.

3. Use the Move handle to orient the component within the view.

Views related to the current view also change their orientation.

Modifying a View
1. Select the view.

You can select multiple views to modify the properties they have in common.

2. Modify the view's properties in the Properties panel or right-click and modify the view using the mini-toolbar.

3. Control the visibility of the view in the Structure tree.

Renaming a View
1. Right-click a view in the Structure tree and select Rename.

The Rename drawing view labels dialog opens.

2. Change the following:

• Name: The name of a view. By default, the name of a view is a number or letter.
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• Show prefix label: Display a descriptive prefix before the view name, such as Detail, Top View, or Front View.

• Structure tree name override: Use the text in the area below this option instead of the name and prefix.

The combination of user input and check boxes are shown in a preview of the view name in the box at the bottom
of the dialog.

Locking a View
1. Select one or more views.

2. Open the RMB menu

3. Choose Lock Position

Notes on Locked views:

• Any view that is not aligned to another view can have its poosition locked on the sheet
• Locked views have the "Locked" icon next to them in the Structure Tree
• Locked views are given a red outline in pre-highlighting and selection
• If a selection consists only of locked views, attempting to drag switches the cursor to the "circle-slash" cursor

meaning the action is blocked.

8.6.1. General Views
Use the General View tool

to add a new, independent view.

You can create views of multiple components and assemblies. You can move the view of a component from one
drawing sheet to another by dragging the view in the Structure panel. When using the Bill of Materials tool, you can
select the component on the Options panel to create a BOM for just that component.

Adding a New, Independent View
1. Click the General View tool

.

2. Click the drawing sheet to add the view at that location.

External Model Views
You place views of models that are not present in the Design document attached to the drawing sheet. This allows
you to do the following:

• Create a new empty drawing sheet without an associated design model.
• Save an .scdoc containing only a drawing sheet.
• Add views of any external part or assembly to an empty drawing sheet.
• Add multiple external part or assembly to an empty drawing sheet.

Adding a View of an External Model
1. Click the General View tool

.
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2. Click the Browse button in the Options panel.
3. Locate the desired model
4. Select the model and drag it into the empty drawing sheet.

Some details about external views:

• The design window associated with the drawing sheet does not contain any geometry.
• The Structure tree of the associated design window contains only the drawing sheet. Hover over each view to

display the file name of the external document.
• Changes made to models in the drawing sheet update the external .scdoc once the drawing is saved. Opening

these models in a new design window shows the changes.
• Geometry created in the associated design window can be placed in the drawing sheet with the external views of

other models.

Modifying a General View
1. Select the view.

2. Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change the:

• Orientation to change the orientation of the view to isometric, trimetric, or any side. If you change the
orientation of a general view from which projected views were created, the orientation of the projected views
also change.

• Renderingmode to change the graphics style for the view. Select Inherit if you want to link the graphics style
to the drawing sheet.

• Scale to magnify or shrink the view. When you change the scale, the Type property changes to Independent
from sheet. You can select Linked to sheet to set the scale to be the same as the scale used for the drawing
sheet.

3. You can also adjust the appearance of your design on the drawing sheet by using the:

• Snap View tool to correctly position the design.

• Move tool to position the design more accurately.

When you modify the orientation of a general view, any views dependent on the general view are oriented
simultaneously. Other general views do not change.

Creating a View of a Component on a Drawing Sheet
1. Select the General View tool

.

2. Select the component from the Options panel.

As you move your cursor over the drawing sheet to place the view, the model you selected is previewed at the
cursor location.

3. Click to place the view of the selected component on the drawing sheet.

The component is repeated in the Structure tree as a root node. You can place multiple internal components.

Creating a View of an Assembly on a Drawing Sheet
1. Select the General View tool

.
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2. Select the assembly from the Options panel.

As you move your cursor over the drawing sheet to place the view, the model you selected is previewed at the
cursor location.

3. Click to place the view of the selected assembly on the drawing sheet.

The assembly appears in the Structure tree as a root node

8.6.2. Projected Views
Projected views show another side of the model.

You can drag drawing views to different sheets in the Structure tree. When you drag a projected or auxiliary view to
a different sheet from its parent, its alignment is changed to independent. The two views will be linked again if you
drag it back to the same sheet and align it with the parent view.

You can place a projected or auxiliary view independent of the parent view. Select the view, then select Independent
or Aligned to View for Alignment in the Properties panel.

Creating an Orthogonal Projected View
1. Click the Projected View tool

on the Detailing tab's Views ribbon group.

2. Click within the view you want to use to create the projected view. Do not click a highlighted edge.

If dotted gray lines do not appear around the view, it is not selected. If this occurs, press Esc and try again.

3. Move your mouse to preview the projected view.

Orthogonal views are created as you move toward the top, bottom, left, and right of the current view.

4. Click to place the view on the drawing sheet.

5. Press Esc or S to exit the tool.

Creating an Auxilliary Projected View
1. Click the Projected View tool

on the Detailing tab's Views ribbon group.

2. Mouse over the view until the edge you want to use to create an auxiliary projected view is highlighted, then
click.

If dotted gray lines do not appear around the view, it is not selected. If this occurs, press Esc and try again.

3. Move your mouse to preview the projected auxiliary view.

Auxiliary views are created as you move the mouse perpendicular to the highlighted edge.

4. Click to place the view on the drawing sheet.

5. Press Esc or S to exit the tool.
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Modifying a Projected View
1. Select the view.

2. Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change the:

• Orientation Type to change the projected view to a General view. This makes the selected view independent
of the view used to create it.

• Renderingmode to change the graphics style for the view. Select Inherit if you want to link the graphics style
to the parent view.

• Scale to magnify or shrink the view. When you change the scale, the Type property changes to Independent
from sheet. You can select Linked to sheet to set the scale to be the same as the scale used for the drawing
sheet.

8.6.3. Cross-Section Views

Planar cross-section views show interior details of your design. You locate a plane through the details of interest
and SpaceClaim creates the view.

To create a cross-section view, you must already have at least one view. You can add a cross-section to any view
type.

In some cases, you may want to only show the geometry that lies in the section plane. This is called an Area section.
In other cases, you may want to see the geometry behind the plane as well. This is called a Total section. Both types
are illustrated in the image below.

The Detail section of SpaceClaim Options also has settings for Cross Sections. Refer to the View Options and Line
Style Options.

Planar cross section views can be created in the following ways:

• As a new view projected from an existing view.
• By converting an existing view to a cross section.
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Creating a New Planar Cross-Section View
1. Click the Cross Section View tool

in the Detailing tab Views group.

2. Click the Select Reference Geometry Inside Drawing View tool guide.

3. Set the following options in the Options panel before you position the view:

• Create a Total Cross-Section

• Uncheck the option to set the property to Area.

• Check the option to set the property to Area.

• Arrow Orientation

• Horizontal

• Vertical

• Through Selected Geometry to orient the arrows based on the highlighted object, which can be sketched
geometry.

• Placement

• Create as General View to place the view in any location on the drawing sheet.

• Create as Auxiliary View to link the orientation of the cross-section view to the view containing the arrows.

4. Drag and place the section line on an existing view. If you chose Through Selected Geometry, the section line
will snap to highlighted objects and orient accordingly.

5. The new view is created and attached to the cursor for placement.

6. Click to position the new section view in your drawing sheet.

• For an Auxiliary view, drag parallel to the section arrows to place the view.

• A general view can be placed anywhere in the sheet.

7. Press Esc or S to exit the tool.

Alternate Workflow
1. Sketch a single line in a drawing sheet view.
2. Select the single line.
3. Enter the Cross Section tool.
4. Move your mouse to place the planar cross section view.

In addition to Planar sections, you can also create Offset cross sections and Aligned cross sections.

Converting an Existing View to a Cross-Section View
1. Click the Cross Section View tool

on the Detailing tab's Views ribbon group.
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2. Click the Select Section View tool guide and select the view you want to convert to a cross-section.

If dotted gray lines do not appear around the view, it is not selected. If this occurs, press Esc and try again.

3. Set theCreate aTotal Cross-Sectionoption to set the view's section type property to Total. Uncheck the option
to set the property to Area. See examples in the image above.

4. Mouse over a related view to display the cross-section indicator and preview the cross-section.

The indicator line snaps to geometry in the view. Geometry in front of the cutting plane is not displayed.

5. Click to place the cross-section indicator and create the cross-section view.

The view is labeled automatically.

6. Press Esc or S to exit the tool.

Modifying a Cross-Section View
1. Move the cross-section indicator to change the cutting plane.

2. Select the cross-section view.

3. Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change the value
in:

• OrientationType to change the cross-section view to a General view. This makes the selected view independent
of the view used to create it.

• Renderingmode to change the graphics style for the view. Select Inherit if you want to link the graphics style
to the parent view.

• Scale to magnify or shrink the view. When you change the scale, the Type property changes to Independent
from sheet. You can select Linked to sheet to set the scale to be the same as the scale used for the drawing
sheet.

• Section Type to create a total or area cross-section. Select Total to display 3D geometry not on the cross
section plane. Select Area to display only the geometry on the cross-section plane. You can select None to
turn the view into a General view.

4. Select a region within the cross-section view.

5. Modify the values in the Properties panel. Change the value in the following Cross hatching properties:

• Exclude from sectioning to remove the selected region from the cross-section view.

• Fill styles to add or removing hatching from the region.

• Angle to modify the angle at which the hatching lines are drawn.

• Spacing to modify the space between hatching lines.

• Offset to modify the start point of the first hatching line.

Reversing the Direction of a Cross-Section View
Right-click the cross-section arrow and select Flip Viewing Direction.

Publishing a Cross-Section View to 3D
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1. Right-click the cross-section view on the drawing sheet or in the Structure tree.

2. Select Publish to 3D from the context menu.

A published section appears as a root node in the Structure tree.

You can right-click the published cross-section in a Design window and select Clip with Plane. You can also use
the Move tool to move a published cross-section.

Examples

Selecting a published cross-section to clip with plane.

Using the Move tool to move a published cross-section.

Working with Cross Sections
• When you select and drag an individual section line segment, the segment you are dragging will snap to and merge

with other sections as it moves across other segments on the drawing sheet.

• You can create an offset section from inside the tool. To view the cross-section cut indicator (red diamond), select
the Cut Existing Sections tool guide, then click a section line.

• To create a cross-section from inside the tool, click the Cross Section tool, and then within the drawing sheet,
select a view. Use the Select Reference Geometry Inside Drawing View tool guide to place the section line.

• You can only divide a section on segments that are perpendicular to the principal direction. At your cursor location
you can right-click a section line segment and select Split Section. This right-click option is no longer available
for segments that are parallel to the section direction.

• To view a dotted-line preview of the principal direction of a cross section, scroll with the mouse wheel onto the
entire section line.
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8.6.4. Offset Cross Sections

Offset sections allow you to show interior details that lie on different section planes in one view.

In some cases, you may want to only show the geometry that lies in the section plane. This is called an Area section.
In other cases, you may want to see the geometry behind the plane as well. This is called a Total section. Both types
are illustrated in the image below.

The Detail section of SpaceClaim Options also has settings for Cross Sections. Refer to the View Options and Line
Style Options.

Offset cross section views can be created in the following ways:

• As a new view projected from an existing view.
• By converting an existing view to a cross section.

Once a cross section view is created, you can reverse the viewing direction.

1. Right-click a section line or arrow.
2. Select Flip Viewing Direction.

Creating an Offset Section from an Existing Cross Section
1. Create a cross section view.
2. Select the Create Offset Section tool guide.
3. Click the section line at a point where you want to create an offset.
4. Drag the side of the section line you want to have pass through a different detail.
5. Continue until you establish all necessary offsets.

When you select and drag individual section line segments, the segment you are dragging will snap to and merge
with other sections.

Alternate Workflow
1. Create a cross section view.
2. Right-click the section line.
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3. Select Split Section.
4. SpaceClaim creates a default offset.
5. Drag individual section line segments to the desired locations.

When you select and drag individual section line segments, the segment you are dragging will snap to and merge
with other sections.

You can only divide segments that are perpendicular to the principal direction.

6. Continue until you establish all necessary offsets.

Creating an Offset Section as a New Cross-Section View
1. Sketch a chain of lines in a drawing sheet view.
2. Select a line segment.
3. Enter the Cross Section tool.
4. Move your mouse to place the planar cross section view.

The new view will be projected perpendicular to the selected line segment, which can be slanted.

SpaceClaim will find the other connected segments to create the view.

If the tool cannot find an unambiguous chain of lines, a planar section will be created.

Publishing a Cross-Section View to 3D
1. Right-click the cross-section view on the drawing sheet or in the Structure tree.

2. Select Publish to 3D from the context menu.

A published section appears as a root node in the Structure tree.

You can right-click the published cross-section in a Design window and select Clip with Plane. You can also use
the Move tool to move a published cross-section.
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8.6.5. Aligned Cross Sections

Aligned cross sections are similar to Offset cross sections but the segments are rotated about a pivot point to be
parallel to the sheet. So, the width of the section view will be greater than the width of the parent view.

In some cases, you may want to only show the geometry that lies in the section plane. This is called an Area section.
In other cases, you may want to see the geometry behind the plane as well. This is called a Total section. Both types
are illustrated in the image below.

The Detail section of SpaceClaim Options also has settings for Cross Sections. Refer to the View Options and Line
Style Options.

Planar cross section views can be created in the following ways:

• As a new view projected from an existing view.
• By converting an existing view to a cross section.

Once a cross section view is created, you can reverse the viewing direction.

1. Right-click a section line or arrow.
2. Select Flip Viewing Direction.

You can modify an aligned section by selecting and dragging individual section line segments, the segment you are
dragging will snap to and merge with other sections.

Segments can be deleted. If all segments are deleted, the section reverts to Planar.

Creating an Aligned Section with a Single Pivot Point
1. Create a cross section view and exit the tool.
2. Select the Cross Section tool.
3. Click the Set Pivot for Aligned Sections tool guide.
4. Click somewhere on the section line to set the pivot point.
5. The Create Aligned Section tool guide activates.
6. Click somewhere on the section line to set a cutter point.
7. Drag to move that portion of the section line.
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8. An arc is created to show how the linear sections connect. The arc has no length in the section view.

Creating an Aligned Section with Multiple Cutter Points
1. Create a cross section view and exit the tool.
2. Select the Cross Section tool.
3. Click the Create Aligned Sections tool guide.
4. Click somewhere on the section line to set the pivot point, which also sets the cutter point.
5. Drag to move that portion of the section line.
6. Repeat to set additional cutter points.

Adding Aligned Section Pieces to an Existing Cross Section
1. Right-click a section line.
2. Select Split Aligned Section.
3. Click somewhere on the section line to set the pivot point, which also sets the cutter point.
4. The tool creates a default pivot.
5. Drag to move that portion of the section line.
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6. Repeat to set additional points.

To publish a cross-section view to 3D
1. Right-click the cross-section view on the drawing sheet or in the Structure tree.

2. Select Publish to 3D from the context menu.

A published section appears as a root node in the Structure tree.

You can right-click the published cross-section in a Design window and select Clip with Plane. You can also use
the Move tool to move a published cross-section.

8.6.6. Detail Views
Detail views allow you to magnify a portion of another view to show more detail. To create a detail view, you must
already have at least one view on your drawing sheet.

If a detail view does not display correctly, make sure that you loaded any lightweight components shown in the
view.

You can change several options for detail views in the Detailing options, such as line weights and note options.

Creating a New Detail View
1. Click the Detail View tool

on the Detail tab's Views ribbon group.

2. Select one of the following options:

• Create Detail of Selected View to create a new detail view with the boundary drawn on an existing view.

• Convert Selected View to Partial to convert an existing view into the detail view.

3. Select the Sketch Boundary Type (circle, rectangle, or spline) from the Options panel.

4. (Optional) Enter the Scale on the Options panel.

5. Click the view that will create the detail to set the anchor point for scaling.

Usually, you will create an anchor point very close to the detail that you want to show in the view.

6. Click to set the center of a boundary circle, a corner of a rectangle, or the first point of a closed spline.
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7. Click again to define the boundary circle or rectangle, or click multiple times to define the boundary spline.

The detail view is displayed.

8. Click to place the detail view on the drawing sheet.

9. Press Esc or S to exit the tool.

Modifying a Detail View
If you created a circular or rectangular boundary, you can drag the boundary to expand or shrink it.

Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change the value
in:

• Renderingmode to change the graphics style for the view. Select Inherit if you want to link the graphics style to
the parent view.

• Scale to magnify or shrink the view. When you change the scale, the Type property changes to Independent from
sheet. You can select Linked to sheet to set the scale to be the same as the scale used for the drawing sheet.

• Orientation type to change the detail view to a General view.

You can drag drawing views to different sheets in the Structure tree. When you drag a detail view to another sheet
it remains linked with its parent view.

8.6.7. Broken Views

Broken views are a way of foreshortening long views without changing the scale.

When you break a view, a new view is created and both the original and the new view are converted to partial views.
An alignment is set up to match the cut orientation.

Creating a Broken Viewwith a Straight Line Break
1. Check the Linestyle options in the General section of Detailing options.

• Under Type of object, select Broken view clipping edges

• Set the style, thickness, color, and extent as appropriate
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2. Click the Broken tool

in the Detail tab Views group.

3. Set the following options (remembered for the entire session):

• Cut Direction: Horizontal, Vertical, or Aligned to Geometry.

• Break Line: Set this to Straight Cut (Freehand Spline Cut is the other option)

• Default Gap: Sets the initial gap between broken view pieces.

4. Pick a location for the first cut line. A blue line pre-highlights the cut location. If CutDirection is Aligned
toGeometry, the cut orientation will be perpendicular to the selected geometry.

5. Pick a location for the second cut line to create the view break. A blue line pre-highlights the cut location. If
CutDirection is Aligned toGeometry, the cut orientation will be parallel to the first cut line.

6. The view is created with the default gap set in the Broken View Options.

7. Press Esc or S to exit the tool.

Creating a Broken Viewwith a Sketched Spline Break
1. Click the Broken tool

in the Detail tab Views group.

2. Set the following options (remembered for the entire session):

• Cut Direction: Horizontal, Vertical, or Aligned to Geometry.

• Break Line: Set this to Freehand Spline Cut (Straight Cut is the other option)

• Default Gap: Sets the initial gap between broken view pieces.

3. Pick a location for the break. The spline sketch mode is now active.

4. Sketch the spline and double-click to finish the spline.

5. The break spline is shown in blue. If you want to sketch a different spline, you need to restart the tool.

6. Pick a location for the second spline.

7. The view is created with the default gap set in the Broken View Options.

8. Press Esc or S to exit the tool.

Working with Broken Views
• Both break locations must be picked on the same view (this is automatically enforced by the tool).

• You can create multiple breaks in a view.

• When inserting a new break in a view, the new break lines cannot intersect any existing break lines.

Deleting a Broken View
1. While in the Select tool, mouse over the break.

654Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Detailing



2. A handle is displayed.

3. Select and delete the handle.

• The break is removed
• The view is also removed

Changing the Angle of an Existing Cut Line
1. Select the break line
2. Change the Angle property
3. Both sides are slanted by the specified amount relative to the original cut.

Moving a Set of Broken Views
1. Double-click any view in the set.
2. All the view pieces are highlighted.

3. Move the views as needed.
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8.6.8. Broken Out Sections

Broken out sections display internal details in a portion of an existing view. You select an attachment point in the
view, set the depth of the section, and sketch a section boundary. The area within the boundary is cutout up to the
section depth to expose the interior details.

Creating a Broken Out Section View
1. Set the attachment popint by picking on a point somewhere on a model within a drawing view.

2. Set the depth.

• The default is zero.

• If the attachment point is on a hole axis, a zero depth creates a section through the center bof the hole.

3. Choose the boundary type:

• Circle

• Spline

4. Sketch the section Boundary.

5. The view is created.

Changing the View Boundary Linestyle
1. Open SpaceClaim Options.
2. Click Detailing.
3. Open the General options page.
4. In Linestyle options, select Broken-Out section clipping edges.
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5. Choose from:

• Thin
• Medium
• Thick

Modifying a Broken Out Section View
1. Hover over the clipping boundary to prehighlight it for selection.
2. Select the boundary.
3. Do any of the following:

• Drag the boundary to re-size the area
• Select the anchor and drag it to a new location
• Change the depth in the Properties panel
• Delete the section

8.6.9. Displaying a Modular Grid
The modular grid is a coordinate system used to locate objects relative to an origin in 3D space. You can display the
modular grid on any view that is parallel to the world origin axes.

Toggling the Display of the Modular Grid for a View
Right-click the view and select ShowModular Grid.

Adjusting the Size of the Modular Grid
Click the grid labels (or end points if labels are not displayed) and drag.

Displaying Grid Information for a Cross-Section View
Select the cross-section view reference plane and set ShowModular Grid Description in the Properties panel to
True.

Change Modular grid description label to change text displayed before the coordinates in the label.

You can move the reference plane by changing the value of its label.

Customizing a Grid
1. Select the grid by clicking on a grid label or end point.

2. Drag the handles to expand or shrink the grid dynamically.
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3. Modify the following values in the Modular grid section of the Properties panel:

• Color: The color of the grid, labels, and the legend axis.

• Font: The font and text height used for grid labels. Type the complete name for a font, followed by a comma
and the font height in units (mm, in, etc.). You can also click the ...button and select a font and a size in points.
The size will be converted to the current units.

• Grid interval: The distance between grid lines.

• Horizontal text location: Show labels for the bottom of grid lines, the top of grid lines, both, or neither.

• Intervals per grid line: The number of rows between each grid line.

• Show balloons around grid labels: Show circles around grid labels.

• Show baselines only: Select True to only show the baselines. The default is False which shows all grid lines.

• Show origin: Show the legend axis on the lower left corner of the view.

• Showwhen at least one direction is parallel to the sheet: Select True to automatically display the grid if
the X, Y, or Z axis in the view is parallel to the drawing sheet. Select False if you want to hide the grid in this
case.

• Vertical text location: Show labels for the left end of grid lines, the right end of grid lines, both, or neither.

• Axis labels: Override X, Y, or Z with your own labels.

• Negative and positive prefixes: A prefix shown before the distance on a grid label.

• Negative, positive, and zero suffixes: A suffix shown after the distance on a grid label.

You can set the defaults for these values by changing the Modular grid options.

Note: Modular grid properties are based on the sheet defaults and are not inherited by child views.

8.7. Custom Symbols
A custom symbol is a two-dimensional collection of sketch curves and text grouped together as one selectable entity.
You can insert a custom symbol multiple times in the same document and each instance of the symbol can be scaled,
rotated, and transformed independent of the others.

Custom symbols can include:
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• Any set of sketch curves that you can draw using the tools in the Sketch group.
• Fixed text that always remains the same.
• Editable text that you can change independent of other instances of the symbol.
• Leader attachment points that allow you to add note leaders at one or more points on the symbol.
• Other symbols.

Custom symbols can be attached to geometry. Symbols attached to geometry move with that geometry as it changes

Custom symbols are saved with the document, and can be imported from saved documents.

8.7.1. Using Custom Symbols
You can insert a custom symbol multiple times in the same document and each instance of the symbol can be scaled,
rotated, and transformed independent of the others. You can copy and paste inserted symbols within the same
drawing sheet. Symbols are saved with the document, and can be imported from saved documents.

You can add and remove symbol libraries in Support files.

Inserting a Custom Symbol Into Your Design

1. Click
Insert in the Symbols group on the Detail tab.

The icon for this tool will change to the symbol thumbnail after you insert a symbol.

2. Select a symbol from the list of available symbols.

3. Choose one of the Creation options:

• Create in model space

• Create in paper space

4. Place the symbol:

• Click anywhere in your design to place the symbol

• Click highlighted geometry to attach an attachable symbol to that geometry.

If you want to attach the symbol to the intersection of two curves, click the first curve to attach the symbol to
it, and then Alt+click the second curve to move the symbol to the intersection of the two curves. You can also
select theAttach to Intersection tool guide, then click the second curve to move the symbol to the intersection.

The symbol is attached to the geometry and will move with that geometry as it changes.

5. If editable text was defined in the symbol, you can change the text now.

Importing Custom Symbols from Another Document

1. Click
Insert in the Symbols group on the Detail tab.

2. Click Add Symbol Library.

3. Browse to select one or more SCDOC files that contain the symbols you want to use.

4. Click Open.
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The symbols from the file are available in a new tab in the symbol library. Symbols are saved in the current
document only when they are used.

5. If a conflict is found between the imported symbols and symbols already in the open file, then a dialog will open
with the following options:

• Copy and replace: Replace the local version with the imported version everywhere it is used in the current
document.

• Don't copy: Leave the current version of the symbol unchanged and don't import the external version.

• Copy and keep both versions: Import a second copy of the external symbol and make both available in the
current document.

Scaling or Rotating an Inserted Custom Symbol

1. Click
Select or press S.

2. Select the symbol you want to change.

3. Use the size handles to resize the symbol, like this:

4. Use the rotation handle to rotate the symbol, like this:

Attaching Note Leaders to an Inserted Custom Symbol
1. Click

Note Leader in the Annotation group on the Detailing tab.

2. Move your mouse over the symbol and the possible attachment points will appear as white circles.

3. Click an attachment point.

4. For a segmented line, click to set each point of the note leader line.

5. End the note leader by clicking a vertex, edge, or face to attach the end of the note leader, or double-click to end
the note leader at any point.

The end of the note leader is an arrow unless you attach it to a face.
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Converting a Custom Symbol to a Sketch Curve
Right-click the symbol and select Explode.

This only affects the selected instance of the symbol and not the primary symbol in the library.

Changing Custom Symbol Properties

1. Click
Select or press S.

2. Select the symbol you want to change.

3. Change the following properties, as desired:

Cosmetic: The Space property determines how a symbol behaves in terms of scale and visibility. You can have
it inherit the value (Model space or View space) from the symbol definition, or you can set the value for individual
symbol insertions.

• Same as original: Uses the value of the symbol definition.

• View space: The symbol will resize when you change the view scale.

• Model space: The symbol will remain the same size when you change the scale (in the Sheet Setup group in
the Detail tab).

Symbol Insert Parameters:

• Attachmentmethod: An unattached symbol is set toFreePlacement. If you want the symbol to be attachable,
set this property toAttachtogeometry,Setnormal togeometry, orPlacenormalandupwardtogeometry.

• Flipped: Set this property to True to flip the symbol in its plane, like this:

For an attachable symbol, set this property to True to flip an attached symbol to the opposite side of the
selected geometry.

• Rotation: Use this property to rotate the symbol counterclockwise in the plane where it was placed.

• Scale: The size of the symbol is multiplied by the scale value. For example, if you set this property to 5, then
the symbol size is multiplied by 5.

• Text height: If you selected the Scale symbol to text height option when you created the symbol, you can
set this property to change the text height that is used to scale this instance of the symbol.

• Use original symbol style: The original scale and size are used for the symbol.

Examples

Attaching a note leader to a custom symbol
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Custom symbols attached to geometry

Same symbols with Flipped property set to True

Same symbols moving with changed geometry

Attaching symbols to the intersection of two curves

8.7.2. Creating Custom Symbols
A custom symbol is a two dimensional collection of sketch curves and text grouped together as one selectable and
editable entity. Your symbols can include anything drawn with Sketch tools and text made with the Note tool.

1. Draw the symbol using Sketch tools and use the Note tool to add text, as needed.
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2. Click
Create in the Symbols group on the Detail tab.

The Symbol tab will open in the ribbon bar.

3. Use the following tools in the Symbol tab to build your custom symbol:

• Select: This tool is active by default. Use it to select sketch curves and text to include in your symbol.

• Editable Text: Use this tool to select notes that will be editable when you use the symbol. Notes you select
with the Select tool cannot be edited in the finished symbol.

• Remove: Use this tool to remove elements from the symbol.

• LeaderAttachment: Use theHorizontalorVertical tools to add note leader attachment points to the symbol.
Click to add a note leader, then drag the leader into position. You can drag the white circle or the red diamond
to adjust the leader's length.

You will be able to create note leaders that are attached at these positions. The line segment between the
white circle and the red diamond is fixed. The line segment after the red diamond is adjusted when you add
the leader.

• Use original style in inserts: Use the original text height for inserted symbols.

• Scale symbol to text height: Select this option if you want to set the reference text height that is used if you
scale the symbol based on text height when it is inserted. The ratio between the current window text height
and the symbol reference text height determines the scale of the symbol. If you select this option you can also
change the Reference text height.

• Symbol Space: These options determine how the symbol is scaled in your design.

• Model space: Select this option if you want the symbol to remain the same size when you change the scale
(in the Sheet Setup group on the Detail tab).

• View space: Select this option if you want the symbol to be resized when you change the scale.

The example below shows two symbols scaled at 1:1, 4:1, and 10:1. The rectangular symbol was set to Model
space and the round symbol was set to View space.

4. If you want the symbol to be attachable, move the origin handle (shown below) to set the origin of the symbol
and then select one or more Placement options to determine how the symbol will be scaled in your design:

• Allow attaching placements to geometry: Attaches the origin point of the symbol to 3D edges and curves.
You must select this option to create an attachable symbol.

• Orient placements normal to geometry: Orients the symbol perpendicular to the selected curve or face.

• Maintain an upward orientation for placements: Automatically positions a symbol oriented normal to
geometry so that it is never upside down. This option is useful for annotation symbols, such as surface finishes,
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that should be perpendicular to their reference geometry and also right side up relative to the reading direction
of the model.

When you select the first two options, the symbol is automatically oriented perpendicular to the reference.

5. Click Complete to finish editing and save the custom symbol in the current document.

or

Click Close Symbol Tools to exit the Symbol tab without saving the symbol.

Editing a Symbol
1. Insert a symbol if you haven't already.

2. Select the symbol.

3. Click
Edit in the Symbols group on the Detail tab or right-click a symbol and select Edit.

4. Use the tools in the Symbol tab to edit your symbol. Refer to the instructions above for information about each
tool or option.

8.8. Drawing Sheets
SpaceClaim helps you create drawing sheets. When you add a new drawing sheet to a design, views of the design
are created for you automatically. You can then add, remove, and edit these views, as well as drag them to move
them around on the sheet. Drawing sheets are saved within your design.

Normally, you will create the drawing sheet, set up the sheet, apply a format, add and modify views, then annotate
the views.

Drawing sheets and their views appear in the Structure tree. You can place drawing sheet views on layers.

You can edit a design directly while viewing the drawing sheet using the tools on the Design tab.
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Creating a New Drawing Sheet
Select New > New Drawing Sheet from the File menu.

A drawing sheet containing top, front, and right-side views appears in the Design window, and the Drawing Sheet
appears in the Structure tree. The Detailing tab is displayed. You do not need to create a design before creating a
drawing sheet. SpaceClaim allows you to create and edit geometry within the drawing sheet itself. When you create
a new drawing sheet for an empty design, the sheet contains the view outlines, with handles you can use to control
the size and position of the view. You can delete the handles and move the view using the outline.

If you began a design from an empty drawing sheet, you can right-click a design on the drawing sheet and select
Open Component to display the design in a new Design window.

Modifying one view changes the related views as appropriate.

Displaying a Drawing Sheet in the Design Window
Right-click the sheet in the Structure tree and select Open Sheet from the context menu.

Deleting a Drawing Sheet
Right-click the sheet in the Structure tree and select Delete from the context menu.

The drawing sheet window closes. If the drawing sheet is no longer referenced by any other open design document,
it is removed from active memory. It is not deleted from other documents that reference the drawing sheet.

Changing the Visual Orientation of a Drawing Sheet
You can orient a drawing sheet using the normal mouse + keyboard combinations and menu commands. For example,
you can press the middle mouse button and drag to spin the drawing sheet. See Orienting.

Right-click anywhere in the drawing sheet and select View > Flat View from the context menu to view the sheet
head-on.

Drawing sheets have separate named views in the Views tab. These are the views used to orient your sheet in the
design area. The default named views are

• Home: Changes the view to head-on by default. Can be set to a different view.
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• Plan View: Changes the view to head-on based on the face you have selected. If nothing is selected, the sheet is
oriented to the drawing window.

• Flat View: Changes the view to head-on for the drawing sheet.

See Customizing views.

Editing Design Annotations
Right-click the annotation plane in the Structure tree and select Show all dimensions to display any design
annotations on that plane. Click an annotation to edit it. Changes made on the drawing sheet will also appear in the
design.

Controlling the Visibility of Objects in a Drawing Sheet
The Structure tree in a drawing displays the design components under each drawing. You can:

• Hide or show a view: Check or clear the box next to the view in the Structure tree. You can also right-click the
view in the drawing sheet and select Hide from the context menu.

• Hide or show a component in all views: Right-click the component in the Structure tree and select Hide in all
views or Show in all views from the context menu.

• Hideor showacomponent inaparticularview: Check or uncheck the box next to the component in the Structure
tree.

• Hide or show an object in all views: Right-click the object in the Structure tree and select Hide in all views or
Show in all views from the context menu.

• Hide or show an object in a particular view: Right-click the object in the drawing sheet and select Hide in
Selected View from the context menu. Check the box in the Structure tree to restore visibility.

• Isolate a solid in a view: Right-click the solid in the Structure tree and select Isolate in selected view from the
context menu. You can also right-click a face of the body in the drawing sheet. All geometry in the view disappears
except the selected object. This option is not available for components.

• Hidean individual curve in a component instance: Right-click the curve and selectHide from the context menu.
You can also check or clear the box next to the curve in the Structure tree.

The Structure tree displays a mixed visibility state for any objects hidden in a view, as shown in the figure below.

Visibility in a drawing sheet is independent from the visibility of the model in the design window.

If you insert a model into a new document, the model appears with the visibility saved in the document. After the
model is inserted, the visibility of objects is independent of the saved document.

When you create a new view (general view, projected view, cross section, or detailed view) in a drawing sheet from
an existing view in your drawing sheet, the visibility of objects is copied to the new view.

Opening a Root Part in the Design Document
Right-click a root node in the Structure panel of a drawing sheet and select Open Root Part.
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In a drawing sheet opened from a component-only design document, right-click the component root node and
select this option to display the design document for the full assembly. In a drawing sheet without any views,
right-click the Drawing Sheets root node and select this option to display the design document for the assembly.

Duplicating a Drawing Sheet
Right-click the sheet in the Structure tree and select Duplicate from the context menu.

The drawing sheet and its views are duplicated in a new drawing sheet.

Copying and Pasting a Drawing Sheet
You can Copy and Paste Drawing Sheets with all Annotations, Formats, Tables, and Content.

1. Select a Drawing Sheet in the Structure Tree
2. Click Copy in the ribbon, or use the Ctlr+C shortcut
3. Click Paste in the ribbon, or use the Ctrl+V shortcut

8.8.1. Setting Up a Drawing Sheet
You can format the drawing sheet using a template, orient the page, and select a paper size for the sheet. When you
select the format and size of the drawing sheet, SpaceClaim automatically sets the scale, but you can modify it.

Use the following tools in the Sheet Setup group to change a drawing sheet:

Format: Select a default or custom format, or remove
the formatting from the drawing sheet with the Format
tool.

Orientation: Select a portrait or landscape orientation
for the page from the Orientation drop-down list.

Size: Select the page size from the Size drop-down list.

Scale: Select a scale or type a ratio in the Scale field. For
example, enter 1:1 to display views of your design at
actual size. The values listed are the two most common
ratios that are smaller and larger than the current scale
ratio.

Scale

8.8.2. Formatting a Drawing Sheet
You can apply SpaceClaim formats to your drawing sheet or create your own custom formats. You can show or hide
the format lines on the sheet.

You can use different sheet size formats in a single document. The Format, Orientation, and Size tools now have
a Apply to All Sheets option that, when selected, applies your changes to all sheets in the document. When not
selected, the change is only applied to the sheet displayed in the Design window. The option is only available when
the document contains more than one drawing sheet.
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Changing the Format of a Drawing Sheet

1. Click
Format in the Sheet Setup group on the Detail tab.

2. Select a format from the list.

3. (Optional) Click More Formats near the bottom of the format list.

• Select Use a specific sheet of the format if you want to use only the format from one sheet in the drawing
file.

• Use Copy BOM tables from format to specify whether or not you want to include the BOM tables.

• Use Copy views from format to specify whether or not you want to include views

• Navigate to the SCDOC file containing the format and click Open.

4. (Optional) Deselect Apply to All Sheets to apply the format to only the current drawing sheet.

Removing the Formatting from the Drawing Sheet
Select Remove Current Format from Format tool drop-down.

Creating a Custom Drawing Sheet Format
1. Create a new drawing sheet.

2. Set the orientation, size, and scale of the drawing sheet.

3. Draw on the drawing sheet using the Sketching and Annotation tools.

Tip If you insert fields based on document properties into annotations on the drawing sheet, you can create a
drawing sheet format that automatically updates when it is applied to a drawing sheet in a design.

4. Save the drawing sheet into a support directory.

The drawing sheet appears as a format within the Format tool's drop-down list.

Creating a Custom Drawing Sheet by Inserting an AutoCAD File
1. Create a new drawing sheet.

2. Click
File in the Insert group on the Design tab.

3. Select AutoCAD files for the Files of Type.

4. Select the Import onto drawing sheet option.

5. Browse to locate the AutoCAD file, then click Open.

8.8.3. Editing on a Drawing Sheet
You can edit your design directly while viewing the drawing sheet using the tools on the Design tab.

When sketching on a drawing sheet, you can:
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• Click within the view boundary with a sketch tool to display a sketch grid.

• Right-click a view and select Use Last Sketch Plane from the context menu.

• Turn the mouse wheel to select a face of a solid in the drawing sheet when only the edge is displayed.

• Override colors for solids and surfaces. Changing the colors on the drawing sheet does not affect the colors in the
design.

To sketch in the active view only
Select Create curves shown only in current view in the Sketch options panel.

Sketched curves appear only in the active view. This function is useful if you want to show multiple design possibilities
using the views on your drawing sheet. If you want to work with the sketch curves as design elements, make them
visible in your design document.

8.9. 3D Markup
SpaceClaim allows you to create 3D markup slides so that you can highlight and communicate the differences
between versions of a design. 3D Markup slides display by name, such as Slide1, as components in the Structure
tree.

Slides can be exported in PowerPoint and XPS formats.

Markup Ribbon Group
The Markup ribbon group contains the following tools:

Create a new 3D markup slide for the current design with
the New Slide tool.

Display the dimensions of the previous version and the
current version with the Original Dimension Values tool.

Apply colors to the design that indicate the type of change
that occurred with the Color Changed Faces tool.

Creating a 3DMarkup
1. Open the design you want to mark up in the Design window.

2. Select Save As New Version from the File menu to create a new version of your design.

The new version is saved with a version number appended to the file name, and becomes the active Design
window.

3. Make changes to the new version of the design.

4. Select New > 3DMarkup from the File menu to create the first 3D markup slide.

The slide is shown in the 3D Markup panel, the design window, and the Structure tree. In the Structure tree, the
version you created in step 2 is labeled Reference Design.

5. Open the Assembly tab in the ribbon.

6. Click the File tool and browse to a previous version or the original version to insert into the slide.
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The design appears in the Structure tree, labeled either Alternate Version or Original Version. In the Design
window, the previous version of the design is displayed in the wireframe transparent style and is placed directly
on top of the new version. The Move tool is active.

7. (Optional) Move the alternate version to a new location by clicking on a Move handle axis and dragging.

8. Customize the slide using the tools in the Markup ribbon group in the Detailing tab.

You can document the dimension changes with dimension annotations, color the faces based on the type of
changes made, and apply any other annotations using the tools in the Annotation ribbon group in the Detailing
tab. You can right-click a lightweight component and select Load Component to load it.

9. Create as many slides as you need to effectively communicate your changes.

You can right-click a slide in the Structure tree and select Open Slide to display the slide.

10. Select Save As XPS or Save As PowerPoint from the File menu to export the 3D markup slides to a separate
document.

Deleting a 3DMarkup Slide
1. Select the slide in the Structure tree.
2. Right-click and select Delete to remove the slide.

Because a slide is a component, when you delete a slide from the Structure tree you also delete all of that slide's
objects. This feature allows you to organize your 3D Markup slides as you work towards creating a design or finished
assembly.

Examples

The Structure tree shows contents of each slide. 3D Markup panel shows two slides in the slide show. The Design
window shows reference and original versions compared with dimensions and coloring for changed faces.

8.9.1. Creating 3Dmarkup slides
Use the New Slide tool in the Markup ribbon group on the Detailing tab to create a new 3D markup slide.

1. Select the New Slide tool

or right-click in the 3D Markup panel and select New Slide from the context menu.

A new 3D markup slide appears in the 3D Markup panel containing the reference design. (The reference design
is the design that was active when you first created the 3D Markup document.

2. Insert a previous version of the design for comparison.
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8.9.1.1. Inserting
The Insert tools allow you to insert components, images, planes, axes, origins, cylinders, and spheres, and create
relationships between the solids and surfaces in your design.

Insert tab
The Insert ribbon tab contains the following tools:

Use the File tool to insert a component or an image into
your design.

Use the Plane tool to insert a plane into your design.

Use the Axis tool to insert an axis into your design.

Use the Origin tool to insert an axis into your design at
the location of the Move handle.

Use the Cylinder tool to quickly create a cylinder.

Use the Sphere tool to quickly create a sphere.

Use the Linear pattern tool to create a linear pattern.

Use the Circular pattern tool to create a circular pattern.

Use the Fill pattern tool to create a fill pattern.

Use the Shell tool to convert a solid to a shell.

Use the Offset tool create an offset relationship between
faces in your design.

Use the Mirror tool to designate a face or plane as a
mirror.

8.9.2. Displaying Changes to Dimensions
Use the Display Original Dimension Values tool to create dimension annotations for the current and original dimensions
in the 3D markup slide.

Create dimension annotations on the new version with the Dimension tool.

The original dimension appears as a "Was" value alongside the current one, if that dimension changed between the
two versions.
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Editing a Change Dimension
Click within the dimension and edit the text or formatting.

You can copy and paste the dimensions into a note or table.

You can also delete either the original or new value. If you delete the original dimension, and then want to restore
the change dimension, select the annotation and click the Original Dimension Values tool

from the Markup ribbon panel on the Detailing tab. To restore the change dimension to all annotations, click the
Original Dimension Values tool

with no annotations selected.

8.9.3. Coloring Changed Faces
Use the Color Changed Faces tool in the Markup ribbon group on the Detail tab to automatically color the faces
that changed from one version to another based on the nature of the change.

We recommend creating a legend on your slide similar to the following to help communicate the meaning of each
color:

New faces are colored green. Green faces did not exist in
the previous version and will appear only on the modified
version of the design.

New topology is colored blue. Blue faces have changes
to both the face and its edges, but the face existed in the
previous design.

Deleted faces are colored red. Red faces will appear only
on the previous version of the design.

Faces with changed edges are colored pink. Pink faces
are in the same spatial location, but are bounded
differently because their edges have changed.

Faces with a changed spatial location are colored yellow.
The edges of yellow faces have not changed from the
previous version.

If you want to manually color the faces, you can apply colors to the individual faces on your 3D Markup slide.

Coloring Changed Faces (Temporarily)
Click the Color Changed Faces tool

.
Click again to remove the colors.
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The colors are shown on the current slide.
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9:Measuring and Analyzing

The Measure tab contains the tools you use for measuring, displaying interference, and analyzing quality in your design.

The tools are grouped into the following ribbon groups:

Tools for displaying measurements of the edges, faces, and
solids in your design.

Inspect

Tools for displaying edges where solids intersect each other
or volumes created by the intersection of solids, surfaces,
and components in your design.

Interference

Tools for detecting anomalies or discontinuities in surfaces
that shading cannot show.

Quality

9.1. Quick Measurements
A simple measurement is displayed in the status bar when you select a single object or a pair of objects. This
measurement is displayed using the units and precision set in Units options for the current document. TheMeasure
tool also has a Units option to switch units for the measured values without changing units for the document.

If the text in the quick measure area is cut off, move your mouse over the text area to show all of the text.

Select:Tomeasure:

• Two parallel linear objects (lines, edges, axes)
• Two parallel planar objects (faces, surfaces, planes)
• Two points or vertices
• One point or vertex and one curve or edge (curved or

linear) - displays the shortest distance from the point
to the curve or edge

• One point and one analytic face, edge, or curve -
displays the projected distance of point onto face, edge,
or curve

• Two parallel, but not concentric, cylindrical faces -
displays the distance between the axes

• Two non-concentric circular edges or arcs - displays
the distance between the centers

Distance between two objects

• A linear object (line, edge)Length of an object

• A circular object (circular edge or curve, cylinder,
sphere)

Radius of an object

• Two non-parallel linear objects (lines, edges, axes)
• Two non-parallel planar objects (faces, surfaces,

planes)
• Two analytic curves that share an end point - displays

the angle between the curves at the point where they
meet

Angle between two objects
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Select:Tomeasure:

• Two concentric cylindrical faces
• Two circular edges that are in the same plane

Offset

• A point or vertexX, Y, Z coordinates from the world origin

9.2. Inspect
Select a tool from the Inspect ribbon group to display measurements for the edges, faces, and solids in your design.

The Inspect group contains the following tools:

Use the Measure tool to display measurements of the
edges and faces in your design. Select from this tool's
menu to display edges and volumes of intersection.

Use the Mass Properties tool to display volume
information for the objects in your design.

Use the Check Geometry tool to check geometry for
common problems.

9.2.1. Displaying Measurements
Use theMeasure tool to display measurements of the edges and faces in your design. Any values displayed on screen
are automatically copied into the clipboard and can be pasted into another document.

The Measure tool is accessible in the ribbon and from within the Pull and Move tools. Measurement values are
selectable only when the tool is invoked within Pull or Move.

You can select units for measurement in the SpaceClaim Units options. You can also modify the Precision and
Angular Precision values in the Measure Tool options.

The document origin is displayed by default. You can hold Alt and select the origin or its axes as reference objects,
and the distance in that direction (or all three) is displayed.

If you holdAltand select an origin, then you will see a preview of the X, Y, and Z distance from the origin. This preview
changes as you move your mouse over objects in the Design window. If you hold Alt and select any plane, then the
preview shows the distance from the point under the mouse to the plane. If you hold Alt and select a line or axis,
then the preview shows the distance from the point under the mouse to the line. Clicking on an object sets the
dimensions in the results box.

Negative values are displayed for the results when you select an origin and the measurement is negative in the
direction of one or more axes.

Viewing a Measurement
1. Measure > Inspect > Measure

Mouse over your design to preview the faces and edges eligible for measurement.

2. Select points, curves, edges, or faces to display measurement information.
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Ctrl+ Selecting multiple objects displays measurement between them as appropriate. The value Min. distance
between objects displays an exact measurement of the minimum distance between the objects you selected.

Selecting multiple faces displays their total area.

Triple-click a body to display its total surface area. Selecting a whole body in the Measure tool also reports the
overall X, Y, and Z direction extents.

3. (Optional) Hold Alt and select a reference object.

The reference can be a point, curve, edge, face, plane, axis, or origin.

You can measure to an axis of an origin object.

4. (Optional) Hover over a measurement value to display the mini toolbar.

• Click

Copy
to copy the value to the clipboard for pasting into Notes, etc.

• Click

Flag
to create a flag group to capture the measurement and ensure unwanted changes cannot be made.

• Click

Record
to record parameters as a script in the script editor window, when scripting is enabled.

When measuring edges and curves, the Minimum and Maximum Curvature locations are highlighted in the
geometry when you hover over the result as shown below.
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Creating a Flag Group
Flag groups capture measurements and ensure that unwanted changes are NOT made to the model.

1. Measure the geometry that you do not want to change
2. Hover over the measurement.
3. Click the Flag Group

icon next to the measurement.
4. Open the Groups panel and see that a flag group has been created.

In the Groups panel, the group is shown with a

Locked
icon to indicate that it will prevent modifications. The measurement value is also listed.

Creating a Flag Group From a Dimension Annotation
Flag groups capture measurements and ensure that unwanted changes are NOT made to the model.

Flag Group Example
This example steps through the Flag Group functionality using a simple block.

The right face area is added to
a Flag Group.
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Modifications to the model
that do NOT change the right
face area can be made as
usual.

Here a Pull operation is
performed that changes the
right face area.

Because of the Flag Group, the
model snaps back with a
warning message.

You can unlock a Flag Group
by right-clicking on it in the
Groups panel and choosing
Unlock. After it is unlocked,
the icon changes to indicate
that it is unlocked and can be
modified.

At this point, the Measurement
value is also the Current value,
as indicated by the listings in
the Groups panel.
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With the group unlocked, you
can make changes to the right
face. The face still blinks red
and a warning is issued to
inform you of the new
measurement.

The icon changes to indicate
that the measurement has
changed from its original
value.

To make this new value the
Measurement value, right-click
the group in theGroupspanel
and chooseReset. This makes
the Measurement value and
the Current value the same
and it changes the group's
icon to indicate that it is still
unlocked.

To Lock the group at this new
value, right-click the group
and choose Lock.

If modifications result in the disappearance of the Flag Group's measured object, the flag group is deleted. UseUndo
to get it back.

1. Click a dimension annotation.
2. Click the Lock icon next to the measurement.

3. Open the Groups panel and see that a Flag Group has been created.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select objects tomeasure tool guide is active by default. This tool guide allows you to select the object
you want to measure.

The Select plane or origin tool guide allows you to set the measurement directions by selecting an origin,
origin axis, line, or plane. You can hold Alt and select the origin to display the X, Y, and Z coordinates from
the origin to the object being measured or between the objects if you select two objects. You can select a
plane or origin in the Structure tree or the Design window.
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Examples

Measuring between two points.

Measuring between two points, with a reference face Alt+selected, so the projected distance is appended to the
measurement.

Measuring between two points, but the origin is Alt+selected as a reference, so the X, Y, and Z distances are shown.
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Measuring the distance between two sketch points

Measuring the angle between a sketch curve and a face. The sketch curve is extended until it intersects the face.
Angle to surface normal is the angle between the extended curve and a line that is perpendicular to the surface at
the intersection point.Angle to surface is the angle between the extended curve and a plane tangent to the surface
at the intersection point.

9.2.2. Displaying Mass Properties
Use the Mass Properties

tool to display volume information for the objects in your design.

Note: The accuracy of the mass properties calculation is based on displayed facets, approximations can
occur based on faceting.

If you use the tool on a surface, it will display the total surface area. If there are multiple surfaces on the same plane,
the tool displays the total surface area for all the surfaces. To display the surfaces' individual surface areas, use the
Measure tool.
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Viewing Mass Properties of an Object
1. Click Measure > Inspect > Mass

Properties .

With the Select Body tool guide active, select a solid in the Structure tree or by triple-clicking it in the Design
window to display its volume, center of mass, and principal moments and axes.

2. A small origin appears at the center of volume with its axes oriented in the direction of the principal axes. To
calculate the principal moments and axes for another point, holdAltand select an origin to add it to your selection.

To calculate the actual moment of inertia, multiply the moment measurement by the density of the solid.

The axis is indicated with x, y, z values. In the figure above, these values are (0, -1, 0). The first number is the red
axis of the origin, the second is the green axis, and the third is the blue axis.

3. For beam objects ensure that the Material Name property is set as appropriate to display the mass and center
of mass properties in addition to the volume.

Measuring the Projected Area of an Object or Objects
1. Click Measure > Inspect > Mass

Properties .

2. Click the Select datum plane tool guide.

3. Select the objects you want to measure.

You can also hold Alt and select the object without using the tool guide.

The projected area and estimated precision is displayed in the Design window.

Measuring the Properties of a Planar Section
1. Click Measure > Inspect > Mass

Properties .

2. Click the Select Planar Face or Section Loop tool guide.

Select a planar area.
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Note: Mass properties for planar sections are approximated using edge tessellation.

Selecting a Coordinate System
1. Click Measure > Inspect > Mass

Properties .

2. Select the objects you want to measure.
3. Click the Select Coordinate System tool guide and select a coordinate system or coordinate system axis.

The center of volume and moment and axis are measured from the origin/axis chosen rather than the default
origin (0, 0, 0).

9.2.2.1. Measuring a Projected Area
You can measure the projected area of one or more objects. The objects are projected onto a plane, and the area of
their silhouette is measured.
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To measure the project area of an object or objects:

1. Click Measure > Inspect > Mass

Properties .

2. Select the objects you want to measure.

3. Select Options > Show projected area to see a shadow of the projected area.

4. Click theSelectDatumPlane tool guide or holdAltand select the plane you want the objects' silhouette projected
on.

The projected area and estimated precision is displayed in the Design window.

9.2.3. Checking Geometry
You can check the geometry for solids and surfaces. The geometry is checked for all possible ACIS errors. Select
errors and warnings in the Check Geometry dialog to highlight the associated geometry in the Design window.

To check an object's geometry:

1. Right-click a solid or surface in the Structure tree.

2. Select Check Geometry.

You can click Stop in the status bar or press Esc to cancel the operation if necessary.

A dialog will open that lists any errors or warnings found.

3. Select errors and warnings in the dialog to highlight the associated geometry in the Design window.

a. Select Zoom to fit selection to automatically zoom in to the problem area in the Design window.

b. Select Hide Others to focus on a particular problem and hide other geometry.

c. Select Create NS to create a Named Selection for the problem geometry.

d. Select Delete Face to delete problem faces.

4. Click Close when you are finished.

9.3. Interference
Use the Curves tool

to display the edges where solids intersect each other, as shown in the example below with a block and a sphere.
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Use the Volumes tool

to display volumes created by the intersection of solids, surfaces, and components in your design, as shown in the
example below.

Displaying the Edges of Intersection
1. Click Analysis > Interference >

Curves .
2. Select intersecting objects to see their edges of intersection.

Displaying Volumes of Intersection
1. Click Analysis > Interference >

Curves .
2. Select objects to display their intersection in green.

You can also select multiple faces by box-selecting or selecting in the Structure tree.

Interference with thread intersections are not reported.

3. (Optional) Click the Create Volumes tool guide and select an area of interference to create a new solid from the
volume.

Displaying Interference Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Targets tool guide allows you to select the
objects for which interference will be shown.

The Create Volume tool guide allows you to select an
area of interference and create a new solid from the
volume.

Displaying Interference Options
The following options are available:
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• Collapse toparent component: All of the component's sub-components are treated as part of a single solid when
performing the volume interference calculation. Select this option to optimize performance.

9.4. Quality
The tools in theQuality ribbon group allow you to detect any anomalies or discontinuities in a surface that shading
cannot show.

The Quality ribbon group contains the following tools:

Use the Normal tool to display the normal direction
("inside" or "outside") of faces or surfaces.

Use the Grid tool to display the curves that define any
face or surface in your design.

Use the Curvature tool to display a fringe graph of the
curvature along curves or edges.

Use the Dihedral tool to display a fringe graph of the
angle between two faces along the selected edges.

Use theDraft tool to display a fringe graph of the selected
surfaces, where each value is an angle measurement.

Use the Stripes tool to reflect a virtual 3D cube "room"
on the selected faces.

Use the Deviation tool to show the distance from a
source, or reference, body to a selected body or Mesh
body.

9.4.1. Displaying Normal Direction
The Normal tool will display the normal direction of faces or surfaces in your design. The normal direction is the
"outside" of the face or surface. The normal can be flipped when you import models. Use this tool to check and fix
face normal directions.

Displaying Normal Directions for Faces
1. Click Measure > Quality > Normal

.

2. Select an object, face, or surface. Ctrl+click to select multiple faces and surfaces, or select an object in the
Structure tree.
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The normal direction of each face or surface at the point where you click is displayed.

3. If you find an incorrect normal, right-click the face or surface and select Reverse Face Normal.

Displaying Normal Directions Options
The following options are available with the Normal analysis tool:

Display the normal direction using an arrow.Show face normal using Arrow

Display the normal direction using colors. Select colors for the front ("outside")
and back ("inside") using the drop-down menus. Use contrasting colors to
make it easier to see which faces were incorrectly reversed on import.

Show face normal using Color

Displaying Normal Directions Examples

Displaying face normals using arrows

Displaying face normals using colors

9.4.2. Displaying a Face (UV) Grid
Use the Grid tool to display the curves that define any face or surface in your design. This tool displays a visual
representation of the mathematical expression of the surface. The grid lines represent the mathematical expression
used to generate the surface. You can use it to identify a low quality surface. For example, a face may look fine, but
the underlying mathematical representation is unnecessarily complicated or poorly parameterized. You would have
problems changing the face using other tools.

If you find a face with underlying problems, you can delete the face, then use the Fill tool with the Patch Blend
option or the Replace tool to generate a new face.

Viewing a Face or Surface Grid
1. Click Measure > Quality > Grid

.

2. Select a face or surface. Ctrl+click to display the grid on multiple faces and surfaces.

Click in an empty area in the Design window to hide the grid.
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Grid Tool Options
The following option is available with the Grid analysis tool:

SelectGrid orChecker from the Texturemenu. Use this
option to increase performance with large or complex
designs.

Shading

Slide the scale or click - or + to set the scale of the grid.Wire

Displaying a Face Grid Examples

Face grids with grid shading, checker shading, and wire

Face grids displayed on a blended face and on a sphere

9.4.3. Displaying Curvature
Use the Curvature tool to show curvature values along faces or edges. You can use this analysis to identify areas
with very tight curves that can be difficult to offset or turn into thin solids.

You can also use the visualization to evaluate curvature continuity along a set of faces or edges. Curvature continuity
is when the curvature values change in a smooth, continuous manner. You can see continuous curves because the
data points will gradually change length or the transition between face coloring is even and smooth. Sudden changes
in the length of the data points or color on a face indicates non-continuous curvature.

Displaying Edge Curvature
1. Click Measure > Quality > Curvature

.
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2. Select a line, curve, or edges. Ctrl+click to select multiple lines or edges, or select an object in the Structure tree.

You can change the shading colors in the options panel.

You can change the color, scale, and density of the data points in the options panel.

Tip: Select Edges in the selection filter, then box select to select all the edges in your design.

The visualization for edges shows lines at data points along the edge. The greater the curve's radius, the longer
the data point. Straight edges won't show any data points because they don't have curvature.

Displaying Face Curvature
1. Click Measure > Quality > Curvature

.

2. Select a face or Ctrl+click to select multiple faces.

You can change the shading colors in the options panel.

In addition to the face curvature display, the absolute values for minimum and maximum curvature are displayed
in the Properties panel.

The curvature with the smallest radius is shown in the maximum color (red is the default). The curvature with
the smallest radius, or no radius, is shown in the minimum color (gray is the default).

Each line length of the fringe graph represents a curvature value C = absolute value (1/r) when a surface or body
is selected.

Curvature Tool Options
The following options are available with the Curvature analysis tool:

Show edge curvature using:

Select a color for the fringe graph from the drop-down
menu.

Color

Slide the scale or click - or + to increase or decrease the
relative size of the fringe graph.

Scale

Slide the scale or click - or + to increase or decrease the
density of sampling (the number of lines created along
the edge).

Density

Select Shading to display face curvature using color.
Select colors for Min and Max from the drop-down menus.

Shading

Curvature Tool Examples

Displaying face curvature using color

689Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Measuring and Analyzing



9.4.4. Displaying a Dihedral Graph
TheDihedral tool can be used to visualize tangency (or lack of tangency) between two faces. You won't see any data
points if you select an edge between two tangent faces. Non-tangent faces will show data points because the angle
is more than 0. The larger the angle between the faces, the longer the fringe lines will be at each test point.

You can use theRepairdihedral tool guide to make the faces tangent. You should only use this tool guide if the faces
are already close to tangent. Neighboring edges are not modified to be tangent as well, so the results can be
unexpected if the faces are not close to tangent.

Displaying a Dihedral Graph
1. Click Measure > Quality > Dihedral

.

2. Select a dihedral edge. You can Ctrl+click to select multiple edges.

Data points show the angle between the faces along the edge. Longer data points are shown for larger angles,
or, variable dihedral angles

TheAnalysis section of thePropertiespanel displays both minimum and maximum edge dihedral angle values.

Dihedral Tool Options
The following options are available with the Dihedral analysis tool:

Select a color from the drop-down menu.Color

Slide the scale or click - or + to decrease or increase the
relative size of the fringe graph.

Scale

Slide the scale or click - or + to decrease or increase the
number of points along the edge where the angle is
measured and displayed.

Density

9.4.5. Displaying Draft Angles
The Draft tool helps you identify the amount of draft and direction on each face in a design.

You can use this tool to analyze parts that will be molded. Faces shown in red (the default color for a negative draft
angle) may not release properly from a mold. You should specify the draft angle you consider necessary for proper
release. The draft angle may depend on a number of factors, including material choice and design constraints.
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Displaying Draft
1. Click Measure > Quality > Draft

.

2. Click the Draft Direction tool guide and select a face, surface, or the World Origin to set the draft direction.

If you don't first set the draft direction, the angle is measured with respect to the Z axis.

3. Set the Angle in the options panel.

The face highlight color is based on the angle you specify. A face will be highlighted in the positive color if the
angle of the face is greater than the Angle value and the negative color if its angle is smaller in the direction you
specify. You can change these colors in the Options panel.

4. Click the Draft Select tool guide and select a face to check its draft angle. You can also Ctrl+click to select solids
and surfaces, box-select or select objects in the Structure tree.

A color graph of the selected surfaces is displayed. Each value is an angle measurement between the surface
and the selected plane.

Set the probe location(s) to see the draft value at the selected locations.

You can also see the draft angle at any given location by hovering over the display.

Draft Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Draft Select tool guide is active by default. Use it to select the face(s) for which you want to display
draft angles.

Use the Draft Direction tool guide or Alt+click to select an alternate reference for the draft direction.

Use theDraft Probe tool guide to set a probe location. Use the Ctrl key to select multiple probe locations.

Use theDraft Curve tool guide to select a temporary curve (created by the faces selected, draft direction,
and angle of one or both sides) to create the curve in the Structure tree. Curves appear in the current layer
color.

Draft Tool Options
The following options are available with the Draft analysis tool:

Slide the scale or click - or + to set the minimum angle to display.Angle

Select One or Both to display the draft angle in one or both directions.Direction
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Select colors from the drop-down menus to indicate positive and negative draft
angles.

Color

Slide the scale or click-or+ to adjust the color transition between sharp and smooth.
The higher this setting, the more gradual the transition between positive and
negative faces.

Color Transition

Display shadow lines where the angle of the face is the same as the draft angle.Shadow Lines

Draft Tool Examples

Draft analysis with color transition low (sharp)

Draft analysis with color transition set to high (smooth)

The shadow line on these examples show where the angle of the curved face is the same as the draft angle. The
example on the left is shown with the Color Transition option set low, and the example on the right shows the Color
Transition set high.

9.4.6. Displaying Stripes
The Stripes tool will reflect an infinite striped plane on the selected faces (or on all the faces of the selected solid).
This tool is useful to show how the smoothness of a surface.

Use this tool to visualize and check tangency and curvature continuity between faces. For example, two surfaces
may appear to have a smooth transition, but the Stripes tool will reveal an irregularity.
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In the example above, the area marked with A has good continuity. The stripes line up almost perfectly across the
edge. The area marked with B does not have good continuity. The stripes do not quite line up at the edge.

If you find irregularities in your design, you can repair them using the following tools:

• Tangency (on the Prepare tab)

• Merge Faces (on the Prepare tab)

• Fill with the Patch Blend option (on the Design tab)

Displaying Stripes
1. Click Measure > Quality > Stripes

.

2. Select the face that you want to appear striped. Ctrl+click to select multiple faces or select an object in the
Structure tree.

Stripes Tool Options
The following options are available with the Stripes analysis tool:

Select light and dark colors for the pattern from the
drop-down menu.

Color

Slide the scale or click - or + to increase or decrease the
stripe density (the number of lines in the pattern).

Density

Stripes Tool Examples
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9.4.7. Displaying Deviation
Use theDeviation tool to show the distance from a source, or reference, body to a selected body or Mesh body. Use
this analysis to see how closely the geometry of two bodies match up. For example, you would use the Deviation
tool when you reverse engineer a design from mesh data to see how closely your design matches the mesh.

The Deviation tool also works to show deviation between meshes.

Displaying Deviation
1. Click Measure > Quality > Deviation

.

2. Select a body or a mesh as the source, or reference, body.

3. Select a second body as the target body.

When you have two bodies selected, the system automatically calculates the deviation.

Note: You can select only one mesh or faceted body.

4. Set the probe location(s) to see the deviation value at the selected locations.

You can also see the deviation value at any given location by hovering over the deviation display.
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Note: In a small number of cases, deviation results may be exaggerated. You should take sample
measurements in the areas of maximum inside and outside deviation to rule out the chance of exaggeration.

Deviation Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Body tool guide is active by default. Use it to
select the source and target bodies.

Use the Deviation Probe tool guide to set a probe
location. Use the Ctrl key to select multiple probe
locations.

Deviation Tool Options
The following options are available with the Deviation analysis tool:

Swap the faceted bodies selected as source and target
bodies.

Swap Source/Target
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• Inside distance - Choose a color for displaying
distances to sample points inside of the target body.

• Outside distance - Choose a color for displaying
distances to sample points outside of the target body.

• Tolerance - Display deviation results above a specified
tolerance. Choose a color for displaying distances
within the specified tolerance

• Transition - Slide the scale or click - or + to increase
or decrease the smoothness of the transition between
colors in the display.

Deviation

Select the method for defining the sample point spacing.Sample Spacing (Source Body)

• Body - Use body faceting vertices as sampling points
• Percentage - Specify a percentage of the body's

diameter to define sample spacing
• Length - Specify a length to use as the sample spacing

Display controls:Show

• Shading - Use textured shading to indicate deviation
• Porcupine - Use lines to indicate deviation
• Sample points - Show sample points in the deviation

display
• Target - Show the target body in the display

Transparent - If the target body is displayed, show
it as transparent



10: Sheet Metal

This section contains the following topics:

10.1. Creating and Editing Sheet Metal
Create a new sheet metal design using the tools in the Sheet Metal tab. See Converting a design to sheet metal if
you have already modeled the part.

To create a new sheet metal design:

1. Click the Sheet Metal tab.

2. Select a tool in the Sketch group.

3. Sketch the first wall of your sheet metal part:

You can see a preview of the wall's thickness as you sketch.

See Sketching sheet metal parts for detailed information and instructions.

4. Select

Pull in the Sheet Metal tab.

5. Select an edge or edges and pull side walls on your part:

Junctions, corner reliefs, and bends are automatically created as needed.

See Pulling sheet metal parts for detailed information and instructions.

Highlighting Objects in a Sheet Metal Design
Select options in the Highlight ribbon group in the Sheet Metal tab.
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You can toggle highlighting on and off for junctions, reliefs, notches, and other sheet metal objects. You can customize
the highlighting colors in the SpaceClaim Sheet Metal Options. Show Flat Bend Extents turns off tangent edges
when unchecked in the unfolded part.

10.2. Working with Sheet Metal
You can use SpaceClaim to create sheet metal designs and components.

SpaceClaim recognizes a component as sheet metal if it consists of only planar, cylindrical, and conical faces, and
when faces are offsets of the same size.

Sheet metal parts are displayed in azure (blue) by default. Unfolded parts are displayed in purple, as shown in the
image below.

Unfolded parts have the following default layers:

• Dimension
• Bend Lines Up
• Bend Lines Down
• Bend Dimensions
• Forms
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10.3. Importing Sheet Metal Designs
This section contains the following topics:

10.3.1. Converting a Design to Sheet Metal
Use the

Convert tool in the Import ribbon group on the SheetMetal tab to convert an existing design to sheet metal within
SpaceClaim. You may need to convert if you imported regular geometry or if you moved a part to another component.

When you click theConvert tool and select a surface body of a design, the surface body automatically thickens into
a sheet metal body at the default sheet metal thickness. This enhancement eliminates the need to redo a surface
you may have sketched prior to converting the design to sheet metal. After you convert the body, you can use the
Identify tool to call out forms, joggles, hems, etc.

Walls, bends, junctions (only created, default-sized junctions, not imported junctions), and forms that were made
in Sheet Metal are identified by color: Faces are blue, junctions are purple, forms are orange, partial bends are yellow,
and edges of end faces that are not square are red. Identification is important because it allows the element to be
unbent or flattened when you unfold the part.

Converting a Solid to Sheet Metal

1. Click
Convert in the Import group on the Sheet Metal tab.

The Select Bodies tool guide is enabled by default.

2. Select the body you want to convert.

You can Ctrl+click to select multiple bodies.

Walls, bends, and junctions (only default-sized junctions you created as sheet metal, not imported junctions)
are automatically detected and identified by color. Faces that are not separated by the default thickness are not
highlighted. Edges shown in red indicate end faces that are not square, as shown in the following figure.

3. Click the Assign Objects tool guide.
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4. Convert hard edges to junctions:

a. Select an option from the Junction tool in the Create group on the Sheet Metal tab.
b. Select the hard edges that you want to convert to the current junction type.

Clicking an edge shown in red creates a junction or squares up a sharp face. The edge you click to square a
face determines the final length of the sheet metal wall.

When you convert to sheet metal, faces that have problems are identified with error messages in the Status Log.
Clicking on each message will highlight the problem with red blinking. In the example below,the message is selected
and the problem is highlighted in the upper left corner of the leftmost image. A detailed view of the problem geometry
is shown below in the rightmost image.

This example shows the converting of a sheet metal design with bends automatically detected.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use theSelectBodies tool guide to select the part(s) you
want to convert to sheet metal.

Use the Assign Objects tool guide to assign or change
the junction types, reliefs, and notches. You can only
select geometry that is appropriate for the tool guide.
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10.3.2. Sheet Metal Square-Up
After you have converted a design to sheet metal, you can use the

Square-Up tool in the Import ribbon group on the Sheet Metal tab to find and fix edges and faces that are not square
to the Sheet Metal sheet.

The image below shows a simple example. The circular hole and right thickness face are not perpendicular to the
sheet. Square-Up finds this geometry and highlights it.

Squaring up Sheet Metal Geometry
1. Click the

Square-Up tool in the Import group in the Sheet Metal tab.

Geometry that can be squared-up is highlighted in red.

2. Click the highlighted geometry to fix:

• If you click an edge, that edge remains fixed and the opposite edge is moved to line up with the selected edge

• If you click a face, all edges misaligned on the opposite face are moved.

10.3.3. Identifying Sheet Metal
When you use the Convert tool to convert a body to sheet metal, or, are working with an existing sheet metal body,
only the sheet metal faces that are separated by the default sheet metal thickness are shown in blue, but sheet metal
that varies in thickness from the default, as shown in the image below, does not display in blue:
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After you have converted a design to sheet metal, you can use the

Identify tool in the Import ribbon group in the Sheet Metal tab to call out sheet metal geometry such as forms,
hems, joggles, beads, notches, and gussets.

You can also use Select > Using Box to identify sheet metal geometry. Box selecting selects front and back faces
of the pre-identified sheet metal geometry.

Some geometry is automatically identified and other geometry must be manually assigned. As the geometry is
identified, the highlighting color changes to indicate. the sheet metal object.

Objects in a converted sheet metal part must be identified before they can be unfolded.

Identifying Sheet Metal Geometry
1. Click the

Identify tool in the Import group in the Sheet Metal tab.

2. Identify each of the following objects as needed by clicking the appropriate tool guide. Click Complete when
finished.

• Beads: Select highlighted beads or select the faces to identify as a bead.

• Forms: Select highlighted forms or select the faces to identify as a form.

• Formed Bends: Select highlighted formed bends or select the faces to identify as a formed bend.

• Gussets: Select highlighted gussets or select the faces to identify as a gusset.

• Hems: Select highlighted hems or select the faces to identify as a hem.

• Joggles: Select the faces to identify as a joggle.

• Notches: Select highlighted notches or select the faces to identify as a notch.

• Tabs: Select highlighted tabs or select the faces to identify as a tab.

• Reliefs: Select highlighted reliefs or select the faces to identify as a relief.

Highlighting Sheet Metal Objects
Select All, or some of the options, from the Highlight drop-down in the Show group in the Sheet Metal tab, as
shown in the image below:
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Examples - Identifying Sheet Metal

Automatically identifying forms.

Automatically identifying a hem.

Selecting two bends to identify a joggle.

Selecting the front faces and back faces to identify a bead.
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Selecting the thickness edges to identify a notch.

Automatically identifying gussets.

Unfolding a sheet metal design after identifying the geometry.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use the Beads tool guide to find and identify beads.

Use the Forms tool guide to find and identify formed
sheet metal details on a part.

Use the Formed Bends tool guide to find and identify
formed bends.

Use the Gussets tool guide to find and identify gussets.

Use the Hems tool guide to find and identify hems.

Use the Joggles tool guide to select faces to identify as
joggles.

Use theNotches tool guide to find and identify notches.

Use the Tabs tool guide to identify tabs.

Use the Reliefs tool guide to identify reliefs.

Use the Complete tool guide to complete each
identification.
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10.4. Sketching Sheet Metal Parts
The tools in the Sketch group in the Sheet Metal tab are a little different from normal sketch tools:

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. See Sheet metal options to change the default wall thickness. Lines, splines, and arcs are extruded when
they form a closed profile.

Sketching in empty space creates new walls.

A preview is displayed as you sketch that shows you the wall thickness for each sketch curve:

Sketching perpendicular to an existing wall creates a new wall with a bend between the walls with corner or rip
reliefs where needed. The bend radius is created inside when the sketch is connected to the top edge and outside
when the sketch is connected to the bottom edge:

Sketching on an existing wall creates sketch curves on the wall that you can use with the Bend and Split tools.

Sketching adjacent to or overlapping an existing wall adds material to the wall and may imprint the overlapping
curves on the wall:

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch:
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Sheet Metal Sketch Tools
The following tools are available:

PolygonsCirclesRectanglesLines

SplinesThree-point circlesThree-point rectanglesTangent lines

Three-point arcsSweep arcsEllipsesTangent arcs

Sheet Metal Sketch Options
The following Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is
perpendicular to the sketch plane:

When sketching an open profile (series of lines), a
perpendicular wall is created. When sketching a closed
profile (square, circle, etc.), a flat wall is created.

Auto

Any closed sketch creates a flat wall.
Flat

When sketching an open profile (series of lines), a
perpendicular wall is created.Profile

Use the starting location of the sketch to determine
whether the inside or the outside of the sheet is
maintained when bending.

Automatic

Maintains the length of the sheet's inside surface when
bending.Inside

Maintains the length of the sheet's outside surface when
bending.Outside

Common Sketch Options
The following options are available for every sketch tool:

• Cartesian dimensions: Select a point in a sketch and then click this option to see Cartesian dimensions from the
point. Cartesian dimensions show you the X and Y distances from the point you select. If you don't have a point
selected, it shows you the X and Y distances from the origin.

• Polar dimensions: Select a point in a sketch and then click this option to see Polar dimensions from the point.
Polar dimensions show you an angle and a distance from the point you select. If you don't have a point selected,
it shows you the angle and distance from the origin.

• Snap to grid: Select this option turn snapping on or off while sketching. The cursor will snap to the minor grid
spacing increment while you sketch. The defaults are 1mm for Metric and 0.125in for Imperial units. See Units
options to change the minor grid spacing.

• Snap to angle: Select this option to turn angle snapping on or off while sketching. The cursor will snap to the
angular snap increment while you sketch. The default is 15 degrees. See Snap options to change the angular
increment used for snapping.
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• Create layout curves: The sketch curves are created as layout curves. If you move the design to a drawing sheet,
with Sketch mode selected you must select the Create layout curves option again in the Sketch Options group
of the Options panel in order to create layout curves on the drawing sheet. See Layout Curves.

• Curve Fitter Options: If the Sketch plane passes through a Mesh object, the system will fit curves through the
facet points. Lines are displayed green and arcs are displayed blue. The following options apply to the
system-generated curves.

º Fit curves - Uncheck this option if you do not want the system to fit curves through the points.

º Tolerance - Determines how many points will be found, which also determines how many curves will be created.
The smaller the tolerance, the more points will be found and the curves will be generated.

º Auto-merge - When checked On, the system will merge lines and arcs to form splines. Splines are displayed
pink.

10.4.1. Lines
The Sheet Metal Line tool is primarily used to sketch freeform shapes and to draw lines that will become bends.
See Bending a sheet metal wall.

Lines, splines, and arcs are extruded to the thickness of a sheet metal wall when they form a closed profile. You can
change the default wall thickness in the sheet metal properties.

In addition, you can use the Profile option to create a wall that is perpendicular to the sketch plane as you sketch.

When sketching lines for a profile wall, the attachment edge for determining inside or outside radius follows the
same paradigm as flat-sketched walls. In the images below, both lines start at the top corner. Sketching vertically
downward creates an outside wall, while sketching vertically upward creates an inside wall.

Sketching a Line in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Line in the Sketch group or press L.
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3. (Optional) Click the Profile option if you want to create walls as you sketch.

4. Click to set the first point of the line.

You can dimension the points relative to other sketch objects.

5. Click to set the next points of the line.

If you want any section of the line to be an arc, right-click and select Switch to Arc, then click to set the radius.
Right-click and selectSwitch to Line to return to drawing straight lines between points. You must create at least
one line segment before using this option.

6. End the line:

• Double-click to set the end point of the line.

• Right-click and select Finish Line.

• Press Esc.

• Connect the end point to the start point.

• Click any tool (except the Clipboard and Orient tools).

To do it faster, click and drag to draw one straight line.

This example shows the sketching of a polyline using the Profile Sheet metal option.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.2. Tangent Lines
Use the Sheet Metal Tangent Line tool to sketch lines that are tangent to curves in your design.

Lines, splines, and arcs are extruded to the thickness of a sheet metal wall when they form a closed profile. You can
change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.
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Sketching a Tangent Line in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Tangent Line in the Sketch group.

Curves are highlighted as you hover over them, and the tangency indicator appears at your cursor location. If
there are no curves in your design, this tool is disabled. You must add a curve to create a tangent line.

3. (Optional) Click the Profile option if you want to create walls as you sketch.

4. Click the curve you want to draw tangent to.

As you move the mouse, the start point moves so that the line remains tangent to the curve.

5. (Optional) Dimension the line with a length.

You cannot dimension from another sketch object when creating a tangent line.

6. Click to set the end point of the line.

If you move your mouse over another curve, the line snaps so that it is tangent to the second curve. Hold Alt to
stop your cursor from snapping to curves.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.3. Tangent Arcs
Use the Sheet Metal Tangent Arc tool to sketch an arc that is tangent to a curve or line in your design.

Lines, splines, and arcs are extruded to the thickness of a sheet metal wall when they form a closed profile. You can
change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Tangent Arc in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Tangent Arc in the Sketch group.

The tool is disabled if there are no curves or lines in the sketch plane.

3. (Optional) Click the Profile option if you want to create walls as you sketch.
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4. Click the line or curve you want to draw tangent to.

This is usually done at the end point of a line, arc, or spline, but it can be on the line. If two lines share an end
point, use the scroll wheel to set tangency to the other line.

5. (Optional) Dimension the radius and chord angle.

6. Click to set the end point of the arc.

The arc cannot end on its start point to make a circle or end on the same line as its start point.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.4. Rectangles
The Sheet Metal Rectangle tool is most often used to draw the base of a sheet metal part. After you sketch a base,
you can use the Pull tool to create walls perpendicular to the rectangle.

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. You can change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Rectangle in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Rectangle in the Sketch group or press R.

3. (Optional) Select Define rectangle from center in the Options panel to start drawing the rectangle by clicking
the point for its center instead of a corner.

4. (Optional) Click the Profile option if you want to create walls as you sketch.

5. Click to set the first corner.

Move your mouse over the sketch grid to preview the rectangle. Dashed lines appear when you create a square
or golden rectangle.

You can dimension the points relative to other sketch objects.

6. Click to set the opposite corner of the rectangle.
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Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

The following additional options are available in the Options panel:

Define rectangle from center: Select this option to sketch rectangles from their centers. Click to define the center
of the rectangle, then click again to set the length of the sides. You can also drag to draw the rectangle. Hold the Alt
key while drawing a rectangle to toggle this option on-the-fly.

10.4.5. Three-Point Rectangles
The Sheet Metal Three-Point Rectangle tool is used to draw a rectangle at any angle on the sketch plane.

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. You can change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Three-Point Rectangle in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Three-Point Rectangle in the Sketch group.

3. (Optional) Select Define rectangle from center in the Options panel to start drawing the rectangle by clicking
the point for its center instead of a corner.

4. (Optional) Click the Profile option if you want to create walls as you sketch.

5. Click to set the first corner of the rectangle.

Move your mouse over the sketch grid to preview the rectangle. Dashed lines appear when you create a square
or golden rectangle.

You can dimension the points relative to other sketch objects.

6. Click to set the length of the second side.

Note: Click and drag to draw the first side, then click to set the length of the second side.
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Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

The following additional options are available in the Options panel:

Define rectangle from center: Select this option to sketch rectangles from their centers. Click to define the center
of the rectangle, then click again to set the length of the sides. You can also drag to draw the rectangle. Hold the Alt
key while drawing a rectangle to toggle this option on-the-fly.

10.4.6. Ellipses
Use the Sheet Metal Ellipse tool to draw ellipses in sheet metal.

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. You can change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching an Ellipse in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Ellipse in the Sketch group.

3. (Optional) Click the Profile option if you want to create walls as you sketch.

4. Click to set the center of the ellipse.

You can dimension the points relative to other sketch objects.

5. Click to set the overall length and angular orientation of the first axis.

6. Click to set the length of the second axis.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.7. Sweep Arcs
Use the Sheet Metal Sweep Arc tool to sketch an arc when you know the location of its center and end points.
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Lines, splines, and arcs are extruded to the thickness of a sheet metal wall when they form a closed profile. You can
change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Sweep Arc in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Sweep Arc in the Sketch group.

3. Click to set the center of the arc.

You can dimension the point relative to other sketch objects.

4. (Optional) Click the Profile option if you want to create walls as you sketch.

5. Click to set the start point and radius of the sweep circle.

You can dimension the chord angle or offset the angular dimension.

6. Click to set the end point of the arc.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.8. Three-Point Circles
Use the Sheet Metal Three-Point Circle tool to draw circles when you know the location of the edge of the circle
but you don't know the location for its center, or when you want to draw a circle that is tangent to two objects.

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. You can change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.
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Sketching a Three-Point Circle in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Three-Point Circle in the Sketch group.

3. (Optional) Select Three-point circle segment in the Options panel to create an arc that is a segment of a
three-point circle.

4. (Optional) Click the Profile option if you want to create walls as you sketch.

5. Click to set the first point on the circle's edge.

If you click a curve or line, the circle will be drawn tangent to the curve or line, unless you click the midpoint or
vertex.

You can dimension the points relative to other sketch objects.

6. Click to set the second point on the circle's edge.

If the circle disappears as you move your mouse over the sketch grid, then the cursor location cannot be included
in any circle drawn through the first two points and the current point. If you click a curve or line, the circle will
be drawn tangent to the curve or line unless you click the midpoint or vertex.

7. Click to set the last point on the circle's edge.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

The following additional options are available in the Options panel:

Three-point circle segment: Check this option to create an arc that is a segment of a three-point circle. To create
an arc with this option, click to set the first point, click to set the second point, then enter the diameter or click to
set the final point.

10.4.9. Circles
Use the Sheet Metal Circle tool to draw circles in sheet metal.

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. You can change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Circle in Sheet Metal
1. Select the Sheet Metal tab.
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2. Click
Circle in the Sketch group or press C.

3. (Optional) Click the Profile option if you want to create walls as you sketch.

4. Click to set the circle's center.

You can dimension the points relative to other sketch objects.

5. Click to set the circle's diameter.

6. The circle will snap to existing sketches or determined circles and arcs in the plane of the sketch.

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by editing
its dimension, tangency with the other circle is maintained.

If you drag the center of a circle that is tangent to another circle, the radius of the other circle changes to maintain
tangency.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.10. Polygons
Use the Sheet Metal Polygon tool to draw a polygon with between 3 and 64 sides.

Rectangles, circles, polygons, and ellipses are automatically extruded to the thickness of a sheet metal wall as you
sketch. You can change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Polygon in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Polygon in the Sketch group.

3. (Optional) Select Use internal radius in the Options panel to dimension the polygon based on the diameter of
a circle inscribed within the polygon. Uncheck the option to dimension the polygon based on a circumscribed
circle.

4. (Optional) Click the Profile option if you want to create walls as you sketch.

5. Click to set the center of the polygon.

You can dimension the points relative to other sketch objects.

6. Drag the mouse to draw the polygon and change its orientation.
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The orientation is the polygon's angle relative to the X and Y axis.

You can press Tab and type a number to change the diameter, orientation, or number of sides.

7. Click to complete the polygon.

The sides of the polygon are all related, and act as one object. When pulled in 3D, the edges and faces of the
polygonal solid will also maintain this relationship.

Tip: If you trim a polygon sketch with the Trim Away tool, you can drag the original sides of the polygon
with the Select tool to recreate the polygon.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

The following additional options are available in the Options panel:

Use internal radius: Select this option to dimension the polygon based on the diameter of a circle inscribed within
the polygon. Uncheck the option to dimension the polygon based on a circumscribed circle. In the image below,
the blue circle is inscribed within the polygon and the orange circle is circumscribed around it.

10.4.11. Splines
Use the Sheet Metal Spline tool to draw curvy lines in sheet metal.

Lines, splines, and arcs are extruded to the thickness of a sheet metal wall when they form a closed profile. You can
change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Spline in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Spline in the Sketch group.

3. (Optional) Click the Profile option if you want to create walls as you sketch.

4. Click to set the first point of the spline.

5. Click to set the next points of the spline.

You can Dimension spline points by entering the coordinate distance from the start point to each point, or
dimension each point relative to another sketch object.
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6. End the spline:

• Double-click to set the end point of the spline.

• Right-click and select Finish Spline.

• Press Esc.

• Connect the end point to the start point.

• Click any other tool (except the Clipboard and Orient tools).

You can create a closed spline in the following ways:

• When drawing a spline, end it on the start point.

• When editing the spline, drag one end point on top of the other point.

Once you have created a closed spline, you cannot edit it into an open spline.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.4.12. Three-Point Arcs
Use the Sheet Metal Three-Point Arc tool to sketch an arc when you know its chord angle and the location of its
start and end points.

Lines, splines, and arcs are extruded to the thickness of a sheet metal wall when they form a closed profile. You can
change the default wall thickness in the sheet metal properties.

In addition, you can choose theProfileoption to create a wall that is perpendicular to the sketch plane as you sketch.

Sketching a Three-Point Arc in Sheet Metal
1. Select the Sheet Metal tab.

2. Click
Three-Point Arc in the Sketch group.

3. (Optional) Click the Profile option if you want to create walls as you sketch.

4. Click to set the start point of the arc.
5. If the start point is on another line, arc, or spline, then the arc will initially be drawn tangent to that line, arc, or

spline.

You can dimension the point relative to other sketch objects.
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6. Click to set the end point of the arc.

7. Click to set the arc's radius.

You can dimension the chord angle or radius.

The arc will snap to tangent objects.

Tool Options
The Sheet Metal sketch options allow you to choose between sketching a flat wall or a wall that is perpendicular to
the sketch plane.

See Common Sketch Options on page 706 for descriptions of the common sketch options.

10.5. Editing Sheet Metal Parts
This section contains the following topics:

10.5.1. Selecting Sheet Metal Objects
The Select tool on the Sheet Metal tab works much like the standard Select tool, with the following differences:

• The tools on the Sheet Metal tab recognize junctions, bends, bend reliefs, and forms first, then edges and points
when you scroll the mouse wheel to select the underlying entities.

• Your selection is now automatically converted from faces to junctions, bend reliefs, or forms when you switch to
the Sheet Metal tab and the Pull, Select, or Move tool is active. The selection is converted back to faces when
you switch to a different tab.

• You can box-select sheet metal objects. For example, to select a corner relief, box-select all of the faces in the
corner relief. If you box-select any of the faces from right to left, the entire sheet metal object is also selected, even
if you have not fully enclosed the object within the selection box.

• Only the tool guides and options that are appropriate for sheet metal are displayed.

Shortcut keys work for all of the tools on both tabs. For example, you can press S to activate the Select tool from
either the Design tab or the Sheet Metal tab.

10.5.2. Pulling Sheet Metal Parts
Use the

Pull tool in the Edit ribbon group in the Sheet Metal tab to change sheet metal parts.
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You can create conical bends by pulling one edge of a bend junction.

Pulling Sheet Metal Parts
1. Click the

Pull tool in the Edit group in the Sheet Metal tab.

Shortcut keys work for all of the tools on both tabs. For example, you can press P to activate the Pull tool from
either the Design tab or the Sheet Metal tab.

2. Change the Junction and Relief tool settings in the Modify group, if necessary.

The settings of these tools are used when you pull. For example, if the Junction tool is set to Sharp, then a sharp
edge is created when you pull. The tools' icons change to represent their current settings, so you can see them
at a glance.

3. (Optional) Change the bend behavior in the Options panel:

The bend options control where bend radii are created in relation to adjacent walls.

•
Use Edge Location: When you pull a sheet metal edge, the location of the bend radius depends on the edge
you select and the direction you pull.
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When you pullaway from the other edge (1), the selected edge becomes an inside corner. When you pullacross
the other edge (2), the selected edge becomes an outside corner.

•
Inside: The length of the inside surface of the wall is maintained, like 1 in the illustration above.

•
Outside: The length of the outside surface of the wall is maintained, like 2 in the illustration above.

•
Offset: The amount of space to allow for the bend when pulling.

• Bend angle: The angle between the two walls.

• Bend radius: The inside radius of the bend.

4. Select one of the following:

• An edge to create a new wall with the default sheet thickness.

• A thickness face to extend an existing wall.

• A wall face to offset (or move) the wall in the direction of the Pull arrow.

• A thickness edge to round or chamfer the edge. You cannot create a hem on a non-thickness edge.

5. (Optional) Click the Pull Direction tool guide or hold Alt and select a reference element to set the direction of
the pull.

6. (Optional) Click the Up To tool guide or press U and select a face, edge, or point to pull up to.

7. Click a yellow Pull arrow and drag in the direction of the arrow.

Panel Bends
Select a chain of edges to create a Panel Bend.
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You can change the height of the Panel Bend (11.59 mm in the image above) after the bend is created. Select the
Panel Bend and change the Height property in the Properties panel.

You can also change the Flat Length property to change how the Panel Bend unfolds. See the Unfold topic for more
information.

Walls
Junctions and bend reliefs are automatically created and are determined by the current settings of the Junction
and Relief tools. Pulling an edge on an inside contour creates a wall with a gap on both sides, if a circular or square
bend relief is chosen at the standard bend relief width. If a Rip relief type is selected, then the gap is equal to the rip
width.

You can select an edge loop to pull multiple walls simultaneously, as shown below.

When you pull walls up on a design, the side edges of the new wall will follow the angles of its neighbors. This angle
is usually 90°, but can be almost any angle. If the neighboring walls are obtuse angles, the neighbor wall must be
less than 135° for the new wall to follow along the neighbors.

When pulling side edges with neighboring bend junctions, you can snap the resulting round radius to the radius of
the junction. Hold the Shift key while pulling to snap to the bend radius, inner or outer, whichever is appropriate.
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Joggles
Since Sheet Metal thickness faces are thin, and you are likely zoomed out, selecting a non-thickness edge allows
both edge and face Pull options. The image below shows that you can choose to pull the edge (dimmed Pull arrow)
to create a new wall, or pull the face (active Pull arrow) to extend the wall. When you extend the wall, you have the
option of creating a Joggle by clicking the Joggle icon in the mini-toolbar.

If you choose Joggle in the mini-toolbar

,
pulling the edge will create a Joggle.

On cylindrical walls, the mini-toolbar has an option to create a Curved Joggle

.
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Examples

Pulling a wall with an adjacent wall creates a matching angle in the end of the new wall.

Pulling one side of a wall moves the wall and changes adjacent walls.

Moving walls using the Up To tool guide.

Pulling a wall up to an angled wall. The wall merges to the walls from which it extends. The extension and angled
wall do not merge, a small gap is maintained.

Creating swept sheet metal walls by selecting a tangent chain of edges and pulling them perpendicular to the chain
(left). Swept sheet metal walls can be unfolded (right).

Pulling the edge of an inner loop to create a flange form. Edge reliefs are created automatically and can be unfolded.
(Reliefs are not highlighted in the figure because they are not yet classified as edge reliefs).
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Pulling an angled sheet metal wall. The neighboring wall is modified so that it does not maintain the junction.

Using the Revolve tool guide to maker an angled end face.

Pulling a Partial Wall
1. Click the Pull tool.

2. Change the Relief tool setting in the Create group, if necessary.

3. Select an edge on the wall.

4. Drag one or both of the yellow balls to the desired width.

Type a number to dimension the location from the end of the edge.

5. Click a yellow Pull arrow and drag in the direction of the arrow.

6. Reliefs are created as necessary. The shape and size of the relief is determined by the Edge Relief tool and your
Sheet metal options.

Pulling a Wall Between Two Parallel Walls

1. Click
Pull in the Create group in the Sheet Metal tab.

2. Select an edge on the first wall.

3. Click the Up To tool guide or press U.

4. Select an edge on the second wall.

The Pull handle previews the direction of the pull direction when you move your mouse over an edge.

Bends are automatically added as needed.
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Controlling the Bend Angle of a Pull
Enter a value in the Bend angle option before pulling.

The angle is measured from the flat state of the sheet. The following image shows a 10° (left) and 170° (right) bend

Creating a Round or Chamfer
1. Click the Pull tool.

2. Select one or more thickness edges.

3. Click Round or Chamfer in the Pull options panel.

You can also select Round or Chamfer from the mini-toolbar.

4. Click a yellow Pull arrow and drag in the direction of the arrow.

Creating a Jog or S Junction
1. Click the

Pull tool in the Create group in the Sheet Metal tab.

2. Select the edge of a sheet metal wall.

3. Select a Bend option in the Sheet Metal Options panel.

4. Pull along the direction of the wall.

The wall will jog up one wall thickness and continue in the same direction, as shown below. The bend faces
become joggles.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. This tool guide allows you to select an object to pull.

The Revolve tool guide allows you to revolve instead of pulling in a direction.

The Pull Direction tool guide allows you to set the direction to pull.

The Up To tool guide pulls the object up to another object.

When using the Up To tool guide to move a face, form, or bead to a new location on a part, such as an
edge or face, select a direction with a Move tool handle and click the Up To tool to move the face, form,
or bead to the new location. You can also use this tool guide with a sheet metal model in flattened mode.

Sheet Metal Options
The following Sheet Metal options are available for the Pull tool:

•
Use Edge Location: When you pull a sheet metal edge, the location of the bend radius depends on the edge you
select and the direction you pull.

When you pull away from the other edge, the selected edge becomes an inside corner. When you pull across the
other edge, the selected edge becomes an outside corner.

•
Inside: The length of the inside surface of the wall is maintained, like 1 in the illustration above.

•
Outside: The length of the outside surface of the wall is maintained, like 2 in the illustration above.

•
Offset: The amount of space needed to offset the sheet, in order to allow space for pulling.

•
Dimension to Selected Edge: Uses the selected edge to automatically calculate the dimension reference based
on the subsequent pull direction.

•
Dimension to Inside Edge: Uses the inside edge as the dimension reference regardless of the pull direction.

•
Dimension to Outside Edge: Uses the outside edge as the dimension reference regardless of the pull direction.

• Bend angle: Angle between the two walls.
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• Bend radius: Inside radius of the bend.

Pull Tool Options
• Add: Only add material when you pull. If you pull in a subtractive direction, no change will occur. You can combine

this option with other Pull options.

• Cut: Only remove material when you pull. If you pull in an additive direction, no change will occur. You can combine
this option with other Pull options.

• Nomerge: Pulls without merging into other objects even when the object pulled intersects with an existing object.

• Round: Create a rounded corner (fillet) on a thickness edge while pulling.

• Chamfer: Create a chamfer on a thickness edge while pulling.

10.5.3. Moving Sheet Metal Objects
• The tools in the Sheet Metal tab recognize junctions, bends, bend reliefs, and forms first, then edges and points

when you scroll the mouse wheel to select the underlying entities.
• You can select a form with one click and move or rotate the form using the Sheet Metal Move tool. The 2D Move

handle is displayed for a form, and it is lined up with the frame of the form.
• Your selection is automatically converted from faces to junctions, bend reliefs, or forms when you switch to the
Sheet Metal tab and the Pull, Select, or Move tool is active. The selection is converted back to faces when you
switch to a different tab.

• Only the tool guides and options that are appropriate for sheet metal are displayed.
• The side of the wall you select determines how a bend changes when you rotate a wall. See Rotating sheet metal

walls. When you move a wall, any associated sheet metal objects associated with that wall, such as junctions,
edges, reliefs, corner reliefs, and bends, also move with the wall.

Shortcut keys work for all of the tools on both tabs. For example, you can press M to activate the Move tool from
either the Design tab or the Sheet Metal tab.

Faces which have beads can be moved with the Move tool.

Moving an Edge Relief
1. Click the

Move tool in the Create group in the Sheet Metal tab.

2. Select the edge relief.

3. Click an axis and drag in that direction.

Moving aWall Between Joggles
1. Click the Move tool.

2. Select a wall between joggles.

3. Click an axis and drag in that direction.

The wall is translated between the joggles.
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Note: You can move a joggle along a bend. If you have trouble moving a joggle, use the sheet metal Select
tool to select the joggle, then usethe Move tool in the Edit ribbon group of the Design tab to move it.

Example
The example shows translating a wall between four joggles.

10.5.3.1. Rotating Sheet Metal Walls
Select one face of the sheet metal wall and rotate it with the Move handle. If you select the inside of a face to rotate
around the inside bend center, or select the outside face to rotate around its outer mold line

A default junction to rotate around is chosen based on which junction causes the smaller portion of the part to
rotate. To rotate around the other junction, drag the Move handle anchor (the center ball) to an edge on the other
junction.

Rotating a Sheet Metal Wall

1. Click
Move in the Edit group on the Design tab.

2. Select a face of the wall you want to rotate.

The face you select determines the rotation point:

Select the inner face to rotate around the inside of the bend:

Select the outer face to rotate around the outside of the bend (the outer mold line):
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When a wall is rotated around the outer mold line, the size of the walls change. This type of rotation is useful
because the mold line is a measurable point for inspection.

If the face is connected to more than one junction, then the junction closest to the point where you click is
selected:

3. Select the blue rotation axis and rotate the wall.

The Move tool will stop when the wall touches another wall.

The bend will reverse direction if you rotate the wall so its angle is greater than 180°.

Example

Rotating the inside wall so the bend is reversed.

Rotating walls that are split on an edge around a bend junction and then translating tha base face shared by the
split walls.
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10.6. Modifying sheet metal parts
SpaceClaim automatically creates reliefs, junctions, and other sheet metal features as you create a sheet metal
design or convert a design to sheet metal.

Use the following tools in the Modify ribbon group on the Sheet Metal tab to change the type of existing sheet metal
features or to create additional features.

Modify ribbon group
The Modify ribbon group contains the following tools:

Junctions

Edge relief

Corner relief

Notch

Hem

10.6.1. Changing junction types

The icon on the Junction option tool changes to reflect the junction type. This setting is saved until you close
SpaceClaim. The junction type can also be found in the Sheet Metal section of the Properties panel when you select
a junction.

Select Junctions in the Highlight group to highlight all junctions in your sheet metal design.

To change the junction type
Select an option from the

Junction tool in the Create group on the Sheet Metal tab:

A traditional, circular bend
between two sheet metal
walls.

Bend

One wall overlaps the other.Full Overlap
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One wall overlaps the other
halfway.

Partial Overlap

The walls meet but do not
overlap.

No Overlap

Removes rips and bends from
the geometry and returns it to
a shell, where there is no
inside or outside radii. (You
can also rotate a 180° "hem"
to create a 90° flange.)

Sharp

One side of the junction is bent
and the other is straight. Use
Reverse to change the bent
and straight sides.

Flange

The junction will no longer be
recognized by SpaceClaim.

None

The junction type you select is saved as the default for the session, so any junctions created by Pull will be this
junction type.

To change a junction on a sheet metal design
1. Select an edge or face of a junction.

You can Ctrl+click to select multiple junctions.

2. Select an option from the Junction tool.

You can also select an option from the mini-toolbar or change theJunction type value in the Sheet Metal section
in the Properties panel.

Examples

Selecting an edge to change an S Bend junction to a No Overlap junction

Selecting the edge of a corner junction to change the junction type from No Overlap to Full Overlap
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Changing a Bend to a Full Overlap junction

Using the junction mini-toolbar to change a junction type when Select and Pull tools are active

To remove a junction
1. Select an edge or face that belongs to one or more Full overlap, Partial overlap, or No overlap bend junctions.
2. Ctrl+click to elect multiple edges.

3. Select the None option from the Junction option tool.

You can also right-click the edge or face and click

in the junction mini-toolbar or select None as the Junction type in the Sheet Metal section of the Properties
panel.

The geometry at the junction will not change, but the junction will no longer be recognized by SpaceClaim. You
may need to do this when you want to make changes that can't be made to a recognized junction, such as creating
a partial flange.

To reverse an overlap junction
Right-click a partial overlap or full overlap junction and select Reverse from the context menu.

10.6.1.1. Creating a partial flange junction
The part shown below has partial flange junctions on the front and back corners:
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To create a partial flange
1. Select an edge or face that belongs to a junction.

2. Change the junction type to No Overlap, if necessary.

3. Change the Junction type parameter in the Sheet Metal section of the Properties panel to None.

4. Click
Pull in the Edit group on the Sheet Metal tab.

5. Select the outside edge of one wall of the junction.

6. Drag the yellow balls in to the points where you want the flange to end, as shown below.

7. Pull in the direction that is parallel with the adjacent wall, as shown below.

10.6.2. Creating and changing edge reliefs
Edge reliefs are automatically created when you pull a partial wall.

The edge relief type is determined by the
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Edge Relief option tool in the Modify group on the Sheet Metal tab. The default is round, but you can change it to
another type. The icon on the Edge Relief tool changes to reflect the relief type. This setting is saved until you close
SpaceClaim.

The shape of the end of a partial split is also determined by the relief type you have set for the Edge Relief tool. See
Splitting a sheet metal face.

The dimensions of a relief are determined by the relief settings in Sheet metal options.

Dragging a yellow ball end point to pull a partial wall creates an edge relief.

A message appears in the status bar if a relief cannot be created, such as when it is too close to the side.

After you create a bend that has an edge relief, you can select the relief and change the type using the Edge Relief
tool, or you can change the type, depth, and width in the Properties panel. You can also move an edge relief along
a sheet metal wall.

IconEdge relief type

Round

Square

Rip

Circular

Smooth

Note: Smooth and Circular edge reliefs do not change the 3D geometry. Their effect is seen in the unfolded
part.

To change an edge relief type and dimensions
1. Select an edge or face of a relief.

You can Ctrl+click to select multiple reliefs.

2. Select an option from the Edge Relief tool in the Modify ribbon group on the Sheet Metal tab.

You can also select a relief type from the mini-toolbar or modify theBendRelief Type in the Sheet Metal section
in the Properties panel. Depending on the relief type, you can also modify:

• Bend Relief Width: The width of the relief is A in the images below.
• Bend Relief Depth: The depth of the relief is B in the images below.
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10.6.3. Creating and changing corner reliefs
Corner reliefs are created automatically when you create a sheet metal design or convert a design to sheet metal.

The corner relief type is determined by
the
Corner Relief option tool in the Modify group on the Sheet Metal tab. The default type is square, but you can change
it to another type. The icon on the Corner Relief option tool changes to reflect the corner relief type. This setting is
saved until you close SpaceClaim.

You can select a corner relief and view its properties in the Sheet Metal section of the Properties panel.

Note: You may need to create a corner relief on a sheet metal part, for example, when you import a shelled
part that doesn't have any reliefs, or when you want to convert a watertight corner to a regular corner. When
you change a sharp edge to another junction type or when you split a wall at a corner, corner reliefs are
automatically added.

To add a corner relief
1. Select an option from the Corner Relief tool in the Modify group on the Sheet Metal tab.
2. Select one or more points where you want a corner relief added.

To change the type of a corner relief
1. Select one or more corner reliefs by clicking any face in the corner relief.
2. Select an option from the Corner Relief tool in the Create group on the Sheet Metal tab:

ApplicationIconCorner relief type

Any cornerDefault

Any cornerFilled

Corners between bends or anglesSmooth

Any cornerSquare

Any cornerCircular

Any cornerPunch

Any cornerTriangular

Any cornerRectangular

Any cornerOblong

Corners between bends of unequal
radius or angles

Diagonal
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ApplicationIconCorner relief type

Any cornerLaser Edge

Any cornerLaser Symmetric

Any cornerNone

3. You can also select a corner relief type from the mini-toolbar or modify the following values in the Sheet Metal
section of the Properties panel:

• Relief Type: Select a corner relief type.

• Reference: Select Corner or Middle based on how you want the corner to be positioned.

• Diameter, Offset, Width, Height: Enter values for the selected relief type.

Note: You may wish to rotate a wall. To achieve a solid rotation and retain correct geometry, before
rotating a sheet metal wall face, you can automatically convert the corner reliefs to a default corner
relief (which is purposely a bit over-sized). When finished with the rotation, the corner reliefs will
automatically restore to their original relief type.

Two-Dimensional (2D) and Three-Dimensional (3D) Corner Reliefs
In the image below, the 3D corner relief is visible in the folded (3D) model, but, since the other three were created
as 2D corners, they show default geometry in the folded model and their actual geometry in the flat (2D) model. 2D
corners show as default corner reliefs in folded models, but show their actual shape in flat models.

• 2DOblongRelief - Created as 2D and shows default geometry in the folded and actual geometry in the flat model.
• 3D Triangular Relief - Created as 3D and shows actual geometry in the folded and flat models.
• 2D Punch Relief - Created as 2D and shows default geometry in the folded and actual geometry in the flat model.
• 2DCircularRelief - Created as 2D and shows default geometry in the folded and actual geometry in the flat model.

Note that each 2D relief is shown as a default relief. In the Unfolded part, each relief shows the actual shape.
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Two-Dimensional (2D) and Three-Dimensional (3D) Corner Relief Options
In SpaceClaim Options > Sheet Metal, you can set all corners to 2D.Corners can be toggled between 2D and 3D
using a check box in the mini-tool bar.

Individual corners can also be changed to 2D by updating their properties in the Options panel. You can change from
3D to 2D and 2D to 3D, as possible with respect to geometry. When selecting 2D-Only, the unfolded model will show
the actual selected corners even when the 3D model can only show the default corners.

Some examples of Corner Relief types
Changing a corner relief type to Laser symmetric.

Selecting theSmoothoption from the Corner Relief tool for unequal radius
bends.
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Selecting the Smooth option for a non-90-degree corner.

The Punch is centered on the intersection of the Bend Lines. The Punch
diameter can be changed in the Properties panel. The images show the
diameter changed from 1 mm to 3 mm.

The following examples show the effect of the Reference corner relief property in an unfolded sheet metal part.

Corner relief type: Circular

Reference: Corner

Corner relief type: Circular

Reference: Middle

Corner relief type: Square

Reference: Corner

Corner relief type: Circular

Reference: Middle

Corner Relief added to a shelled part converted to Sheet Metal

Adding a corner relief to a shelled part that was previously converted to sheet metal. This part will need junctions
and split faces before it can be unfolded.
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To change a corner relief type back to default
1. Select one or more corner reliefs.

You can select a Filled corner by selecting the vertex where the corner relief would be.

2. Select the Default option from the Corner Relief tool.

You can also modify the Relief Type value in the Sheet Metal section of the Properties panel.

To create a smooth corner relief between equal bends
1. Ctrl + click to select equal bends neighboring a corner relief.

2. Select the Smooth option from the Corner Relief tool.

Watertight corners
Watertight corners are sheet metal corners that don't have reliefs so, to make them, you simply remove the reliefs.
Parts with watertight corners can be unfolded and modified just like any other sheet metal part.

Watertight corner on a No-Overlap Junction
1. Select the faces of the corner.

2. Click
Filled in the mini-toolbar, or in the Corner Relief dropdown menu.

The corner is now watertight.

Watertight corner on a Full Overlap Junction
1. Select the faces of the corner, and choose a Filled relief from the mini-toolbar, or the Corner Relief dropdown

menu.
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2. The watertight corner is created.

Partial Overlap Junction:

Watertight corner on a Partial Overlap Junction
1. Select the faces of the corner, and choose a Filled relief from the mini-toolbar, or the Corner Relief dropdown

menu in the Sheet Metal tab.
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2. The watertight corner is created.

To convert a watertight corner to a corner with reliefs
1. Select the edge or point where the bends meet, as shown below.

or
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2. Click the

Corner relief tool in the Modify group on the Sheet Metal tab and choose a Relief type.

The corner now has a relief.

To remove a corner relief

To remove a corner relief
1. Select one or more corner reliefs.

2. The corner relief object is removed. The geometry remains.

10.6.4. Creating and changing notches
Use the

Notch option tool in the Modify ribbon group on the Sheet Metal tab to create a notch in an edge of a sheet metal
wall. The notch type is also determined by this tool. The icon on the Notch tool changes to reflect the type.

Click the Notches option in the Highlight group to highlight all the notches in your sheet metal design.

When you convert a part that includes a notch, and then click the Identify tool and select the Notches tool guide,
notches are clearly identified by the cyan color in the sheet metal part.

To create a notch

1. Select a vertex or thickness edge.

2. Select an option from the Notch tool in the Create ribbon group on the Sheet Metal tab to create the notch.

IconNotch type

Square

Rectangular

45-Degree Bevel

XY Bevel

Radius
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Tomodify a notch
Select one or more notches and do any of the following:

• Select an option from the Notch tool.
• Select a notch type from the mini-toolbar. Use the Reverseoption to flip the sides of Rectangular and XY Bevel

notches.

• Modify theNotchType in the Sheet Metal section in the Properties panel. Depending which Notch Type you select,
you can modify the Width, L1, L2, and Radius values.

To remove a notch

To remove but leave the geometry
1. Select the notch.

2. The notch object is removed. Highlighting Notches no longer highlights the object.

The geometry remains and can now be manipulated.

To remove by filling
1. Select the notch.

2. Click the Fill tool in the Edit section of the Design tab.

10.6.5. Creating and changing hems
The following table shows the available Hem types.

IconOption

Simple

Open

Teardrop

Rolled

None

Hems can be created in two basic ways.

• Applied to a selected edge
• Pulling a selected edge

If you move a wall with a hem, the hem moves with the wall.

Click the Hems option in the Highlight group to highlight all the hems in your sheet metal design.

To create a hem using the Hem tool
1. Select an edge
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You can only create Hems on straight edges that have squared straight thickness edges.•
• You can not create hems on non-thickness edges, such as those created with chamfers.

2. Choose a Hem type from the Hem tool dropdown list

3. The Hem is created

• Simple hems are offset by one wall thickness.

To create a hem using the Pull tool

1. Use the Hem

tool dropdown menu to set the default Hem type

2. Enter the Pull tool

3. Select an edge
4. Choose the inline Pull arrow (not the arrow at 90 degrees from the face)
5. Choose Joggle or Hem from the mini-toolbar
6. Pull back over the face to create the Hem

To create a partial edge Hem

1. Use the Hem

tool dropdown menu to set the default Hem type
2. Enter the Pull tool
3. Select an edge
4. Drag the edge end handles (yellow balls) to size the length of the Hem
5. Choose the inline Pull arrow (not the arrow at 90 degrees from the face)
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6. Choose Joggle or Hem from the mini-toolbar
7. Pull back over the face to create the Hem

To create a Hem onmultiple edges

1. Use the Hem

tool dropdown menu to set the default Hem type
2. Enter the Pull tool
3. Double-click an edge to select an entire edge chain
4. Choose the inline Pull arrow (not the arrow at 90 degrees from the face)
5. Choose Joggle or Hem from the mini-toolbar
6. Pull back over the face to create the Hem

To create a hem using the Move tool
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1. Enter the Move tool

2. Select the inside wall of the bend.

Turn the mouse wheel to select a face that is hidden by another face, if necessary.

3. Rotate the wall back on its neighboring face, as shown below.

A 0.0001 mm gap is created automatically.

Tomodify a hem
1. Select one or more hems.
2. Select an option from the Hem tool.

You can also select a hem type from the mini-toolbar or modify the Hem Type in the Sheet Metal section in the
Properties panel. Depending which hem type you select, you can modify theLength,Height,Gap, andDiameter
values.

With a hem selected, you can also modify the hem's Inner Radius, Bend Steps, Bend Allowance (BA) and Bend
Deduction (BD) parameters in the Sheet Metal section of the Properties panel. When you change a hem's BA, the
BD parameter also automatically updates, depending on the hem's other parameters, such as Inner Radius,
Height, or Angle.

With a hem selected, you can also modify the hem's Inner Radius, Bend Steps, Bend Allowance (BA) and Bend
Deduction (BD) parameters in the Sheet Metal section of the Properties panel. When you change a hem's BA, the
BD parameter also automatically updates, depending on the hem's other parameters, such as Inner Radius,
Height, or Angle.

To remove a hem

To remove a hem object but leave the geometry
1. Select the hem.

2. The hem object is removed. Highlighting Hems no longer highlights the object. The geometry remains and can
now be manipulated.

To remove a hem, you can also select Fill from the Edit group in the Design tab, or right-click and select Delete
from the context menu.
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10.6.6. Sheet metal miter

When you pull two Sheet Metal edges that form a corner, a Miter will be created. Miters are Sheet Metal objects like
Hems Notches, Reliefs, and Junctions.

There are two types of Miters.

• Bisector

• Perpendicular

To create amiter
1. Select two edges that form a corner.
2. Enter the Pull tool.
3. Pull the edges.
4. The miter is created as you pull.

You can also enter the Pull tool and then select the edges.

Tomodify amiter
1. Select a miter.
2. Choose one of the following options from the mini-toolbar.

a. Bisector: If the selected miter is Perpendicular, you can change it to Bisector.
b. Perpendicular: If the selected miter is Bisector, you can change it to Perpendicular.
c. None: Remove the miter
d. Reverse: If the selected miter is Perpendicular, you can reverse the direction.

10.7. Create
This section contains the following topics:

747Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Sheet Metal



10.7.1. Adding Sheet Metal Forms
Use the

Forms tool in the Create group on the Sheet Metal tab to choose from a gallery of standard formed sheet metal
details. Forms can be placed on any sheet metal face and can be placed on the edge of a face.

Select Forms in the Highlight group on the Sheet Metal tab to highlight all forms in your sheet metal design.

Adding a Form to Your Design

1. Click
Forms in the Create group on the Sheet Metal tab.

2. Select a form in the gallery that opens below the tool icon.

3. Change the form parameters in the Options panel.

Hover over the illustration thumbnail in the Options panel to see a larger illustration with each dimension or
value.

These parameters will be saved as properties for the form.

4. Change the Rotation angle in the Options panel, if available.

5. Click a face to place the form.

If you want to dimension the position of the form, click the Place the form using a grid tool guide and select a
face to place a sketch grid. You can then snap to the grid or hold the mouse over an edge and press Shift for
dimensions to lines, points, and intersections

An outline of the form will be shown on the face. You can click again to reposition the form.

6. Click the Complete tool guide to create the form or double-click to place and complete the form in one step.

Adding a Swept Edge Form to Your Design
1. Sketch a profile at an endpoint of the edge.

2. Enter the Pull tool.

3. Click the Sweep tool guide.

4. Click the Full Pull tool guide.
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The vertical line will be swept along the arc to create the form.

Notice that the sweep profile is a single line and an Inside Radius arc is automatically added to the profile, at the
attachment point, to produce a bend. If you draw a tangent arc along with a line, then that arc determines the bend
radius and overrides any inside radius automation that is done in the case of only a straight line.
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Swept Edge Forms can be unfolded.

Adding a Countersink or Special Form

1. Click
Forms in the Forms group on the Sheet Metal tab.

2. Hover over the illustration thumbnail in the Options panel to see a larger illustration with each dimension or
value.

3. Click to select a form from the Countersink or Special gallery.

4. The Options panel updates to display specific parameters for the form type you selected. These parameters will
be saved as properties for the form.

5. Select the face to use as the form shape.

6. Click theComplete tool guide to create the form or double-click to select the face and complete the form in one
step.

Adding a User-defined Punch, Knockout, Extrusion, or Cup Form

1. Click
Forms in the Forms group on the Sheet Metal tab.

2. Select a user-defined form in the punch, knockout, extrusion, or cup sections of the gallery that opens below the
tool icon.

3. If you are adding an extrusion or cup form, you can change the form parameters in the Options panel.

Hover over the illustration thumbnail in the Options panel to see a larger illustration with each dimension or
value.

These parameters will be saved as properties for the form.

4. Select the face to use as the form shape.

5. Click theComplete tool guide to create the form or double-click to select the face and complete the form in one
step.

Adding a Custom Embossed Form to Your Design

1. Click
Forms in the Forms group on the Sheet Metal tab.

2. Click Emboss in the Custom Tools section at the bottom of the gallery.

Click the arrow at the bottom of the gallery to scroll down if you don't see the Custom Tools section.

3. Set the following parameters in the Options panel:

• Distance: The distance that the section of wall will be offset.

• Round radius: All edges that are created are automatically rounded to this radius. Set the option to 0 if you
don't want the edges to be rounded.

• Draft angle: The angle of the inside wall of the embossed area. Set this value to 0 or hold Alt and select the
edges of the sketch area to prevent a draft. The draft is angled inward from the profile you select.

• Shift faces or Offset faces: In the illustration below, the embossed area on the left was done with the Shift
method and the embossed area on the right was done with the Offset method.
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• Remove top face: The top face is removed and the end faces are squared up.

• Chamfer holes: Creates a chamfer on the top edge of inside holes.

4. Select a sketched region to use as the form shape.

Closed sketches inside the region you select will become holes, as shown in the example below. The Chamfer
holes option has been selected in this example:

5. (Optional) Use the Select Edges tool guide and select sides that you want open, like this:

6. Click theComplete tool guide to create the form or double-click to select the face and complete the form in one
step.

Adding a Custom Punch Form to Your Design

1. Click
Forms in the Forms group on the Sheet Metal tab.

2. Click Punch in the Custom Tools section at the bottom of the gallery.

Click the arrow at the bottom of the gallery to scroll down if you don't see the Custom Tools section.

3. Set the following parameters in the Options panel:

• Through: The hole will go all the way through the sheet metal wall.

• Partial: The hole will go only to the depth that you set in the Depth field.

• Depth: How deep the punched hole should go into the sheet metal wall.

• Countersink: The sides of the punched area are drafted at a 45° angle. The draft angle is measures across the
hole and made so that its extents are outside of the sketched area.

• Full: If you selectCountersink, the inside walls of the hole are angled from the top of the hole to the bottom.

• Partial: If you select Countersink, the inside walls of the hole are angled from D1 to D2 in the illustration
below.
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• Diameter: The smaller diameter of a partial countersink (labeled as D2 in the illustration above). Only used
if you select Partial.

4. Click theComplete tool guide to create the form or double-click to select the face and complete the form in one
step.

Removing a Form From Your Design
1. Click the form to select it.

All faces that belong to the form are selected by default. You can scroll your mouse wheel if you need to select
a single face of the form.

2. Click the Fill tool in the Edit section of the Design tab.

Changing Form Properties
1. Click the form to select it.

2. Change the parameters in the Sheet Metal section of the Properties panel.

The parameters in the Properties panel are the same as the parameters in the Options panel when you created
the form. No parameters are shown for forms that can't be rotated or that don't have parameters.

You can also change the Flatten Form property for the component to change how the form is treated when the
sheet metal part is unfolded. See Changing sheet metal part properties.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Place the form tool guide is active by default. This tool guide allows you to place a
form on any sheet metal face.

The Place the form using a grid tool guide allows you to select a face for a sketch plane,
and then you can place the form on the plane using the grid. You may want to use this tool
guide to help accurately position your form. You can use any dimensioning methods normally
available for a sketch grid.

The Select a face tool guide allows you to select the face that will become the form when
you create a user-defined form.

The Complete tool guide creates the form and allows you to place more forms until you
exit the tool.
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Options
Each form has its own options for the form's dimensions. These dimensions are shown in the thumbnail illustration
in the Options panel. Hover over the thumbnail with your mouse to see the full-size image.

Most forms have the following options:

• Rotation angle: Use this option to turn the form on the face where it is placed.
• Create rounds: Use this option to round the edges of the form.

Examples

Creating a user-defined punch form on the edge of a face removes material from the edge.

You can create a pattern of forms, and the forms are recognized by the Convert tool.

10.7.2. Splitting a Sheet Metal Face
Use the

Split tool in the Create group on the Sheet Metal tab to divide sheet metal faces and create partial rips.

You can use the Split tool and the Select Two Cutter Points tool guide and select a corner for either or both points
to make a miter junction, as shown below. Corner reliefs are automatically created where needed.

You can only select a face—not a thickness edge—with this tool. You cannot split a bend face.

When creating multiple splits along a sheet metal part, regardless of whether you use one or two cutter points or
bend direction, the resulting bend spans the length of the sheet metal part across all splits, and, on both sides of
the split(s):

753Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Sheet Metal



The Split face gap option in Sheet Metal options controls the width of a gap when you use the Split tool.

Creating a Partial Split or Rip

1. Click
Split in the Create group on the Sheet Metal tab.

2. Select the Select Two Cutter Points tool guide.

3. Change the selection for the Relief tool, if necessary.

The shape of the end of a partial split is determined by the type of relief selected for the Relief tool. The Relief
tool is set to Square in the example below.

4. Click a point on an edge.

5. You can enter a dimension for the percentage of the distance along the edge or the distance from the end of the
edge.

The yellow ball turns green when the endpoint snaps to a point.

6. Click the point for the end of the split or rip.

Splitting Using an Imprinted Edge or Sketch Curve
Click Split and then select an imprinted edge or sketch curve.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Cutter Point tool guide is active by default. This tool guide splits a face
perpendicular to an edge at the point you select.

TheSelect TwoCutterPoints tool guide allows you to select two points and a split is made
between the points. The snap radius from SpaceClaim Options > Snap is used.

754Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Sheet Metal



10.7.3. Adding a Sheet Metal Bead
Use the

Bead tool in the Create ribbon group on the Sheet Metal tab to create a bead on a face of a sheet metal part.

You can create a bead using a line, spline, arc, tangent curve chain, layout curve, imprinted edge, or other curve on
a face. The curve must be completely on the face and must not self-intersect. The curve can extend from an edge of
the face or it can extend from edge to edge to create a full bead.

A dotted line previews the bead. If the preview extends beyond the edge of the face, or if the curve is too tight, the
bead will not be created. Faces which have beads can be moved with the Move tool.

The bead unfolds in the same way as a form unfolds.

Select Bead in the Highlight group on the Sheet Metal tab to highlight all the beads in your sheet metal design.

To relocate beads on a face, select the Move tool.

Adding a Bead to Your Design
1. Click the

Bead tool in the Create group on the Sheet Metal tab.

The Select Path tool guide enables.

1. Select one or more curves to use to create the bead.

2. (Optional) Modify the Bead radius value in the Options panel.

3. (Optional) Modify the Round radius value in the Options panel.
4. Click the

Create Bead tool guide.

Do it Faster
Select the curve then click the Bead tool.

You can also create a bead using the sheet metal Bend tool.

Options
The radius of the bead, which is also the height of the
bead. The minimum bead radius is 0.25 x T (sheet metal
thickness).

Bead radius

Radius of the round at the base of the bead where it
intersects with the surface.

Round radius
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Examples

Create a bead from a line on a sheet metal face.

Creating a bead using a line that extends across a face.

10.7.4. Bending a Sheet Metal Wall
The Sheet Metal Bend tool works similar to Split, and is used to create bends in a sheet metal flat or unfolded part.
You can bend along a sketch curve on the sheet metal face, bend perpendicular to an edge, or bend between two
points.

You can also place multiple bend lines along a surface. Existing in-progress bends, that are not yet bent (flipped)
remain de-selected as you place one or more new, additional bend lines along the sheet metal surface.

Bending Along a Line
1. Click the

Bend tool in the Create group on the Sheet Metal tab.

The Create Bend option is enabled in the Bend Options panel.

2. (Optional) Modify the following values in the Bend Options panel:

• Bend angle: The angle of the bend.

When selecting on an edge to create a bend angle, modifying the Bend Angle option propagates to the pull
edge handles immediately.

• Bend radius: The inner radius of the bend.

• When a Bend Table is applied to the part, Bend radius is changed to Tool radius and the input becomes a
dropdown list of available radius values from the table.
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• Die width: The width of the die. This changes to a dropdown list of available widths when a Bend Table is
applied to the part.

• Bend Allowance: Value to use for calculating the flat length of the bend.

• Bend Deduction: Value to use for calculating the flat length of the bend.

3. Click a sketch curve on the sheet metal face. The bend will be made across the full length of the face, regardless
of the length of the sketch curve.

4. Click the Complete tool guide to create the bend.

Bending in Multiple Components at Once
1. Follow the same steps you would use for creating a single bend.

2. Select curves in multiple components. The curves can belong to one component but lie on a face of another
component. For example, curve 1 belongs to component 1, but is sketched on the face of component 2.

3. Click the Complete tool guide to create the bend.

Reversing Bend Direction
Click the bend line to cycle through bending up and bending down.
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Removing Bend Segments
Clicking a bend segment until the bend line turns red removes the segment from the bend.

The dashed lines to either side of the bend line show the extents of the bend allowance area, based on the radius
set by default or overridden by the user in the options area.

If necessary, you can click an empty location in the Design window while a tool guide is active to clear the bend line
and activate the Select Cutter Point tool guide.

Cutting Holes in Flattened Conical Bends
1. You have a conical bend where you need to add a hole.

2. Flatten the part and sketch on or across the flattened conical face.

3. Pull the sketch to cut through the part.

4. The cut shows up in the folded part.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Select Cutter Point: Click a point
on an edge to create a bend that
is perpendicular to the edge at the
point. Press Tab to enter a value
for the percentage or distance
from the bend to the endpoint
along the edge.

Select TwoCutterPoints: Click a
point on one edge and a point on
another edge to create a bend
between the points. You can see
a preview of the line as it extends
to the second edge before you
click it. Press Tab to enter a value
for the percentage or distance
from the bend to the endpoint
along the edge.

Select Anchor Point: Select the
face you want to remain fixed
when the body is bent:

SelectCurves: Select curves to be
wrapped around bends.

Adding Bend Steps
1. Select a bend.
2. Modify the Bend Steps value in the Sheet Metal section of the Properties panel.

Adding bend steps creates a bumped bend, which instructs the operator and machine to create a large radius bend
by bumping instead of "rolling" smoothly. The bend is hit with a sharp tool, creating closely spaced sharp bends
that form a large bend.

To display the bend steps and bend dimension properties of the bend in an unfolded sheet metal part, turn on the
visibility in the Bends and Bend Dimensions layers in the Layers panel or in the Style ribbon group on the Display
tab.
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Creating a Joggle

1. Click the

Bend tool in the Create group on the Sheet Metal tab.
2. Select the

Create Joggle option in the Bend Options panel.
3. (Optional) Modify the following values in the Bend Options panel:

• Bend angle: the angle for both bends of the joggle
• Bend radius: the inside radius for both bends of the joggle
• Joggle height: the measurement between the top of the sheet going into the bottom bend and the top of the

sheet coming out of the top bend.
• Bend Allowance: Value to use for calculating the flat length of the joggle.

• Bend Deduction: Value to use for calculating the flat length of the joggle.

4. Use the Select Cutter Point or Select Two Cutter Points tool guide to create the bottom bend of the joggle.
5. Click to select the second bend of the joggle, which is previewed as you mouse over the sheet metal face, as

shown below.

If necessary, you can click an empty space in the Design window to clear your selections and activate the Select
Cutter Point tool guide.

6. Use the Select Anchor Point tool guide to select the face to remain fixed when the rest of the body is bent to
create the joggle.

7. Click the Complete tool guide to create the joggle.

You can move the walls between joggles.

Creating a Joggle from Existing Bends
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1. Select two bends with a face between them.
2. Right-click and select Create Joggle From Bends from the context menu.

The face between the two bends is added to the joggle. The highlighting color changes to indicate the joggle.

Returning a Joggle to Independent Bends
Right-click the joggle and select Explode Joggle from the context menu.

The independent bends remain selected. If you want to return the bends to a joggle, right-click and select Create
Joggle From Bends.

Examples

Joggles created using the Bend tool.

Creating a Bead Using the Bend Tool
1. Click the

Bend tool in the Create group on the Sheet Metal tab.
2. Select the

Create Bead option in the Bend Options panel.
3. (Optional) Modify the following values in the Bend Options panel:

• Bead radius: The radius of the bead, which is also the height of the bead. The minimum bead radius is 0.25xT
(sheet metal thickness).

• Round radius: Radius of the round at the base of the bead that intersects with the surface.

4. Click a curve on the sheet metal face, or select a tool guide and select bend points based on the tool guide you
use.

5. Click the

Bend tool guide to complete the bead.

You can also create a bead using the Bead tool.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Cutter Point tool guide is active by default.
This tool guide creates a bend that is perpendicular to
the edge at the point you select.

The Select Two Cutter Points tool guide allows you to
select a point on one edge and a point on another edge
to create a bend between the points.

The Select Anchor Point tool guide allows you to select
the face that will be fixed when the body is bent.

Click the Complete tool guide to create the bend.

Bend Options
Use the Create Bend option to bend a sheet metal face
along a line.

Use the Create Joggle option to create a joggle bend in
a face.

Use the Create Bead option to create a bead along a
curve on a face.

10.7.4.1. Adding a Cross Break

Cross breaks are a cost effective method for strengthening a thin piece of sheet metal. Typically, this is done in an
X shape, however two lines crossing at most angles will add strength.

Adding a Cross Break to Your Design
1. Enter the Bend tool.
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2. In the Options panel, click

Create Cross Break.

3. Select Cutter Point is the default tool guide. When you mouse over an edge, you see a preview of the bend line
and its location. Click anywhere along the edge to place a bend line perpendicular to the edge across the entire
face.

4. The Select Two Cutter Points tool guide lets you select both bend line endpoints to produce different angles.

5. Click Complete once you have created two crossing bend lines.

6. SpaceClaim shows the cross break as triangular shaded areas on the face.

10.7.5. Adding a Sheet Metal Marker
Use the

Marker tool to create one or more blue ‘cross-hair' placeholder markers on planar sheets or side walls (flat surfaces)
of your sheet metal design.

Creating a Marker
1. Click Marker

in the Create group on the Sheet Metal tab.
2. Select thePlace themarker tool guide to activate the tool. The tool remains active, enabling you to place multiple

markers.

3. Move your cursor over the face where you want to place a marker.

4. Click to place the marker.

Moving a Marker
When moving a marker, the only Move handles that display are those that allow you to move the marker along the
design's grid. Markers move along with the walls on which they are initially placed.

1. Click Move in the Edit group on the Sheet Metal tab.

2. Click the marker that you want to move.

Hold Ctrl and click to select multiple markers. Markers you select with Ctrl will move as a group. You can also
select one marker, then right-click and choose Select All to select all markers. To move a marker, you can also
enter a new location value.
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3. Move the marker to its new position.

Note: Markers that are added to a sheet metal part remain in place if you bend the part. When you unfold
a sheet metal part, markers that appeared on the part will also display on the unfolded part.

10.7.6. Creating a Double Wall
Use the Double wall

tool in the Create group on the Sheet Metal tab to create a folded full or partial double wall in your sheet metal
design, for example, in use with creating pipes, ducts and fittings.

Creating a Double Wall
1. Click Double wall in the Create group on the Sheet Metal tab.

2. Select the Select faces tool guide to activate the tool.
3. Click the face where you want to place the double wall.

4. Click the Select Edges tool guide, and click the edge where you want to place the bend.

5. Click the Complete tool guide to create the double wall.

Examples
You can not only rotate double walls around a bend axis, but you can also click anywhere on the model, such as a
face, and rotate the double wall to change the model's geometry. How the double wall rotates depends on which
face is selected, as shown in the examples below:
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Note: When you move a double wall, the wall and any objects associated with it, such as junctions and
reliefs, also move..

10.7.7. Creating a Sheet Metal Gusset

Creating a Gusset

1. Click
Gusset in the Create group on the Sheet Metal tab.

2. From the Options panel, select a gusset type (Flat or Cylindrical), and then choose Angle, Depth, Width, and
Round radius values for the gusset.

3. Click the bend where you want to place the gusset. A blue outline of the gusset appears to indicate where the
gusset will be located on the bend.

4. Click to set the gusset.
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Moving a Gusset
When moving a gusset, the only Move handle that displays is simply the handle that allows you to move the gussets
along the bend axis on which the gusset is defined.

1. Click Move in the Edit group on the Sheet Metal tab.

2. Select the gusset that you want to move.

3. Move the gusset along the bend axis to relocate the gusset to a new position.

You can also enter a new location value for the gusset.

Note: When you use the Fill tool to fill a gusset, the bend geometry on which the gusset is defined remains
intact.

10.7.8. Creating a Tab

Tab Options
Overlap Full

Overlap 1-sided partial
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Overlap 2-sided partial

Length

Spacing

Clearance

Height

Sharp Edges

Rounds

Chamfers

Creating a Tab
1. In your design, select the junction where you want to place the tab.
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2. Click the Tab tool in the Sheet Metal tab Create group. The Select Edges tool guide activates. The tab highlights
in preview mode (blue) so you can see the tab's values and placement.

3. (Optional): Modify the options in the Options panel

• Length

• Spacing

• Clearance

• Height

• Edge options:

• Sharp Edges

• Rounds

• Chamfers

• Flip: Checkbox to alternate the tabs in the opposite direction along the edge used to create the hem.

4. Click Complete to create the tab.

With a Hem feature selected, the RMB has two Hem menu options.

• Flip: Alternate the tabs in the opposite direction along the edge used to create the hem.
• Reverse: Switches the edge to the other body to create the hem.

Creating a Single Tab
1. In your design, select the junction where you want to place the tab.
2. Click the Tab tool in the Sheet Metal tab Create group.

3. Click the Select Points tool guide.

4. (Optional): Modify the options in the Options panel.

• Clearance1

• Clearance 2

• Height

• Edge options:

• Sharp Edges

• Rounds

• Chamfers

5. Hover over the edge you want for the tab.

6. Click once to locate the first point. Dimensions display to enter an exact location.

7. Click the edge a second time to locate the end of the tab. Dimensions display to enter an exact tab length.

8. Click Complete to create the tab.
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Examples

Tabs created on a sheet metal junction.

Tabs created on a split sheet metal partial edge.

Tabs created at a T junction where one sheet is perpendicular to another.

10.7.9. Creating a Hinge
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Hinge Options
Pin diameter

Pitch

Knuckle length

End play

Paint clearance

Creating a Hinge
1. Create one of the three overlap junctions, or create a split across a flat wall.
2. Select the junction where you want to place the hinge.
3. Click

Hinge in the Sheet Metal tab Create group.

4. The Select Edges tool guide activates and the hinge highlights in preview mode to show the hinge's placement
and size.
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5. (Optional): Modify the Hinge options in the Options panel:

• Pin diameter

• Pitch

• Knuckle length

• End play

• Paint clearance

• Hinge direction can be flipped using the Flip check box.

6. Click Complete to create the hinge.

10.7.10. Creating a Flange
Use the

Flange tool in the Create group on the Sheet Metal tab to create a Complex Flange Form. Flange forms get their
shape from a separate, existing surface.

Creating a Flange
1. Create a surface that has the shape desired for

the Flange.
2. Click the Flange tool.
3. Select edges where the Flange will be created.
4. Click the Select Faces tool guide.
5. Select the Face to define the Flange.
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1. Select the Face to define the Flange.
2. Enter aFlangeRadius,FlangeHeight, orBend

Allowance in the Options panel.
3. Click Complete.

1. Click Complete.
2. Enter a new Flange Height. Notice how it

follows the shape of the selected face.

Options
The Flange tool has following options:

• Flange Radius: Use this option to change the size of the Radius at the base of the Flange.
• Flange Height: Use this option to change the Flange wall height.
• Bend Allowance: Use this option to set the Bend Allowance for the Flange.

10.7.11. Adding Engraved or Cut-out Text in Sheet Metal
A note is text that is engraved or cut out of the sheet metal part when it is fabricated. The special sheet metal note
can only be created, edited, moved, or deleted in the flattened state, but you can see it in the folded state. The text
can cross bends, as shown in the example below.

You can only create lightweight notes, which means they are rendered simply and don't require as many resources
as normal rendering. Their faces cannot be edited directly; you can only change the text by changing the note.

Adding Engraved or Cut-out Text to Your Design
1. Unfold the sheet metal part.
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2. Click
Note in the Annotation group on the Detail tab.

3. Click the face where you want to place the note.

4. Click again to place the note.

5. Type the note text.

6. Right-click the note text and select Convert To Lightweight > Cutout or Engraving.

You can change the note text like a normal annotation note. See Formatting note text.

Converting a Sheet Metal Note to a Regular Annotation Note
Right-click the note text and select Convert To Note.

10.7.12. Creating a Lightweight Pattern
Lightweight patterns allow you to create patterns in sheet metal that contain hundreds of thousands of members.
They are displayed nearly as fast as one member because only the original member's graphics facets are calculated
and then translated into graphics according to the pattern dimensions.

You can't select the graphics-only members. All changes are driven from the pattern leader and all pattern members
move when you move the leader.

When you toggle from a real to a lightweight pattern, the hole that is selected as the pattern leader remains selected.
This allows you to convert a lightweight pattern to a regular pattern, change the center of modification or the leader
position, then convert the pattern back to lightweight for speed purposes.

Lightweight patterns are automatically converted to regular patterns when you export a sheet metal design.

Note: You can only make a lightweight pattern using a pattern of holes.

Making a Lightweight Pattern
1. Follow the instructions in Creating a pattern to create a pattern of holes.
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You can make any type of pattern, including linear, circular, radial, etc.

2. Right-click the pattern leader and select Lightweight Pattern.

Converting a Lightweight Pattern to a Normal Pattern
Right-click the pattern leader and select Toggle Lightweight Pattern.

10.8. Unfolding Sheet Metal Components
You can unfold a sheet metal design and changes appear simultaneously in the unfolded component and in the
original design.

Unfolded parts are not exported with the solid when you export a sheet metal part; however, you can explicitly
export the unfolded part.

You can unfold the following types of walls, but you must right-click a planar face and not a cylinder or a cone:

• Planar walls
• Cylindrical walls, including large diameter cylinders (roll bends)
• Most conical walls, such as a part with variable radius round between arcs that was shelled and converted to a

sheet metal part. Parts that are made with blends between radii also unfold reliably.
• Z bends and S bends, even when they neighbor a cylindrical or conical wall.
• Walls that includes holes that touch a bend or are included in an object that includes a bend.
• Double-walled parts that include a complex unbending edge.

Unfolding a Sheet Metal Component
1. Select a face of a sheet metal component with at least one bend junction.

The selected face sets the orientation of the unfolded design. When you select a single face of a sheet metal part,
the Unfold button enables. You can also right-click and select Unfold Part from the context menu.

2. Click Unfold in the Flat group on the Sheet Metal tab.

Note: Conical bends that are not exactly conical will flatten approximately.

An unfolded version of the component is displayed in a new Design window as a top view with its overall
dimensions, as shown in the figure below. It also appears in the Structure tree as an unfolded part

.
The visibility of the unfolded part in the original design is initially set to Off in the Structure tree. The unfolded
part is saved as part of your design.

Overall dimensions on an unfolded part are measured based on the orientation of the sketch grid. The inside
angle of a bend is used to calculate dimensions. The two flat extent dimensions are automatically displayed.

Bends are listed as objects in the Structure tree for the unfolded part. Bend lines and bend dimensions are placed
on a Bends layer with the visibility off. Turn the visibility on in the Layers panel to view the bend lines.

If a chamfer is recognized as a form, it unfolds based on the Flatten form as value in the Sheet Metal section of
the Properties panel for the design.

If an unfolded component has conflicting geometry, the conflicting geometry is made a separate surface in the
Structure tree and highlighted in red, as shown in the figure below. The edge that prevents the unfold is also
highlighted.
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If you save an unfolded sheet metal part within a component, opening that component in an assembly displays
a check box and icon for the unfolded part in the Structure tree. You can toggle the visibility of the unfolded sheet
metal part in the unfolded part design window.

Unfolding Panel Bends
Panel Bends have a Flat Length property that you can change to set the length of the unfolded bend.

The Panel Bend above has a default Flat Length of 13.59 mm, which results in an unfolded dimension of 41.35 mm.
Setting the Flat Length property to 16.35 mm results in and unfolded length of 44.11 mm as shown below.

Flat Length = 13.59 mm
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Flat Length = 16.35 mm

Folding an Unfolded Sheet Metal Component
Use the Fold Walls tool to fold walls in the unfolded part.

1. Click Fold Walls in the Flat group on the Sheet Metal tab.
2. (Optional) Enter a Bend Percentage in the Options panel if you want to only partially bend back the wall.
3. Click Bends (not the wall) to bend them back

Box-selection is available for selecting Bends to bend back.

Examples

Unfolding a form. Outlines are shown on the unfolded part on the side on which they were placed. Only the topmost
outlines of forms are displayed. Form outlines are on the Bends layer, which is hidden by default.

Unfolding a flange form.

Working Simultaneously on the Folded and Unfolded View of a Design
The unfolded view of a sheet metal part can be placed next to the folded view in order to work simultaneously on
both views. Changes made to the part in one view updates in the other view.
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You can use the Pull tool to make the following changes, and the change will be reflected in the unfolded view:

• Punch holes in planar and cylindrical walls

• Pull walls to change their height or width, or pull to change the dimensions of a hole

• Use the annotation dimensions that are automatically created with an unfolded part to change the height or width
of a wall (see the animated example below)

To place views next to each other, click and drag the tab for a Design window and drop it next to another view.

Examples

Using the Pull tool and annotation dimensions to change the height of a wall on the unfolded part (on top); the
changes are reflected in the folded part (on the bottom).

Using the Pull tool to put a hole in an unfolded cylinder also creates the hole in the folded part.

Creating a View of an Unfolded Part in a Drawing Sheet
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1. Unfold the sheet metal part in the drawing sheet.

Move the mouse to preview the unfolded part.

2. Click the drawing sheet to place a general view at that location.

Adding Bend Dimensions to an Unfolded View
1. Select the view.
2. RMB > Show Bend Dimensions
3. Make sure the Bend Dimensions layer is turned on.

With this option enabled, any changes made to the model will automatically update the drawing sheet bend
dimensions.

To Export an Unfolded Part as .dxf
1. Place the desired dimensions and notes on the unfolded view using the tools in the Detailing tab.
2. Set the Graphics Style in the Display tab to Wireframe.

This step prepares the model for dxf export and shows you what the resulting image will look like.

3. Select Save As from the SpaceClaim menu and specify AutoCAD files (*.dxf) as the export type.

The unfolded model is saved as a 2D dxf file with the included annotations and can be used in manufacturing.

10.8.1. Calculating Unfolded Lengths
SpaceClaim can use sheet metal bend deduction to calculate unfolded lengths. You can set the default Sheet Metal
Options in the SpaceClaim Options window.

You can change the default bend properties for a specific component or bend by selecting the component or bend
and modifying the values in the Properties panel:
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• The Bend Allowance property contains the length of the arc through the bend at the neutral axis of the sheet
metal wall being bent. Adding the Bend Allowance and the lengths of the two sides give the unfolded length.

• The Bend Deduction value for the selected bend represents 2 times the Outside Set Back (OSSB) minus the bend
allowance.

Bend Allowance (BA) and Bend Deduction (BD) are linked. Modifying one value causes the other to be automatically
recalculated as follows.

BD = 2 x OSSB - BA

10.8.2. Calculating Bend Allowances
Bend allowance calculations use what is known as a K-factor. This is the ratio of the location of the neutral line (t
in the image below) to the material thickness (T). When metal is bent, the material at the inside radius is put in a
compressive state while the material at the outside radius is put in tension. The neutral line is the point of zero stress
where the material transitions from compression to tension.

K-factor = t/T

The K-factor is a geometric calculation and does not take into account physical factors for a given bend process
(material type, bend operation type, tools, etc.). Because of this, the only way to know the actual K-factor for a given
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setup is to do a reverse calculation from an actual bend. In other words, bend the metal, measure the result, and
calculate the K-factor.

SpaceClaim determines the correct K-factor curve so you have a more accurate result, without changing the K-factor
or frequently change bend tables. The default bend allowance produces an accurate result for normal bends made
with normal tools and a normal press brake. For basic parts, you should use the default allowances. For special
cases, you can use a bend allowance table.

The curve for the default values used in SpaceClaim is shown below.

The graph shows three segments: red, blue and green.

• The red segment represents bend radii less than the material thickness. Because of the physical limit of the steel
compressibility, it is difficult to obtain bends with a radius less than the thickness in an air bend process.

• The blue segment shows that, as the inner radius increases, the K factor is not constant. It increases up to
approximately 0.5 when the inner radiu is about four times the material thickness. It does not increase beyond
that because the material is no longer stretched. A K-factor greater than 0.5 is not possible.

• The green segment is constant at 0.5, which is the neutral axis for bends with a radius greater than four times
material thickness.

The point where the red and blue segments meet is important. It represents a bend radius equal to the material
thickness. For normal bends, a reverse calculation finds the K-factor to be:

K = (4-PI) / PI = 0.27324

This can be confirmed by press brake manufacturers. It is correct for normal bends because it is based on the actual
physical result.

You can build bend allowance tables for your materials and processes. When your tables are filled (which is a one-time
task), you can unfold with the tables, or use the default value.

With a sheet metal design selected at the top level of the Structure tree, theK-Factor Typeoption displays in the
Sheet Metalgroup of thePropertiespanel. By default, the K-factor type is set to Variable, but you can also set a
constant K-factor.

The Constant K-Factor type option allows you to enter a numerical value for the part. Using this option, you can
map the design to other mainstream CAD functionality, or, adjust the design to a manufacturer's unique standards
or tolerance levels to achieve various unfolding results.

Note: You should only change the K-factor so it corresponds to the working properties of the metal.

10.8.3. Using a Bend Deduction Table
Bend deduction tables are used to calculate flat pattern layouts. The tables are based on the Bend Deduction (BD)
formula, which calculates the flat line length to produce a specific bend angle.

BD = 2 X OSSB - BA

Where:

• BD is Bend Deduction
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• BA is the Bend Allowance that equals the arc length of the bend along theneutral line. Theneutral line is the radius
where the material transitions from compressive stress (inside) to tensile stress (outside)

• OSSB is the Outside Set Back. Depending on the bend angle, SpaceClaim uses two different definitions of OSSB
as explained below.

For bend angles less than 90-degrees, OSSB is measured from the beginning of the bend to the Outside Mold Line,
which is the intersection of the planar faces. See the image below.

OSSB = Tan(A/2) X (BR + T)

Hence

BD = 2 X Tan(A/2) X (BR + T) - BA

Where:

• BR = Bend Radius
• T = Thickness
• A = Angle measured from flat (radians)

For bend angles greater than, or equal to, 90-degrees, the OSSB is measured from the beginning of the bend to a
plane tangent to the outside bend face. This means that the OSSB is the same as the outside radius of the bend. See
the image below.

OSSB = BR + T

Hence

BD = 2 X (BR + T) - BA

Where:

• BR = Inside Bend Radius
• T = Thickness
• A = Angle measured from flat (radians)

Note:

• If a bend table is not assigned to a part, the Bend Allowance is calculated from the default K-factor found
in the Sheet Metal options.

• If a bend table is assigned to a part, the Bend Allowance is obtained from the table and the assigned bend
table file must specify tables for all possible combinations of part thickness and Vee Die width.
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• If some bends in the part use Vee Die and other bends in the part do Not, the assigned bend table file must
specify a table with no Vee Die Width entry.

• If you enter values in the Properties panel for a Bend Allowance or Bend Deduction, it will override the
values obtained from the bend table or computed using K-factor.

• You can set the bend deduction to a negative value to correctly represent the corresponding bend allowance.

A bend table can also be assigned to the part. All values may then be obtained from the bend table instead of being
calculated. Any values not obtained from the bend table may result in an error when you unfold the design. You can
clear the sheet metal bend table assignment from a component by selecting the blank value from the Bend Table
property drop-down.

The table below shows a simple bend table as it would appear in a spreadsheet editor. Keywords are shown in bold.
Angle Values are measured from the flat.

When you unfold a sheet metal design, the thickness, inner bend radius, and angle from the design are used to
determine the value in the selected table.

Once you select a bend table, you can edit the Vee Die Width property in the Properties panel. Vee die width sets
the width of the tooling that produces the bend.

To use a sheet metal bend table to calculate unfolded lengths, you can use an existing file or create a custom file.
To use an existing file, select a sheet metal component and change the bend table property in the properties panel.
To use a custom file, do the following:

1. Copy the Sample.csv file in the installation directory>/Library/Bends folder where installation directory>is
where you installed the software or into a SpaceClaim Support File directory.

2. Paste it into the same directory and give it a new name.
3. Edit the file as described below in the Comma-separated value file section.
4. Select the component and change it's Bend Table property for the new custom file.

Comma-Separated Value File
Bend table files are stored as comma-separated value (CSV) files, which can be edited. The file below shows the
same data as in the previous table, but as it appears when stored in the comma-separated value file.

782Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Sheet Metal



Tables can have two types of data. In the example above, the data type is DataTypeCompensation, which is the
default. The table below is an example where data type is set to DataTypeRadius.

In this table, each combination of Thickness and VeeDieWidth represents a table that provides the actual radius
based on tool radius and angle. In the example above the green cells are the tool radius, blue cells are the angle,
and pink cells are the actual radius applied to the geometry.

The radius table only affects bend creation. Once the bend is created the actual (table lookup) radius is stored in
the bend. You can change the value later or disconnect the table without affecting the bend.

When a radius table is applied, Bend creation changes slightly. In the Sheet Metal Options panel, Die width is a
dropdown list. The Bend radius text box label is changed to Tool radius and the input dynamically changes to a
dropdown list if the following conditions are met.

• One or more edges of a sheet metal part are selected
• The selected edge is in a part that references a bend table file
• The bend table file contains a table that matches the part's thickness and selected vee die width

Keyword Description Parameters for Bend Tables
ParametersDescriptionKeyword

The file format version number is provided.
The current version is 3.00. Versions 1.00 and
2.00 are also supported.

Specifies the file format version.Version,<version-number>
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ParametersDescriptionKeyword

A single string representing the type of data
contained in the tables. Supported values are
file format version dependent.

• Version 1.0

º Bend Allowance
º BendDeduction: Outside setback is

measured from the bend outside mold
line for all bend angles.

• Version 2.0

º Bend Allowance
º BendDeductionOml:Outside setback is

measured from the bend outside mold
line for all bend angles.

º BendDeductionTangent: Outside
setback is bend angle dependent:

Bend angle < 90 degrees: outside setback
is measured from the bend outside mold
line.

Bend angle >= 90 degrees: outside
setback is measured from tangent plane
to bend.

• Version 3.0

º Bend Allowance
º BendDeductionOml:Outside setback is

measured from the bend outside mold
line for all bend angles.

º BendDeductionTangent: Outside
setback is bend angle dependent:

Bend angle < 90 degrees: outside setback
is measured from the bend outside mold
line.

Bend angle >= 90 degrees: outside
setback is measured from tangent plane
to bend.

The type of data contained in the file.Type,<type-name>

Must be in, mm, or cm.The default units are used for numeric values
which do not have units provided explicitly.

Units,<units-type>

A single parameter specifying the thickness
for which the bend deductions in the table
are defined.

Begins a bend table definition.Thickness,<value>

A single parameter specifying the width of
the die tool.

Optional. Specifies an optional tooling
parameter, allowing multiple sets of bend
deduction values for a given thickness.

Must occur after a Thickness keyword.

VeeDieWidth,<value>
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ParametersDescriptionKeyword

Two types are supported in Version 3.0.

• DataTypeCompensation: This is the default
and was the only type for Versions 1.0 and
2.0. Allows for radius values to be manually
entered.

• DataTypeRadius: New in version 3.0. Limits
bend radii and VeeDieWidths to those
contained in the table.

Optional. Specifies whether bend radii will
be specified manually or obtained from a
Bend Table. Inputs in the Bend tool switch to
dropdown lists of values contained in the
table.

DataType,
<datatype-name>

A list of angles, specified in degrees.Defines the columns of the bend deduction
table.

Note the extra empty cell to aid in table
alignment.

The values defined by the table are associated
with the preceding Thickness and
VeeDieWidth keywords.

AngleValues,<value>,…

The first parameter (radius) provides the inner
bend radius for the table row. The following
parameters all provide the deduction values
for each combination of angle and radius.

Defines the body of the bend deduction table.

Individual deduction values may be omitted.

The total number of deduction values
provided cannot exceed the number of values
provided above for the AngleValues keyword.

Radius,<radius>,

<deduction-value>,…

True: K-Factor is used

False: The Bend fails. This is the default.

Controls what happens when an invalid
VeeDieWidth is encountered.

KFactorFallback
<True/False>

10.9. Changing Sheet Metal Part Properties
You can modify the thickness, inner radius, and K-factor of sheet metal components in the Properties panel. Modifying
the component's properties affects all the objects in the component. Modified property values appear in bold. You
can set the default values for sheet metal components by setting sheet metal options. Delete a modified property
value to return it to the default value.

The thickness of sheet metal is maintained with an offset relationship. A sheet metal component retains its properties
when you move it into a non-sheet metal component.

1. Select the sheet metal component in the Structure tree.

2. Change the following in the Properties panel:

• Bend Table: The bend table to use for this sheet metal part.

• Flatten Form: How forms should be represented in the unfolded part. You can choose from the following
values:

• No flatten: The form is shown as-is in the unfolded part.

• Outline: A dotted line is shown for the extents curve and center cross-hair. The outline is added to the Bends
layer on the unfolded part, which is hidden by default. This is the default value.

• Remove: The form is not shown on the unfolded part.
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• Inner Radius: How the inside radius of a bend is calculated. This field shows you what you have set in the two
fields below.

• Radius: The radius of a bend.

• Type: Select Thickness Ratio or Absolute.

Note: When the Bend Radius in Sheet Metal options is set to Thickness ratio and you change the
sheet metal part thickness for the part, the value for the InnerRadiusnow changes in the Properties
panel. In other words, changing the part thickness property will not change all the bend radii, but
the displayed bend radius changes to show that there is a problem for you to fix. You can fix them
by selecting the desired bends and changing their properties manually.

• K-Factor: The K-Factor is used to calculate the bend radius, and is determined by the material, the type of
bend, and the ratio of the bend radius to the thickness of the metal.

• Material:You can set the gage for a material used in a sheet metal part. Assigning a gage enables you to control
the thickness of a sheet metal part at a more granular level. Gage, or, ‘gauge', is the thickness of the metal
organized by numbers: the smaller the number the thinner the metal. A sheet metal design or component of
a design must be assigned a material in order for the gage drop-down to display. You cannot select a gage for
designs or components that are assigned the ‘Unknown Material' option.

To assign a material, from the Structure tree select the design at the top level, or select the component for
which you want to assign a material, and then click the Material Name drop-down from the Material group in
the Properties panel. From the Thickness group in the Properties panel, click the gage drop-down, and select
a gage.

• Sheet Metal: True or false. Determines whether or not the component is a sheet metal part. All sheet metal
properties and parameters are removed from a part when you turn off the Sheet Metal property in the Properties
panel. This includes things like junctions, reliefs, forms, etc.

• Thickness: The thickness of the sheet metal part.

You may need to change the inside radius of bends, change the bend or corner reliefs, or alter the geometry
after you change the thickness.

Exporting Sheet Metal Part Properties
With a Sheet Metal part selected, the RMB now has anExportSheetMetalProperties command. It opens the Export
Sheet Metal Properties dialog for writing a CSV file. The file has columns for the following properties.

• Thickness
• Area of the flattened part
• Perimeter of the flattened part
• Maximum X and Y extents of the flattened part
• Number of holes
• Number of bends

You must first unfold the part to have the flat properties export.
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Example

Changing the thickness of parts caused the S junctions to become no-overlap junctions because the radius was too
small for the new thickness. You would need to change the inside radius to convert the junctions back to S junctions
on these parts.

10.10. Correcting a Sheet Metal Component
SpaceClaim 's sheet metal functionality can be used to fix components that are intended to be made from sheet
metal but which do not conform to the sheet metal standards required for production. There are a number of typical
errors in sheet metal creation that can be easily remedied in SpaceClaim.

1. Fix joints that are not bendable.

Select the edge of an improper joint, click Junction, and select a junction type. Once a proper joint has been
created, it will update with changes to part thickness, bend radius, and K-factor as well as show the joint's bend
allowance on the unfolded design. An example of this change is shown below.

2. Fill in extraneous geometry.

A sheet metal component often has a number of details (such as punches, louvers, and vents) that may not be
relevant to each person involved in the manufacturing process. SpaceClaim allows these details to be quickly
and easily filled in order to simplify parts and retain focus on only the elements necessary for each step of the
manufacturing process.

To fill in geometry, use Select to box select desired features and then Fill to remove them. An example is shown
below.

Identifying ProblemsWhen Unfolding Parts
If an unfolded component has conflicting geometry, the conflicting geometry is made a separate surface in the
Structure tree and highlighted in red, as shown in the figure below. The edge that prevents the unfold is also
highlighted.
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11: Tools

This section contains the following topics:

11.1. Reverse Engineering
This section contains the following topics:

11.1.1. Auto Skin
The Auto Skin tool generates the CAD geometry from faceted models that are relatively smooth and error free. For
example, the starting point of your design may be a clay model which is scanned and output to one of the supported
faceted data types. After importing the faceted data as a Facet Mesh, use the Auto Skin tool to create the CAD
geometry.

Note:

• The faceted model should be smooth and free from defects (for example, the model should be manifold
with no sharp edges, self intersections, etc.). If the model boundary is not smooth, the CAD geometry
creation may fail or result in incorrect geometry.

• Only a single faceted body can be converted at a time.
• The conversion is dependent on the number of facets, inflection points, curves, etc. Performance will be

impacted when skinning models with a large number of facets (above 200,000 triangles).
• The Skin Surface tool can be used to manually create any missing patches.

Creating the CAD Geometry
1. Import or create a facet mesh.
2. Use the tools in the Cleanup group in the Facets tab to ensure the model is smooth and watertight before

skinning.
3. Select the

Auto Skin tool in the Reverse Engineering group of the Tools tab.
4. The Select Faceted Body tool guide is active by default. Select the faceted body.

5. The Select Solid Bodies tool guide is activated when the mesh selected has groups or facet regions. Select the
solid bodies which match the facet regions.

For example, models with topology optimization results from Mechanical contain groups/facet regions. These
models will have the facet regions set on import, but you can add facet regions using the Select Solid Bodies
tool.

6. Click
Complete to convert the model to CAD geometry.
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This example shows the conversion of a faceted model to CAD geometry.

This example shows the conversion of a faceted model with an open body to CAD geometry.

This example shows a model with a facet region.
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Select the faceted mesh and the solid bodies which have faces that match the facet regions as shown in the
example.
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The CAD faces will be trimmed to the facet regions. Triangles on the mesh which do not match a selected CAD
face will be autoskinned.

In the example, the green faces are the faces generated by the autoskin algorithm. The beige/white ones are
copies from the selected CAD faces. These faces are trimmed if the facet region corresponding to a CAD face does
not cover the whole face (as seen in the example).

7. Verify the CAD geometry. In the example, the CAD geometry created has missing patches.

If the geometry has missing patches, use the

Skin Surface tool to create the missing patches.

792Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



If the boundary is not smooth, the CAD geometry creation may fail or result in incorrect geometry.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Faceted Body tool guide is active by default. Select the faceted body to be
converted to CAD.

The Select Solid Bodies tool guide will be activated if the mesh selected has groups or
facet regions.

Select solid bodies which will be used to generate CAD faces which match the facet
regions. The CAD faces will be trimmed to the facet regions.

Converts the faceted model to CAD geometry.

11.1.2. Skin Surface
TheSkinSurface tool helps you reverse-engineer a surface model from faceted data. For example, the starting point
of your design may be a clay model which is scanned and output to one of the supported faceted data types. After
you import the faceted data as a Facet Mesh, use the Skin Surface tool to sketch and create surface patches on the
facets, and stitch them together into a surface body.

Sketching a Surface Patch
1. Import or create a facet mesh
2. Select the

Skin Surface tool in the Reverse Engineering group of the Tools tab
3. Single-click the mesh where you want to start the sketch
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4. Sketch the desired shape as follows:

• Single-click to create internal edge points, which can later be moved to adjust the shape of the edge

• Double-click to end the edge and create a corner

5. Continue creating edges and corners
6. Close the shape by single-clicking on the start point

7. The surface is shown in preview and you can drag any of the sketched points to adjust the shape of the sketch
8. If you need to start over, simply hit the Escape key and the current sketch will be removed

9. Click
Complete to create the surface
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Options
The following options are available in the Skin Surface tool.

The value entered determines the number of Control Points on the Control Curves for
the surface. By default, the number of sample points is fixed and cannot be changed. If
you check the Full Preview option, you can enter a new number of sample points. In Full
Preview mode you can enter a new number of points directly, or use the dropdown slider.

Samples

When you check Full Preview ON, you can control the number of sample points used in
the surface. In Full Preview mode, when you change the number of sample points, the
preview dynamically updates. The speed of the dynamic updates is affected by the
number of sample points. Fewer points leads to faster updates.

Full Preview

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Boundary tool guide is active by default. When this tool guide is active, you
sketch surface patch boundaries on the facets.

TheSelectGeometry tool guide lets you choose planes or existing patch edges to create
boundary loops for surface patches.

Using Box-select
If you want to work with rectangular patches, use box-select instead of sketching them freehand. With the Select
Boundary tool guide active, simply box-select the area where you want the sketch.
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Sketch is made from the box-selectionBox-select facets

Notice that control points are automatically added in areas with curvature. This can be seen more dramatically in
the images below.

Change view to see the curvatureControl points are auto-createdBox-select across a curved area

Editing a Sketch
While in Preview, you can modify the shape of a sketch by dragging the corners and control points. Control Points
are the internal points on edges that allow you to adjust the edge's curvature. You can also add control points to
give you more curvature control on edges.

The images below show a sketch being adjusted to better fit to the contours of the model and show a control point
being added for further adjustments.
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Adding a control pointDragging a control pointDragging a corner

Periodic Surfaces
Surfaces that wrap around cylindrical, and roughly cylindrical, volumes are called Periodic surfaces. They look like
a rectangular patch wrapped around the volume.

Sketching these by hand can be tedious because you need to rotate the model to expose more facets on which to
sketch.

The Select Geometry tool guide streamlines the process by letting you select planes that create sections through
the volume. The sections are then used to automatically generate sketch curves. Selecting two planes some distance
apart automatically, creates the periodic surface.

In the following example, there are multiple periodic surfaces possible. Skin Surface previews one by default. If it is
not the one you want, you simply select the edges of the one you do want.

Two planes intersect the four legs.
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Selecting the first plane displays
sections on all four legs.

Selecting the second plane displays the
other four sections and the default
surface.
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To create a different surface, select the
first section of the surface you want.

Select the second section to display the
surface preview.

Click Complete to create the surface.

Conical Patches:

Periodic surfaces can also be conical. The following example shows how to create a conical surface patch.
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You can either sketch a periodic edge
manually, or use the Select Geometry
tool guide and a plane to create a
periodic edge on the section.

Click the apex of the cone to preview
the surface.

Click Complete to create the surface.

"Stitching" Surfaces
Existing skin surfaces can be 'stitched' into a single surface patch. Examples are shown below.

Use the Select Geometry Tool Guide to Select Rectangular Edges:
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You can bridge the gap between
rectangular patches using the Select
Geometry tool guide. pre-highlight and
select one edge.

Pre-highlight and select the second
edge to preview the surface.

Click Complete to create the surface.

Use the Select Geometry Tool Guide to Select Triangular Edges:

801Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



The same procedure works for
triangular patches. Pre-highlight and
select the first edge.

Pre-highlight and select the second
edge to preview the surface.

Click Complete to create the surface.

Snap to Existing Patch Edges and Points:
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Withe the Select Boundary tool guide active, you
can snap to existing surfaces. Here, the sketch
started by snapping to the bottom corner. The
color and size of the start point indicate that it
is snapped to the lower right corner of the
existing surface.

The sketch then proceeds in a counterclockwise
direction.

The end of the third edge snaps to the existing
edge, which is highlighted to indicate it will be
used.

The fourth edge is auto-completed by the tool
and is shown on top of the snapped edge.

A single click completes the third and fourth
edges and the surface previews.

Click Complete to create the surface.
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The next sketch begins at the upper right corner
of the first surface. Like the previous sketch, the
color and size of the start point indicate that it
is snapped.

The sketch proceeds in a clockwise direction.

When the second edge reaches the upper right
corner of the previous surface, the corner and
edge of that surface highlight to indicate they
will be used.

Two edges can auto-complete to complete the
loop. They are highlighted on top of the existing
edges that will be used.

A single click completes the second, third, and
fourth edges and the surface previews.

Click Complete to create the surface.

11.1.3. Extract Curves
The Extract Curves tool creates curves through design mesh cross sections.
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Curves are created on multiple design mesh sections.

Creating Edges
1. Open the Tools tab.

2. Click Extract Curves in the Reverse Engineering group of the Tools tab.
3. The Select Section Planes tool guide is active by default.
4. Select one or more planes that intersect the mesh.
5. Click Complete to create the curves.

You can also extract curves by placing a section plane in the mesh.

1. Open the Tools tab.

2. Click Extract Curves in the Manufacturing group of the Tools tab.
3. Click the Select Curve tool guide.
4. Select one or more planes that intersect the mesh.
5. Click in the model to place a section plane.
6. The model is displayed in Sketch Mode.
7. Click Complete to extract All curves from the entire section.
8. Or you can select parts of the section and then click Complete.

Curves are created on a section plane placed in the model.
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11.1.4. Orient Facets
The Orient Facets tool

in the Reverse Engineering group of the Tools tab allows you to select roughly planar areas of triangles or cylindrical
areas of triangles to align to the World Origin axes.

Orienting a Faceted Body
1. Open the Tools tab
2. Click Orient Facets in the Reverse Engineering group of the Tools tab.
3. Hover over the triangles to see a preview of the axis it would align to.
4. Select the highlighted triangle.
5. The facet aligns as previewed. The selected triangle is shown in blue. Its normal is aligned to the Z-axis.

6. With each selection, the align-to axis alternates between Z and Y. In the next example, the normal of the selected
triangle (shown in green) aligns to the Y-axis
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As you hover over triangles, cylindrical areas are detected. The following examples show cylindrical areas being
aligned to the Z-axis.
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11.1.5. Fit Spline
The Fit Spline tool

allows you to create a "best fit" spline surface through selected mesh facets.

Fitting a Spline Surface on a Mesh
1. Select mesh facets individually, or use box-selection.
2. Choose Fit Spline from the Reverse Engineering group of the Tools tab.
3. The surface is created (see example above).
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11.1.6. Creating Curves from Images
The Vectorize Image

tool in the Tools tab creates curves around colored areas in images.

Vectorizing an Image
1. Insert an image into your design.
2. Open the Tools tab
3. Click the Vectorize Image in the Reverse Engineering group of the Tools tab.
4. Curves will preview along the boundaries of colored areas.
5. (Optional) Change the tool options.

• Trace Method:

• Border: Curves are created along borders between colors.
• Midline: Curves are created along the mid lines of colored areas. Use this option for line drawings

• Threshold: This is the sum of RGB color values normalized to a value between 0 and 1. It is useful for
non-black-and-white images where area boundaries may not be as well defined as black-and-white images.

• Check which RGB colors to include.

• Smoothness: Controls how curves are fit through the image pixels. Enter a number between 0 and 1. Higher
numbers produce smoother curves.

6. When you are satisfied with the curves, based on preview, click the Complete button to create the curves.
7. If necessary, open the Repair tab and use the Fit Curves tool to further refine the curves.

The images below show the effects of the tool options. The black-and-white image is used to show Smoothness and
a more colorful image is used to show Threshold.

Trace Method = Border

Trace Method = Midline
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Threshold = 0.3

Threshold = 0.5

Threshold = 0.7
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Smoothness = 0.0

Smoothness = 0.2

Smoothness = 0.2
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11.2. Manufacturing
This section contains the following topics:

11.2.1. Standard Hole
The Standard Hole tool creates industry standard drilled and tapped holes. Select one of the available standards
(ISO, UNC, etc.) and then choose from available sizes and specify other hole characteristics (Blind, Tapped,
Countersink, Counterbore, Drill point details).

The current hole profile is displayed in the Preview group. It dynamically updates as you define the hole. There is
also a gallery of common hole profiles to choose from.

Hovering over the Preview shows the hole's definition, as it would appear in a Hole Table.

While choosing a placement location, a preview of the hole opening, including countersink and/or counterbore, is
attached to the cursor. This allows you to view the footprint of the hole as you locate it.

Inserting a Standard Hole
1. The Hole Toolbar opens. Groups in the toolbar contain the options and inputs for hole definition.

2. Set options and enter values to define the hole.

• Choose a Series, Size, and Fit

• The Series you choose determines the available sizes and Fit options

Choose treatments:

• Blind depth
• Tapped thread depth

• When Tapped is checked, diameter displays tap drill size
• When Tapped is checked, Fit is disabled
• May be determined by Series and Size. If so, you can still enter a different value. The value you enter will be

displayed in bold font to indicate it is non-standard

• Default thread depth is twice the basic hole diameter

• Note that only the most common Standard Hole sizes have cosmetic display
• Cosmetic threads appear in the Structure tree and can be toggled on/off

• Cosmetic thread depth
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Cosmetic threads are only available for the UNC series•
• Cosmetic threads show a thread helix without actual thread geometry

Cosmetic Threads are created blind, regardless of whether the option is checked or not.

Thread depth is controlled with the Depth option in the Treatment group. To make threads go through all
of the material, enter a Depth that is greater than the material depth.

• Choose a Style: Countersink, Counterbore, or both

• Countersink Counterbore Both

• Diameter and Angle

• Determine countersink depth

• Some Series specify both dimensions, some specify one, and others specify none

• If they are specified, you can still enter a different value but it will be displayed in bold font to indicate it
is non-standard

• Diameter and Depth

• Some Series specify both dimensions, some specify one, and others specify none
• If they are specified, you can still enter a different value but it will be displayed in bold font to indicate it

is non-standard
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• For Blind holes, you can specify a Drill point

• Enter a Drill point angle
• Choose Drill point depth measurement type

• Depth to Shoulder

• Depth to Tip

Preview shows the hole profile based on current selections and values. Shown below is a Blind, Tapped,
Countersunk, and Counterbored hole with Drill point details.

As you work with different inputs, Preview gives visual feedback. Below are examples of what you would see
when entering values for Diameter, Hole Depth, Countersink Angle, and Drill point Angle.

Preview also has a gallery of profiles to choose from. Click the Preview image to open the gallery.

The gallery is a graphical way to define the hole. Selecting a hole from the gallery automatically fills in the details
in the ribbon.

3. Choose a tool guide for hole placement.

•
Snap to Grid

Select a face on which to display the sketch grid. As you move the cursor, the hole center will snap to the grid
points.

•
Free Placement

Pick anywhere on any face to locate the hole center.

4. Place the hole by clicking in the desired location.
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You can continue to place this type of hole at more locations, or you can change values and options to place
different types of holes.

•

• All holes show in preview until you decide to complete them.
• You can place holes using a plane that is some distance away from the face. This is useful if the hole must be

on a curved face.

5. While the holes are previewed, you can:

• Ctrl+click a hole preview to remove it from the set of holes to be created.
• Press the Escape key to clear all previews without exiting the tool.

6. Complete the hole(s) by clicking

Complete. All previewed holes will be completed. You can also double-click when you place a hole to complete
it.

7. Continue to make more holes or leave the Hole toolbar.

8. Click in the Close group to close the toolbar.

Hole Series
Hole Size and Fit options are determined by which Series you choose.

The examples below show the difference between ISO and UNC. Notice the change in Size nomenclature and Fit
options. ISO has Fit options of Nominal, Close, Medium, and Free.

Fit is disabled in UNC.

• Within each Series, the Size you choose determines the hole diameter
• You can enter a different diameter and it will be shown in Bold to indicate that it is non-standard
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Note: In legacy models, Standard Holes created using the NPS series are not recognized, since NPS has
been replaced with the NPSM series.

Customizing Hole Series
• Series and Size determine the values in the rest of the Hole ribbon inputs.
• All of the information to update the inputs is contained in XML files located in the installation
directory>\Library\Holes directory, where <installation directory> is where you installed the software.

• Each series has a corresponding XML file.

The image below shows the ISO M18 x 2.5 ribbon.

The XML for this ISO hole size is in the ISO.xml file. The relevant XML is shown below.

Notice the correspondence between the XML tags and the ribbon inputs.

All dimensions are in millimeters and angles are in degrees.

The image below shows the result of switching to the UNC Series and the 3/4 - 10 Size.

The XML for this UNC hole size is in the UNC.xml file. The relevant XML is shown below.

• Notice the correspondance between the XML tags and the ribbon inputs.
• All dimensions are in inches and angles are in degrees.

816Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



The image below shows the values in the XML file show up in a Hole Table created in a drawing.

You can edit any of the series XML files to customize the series.

• Note that edited files will be overwritten the next time you upgrade to a newer version of SpaceClaim
• Any changes made to the XML files, do not go into effect until you restart SpaceClaim

You should customize the series by adding files to the directory.

• New files add items to the Series drop-down menu
• Deleting files or moving them out of the directory removes items from the Series drop-down menu

The image below shows a "DCZ" series added.

The DCZ series is based on UNC by copying UNC.xml to DCZ.xml and editing the sizes.

• Note the new TapDrill value reflected in the Diameter input and the new Countersink and Counterbore values.
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Drill Chart
Drill chart is a Series based only on Diameter values. It refers to a set of XML files that contain hole definition tables.
Edit the files to customize the Standard Hole tool.

In the <installation directory>\Library\Holes\Drills directory where installation directory> is where you installed the
software, you will find the following files:

• Fraction.xml
• Letter.xml
• Metric.xml
• Number.xml

File names refer to how the hole name is specified. Below is an example from Letter.xml.

<Name>A</Name>

<Diameter>0.234</Diameter>

<ImperialDisplay>0.234</ImperialDisplay>

<MetricDisplay>5.94</MetricDisplay>

Modify the files according to this format to define custom holes.

Creating a Hole Using a Drill Chart
1. Select Drill chart as the Series.
2. Enter a Diameter.

• Enter a letter, decimal value, fraction (1/64, 3/32, etc.), or number (#1, #2, etc.)
• Units are assumed but can be overridden. For example, if Units are metric, 5.94 is assumed to be 5.94mm.

Override the default by entering 0.234".

3. Diameter as entered is matched to the corresponding hole in the appropriate chart. Hover over the Preview to
see the callout information.

4. Place the hole on a face.
5. Click Complete, or double-click.

Selecting a Hole
SpaceClaim recognizes Standard Holes. Hovering over a hole face will pre-highlight the hole object.

Select individual hole faces using query select.
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Deleting any Standard Hole face, or the face it was created on, breaks the Standard Hole association. Individual
faces are still selectable, but are not recognized as a Standard Hole.

Editing a Hole
1. Select the hole to modify.

You can also Ctrl select, or box-select, several holes that share any of the same parameters.

2. Open the Standard Hole Edit tab. You can also double-click a Standard Hole to open the Edit tab.

The Edit tab is not available for multiple holes that share no parameters.

3. Edit the Hole definition.

4. You can continue to select and Edit more holes.

5. To close the Edit tab:

• Select a non-hole object

• Click white space in the Design window

• Enter selection for another tool

With a Standard Hole selected, you can use the Reverse Hole option in the context menu to flip the hole to the
opposite side of the part.

11.2.2. Identify Holes
Use the Identify Holes tool to identify hole geometry in models imported from other modelers. You can also use it
on models made in SpaceClaim that do not have Standard Hole associations.
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Identifying Holes
1. Click

Identify Holes in the Manufacturing group of the Tools tab.
2. In the Find Options panel, choose the types of holes to find

3. Select a body to look for holes.

Holes matching the Find Options are highlighted in red.

4. Click highlighted holes to create associations. Selected holes change to cyan color.

• Box selection is allowed.

• You can change the Find Options if no holes are found or to find different holes.

• To create associations for all highlighted holes, click the Complete button.

Finding Standard Holes
1. Check the Match standard size option on
2. Choose a Series from the drop-down menu

Any customization to existing series apply

The list of available series reflects any added and removed series

3. Enter a Tolerance

Any Standard Holes in the selected Series that are within the tolerance will be identified.

4. Select a body to find holes

5. Click highlighted holes to create associations. Selected holes change to cyan color.
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• Box selection is allowed.

• You can change the Find Options if no holes are found or to find different holes.

• To create associations for all highlighted holes, click the Complete button.

Example
The block shown below has three holes that match DCZ Standard holes, but they do not have associations.

In a drawing section with a Hole Table they appear as shown below.

Using Identify Holes, associations are added and the Hole Table updates.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use the Select Bodies tool guide to select the body in
which to find holes.

Use the Find tool guide to select holes to create an
association.

The Complete tool guide creates hole associations for
all holes found.

Options
• Match standard size: Choose the hole series and set a tolerance for comparing the hole geometry to standard

hole dimensions. Simple holes within the tolerance of a standard hole in the series will update to match that hole.
See Inserting a standard hole for more detail on standard sizes.

º Series: Choose one of the available Hole Standards from the Series drop-down menu
º Tolerance: Enter a tolerance value. Any Standard Holes in the selected Series that are within the tolerance will

be identified.

• All holes: With Match standard size checked Off, this option will find all holes.
• Through-holes: Only finds through holes.
• Blind holes: Only finds blind holes.
• Countersunk: Finds holes with countersink geometry.
• Counterbore: Finds holes with counterbore geometry.

822Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



11.2.3. Move Body
The Move Body tool

allows you to select vertices, edges, or planar faces to snap to the World Origin.

Snapping means the body is translated to the World Origin such that a point on the selected object coincides with
the origin. The body is not oriented or aligned to the World Origin axes.

Using the Move Body Tool
1. Open the Tools tab
2. Click the Move Body button in the Manufacturing group
3. If the World Origin display is OFF, it will be toggled ON automatically
4. Select the geometry on the body that you want to be coincident with the World Origin
5. The body is translated to the World Origin depending on what is selected

• Vertex - The vertex is made coincident with the World Origin
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• Edge - The endpoint nearest to the World Origin is made coincident with the Origin

• Planar Face - Of all the face's edge vertices, the one nearest to the World Origin is made coincident with the
origin
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6. When you exit the tool, the World Origin display is toggled OFF, if it was OFF when you entered the tool

11.2.4. Create Workpiece
The Create Workpiece tool

creates a component containing a solid Box or Cylinder that encloses a selected body or selected faces.
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Like other components, with a Workpiece you can:

• Create sub-components underneath itusing RMB > New Component
• Activate it for editing

º Rounding edges
º Adding Draft
º Adding protrusions and cuts
º Etc.

• Open it in a separate window
• Replace it with another component using RMB > Source > Replace
• Make it an external component using RMB > Source > Convert to External
• Make an External workpiece Internal using RMB > Source > Use Internal Copy

One cylindrical face SelectedTwo Faces SelectedBody Selected

Creating a Workpiece
1. Open the Tools tab.
2. Click Create Workpiece in the Manufacturing group
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3. Use the Select tool guide to select a body or use the Select Face tool guide to select faces

• You can select more than one body
• The Workpiece will enclose all selected bodies

4. Make your selection
5. The Workpiece previews
6. (Optional) Choose a Workpiece type

• Box (the default)
• Cylinder

7. (Optional) Change the Workpiece dimensions

• Set the Default cushion - Enter a percentage based on the size of the selection. This will be the amount of
clearance around the selection.

• Choose Symmetric dimensions - Applies symmetry to center the selection in the workpiece. When checked
OFF, you can have uneven clearance around the selection.

8. (Optional) Orient the Workpiece

a. Click the Set Orientation tool guide
b. Select an edge to align the nearest face of the box or the axis of the cylinder

9. Click Complete to create the Workpiece

A finished Workpiece

Notes onWorkpiece Orientation
• The default orientation is based on the World Origin
• A Box type has walls parallel to the planes of the world origin
• A Cylinder type has its axis aligned to the Z-axis of the World Origin.
• Selecting a line, edge, or axis to orient a box will rotate the box to align one of the workpiece edges to the selected

object
• Selecting an origin to orient the box will transform the box to align its walls with the new origin
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• You can only select a linear object (line, axis, edge, or origin axis) to orient a cylinder
• Orienting a cylinder means aligning its axis with the selected linear object

Orientation example is shown below. Selecting the slanted edge will orient the side of the workpiec with that edge.

The images below show the effects of the Symmetric dimensions option.

On the left the option isON and on the right it isOFF. When it is on, dimension changes apply to both side of a plane
of symmetry.

When it is off, dimensions can be changed independently on either side of a plane of symmetry.
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For a cylinder, symmetric dimensions apply to the ends of the cylinder.

Once a workpiece is completed, you can incorporate subsequent design changes using RMB > UpdateWorkpiece.

Select workpiece in Structure Tree then RMB > Update Workpiece
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. When active,
selecting any face will select the entire body.

Use theSelectFace tool guide to select faces to surround
with the Workpiece.

The Set Orientation tool guide asks you to select an
edge. A box workpiece will align the nearest side to yhe
edge. A cylinder workpiece will align its axis to the edge.

Create the workpiece

11.2.5. Toolpaths
This section contains the following topics:

11.2.5.1. Turn Profile
The Turn Profile tool creates curves that trace the path of a tool bit during a turning operation. Turning is a machining
operation in which the workpiece rotates while the tool bit moves linearly.

The Turn Profile tool is available for parts that are:

• Cylindrical
• Conical
• Spherical
• Toroidal
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The bodies can have non-cylindrical surfaces, protrusions, depressions, and cutouts.

Curves are generated that represent the path of the machining tool will traverse during a turning operation to
produce the part. For non-cylindrical surfaces, protrusions and depressions, the turning operation needs to leave
material that can be removed with additional machining operations.

Curves are created representing the path of a turning tool.

Creating a Turn Profile
1. Open the Tools tab.
2. Click Turn Profile in the Manufacturing group.
3. (Optional) Check the Includeprotrusionsoption. This creates curves like in the image on the left above. Imagine

the protrusion sweeping around 360° and passing through the protruding curves in the profile.
4. (Optional) Alt-select an origin, if one exists along the part axis.

• This will orient the plane on which the curves will lie, depending on which origin axis aligns to the part axis as
follows.

• Origin X aligned to part - Curves created in origin XY-plane
• Origin Y aligned to part - Curves created in origin YZ-plane
• Origin Z aligned to part - Curves created in origin XZ-plane

5. Select a cylindrical surface to preview the curves.

• Curves are created on a plane passing through the pick point on the surface and the axis of the part.

6. Click Complete to create the curves.

The curves are displayed in the Structure Tree under the Curves folder.

The cylinder with a hex end in the image on the right above, you need to check the Include protrusions option to
offset the curve so that the turning operation leaves enough material for the hex to be machined later. This can be
seen in the image below. The curve that offsets from the face was created with the option checked.
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11.2.5.2. Deburring Toolpath
The Deburring Toolpath tool creates an offset curve profile representing the center of a tool traversing a set of edges.

A burr is a raised edge, or small pieces of material, that remain along the edges of a part after some type of creation
or modification process. Burrs are often undesirable and are removed by a deburring process.

An offset curve profile created with the Deburring Toolpath tool.

The following options let you control the tool path.

• Tool Radius: Enter the radius of the deburring tool in current model units.
• Width: The width of the flat which is left along the edge after the deburring process.

Creating a Deburring Toolpath
1. Open the Tools tab.

2. Click Deburring Toolpath in the Manufacturing group.
3. Enter a Tool Radius and Width in the options panel.
4. Select edges for deburring.
5. Click Complete to create the tool path.
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11.2.5.3. Edges
The Edges tool creates curves on All edges of a selected body.

Curves are created on all edges of a selected body using the Edges tool.

Creating Edges
1. Open the Tools tab.
2. Click Edges in the Manufacturing group.
3. Curves are created on all edges of the body.

11.2.6. Relief
The Relief tool identifies thickness edges at concave corners. Edges found can then have a cylindrical cutout made
to provide relief at the corner.

Multiple pairs of thickness faces in the same body are included.

An example is shown below.

Internal thickness edges at concave corners.

By default, the tool identifies edges that are Interior to the part. The tool Options allow you to look for External edges
as well. An example is shown below.

833Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



External thickness edge at a concave corner.

Edges that Do Not go all the way through the thickness of the part are filtered out of the tool. The example above
shows this with the small pocket on the left side of the part.

The size and position of the reliefs placed on the edges can be controlled with the following options.

• Cut Radius: Controls the size of the relief.
• Clearance: Controls the position of the reliefs by specifying how far the edge of the relief is from the original edge.

An example is shown below with a solid block inserted into the cutout. The corners of the block represent the
locations of the original edges.

Beginning at the upper left corner and moving clockwise through the four corners the settings are:

1. Radius = 1 mm / Clearance = Default
2. Radius = 1 mm / Clearance = 0 mm
3. Radius = 1 mm / Clearance = 1.5 mm
4. Radius = 1 mm / Clearance = 1 mm
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Creating Reliefs
1. Open the Tools tab.
2. Click Relief in the Manufacturing group.
3. If you want to find external edges, make sure that the Include external corners option is checked.
4. All thickness edges in concave corners are found and highlighted.
5. Click the Exclude Problem tool guide and click any edges that you do not want to have relief.
6. In Fix Options, set a Cut Radius and Clearance for the reliefs.
7. Click Complete to create the reliefs.

11.2.7. Unroll

The Unroll

tool works on surface bodies with planar or curved faces.

• Like Unfold in Sheet Metal, Unroll flattens all the surfaces based on a single selected surface.
• The result of Unroll is another surface shown in the Structure Tree as "Unrolled".
• You can have multiple unrolled surfaces in the model

Unrolling a Surface Body
1. Open the Tools tab and select the Unroll tool.
2. Select a planar or curved face.

• The selected face serves as the anchor for the unrolled surface. The orientation of the unroll is determined by
where you click to select the anchor.

3. (Optional) Enable Keep Bend Lines in the Options panel. If enabled, bend lines are imprinted on the Unrolled
surface

body.
4. Click the Complete tool guide.
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5. The surface is unrolled. A body named Unrolled is added to the Structure tree.

Curved surfaces can have curvature in one or two directions.

Flat and Single Curvature Surfaces
Flat surfaces can be unrolled.

Singly curved surfaces (for example, cylinders, cones, etc.) can be unrolled exactly into flat sheets.

Below is an example with two unrolled surfaces built from one singly curved surface.

Surfaces do not need to be tangent to unroll.
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Double Curvature Surfaces
Doubly curved surfaces (for example, spherical, toroidal, etc.) are unrolled approximately into flat sheets.

• Unrolling a doubly curved surface introduces some distortion in angles and/or lengths
• Doubly curved surfaces that have small curvature in one of the directions will unroll

º A sphere would distort too much to flatten (picture a flattened map of the world)
º A big enough torus, and many free-form designs can be flattened without too much distortion

• Angles, perimeter, and area are preserved as closely as possible (within 15%)

º The accuracy increases as the curvature decreases
º The simpler the shape, the more accurate the perimeter and area

This example is a parabola swept along a slightly curved trajectory. Notice that the Area and Perimeter are both
within 0.3% of the original.

OriginalSurfaceProperties

Unrolled Surface
Properties

Area within 0.3%

Perimeter within 0.2%

This example is a parabola swept along a highly curved trajectory. Notice that the Area and Perimeter are also both
within 0.3% of the original. This is because the shape is a simple parabola.

837Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



OriginalSurfaceProperties

Unrolled Surface
Properties

Area within 0.3%

Perimeter within 0.2%

This example Is a more organic shape. Notice that the Area is within 0.4% and the Perimeter is within 6.5%.

OriginalSurfaceProperties

Unrolled Surface
Properties

Area within 0.3%

Perimeter within 0.2%

This example is a more complex perimeter. Notice that the Area is within 0.8% and the Perimeter is within 6.0%.

OriginalSurfaceProperties

Unrolled Surface
Properties

Area within 0.3%

Perimeter within 0.2%
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When Surfaces Fail to Unroll
If the Unroll tool fails, an Error message indicates that the faces cannot be unrolled.

Recall that Unroll works on planar, conical, and cylindrical faces.

839Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Tools



12: Repairing Problems

SpaceClaim can import a variety of native and neutral CAD formats, but you may need to clean up and repair this data for
use in SpaceClaim and for CAE. The Repair tab includes tools you can use to repair imported models and prepare your
designs for export and analysis.

The Repair tools are presented in the following groups:

• Solidify
• Fix
• Fix Curves
• Adjust

In general, when you need to repair geometry imported from another source, you use the tools in the order they are
presented in the ribbon (left to right).

12.1. Navigating Through Issues
The Navigate ribbon group allows you to quickly jump through all the problems identified by a tool on this tab.

Navigating Identified Issues
Click the Next or Back buttons to view each problem.

Click Select to convert the problem area into a selection and exit the tool for manual fixing.

Select Zoom to Fit to zoom in on each problem when you click next or back.

Select Clip Volume to put a Clip Volume spheres around the problem areas. You can then use the Next and Back
buttons to make them current.

Problem areas are found.
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Clip Volume places clipping spheres around the problem areas.

Zoom to fit the current problem.

12.2. Solidify
Tools in the Solidify group fix problems that may exist in imported data, which prevent the model from being solid.

Use the Stitch tool to combine surface part faces that are
touching at their edges.

Use the Gaps tool to repair gaps between faces.

Use the Missing Faces tool to fill missing faces.

12.2.1. Stitching Adjacent Faces
The Stitch tool combines surface part faces that are touching at their edges. When the merged faces form a closed
surface, a solid is automatically created. You can use this tool to repair multiple surface parts that are in separate
components. Coincident faces are detected and removed before Stitch merges surfaces into a single body.
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Stitching Faces Together
1. (Optional) Select one or more surface parts or a components.

Selecting objects before starting the tool will limit the tool's results to those objects.

If you select a component, all surface parts in the component that have touching faces will be merged.

2. Click
Stitch in the Solidify group on the Repair tab.

The edges of faces that can be merged are highlighted.

3. (Optional) Change the Maximumdistance slider in the Options panel to adjust the distance between parts that
are automatically detected.

4. Select the Check for coincidence checkbox to find any edges or planes that are coincidental to each other.

5. Click the highlighted faces that you want to merge.

The faces are merged when you click on them.

6. (Optional) Click the Select Geometry tool guide to select faces that were not automatically detected.

7. Click Complete to merge all highlighted faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
faces that were not automatically found. Hold Ctrl to
select multiple objects or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide merges the highlighted faces.

Options
The following options are available:

The maximum distance between faces that is
automatically detected by the tool. The maximum
distance value can be adjusted using a slider in the
Options panel.

Maximum distance

Set this option to check for coincidence within the model.Check for coincidence

When you call a stitch, stitching will isolate each
component and attempt to sew surface bodies within
that component. It will not stitch surface bodies across
components. This option is on by default.

Maintain components
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12.2.2. Repairing Gaps
The Gaps tool removes gaps between faces. These gaps are usually found on parts imported from other CAD systems
when the native format allows faces to fit together loosely.

This tool only works for edges that are paired. Paired edges are edges that are within the maximum distance along
their length or that share an end point and are within the maximum angle you set in the tool's options. Use the
Missing Faces tool if you need to repair a part with edges that are not paired. When a gap is adjacent to a larger hole,
this tool only repairs the gap and not the hole.

Removing Gaps

1. Click
Gaps in the Solidify group on the Repair tab.

The tool will automatically detect and highlight gaps in an object, as shown in the image above.

2. Select the object(s) you want to change:

• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edges that were not automatically detected.

3. Set the following options:

• MaximumAngle: The maximum angle between any neighboring edge pairs in the potential missing face edge
loop.

• MaximumDistance: The maximum distance between any pair of edges in the potential missing face edge
loop.

4. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

5. Click the Complete tool guide.

SpaceClaim adjusts neighboring faces to remove the highlighted gaps.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.
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The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
edges that were not automatically found. Hold Ctrl to
select multiple edges or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide fills faces between all
highlighted edges.

Options
The following options are available in the Options panel:

The maximum angle between any neighboring edge pairs
in the potential missing face edge loop.

Maximum angle

The maximum distance between any pair of edges in the
potential missing face edge loop.

Maximum distance

12.2.3. Finding and Correcting Missing Faces
The Missing Faces tool automatically detects and fills missing faces on an object. This tool should be used to find
missing faces on imported designs.

Use the Fill tool to fill faces when you know where the edges of the new face should be. Use the Missing Faces tool
to identify missing faces and fill them automatically or choose which missing faces you want created.

As a precaution, if your design includes any open edge loops, first be certain that the loop(s) are not simply imported
parts that may have been designed as a surface body with open regions.

Finding Missing Faces

1. Click
Missing Faces in the Solidify group on the Repair tab.

The tool will automatically detect and highlight missing faces, as shown in the image above.

2. Select the object(s) you want to change:
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• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edge loops that were not automatically detected.

3. Set the following options:

• Minimum Angle: The minimum angle between all neighboring edge pairs in the potential missing face edge
loop.

• MinimumDistance: The minimum distance between all of edges in the potential missing face edge loop.

Note: The tool looks for missing faces that meet both of the minimum measurements.

• Fill: Fix the missing face by extending neighboring faces until they intersect.

• Patch: Fix the missing face by creating a new face through the bounding edges of neighboring faces. To repair
edge loops, select Patch and insert a new blended face. This new face will include each relevant tangent
neighboring face, enabling you to close any selected edge loops with the smoothest possible inside surface,
thereby creating a more realistic design..

• Try both: Fix the missing face by extending neighboring faces. If that does not work, SpaceClaim will attempt
to fill by creating a patch.

• Allowmultiple faces: Fix a hole in the surface with two or more missing faces.

4. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

5. Click the Complete tool guide.

SpaceClaim creates a new face using the method you selected in the Options panel.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
edges between faces that were not automatically found.
Hold Ctrl to select multiple edges or box select in the
design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

TheComplete tool guide creates new faces in areas that
are highlighted.
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Options
The following options are available in the Options panel:

The minimum angle between all neighboring edge pairs
in the potential missing face edge loop.

Minimum angle

The minimum distance between all of edges in the
potential missing face edge loop.

Minimum distance

Fix the missing face by extending neighboring faces until
they intersect.

Fill

Fix the missing face by creating a new face through the
bounding edges of neighboring faces.

Faces with a high level of detail on a boundary may have
one or more short edges. To make a smooth patch on a
boundary, short edges are automatically removed when
patching.

Patch

Fix the missing face by extending neighboring faces. If
that does not work, SpaceClaim will attempt to fill by
creating a patch.

Try both

Fix a hole in the surface with two or more missing faces.Allowmultiple faces

12.3. Fix
Tools in the Fix group fix problems that may exist in imported data, which can exist in a solid model but cause
problems when you edit or modify the geometry.

Use the Split Edges tool to remove extraneous points on
edges.

Use the Duplicates tool to detect and fix duplicate faces.

Use the Extra Edges tool to detect and remove edges that
are not needed to define the model.

Use the Bad Faces tool to detect faces that have corrupt
rendering.

12.3.1. Repairing Split Edges
The Split Edges tool detects and merges coincident edges that do not mark the boundaries of new faces.
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Consolidating Split Edges
1. Click

Split Edges in the Fix group on the Repair tab.

The tool will automatically detect and highlight split edges, as shown in the image above.

2. Select the object(s) you want to change:

• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edges that were not automatically detected.

3. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

4. Click the Complete tool guide.

SpaceClaim consolidates the highlighted areas.

Options
Set the Maximum Length to search the model for split edges that are no longer than the
specified length.

Maximum Length

Use the Minimum Angle option to detect open edges on surfaces that are close to tangent.
An open edge is defined as an edge on the outside boundary of a surface and not connected
to another surface. This option must be enabled for the tool to find the edges.

Minimum Angle

The image below shows an example of using the Minimum Angle option to find open edges that are close to tangent.
After fixing the edges found, they are made tangent, resulting in continuous tangent edges.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
points that were not automatically found. Hold Ctrl to
select multiple points or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide consolidates all highlighted
areas.

12.3.2. Repairing Extra Edges
The Extra Edges

tool works like Merge Faces but operates on edges. Instead of merging two faces by selecting the faces, you select
the edges between faces to remove the extra edge and merge the faces.
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You should only merge faces that are tangent or close to tangent; otherwise, the results may not be what you expect.

Note: The Extra Edges tool is only intended to be used as preparation for analysis. Merging faces simplifies
the model by removing edges and makes the model more difficult to modify.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
faces that were not automatically found. Hold Ctrl to
select multiple objects or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide merges the highlighted faces.

Removing Edges
1. Open a model which needs edges removed.

2. Click the Extra Edges tool in the Fix group of the Repair tab.

3. Edges which can be removed are highlighted.

4. Click the Complete tool guide to remove all edges at once.

5. You can also select areas to be excluded from fixing.

SpaceClaim removes the edges and merges the faces.
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12.3.3. Repairing Duplicates
The Duplicates tool detects and fixes duplicate faces on surfaces. SpaceClaim highlights the duplicates and will
remove them all, or you can select duplicates to exclude from being fixed. You can optionally choose to detect and
fix duplicate faces from solids as well.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
faces that were not automatically found. Hold Ctrl to
select multiple objects or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

TheComplete tool guide removes the highlighted faces.

Finding and Fixing Duplicate Faces
1. Open a model which needs faces removed.

2. Select the Duplicates tool in the Fix group of the Repair tab.

The tool highlights the Duplicate faces to be removed.

3. (Optional) Select Allow face removal from solids, if required.

4. Click the Complete tool guide to remove all duplicates at once.

5. You can also select areas to be excluded from fixing using the Exclude Problem tool guide and then click
Complete.

SpaceClaim removes the duplicate faces.

Options
Enables you to detect and fix duplicate faces from solids.Allow face removal

from solids

12.4. Fix Curves
Tools in the Fix Curves group fix problems that may exist in imported data, which cause problems when working
with curves.

Use the Curve Gaps tool to detect and fix gaps between
curves.

850Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Repairing Problems



Use the Small Curves tool to detect and remove small
curves and fix the resulting gaps.

Use the Duplicate Curves tool to detect and remove
duplicate curves.

Use the Fit Curves tool to improve selected curves by
replacing them with lines, arcs, or splines.

12.4.1. Fitting Curves

The Fit Curves

tool attempts to create fewer and better curves to replace selected curves which may not be continuous or tangent.
You can also replace a curve with simple line segments as in the example above.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Geometry tool guide allows you to select
geometry that were not automatically found. Hold Ctrl
to select multiple objects or box select in the design area.

The Complete tool fixes the curves.

Fixing and Replacing Small Curves
1. Click the Fit Curves tool in the Fix Curves group of the Repair tab .

2. Select or box-select the curves you want to fix.

3. Set the Maximum distance option to determine the curves that will be found and how closely new curves will
follow old curves.

4. Choose Fix Options to set the types of replacement curves to use.
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• Lines

• Arcs

• Splines

• Correct tangency: Check this option to make arcs tangent that are otherwise slightly non-tangent.

5. Small curves are highlighted and new curve start and end points are indicated.

6. Click problem areas to fix them or click the Complete tool guide.

The images below show the effect of the Check tangency option.

Without the Check tangency option checked, only one tangency is found.

With the Check tangency option checked, a slightly non-tangent arc is made tangent.

12.4.2. Fixing Curve Gaps
The Curve Gaps tool finds any gaps between curves and closes them. It can extend and/or move lines to close the
gaps.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
geometry that were not automatically found. Hold Ctrl
to select multiple objects or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool repairs the gaps.

Fixing Curve Gaps
1. Click the Curve Gaps tool in the Fix Curves group of the Repair tab.

2. Set the Maximum distance option or keep the default value

3. Gaps within the maximum distance tolerance are highlighted.

4. Click problem areas to fix them or click the Complete tool guide.

12.4.3. Duplicating Curves
The Duplicate Curves tool finds any overlapping curves and deletes any extra curves.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
geometry that were not automatically found. Hold Ctrl
to select multiple objects or box select in the design area.
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The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool removes the duplicate curves.

Fixing Duplicate Curves
1. Click the Duplicate Curves tool in the Fix Curves group of the Repair tab.

2. Duplicate curves are highlighted.

3. Click problem areas to fix them or click the Complete tool guide.

12.4.4. Fixing Small Curves
The Small Curves tool finds any curves smaller than a specified length.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
geometry that were not automatically found. Hold Ctrl
to select multiple objects or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

TheComplete tool removes the small curves and repairs
the gaps they leave.

Finding Small Curves
1. Click the Small Curves tool in the Fix Curves group of the Repair tab.

2. Set the Maximum length option or keep the default value.

3. Curves within the maximum length tolerance are highlighted.

4. Click the problem areas to fix them or click the Complete tool guide.
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12.5. Adjust
Tools in the Adjust group help you modify characteristics of your design that will affect analysis.

Use the Merge Faces tool to combine two or more faces
into a single face.

Use the Small Faces tool to remove small faces from your
design.

Use the Tangency tool to change nearly tangent faces so
they are tangent.

Use the Simplify tool to simplify complex faces and
curves.

Use the Inexact Edges tool to repair edges that do not fit
together precisely.

Use the Relax tool to reduce the number of control points
in imported surfaces to make them more stable.

Use the Straighten tool to straighten faces that are at
unwanted angles.

12.5.1. Merging Faces
The Merge Faces tool replaces two or more neighboring faces with a single new face that closely fits the original
faces. Use this tool to simplify a model before you export it for analysis. Merging faces can result in a smoother mesh
on the solid.

You should only merge faces that are tangent or close to tangent, otherwise, the results may not be what you expect.

You cannot select edges when using the Merge Faces tool. You should use the Fill tool on the Design tab when you
need to select an edge and a face to fill in a missing face. The Missing Faces and Gaps tools on the Prepare tab also
perform this function.

Note: The merge faces tool is only intended to be used as preparation for analysis. Merging faces simplifies
the model by removing edges and makes the model more difficult to modify.
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Merging Neighboring Faces

1. Click
Merge Faces in the Adjust group of the Repair tab.

2. Select two or more faces you want to merge.

3. If you want to retain tangency between the new face and an existing face, use theMaintain Tangency tool guide
and select the face with which you want to retain tangency.

4. Click the Complete tool guide.

SpaceClaim replaces the selected faces with a new face.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. You can also select by drawing a box in the design window.

The Maintain Tangency tool guide allows you to select faces with which you want to retain tangency.
The new face will be tangent to the face(s) you select. You can also use Alt+click to select faces for tangency.

The Complete tool guide replaces the selected faces with a single face.

12.5.2. Removing Small Faces
The Small Faces tool detects and removes small and sliver faces in your design. You may want to remove these faces
before you export the design for analysis if they will have a negligible impact on the analysis accuracy but a significant
impact on its speed.

If the small face is tangent to a neighboring face, the tool will merge the small face with the neighboring face. If no
neighboring face is tangent, the tool will extend neighboring faces to remove the small face.

Removing Small and Sliver Faces

1. Click
Small Faces in the Adjust group of the Repair tab.
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The tool automatically finds small faces in the active component and highlights them in the design area, as
shown in the image above.

2. Select the object(s) you want to change:

• Use the Select Problem tool guide to select highlighted areas that you want to adjust. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select faces that were not automatically detected.

3. Set the Maximum area and Maximumwidth in the Options panel. Faces that are smaller than the maximum
area and thinner than the maximum width will be found and highlighted for adjustment.

4. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

5. Click the Complete tool guide.

SpaceClaim will remove the Selected faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. You must select objects that you want to adjust in the
Structure tree while this tool is active.

The Select Geometry tool guide allows you to select small and sliver faces that were not automatically
detected. The face will only be removed if it is smaller than the maximum area and/or width in the Options
panel.

The Exclude Problem tool guide allows you to exclude areas from selection and fixing.

The Complete tool guide removes all the faces that are highlighted.

Options
The following options are available in the Options panel:

Faces that are smaller than the maximum or area will be
found and highlighted for adjustment.

Maximum area

Faces that are thinner than the maximum width will be
found and highlighted for adjustment.

Maximumwidth

12.5.3. Simplifying Designs
This tool examines a design and simplifies complex faces and curves into planes, cones, cylinders, lines, arcs, etc.
This automates the one-by-one Simplify capability found in the Replace tool.
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Simplifying a Design
1. (Optional) Select the faces you want to simplify.

You may want to pre-select faces on large designs because it can be easier to simplify a region at a time.

2. Click Simplify in the Adjust group of the Repair tab.

3. (Optional) Click the Select Geometry tool guide to select faces to simplify that aren't automatically detected.

4. Click the Select Problem tool guide and select a highlighted face to simplify the face or click the Complete tool
guide to simplify all highlighted faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
faces and curves that were not automatically found. Hold
Ctrl to select multiple objects or box select in the design
area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide replaces all the highlighted
objects with simplified faces and curves.

12.5.4. Repairing Inexact Edges
The Inexact Edges tool finds and repairs edges that have been inaccurately defined and do not meet precisely. These
types of edges are usually found in designs imported from other CAD systems, particularly from conceptual design
systems.
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Fixing Inexact Edges

1. Click
Inexact Edges in the Fix group of the Repair tab.

The tool will automatically detect and highlight gaps in an object, as shown in the image above.

2. Select the object(s) you want to change:

• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edges that were not automatically detected.

3. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

4. Click the Complete tool guide.

SpaceClaim redefines the edges so they meet precisely.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
edges that were not automatically found. Hold Ctrl to
select multiple edges or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

TheComplete tool guide recalculates all the highlighted
edges to increase the precision between faces or surfaces.
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12.5.5. Straightening Faces
The Straighten tool is used to look for holes and planar faces that are inclined at angles less than a specified value.

The examples below show how the tool straightens the faces.

The hole is adjusted equally relative to the center. So, the top edge shifts to the Left and the bottom edge shifts to
the Right.

The face is adjusted about its center. So, the left end adjusts Upward and the right end adjusts Downward.

Straightening Holes and Faces

1. Click
Straighten in the Adjust group of the Repair tab.

2. (Optional) Click theSelectGeometry tool guide to select surfaces to straighten that aren't automatically detected.

3. Click the Select Problem tool guide and select a highlighted hole or planar face to straighten it or click the
Complete tool guide to straighten all highlighted holes and planar faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
faces and curves that were not automatically found. Hold
Ctrl to select multiple objects or box select in the design
area.
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The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide replaces all the highlighted
surfaces with new surfaces based on the Fix Options.

TheSelectPlaneOrOrigin tool guide allows you to select
an origin, origin axis, line, or plane to use for the
measurement direction.

Find Options
Maximum angle: Find faces inclined at less than the specified angle.

Fix Options
Snap faces to nearest: Angularly misaligned faces will be adjusted to the snap tolerance, making it easier to put
model dimensions to round numbers. The images below show an example.

Precision is set to 3 decimal places with the trailing zeroes option turned on.

Snap faces to nearest is checked On.

The top face will be straightened by rotating the right edge down and the left edge up.

Snap faces to nearest = 0.001mm

Snap faces to nearest = 0.010mm

Snap faces to nearest = 0.100mm
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12.5.6. Relaxing Surfaces
The Relax tool is used to look for surfaces that may have too many control points and to reduce the number of points.
Reducing the number of control points 'relaxes' the surfaces and makes them more stable.

Relaxing a Surface

1. Click
Relax in the Adjust group of the Repair tab.

2. (Optional) Click the Select Geometry tool guide to select surfaces to relax that aren't automatically detected.

3. Click the Select Problem tool guide and select a highlighted surface to relax or click the Complete tool guide
to relax all highlighted surfaces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
faces and curves that were not automatically found. Hold
Ctrl to select multiple objects or box select in the design
area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide replaces all the highlighted
surfaces with new surfaces based on the Fix Options.

Find Options
• Maximumdistance: Find faces whose control points are less than the specified distance apart in either direction.
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• Minimum points: Find faces with more than the specified number of control points in either direction.

Fix Options
Density of points: Point density to apply when relaxing the surface.

12.5.7. Adjusting Tangency
The Tangency tool detects edges between faces that are close to tangent and adjusts the faces so they are tangent.

If a faces is near tangent with more than one neighboring face, you will get the best results if you make all the edges
tangent at the same time.

Adjusting Tangency Between Faces

1. Click
Tangency in the Adjust group of the Repair tab.

The tool automatically finds near-tangent faces in the active component and highlight their edges in the design
area, as shown in the image above.

2. Select the object(s) you want to change:

• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edges between faces that were not automatically detected.

3. Set the Maximum angle in the Options panel.

The tool will automatically detect near-tangent faces again when you change this value. For best results, keep
this angle as small as possible.

4. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

5. Click the Complete tool guide.

SpaceClaim adjusts the highlighted edges so their adjacent faces are tangent.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This tool guide allows you to select problem areas
that are automatically found by the tool.

The Select Geometry tool guide allows you to select edges between faces that were not automatically
found. Hold Ctrl to select multiple edges or box select in the design area. When you hover over an edge,
you can see the two faces that would be affected by the change.

The Exclude Problem tool guide allows you to exclude areas from selection and fixing.

The Complete tool guide makes all highlighted edges tangent.

Options
The following options are available in the Options panel:

The maximum angle to detect for tangency. For best
results, keep this angle as small as possible.

Maximum angle



13: Preparing Designs for Analysis

SpaceClaim can import a variety of native and neutral CAD formats, but you may need to prepare this data for export and
for CAE. The Prepare tab includes tools you can use to prepare your designs for export and analysis.

The Prepare tools are presented in the following groups:

• Analysis

• Remove

• Detect

• Beams

13.1. Analysis
Use the tools in the Analysis group to create or subdivide bodies for analysis.

Use the Volume Extract tool to create a solid based on
an enclosed region within a part.

Use the Midsurface tool to create a surface midway
between two offset faces.

Use the Enclosure tool to detect coincident faces, edges,
or vertices and imprint them to allow for mesh
connections.

Use the Spot Weld tool to define points on two faces that
represent weld points.

Use the Weld tool to define edges where the welds will
be created.

Use the Wrap tool to wrap geometry around a target
model.

Use the Split by Plane tool to split a part based on a plane.

Use the Imprint tool to imprint coincident faces.

Use the Extend tool to extend surface edges or curves up
to intersecting bodies.

13.1.1. Extracting Volume
Use the

Volume Extract tool in the Analysis group on the Prepare tab to create a solid that represents the internals of a
part or assembly (including meshes). A solid named Volume is created in the Structure tree, and the bodies used to
generate the volume are temporarily transparent when the volume is created.
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Note: If an edge will be removed when you use the Volume Extract tool, that edge will flash red and you
will receive a warning message. This can happen when you select a capping edge that will be removed when
it is merged with the rest of the model. The highlight identifies the problem so you can pick a different edge.

Creating a Volume Body
1. Click the

Volume Extract tool in the Analysis group of the Prepare tab.

2. Click the Select Faces tool guide to select the faces that enclose the volume of the area. Alternatively, click the
Select Edges tool guide to select the edge loops that enclose the volume of the area.

Only select faces or edge loops that you intended to use to enclose the volume area. You can double-click to
select more than one contiguous edge. You can also click a selected face or edge to deselect it. If you hover over
a face that contains internal edge loops, the edge loops are highlighted. Click the face to select the highlighted
edge loops.

For Faceted bodies, use Shift+Double-Click on a facet edge to select a faceted loop.

3. Click the Select Seed Face tool guide and select a face inside the volume area. The Select Seed Face tool guide
is used to select a face to determine the inside of the enclosed volume. You only need to use this tool guide if
the Volume Extract tool fails to correctly identify the inside of the volume.

4. If necessary, click the Select Cap Faces tool guide to cap a face.

5. (Optional): SelectPreview inside faces to activate the Preview slider. Your model immediately updates to paint
a preview of the inner faces shown in red at 100%. Click the Play button to preview the faces in an animation, or
use the slider to manually preview the faces. Move the slider to the left and right to see a progression of how the
faces were captured.

When previewing the faces, all Select tools and context menu Select tools, as well as all Volume Extract tool
guides, are disabled until the Preview check box is turned off.

6. Click the Complete tool guide.

SpaceClaim creates a solid part based on the volume you defined.

Updating the Volume Body
Right-click the volume part (namedVolumeby default) in the Structure tree. Select one of the following commands:

• Update Volume Body as Created updates the volume body based on objects that were visible when the volume
was created (regardless of their current visibility). Use this option for simple regeneration.

• Update Volume Body in Context updates the volume body based on objects that are currently visible in the
design area. Use this option to remove bodies from the volume calculation.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.
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The Select Faces tool guide activates by default when you select the Volume Extract tool, and selects
faces whose edges seal an enclosed region. This is a shortcut to selecting all the edges that are detected
in a face. You canCtrl+ Selectmultiple seed faces, and then choose to select a different tool guide. Once
you create a volume, the Select Faces tool guide resets by default.

The Select Edges tool guide selects edge loops that enclose a region. Edges are used to stop the
propagation of face selection, emanating face-wise outward, starting at the selected seeds.

TheSelect CapFaces tool guide selects optional capping faces. This is important when an internal edge
loop is either not simply fillable, or when you want some non-standard fill geometry to be created.

The Select Seed Face tool guide selects a face that lies within the volume you want to enclose. If this is
not chosen, then SpaceClaim chooses an arbitrary face to start from, and test whether any bounded
volumes are created. If they are not, another face will automatically be selected and the algorithm will
re-start. Select a face here to save this iteration time.

The Complete tool guide creates the volume solid based on the edges and seed face you select.

Options
Merges the created volume into the outer shell to effectively fill the inner
cavity. This option is useful if the outer volume is of main interest.

Merge created volume

Leaves the capping faces intact so that the location of the inlets and outlets
can be seen.

Imprint capping edges

Creates share topology between the volume extracted and the input bodies.Create share topology

Enables you to preview the selection of inner faces and detect leaks. Click
the Play button to preview the faces in an animation, or use the slider to
manually preview the faces.

Preview inside faces
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Examples - Extracting Volume

The faces enclosing the region of interest and a seed face are selected to extract the volume of interest.

Preview the selection of inner faces for the volume extraction and detect leaks. Click thePlay button to preview the
faces in an animation, or use the slider to manually preview the faces.
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13.1.2. Creating Midsurfaces
TheMidsurface tool creates a surface midway between two offset faces. The midsurfaces are automatically extended
or trimmed to adjacent faces, and the distance between the original faces is stored as a thickness property. You can
use these midsurfaces for FE analysis.

Color highlighting shows you face pairs that have been selected, as shown below. The midsurface will be offset from
the cyan faces. Green indicates that a face is paired with a cyan face. Unselected faces and faces without offsets are
shown in the original color.

The thickness of the original model face offsets are stored as a property namedThickness in theMidsurface section
of the Properties panel. This is a face property, so you must select the face in the Design window rather than in the
Structure tree, even if it is a single face. You can change this property, and it is included in the Ansys data when it is
sent out to Ansys via the SpaceClaim add-in.

TheMidsurface tool detects and removes small faces of midsurfaces that are created when an edge is equal to half
of the part thickness.

If the Midsurface tool finds missing faces because neither side can be offset, you will receive an error message in
the error box that lists the faces. If the tool fails to create midsurface parts, the problem faces or edges are highlighted.

• Midsurfaces inherit the material properties of their parent components, but you can change the material properties
for the midsurface object.

• Midsurfaces are shown in the Structure Tree with a default name that includes the assigned thickness. When you
rename the surface, the thickness is appended to the new name.

• You can change the thickness of a midsurface face, select the midsurface face in the Design window and change
the Thickness property in the Properties panel.

• You can remove the Midsurface association by setting the Thickness to 0.

• When you right-click a Midsurface in the tree, you can select the source body using Select > Midsurface Source.

Tomake amidsurface body from a regular open surface body
1. Select the surface in the Structure tree.

2. Change the Thickness property in the Properties panel.

Creating Midsurface Faces by Selecting Offset Pairs
1. Click

Midsurface in the Analysis group of the Prepare tab.

2. Select the Use selected faces option in the Options panel.

This option automatically detects all offset face pairs on a body with one or more offset distances.

869Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Preparing Designs for Analysis



3. Select a face for which you want to create a midsurface.

4. Select a second face that makes an offset pair with the first face. All face pairs that have the same offset distance
will be added to the selection.

5. Use the Add/Remove Faces tool guide to remove detected face pairs or to add undetected face pairs.

To add or remove a detected face pair, click either face in the pair.

Note:

• If the face has an offset pair that was previously selected, the pair will be deselected.

• You may need to remove a face from selection if it is paired incorrectly.

• The midsurface distance will be offset from this face the same distance as adjacent faces, regardless
of any potential offset pair for this face.

• Two faces may be detected as a pair because they have the same offset distance as the face pairs to
be midsurfaced. Select the cyan face to remove the pair from selection.

• A face pair that should be midsurfaced may not be detected because its offset pair is not a perfect
offset of the first face. Select the face you want offset to add it to the selection. Its midsurface will be
offset using the thickness of neighboring detected face pairs.

6. (Optional) Click the Select Faces tool guide or hold the Ctrl key and select additional face pairs with a different
offset distance.

When you add face pairs, all face pairs with the same offset distance will be added to the selection.

7. Click the Complete tool guide when you are finished selecting faces.

When you successfully create a midsurface, the solid will become semi-transparent and the surface will be opaque
until you select a different tool or clear your selection.

Midsurface bodies are created in a component in the Structure tree, and are named using the name of the original
object and appended with MidsurfaceN, where N is a unique number.

Creating Midsurface Faces Based on an Offset Range
1. Click

Midsurface in the Define group on the Prepare tab.

2. Select Use range in the Options panel.

The face pairs with offset distances within the range are automatically detected. If you have face pairs selected,
the range will automatically change to include the offset distance.

3. Select the body for which you want to detect offset face pairs.

4. Change the Minimum thickness and Maximum thickness values in the Options panel as needed.

Face pairs within this range will be selected, while face pairs outside this range will be removed from the selection.

5. Click the Complete tool guide when you are finished selecting faces.

870Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Preparing Designs for Analysis



Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Faces tool guide is active by default. This tool guide allows you to select a
pair of offset faces, and all other face pairs with the same offset distance are automatically
detected.

The Add/Remove Faces tool guide allows you to select additional faces to offset or
remove detected face pairs from the selection.

The Swap Sides tool guide allows you to switch the face pairs. You may need to do this
when you detect pairs with more than one offset distance, and the offset relationships
are incorrectly detected.

The Complete tool guide creates the midsurface faces.

Options
The following options are available in the Options panel:

Select this option to create midsurfaces for only the faces you select.Use selected faces

Select this option to create midsurfaces on all faces in the specified thickness
range.

Use range

Change the value of this option to detect offset spline faces with an offset
value within the tolerance amount.

Thickness tolerance

Select Same component to create the midsurfaces in the same component
as the part you selected for midsurfacing. SelectActive component to create
the midsurfaces in the active component.

Createmidsurfaces in

Select the location for the midsurface created. Choose fromMiddle (default),
Bottom (green), or Top (cyan).

Createmidsurfaces at

Select this option to create midsurfaces in a new sub-component. Deselect
the option to create the midsurface objects in the component you select in
the option above (same component or active component).

Groupmidsurfaces

Select this option to extend surfaces to another surface.Extend surfaces

Select this option to trim surfaces to another surface.Trim surfaces

Examples - Midsurfaces

Selecting an additional face pair with the Use selected faces option and the Select Faces tool guide. All face pairs
with the same offset are added to the selection.
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Removing a face that was automatically detected but not desired as a midsurface pair.

Extend Surfaces isON by default. Because it's obvious in the above example, the surfaces meet even when Extend
Surfaces is turned OFF.

When the edges are rounded, the surfaces meet with Extend Surfaces turned ON. They do not meet with Extend
Surfaces turned OFF.
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Trim Surfaces trims the surfaces to the extent of the original body. In the example above, the slope at the bottom
shows two different results. In the second image with Trim Surfaces turned OFF, the midsurface will extend to the
extent of the largest face of the pair. In the third image with Trim Surfaces turned ON, the midsurface is trimmed
to the sloped face.

13.1.3. Creating Spot Welds
The Spot Weld tool creates points on two faces that represent weld points. Each spot weld consists of two points:
one on each face that is to be welded together. Each point must lie on a face or edge. For export to Ansys, each point
must lie on a different solid or surface part.

When spot weld points are found on another body, the set does not include points with mates within the same body,
as shown below. Weld points in a set that have mates are blue and points that do not have mates are gray.

Spot welds are updated with changes to the guiding edges or base faces.

• If a guiding edge disappears, the points created along it are removed.

• If a mate face moves out of the search range the weld point, the pairs to that mate face will disappear.

• If the mate face moves back into the range, the point pairs will reappear.

• If pairs cannot be found for all of the points on the base face, the spot weld is marked in the Structure tree with
an error icon showing that it is no longer valid.

Dimensions for spot weld point patterns are displayed in the Design window. These dimensions look the same as
dimensions for other patterns.

Exporting to Ansys
Spot welds defined for the design can be exported to Ansys.
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Ansys DesignModeler and Ansys Workbench recognize the weld points with the following limitations:

• Only points with mates can be used for simulation.

• You may place weld points between multi-body parts if the two bodies belong to different parts. Spot welds defined
between bodies in the same part are not transferred to simulation.

• You can approximate seam welds by placing weld points on the guiding edge with an offset of zero, if no mating
face is found on either side of the base face.

• SpaceClaim supports spot welds of more than two weld points (more than two components are welded together
at one location), but Simulation does not. Simulation ignores any weld points after the first two supplied.

If a spot weld joint in SpaceClaim contains a spot weld with more than two weld points, then a chain of pairs of
weld points is transferred to Simulation as separate spot welds, and each two-point spot weld is listed separately
under the Connections node. For example, if a single SpaceClaim spot weld connects parts A-B-C-D, this is
transferred as three separate spots welds: A-B, B-C, and C-D.

Defining Weld Points
1. Click

Spot Weld in the Analysis group of the Prepare tab.

2. Select base face.

This is the face or faces on which the weld points will be defined. You should select a single face or a chain of
tangent faces.

3. Click the Select guiding edges tool guide and select an edge.

This is the edge along which the weld points will be defined. The tool searches for mating edges in the following
directions:

a. The surface normal.

b. The opposite direction of the surface normal.

c. If no match is found for a orb, then the direction perpendicular to both the surface normal and edge tangent
is searched.

You can hold Ctrl and double-click to select a chain of edges.

4. (Optional) If you want to define a different mating face, click the Select mating faces tool guide and select a
mating face.

You can select more than one face. Clicking on a mating face removes all previously selected faces and holding
Ctrl adds a face.

5. Set the following options:

• Start offset: The distance of weld points from the beginning of the guiding edge.

• Edge offset: The distance of weld points from the guiding edge.

• End offset: The distance of weld points from the end of the guiding edge.

• Number of points: The number of weld points to define for each edge chain.

• Increment: The distance between weld points.

You can set either the number of points or the increment. The last value you enter will be used. For example,
if you change the number of points, the increment will automatically update. If you then change the increment,
the number of points will change.
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• Search range: The distance to search for mating faces from the guiding edge.

6. Click the Create spot weld tool guide to define the spot welds.

Redetecting Mating Faces
1. Right-click a face with spot welds.

2. Select Redetect Mating Faces.

Spot welds will be placed on any new nearby faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use the Select Base Faces tool guide to select the face or faces on which the weld points
will be defined. You should select a single face or a chain of tangent faces.

Use the Select Guiding Edges tool guide to define the edge along which the weld points
will be defined.

Use the Select Mating Faces tool guide to change the mating face from the face that is
automatically detected. You can select more than one face. Clicking on a mating face removes
all previously selected faces and holding Ctrl adds a face.

The Complete tool guide completes the spot weld definition.

Options
The following options are available in the Options panel:

The distance of weld points from the beginning of the
guiding edge.

Start offset

The distance of weld points from the guiding edge.Edge offset

The distance of weld points from the end of the guiding
edge.

End offset

The number of weld points to define for each edge chain.Number of points

The distance between weld points. You can set either the
number of points or the increment. The last value you
enter will be used. For example, if you change the number
of points, the increment will automatically update. If you
then change the increment, the number of points will
change.

Increment

The distance to search for mating faces from the guiding
edge.

Search range
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Example - Spot Welds

Spot welds that cross over multiple nearby welded parts

13.1.4. Creating Welds
You can weld surface bodies to other surface bodies or to solid faces.

Welding Surface Bodies Manually
1. Click the Weld tool in the Prepare tab.

2. Click the Select Edges tool guide.

3. Select edges where the Weld body will be created.

You can Ctrl-select individual edges or select chains or loops.

4. Click the Select Target Faces tool guide.

5. Select a target face where the Weld body will attach.

• Use the Ctrl key to select multiple target faces.

• The edges can extend beyond the selected faces.

• The tool will determine the extent of the Weld.
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6. Click the Complete tool guide to create the Weld body.

Finding Potential Weld Sites
1. Click the Weld tool in the Prepare tab.

2. The Select Problem tool guide is active by default.

3. Change the MaximumWeld length if needed.

Based on the Maximum Length value in the Weld tool Options, the model is searched to find potential Weld
sites.

The weld sites are highlighted as in other Find/Fix tools.

4. Select individual sites for Weld creation or click Complete to create Welds at all sites found.

You can add a Thickness to a Weld by selecting it and editing its Properties.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is used for selecting sites found and creating welds at the
sites.

TheSelectEdges tool guide is used for manually selecting edges where welds will be created.

The Select Target Faces tool guide is used for selecting the faces where welds will attach.

The Exclude Problem tool guide is used for excluding sites found.

The Complete tool guide creates the weld.

Options
The following options are available in the Options panel:

This is a length in model units that represents the
maximum length for a weld. All potential welds that are
equal to, or less than, the Maximum Length will be found.

Maximum Length

Examples - Welds
The following example shows how you can find potential Weld sites and create welds.
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Enter theWeld tool. By default, the tool
will find any sites that can be welded
with a length less than, or equal to, the
MaximumLength specified in the tool
options.

Any sites found are highlighted.

Using the Select Problem tool guide,
you can select individual sites to create
welds. Here, one of the sites is selected.

The weld is created at the selected site.
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Clicking the Complete tool guide
creates the remaining welds.

13.1.5. Wrapping Geometry
The Wrap tool lets you wrap geometry around a target model. The example below shows both a solid block and a
circular surface wrapped onto a cylindrical target body using the Wrap tool.

Sketched Curves and Notes can also be wrapped around a target body.
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Wrapping Geometry and Text
1. Click the Wrap tool in the Manufacturing group.

2. The Select Target tool guide is active by default.

Select the target body.

3. The Select Geometry tool guide becomes active.

Select the geometry, curves, points, point patterns, or notes to wrap around the target.

4. (Optional) Click theSelect Start tool guide and select a Datum Point or Origin to use as a start point for the wrap.

You can drag the source and target start points to reposition the wrap

5. (Optional) Set the Wrap Options.

• Imprint as edges
• Delete source geometry

6. Click Complete to wrap the selection.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is used for selecting sites found and creating welds at the
sites.

TheSelectEdges tool guide is used for manually selecting edges where welds will be created.

The Select Target Faces tool guide is used for selecting the faces where welds will attach.

The Exclude Problem tool guide is used for excluding sites found.

The Complete tool guide creates the weld.
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Options
The following options are available in the Options panel:

When selected, no solid or surface geometry is wrapped.
Solid and surface boundaries, and curves, are imprinted
on the target.

Imprint as edges

The source geometry is deleted after it is wrapped.Delete source geometry

Examples - Wrapping
Layers of solid geometry can be wrapped. Consider a
circuit board that is not flat, for example. Components
layered onto the board need to follow the contours of
the board. An example of the final circuit board is shown
with transparency in the board to show a component
underneath.

The starting model for the circuit board is shown below.
Notice that the components are at two different heights
and they extend beyond the board. The spacing of the
solids is based on their proximity to the first selected solid
to be wrapped.

Components are about to be wrapped onto the contoured
board.

The board is selected as the target and the first set of
components is selected for wrapping. it includes a base
layer of components and a second layer that rest on top
of the first. Notice the starting point indicated by the
yellow handles on the right. By default, the handle
locations are set to the shortest distance between the
Source and the Target. They can be moved to different
locations if desired. In the image below, the default
location is used for the first set of components. The
wrapped locations are previewed in purple.
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The image shows the completed wrap for the first set of
components.

The last component gets wrapped underneath the board.
Notice how the start point is initially at the shortest
distance. This would distort its spacing relative to the
first set of components.

In order for the component to map too the correct
location, an origin is selected as the start point. This will
maintain the original spacing of the component relative
to the other components.

13.1.6. Creating Enclosures
An enclosure is a solid around a body or bodies that has a cushion around the enclosed solid(s). The enclosure can
be a box, cylinder, or sphere, as shown below.

Enclosures are used by analysis tools to simulate fluid.
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Creating an Enclosure
1. Click

Enclosure in the Analysis section of the Prepare tab.

2. Select one or more solid or faceted bodies in the Design window or Structure tree.

These bodies will be inside the enclosure.

3. Set the Default cushion amount.

This is a percentage of the minimum enclosure size, and determines the initial distance between the enclosed
object(s) and the closest point of the enclosure to the objects. You can adjust the distances by typing in the fields
in the Design window.

4. Select the shape of the enclosure in the Options panel: Box, Cylinder, Sphere, or Custom shape.

If you select Custom shape, you must use the CustomShape tool guide to select a solid to use as the enclosure
shape.

5. (Optional) Click the Set Orientation tool guide and select a line, axis, or origin to change the orientation of the
enclosure.

The enclosure is oriented with the world origin by default.

6. (Optional) Deselect theSymmetric dimensions option to set the cushion distance different for dimensions that
are opposite each other.

7. (Optional) Type a value to adjust the cushion values, if necessary.

Press Tab to move among the cushion values.

8. (Optional) Enable Create share topology to create share topology between the enclosed body and the input
bodies.

9. Click the Complete tool guide when you are finished.

The enclosure is created in a sub-component of the active part.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use theSelectBodies tool guide to select the bodies that
will be enclosed.

Use the Set Orientation tool guide to change the
orientation of the enclosure relative to your design or
the axis of a coordinate system.
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Use theCustomShape tool guide to select a solid to use
as the custom shape when you set the enclosure type to
Custom in the Options panel.

Click the Complete tool guide when you are finished.

Options
The following options are available in the Options panel:

This is a percentage of the minimum enclosure size, and
determines the distance between the enclosed object(s)
and the closest point of the enclosure to the objects. You
can change adjust the distances by typing in the fields in
the Design window.

Default cushion

Select an enclosure shape from the list. If you select
Custom shape, you must use the Custom Shape tool
guide to select a solid to use as the enclosure shape.

Enclosure type

Forces the dimensions to remain symmetric. Deselect
this option if you want to enter values for dimensions
and you don't want the opposite dimensions changed.

Symmetric dimensions

Creates share topology between the enclosed body and
the input bodies.

Create share topology

Examples - Enclosures

Changing the cushion by typing in the field doesn't change the size of the opposite cushion. The Symmetric
dimensions option must be disabled.

Changing the orientation of the enclosure so it is aligned with the edge highlighted in yellow aligns the enclosure
with that edge.
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If the associated body is modified, you can update the enclosure using the context menu item found by right-clicking
on Enclosure in the Structure tree.

13.1.7. Splitting by Plane
TheSplit byPlane tool splits parts based on a plane. It is intended to be used to split symmetrical parts for analysis.
This tool is similar to Split Solid, except Split by Plane allows you to select an axis, point, or edge, to use as splitting
plane locations which are not allowed by Split Solid.

The part below has been split along the length of its handle. The purple and green parts are symmetrical, and can
be analyzed faster than the whole part.

Splitting Objects by Plane
1. Click

Split by Plane in the Analysis group of the Prepare tab.

2. Select the object(s) you want to split.

3. Select a plane to split the object:

• To split the part on the same plane as a face, edge, or point, click Select Cutter and select a reference face,
edge, or point.

• To define a temporary plane based on design elements, click Build Cutting Plane and select faces, edges, or
points to define the plane. You can select more than one face, edge, or point, and the cutting plane will be
created that bisects the elements. The wrench in the image above is tapered. Using the Build Cutting Plane
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tool guide, you can select the top and bottom of the wrench to create a plane that bisects the wrench along
its plane of symmetry.

4. To delete objects created by the split, click the Select Regions tool guide and mouse over the parts created by
the split. The regions will be highlighted. Click to delete the region.

5. Click the Complete tool guide.

SpaceClaim splits the solid along the plane.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelect Target tool guide is active by default. Use this tool guide to select the object that
will be split.

Use the Select Cutter tool guide to select a reference face, edge, or point with which to cut
the part. Use Ctrl to select more than one object. The plane is previewed in gray before you
select the reference object.

Use theBuildCuttingPlane too guide to select faces, edges, or points to create a temporary
plane with which to cut the object. The temporary plane(s) are shown with a dashed line.
Select a temporary plane to complete the split.

Use theSelectRegions tool guide to select regions that will be removed. You can move your
mouse over regions that were created and highlight them before you click to delete.

Options
The following options are available in the Options panel:

Select this option to merge all touching solids or surfaces when you exit the tool.
Hidden objects are not merged. This saves you the extra step of selecting all the
cut-up regions after you are done and manually merging them all back together.

Merge when done

13.1.8. Extending Adjacent Faces
Use this tool to extend or trim surfaces and merge them with nearby parts, or to extend or trim sketch curves. The
tool automatically detects faces that can be extended or trimmed and highlights them, as shown below. Click a
highlighted area to perform the extension or trimming. You can also select a surface that wasn't automatically
detected and attempt to extend or trim it. This tool only works with surface parts and sketch curves.
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Extending or Trimming Adjacent Surfaces
1. Click

Extend in the Analysis group of the Prepare tab.

The edges of surface parts or sketch curves that can be extended or trimmed are highlighted.

Chains of tangent faces are automatically grouped to offset them together.

2. Change the following options:

• Maximum distance: The maximum distance between surfaces. The tool will search for adjacent faces again
if you change this value.

• Trim surfaces: Controls whether or not surfaces may be trimmed in addition to extended.

• Partial intersections: Controls whether or not faces that partially intersect are detected.

• Same body: Allows a surface to be trimmed or extended by a face or edge on the same body.

• Merge after extend or trim: Merges bodies, if possible, when you trim or extend an edge on one surface body
up to a face or edge on another body.

3. If you want to extend or trim only some of the surfaces or sketch curves, click the highlighted spots.

Hold Ctrl to select multiple edges.

The surfaces or sketch curves are extended or trimmed when you click them.

4. Click Complete if you want to extend or trim all highlighted surfaces.

Press Esc to cancel the operation.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This tool guide allows you to select and
fix problem areas that are automatically found by the tool.

The Select Geometry tool guide allows you to select faces that were not automatically
found. Hold Ctrl to select multiple objects or box select in the design area.

The Complete tool guide merges or trims the highlighted surfaces.

Options
The following options are available in the Options panel:

The maximum distance between parts. The tool will
search for adjacent faces again if you change this value.

Maximum distance

Controls whether or not surfaces may be trimmed in
addition to extended.

Trim surfaces

Controls whether or not faces that partially intersect are
detected.

Partial intersections
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Allows a surface to be trimmed or extended by a face or
edge on the same body.

Same body

Finds surfaces to extend to curves when the curve is in
the same plane as the surface.

Extend to curves

Merges bodies, if possible, when you trim or extend an
edge on one surface body up to a face or edge on another
body.

Merge after extend or trim

Examples - Extending/Trimming

Curves are extended from endpoint to endpoint.

The edges of separate surfaces are merged when you select the Merge after extend or trim option.

You can extend curves to surfaces and surfaces to curves when you select the Extend to curves option.

13.1.9. Imprinting
The Imprint tool detects coincident faces, edges, and vertices between bodies and imprints them onto the coincident
face. The contact regions will be the same shape, and the resulting mesh on each face will be similar. This can be
helpful when analyzing stress between two parts.
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Curves and Beams that intersect faces create imprinted Points that are converted to Pinned Datum Points.

Sketch points coincident to faces create Pinned Datum Points when imprinted.

Imprinting a Part
1. Click Imprint in the Analysis group of the Prepare tab. The tool will automatically detect and highlight coincident

edges, as shown in the image above.

2. Select the object(s) you want to change:
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• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edges that were not automatically detected. You can use box,
lasso, and paint select modes.

3. Use the controls in the Navigate ribbon group to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

4. Click the Complete tool guide.

SpaceClaim imprints the selected edges of the coincident faces.

Note: There is an internal limit to the number of imprint sites found by the tool. The limit is set to 1000 to
optimize for performance.

Options
Tolerance: If the distance between objects is less than or
equal to the Tolerance value, they will be considered
intersecting.

In the image on the right, the distance between the objects
is 0.01, which is equal to the Tolerance.
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Preserve Instances enabled

Preserve Instances disabled

Preserve Instances preserves instanced components.

When this option is enabled (default), contacts between
instanced components and other geometries will be ignored
while imprinting.

When this option is disabled, contacts between instanced
components and other geometries will be considered while
imprinting.

Face finds intersections between two faces.

Edge finds intersections between two edges.
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Beam/Curve finds intersections between curves/beams.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide imprints all the highlighted
edges.

13.2. Remove
Tools in the Remove group help you easily remove elements to simplify your designs.

Use the Interference tool to merge parts that clash.

Use the Rounds tool to remove rounded edges from a
design.

Use the Faces tool to remove features from a design.

Use the Short Edges tool to find edges shorter than a
specified length that may impact meshing results.

13.2.1. Removing Rounds
The image below shows an example of well-formed rounds, on the left, and poorly formed rounds, on the right:
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Note:

• You will have a greater chance of success if you remove only a few rounds at a time. If you spend a lot of
time removing rounds, you may want to review SpaceClaim's tutorials or technical support information
for advanced techniques you can use when removing rounds.

• Closely inspect your model from various angles and zoom levels, so you can best determine the areas of
rounds you want to remove. Each area of a model is unique, and different areas may require different
approaches to round removal.

• Select the round's or round group's shortest edge first.

To ensure accurate and complete round removal, remove the rounds in the reverse order in which they were created,
as shown in the example below of a model with colored rounds:

Removing Rounds
To split and partially remove a round:

1. Click Rounds from the Remove group on the Prepare tab.

Avoid splitting into a round. Instead, split on either side of it. You may need to split and partially remove one or
more rounds before adjacent rounds can be removed, especially when two or more rounded faces meet along
an edge or vertex. The rounded face is split and filled in the middle. To select faces or capping faces, use the
Faces tool.

2. Hover over one tangent edge of the rounded face to display the round's split lines. These lines show you a visual
indication of where the round will split, as shown below. You can move the split lines by moving your mouse.
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3. If necessary, from the Options panel, change the Capwidth option to adjust the percentage of the round face
that is removed.

• Click the edge to split the rounded face.

• Select the rounds you want to remove:

• Click an object in the Structure tree to select all rounds on the object.

• Select a round face in the design area. You can hold Ctrl and select faces or draw a box to select multiple
faces.

Ctrl+click to deselect a face.

From the context menu choose Select > Using Box. Move your mouse over the area you want to remove to
identify the parts you want to select. Draw the selection box around the area. You can only select round faces
while this tool is active.

4. To select faces or capping faces, use the

Faces tool.

5. Click the Complete tool guide.

SpaceClaim removes the rounded faces you selected and replaces them with a sharp edge.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelectRounds toRemove tool guide is active by default. You can also
select by drawing a box in the design window. You can only select round
faces while this tool is active.

The Complete tool guide finishes the operation. F or Enter are shortcuts
for removing the rounds.

Options
The following options are available in the Options panel:

• Auto-shrink fill area: Select this option to split round faces where they can't be removed when you select a chain
of rounds and it cannot be filled in its entirety. The rounds will be partially removed.

• Capwidth: The percentage of the width of a round that is removed when you click an edge of an existing round.
The splits are previewed as the cursor is moved along the round tangent edges.
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Examples - Removing Rounds
Splitting and partially removing a round.

Using other tools to remove a round.

Progression using a face to remove a round.

Using the Sphere tool to split and partially remove a
round.

• Try using the Sphere tool from the Insert group on the
Design tab. Using this tool, you can create a round
sphere and place it at difficult geometry junctions. Once
in place you can use the sphere to split the junction in
order to remove the round. In some cases, you may
want to create a chain of two or more spheres to help
with removing larger or more complex rounds areas.

• To avoid trouble with removing spheres, it's good
practice to fill the sphere immediately after you remove
the rounds on either side of a sphere or sphere chain.

13.2.2. Removing Interference
The Interference tool detects and removes interference from clashing bodies. The interference is removed from
the body with the largest volume.

The tool searches all visible bodies for interference. Bodies that are hidden (turned off in the Structure tree) are
ignored.
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If you want to remove an interfering region from one of the bodies, use the Interference Volumes tool on the
Measure tab to create a solid of the interfering region. You can then use theCombine tool to remove this solid from
one of the parts.

Removing Interference

1. Click
Interference in the Remove group of the Prepare tab.

The tool will automatically detect and highlight interference, as shown in the image above.

2. Select the object(s) you want to change:

• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default.

• Use the Select Geometry tool guide to select edges that were not automatically detected.

3. Click the Complete tool guide.

SpaceClaim removes the interference by merging the bodies into one part.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
edges that were not automatically found. Hold Ctrl to
select multiple edges or box select in the design area.

The Complete tool guide merges the clashing objects.

13.2.3. Removing Faces
The Faces tool allows you to quickly remove faces from your design. Use it to simplify your design by removing
holes, protrusions, etc.

1. Click
Faces in the Remove group of the Prepare tab.

2. Select the faces you want to remove. Hold the Ctrl key to select more than one face.
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3. Click the Complete tool guide.

SpaceClaim attempts to remove the selected faces by extending neighboring faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Faces to Remove tool guide is active by default. You can also
select by drawing a box in the design window. You can only select faces
while this tool is active. Edges and vertices will not be selected.

The Complete tool guide finishes the operation.

13.2.4. Finding Short Edges
The Short Edges tool finds any edges smaller than a specified length. If the design must be meshed for running
simulations, short edges have an impact on the mesh quality.

1. Click the Short Edges tool in the Remove group of the Prepare tab.

2. Set the Maximum length option or keep the default value.

3. Edges within the maximum length tolerance are highlighted.

4. Click the problem areas to fix them or click the Complete tool guide.

Tool Guides
The following tool guides help you through the process.

The Select Problem tool guide is active by default. This tool guide allows
you to select and fix problem areas that are automatically found by the
tool.

TheExcludeProblem tool guide allows you to exclude areas from selection
and fixing.

The Complete tool fixes all remaining problem areas or those that are
currently selected.
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13.3. Detect
Tools in the Detect group help you easily find geometry problems in your designs.

Use the Bad Faces tool to detect faces that have corrupt
rendering.

Use the Sharp Edges tool to find sharp edges on faceted
and solid bodies.

Use the Clearance tool to find small gaps between parts.

13.3.1. Finding Bad Faces
The Bad Faces tool detects faces that have corrupt rendering. It detects bad edges that get flagged when faceting
faces for graphics display.

A bad face is highlighted with a red circle.

Finding Bad Faces in the Design
1. Click Bad Faces in the Detect group of the Prepare tab.

Any faces with corrupt rendering are highlighted.

2. When the Bad Faces tool finds bad faces/edges, click the Convert to Selection tool guide

to add them to a selection.

13.3.2. Finding Sharp Edges
The Sharp Edges tool identifies sharp edges on faceted and solid bodies, but it does not fix them.
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Edges on overlapping faces are also identified.

Finding Sharp Edges in the Design
1. Select the Sharp Edges tool

.
2. Set the options for finding sharp edges.
3. Click a faceted or solid body to find edges sharper than the Max edge angle specified.

Based on the options settings, if any sharp edges are found, they are highlighted.
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4. When the Sharp Edges tool finds sharp edges on facets or geometry, click the Convert to Selection tool guide

to add them to a selection.

Options
The following options are available for finding sharp edges:

This is the angle between normals of faces that share an edge. Any edges with an
edge angle greater than the angle specified will be highlighted.

Max edge angle

Convex sharps are found. These are sharps that point outward.Convex

Concave sharps are found. These are sharps that point inward.Concave

13.3.3. Checking Clearance
The Clearance tool helps you easily find small gaps between faces.

1. Click Clearance

in the Detect group of the Prepare tab.

2. Type a distance for the Maximum distance in the Options panel.

If theClearance tool cannot locate gaps between faces for the setting you entered, an Information alert informs
you that no areas were found. Specify a new setting to locate existing gaps. If you enter a distance that does not
exist in your design, an alert informs you that the distance setting you entered is invalid. When you enter a valid
maximum distance, gaps between faces that are equal or less than this distance are automatically detected and
highlighted, as shown below.

3. When the Clearance tool finds gaps between faces, click the Convert to Selection tool guide

to add them to a selection.

4. Use the Pull or Move tools to adjust any gaps as needed.

Options
The following options are available in the Options panel:

Maximum distance: The maximum distance to detect for near faces.

13.4. Beams
Create and edit beam objects with the tools in the Beams group.
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Use the Profiles tool to select a profile for a beam object.

Use the Create tool to define a beam using a profile from
the library.

Use the Extract tool to define a beam and profile from a
solid.

Use the Orient tool to change the orientation or axis of
the beam.

Use the Connect tool to find endpoints and endpoint
connections that can be extended or moved to connect
to a nearby beam.

Use the Split tool to find endpoint connections between
Solidified beams, where one Beam endpoint lies
somewhere in the middle of another Beam.

Use the Display tool to change how beams and shells are
displayed.

Creating a Beam
A beam is a long, thin object with a constant cross-section. Defining objects as beams, rather than modeling them
as solid geometry, simplifies the model and analysis.

To create a beam:

1. Create objects to define the beam path.

One or more of the following methods can be used in the same design:

• Sketch curves: Use any of SpaceClaim's sketching tools to create straight or curved segments and then assign
beam profiles to them. These sketch curve beams can then be modified just like any curve in SpaceClaim using
the Move, Pull, Select, Scale, Bend, Extend, and Trim tools. This method is a straightforward, lightweight way
to create beam structures.

• Edges of a solid or surface: Use this method when you have solid geometry that you want to reference for the
beams. For example, to create a simple rectangular cage of beams, sketch a rectangle, pull it into a solid, and
assign beams to all of the edges.

• Twopointsormidpoints inamodel: You can use any two points in a model to define a straight beam segment.
Planes can be used to create "stages" or additional locations for defining beams to or from. A beam can be
created to the intersection point of any plane with any edge.

2. Click
Profiles in the Beams group on the Prepare tab.

This tool enables you to add a profile to your structure.

3. Select a profile from the library or click More Profiles to load a profile that is saved as an SCDOC file.

See Changing beam profiles.
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Note: More than one beam can reference the same profile, so the characteristics of all beams that use
that profile will change if you edit the profile.

4. Click
Create in the Beams group on the Prepare tab.

The Create tool is enabled when you select a profile, which adds the profile to your design document. This tool
enables you to create the beam path.

5. Select edges or points to define the path:

• Click the Select Point Chain tool guide and then select an edge or curve, or select a series of points to create
the path.

• Click the Select Point Pairs tool guide and then select a beginning and end point for the path.

You can use intersection points and midpoints on edges and other beams. Click the small triangles on the ends
and midpoint when you hover over an edge or beam.

See Creating a beam.

A Beams folder is created for the beams and a BeamProfiles folder is created for the profiles in the Structure tree:

The profile name is displayed in parentheses after the beam name in the Structure tree.

If you have already modeled the beam you can convert it to a beam object. See Extracting a beam from a solid.

Beams and Ansys
If you send a design with beams to Ansys, the following is sent for each beam object:

• Profile and path

• Beam properties

• Profile properties

• Material properties

You can import groups from a beam profile into your design document, which makes them available to drive changes
within Ansys. The groups are named based on the profile name, as <profile name>_<group name>.

Beams and Shared Topology
Beams can share topology with surfaces when

• The end point of the beam lies on the surface:
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• The path of the beam lies in the surface.

• The beam intersects a surface at a point.

The beams and surfaces must be in the same component, the component must be set to share, and the mixed import
option in Workbench must be set to lines and surfaces. See Shared topology in Ansys for more information about
shared topology.

Note: If it is desired for beams to NOT form a single beam when sharing topology, disable the Merge
Connected Beams option in the SpaceClaimOptionswindow (File > SpaceClaimOptions > File Options
> Workbench).

Copying Beams
You can use Copy and Paste to make copies of beams.

• In the same document, copies are pasted on top of the originals.

º To move a copied beam, make sure that Maintain sketch connectivity is checked OFF in the Selection tool's
Sketch Options.

º You can then use the Move tool to move the entire beam or use Vertex Dragging to move an endpoint.

• You Copy beams in one document and Paste them in another.

Beams can also be copied in the same way as Curves, by using Ctrl+Alt when dragging the endpoint.

13.4.1. Beam Properties
Select a beam in theBeams folder and you can change the following properties, which are found in theBeam section
of the Properties panel:

• Type: Select an option from the drop-down list -Beam,Cable,Spring,Link/Truss,Pipe, orThermalFluid.Spring
or Link/Truss types may be applied only to straight lines.

• Orientation: The angle of the profile relative to the path.
• Profile Name
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• Reversed: Changing this property flips the profile.
• Rigid
• Section Anchor: Select the location where the profile intersects with the path of the beam: Area Centroid, Shear

Center, or Location. If you select Location, then you can enter the X and Y coordinates of the anchor location. Area
Centroid is the default.

Editing Beam Properties
To rename a beam in the Structure tree, right-click and select Rename.

You can edit the Beam Section properties by highlighting values and changing them accordingly. This allows you to
create beams that have different geometry characteristics from their profile sketches.

Beams can also have material properties just like other objects.

See Changing beam profiles for information about beam profile properties.

Beam Section Properties
The following beam cross-section properties are calculated by SpaceClaim and transferred to Ansys.

The area of section:

The X coordinate of the centroid:

The Y coordinate of the centroid:

Moment of inertia about the X axis:

Moment of inertia about the Y axis:

Product of inertia:

The warping constant, shear center and torsional constants are calculated from the warping function. The warping
function is the solution to the St. Venant boundary value problem for pure torsion:

Using the Trefftz definition, the shear center and warping constant are calculated purely as a property of the section:

X coordinate of shear center:
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Y coordinate of shear center:

Warping constant:

with

13.4.2. Creating Beam Profiles
You can create your own beam profiles and save them as files.

To use these profiles, click Profiles, select More Profiles, and then browse to locate the SCDOC file.

Creating a Profile Without Creating a Beam
1. Sketch the profile.

2. Click Pull in the Edit group on the Design tab.

3. Pull to extrude the profile into a solid.

4. Change the color of the face you want to use as the profile.

You can change this face to any color, as long as it overrides the color of the solid. Only one face can have a color
override, otherwise SpaceClaim won't know which face is used for the profile.

5. Save the design as an SCDOC file.

Creating a Profile Based on an Extracted Beam
1. Sketch the profile.

2. Click Pull in the Edit group on the Design tab.

3. Pull to extrude the profile into a solid.

4. Click
Extract in the Beams group on the Prepare tab.

5. Select the solid you created in the previous steps.

6. Right-click the profile in the Beam Profiles folder and select Save beam profile.

7. Browse to the folder where you want to save the profile, type a file name, and click Save.

By default, the Section Anchor lies on the centroid of the profile. The Section Anchor is the point where the profile
attaches to the beam path. You can change this in two ways.
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• Use the Orient tool in the Beams group of the Prepare tab
• Select the beam and change the Section Anchor property

13.4.2.1. Changing beam profiles
Profiles are found in the Beam Profiles folder in the Structure tree.

To change the profile for a beam
1. Select the beam in the Structure tree or Design window.

2. Click
Profiles in the Beams group on the Prepare tab.

3. Select a profile from the list or from one of the libraries.

• More Profiles opens a folder browser to browse to profiles you may have saved on your machine
• Standard Library opens a browser of industry standard beam profiles. Two libraries are available.

• AISC
• Eurocode

The name of the beam in the Beams folder changes to the name of the profile, and the new profile is added to
your Beam Profiles folder.

To view beam profile properties
Select a beam profile in the Beam Profiles folder in the Structure tree.

The profile properties are displayed in the Properties panel. These properties are read-only and cannot be changed.

See Beam properties.

To edit a profile
1. Right-click the profile on the Structure tree.

2. Select Edit Beam Profile.

The profile will open as a sketch in a new Design window.

3. Change the profile like you would a sketch.

Each profile has driving dimensions set up in the Groups panel, and each annotation dimension is labeled to
show you which group it corresponds with. You can change these dimensions to alter the profile. See Working
with groups.

To set the default profile
1. Clear your selection by clicking in empty space in the Design window.

2. Click
Profiles in the Beams group on the Prepare tab.

3. Select a profile from the list or from the profile library.
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New beams you create during this session will use this profile by default.

The default profile is not persistent and will be cleared when you restart SpaceClaim.

To remove a profile from the Beam Profiles folder
1. Select the profile in the Structure tree.

2. Click
Profiles in the Beams group on the Prepare tab.

3. Click Remove Profile.

Example

The labels of the annotation dimensions on a beam profile correspond with the group names.

13.4.3. Creating Beams
The library of standard profiles includes several basic beam profiles. You can use these profiles and edit them to
your own dimensions.

To create a beam:

1. Click
Create in the Beams group on the Prepare tab.

The Create tool won't be active until you select a profile, which adds the profile to your design document.

2. Select edges or points to define the beam path:

• Click the Select Point Chain tool guide and then select an edge or curve, or click a series of points to create
the path.

• Click the Select Point Pairs tool guide and then select a beginning and end point for the path.

• You can use intersection points and midpoints on edges and other beams. Click the small triangles on the ends
and midpoint when you hover over an edge or beam.
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The beam object is defined, and the Beams and BeamProfiles folders are created in the Structure tree. The profile
name is displayed in parentheses after the beam name in the Structure tree.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use the Select Point Chain tool guide to create a beam
along an edge or a series of points that you select.

Use the Select Point Pairs tool guide to create a beam
between two points.

13.4.4. Extracting Beams From Solids
The Extract tool converts an existing 3D solid into a beam.

To extract a beam from a solid:

1. Click
Extract in the Beams group on the Prepare tab.

2. Select a solid in the Design window.

The beam object is defined, and the Beams and Beam Profiles folders are created in the Structure tree.

If you select faces on multiple bodies, then beams will be extracted for each body.

Similar profiles are detected when you extract beams from 3D geometry. The resulting beams are linked to the
same profile, so multiple profiles with the same shape are not created.

Examples

This is the Beam after using the Extract tool.

This is a simple I-beam modeled as a solid part.
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This is the Beam after using the Extract tool.This is a complex solid with a constant cross section.

This is the ring-shaped Beam after using the Extract tool.
A ring-shaped solid body with constant cross section can
be modeled as a beam.

This beam was extracted from the midsurface.

Midsurface geometry can also be used to Extract a beam.

Note:

• While extracting a beam from a midsurface,
the beam profile is based on the closed loop
of the midsurface body.

• The beam extraction will fail if the midsurface
does not have a closed loop.
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13.4.5. Changing BeamOrientation
You can use theOrient tool to change the direction of a beam, rotate it around its section anchor, and offset it from
its section anchor.

Changing a Beam's Orientation
1. Click Orient in the Beams group on the Prepare tab.

2. Select a beam in the Structure tree or Design window.

You can click Display in the Beams group and change the display mode to Solid Beams while the Orient tool is
active. You may want to do this so you can see the beam.

3. (Optional) Click the Orient to Object tool guide or hold the Alt key and select a reference object, and the beam
will be oriented to the projected Z direction of the plane of the selected object.

4. Use the blue arrows to change the beam's orientation:

• Click the straight blue arrow (X axis) to reverse the beam's direction.

• Drag the curved blue arrow to rotate the beam around its anchor point.

• Double-click the curved blue arrow to rotate the beam 90°.

• Drag the red or green arrows (Y and Z axes) to offset the beam.

You can also offset the beam from the Anchor Point by changing theSectionAnchorproperty in the Beam's properties.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. This tool guide allows you to
select the beam object that you want to reorient.

The Orient to Object tool guide allows you to select a face, edge, or axis
and orient the beam in that direction.
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Example

Offsetting a beam along the Y axis.

13.4.6. Connecting Beams
TheConnect tool finds endpoints and endpoint connections that can be extended or moved to connect to a nearby
beam. The images below show two beams that can be extended to connect to a third beam. The Connect tool finds
the endpoints and highlights them.

Clicking Complete extends the two beams to connect to the third beam.
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Connecting Beams

1. Click
Connect in the Beams group on the Prepare tab.

Any endpoints that can be connected are highlighted

2. Change the tool options as needed:

• Maximum distance sets the distance to be considered a gap needing to be closed.

• Free ends only will ignore beam endpoints that already connect to a beam.

3. Use the tool guides to connect or exclude endpoints:

• Complete connects all of the highlighted beams.

• Select Problem connects only those endpoints that you select.

After making your selections, simply exit the tool, do not click Complete.

• Exclude Problem ignores endpoints that you select.

After making your selections, click Complete to connect the remaining beams.

Endpoints that are already connected to another beam can be connected to each other. If any of the beams to be
moved are parallel to the X, Y, and Z directions, their directions are preserved. An example is shown below.

The vertical beam and the slanted
beam both connect to the two
horizontal beams. At the top, they are
separated by a distance that is less than
theMaximumdistancevalue set in the
Options panel.
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After clicking Complete, the vertical
beam remains stationary because it is
parallel to the Y direction.

The top end of the slanted beam moves
in the X direction to connect to the
vertical beam.

Merging Connected Beams During Transfer
In SpaceClaimOptions, in the File Options tab you can selectMerge connected beams for Export toWorkbench.
This option allows you to merge connected beams during a transfer when they share the same cross section or
properties. This option is on by default. When this option is selected, you will receive a notification that connected
beams that share a profile will be merged into a single entity when Shared Topology is applied.

13.4.7. Splitting Beams
The Split tool finds endpoint connections between Solidified beams, where one Beam endpoint lies somewhere in
the middle of another Beam.

Splitting Solidified Beams
1. If beams are currently displayed as Wire Beams, change them to Solid Beams.
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2. Click
Split in the Beams group on the Prepare tab.

Any connections that can be Split are highlighted

3. Use the tool guides to Split connections:

• Complete splits all of the highlighted connections.

• Select Problem splits only those connections that you select.

After making your selections, simply exit the tool, do not click Complete.

• Exclude Problem removes connections that you select.

After making your selections, click Complete to split the remaining connections.

In any connections found, the Beam with the smaller cross section is split by the Beam with the larger cross section.

If the beams have the same cross section, they are not highlighted.

After splitting, the split portion of the beam that lies within the larger beam is marked as "Rigid". You can check this
by selecting the split beam within the larger beam and looking at the Rigid property in the Properties panel.

Some beams may have cross sections that are not the same but are of similar size. You can chose to ignore these
by setting the Ignore similar option. This sets a percentage difference in sizes that is acceptable for considering
two beams to be the same. The default value is 10%.

Example
The images below show a zoomed in portion of the truss above. The image on the left shows two of the connections
found. The image on the right shows the result of clicking Complete.

13.4.8. Changing the Beam Display Style
You can display the beams and shells as a wireframe/thin surface or as a lightweight model.

To change the display

1. Click
Display in the Beams group on the Prepare tab.
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2. Select a display type:

• Wire Beams displays the beam as a wire or a thin line in the Design window.

• Solid Beams displays the beam as a lightweight solid, so it is displayed as a semi-transparent 3D object.

• Thin Shells displays the shell as a thin surface in the Design window.
• Thick Shells displays the shell as a lightweight solid, so it is displayed as a semi-transparent 3D object.

13.4.9. Moving Beams
You can use the Move tool to move beams. The Move tool has a special Keep beam fixed option for beams. This
options causes the beam (shown in dark green) to be offset while the profile (shown as a green semi-transparent
3D object) remains fixed.

When you move more than one beam at a time and select the Keep beam fixed option, the beam profiles moving
along a trajectory that can be reversed (normal to the trajectory) are moved and the beam profiles that can't be
reversed (along the trajectory) remain fixed. The beam is offset with equal and opposite changes to the Location
property and the location of the beam's section is maintained. You can see this in the preview geometry for the
beam.

• Moving the beams without the Keep beam fixed option moves all beams and profiles:

• Moving the beams with the option selected moves the two beams that are normal to the trajectory, but the two
beams that aren't normal to the trajectory are offset:
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14:Workbench

TheWorkbench tab includes tools for identifying and simplifying bodies for conversion to Icepak object geometry, sharing
topology, and transferring geometry to Ansys applications.

This section contains the following topics:

14.1. Icepak
The Icepak group contains tools for identifying and simplifying bodies for conversion to Icepak object geometry. It
also has tools that can create Icepak openings, fans, and grilles. The table below summarizes the tools.

Note: These tools are available in the Workbench tab of SCDM licenses only.

Use the Identify Objects tool to identify bodies that can be converted to Icepak objects.

Use the Icepak Simplify tool to simplify bodies to make them compatible with Icepak object geometry.

Use the Openings tool to create surface bodies to represent an opening in a body.

Use the Fan tool to convert existing fans to Icepak fans or to add Icepak fans to specified bodies. Both
the hub and shroud of user-identified fans will be deleted upon conversion to an Icepak fan.

Use the Grille tool to create an Icepak Grille on a selected face.

Use the Enclosure tool to convert an object to an Icepak Enclosure. The Enclosure tool approximates a
box-shaped object as an open box based on any open geometry found by the tool.

14.1.1. Identifying Icepak Objects
The Identify Objects tool identifies bodies that can be converted to Icepak objects.

Note: This tool is available in the Workbench tab of SCDM licenses only.

Icepak object types are compatible with certain types of geometry. By default the Identify Objects tool looks for
the "Block" type and highlights any bodies whose geometry is compatible with Icepak blocks. The workflow for this
tool is similar to other Find and Fix tools in SCDM.

Note: Surface bodies may be made up of multiple surfaces. In these cases, right-click on the surface node
in the Structure Tree and choose Detach All. This will separate the surfaces so they can be individually
considered as Icepak objects.
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Converting Bodies to Icepak Objects
1. Open a model that has bodies to convert.

2. Select the Identify Objects

tool in the Icepak group on the Workbench tab.

The tool finds all bodies that can be converted to the Icepak Block type.

3. (Optional) Enable Hide Icepak bodies in the Options panel to hide bodies after they are converted.

4. If some of the found bodies do not need to be converted, click the Exclude Problem tool guide and select those
bodies.

5. Click Complete to convert the highlighted bodies.

6. To convert bodies to different Icepak object types, click the Select Bodies tool guide.

7. Change the Icepak Object Type in the Options panel.

8. Select the bodies to convert and click Complete to convert the selected bodies.

Only bodies with geometry compatible with the Icepak Object Type will be converted. If any of the selected
bodies has incompatible geometry, a warning message is displayed.

Repeat the steps for other object types.

As bodies are converted, their icon in the Structure Tree changes to reflect that they are now Icepak bodies.

Use the Show

menu to toggle the display of the following bodies.

• Icepak Bodies
• Non-Icepak Bodies
• All Bodies

Note: Since Icepak object types depend on the geometry, if a converted body's geometry changes, it can
become incompatible with the object type. In this case (rounded edges, etc.) the body is converted back to
a normal solid body.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

Use the Select Problem tool guide to convert individual
bodies found by the tool.

Use the Select Bodies tool guide to manually choose
which bodies to convert. When this tool guide is active,
you can change the Icepak Object Type in the Options
panel.
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Use theExcludeproblem tool guide to select bodies that
you do not want to convert.

The Complete tool guide completes the conversion.

Tool Options
The following options are available in the Options panel:

• IcepakObject Type: When the Select Bodies tool guide is active, you can change the type of Icepak object to one
of the following types:

º Block
º Plate
º Opening
º Source
º PCB
º Resistance
º Wall
º Grille
º None

• Hide Icepak bodies: Enable this option to hide the Icepak objects after they are converted. This makes it easy to
see which bodies still need to be converted.

14.1.2. Simplifying Objects for Icepak
The Icepak Simplify tool simplifies bodies to make them compatible with Icepak object geometry.

Note: This tool is available in the Workbench tab of SCDM licenses only.

Simplifying Bodies
1. Open a model that has bodies to convert to Icepak objects.

2. Select the Icepak Simplify

tool in the Icepak group on the Workbench tab.

3. Choose a Simplification Type in the Options panel.

• Level 0 - Bounding box

Each body is fit within its simple bounding box.

• Level 1 - Cuboid, cylinder fit

• Bodies are simplified to simple solid or annular cylinders and cones.
• Bodies already in this state are not simplified further.
• Bodies with additional features may be simplified to bounding boxes if they cannot be resolved as cylinders

or cones.
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• Bodies can be split into multiple polygons if required.

• Level 2 - Polygon fit (Default)

• Bodies are analyzed along a specified direction and fit within polygonal shapes
• Bodies can be split into multiple polygons if desired

• Level 3 - CAD object

Bodies are converted to faceted bodies

4. Depending on the Type, set additional options.

• Level 0 - No options needed.

• Level 1:

• Use Cleanup to remove details such as rounds before attempting to simplify, making it easier to recognize
basic shapes.

• Use Allow splitting to split a body into multiple simplified shapes if possible.

Use Randomize color to randomly assign colors to additional objects created by splitting.

• Level 2:

• Use Enforce axis to choose an axis along which the simplification will be based.

Select Automatic to have the system choose an alignment programmatically, or select X axis, Y axis, or Z
axis to align polygons along the selected axis.

• Use Points on arc to set the number of interior points to use for representing curved edges.
• Use Length threshold to specifiy the threshold value for representing curved edges using interior points.

The number of points is specified by the Points on Arc setting. If a curved edge length, as a percentage of
the largest edge in the polygon profile, is higher than the LengthThresholdpercentage, then interior points
will be added. Otherwise, the curve is considered too short and will be represented as a straight line.

• Use Clean up to remove details such as rounds before attempting to simplify, making it easier to recognize
basic shapes.

• Use Allow splitting to split a body into multiple simplified shapes if possible.

Use Randomize color to randomly assign colors to additional objects created by splitting.

• Use Preserve original to preserve the original body when a body is simplified.

• Level 3:

Use Facet Quality to control the fineness of the facets. The facets preview on the object and remain visible
until you exit the tool.

Note: If you want the highest level of faceting possible, and can accept the performance cost, choose
the finest setting in Level 3.

5. Select bodies to simplify. Box-selection is allowed.

Examples - Simplifying Bodies
Simplified BodyOriginal BodyLevel and Options
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Level 0

Level 1

Cleanup = No

Level 1

Cleanup = Yes

Level 2

Enforce Axis = Automatic

Level 2

Enforce Axis = X axis
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Level 2

Enforce Axis = Y axis

Level 2

Enforce Axis = Z axis

Level 2

Enforce Axis = Automatic

Points on arc = 3

Length threshold = 20%

The larger round uses Points on Arc
for faceting.

Level 2

Points on arc = 3

Length threshold = 10%

Decreasing the Length Threshold
decreases the round size that uses
Points on Arc for faceting.
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Level 3

Facet Quality = Default

Level 3

Left Image: Facet Quality = Decrease

Right Image: Facet Quality = Increase

Decreasing Facet Quality results in
coarser faceting.

Increasing Facet Quality results in
finer faceting.

This single body is to be simplified.

Icepak Simplify deletes the original
body by default and, because Allow
splitting is ON, it creates three Icepak
objects.
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With Preserve original body ON, the
original solid is preserved.

14.1.3. Creating Icepak Openings
The Opening tool creates surface bodies to represent an opening in a body.

Note: This tool is available in the Workbench tab of SCDM licenses only.

Creating an Opening Surface Body
1. Select the Openings tool

.

2. Select a face with an opening. In the example, there is a rectangular cut through the block and a cylindrical hole
partially through the block.

3. The opening surface body is created automatically. In the example, after selecting both the top and the front
face, two openings are created.
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14.1.4. Creating Icepak Fans
The Fans tool converts bodies to Icepak fans.

Note: This tool is available in the Workbench tab of SCDM licenses only.

This tool has two modes.

• One functions like the Midsurface tool, in that pairs of coaxial and opposite-facing faces are Ctrl-selected. On the
second selection, the fan is created.

• In the second mode, either the hub (inside) or shroud (outside) face is selected and then the Complete tool guide
is clicked to create the fan.

Creating a Fan From a Hub and a Case
1. Select the Fan tool

.

2. Select the hub.

3. Press the Ctrl key and select the shroud.
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4. The Fan is created automatically. As fans are created, the original geometry is deleted and replaced with simpler
bodies so it is easier to see which fans have been converted. If the shroud used to create the Fan is not square,
the tool adjusts it to be square.

Creating a Fan
1. Select the Fan tool

.

2. Select the hub. Alternatively, one or the other of the faces can be selected and the other face (size) is assumed
by rule. This allows for very fast and repeated fan creation.
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3. Click Complete

.

Fan Properties
Icepak body properties are read-only and include the sizes of the fans, including Height, as determined by the
geometry or rule. When you create or add an Icepak fan, the following properties display.

For fans, the object type is fan.Object Type

For fans, the shape is fan.Shape

Radius of the fan hub.Fan Hub Radius

Radius of the fan shroud.Fan Shroud Radius

Height of the fan case.Fan Case Height

14.1.5. Creating Icepak Grilles
The Grille tool creates an Icepak Grille on a selected face.

Note: This tool is available in the Workbench tab of SCDM licenses only.

There are several Grille types available in the Options panel.

• Rectangular
• Circular
• Polygonal
• Inclined Rectangular
• Automatic
• Preserve openings allows the original openings to be preserved when a grille is created.
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Creating a Rectangular Grille
1. Select the Grille tool.

.

2. Select Rectangular in the Options panel.

By default, the Select Opening Bodies tool guide is active.

.

3. Click the Select Face

tool guide and select the face on which to create the Grille.

4. Click Complete

to create the Grille.
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Inclined Grilles are also supported for surface bodies. Inclined means that the openings are not aligned with the
axes of the World Origin. The workflow is the same as for Rectangular Grilles. The following example shows openings
aligned with the World Origin Z-axis.

When viewed from the top, it is clear the part is not aligned with the World Origin axes.
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Creating a Circular Grille
1. Select the Grille tool.

.

2. Select Circular in the Options panel.

By default, the Select Opening Bodies tool guide is active.

.

3. Click the Select Face

tool guide and select the face on which to create the Grille.

4. Click Complete

to create the Grille.
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Creating a Polygonal Grille
1. Select the Grille tool.

.

2. Select Polygonal in the Options panel.

3. By default, the Select Opening Bodies tool guide is active.

.

4. Click Select Face

and select the face on which to create the Grille.
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5. The Select Polygon

tool guide is activated.

Select a body to serve as the polygon.

6. Click Complete to create the Grille.
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Note: The polygonal shape can also be projected onto curved surfaces.

Creating an Automatic Grille
1. Select the Grille tool.

.

2. Choose Automatic in the Options panel

3. Select all of the openings.

Note: This part has several holes that were converted to Openings using the Opening tool.
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The Grille is created with a best-fit polygon surrounding the Openings.
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14.1.6. Creating Icepak Enclosures
The Enclosures tool converts objects to Icepak enclosures. It approximates a box-shaped object as an open box
based on any open geometry found by the tool.

Note: This tool is available in the Workbench tab of SCDM licenses only.

Creating an Enclosure From a Box-Shaped Object
1. Select the Enclosure tool

.

2. Select a box-shaped object.

3. The Enclosure is created automatically.

After conversion, the solid's icon changes in the structure tree.
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Tool Options
The Enclosure tool options panel has an Assign thin boundaries option, which will make any checked boundaries
thin.

Check to allow selection of individual boundary options.Assign thin
boundaries

Check to assign -X as a thin boundary.-X boundary

Check to assign +X as a thin boundary.+X boundary

Check to assign -Y as a thin boundary.-Y boundary

Check to assign +Y as a thin boundary.+Y boundary

Check to assign -Z as a thin boundary.-Z boundary

Check to assign +Z as a thin boundary.+Z boundary

Check to keep original object shape along with new enclosure.Preserve original

In the example below, the XYZ Direction gizmo illustrates the meaning of the boundary labels.

Read-only displays of the boundaries are included in the Enclosure's Properties panel.
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Enable Preserve original in Options to keep the original shape along with the new Enclosure.
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14.2. Shared Topology
Use the tools in the Shared Topology group to prepare bodies for sharing topology.

Use the Preparing Overlapping Bodies on page 938 tool to merge bodies so they can be shared.

Use the Detecting Split Edges on page 941 tool to detect and merge coincident edges that do not
mark the boundaries of new faces.

Use the Extra Edges tool as an alternative for merging faces that are tangent or nearly tangent.

Use the Simplify tool to examine a design and simplifiy complex faces and curves into planes,
cones, cylinders, lines, arcs, etc.

Use the Small Faces tool to detect and remove small and sliver faces in your design.

Use the navigation tools to step through all topology identified as shareable.Previous/Next

Use the Share tool to identify topology that can be shared among bodies in the model.

Use the Unshare tool to unshare topologies.

Use the Force Share tool to force a connection between Faces and Edges on bodies.

Use the View Assembly Structure tool to see how the assembly will appear when transferred
downstream to Ansys Workbench.

Use the Show Connected Bodies tool to see body-to-body connections.
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Use these options to choose display options for the connections in your model.

14.2.1. Preparing Overlapping Bodies
The Overlap Bodies tool

allows you to merge bodies so they can be shared.

Resolving Intersections
Bodies that intersect create overlapping volumes, surfaces, or edges that make sharing difficult. By default,Overlap
Bodies will separate intersections into their own bodies in the Structure Tree. You can turn this Off using the
Intersect bodies option in the Options Panel.

A model before using Overlap Bodies to
resolve intersections.

Notice that the overlapping volume is a
mixture of the two bodies colors.

The model after resolving intersections

Notice the separated body with its own color.
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Options
The following options are available.

You can disable/enable the option to specify whether
bodies will be intersected before shared topology is
applied.

Separate Overlaps

Examples - Separating Overlaps
Partially overlapping single-face surface bodies.

• A single shared surface is created, resulting in
three surface bodies.

Coincident single-surface bodies (Duplicate
surfaces).

• Duplicate is removed and only one surface
remains.

Overlapping single-surface bodies where one
lies completely within the other.

• Results in two surface bodies - one is the outer
portion and the other is the inner portion.

Intersecting solid bodies.

• Two bodies become five separate solid bodies.
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Surface bodies partially and fully intersecting
solid bodies.

• Where the surface body can split the solid, two
solid bodies are created, resulting in three
bodies total.

• Where the surface partially intersects the solid,
the edge is imprinted on the solid. This is
picked up by the Share tool.

Baffles are created when surface bodies reside inside solid bodies.

For baffles that touch the boundary of
their corresponding solid body, the
Share tool will report the edges where
the sheet and solid touch.

For baffles which reside entirely within
the solid volume, the Share tool will
report the baffle faces.

In both cases, the final result will be a
properly constructed geometry for
analysis.
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Example - Overlapping Bodies
A body is embedded inside a larger
block.

No merge was done on the bodies so,
if you hide the inner body, there are no
internal edges.

Click the Overlap Bodies tool and
select the bodies. The tool will merge
them so that they can be Shared.

Switching to Wireframe display, you
can clearly see the internal edges when
the internal body is hidden.

14.2.2. Detecting Split Edges
The Split Edges tool detects and merges coincident edges that do not mark the boundaries of new faces.
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This is one of a few geometry repair and navigation tools included here for ease of access. Their behavior is the same
as if accessed from the Repair ribbon.

Consolidating Split Edges
1. Select the

Split Edges tool.

The tool will automatically detect and highlight split edges, as shown in the image above.

2. Select the split edge(s) you want to change:

• Use theSelect Problem tool guide to select highlighted areas that you want to change. The cursor will change
to a hand when you move the mouse over a problem area. This tool guide is active by default. When a single
edge split is selected, the coincident edges are merged.

• Use the Select Geometry tool guide to select edges that were not automatically detected.

3. (Optional) Use the Navigation tools to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you clickNext
or Previous.

4. Click the Complete tool guide to fix selected edge split(s).

• Problems that are highlighted when using the Navigation tools are fixed using the Complete tool guide.
• You may box select several identified edge splits to be fixed in one operation.
• Click in white space or click the Select Problem tool guide. No individual problem area is highlighted. Then

the Complete tool guide will attempt to repair all identified edge splits.

Tool Options
Set the Maximum Length to search the model for split edges that are no longer than the
specified length.

Maximum Length

Use the Minimum Angle option to detect open edges on surfaces that are close to tangent.
An open edge is defined as an edge on the outside boundary of a surface and not connected
to another surface. This option must be enabled for the tool to find the edges.

Minimum Angle

The image below shows an example of using the Minimum Angle option to find open edges that are close to tangent.
After fixing the edges found, they are made tangent, resulting in continuous tangent edges.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
points that were not automatically found. Hold Ctrl to
select multiple points or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide consolidates all highlighted
areas.

14.2.3. Removing Extra Edges
The Extra Edges

tool is an alternative for merging faces that are tangent or nearly tangent. Instead of merging two faces by selecting
the faces, you select and remove the edge(s) between faces to merge the faces. You should only merge faces that
are tangent or close to tangent. Otherwise, the results may be unexpected.

Note: Merging faces is recommended only as preparation for analysis. Merging faces simplifies the model but it may
make it more difficult to modify.
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This is one of a few geometry repair and navigation tools included here for ease of access. Their behavior is the same
as if accessed from the Repair ribbon.

Removing Extra Edges From the Model
1. Open a model which needs edges removed.

2. Select the Extra Edges tool.

Edges which can be removed are highlighted.

3. Click the Complete tool guide to remove all identified edges at once.

SpaceClaim removes the edges and merges the faces.

4. Alternatively, you can use the Select Problem tool guide to select problems to be fixed individually.

Or, use the Navigation tools to step through the identified problems and selectively fix them using theComplete
tool guide.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select and fix problem areas that
are automatically found by the tool.

The Select Geometry tool guide allows you to select
edges that were not automatically found. Hold Ctrl to
select multiple edges or box select in the design area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide removes the selected edge(s).
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14.2.4. Simplifying Designs
The Simplify tool examines a design and simplifies complex faces and curves into planes, cones, cylinders, lines,
arcs, etc. This automates the one-by-one Simplify capability found in the Replace tool.

This is one of a few geometry repair and navigation tools included here for ease of access. Their behavior is the same
as if accessed from the Repair ribbon.

Simplifying a Design
1. (Optional) Select the faces you want to simplify.

You may want to pre-select faces on large designs because it can be easier to simplify a region at a time.

2. Click the Simplify tool.

3. (Optional) Click the Select Geometry tool guide to select faces to simplify that aren't automatically detected.

4. Click the Complete tool guide to simplify all highlighted faces.
5. Alternatively, click the Select Problem tool guide and select a highlighted face to simplify that face. Hold the

Ctrl key or box select, to select multiple faces. Use the Complete tool guide to simplify the selected faces.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. This
tool guide allows you to select problem areas that are
automatically found by the tool.

The Select Geometry tool guide allows you to select
faces and curves that were not automatically found. Hold
Ctrl to select multiple objects or box select in the design
area.

The Exclude Problem tool guide allows you to exclude
areas from selection and fixing.

The Complete tool guide replaces all the highlighted
objects with simplified faces and curves.

945Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Workbench



14.2.5. Removing Small Faces
The Small Faces tool detects and removes small and sliver faces in your design. If the small face is tangent to a
neighboring face, the tool will merge the small face with the neighboring face. If no neighboring face is tangent, the
tool will extend neighboring faces to remove the small face.

You may want to remove these faces before you export the design for analysis if they will have a negligible impact
on the analysis accuracy but a significant impact on its speed.

This is one of a few geometry repair and navigation tools included here for ease of access. Their behavior is the same
as if accessed from the Repair ribbon.

Removing Small and Sliver Faces
1. Click the

Small Faces tool.

The tool automatically finds small faces in the active component and highlights them in the design area, as
shown in the image above.

2. Select the small face(s) you want to remove:

• Use the Select Problem tool guide to select highlighted faces. The cursor will change to a hand when you
move the mouse over a problem area. This tool guide is active by default. When a single small face is selected,
the face is removed immediately.

• Use the Select Geometry tool guide to select small faces that were not automatically detected.

3. (Optional) Use the Navigation tools to view each problem one at a time before you fix it.

• Click Next or Previous to step through and highlight each identified problem.

• SelectZoomtoFit if you want to automatically zoom in on the problem in the design area when you click Next
or Previous.

4. Click the Complete tool guide to fix selected small faces.

• Problems that are highlighted when using the Navigation tools are fixed using the Complete tool guide.
• You may box select several identified small faces to be fixed in one operation.
• Click in white space or click the Select Problem tool guide. No individual problem area is highlighted. Then

the Complete tool guide will attempt to repair all identified small faces.
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Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select Problem tool guide is active by default. You must select objects that you want to adjust in the
Structure tree while this tool is active.

The Select Geometry tool guide allows you to select small and sliver faces that were not automatically
detected. The face will only be removed if it is smaller than the maximum area and/or width in theOptions
panel.

The Exclude Problem tool guide allows you to exclude areas from selection and fixing.

The Complete tool guide removes all the faces that are identified or selected.

Options
The following options are available in the Options panel:

Faces that are smaller than the maximum area will be
found and highlighted for adjustment.

Maximum area

Sliver faces that are thinner than the maximum width
will be found and highlighted for adjustment.

Maximumwidth

14.2.6. Navigating Through Shareable Topology
In addition to stepping through identified problem areas, the navigation tools that allow you to step through all
topology identified as shareable.

1. Click the Share tool

.
Sharing candidates are highlighted in red.

2. Click the Next or Back buttons to view each identified sharing candidate. The individual sharing candidates are
identified in darker red.

3. (Optional) Select Zoom to Fit to zoom in and center on each sharing candidate when you click next or back.

4. (Optional) Select Clip Volume to show only the volume centered on the sharing candidate, hiding other regions
of the model. You can then use the Next and Back buttons to step through the candidates.

5. Click the Complete tool to create shared topology at the selected candidate. Other candidates are not shared.

6. Repeat these steps until all required shared topology is created.

Note: To cancel out of navigation mode, click the Select Problem tool guide. You may then create shared
topology on all identified sharing candidates in one operation.

This is one of a few geometry repair and navigation tools included here for ease of access. Their behavior is the same
as if accessed from the Repair ribbon.
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14.2.7. Sharing Topology
The Share tool

will identify topology that can be shared among bodies in the model. You can then choose to share all or some of
the candidates identified.

• Visible bodies are searched for sharing candidates.

Hidden bodies are ignored.

• Candidates are identified by imprinting bodies with each other.

• Potential candidates outside the coincidence tolerance are ignored.

Note:

• When you re-apply the Share tool, already-found shared examples are not re-detected.

• The Share tool does not work on Locked Bodies. It treats them as if they are hidden.

• Using Instancing, bodies withSharedTopologywithin a component have theSharedTopologypropagated
to other instances of the component. This only affects bodies with Shared Topology and does not affect
bodies without it.

• Component names are changed when they are made independent in the process of sharing.

Using the Share Topology Tool
1. Click the Share tool

.

Sharing candidates are highlighted in red.

2. (Optional) Enter a new Coincidence tolerance in the Options panel.

3. Using the Select tool guide, click individual candidates to share them.

4. Click the Exclude Problem tool guide and click individual candidates to exclude them.

5. Click the Complete tool guide to apply sharing to all remaining candidates.
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The Share tool automatically finds
sharing candidates and highlights them
in red.

Using theExcludeProblem tool guide,
candidates in one area of the model are
selected for exclusion. These
candidates are now highlighted in
green to indicate they are excluded.
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Click theComplete tool guide to share
all remaining candidates.

Manually Selecting Topologies to Share
You can also manually select groups of topologies for sharing.

• Faces and edges may be chosen
• Choose individual entities in pairs
• Ctrl-select additional entities if more than two entities need to be shared

Enter the Share tool.

Click the Select Geometry tool guide.

First click: Select the first surface.
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Second click: Select the edge.

Third click: Hold Ctrl and select the
surface body.
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After selections are complete, the
possible connections are highlighted.

After clicking Complete, the
connections are made.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

TheSelect tool guide is active by default. This tool guide allows you to select coincident
areas that are automatically found by the tool.

The Select Geometry tool guide allows you to select faces and edges to share.

The Exclude Problem tool guide allows you to exclude areas sharing.

The Complete tool guide shares all highlighted coincident areas.
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Tool Options
The following options are available.

Enter a value in model units. Objects that are within this
distance from each other will be considered coincident.

Coincidence tolerance

Select this option to preserve instanced components.
Contacts between instanced components and other
geometries will be ignored.

Preserve instances

Select this option to see the types of connections that
will be generated after sharing. This option is off by
default, but can add a lot of clarity to the preview.

Preview connectivity by color

Shared Topology and Legacy Models
• With new documents, you can setSharedTopologyusing the old component method or with the newShare tool.
• With documents that are using the old component method, you must click Share to switch to the new method.
• If a document is using the new Share method, and everything is Unshared, you can subsequently use either the

old component method or the new Share method.

Updating Legacy Models
Legacy models have Shared Topology declared in the assembly structure but the Shared Topology information is
outdated.

Upon clicking the Share tool, SpaceClaim will search the assembly structure for shared topology and apply it to the
model. A summary of the result will be displayed in the status bar. At this point, the other sharing tools in the ribbon
group will be enabled.

Legacy model with shared topology
before upgrade
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Model after upgrading shared topology

Notice the colored edges indicating
that the shared topology has been
upgraded.

Showing Connected Bodies
In Legacy models, the Show
ConnectedBodies tool only shows the
legacy Boolean connections.

954Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Workbench



After upgrading to the new Sharing,
Show Assembly Structure shows the
new display.

14.2.8. Unsharing Topology
The Unshare tool

unshares topologies. Simply select shared entities in the graphics area to unshare. The tool's selection filter only
allows selection of entities which are currently shared. Shared Faces display is enabled while the tool is active to
assist in selection. Unshare also works with instances.

Using the Unshare Tool
1. Click the Unshare tool

.

Shared faces are displayed. You can enable the display of Shared Edges and/or Shared Vertices.

2. The Includegroupsoption is enabled by default forSearchOptions. Contact groups (Named Selections) created
using the Force Share option will also be searched for and unshared.

The figure shows the initial model with shared topology highlighted.
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Three faces and their boundary edges are currently shared.

• The Select

tool guide is active by default. Use this tool guide to select the entities that are automatically found by the tool.

You can also use the Select Geometry

tool guide to select faces and edges to unshare.

• Use the Exclude Problem

tool guide to exclude entities for the unshare operation.

• Click Complete

to unshare all highlighted shared entities.

Tool Guides
The following tool guides help step you through the process. Use the Tab key to cycle through them. As soon as the
tool guide switches, the cursor may change to reflect the active guide.

The Select tool guide is active by default. This tool guide allows you to select previously
shared entities that are automatically found by the tool.

The Select Geometry tool guide allows you to select faces and edges to unshare.

TheExcludeProblem tool guide allows you to exclude entities for the unshare operation.

The Complete tool guide unshares all highlighted shared entities.

Tool Options
The following Search options are available.
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Contact groups (Named Selections) created using the
Force Share option will also be searched and unshared.

This option is enabled by default.

Include groups

14.2.9. Force Sharing Topology
The Force Share tool

allows you to force a connection between Faces and Edges on bodies. When using the tool, you can continue
selecting Face, Edge, or Face-Edge pairs to share.

Forcing Sharing Between Bodies
1. Click the

Force Share tool.

The tool automatically finds faces and edges within the tolerance limit and highlights them in the design area,
as shown in the image above.

2. Select the faces and edges you want to be shared:

• Use the Select Problem tool guide to select highlighted faces and edges. The cursor will change to a hand
when you move the mouse over a sharing candidate. This tool guide is active by default. When a sharing
candidate is selected, sharing is applied immediately.

• Use the Select Geometry tool guide to select sharing candidates that were not automatically detected.

3. (Optional) Use the Navigation tools to view each sharing candidate one at a time before you force sharing.

• Click Next or Previous to step through and highlight each identified sharing candidate.

• Select Zoom to Fit if you want to automatically zoom in on the sharing candidate in the design area when you
click Next or Previous.
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4. Click the Complete tool guide to force sharing on the selected candidate(s).

• Problems that are highlighted when using the Navigation tools are fixed using the Complete tool guide.
• You may box select several identified candidates to be fixed in one operation.
• Click the Select Problem tool guide. No individual sharing candidate is highlighted. Then the Complete tool

guide will attempt to force sharing on all identified candidates.

Tool Options
The following options are available.

You can control the distance between objects that are considered to be shared.Max Tolerance

For each pair of contact faces, instead of creating a shared face, a Named Selection
is created, which may then be used to create the mesh connection in your downstream
application.

Createonlycontactgroups

Example - Force Share
In the example, the blocks are 4mm apart. With the default tolerance, they cannot be Shared. Increasing the Max
tolerance to 5 allows them to be Shared.

Note: This example is extreme to make the separation visible. In practice, the separations will not be as
obvious. The purpose of the tool is to follow up after executing a Share on the entire model to force sharing
on objects missed, with potentially a very different tolerance.

14.2.10. Viewing Tools
This section contains the following topics:

14.2.10.1. Viewing Assembly Structure
The View Assembly Structure tool

allows you to see how the assembly will appear when transferred downstream to Ansys Workbench. When transferred,
the assembly may be structured differently because bodies sharing topology must belong to the same part in order
to be meshed conformally. When bodies share topology, SpaceClaim will group them by their nearest common
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parent component. If no common parent component exists among the shared bodies, then the entire assembly will
be transferred as a single multi-body part.

The image below shows a simple assembly structure in SpaceClaim. Topology is shared as follows in this assembly.

• Bodies B and C share topology
• Bodies E and F share topology

When you click the View Assembly Structure tool, The Transfer Assembly Structure dialog opens as shown below.

Because bodies B and C share topology and they do not belong to the same component, they must be grouped into
the same part at their nearest common parent, which is SubAssembly1. This pulls other bodies into the multi-body
part which do not participate in sharing, such as body G.
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Bodies E and F are already contained in the same component, so they would transfer under Component3 as a
multi-body part.

14.2.10.2. Viewing Connected Bodies
The Show Connected Bodies tool

allows you to see body-to-body connections. Selecting a body will highlight the body in cyan, while all bodies shared
with the selected body will appear in magenta. Sharing is displayed for solids, sheets, and beams.

UsingComponentSelection inShowConnectedBodiesallows you to differentiate between selected bodies sharing
entirely within a component and sharing from a body in one component to a body in a separate component.

Show Connectivity

,
ShowObscured

,
and Fade Shading

allow you to choose display options for the connections in your model.

The image below shows a tube structure after applying topology sharing.

The image below shows body connections shown in the Show Connected Bodies tool.
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14.2.10.3. Share Topology Display Options
Confirming that topology sharing is present can be done by enabling the display options in the Sharing tool group.
The following choices are available forSharedDisplayandFreeDisplay, which are independent and may be enabled
separately.

Shared Display

• Faces: Shared faces are highlighted such that they can be seen through the model.

º Shared Face Color: Choose the color to highlight these faces.

• Edges: Edges shared among bodies are highlighted in unique colors according to the amount of edges shared.
Shared edges can be set to Thick or Thin for display purposes.

º Double: Choose color for edges sharing two edges.
º Triple: Choose color for edges sharing three edges.
º Multiple: Choose color for edges sharing multiple edges.

• Vertices: Shared vertices are highlighted in unique colors according to the number of connected edges.

Free Display

• Beams: Free beams are highlighted in unique colors according to the number of shared points.

º No Point: Choose the color for beam sharing no points.
º One Point: Choose the color for beams sharing one point.
º Two Point: Choose the color for beams sharing two points.

• Edges: Free edges are highlighted in unique colors according to the amount of edges shared.

º Single: Choose color for edges sharing one edge.
º Double: Choose color for edges sharing two edges.
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The image below shows a tubular structure with shared edges and faces displayed.

The image below shows a beam and shell structure with shared edges and vertices displayed.

14.3. Ansys Transfer
The Ansys Transfer group contains options for transferring geometry to Ansys applications.
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Use Update Parameters to update parameter values in the Workbench parameter set.

Use Workbench to start Ansys Workbench with a geometry system.

Use Mechanical to start Ansys Mechanical with the geometry imported.

Use the workflow options in the drop-down to startAnsysFluent. Select the appropriate
options in the Fluent Launcher.

Fluent Options
Select the appropriate workflow option in the drop-down to start Ansys Fluent.

• Select Watertight Geometry Workflow to transfer the geometry to Ansys Fluent with the Watertight Geometry
workflow selected. See the Ansys Fluent User's Guide for more information about Using the Watertight Geometry
Workflow.

• Select CustomNewWorkflow to transfer the geometry to Ansys Fluent. See the Ansys Fluent User's Guide for
more information about Customizing Workflows.

• Select Mesh to Solver to transfer the SpaceClaim mesh to Ansys Fluent. Select the appropriate options in the
Fluent Launcher.

• Select Export PMDB to save Ansys Part Manager Files (*.pmdb).

963Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Workbench



15:Meshing

SpaceClaim has interactive meshing tools that enable you to create a high-quality mesh directly on your model. The Mesh
ribbon uses the SpaceClaim tools paradigm to set up meshing parameters, generate a mesh, and interrogate the mesh
within SpaceClaim. Having the geometry and meshing tools in the same application helps streamline mesh generation
and can reduce the time it takes to create a high quality mesh on complex models. Solver context determines which
meshing options are presented to you and provides them with intelligent defaults based on physics, helping to simplify
your user experience. If connected to Workbench, the geometry and mesh is then passed to downstream systems.

Note: You cannot use SpaceClaim with meshing tools enabled as an external CAD system for direct downstream
connection to Ansys Workbench. Disable Use SpaceClaim Direct Modeler as an External CAD in Workbench
options to allow blocking mesh transfers.

Select Mesh in the Ribbon Tabs page of the SpaceClaim Options window to enable the Mesh ribbon tab.

If you read a SpaceClaim file with mesh data, the Mesh ribbon tab is enabled, by default.

The Mesh ribbon layout has tools organized as shown.

15.1. Mesh Ribbon Behavior
To get started with SpaceClaim Interactive Meshing ("Meshing"), you must become familiar with the primary meshing
tools found on theMesh ribbon. You will use these tools not only to perform common operations in a typical meshing
workflow, but also to affect how Meshing and many of its other tools behave. As you create a mesh and adjust mesh
controls to fine-tune that mesh, Meshing is able to respond immediately.

The Update tools are used to enable or disable the meshing tools and automatic updating.
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DescriptionUse this toolTo ...

With a model loaded, turnOn the Meshing tools to access
the interactive meshing tools.

Turning On the Meshing tools will adjust the way
geometry is treated by downstream systems in
Workbench so turn On the Mesh ribbon only if you want
to pass the geometry and mesh to downstream systems.
The On/Off status of the mesh ribbon is saved with your
model.

If you delete the mesh data and turn Off the Meshing
tools before saving the SpaceClaim file (*.scdoc), all
meshing data will be deleted and only geometry will be
transferred to downstream systems in Workbench.

or

On/Off

Toggle meshing tools off and on.

Meshing operates in Play mode by default, delivering
automatic, live, dynamic mesh updates each time you
complete a mesh control, change the geometry, or edit
the blocking. If you don't want Meshing to respond
immediately to changes and prefer to do several changes
prior to updating the mesh, click to Pause.

In Play mode, the mesh will update with blocking and
geometry changes. In Pause mode, the blocking will
continue to update when geometry or blocking changes
are made, but the mesh will not be updated until you
click Play.

or

Play/Pause

Toggle immediate responses in
meshing and blocking.

The Settings tools are used to determine global default parameters and to select bodies for meshing.

DescriptionUse this ToolTo ...

Meshing calculates an initial default size based on the
diagonal of the selected body, which is then used
internally to determine other size defaults based on the
selected Physics Type. See Selecting a Physics Type.

or

Physics Type

Initialize default values for many
of the global mesh options.

You will have the opportunity to accept defaults, set your
own parameters, or reuse mesh settings in the Mesh
Options panel.

See Generating the Mesh.

Add/Edit

Add bodies or faces to the queue
for meshing and activate them so
they can respond to your input.

You can choose to retain certain settings or clear them
along with the mesh data.

In certain circumstances, you use the Delete tool to
Defeature (suppress) edges or vertices before or after
the mesh is calculated.

See Using the Delete Tool.

Delete

Delete mesh data from selected
bodies or faces.

Suppress geometry or blocking
features.

Meshing provides advanced features for creating meshes for your model. Additional steps in your typical meshing
workflow such as mesh editing, inspection, and transferring to a solver are described in subsequent pages.
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15.1.1. Using the Delete Tool
The Delete tool

has multiple context-sensitive functions. You can use the Delete tool to:

• Remove Body settings and/or Local settings and controls along with any blocking and mesh that has been
generated from selected body(s) or surface(s).

• Delete selected blocks.

• Defeature (suppress) geometry edges or vertices before the blocking is calculated.

• Defeature (suppress) blocking edges or vertices after the blocking is calculated.

Removing a Body or Face From theMeshing Queue and Deleting theMesh and
Blocking Data
1. Click the Delete tool.

2. Click the Select Bodies or Select Faces tool guide.

3. Click a body or face to be removed from the meshing queue.

4. You may use the Ctrl+A key combination to select all bodies or faces, or use box select or hold the Ctrl key to
select multiple bodies or faces for removal from the meshing queue at one time. If a single body or face is selected,
the operation occurs immediately. If multiple bodies or faces are selected, the Complete tool guide is required
to complete the operation.

Note: In theGeneral Options panel, you can choose to retain certain settings, or clear them along with the
mesh data.

• Body settings refers to those body settings that were applied when using the Add tool. By default, these are
cleared with the mesh data.

• Local settings and controls refers to Size controls, Map/Sweep controls, Layers controls, Match controls, and
suppressed edges or vertices defined on selected bodies or faces. By default, these are retained.

Deleting Selected Blocks
1. Click the Delete tool.

2. Click the Select Bodies or Select Faces tool guide.

3. Click a block body or block face to delete the block object and have its mesh removed from the meshing queue.

4. You may use the Ctrl+A key combination to select all block bodies or block faces, or use box select or hold the
Ctrl key and select multiple block bodies or block faces to delete the block objects and have their mesh removed
from the meshing queue at one time.

Suppressing Edges or Vertices Before Meshing
1. Click the Delete tool.
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2. Click the Select Edges or Select Vertices tool guide.

3. Select geometry edges or points to suppress in the blocking and mesh. Suppressed edges are displayed in gray
while the Delete tool is active.

4. In the Add tool, suppressed edges will also be displayed in gray and these edges will be ignored (defeatured)
while meshing, if possible.

Note: It is not recommended to suppress edges or vertices at sharp features. In such cases, the mesher may
not be able to suppress such edges or vertices.

Suppressing Edges or Vertices After Meshing
1. Click the Delete tool.

2. Click the Select Edges or Select Vertices tool guide.

3. Click a blocking edge or blocking vertex to be removed from the meshing queue. When suppressing a blocking
edge, the attached block faces will be merged. When removing a blocking vertex, the attached blocking edges
will be merged.

4. You may hold the Ctrl key and select several edges or vertices for removal from the meshing queue at one time.
The Complete tool guide is required to complete the operation. You may also box select several vertices to be
removed from the meshing queue in one operation.

Note: If you suppress geometry edges after a blocking exists, the blocking edges do not inherit the property
automatically.

15.2. The Typical Meshing Workflow
Creating a mesh for your model typically involves the following steps:

1. Select a physics type.

The physics type sets the default values for many of the global mesh options.

2. Generate the mesh.

As you Add objects to be meshed, you set the desired Element shape, Blocking, Sizing, and Connectivity options.
You can apply certain options and settings to some bodies, and different options and settings to other bodies.

The default element shape and blocking are Hexahedral (Quadrilateral on sheet bodies) and Standard,
respectively, which creates hex elements on any sweepable, solid body and hex-dominant mesh on any
non-sweepable, solid body, within an editable blocking topology (for any body that isn't currently meshed).

3. Edit the mesh or edit the blocking.

You can add or modify local mesh controls for sizing, mapped mesh, boundary layers, or match controls to refine
or coarsen the mesh in a particular region of the model or to specify a more specific mesh pattern.

You may need to edit the blocking topology in order to convert free blocks to swept or mapped blocks to get
more hex mesh, or to better resolve or ignore a geometry feature.

4. Check the mesh.
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After the mesh is generated, you should review the Status History to see if any mesh failures have occurred. If
so, those failures should be fixed. See Fixing the mesh.

You can inspect the mesh visually or statistically to see if any adjustments are needed. See Setting mesh display
options and Viewing quality statistics.

5. Transfer the mesh.

When you are satisfied with the mesh, you can transfer it to your solver and set up the physics solution for your
study.

15.3. Selecting a Physics Type
The physics type determines the default values for many of the global mesh options.

Many of the affected defaults are related to mesh sizing. An initial default size (calc_default_size) based on
the diagonal of the selected body is calculated, but not exposed. Meshing uses it internally to determine other size
defaults as noted in the tables below.

To select a physics type:

1. On the Mesh ribbon, click Physics Type.

2. Select Structural

or Fluid Dynamics

.

If you enter SpaceClaim Meshing from Ansys Workbench or Ansys Mechanical, Structural

defaults are set automatically.

Structural Solid DefaultStructural Sheet DefaultOption

Quadrilateral Dominant, HexahedralQuadrilateral DominantElement shape

StandardStandardBlocking

2 x calc_default_size40% of calc_default_sizeElement size

1.81.8Growth rate

OffOffCurvature

4% of calc_default_size4% of calc_default_sizeMinimum size (curvature)

3030Normal angle

OffOffProximity

QuadraticQuadraticElement order

Structural (not exposed or modifiable)Structural (not exposed or modifiable)Shape checking

If you enter SpaceClaim Meshing from Ansys Fluent or select Fluid Dynamics

,
these defaults are set automatically:
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Fluid Dynamics Solid DefaultFluid Dynamics Sheet DefaultOption

Quadrilateral Dominant, HexahedralQuadrilateral DominantElement shape

StandardStandardBlocking

2 x calc_default_size40% of calc_default_sizeElement size

1.21.2Growth rate

OffOffCurvature

4% of calc_default_size4% of calc_default_sizeMinimum size (curvature)

1818Normal angle

OffOffProximity

Linear (not exposed or modifiable)Linear (not exposed or modifiable)Element order

CFD (not exposed or modifiable)CFD (not exposed or modifiable)Shape checking

Note: Regardless of physics type, if your model contains a combination of sheet bodies and solid bodies,
only common settings would be displayed (for example, Growth rate). Options that have different values
(for example, Element size) would be displayed as blank.

15.4. Generating the Mesh
Meshing provides the flexibility to apply certain options and settings selectively to some bodies or faces, and different
options and settings to other bodies or faces. The immediacy of the mesher's response is controlled byPlay/Pause

.

Meshing Objects Using the Defaults or User-Defined Settings
1. (Optional) You can accept or change the default global mesh options as you deem appropriate (SpaceClaim

Options > Mesh Options).

2. (Optional) If desired, on the ribbon, click Play/Pause

.

To change any of the default options and settings, or to apply options and settings selectively to geometry, you
should Pause automatic updates.

3. On the ribbon, click Add/Edit

.

4. Modify any settings in the Mesh Options panel.
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a. (Optional) Set the desired element shape and order. You can use the default Element shape for surface and
volume elements, or choose another mesh element shape. You can also modify the Element order or use
the default.

b. (Optional) Set the desired element sizing options. You can use the default settings forElementsize,Defeature
size, Growth rate, Curvature, and Proximity or change these values.

c. (Optional) Set the desired blocking technique. You can use the default settings for Blocking, Connect
tolerance, and Block Material or change these values.

5. Select a tool guide to set the meshing context, which provides additional filtering of available options and settings:

970Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Meshing



Do this...To...

Use the Select Bodies tool

guide.

Mesh bodies

Use the Select Faces tool guide.Mesh faces

Note: In some situations it may be useful to selectively mesh the faces of your model before converting
the surface mesh to a solid mesh. Where a surface being meshed shares an edge with a previously meshed
surface and within the specified Connect tolerance, the mesh is made conformal. You can iteratively
mesh one or more faces and edit the meshes until the entire surface is meshed, then use the right mouse
button context menu on Blocking in the Structure tree to Solidify the blocking and mesh.

6. Select the object(s) that you want to mesh with the currently defined options and settings:

Do this...Tomesh...

Click a body or face to select it.A single object

Select a group of bodies or faces.Multiple objects

Press Ctrl + A to select all of the bodies or faces.The entire model

7. (Optional) In certain situations, you may want to select source and target imprint surfaces

.

8. When all settings are satisfactory, click Complete

.

In Play mode, when you click Complete, the selected objects are blocked and the mesh is calculated.

In Pause mode, the selected objects are blocked when you click Complete, but you must return to Play mode
to generate the mesh.

Meshing Objects Using Settings From a Previously Meshed Body
1. (Optional) If desired, on the ribbon, click Play/Pause

.

To change any of the settings, or to apply options and settings selectively to geometry, you should Pause
automatic updates.

2. On the ribbon, click Add/Edit

.

3. Select the previously meshed body from which you want to reuse similar settings. Settings for that body are
displayed in the Mesh Options panel.
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4. Now select the body(s) that you want to mesh using the settings as defined in the previous step.

5. (Optional) Modify any setting as you deem appropriate.

6. (Optional) In certain situations, you may want to select source and target imprint surfaces

.

7. When all settings are satisfactory, click Complete

.

In Play mode, when you click Complete, the selected objects are blocked and the mesh is calculated.

In Pause mode, the selected objects are blocked when you click Complete, but you must return to Play mode
to generate the mesh.

Editing the Mesh Settings on a Body(s)
1. (Optional) If desired, on the ribbon, click Play/Pause

.

To modify options and settings selectively to geometry, you should Pause automatic updates.

2. On the ribbon, click Add/Edit

.

3. Select the previously meshed body for which you want to modify settings. Settings for that body are displayed
in the Mesh Options panel.

4. Modify any setting as you deem appropriate.

5. When all settings are satisfactory, click Complete

.

In Play mode, when you click Complete, the selected objects are blocked and the mesh is calculated.

In Pause mode, the selected objects are blocked when you click Complete, but you must return to Play mode
to generate the mesh.

15.4.1. Selecting an Element Shape and Order
The Element shape determines the mesh type for the selected bodies or faces. In addition to shape, the Element
order is used to determine the element type that will be used for Mechanical simulation. For Fluids simulations the
Element order is always linear, and this option is not shown.

For sheet models, it is generally recommended to setElementshape toQuadrilateralDominantorAllQuadrilateral
elements to improve solution accuracy. Setting the Element order to Linear is generally sufficient, but in some
nonlinear cases you may prefer to use Quadratic shell or 2D axisymmetric elements. The default for Mechanical
physics preference is Quadratic, however, you may want to change this default.

For solid models, you should consider whether you want a more regular or uniform mesh or if the geometry is
stretched (anisotropic). If yes for either and the model is sweepable, it is generally recommended to use a hexahedral
mesh, otherwise a tetrahedral mesh is recommended. You can also use a combination of element shapes. For
example, a hybrid mesh that contains hexahedrons in anisotropic or critical areas and tetrahedrons in other areas
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is often ideal. For Mechanical simulations, generally a Linear hex mesh is sufficient, but a Linear tet mesh is not
recommended. For this reason you may want to decide upfront whether a part will be meshed with all hex elements
(in which case set Element order to Linear instead of the defaultQuadratic), or meshed as a hybrid hex/tet or with
all tet elements (in which case use the default Element order of Quadratic).

You can change the default global settings for Element Order and Default Free Mesh Type under Mesh Options.

Selecting the Element Shape
Go to the Mesh Options panel and click the icon that represents the required Element shape.

ConsiderationsDescriptionOption

• Preferred default for surface mesh for most structural use
cases.

• When solid meshing, the free faces of swept blocks will use
this option.

• When solid meshing, the free faces of free blocks will use this
option. This will force pyramids to be created in the free blocks
which may not be recommended for your solver.

Generates a mostly
quadrilateral mesh on sheet
bodies. On solid bodies, this
option will be used in the
generation of the surface
mesh of the free faces of the
solid.

Quadrilateral
Dominant

• Intended for use in special cases where you want to force an
all-quad mesh on select parts or areas.

• When solid meshing, the free faces of swept blocks will use
this option.

• When solid meshing, the free faces of free blocks will use this
option. This will force pyramids to be created in the free blocks
which may not be recommended for your solver.

Generates an
all-quadrilateral mesh on
sheet bodies. On solid
bodies, this option will be
used in the generation of the
surface mesh of the free
faces of the solid.

All Quadrilateral

• Intended for use in surface meshing for solids when trying to
avoid pyramids.

• For example,

º If you set Element shape = Triangle & Tetrahedral and
Blocking = Free, then you will get an all tetrahedral mesh
on a solid body.

º If you setElementshape= Triangle andBlocking= Standard
or Aggressive, and you mesh a sweepable body, then the
swept block will be filled with all wedges (prisms).

º If you have a swept block and a free block with a shared
interface, and that face is meshed with Element shape =
Triangle, then no pyramids would be generated (only tets
and wedges (prisms)).

Generates an all-triangle
mesh on sheet bodies. On
solid bodies, this option will
be used in the generation of
the surface mesh of the free
faces of the solid.

Triangle

• This option is only used for solid, free blocks.
• Other solid blocks (swept and mapped) will always be meshed

with hexahedral elements and wedges (prisms).
• SetBlocking to free if a tetrahedral volume mesh is required,

or convert swept and/or mapped solid blocks to free if you
want them to be filled with tetrahedral elements.

Free blocks will be filled with
a tetrahedral mesh. The
boundaries are controlled by
the surface element shape
option (Quad Dominant, All
Quad, or All Tri). See those
options above and Selecting
a Blocking Technique.

Tetrahedral
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ConsiderationsDescriptionOption

• This option is only used for solid, free blocks.
• Other solid blocks (swept and mapped) will always be meshed

with hexahedral elements and wedges (prisms).
• Set Blocking to free if a Hex Dominant mesh is required, or

convert swept and/or mapped solid blocks to free if you want
them to be filled with a hex dominant free mesh.

Free blocks will be filled with
a hexahedral dominant
mesh. The boundaries are
controlled by the surface
element shape option (Quad
Dominant, All Quad, or All
Tri). See those options above
and Selecting a Blocking
Technique.

Hexahedral

Selecting the Element Order
TheElementorderoption specifies whether the mesh should be generated with midside nodes (quadratic elements),
or without midside nodes (linear elements). You can choose the following options:

• Linear

( )
- The mesh will be generated without midside nodes on any elements.

Example (click to enlarge)

• Quadratic

( )
- The mesh will be generated with midside nodes on all elements.

Example (click to enlarge)
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Note: The blocking mesh will use a linear mesh for display purposes. You may notice that the element shape
looks linear and that blocking mesh quality checks use this linear mesh. To evaluate quality and visualize
the quadratic shape, go to the Quality Metrics panel and turn on High Fidelity.

15.4.2. Setting Sizing Options
When creating a mesh, you can use the settings in the Mesh options panel to define the global element sizing and
behavior for an object, a group of objects, or the entire model. Depending on the meshing context that you select,
you can define settings for solids, surfaces, or both.

The following settings define the global element sizing and behavior:

• Element size

The Element size is the maximum size of element to be generated. This setting drives the mesh seeding of the
volume or surface mesh.

• Defeature size

By default, mesh-based defeaturing is applied automatically to exclude small features and dirty geometry from
the mesh. Any features smaller than or equal to the Defeature size are ignored when the mesh is generated. You
can use the default setting, define your own Defeature size, or turn off defeaturing globally or selectively.

• Growth rate

The Growth rate controls the increase in edge length with each succeeding layer of elements. For example, a
growth rate of 1.2 results in a 20% increase in element edge length with each succeeding layer of elements. The
growth rate is primarily used when using tet mesh in free blocks.

• Growth height

The Growth height specifies the first height of elements coming away from the selected face into the volume.

Applying Mesh-Based Defeaturing
To apply mesh-based defeaturing, do one of the following:
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Do this...To...

Retain the Automatic setting.

Various topology and meshing settings influence the
behavior. To force capturing a particular feature, create
a Named Selection for that topology.

Use program-controlled defeaturing

Click the Defeature size text box and enter a tolerance
value.

If you set the tolerance too high, some bodies or parts
may not be meshed properly. You may have to iterate to
find a reasonable value, and it may help to mesh different
parts with a different defeature tolerance.

If you enter 0 or Off, defeaturing is disabled (and the
text box will display Off). Enter -1 or Auto or
Automatic to apply program-controlled defeaturing
(and the text box will display Automatic).

Enter your own global defeaturing tolerance

Click the Defeature size text box and enter 0 or Off.Turn off defeaturing

You can use the Delete tool to override Automatic
defeaturing or global defeaturing on selected edges or
vertices, either before or after the mesh is generated.

See Using the Delete Tool.

Apply defeaturing selectively to edges.

Understanding the Effects of Curvature and Proximity Settings
If neither Curvature or Proximity is activated, the mesher ignores the aspects of surface curvature and local
proximity. In general, a uniform mesh should be generated in such cases, however, in some cases the mesher may
use biasing in order to match edges meeting at a common vertex. This matching is done to avoid high aspect ratio
elements.

Note: To remove the biasing due to corner matching use the Size tool, select the edges you want to adjust,
select Use element size, select No Bias and Accept.

If you want the mesher to better respect curvature or proximity, these options can be activated and work as follows:
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• Curvature: Surface curvature is computed by finding the angle between normals of adjacent elements. The mesher
reduces the mesh size in the areas of curvature to the Minimum size when possible. Situations that may prevent
the mesher from capturing the curvature include the following:

º The Normal angle will limit refinement. Thus, once the mesh has been refined such that all angles between
normals for adjacent mesh elements is smaller than the defined angle, the refinement will stop even if the
Minimum size has not been reached.

º Mapped mesh takes priority over curvature-based refinement. That is, if the software can either get a mapped
(swept) mesh or a refined mesh capturing curvature, then mapped meshing will take priority. This could lead
to the mesh being refined in one direction of a mapped face but not in both directions.

• Proximity: Proximity of thin regions is computed. The mesher tries to enforce the defined number ofCells across
gaps when possible. Situations that may prevent the mesher from capturing the proximity include the following:

º TheMinimumsizewill limit refinement. For example, if a 1 mm gap is found and you have setCells across gaps
to 3 andMinimumsize to 0.5, then you should only expect 2 cells in the gap. In this situation, the recommendation
would be to set Minimum size to something slightly smaller than 0.5 (such as 0.49) just to be safe.

º Mapped mesh takes priority over proximity-based refinement. That is, if the software can either get a mapped
(swept) mesh or a refined mesh capturing proximity, then mapped meshing will take priority.

Computing the Size Function
By understanding how the size function is computed, you can more effectively apply the most appropriate sizing
options to the objects in your model.

When meshing begins, the mesher computes the size functions as follows:

1. The mesher examines each of the size sources:

• Edge and face curvature, based on the normal angle variation between adjacent mesh elements in surface
(edge) or solid (face) bodies

• Edge and face proximity, based on the number of element layers created in a gap between edges (in surface
bodies) or between faces (in solids bodies)

• Local element sizing on selected edges, faces, or bodies

• Influence of a swept body

2. Based on the smallest size obtained at the location of the sources, the distance to each source, and the growth
rate, the smallest size at each point is selected and stored in a background grid.

3. The mesher uses the sizes from the background grid to generate a mesh.

The background grid is refined automatically to provide size distribution to the mesher.

Generating a UniformMesh
By default, Curvature and Proximity options are off which should produce a mostly uniform mesh. This is the
general recommendation for hex meshing.

You can also deselect Bias edge sizes tomatch small edges (enabled, by default) to obtain a uniform mesh by
removing biasing to match small edges. This option is available as a global option under Mesh Options.

You may want to specify anElement sizeandDefeaturesizeand gradation will be provided between sizes, including
local size controls, based on the specified Growth rate. Alternatively, you can accept the defaults. To further refine
the mesh with local sizing, use the Size control either prior to meshing or after meshing.
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Applying Curvature Sizing
You can apply curvature sizing if you want the mesh size to be refined based on the curvature in the geometry.

The curvature size function examines curvature on edges and faces and computes element sizes on these entities
such that the size will not violate the maximum size or the curvature normal angle. The curvature normal angle is
the maximum allowable angle that one element edge is allowed to span.

To apply curvature sizing:

1. Set the desired Element size and Defeature size, or use defaults.

2. Select the Curvature check box.

3. For Minimum size, set the minimum size of element to be generated when curvature is calculated.

4. For Normal angle, set the maximum allowable angle that one element edge is allowed to span.

A default curvature normal angle is computed automatically. To override this value, enter a value between 0 and
180 degrees.

You can use theNormal angle to limit the number of elements that are generated along a curve or surface if the
minimum size is too small for that particular curve.

Example: How the Normal Angle Controls Element Placement
The following figure shows a curved region with a normal angle of α = 45°. If the curvature were extended to 360°
to create a circle, the normal angle is the arc span from the center of the circle to the curved region. Three arc
spans are needed to span the entire curvature, which results in three elements placed along the curvature: one
in each arc span.

Applying Proximity Sizing
The proximity size function enables you to specify the minimum number of element layers created in regions that
constitute "gaps" in the model. A gap is defined as either:

• The internal volumetric region between two faces

• The area between two opposing boundary edges of a face

The proximity size function does not recognize the proximity between certain entities in cases involving voids in a
model. For example, the proximity between a vertex and an edge on a face is ignored if the triangle is a void in the
rectangle.

Similarly, the proximity between a vertex or edge and a face on a solid is ignored if the prism and the block are voids
in a larger domain.
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To apply proximity sizing:

1. Set the desired Element size and Defeature size, or use defaults.

2. Select the Proximity check box.

3. If thePhysics Type is set to Fluid Dynamics, select aDirection to check for proximity: Inwards,Outwards, or
both.

4. For Minimum size, set the minimum size of element to be generated when proximity is calculated.

5. For Cells across gaps, set the minimum number of layers of elements to be generated in gaps.

You can specify a value from 1 to 100, or accept the default.

This value is an estimate, and it may not be applied precisely in every gap. If you have defined mapped mesh
controls, interval assignment may change the number of divisions (that is, elements) in a gap.

6. ForProximity size function sources, choose whether you want edges, faces, or both to be sources for proximity
size function calculations:

• Select Edges if you want edge proximity to be considered. Resolving all edges as much as possible provides
better feature capture and minimizes non-manifold nodes. For many models, selecting this option sufficiently
resolves all proximity situations.

• SelectFaces if you want face proximity to be considered. If you selectFacesbut do not selectEdges, face-edge
and edge-edge proximity are not considered (for example, the trailing edge of fluid around a wing will not be
captured with this setting). The face normal orientation is ignored during the proximity calculation. For large,
complex models, this setting may result in longer computation time.

Global Boundary Layer Options
In addition to these options available in the Mesh Options panel, you can set global default values for Boundary
Layers. Go to the SpaceClaimOptionswindow and selectMesh to adjust globalBoundaryLayersDefault Settings.

Then, if you create a local boundary layer control, the local control will inherit these global preferences unless any
of its settings differ, in which case the local settings override the global preferences.

See Mesh Options.

15.4.3. Selecting a Blocking Technique
Generating a good quality mesh closely associated to the geometry requires blocking the model into sweepable,
easier-to-mesh regions and filling the regions with the appropriate mesh elements. Options for such decomposition
include the following:

• Geometry decomposition is done manually at the geometry level before meshing usingSplitBodyand other tools
to prepare the geometry for meshing. For simple models, identifying sweepable regions is very intuitive. As the
model complexity increases the process tends to become more iterative.
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• Blocking decomposition uses the software to identify sweepable regions automatically during meshing, and then
generate a blocking topology that could consist of Mapped, Swept, or Free blocks (regions). See Blocking types.
You may edit such a blocking topology using block editing tools to convert free blocks to swept or mapped, and
to improve mesh quality.
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• Bounding box decomposition uses the software to create a single, mapped block from the bounding box, and
then fills the block with all hexahedral elements. You then use block editing tools to sculpt the blocking topology
to the geometry.

• You can also reload a previously created and saved blocking topology. The software will attempt to associate the
blocking topology to the geometry.

Selecting the Blocking Technique
In the Mesh Options panel, select a Blocking technique to use in meshing the model.

Description...Select...To...

This decomposition uses tetrahedra for
the free blocks, hexahedra for the
mapped blocks, and hex-dominant
(Mechanical) or all-hexahedra (Explicit,
beta) for the swept blocks.

All non-sweepable/non-mappable blocks
are free meshed without any further
decomposition.

Blocking = AutomaticGenerate the mesh using
automatic decomposition.

This option should generate an all
tetrahedral mesh, plus it will generate
one free block (volume) for the entire
body. Block editing tools are available
for advanced defeaturing or model
cleanup if meshing fails.

Element shape = Tetrahedral

and Triangle

Blocking = Free

Generate a tetrahedral mesh in
a single, editable block.
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This option will generate a hex dominant
mesh on the entire body. It will generate
one free block (volume) for the entire
body. Block editing tools are available
for advanced defeaturing or model
cleanup if meshing fails.

Element shape = Hexahedral
,

and Quadrilateral Dominant

or All Quadrilateral

Blocking = Free

Generate a hex dominant mesh
in a single, editable block.

The software first attempts to create
swept mesh with source faces meshed
as triangles (volume elements are
prisms/wedges). Any region that cannot
be swept is meshed with a tetrahedron
mesh (Free block).

If swept and free blocks share a common
interface and the interface is a source
face to the swept mesh, then no
pyramids will be created. If swept and
free blocks share a common interface
and the interface is a side face to the
swept mesh, then pyramids will be
created in the free block.

Element shape = Tetrahedral

and Triangle

Blocking = Standard

Generate a MultiZone mesh
with editable blocking
topology, where sweepable
regions are filled with a prism
(wedge) mesh and
non-sweepable (free) regions
are filled with tet volume mesh.

This option is similar to Standard, but
the software tries to generate more
mapped faces.

Element shape = Tetrahedral

and Triangle

Blocking = Aggressive

The software first creates mapped, then
swept, then free blocks as possible. A
higher proportion of mapped blocks
results in a higher proportion of
hexahedral mesh.

For sweepable models, all blocks that
are created should be mapped or swept.
For models where the blocking is not
straightforward, free blocks with a
combination of free and mapped faces
are created on the non-sweepable
regions.

Element shape = Hexahedral
,

and Quadrilateral Dominant

or All Quadrilateral

Blocking = Standard

Generate a MultiZone mesh
with editable blocking
topology, where sweepable
regions are filled with a hex
mesh and free regions are filled
with hex-dominant volume
mesh.

This option is very similar to Standard,
but the software tries to generate more
mapped faces. For some cases this may
help create more mapped or swept
blocks. In other cases, it may not help
with the blocking, but it may result in
more mapped faces attached to free
blocks.

Element shape = Hexahedral
,

and Quadrilateral Dominant

or All Quadrilateral

Blocking = Aggressive
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This top-down approach creates a single,
mapped block from the 3D bounding
box. You then use block editing tools
such as split, merge, move, and associate
to shape the blocking topology to the
simulation model.

Blocking = Bounding BoxGenerate an all hexahedral
volume mesh in a single,
mapped block requiring manual
block editing.

This approach works best for geometries
that are axis aligned. The approach is to
generate a Cartesian mesh, convert that
Cartesian mesh to sweepable topologies
and smooth it out. Next you can use the
block editing tools to improve the mesh.

Blocking = CartSweepGenerate a hex-dominant
volume mesh for axis-aligned
geometries.

This approach works best for meshing
geometries recognized as having
thin-walled solids, as an alternative to
using the typical approach with
Standard blocking. The software first
detects sweep source and target
surfaces. Then the 2D blocking is created
on the source surfaces, and finally pulled
to 3D and associated to the target
surfaces in an automatic fashion.

Blocking = ThinSweepGenerate a hexahedral mesh for
geometries recognized as
having thin-walled solids.

This option is useful when you with to
reuse a blocking topology on a modified
geometry. After selecting Load, you will
select the geometry to which the
blocking topology is associated and then
click Complete. A window opens to
select the blocking file.

The software will attempt to associate
the blocking topology to the selected
geometry and generate the mesh. Some
manual repair and blocking
disassociation/reassociation may be
necessary.

You can enable Improve Association, if
required. This option is disabled by
default. When the ImproveAssociation
option is enabled, the blocking edge to
curve associations are improved when
the blocking is loaded.

Blocking = LoadReuse a previously saved
blocking topology file (*.blk).

Notes:

• When the initial mesh and blocking topology are computed, you will see Blocking objects in the Structure tree.
For details, see Understanding the blocking structure.

• If creating a blocking on multiple parts and using the Blocking = Free, Standard, or Aggressive options, the
Connect tolerance option will be used to keep the mesh conformal between parts. For more information see
Conformal Meshing between Bodies.

• You can perform manual mesh and block editing using tools described in Edit the mesh and Edit the blocking.
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• In some situations it may be useful to selectively mesh the faces of your model before converting the surface mesh
to a solid mesh. Where a surface being meshed shares an edge with a previously meshed surface and within the
specified Connect tolerance, the mesh is made conformal. You can iteratively mesh one or more faces and edit
the meshes until the entire surface is meshed, then use the right mouse button context menu on Blocking in the
Structure tree to Solidify the blocking and mesh.

Setting the Connect Tolerance
As an alternative to creating shared topology, you can set theConnectTolerance to an appropriate value to remove
gaps between bodies and generate conformal mesh.

The Connect Tolerance is a relative tolerance that varies from 0 to 1. Given a set of vertices to merge, the value is
dependent on the smallest attached edge to the two vertices. The default Connect Tolerance is 0.02 or 2% of the
smallest edge length attached to the 2 vertices to be connected.

Note:

• All bodies to be connected should be in the same component or at the root level, else separate blockings
are created.

• When merging blockings, they are connected with the default connect tolerance, so a similar approach
would be to mesh parts separately and later merge the blockings.

• Increasing the connect tolerance will connect larger gaps but could create additional problems.

• Since the tolerance is relative, it can be different for each pair of vertices to be connected.

• After meshing it is best to view the edge/face connectivity to ensure the blocking has the expected shared
topology.

See Setup for conformal mesh using Connect tolerance for details.

Setting the Block Material
Select the appropriate option for theBlockMaterial. TheBlockMaterial is set toBody, by default, where the block
materials are assigned based by the body.

You can also select Component such that block materials are assigned by the component. You can use this option
so that all bodies in a multi-body part would be in the same material (body when transferred to Ansys Mechanical).

The following examples show the difference in the blocking structure in SpaceClaim and in downstream systems
(like Mechanical) when the Block Material is set to Body or Component.

Model Tree - MechanicalStructure Tree - SpaceClaim
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Block Material - Body
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Block Material - Component

15.4.3.1. CartSweep Method
The CartSweep approach works best for geometries that are axis aligned. The approach is to generate a Cartesian
mesh, convert that Cartesian mesh to sweepable topologies and smooth it out. Next you can use the block editing
tools to improve the mesh.

• For hex meshing complex models that have features oriented along the global coordinate system, as in the example
below, the highlighted faces are found as source faces for swept blocks.
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In such cases, you may split the geometry in two and mesh the two parts separately, and then merge the blocks
together afterwards. Here the model can be split into three bodies. The two bodies are meshed separately using
theCartSweepoption and the middle body is meshed using theStandardoption. Then the blockings are merged
to get the mesh.

• For non-aligned geometries, you can define the sweep direction by selecting a face normal to the sweep direction.
Use the Select Source/Target Faces tool guide to set the sweep direction.

Note: Non-aligned geometries may require additional sizing adjustments as compared to those aligned
to the global coordinate system.

• You can set up a mapped mesh control on the source face to create all mapped blocks with theCartSweepmethod.

Performance (time of mesh generation) is dependent on two main steps:

• Time to generate the Cartesian mesh is dependent on the element size, Cartesian size and tolerance.

• Time to convert from Cartesian to sweepable topology is dependent on the number of topological blocks/bodies
created. Many stairsteps can slow things down so setting reasonable sizes and defeaturing non-axis-aligned
features helps improve performance.

When setting up the model, ensure that the sizes specified are appropriate for capturing the features.

Unlike other mesh methods, reducing the Element size may cause the mesh to fail. Setting appropriate sizes is key
to obtaining a good mesh.

• Use Element size to define the final mesh sizes.

• Use Cartesian size to define the size above which features are captured in the mesh. Defeaturing is done based
on Cartesian size:

º Set an explicit Cartesian size to define the size that the Cartesian mesher will use to capture features. Use a
smaller Cartesian mesh size to capture features without increasing final mesh size.

In the example, the Element size is 4 mm, while a Cartesian size of 1 mm is used to capture the gap.
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Alternatively, a smaller Element size can be used to capture the gap.

º Set0 to disable defeaturing. This uses a slightly different approach to calculating the Cartesian mesh size (using
key point blocking).

º Set -1 for Automatic where the Cartesian size is the same as Element size.

• There are two options to control the Grid Spacing in the Cartesian mesh.

º Uniform size - This option will split the model uniformly based on the specified Cartesian size.

º Key-point splits - This option will split the model at the feature points with the specified tolerance in between
the feature lines.

TheKeyPoint tolerance is applied to the Cartesian size. Use aKeyPoint tolerance of0.5or 0.1. If the mesh
is not as desired, vary the Cartesian size instead.

Note:

• Removing fillets/chamfers can help improve success of meshing.

For models with fillets/chamfers, you can simplify the geometry by removing the fillets/chamfers, or drafts,
and then generate the mesh. Then, you can use the Load option to load the blocking for the simplified
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model over the full-featured model. Generate the mesh and use the editing tools to clean up the mesh to
re-use with the original geometry.

• For simple models, you can apply sizing and boundary layer controls before generating the mesh. For
complex models, you should use sizing and boundary layer controls after generating the initial blocking
and mesh.

• For selective meshing workflows, first mesh the bodies using the CartSweep method and then proceed
to mesh the other bodies. The CartSweep method does not support pre-meshed adjacent bodies.

• The Cartsweep method may not work well with shared topology.

• Planar surface patches can be preserved with the CartSweep method by creating Named Selections for
protecting topology. The Named Selections should include ''protected'' (case-insensitive) at the beginning
or as a prefix to the name (for example, PROTECTED-SIDE, ProtectedFaces, protected-outlet).

The example shows a mapped mesh control defined on the source face to create all mapped blocks. The
planar surface patches have been preserved by creating Named Selections.

15.4.3.2. ThinSweep Method
The ThinSweepmethod can be used to mesh geometries recognized as having thin-walled solids, as an alternative
to using the typical approach with Standard blocking. The software first detects sweep source and target surfaces.
Then the 2D blocking is created on the source surfaces, and finally pulled to 3D and associated to the target surfaces
in an automatic fashion.

989Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Meshing



To set up the model:

• Select ThinSweep in the Blocking drop-down list.

• When setting up the model, you can leave the Thickness value set to 0 for the software to identify the thickness
automatically.

Note: Automatic thickness detection may not work in some cases such as when bodies have slanted side
faces or conical faces.

The software can handle some variation in the thickness like the example below. For models with varying thickness,
specify a Thickness value slightly more than the maximum thickness of the model.
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• Set an appropriate value for Number of Divisions to control the number of elements across the thickness.

• (Optional) Use the Select Source/Target Faces tool guide to select the sweep surfaces. If you select the sweep
source (top) and target (bottom) surfaces, the Thickness value is not used.

Note: In general, the software attempts to automatically recognize the source, side and target faces, then
meshes the source set of faces and pulls the sheet blocking to the target set of faces. If the source, side,
and target faces cannot be detected correctly, you will see a warning message. In this situation you need
to select the source/target faces manually:

º When nothing or only one side of the solid is selected, the following priority is used to determine which
(non-thin) side of the solid is a sweep source:

1. manually selected faces

2. shared faces or faces with input mesh

3. non-smooth faces

4. faces containing more features

5. faces with the largest area

The software will then attempt to automatically determine the side faces and remaining faces are the
target set of faces.

º Alternatively, select the source and target set of faces as the source faces. This should be two sets of
connected faces. The remaining faces will be treated as side faces.

Limitations:

The ThinSweep method has the following limitations:

• This method is not yet fully supported for shared topology or Selective meshing.

• This method may not respect features on the target faces that are not present on the source faces. Double-sided
imprinting (for example, boundary-connected imprinting or imprinting of intersection loops) is not fully supported,
so in such cases features on the target faces may be ignored.

15.4.3.3. Blocking Types
When a blocking topology is created, the type of block is classified as Mapped, Free, or Swept:
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• Mapped, or structured, blocks will have an equal number of nodes on parallel edges. Mapped blocks are filled
with an all hexahedral mesh (3D) that is interpolated from mapped faces. For surface blocking, all quadrilateral
elements are created.

• Free, or unstructured, blocks may have a different number of nodes on parallel edges. A free volume block may
be filled with a tetrahedral or hex-dominant mesh. A free volume block's faces can be mapped, free, or a combination
of mapped and free.

• Swept blocks have free (unstructured) source and target faces opposite each other, and mapped faces on the
perpendicular sides between. They are filled with an all hex and/or prism mesh that is interpolated between the
source and target faces.

VolumeSurfaceBlock Type

Parallel edges are mapped,
containing equal number of nodes.

Opposite sides are mapped,
containing equal number of nodes.

Mapped / Structured

Mapped in only one direction
between source and target faces.

N/ASwept

All edges are free from mapping (even
if quad or hex elements)

All edges are free from mapping (even
if quad or hex elements)

Free / Unstructured
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The blocking technique and resulting block type determines the volume and surface elements of the mesh. Editing
a blocking describes the tools you can use to improve the blocking topology and mesh.

15.4.3.4. Conformal Meshing Between Bodies
Bodies in SpaceClaim are a connected set of faces with the following properties:

• There may be single-connected edges (not shared with other faces), in which case the body is considered to be a
sheet body.

• If all edges in the body are shared by two faces, the body is considered to be a (manifold) solid body.

• A body may represent a part for simulation, a material for simulation, or a region of a part or a material.

• In some cases, a solid is split up (decomposed) to aid in meshing. You may wish to split a body into sweepable
regions or to identify a region that is treated differently in the simulation (for example, to identify a weld region).

In cases where a body represents a connected part or material for simulation, there is often no need to have conformal
mesh between it and other bodies. These types of parts are sometimes referred to as a single-body part. That is, the
part equals the body. In more complex cases, you will have multiple bodies that require conformal mesh between
these bodies. There are several ways to ensure conformal mesh for such multi-body parts.

• You can use Share Topology to find interfaces between bodies.
• You can use Connect tolerance in the Add tool.
• You can use the Merge tool and other block editing techniques.

Ensuring Conformal Mesh Using Share Topology
The Share tool, on the Workbench ribbon, is used to find common interfaces between bodies based on a tolerance.
When shared topology is found, or defined, for a model, the mesher will generate a conformal mesh at the common
interface between bodies. See Share Topology for details.
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The following notes are helpful when using shared topology to generate a conformal interface mesh between bodies:

• All bodies that share topology should belong to a common component. In this situation, the component represents
the part and the bodies represent separate materials or regions of the part (that is, a multibody part).

• Each body could have its ownMap/Sweep control with locally-defined source faces to help with generating a hex
mesh.

• Share Topology is intended to be the last geometry-editing operation in the model, which creates some limitations.
For example, the following operations do not maintain shared topology:

º Assembly tools
º Mirror
º Patterns
º Split, Pull, Move, etc. operations may work if they don't affect the topology at the shared interfaces, but in

general these operations are not supported.
º Move to another component

If you plan to modify the geometry after meshing, another approach to getting a conformal mesh may be preferable.

• If you must edit the geometry after meshing, you may be able to use Share prior to mesh generation (to ensure
conformal interfaces), and then use Unshare after mesh generation. The following notes are helpful when using
Unshare after meshing:

º The blocking topology would not change. In this case, the shared block faces and mesh would stay conformal.

º The blocking associations will be updated automatically when geometry is unshared. These associations are
based on projection to the closest geometry and may need to be fixed manually. Use the Associate tool to fix
these associations.

Setting Up Conformal Mesh Using Connect Tolerance
The Connect tolerance option in the Add tool is used to setup conformal mesh without using Share topology. The
software expects there to be duplicate faces at locations where a conformal interface mesh is desired.

Bodies to be connected should have common imprints. You can use the Imprint tool to ensure faces have the same
footprint. If, for example, a small box is sitting on a large box, the face of the large box in common with the small
box should be imprinted to ensure similar topologies to be connected.

The imprinted face on the large box should also be marked in a named selection or you should disable defeaturing
so that the topology is not removed during meshing (prior to connecting).
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The following notes are helpful when using Connect tolerance for conformal interface mesh between bodies:

• All bodies with a conformal mesh requirement should be in a common component. In this situation, the component
represents the part and the bodies represent separate materials or regions of the part (that is, a multibody part)

• Each body could have its ownMap/Sweep control with locally-defined source faces to help with generating a hex
mesh.

• Use the Mesh Display options for Edges and Faces connectivity to help visualize the connected regions after
meshing.

Creating Conformal Mesh Using Merge Tools
You can create conformal mesh between bodies by first meshing the bodies, or parts, separately and then assembling
the blocks together using Merge Blockings and/or the Merge tool.

• Merge Blockings: If parts are meshed separately, each part will have a Blocking object in the Structure tree. If
you select two or more such Blocking objects in the Structure tree, and then RMB >MergeBlockings, the software
will do two things:

º It will combine all the blocks under the two or more separate blocking objects into a single Blocking object.
º It will attempt to merge together those interfaces that are close to one another.

After using Merge Blockings, you should use the Mesh Display options for Edges and Faces connectivity to help
visualize the connected regions after meshing.

• Merge tool: If all vertices of a face are paired and merged with similar vertices on an adjacent face, the interface
will become common to both attached blocks. See Merging block volumes, surfaces or vertices.

15.4.3.5. Meshing Assemblies
SpaceClaim supports assemblies of design components created in SpaceClaim or another application. You can also
insert another design created in SpaceClaim or another application as a component of your design. The design is
inserted as an external component, linked to the external file.

For assemblies of components where the mesh need not be conformal between the components (no Shared
Topology), you can generate and edit the mesh for an external document in the current assembly. Any mesh change
to the component file is reflected both in the component file and also in the assembly. Components in the Assembly
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can also be replaced with already meshed components. You can choose to mesh at the primary assembly level or
mesh individual components.

To mesh external documents at the primary assembly level, ensure that the Loadmodel in background option is
disabled in the general file options. Select the components to mesh and set the meshing options as appropriate.
When all settings are satisfactory, click Complete

.

Alternatively, open each part as a separate component, generate the mesh, and then close the part. To mesh
individual components:

• Right-click a component and select Open Component to open the selected component in a new design window.

• On the ribbon, click Add/Edit

.
Select the objects to mesh and set the meshing options as appropriate.

• When all settings are satisfactory, click Complete

.

• Save the modified component and close the design window. Return to the assembly model.

The Blocking is saved to the External model.

15.5. Editing the Mesh
After the blocking topology and mesh are created, you can inspect the mesh and blocking, and use the editing tools
to adjust the mesh and blocking to improve the quality, mesh distribution, structure and/or connectivity of the
mesh.

Do this...To select...

Triple-click the body in the design window.

Click the body name in the Structure tree.

Hold Ctrl to select multiple bodies.

Bodies

Click the face.

Double-click to select a group of connected faces.

Hold Ctrl to select multiple faces.

Faces

Click the edge.

Double-click to select a loop of edges. If the selected edge
is in more than one loop, repeated double-click will step
through the possible loops.

Hold Ctrl to select multiple edges.

Edges

Press Ctrl + A.The entire model
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Do this...To select...

1. In the Structure panel, click Selection.
2. Select an object in the design window. The Selection

panel offers a list of related objects as search criteria.
3. Select a search criterion from the drop-down list.

Objects that meet the selected criterion will be
highlighted in the design window.

Objects based on search criteria

Tip: With Blocking there can be several objects displayed. You may prefer to turn off Smart Selection and
limit the Selection Filter to the object type you wish to pick. See Status Bar.

Editing the Mesh and Blocking
You can edit the mesh and blocking in the following ways:

• Mesh settings are available in the Mesh Options panel when one or more objects is selected. You can update the
values for your selected objects. Changes are applied and the selected object(s) is remeshed when you click
Complete. For more information, see Update the mesh settings.

• You can modify the mesh on a particular region in the model using local mesh Controls. For example, you can
create finer mesh on only one face of an object or add boundary layers for fluid flow analysis. For more information,
see Managing local mesh controls.

• You can edit the blocking topology independently of the geometry. Common reasons to edit the blocking topology
are to make the blocking topology more closely conform to the geometry, to simplify the blocking, and to improve
feature capture. For more information, see Edit the blocking.

Mesh Propagation After Geometry Changes
When a mesh and blocking exists, the blocking is associated to the geometry. When the geometry changes, the block
associations dictate how the blocking and resulting mesh will be updated. For the following geometry operations,
the blocking updates and mesh propagation work as follows.

Note: Only the most commonly used tools are described here. Other tools behave similarly to the tools
described here.

Behavior when Blocking is presentDesign Tool

Behaves the same as the Select tool in the Mesh ribbon.Select

Behaves the same as the Pull tool in the Mesh ribbon.Pull

Behaves the same as the Move tool in the Mesh ribbon.Move

Behaves the same as the Fill tool in the Mesh ribbon.Fill

Behaves the same as the Blend tool in the Mesh ribbon.Blend

When the Combine operation is performed, the geometry is updated independent of the mesh
and blocking. Blocking and mesh associations are updated to the changed geometry based on
closest projection. You may need to update some associations manually. Use theAssociate tool
to fix any issues that may arise from changes in the geometry. If the mesh should capture the
new features added to the model, use theSplitBlock tool orMergeBlock tool adjust the blocking.

Combine
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When theSplit Body operation is performed, the geometry is updated independent of the mesh
and blocking. Blocking and mesh associations are updated to the changed geometry based on
closest projection. You may need to update some associations manually. Use theAssociate tool
to fix any issues that may arise from changes in the geometry. If the mesh should capture the
new features added to the model, use the Split Block tool to split out those features.

Split Body

When the Split operation is performed, the geometry is updated independent of the mesh and
blocking. Blocking and mesh associations are updated to the changed geometry based on closest
projection. You may need to update some associations manually. Use the Associate tool to fix
any issues that may arise from changes in the geometry. If the mesh should capture the new
features added to the model, use the Split Block tool to split out those features.

Split

Behaves the same as the Project tool in the Mesh ribbon.Project

When a pattern operation is performed, the geometry instances also include blocking and mesh.
When a geometry operation, mesh control or block editing operation is performed to a patterned
feature, that operation is reflected in the other copies/instances.

The pattern operations have some limitations with Shared Topology, therefore it may be helpful
to Unshare the topology prior to using pattern operations with blocking and mesh.

Pattern

When a mirror operation is performed, the mirrored geometry will also include blocking and
mesh.

When the blocking and mesh is mirrored, the mirror interface is not conformal. To make the
interface conformal, you can right-click the Blocking objects in the Structure tree and then
selectMergeBlockings. Blocking and mesh do not respectMergemirroredobjects andCreate
mirror relationship in the Mirror Options panel.

The mirror operation has some limitations with Shared Topology, therefore it may be helpful to
Unshare the topology prior to using mirror operations with blocking and mesh.

Mirror

Behavior when Blocking is presentAssembly tool

Blocking and mesh data do not get stored to external documents. It gets stored to the design
document.

If you use theFileoption, or drag-and-drop, to assemble parts, you should right-click any external
documents and then selectSource> InternalizeAll to combine parts into the same SpaceClaim
document.

File

Behavior when Blocking is presentRepair Tool

When theSplit Edgesoperation is performed, the geometry is updated independent of the mesh
and blocking. Blocking and mesh associations are updated to the changed geometry based on
closest projection. You may need to update some associations manually. Use theAssociate tool
to fix any issues that may arise from changes in the geometry.

If the mesh should ignore some features that were removed, you can use the Merge Block tool
or Delete tool to simplify those features.

Split Edges

When theExtraEdgesoperation is performed, the geometry is updated independent of the mesh
and blocking. Blocking and mesh associations are updated to the changed geometry based on
closest projection. You may need to update some associations manually. Use theAssociate tool
to fix any issues that may arise from changes in the geometry.

If the mesh should ignore some features that were removed, you can use the Merge Block tool
or Delete tool to simplify those features.

Extra Edges
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When the Merge Faces operation is performed, the geometry is updated independent of the
mesh and blocking. Blocking and mesh associations are updated to the changed geometry based
on closest projection. You may need to update some associations manually. Use the Associate
tool to fix any issues that may arise from changes in the geometry.

If the mesh should ignore some features that were removed, you can use the Merge Block tool
or Delete tool to simplify those features.

Merge Faces

15.5.1. Applying Mesh Controls
To refine the mesh on a particular region in the model, you apply a local mesh control to the region. Local controls
may be applied either pre-mesh or post-mesh.

When applied pre-mesh,

• Controls are applied to the geometry.
• Controls will be activated when you generate the mesh using the Add tool.

When applied after meshing,

• Controls may be applied to the geometry or to the blocking, as applicable.

º Blocking inherits mesh controls applied to the geometry.
º Mesh controls applied to the blocking are treated as local and will take priority over a control applied to the

underlying geometry.

• Controls will be activated when mesh is updated. In Play mode, mesh is updated immediately, while in Pause
mode the update occurs when you click Play.

The following Controls are available:

DescriptionLocal Mesh Control

Set the mesh element size on an edge, face, or body.Size

Set a mesh type on blocks or faces.Map/Sweep

Generate boundary layers on a face or faces.Layers

Match mesh parameters from one face to another.Match

You can see if a local mesh control has been applied to the geometry by enabling ShowMesh Controls in the Mesh
Display panel. It may help to disable any mesh display. Local mesh controls are indicated in the graphics image as
shown.
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Local size controls have been added to one edge and to the top surface of the cube. The Map/Sweep control was
used to define a mapped surface mesh on the right side face. And, the curved surface of the cylinder has an added
boundary Layer mesh control.

You can also delete mesh controls that are no longer needed.

15.5.1.1. Creating a Size Control
You can use the Size control tool to set the mesh element size on a face or along an edge.

Creating a Size Control on an Edge
1. On the ribbon, click Size

.
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2. Click the Select Edges

tool guide and select an edge to which you want to add a local size control. You may use Box Select to choose
multiple edges simultaneously.

Note: You may apply a size control to blocking edges or geometry edges.

3. In Size Options, choose Use element size

or Use edge division

for the sizing control.

4. Specify a value for Number of divisions or Element Size and press Enter.

Pressing Enter does not trigger a remesh, but the new number of divisions or element sizing is previewed on the
edge.

5. (Optional) If required, enable Copy to parallel edges. This allows you to set consistent edge sizing on several
edges, such as the radial O-grid edges, with one setting. The parallel edges are highlighted.

6. (Optional) If required, toggle the icon to set aLocked (behaviorHard) orUnlocked (behaviorSoft) sizing control.
The default behavior is Unlocked.

Note:

• This option applies only to blocking edges.
• To avoid size conflicts on topologically parallel edges, only one edge should be locked. Alternatively,

all locked and parallel edges must have the same number of divisions.
• Mapped faces must have equal number of divisions on opposite edges. When edge sizes conflict, the

most recently set sizing control will be applied.

7. (Optional) Choose an Edge Biasing

option.

DescriptionOption

No biasing is applied to the edge. Elements are uniformly sized.No Bias
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DescriptionOption

This is a single side bias based on the Bias method selected.

• When By factor is selected, the bias factor is divided linearly across all elements.
• When Height and ratio is selected, the edge biasing can be set by the height and

ratio specified. Specify the height and ratio at the Start (V1) or End (V2) vertex
(depending on the biasing direction) of the blocking edge selected. Height 1 and
Height 2 are the heights applied at the Start (V1) and End (V2) vertices indicated in
the display.

An arrow is shown on the edge to indicate the direction of increase in size.

Note: Select block edges when the Height and ratio option is used.

Linear Bias: Right

or

Linear Bias: Left
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DescriptionOption

This is a both sides bias based on the Bias method selected.

• When By factor is selected, the bias factor is divided geometrically between all
elements.

• When Height and ratio is selected, the edge biasing can be set by the height and
ratio specified. Specify the height and ratio at the Start (V1) and End (V2) vertex of
the blocking edge selected.

• The Height values are defined at the ends of the edge. Height 1 (H1) and Height
2 (H2) are the heights applied at the Start (V1) and End (V2) vertices indicated in
the display.

• For Exponential biasing, the ratio values should be greater than 1.
• For Bell Curve biasing, the ratio values should be less than 1.

An arrow is shown on the edge to indicate the direction of increase in size.

Note:

• Select block edges when the Height and ratio option is used.
• Specify different values for height 1 and height 2 (or ratio 1 and ratio 2) to

ensure that the Height and ratio method is used for edge sizing. If the values
are identical, the mesher will revert to sizing based on bias factor.

Bell Curve Bias

or

Exponential Bias

8. Repeat steps 4-7 until you are satisfied with the previewed size. Then pressEntera second time or clickComplete

to apply the new size.

Copying Edge Size Controls or Matching Edge Size Distributions
1. On the ribbon, click Size

.

2. Click the Select Edges

tool guide and select the edge to which you want to add a local size control. You may use Box Select to choose
multiple edges simultaneously.
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Note: You may apply a size control to blocking edges or geometry edges.

3. If required, enable Copy to parallel edges. This allows you to set consistent edge sizing on several edges, such
as the radial O-grid edges, with one setting. The parallel edges are highlighted.

4. If required, use Select source edge

to select a blocking edge to use as the source edge for copying the edge sizing and biasing to the target edge(s).

When you select a source edge, you can choose one of the following options:

• Select Link source edgebunching to link the source edge sizing to the target edge(s). This option enables you
to set the distribution of nodes on a single edge to be identical to the distribution of nodes on a series of smaller,
parallel edges.

Note: When theLinksourceedgebunchingoption is selected, only the topologically "parallel" edges
can be selected. The valid edges are highlighted (in green) for selection. The target and the source
edge must be parallel edges of common mapped block faces. If due to local splits there is a sequence
of aligned source edges that are parallel to the target edge, the first source edge should be selected.

The example below shows the selection of the source edge for linking the source edge sizing to the target edge.
As there is a sequence of aligned source edges that are parallel to the target edge, the first source edge is
selected.

The edge sizing of all the aligned source edges is linked to the target edge as shown.
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• Select Copy parameters from source edge to copy the mesh size parameters to the target edge without any
linking.

Creating a Size Control on a Face
1. On the ribbon, click Size

.

2. Click Select Faces

and select a geometry face, or faces, to which you want to add a local size control. The Element size dimension
box is displayed on the face.

Note: Size control is not supported for blocking faces.

3. In the Element size dimension box or in the Size Options panel, specify a value forElement size and pressEnter.
Pressing Enter does not trigger a remesh, but the new element size is previewed on the face.

4. (Optional) In the Size Options panel, specify a value for Defeature size, Growth rate and Growth height as
required, and press Enter. Pressing Enter does not trigger a remesh, but the new value is displayed.

5. (Optional) In the Size Options panel, enableCurvature sizing as required. Specify a value forMinimumsize and
Normal angle if needed, and press Enter.

6. (Optional) In theSizeOptionspanel, enableProximity sizing as required. Specify a value forMinimumsize and
select Proximity size function sources as needed. The Edges option is selected by default.

If Physics Type is set to Fluid Dynamics, select a Direction to check for proximity and specify the number of
Cells across gaps, and then press Enter.

7. Repeat steps 3 to 6 until you are satisfied with the previewed size. Then press Enter a second time or click
Complete

1005Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Meshing



to apply the new size.

15.5.1.2. Setting a Mesh Type
You use theMap/Sweep control to set the local mesh type on solid bodies or surfaces. For surfaces, mapped meshes
can produce a more uniform mesh with fewer distorted elements than a free mesh. Free meshes are useful for more
odd-shaped geometries.

For a body to be considered sweepable, the body must be such that source faces and side faces can be identified.
Source faces can then be meshed with either a mapped mesh or a free mesh, after which it is extruded (swept) along
the side faces. The side faces, therefore need to be mappable so that the sweep direction is clear.

Source faces are highlighted in the image on the left. There is a clear sweep path along the mappable side faces, as
highlighted in the image on the right. For such a model, the software can automatically block the geometry to create
hex mesh in the sweepable regions. For more complex cases, the software may not be able to automatically block
the model, but it may be able to do a partial blocking allowing you to do some manual block editing to complete
the mesh.

Setting the Mesh Type on a Face
1. On the ribbon, click Map/Sweep

.

2. Click Select face

.

3. In the Mapping Options panel, choose a mesh type.

Options are:
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• Mapped Quadrilateral

:
(Default) Instructs the mesher to create a structured face mesh with all quads.

• Mapped Triangles

:
Instructs the mesher to create a structured face mesh with all triangles.

• Semi-structured

:
Instructs the mesher to create a semi-structured face mesh with all quads. For more details, see Semi-structured
Mesh Type.

• Free Quadrilateral

:
Instructs the mesher to create a free face mesh with all quads.

• Free Quadrilateral Dominant

:
Instructs the mesher to create a free face mesh with mostly quadrilaterals. You can also choose to use the
Prime surface mesher with this option.

• Free Triangles

:
Instructs the mesher to create a free face mesh with all triangles. You can also choose to use the Prime surface
mesher with this option.

4. Select a face to which you want to apply the mesh type.

5. If the face is sub-mappable, and you have chosen a mapped mesh type, you need to set the vertex types:

• Select vertices

will be activated.

• Click a vertex and select the vertex type (default is end vertex).

• Repeat click a vertex and select the vertex type as necessary.

• A mapped face requires four End vertices. You can either select the 4 end vertices or, for example, if you have
5 vertices for a given face you can simply mark 1 vertex as a sideand the other 4 vertices would beend vertices.

For more information, see How Vertex Types Affect the Mapped Mesh.

Tip: For the special case of converting an annular face (two concentric loops of edges) from free to
mapped, you do not need to specify any sideorendvertices. The software is able to recognize the annular
face and split it into four mapped faces. On a solid model, the swept block is converted to four mapped
blocks when the free, end face is converted to mapped.
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6. [Optional] When setting a mapped surface type, you can specify the number of Internal Divisions on certain
types of geometry. Select the surface and then use the up or down arrows, or type a new value.

• On an annular face, you can set the number of layers between the inner and outer edges of the annular face.
• On a cylindrical face, you can set the number of divisions in the axial direction.

Note: You must set the Internal divisions before the model is blocked. To set the number of divisions
after meshing, you can use the Size control.

7. Click Complete

to set the mesh type control.

The Map/Sweep control can also be used to adjust mesh after it has been created. If using the Map/Sweep control
with an already meshed model, use the face control to adjust the block face mesh type. For example, a free face
(any mesh type), can be converted to a mapped face (any mesh type), or vice versa, in order to help with converting
free blocks to swept blocks or swept blocks to mapped blocks or vice versa.

To convert a block face type, simply select the option you want to convert the block face to, and then pick the face.
The block face will be converted accordingly. If inPlaymode, the mesh will be updated. If inPausemode, the mesh
will not be updated until you turn on Play mode, however, you can continue converting other face types or solid
block types without updating the mesh.
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Semi-structured Mesh Type
The semi-structured face mesh type is used to transition mapped mesh along one direction while keeping mapped
mesh along the other direction. As such two parallel edges should have the same edge sizing and the other two
edges should have a transitional size that is of the form: edge1 = edge2 +/- 2*nwhere n is the number of transitions.
In the example below:

Edge divisions for A and B should be equal and Edge divisions for 2 would be equal to the number of divisions for 1
+2*2 transitions. Edge 1 has 5 divisions and Edge 2 has 9 divisions as there are two transitional regions.

Corners are handled during meshing, as shown in the example:
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Mesh orientation is also controlled by the sizing specified. For example, here the sizing specifies 10 divisions for the
top two edges combined and 10 divisions on the edge at bottom, 5 on left and 3 on right (1 transition)

Note: If inappropriate size controls are defined, the mesh could go from semi-structured to free quad until
you specify proper sizing controls. Once the proper sizing controls are defined the mesh should convert to
semi-structured.

For the same example, specifying 4 divisions on the right edge would result in a mesh as shown:
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Adjusting the sizing, for example, 11 divisions on the right edge will result in the mesh converted to
semi-structured (5 divisions on the left + 3 transitions * 2 = 11 divisions on the right).

Using Prime Surface Meshing
While creating a free mesh using quadrilateral dominant or triangle mesh type, an additional option is available to
enable Prime surface meshing. When the Use Prime option is enabled, an alternative surface meshing method is
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used for faster surface meshing performance for models having large surfaces with many cut out loops. By default,
this option is disabled. Note that the surface mesh quality may deteriorate when this method is used.

How Vertex Types Affect the Mapped Mesh
The vertex type affects the shape of the face mesh in the vicinity of the vertex. A vertex can be end, side, or corner
based on the number of face mesh lines that intersect the vertex, and the angle between the edges immediately
adjacent to the vertex.

Vertex types are specific to the faces upon which they are set. A vertex can only have a single vertex type for a face.
If a vertex is associated with multiple faces, it can possess a different type for each face. For example, a vertex could
have a side type with respect to one face, and an end type with respect to another face, as long as two separate
mapped mesh controls are defined for the two faces.

The following table describes the different vertex types and how they affect the mapped mesh:

DescriptionRange of
Angles
Between
Edges

Intersecting
Mesh
Lines

Vertex Type

Select with

Creates the mapped mesh such that only
two mesh element edges intersect at the
vertex. The vertex is attached to one quad
element on the mapped face. As a result, the
mapped and sub-mapped face mesh
patterns on both sides of the End vertex
terminate at the edges adjacent to the
vertex.

Assigning the End vertex type to a vertex
whose adjacent edges form an angle greater
than 180° will likely result in mesh failure.

0° - 135°0End Vertex

Select with

Creates the mapped mesh such that three
mesh element edges intersect at the vertex.
The vertex is attached to two quad elements
on the mapped face. The two topological
edges that are adjacent to the vertex are
treated as a single edge for the purposes of
meshing.

136° - 179°
(faces with
only 4
vertices
and 4
edges)

136° - 224°
(all other
faces)

1Side Vertex
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DescriptionRange of
Angles
Between
Edges

Intersecting
Mesh
Lines

Vertex Type

Select with

Creates the mapped mesh such that four
mesh element edges intersect at the vertex.
The vertex is attached to three quad
elements on the mapped face.

Assigning the Corner vertex type to a vertex
whose adjacent edges form an angle less
than 180° will create an unnecessarily bad
quality mesh (although the mesh will be
valid).

225° - 314°2Corner Vertex

Select with

Resets the selected vertex to its default type.

Reset Vertex type.

Setting the Mesh Type on a Solid
1. On the ribbon, click Map/Sweep

.
2. Click Select blocks

.
3. In the Blocking Options panel, choose a block type.

Options are Swept, Mapped or Free.

4. If Free is selected, select the volume fill type.

Volume fill options,HexahedralorTetrahedral, are applied to the body. Bodies with mapped blocks must have
all hexahedral fill. Bodies with swept blocks will be filled with hexahedral and prism elements.

5. Select a block on which you want to set the block type. Hold the Ctrl key to select multiple blocks. The block
type control is applied immediately. If a mesh already exists on the block, the mesh is updated.

Note: When setting type Swept, the suggested source and target faces are previewed. You may accept
these or use the Select source/target faces tool guide to choose alternates.
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Tip: If your model has multibody parts, you may set or change the blocking type for bodies independently
and connect Mapped blocks to Free blocks.

Note: Converting a free block to Swept supports block topology with different number of splits on the side
faces. The free block shown has a single level between the top face and bottom face, while the outer side
surfaces consist of several stepped levels. It can be converted to Swept if the top (as shown) or bottom
surface is selected as the source.

15.5.1.3. Adding Boundary Layers to a Mesh
Boundary layers are useful to capture physical properties near the boundary of a model, such as the viscosity in
fluid flow simulations or high stress concentrations in structural simulations. The Layers

control is used to identify the faces (surfaces) on which you want to extrude orthogonal layers, and to set local
parameters for the creation of those layers.

• You can define a boundary layer control on the face(s) of a solid body(-ies), or on the edge(s) of a shell body(-ies).

• Boundary layers can be defined on the model prior to meshing or after meshing. If defining boundary layers after
meshing, the control can be applied either to the geometry or to the blocking.
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Note: The default options for the Layers control may be set in the SpaceClaimOptions >Mesh panel. See
Mesh options.

Defining Boundary Layers Prior to Meshing
1. On the ribbon, click Layers

.

2. Click Select face

and pick the geometry surface(s) that you want to offset.

Alternatively, click Select body

and pick the entire solid body. Then, click Select target face

and pick the surfaces that you do not want to offset. This selection process may be simpler for more complex
geometries.

If you are selecting faces for a fluid flow simulation, you typically want to pick faces that represent a wall boundary.
For a structural simulation, you typically want to pick faces that represent a boundary where you anticipate high
stress, and you want your mesh to have anisotropy so that you can capture the stress gradient near the boundary.
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Tip: For complex models in which multiple faces require boundary layers, or to select internal faces,
you may find the Inverse Selection option from the context sensitive (RMB) menu helpful.

For shell bodies, the selection processes are similar except you will select edges instead of faces to offset. Click
Select edges

and pick the geometry edge(s) that you want to offset.

3. The following Options are available:

• Choose a Layer growthmethod from the drop-down list. See Choosing a Layer Growth Method.
• Depending on the Layer growth method chosen, set other layer options as described under Boundary Layer

options.

Tip: You can set default Layer growth method and options using the SpaceClaimOptions>Meshpanel.
See Mesh options.

4. Click Complete

to create the boundary layer control.

Defining Boundary Layers After Meshing
1. On the ribbon, click Layers

.

2. Click Select face

and pick the geometry surface(s) or blocking face(s) that you want to offset. Press the Ctrl key or use the selection
filter to determine selection preference.

Alternatively, click Select body

and pick the entire blocking body. Then, click Select target face

and pick the block faces that you do not want to offset. This selection process may be simpler for more complex
geometries.

If you are selecting faces for a fluid flow simulation, you typically want to pick faces that represent a wall boundary.
For a structural simulation, you typically want to pick faces that represent a boundary where you anticipate high
stress, and you want your mesh to have anisotropy so that you can capture the stress gradient near the boundary.

Tip: For complex models in which multiple faces require boundary layers, or to select internal block
faces, you may find the Inverse Selection option from the context sensitive (RMB) menu helpful.
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For surface bodies, the selection processes are similar except you will select block edges instead of faces to
offset. If layer modification is required, click Select block edge

and pick the internal block edge(s) as shown in the example.

3. The available Options depend on blocking or geometry selection.

• For blocking selection:

• Layer growthmethod is restricted to Total Thickness.
• The Offsetmethod is used to specify how the offset layer thickness is calculated. Choose Absolute to force

the Offset value to use your model's measurement units. Default is Relative.

• Specify a numeric Offset value.

• Enable Link shape to cause the internal edge(s) of the boundary layers to be shaped by the nearest,
corresponding geometry shape. This can help make a more uniform height throughout the layer region.
However, the edges and mesh in the center block(s) may not be able to smooth away as quickly, resulting
in more skewed cells. Default is disabled.

• For geometry selection:

• Choose a Layer growthmethod from the drop-down list. See Choosing a Layer Growth Method.
• Depending on the Layer growth method chosen, set other layer options as described under Boundary Layer

options.

4. Click Complete

to create the boundary layer control.

The following sequence of images shows the blocking structure for various options on a simple cylinder with disabled
and enabled mesh display.

• The top row shows the basic blocking with no layers. Cells near the vertices on the curved surface are highly
skewed.

• The second row shows the how the blocking is split to accommodate the layers using a Relative offset value of
1.0. Note that boundary layers were created only on the cylinder side faces.

• In the third row, the split was modified by setting the relative offset value to 0.2.
• In the bottom row, the layer control was created with Link shape enabled and an offset value of 0.75. (Block cage

display is disabled.)
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Choosing a Layer Growth Method
Layer Growth Method enables you to select one of these methods for determining the heights of the boundary
layers:

• Total Thickness creates the specified Number of Layers using the constant Growth Rate to obtain a total
Maximum Thickness.

• First Layer Thickness generates the specified Number of Layers, in which the First Layer Height is specified
and each subsequent layer is calculated from the previous using the constant Growth Rate.

• Smooth Transition uses the local element size to compute each local initial height and total height so that the
rate of volume change is smooth.

Each prism that is grown from a triangular surface element will have an initial height that is computed with respect
to its base area, averaged at the nodes. For a uniform mesh, the initial heights will be roughly the same, while for
a varying mesh, the initial heights will vary. The mesher uses these computations for prism layer growth:
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º The following value is computed at each node on the prism base:Height of last prism (H) =
Transition Ratio * average_edge_length

º The height of the first layer (h) is computed using the following formula, whereg=GrowthRateandn=Number
of Layers:H = h * (g ^ (n - 1))

Increasing the value ofGrowthRate reduces the total height of the boundary layers. The total height approaches
an asymptotic value with respect to the number of boundary layers.

• First Aspect Ratio calculates the heights of the boundary layers starting with the desired aspect ratio of the
elements adjacent to the surface mesh. With this method, you can specify theFirst aspect ratio,Maximumlayers,
and Growth rate. The first layer height is calculated from the First aspect ratio and the local mesh base size.
Subsequent layer heights are calculated using the Growth rate and the previous layer height.

• Last Aspect Ratio also calculates the heights of the boundary layers using a desired aspect ratio.

With the Last Aspect Ratio method, the First Layer Height is specified. The offset height for the last layer is
calculated from the local base mesh size and specified Aspect Ratio (base/height). For example, if you specify a
value of 3 forAspectRatio (base/height), the offset height of the last layer will be the local base mesh size divided
by 3. The local growth rate is calculated using Maximum layers to create exponential growth through the
intermediate layers.

Boundary Layer Options
You can set the following local boundary layer options, depending on the selected Layer GrowthMethod. Options
set here will override the global settings on the selected faces only.

DescriptionOption

Determines the rate at which adjacent elements grow by controlling the
volume-based size change between the last layer of elements in the boundary layer
and the first layer of elements in the tet or hex region. The transition ratio is an ideal
value and should produce accurate size change for extrusion from a planar boundary.
However, areas of strong curvature will introduce an inaccuracy into the size change.
If a proximity-based size function is being used, elements in proximity and elements
with prism aspect ratios meeting the MaximumHeight over base will ignore the
Transition Ratio. Valid range is from 0 to 1.

Transition Ratio

Specify the maximum number of boundary layers you want the mesh to contain.
Valid range is from 1 to 1000.

Maximum Layers

Determines the relative thickness of adjacent boundary layers. As you move away
from the extruded face, each successive layer is approximately one growth rate
factor thicker than the previous layer. Valid range is from 0.1 to 5.0.

Growth Rate
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Specify the number of layers you want to extrude into the body from the surface
mesh. The mesher removes layers locally to improve quality; for example, when
layers would otherwise collide with each other. Valid range is from 1 to 1000.

Number of Layers

Specify the height limit for the total combined thickness of the boundary layers.
Value must be greater than 0.

Maximum Thickness

Sets the height of the first boundary layer, which consists of a single layer of prism
elements formed against the elements of the surface mesh. Value must be greater
than 0.

First Layer Height

Control the heights of the boundary layers by defining the aspect ratio of the prisms
that are extruded adjacent to the surface mesh (base). The aspect ratio is defined
as the ratio of the prism base length to the prism layer height. Value must be greater
than 0.

First Aspect Ratio

Control the thickness of the boundary layers by defining the height of the prisms
that are extruded from the surface mesh (base). The aspect ratio is defined as the
ratio of the prism base length to the prism layer height. Valid range is from 0.5 to
20.

Aspect Ratio (base/height)

15.5.1.4. Copying Mesh Parameters From one Face to Another
Match controls are used to specify faces or edges where the mesh should match (same pattern and spacing). For
example, you can match the side faces of a pie-like section to ensure the mesh matches between slices if you were
to copy the pie slice to form the full pie. Matched meshes support block editing operations such as

• Splitting a face on one face will split the matched face.
• Splitting a block will retain matching on the smaller block.
• Moving a vertex on one face will cause an equivalent vertex move on the matched face.
• Converting a block type will retain matching.
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Creating a Match Control
1. On the ribbon, click Match.

2. Click Select high faces

,
and then identify those faces from which mesh parameters are to be matched. Selected face(s) are highlighted.

3. Click Select low faces

,
and then identify those faces to which the parameters are to be matched. Selected face(s) are highlighted in a
contrasting color.

4. Click Select axis of rotation

(optional), and then select an appropriate center of rotation for a cyclic match control. You may select a geometry
edge or curve, a created axis, or coordinate system axis.

If a valid axis is selected, the Angle option value is automatically calculated from the selected faces. You may
manually specify an angle value.

5. If you are matching blocking, click Select a high Vertex

,
and then identify a key point on the high face, when blocking exists. You may select a geometry point or block
vertex. Blocking does not possess "direction". This point acts like an origin point relative to the face.
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6. If you are matching blocking, click Select a low Vertex

,
and then identify the corresponding key point on the low face.

Note: High and Low vertices may also be used to automatically compute the Angle when an Axis of rotation is
identified.

7. Click Complete to create the Match control.

You can check for matched nodes by mousing over a connected face with the Match tool active. Matched nodes
are indicated with a black, double-headed arrow.

Creating an Arbitrary Match Control
An arbitrary match control can involve both translational and rotational components. To create such a control, with
the Match tool active do the following:

1. Identify the high and low faces whose parameters are to be matched.
2. Select the axis of rotation and specify an Angle to determine the rotational component.
3. Select a high vertex and the corresponding low vertex to determine the translational component.
4. Click Complete to create the Match control.

After a Match control has been created, you may set, or modify, other mesh controls (Edge Size, Face Size, Mapped
Mesh, etc.) on the high face. Changes will be applied automatically to the low face.

Notes regarding the creation of match controls:

• Face meshes are matched across bodies.

• A single match control with one high face and one low face cannot be applied across multiple bodies. If there are
multiple faces on the high side and multiple faces on the low side, Meshing does its best to match the high and
low sides on a body-by-body basis. For example, the match control will support situations in which there are two
bodies, each having one face on the high side and one face on the low side (for a total of two high faces and two
low faces). However, for more complex situations, you must be careful to ensure the proper matching is done.

• Matching will fail if the high and low faces are on two separate bodies that have other bodies (being meshed with
a method other than Sweep) or a space between them.

• The faces or edges that you select must be topologically and geometrically the same. This means they following
conditions are true:

º They have the same number of vertices on the high and low sides.

º They have similar surface area or length.

º The high and low sides have similar transformation.

º The mesher will move nodes away from the geometry to meet the transformation.
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• If the low and high sides of a geometry do not match, the high side geometry is meshed and the low side will be
meshed using the transformation from the match control. In this case, the low side geometry and mesh might be
slightly different, so a warning is displayed prompting you to check this deviation and decide whether it is acceptable
or that you should modify the geometry.

• Multiple match controls can be associated with a single entity, but multiple associations can result in conflicts
among match controls. If a conflict occurs, Meshing issues an error message, and matching fails. For example, a
match control conflict may occur if the two faces adjacent to an edge have two different match controls applied
to them. If the two match controls use two different sets of coordinate systems, then an error may be produced
even if the transformation between the two match controls is the same. However, for this case, if the two match
controls refer to the same set of coordinate systems there won't be any conflict.

• A match control can only be assigned to one unique face pair. Assigning the same face as High, or Low, Geometry
in more than one match control is not supported. If multiple match controls assign the same face as a High, or
Low, Geometry entity, only the last match control created is honored.

• When Match is used with a Size control, the effect of a sizing on the high or low side will be transferred through
the Size control bidirectionally from the high side to the low side and vice versa. This means that if the low side
has a sizing control and the high side does not, the low-side sizing control will be applied on the high side. If both
high side and low side have a size control, the control on the high side has priority.

• Match controls are not enforced when previewing boundary layers.

• When match controls on faces are used with Blocking, only one periodic or cyclic transformation is supported
(Blocking can support multiple match controls, as long as they use the same coordinate system and have the
same angle/translation). In addition, Blocking does not support matching of free meshed regions.

15.5.1.5. Deleting Mesh Controls
Mesh controls can be removed from faces and edges.

Deleting a Size Control
1. Select a face or edge that has a size control.

2. Press Delete.

The size control is deleted. If the face or edge is meshed, then the mesh is updated.

Deleting a Map/Sweep Control
1. Select a face that has a map/sweep mesh control.

2. Press Delete.

The map/sweep mesh control is deleted. If the face is meshed, then the mesh is updated, which will also update
the solid mesh if applicable.

Note: Alternatively, you can right-click the control and select Delete to remove it. Make sure you have
the control highlighted, as this delete will remove anything you have selected. The mesh remains but
may be updated, and can be deleted from the geometry structure separately.

Deleting a Boundary Layer Control
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1. Select a face that has a boundary layer control.

2. Press Delete.

The boundary layer control is deleted. If the face is meshed, then the mesh is updated.

Note: If a face or edge has more than one mesh control, all controls will be deleted by this operation.

Deleting a Match Control
1. Right-click to select the control, and then select Delete from the context menu to remove the control. Make sure

you have the control highlighted - you may need to use the Ctrl key and scroll wheel. You may select either the
high or low side of the Match control.

2. Press Delete.

The match control is deleted. If there is another mesh control applied, for example a size control, then the low
side mesh will be updated and the high side mesh remains under the other mesh control.

15.5.2. Editing the Blocking
Regardless of the blocking technique used, at some point you may need to modify the blocking topology. Typical
reasons to do this include:

• Subdividing free regions to swept regions or swept regions to mapped regions to get more hex mesh

• Making the blocking better conform to the geometry

• Simplifying the blocking

• Adding boundary layers

• Improving feature capture

• Improving mesh quality

Existing blocks are identified in the structure tree as mapped, swept, or free. You can control blocking display in the
graphics window from the Mesh Display panel. Important data about blocks and mesh, either individually or
collectively is available in the Properties panel. Also see Understanding the blocking structure.

When editing the blocking topology, it is important to note that the block type affects the choice of operations, and
ultimately affects mesh generation. For example, if you split mapped blocks, the split will propagate through faces
that have a mapped relationship to the opposite side. For free blocks or swept blocks, a split will terminate at the
free face. Similarly, if you set edge parameters on a mapped face edge, opposite edges will necessarily have the
same number of nodes. If however, that edge is attached to a free face, the number of nodes on the opposite side
will not be adjusted. Understanding this free/mapped relationship will guide you in block editing and help achieve
a quality mesh.

You can lock blocks to preserve the generated mesh topology, so that it cannot be changed during other block
editing operations. Locked blocks display a lock icon in the Structure tree, as shown in the image below.
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When a block is locked, the mesh sizes on the block will be preserved. The mesh on the locked block(s) will not be
recomputed when other blocks are edited, so after editing unlocked blocks the mesh display of the locked blocks
will disappear.

Some notes about editing blocks when some blocks are locked:

• Blocks that are locked should not be edited. Operations such as merging blocks, reassociating vertices, or converting
block type should not be done on locked blocks.

• When mapped faces are connected to locked blocks, size changes and topology changes could affect the locked
blocks. These changes are managed as follows:

º Changes in the number of divisions on a parallel edge that would affect a locked block are not allowed.

º Splits of a parallel edge and other operations that can cause split propagation are allowed to maintain
connectivity. These changes can modify the locked blocks.

• After editing, the Blocking tree state indicates that the full mesh is not up-to-date and must be recomputed as a
final step.

Use Generate Mesh to update the mesh to its complete state.

At any point, you may save the blocking topology to a file, independent of the underlying geometry. Typically this
is done when you want to use the blocking topology as a template to quickly generate hex mesh on a modified
geometry. After opening the blocking file with a new geometry, the software will attempt to associate the blocking
topology to the geometry and generate the mesh. Some manual repair and blocking disassociation/reassociation
may be necessary.
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Do this...To select...

Click a block with theSelectblock tool guide active. This
is available in most block editing tools.

Hold the Ctrl key and use the scroll wheel to highlight
the volume in the design window. Click the block volume.

Click the block name in the Structure tree.

Double-click a block vertex. All connected block volumes
will be selected.

Tip: In the special case of fully mapped blocks,
you may select multiple blocks by first selecting
two corner vertices and then using the RMB
context menuSelect> Block. All blocks between
the two vertices will be selected.

Block Volumes

Click a block face with the Select face tool guide active.
This is available where appropriate in block editing tools.

Hold the Ctrl key and use the scroll wheel to highlight
the face in the design window. Click the block face.

Hold Ctrl to select multiple faces.

Double-click block faces for quicker selection of adjacent
faces by flood-filling.

Note: Internal block faces are not supported for
flood-filling.

Block Faces

Click a block edge with theSelectedge tool guide active.
This is available where appropriate in block editing tools.

Hold the Ctrl key and use the scroll wheel to highlight
the edge in the design window. Click the edge.

Double-click to select a loop of edges. If the selected edge
is in more than one loop, repeated double-click will step
through the possible loops.

Hold Ctrl to select multiple edges.

Block Edges

Click a vertex with the Select vertex tool guide active.
This is available where appropriate in block editing tools.

Hold the Ctrl key and use the scroll wheel to highlight
the vertex in the design window. Click the block vertex.

Hold Ctrl to select multiple vertices.

Block Vertices
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Do this...To select...

Press Ctrl + A to select all blocking plus bodies as
indicated by highlighting in the Structure tree.

Use box select to select blocking faces, edges and vertices
within the box area.

All blocking volumes, faces, edges and vertices.

1. In the Structure panel, click Selection.
2. Select an object in the design window. The Selection

panel offers a list of related objects as search criteria.
3. Select a search criterion from the drop-down list.

Objects that meet the selected criterion will be
highlighted in the design window. A hierarchical tree
shows the block types that currently exist in your
model: Free Blocks, Swept Blocks, or Mapped Blocks.
Initially the display is filtered on a body-by-body basis.
To view blocks on the entire model, enable theSearch
all bodies option.

Objects based on search criteria

Select the block(s) in the Structure tree or the display
window, right-click and select Select Associated
Geometry.

Associated geometry

Do this...To view...

Select the block face(s) in the display window with the
Select face tool guide active. Select the block(s) in the
Structure tree or the display window with the Select
block tool guide active. These options are available where
appropriate in block editing tools.

Right-click and select Show Attached Blocks.

Blocks attached to face(s) or block(s).

Select the block(s) in the Structure tree or the display
window, right-click and select Show Associated
Geometry.

Associated geometry

Use the Block Editing tools to perform the following editing actions:

Click ...To ...

Right-clickBlocking in the Structure tree and select
Detach Faces.

Convert a 3D solid block to 2D surface blocks.

Right-clickBlocking in the Structure tree and select
Solidify.

Convert 2D surface blocks to a 3D solid block.

Note: The surface blocks must form a closed, airtight
solid.

Pull

Pull face(s)/edges of a solid block to create new swept/mapped
blocks or to cut out swept/mapped blocks from a free block.
Pull face(s) of a sheet block to create new solid block(s).

Blend

Select a pair of block faces or edges to split or create a block
between the pair of faces/edges.
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Project
Project edges from one side of a free block to another side.

Split

Divide blocks, block faces or block edges.

Merge

Combine two or more blocks, block faces, or block vertices
into a single block, block face, or block vertex, respectively.

Align

Align block vertices.

Associate

Associate block vertices, edges, and faces to geometry vertices,
edges, and faces.

Shape/Link

Set the curve shape on a block edge by adding/removing
vertices, or by linking/unlinking to other shaped edges. This
can improve the mesh quality by helping the mesh conform
to the geometry better.

Right-clickBlocking in the Structure tree and select
Check Blocking > Check/Fix.

Check block structures for inconsistencies and fix them, if
possible.

Right-clickBlocking in the Structure tree and select
Check Blocking > Fix Inverted.

Fix inverted blocks.

Right-clickBlocking in the Structure tree and select
Check Blocking > Validate.

Validate the blocking.

Select the blocks that you want to invert in the
Structure tree, and right-click and select Invert
Selected.

Invert the selected blocks.

Select the blocks that you want to move to the new
material in the Structure tree or the design window,
and right-click and select Move to NewMaterial
from the context menu.

Alternatively, you can select the block(s) in the
Structure tree and drag and drop to the material
you want to move the block(s) to.

Move the selected blocks to new material.

Select the block materials that you want to merge
in the Structure tree, and right-click and select
Merge Materials from the context menu.

Note: You cannot merge block materials
across components.

Merge block materials.

Select the block(s) in the Structure tree or the
design window, and right-click and selectLock from
the context menu.

Lock blocks to preserve the generated mesh topology.
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Right-click the block that you want to delete in the
Structure tree or select the block in the design
window, and then use the RMB context menu or
Delete key to remove the blocking. Note that this
method does not remove Local settings or
controls.

Remove blocks from the topology using the Delete option.

Right-clickBlockingat the top of the Structure tree.Write the blocking topology to a file using the Save option.

Select the block in the Structure tree and set the
Element order in the Properties panel.

Change the element order (linear or quadratic) for the selected
block.

15.5.2.1. Understanding the Blocking Structure
Blocking represents the decomposition of your geometry into meshable regions. Several common SpaceClaim tools
have been enhanced to allow you to identify the blocking and its relationship to your geometry, and to perform
basic editing tasks.

Before blocking, the Structure tree shows only geometry objects.

After blocking, theStructure tree contains separate objects for each of the blocks, which you can think of as separate
volumes or regions of the full model.
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By selecting or deselecting blocks in the Structure tree, you can see how those blocks correspond to parts of the
geometry.

Alternatively, right-click a block in the structure tree, and then selectMove toNewMaterial from the context menu.
You may now apply distinct colors to the separate materials using the Color tool in the Display ribbon.

Types of Blocks
Individually, a block is one of three types:Mapped,Swept, orFree. See Blocking types. You may use theMap/Sweep
control to convert the block type. See Setting a mesh type.

You may convert fromSurfaceblocks toVolumeblocks and vice versa using theSolidify andDetach Facesoptions
in the Blocking context menu (right-click Blocking in the Structure tree). This may be useful for some cleanup of
surface mesh before performing the volume fill operation.

• Any single blocking node in the Structure tree can contain either surface mesh or volume mesh but not both. To
have both surface and volume meshes in your model requires you to use separate components for each.

• TheSolidify conversion from surface to volume blocks updates the tree to show block type and number. Selecting
a block in the tree will highlight the appropriate block.

This option requires that the surface blocking forms a closed volume.

• The Detach Faces conversion from volume to surface updates the tree to show a single block for each face.
Individual block faces may be selected in the tree.

Basic Design Window Editing
Blocking is generally preserved and propagated when certain geometry design window operations are performed:

• Move and Copy operations
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If you edit geometry, blocking and mesh are moved with the geometry.º

º When holding theCtrlkey to create a copy with theMove tool, the blocking and mesh are also moved and copied
with the geometry.

º You can edit the location of a blocking vertex, or vertices. With the Move tool, select a single vertex. The move
handle is attached to the selected vertex. You may now move it to new location. Similarly, you can move a
blocking edge by selecting the two end vertices or move a blocking face by selecting four corner vertices. Attached
edges, and faces if appropriate, are updated by such move operations.

º You can select a blocking face to move all vertices attached to that face.

º When doing top-down blocking, you may want to disable Snap Associated Vertices in the General options
panel to prevent automatic re-association when vertices are moved across geometry boundaries.

Note:

The Copy/Paste sequence is not yet hooked up to create blocking and mesh with the geometry.
Copy/Paste cannot work from one design window to another.
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• Mirror operations

º Blocking and mesh gets mirrored across a plane along with geometry.

º In complex blocking, such as with boundary layers, some blocking-to-geometry associations may be lost.

• Undo

º Undo also affects any blocking and mesh which were modified by the operations being undone.
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Blocking Display
When blocking is created, the blocking vertices, edges, and faces are associated with the closest geometry points,
curves, and faces. Color coding is used to indicate how block edges and vertices are associated to the geometry,
which can constrain the movement of the blocking edges and vertices. See Associating the blocking to geometry.

• Red vertices are associated to points on the geometry. If you attempt to move these without first disassociating,
the geometry may also be modified.

• Green vertices and edges are associated to curves on the geometry. You may move the vertices but they will be
constrained to stay on the associated curve.

• Purple (pink) vertices and edges are associated to surfaces. You may move the vertices, but they will be constrained
to stay on the associated body.

• Blue (cyan) vertices and edges are internal and not associated to any geometry. You may move the vertices freely.

The Mesh Display panel includes controls to show the Connectivity of blocking edges and faces. If enabled, edge
color indicates the number of connected faces.

1. Red = one face, as in a perimeter edge for surface blocking.
2. Blue = two faces.
3. Pink = three faces.
4. Yellow = interior edges in volume blocking, connected to more than three faces.

Note:

Note: Edge connectivity color will override blocking association color when enabled.

Similarly, if enabled, Faces are colored if shared by two volume blocks.

The Mesh Display panel also includes a control to indicate the type of block face by the presence of a checkerboard
pattern.

1. Patterned faces indicate mapped.
2. Solid color faces indicate free.
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For a full description, see Setting mesh display options.

Global Blocking and Mesh Statistics on a Component
The Select tool will open a Properties panel displaying blocking and mesh statistics. For example, consider this
simple model showing a single solid body consisting of a cylindrical region and attached rectangular region. This
component has been blocked with two mapped blocks and one swept block.

Displaying Global Mesh Statistics Including Node Counts
With theSelect tool, click the body's name in the structure tree or triple-click to select the body in the design window.
The mesh statistics will display all non-zero mesh counts in the Properties panel.

Displaying Global Mesh Statistics for Components Containing Blocking
With the Select tool, click Blocking in the structure tree.

Using the same model as before, in addition to the mesh node and element count, the block count and element
quality are displayed.
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Note:

• The displayed MinimumQuality value is the minimum value of various metrics checked depending on
the element shape. For example, for a hybrid mesh, the MinimumQuality may be the lowest of the
minimumElementQuality for quad elements, minimumAspectRatio for triangle elements, and minimum
Jacobian Ratio for hex elements.

• When you select a body that has been meshed (or select Blocking), statistics for all meshed bodies in the
component are reported.

• You can hold the Ctrl key and selectBlocking under multiple components in the structure tree to display
the combined statistics.

15.5.2.2. Splitting Blocks
The Split

tool is used in block editing to create smaller blocks, faces, or edges that can be fit to the geometry.

With the Split tool you can split an edge by adding a vertex, split a face or block by selecting multiple vertices or
sweeping an edge or loop of edges, or extend an edge split. In certain situations, the split target may be specified.

Note: When splitting the geometry, blocking and mesh are preserved but not split. You will need to manually
split the blocking and may need to reassociate blocking to geometry for correct results.
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Splitting an Edge
1. Click the Select Edge Point or Vertices

tool guide.

2. Position the cursor along an edge. Use the dimension lines for precise positioning or parametric location.

3. Click or press Enter to complete the split. A new vertex is placed at the split position, creating two edges. The
split precision depends on the representation of the blocking edge and can be improved by converting a linear
blocking edge to a spline.

Splitting a Face
1. Click the Select Edge Point or Vertices

tool guide.
2. Click to select the first vertex. The vertex is highlighted.
3. Scroll over the second vertex. The vertex is highlighted and the split location is previewed.

4. Click or press Enter to complete the split. A new edge is placed at the split position, creating two faces.

Note:

• In certain situations, you will click four vertices to split across a face that has a hole.
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• When positioning a single vertex on an edge on a mapped face, the split must propagate across the block
face to maintain the mapped property. Similarly, when splitting a mapped block, a single vertex split will
propagate through the block, plus any attached mapped blocks.

Splitting a Block
1. Click the Select Edges or Faces

tool guide.

2. Double click to select a loop of edges to project through a volume block. You may have to double-click a second
or third time to let the software cycle through all loops connected to the selected edge.

3. Click the Complete tool to create the split. In this example, Faces connectivity is enabled to see the new, shared
face created across the middle of the block.
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Splitting a Block by Extending an Edge or Loop of Edges
1. Click the Select Edge

tool guide.

2. Select an edge or loop of edges to extend through a block. In certain swept block situations, if the selected edge
is across the source face, it will be swept to the target face immediately to preserve the mapped side faces of the
swept block.

3. In certain free block situations, select a target block or face for the split.

The target may be free or mapped.

Note: The source loop and target face must be in the same free block in a single body, with a direct
boundary connection between source and target.

TheSnapassociatedverticesoption is available underSplitOptions. This option is enabled by default. Vertices
created by the split function will be automatically projected to the nearest geometry curve. Disable this option
to prevent automatic association. You may then create the association manually. This is useful when splitting
blocking on a thin, curved body.

15.5.2.3. Merging Block Volumes, Surfaces or Vertices
The Merge

tool is used to simplify the blocking structure by combining block vertices, block faces, or blocks.
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Merging Vertices
You can combine or remove vertices to connect parts without shared topology. Vertices may be merged by individual
selection or by box selection.

Combining Two or More Vertices by Individual Selection
1. Click the Select the anchor vertex

tool guide. The cursor changes to select the anchor vertex (kept vertex) to which merged vertices are pulled.

2. Select your desired anchor vertex. The anchor vertex is highlighted and the cursor changes to Select the vertex
to be released.

Note: The anchor vertex remains highlighted until you escape out of the command or click Select the
anchor vertex again to deselect the first vertex and initiate another sequence.

3. Select a vertex to be merged. The anchor vertex is retained and the second selection is removed. The block
structure is modified to fit the remaining vertices.

Note: The cursor remains in Select the vertex to be released mode allowing multiple vertices to be
combined with the anchor vertex until you escape out of the command, or click white space, or click
Select the anchor vertex again to initiate a new sequence.
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Note: Both vertices must be in the same component. If you attempt to merge vertices from separate parts,
bodies, or components, an error message will be generated.

When merging vertices by individual selection, you can modify the behavior using theMergeOptionspanel:

• Enable Merge to Average. The resulting vertex will be placed at the midpoint between the anchor vertex and the
second vertex.

• EnablePropagateMerge. Parallel edges of all connected, mapped faces will be collapsed irrespective of the block
type. Some blocking associations may be lost and will have to be reset. For example, when edges spanning multiple
curves are collapsed, a new composite group of edges will have to be created. By default, Propagate Merge is
disabled. Combining a single pair of vertices on a mapped face may result in a degenerate face depending on the
type of volume block.

Combining Multiple Vertices Simultaneously
1. Click the Box select vertices

tool guide.

2. Drag a box around all vertices to be merged.

3. In the Merge Options panel, specify a Tolerance. Vertices will be combined to a single vertex only if they are
within the specified tolerance limit.

4. Click the Complete tool.

Tip: Use this option to box-select multiple vertices simultaneously. Only pairs of vertices within the
specified tolerance will be combined into single vertices.

Combining Two or More Block Faces
1. Click the Select faces

tool guide.

2. Select two or more surface blocks or block faces.

You may merge two or more faces in one operation.

• Hold the Ctrl key to select block faces individually.
• Use Box Select to select all block faces in an area.
• Use Ctrl-A to select all visible block faces.

3. Click the Complete tool if more than two faces are selected.

Note:
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• This tool is used to create larger surface blocks from multiple smaller surface blocks, or to combine faces
on volume blocks.

• Faces will merge only if they are the same type: mapped or free.

• When selecting multiple faces, all pairs of the same type and having a common edge are merged, selected
faces without a neighbor are ignored.

• When merging all mapped faces, the software will attempt to create mapped faces as much as possible.
However the blocking topology may not allow merging into a single, mapped face. In this sequence, the
central square is open (no blocking). The merge operation cannot resolve this area if all faces are mapped.

• If all selected faces must be merged into a single face, they must be converted to type free before merging.
The result is a single, free face.

Merging Two or More Volume Blocks
1. Click the Select blocks

tool guide .
2. Select two or more volume blocks. You may use the Ctrl key or box select or Ctrl-A to select multiple blocks.
3. Click the Complete tool.

Note:
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• Blocks will merge only if they are the same type: mapped, swept or free. You may not mix block types in
one merge operation.

• Swept blocks may be merged when they have the same sweep direction at the common face.

• When selecting multiple blocks, all pairs of the same type and having a common face are merged, selected
blocks without a neighbor are ignored.

15.5.2.4. Aligning Block Vertices
The Align

tool can be used to align block vertices to a line or axis, or a plane.

Aligning Blocking Vertices to a Line
1. Click Select

,
and then select the vertex (vertices) to align. To select multiple blocking vertices, hold the Ctrl key while selecting.

You can also select edges or faces. The vertices on these will be aligned to the line.
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2. Click Select 2 vertices or line

,
and then select two vertices or a reference line (edge or axis) to align to.

Aligning Blocking Vertices to a Plane
1. Click Select

,
and then select the vertex (vertices) to align. To select multiple blocking vertices, hold the Ctrl key while selecting.

You can also select edges or faces. The vertices on these will be aligned to the plane.

2. Click Select 3 vertices or plane

,
and then select three vertices or a plane to align to. You can also select a geometric planar face, a block face, or
a plane.

15.5.2.5. Associating the Blocking to Geometry
The Associate

tool creates logical links between the blocking topology (faces, edges, vertices) and CAD geometry (surfaces, curves,
points). This allows the blocking, and therefore the mesh, to be updated automatically when the geometry is modified.
It also allows blocking topology to be reused with similar geometry. When a blocking file is loaded, the software will
attempt to re-associate the blocking topology to the nearest appropriate geometry.
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Blocking entities may be associated with geometry entities of the same or higher dimension. That is, blocking vertices
(0D) may be associated with geometry points (0D), curves (1D), or surfaces (2D); but blocking faces (2D) may be
associated only with geometry surfaces. Such associations will constrain independent movement of blocking entities.

Visually, the existence of associations changes the colors of the blocking entities. In this image,

• Red vertices are associated to points on the geometry. If you attempt to move these without first disassociating,
the geometry may also be modified.

• Green vertices and edges are associated to curves on the geometry. You may move the vertices but they will be
constrained to stay on the associated curve.

• Purple (pink) vertices and edges are associated to surfaces. You may move the vertices, but they will be constrained
to stay on the associated surface.

• Blue (cyan) vertices and edges are not associated to any geometry. You may move the vertices freely.

When block edges are associated to curves, you can project the edge shape to match the geometry or identify the
associated curve.

• To project the edge shape, go to theMeshDisplaypanel. UnderBlock display options, enableProjected Shape.
The blocking edge will follow any geometry curvature.

• To identify the associated curve, disable Projected Shape and select the blocking edge(s) using the Associate
tool. Small arrows will appear between the selected edge(s) and associated curve(s).
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Associating a Block Vertex to a Geometry Vertex
1. Click Select block

entities ,
and then select a block vertex.

2. Click Select target geometry or

mesh ,
and then select a geometry vertex.

3. Click Complete

association
to create the association.

Associating Block Edge(s) or Vertex(vertices) to a Geometry Edge(s)
1. Click Select block

entities ,
and then select a block edge, a block vertex, a set of block edges, or a set of block vertices.

• You may select multiple blocking edges or vertices by holding the Ctrl key while selecting.

• When you release the Ctrl key, the tool guide will automatically switch to geometry selection.

2. Click Select target geometry or

mesh ,
and then select a geometry edge, set of edges, or a named selection group containing a set of edges.

• You may select multiple geometry edges by holding the Ctrl key while selecting.

• If you select multiple geometry edges, the edge segments will be grouped into a composite edge after the
association is created. If you do further association, there will be just the composite edge to select (see Split
Composed Target Edges for more information).

• You may switch from blocking selection to geometry selection by pressing the Alt key.

3. Click Complete

association to
create the association.

Associating a Block Face to a Geometry Face
1. Click Select block entities

,
and then and then select a block face.
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2. Click Select target geometry or

mesh ,
and then select a geometry face.

Note: If you want to associate a block face to multiple geometry faces, you should put the faces into a
named selection group and then select the named selection group instead of the geometry face.

3. Click Complete association

to create the association.

ResettingBlockFace(s),Edge(s)orVertex(vertices) toTheirDefaultAssociation
1. Click Select block

entities ,
and then select a block face(s) and/or edge(s) and/or vertex(vertices).

To select multiple faces, edges or vertices you can hold the Ctrl key or box select.

2. Click Complete

association to
reset the association. This will reset the block entities’ associations.

• For block topology on the boundary of the model the default associations will project to the closest geometry
faces.

• The default associations for internal topology will be not associated.

Disassociating Blocking Entities From Geometry Entities
1. Click Select block entities

,
and then click the block face(s), edge(s), or vertex (vertices) to be disassociated.

• You may select multiple blocking entities by holding the Ctrl key while selecting.

• Use Box Select to choose multiple block edges and vertices from which geometry associations are to be
removed.

Note: By design, box select under Select block entities works only on block edges and vertices. To box
select block faces, first make the selection using theSelect tool. You may then click theAssociate tool
and delete the association.
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2. Click Delete association

to disassociate the blocking from geometry.

You can use the following Blocking Association Options to modify the behavior of the Associate tool:

• Snapassociatedvertices is used to move vertices to the target geometry when the association is created. Default
is enabled.

• Update all associations to closest sets a filter to blocking edges only, which allows for easy selection of edges
for re-association to nearest appropriate geometry. Box select is available. This is useful to reset association of
edges after a model editing operation.

• Split Composed Target Edges can be used to separate geometry edges that were grouped to complete an
association. The tool guide to select block entities is disabled for this option as it only applies to geometry edges.
Disable the option to return to normal behavior.

• Compose targetedgesbyangle can be used to create a target edge for association from multiple edge segments.
Selected edge segments that meet within the threshold Tangential Angle will be grouped when the association
is created.

15.5.2.6. Shaping a Block Edge
The Shape/Link

tool enables you to add curvature to a block edge by adding or removing vertices along the edge. Alternatively, you
can reproduce the shape of one source edge onto one or more target edges. Shaping an edge can help the mesh
conform to the geometry better, and improves the mesh quality.
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Adding Curvature to a Block Edge
To add curvature to a block edge:

1. Click the Select Block Edge tool guide

.

2. Select a block edge. A vertex is added where you clicked and the edge is snapped to the geometry (curve).Click
and drag to position the vertex interactively.

3. Continue to add vertices as required.

In the Block Edge Shape options panel, you may set the following options:

• Enable Auto Shape to position the interior vertex, or vertices, optimally. If disabled, a single vertex is positioned
at the click position.

• Linear will snap the interior vertex (vertices) to the geometry and connect the new vertex (vertices) to existing
vertices with straight line segments.

If Auto Shape is enabled, multiple vertices are created with spacing set by mesh sizing. If disabled, a single vertex
is added at the click position.

º

• Spline will snap the interior vertex (vertices) to the geometry and connect the new vertex (vertices) to existing
vertices with curved line segments.

If Auto Shape is enabled, a single new vertex is positioned at the midpoint of the selected edge. If disabled, it is
positioned at the click position.

Creating Edge Shape Links
To create edge shape links:

1. Click the Select source edge tool guide

.

2. Select the source edge. Only one edge may be source at one time.

3. Click the Select target edge tool guide

.

4. Select the target edge. The selected edge will reproduce the shape of the source edge.

Alternatively, hold the Ctrl key to select multiple edges. When all desired edges are selected, release the Ctrl
key to complete the link operation and to reset the tool to the Select source edge mode.

In the Link Edge Options panel, select the scaling Factor to set the degree to which the target is shaped.

In the following example, one of the curved edges on the cylinder end is selected as the source. The target edge is
the straight edge at the bottom of the image.

With Factor set at 100%, the full curvature is applied.
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With Factor set at 33%, the depth of curvature is reduced to 1/3.

Removing Curvature From a Block Edge
To remove curvature from a block edge:

1. If not selected, click the Select Block Edge tool guide.

.

2. Click the Remove edge curve point tool guide

.

3. Select a block edge. All interior vertices will be removed from the edge.

4. Alternatively, select a single, interior vertex. The selected vertex will be removed from that edge.

Unlinking Edge Shapes
To unlink edge shapes:

1. If not selected, click the Select source edge tool guide.

2. Click the Unlink edge tool guide.

3. Select a target edge to unlink it from the source edge. Clicking a previously linked edge will return it to its default
shape. Alternatively, use box select to select multiple edges. Click theUnlink edge a second time to remove any
edge shape links.
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15.5.3. Pulling a Mesh or Blocking

The
Pull tool can be used to add or cut blocking and mesh. You can pull a mapped or free face, creating a mapped or
swept volume block, respectively. Alternatively, you can pull edges of a free block up to the other side to cut out
swept or mapped blocks to slice up the blocking into more swept or mapped blocks.

Adding Blocking Using the Pull Tool
1. Select the Pull tool from the Edit group.

2. Select the block face, or block faces to be extruded. You may pull one or more free or mapped faces or a
combination of free and mapped faces.

3. Check the Add tool guide is active.

4. Disable Snap associated vertices if there is no geometry to project to.

5. Drag the face or set a dimension for the pull distance. A mapped or swept block is created by extruding the
selected mapped or free face, respectively.
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Splitting Blocking Using the Pull Tool
1. Select the Pull tool from the Edit group.

2. Select the block edges to be extruded.

3. Click the Cut tool guide or select Cut in the Options panel.

4. Use the Up To tool guide to select a face on the opposite side of the model as shown below.

Note: The default behavior is to shape the sweep path by the boundary edge connection between source
and target. If this connection is via a curved boundary, the sweep path will be shaped by the curved
geometry.

Optionally, select an edge, or set of edges, to define the sweep path shape. Selecting the set of curved edges
creates a curved sweep path rather than the default straight path.
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Pulling Sheet Blocks to Solid Blocks (Without Associations)
1. For a sheet part, create the blocking for a face or set of faces.

2. Select the Pull tool from the Edit group.

3. Select the block face, or block faces to be extruded.

Note: You cannot pull only some faces of a sheet blocking to solid blocking. A blocking must be either
entirely sheet blocks or entirely solid blocks, so when pulling sheets to solids, make sure all sheets in
the blocking are pulled.

4. DisableSnapassociatedvertices to prevent automatic re-association when vertices are moved across geometry
boundaries.

5. Select the Up To tool guide and select the reference face to pull up to. A new mapped or swept block is created.
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Note: Block edges cannot be pulled to create a surface.

Pulling Sheet Blocks to Solid Blocks (With Associations)
To mesh thin parts where features on top and bottom may vary slightly, you can do the following:

1. Generate a shell mesh on the top faces (ignoring or capturing features as desired).

2. Select the Pull tool from the Edit group.

3. Select the block face, or block faces to be extruded.

Note: You cannot pull only some faces of a sheet blocking to solid blocking. A blocking must be either
entirely sheet blocks or entirely solid blocks, so when pulling sheets to solids, make sure all sheets in
the blocking are pulled.

4. Leave Snap associated vertices enabled so that the software can find the appropriate faces to associate the
blocks to.

5. Select theUpTo tool guide and select the reference face to pull up to. New mapped or swept block(s) are created.

Note: You only need to select one face to pull up to. The software gets the pull distance from the selected
face. The extruded block faces are then associated to the nearest geometry (so it can handle some
deviation in thickness).
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Pulling Block Faces Radially With the Revolve Tool Guide
To select multiple, connected/disconnected 2D block faces or faces of 3D blocks and pull radially, you can do the
following:

1. Generate the mesh on the block face(s) (ignoring or capturing features as desired).

2. Select the Pull tool from the Edit group.

3. Select the block face, or block faces to be extruded.

Note: You cannot pull only some faces of a sheet blocking to solid blocking. A blocking must be either
entirely sheet blocks or entirely solid blocks, so when pulling sheets to solids, make sure all sheets in
the blocking are pulled.

4. Select the Revolve tool guide and select the axis of rotation.

5. Leave Snap associated vertices enabled so that the software can find the appropriate faces to associate the
blocks to.

6. Select the Up To tool guide and select the reference face to pull up to.

The example shows the use of the Revolve tool, along with the standard pull operation, and carving out the
blocking using a combination of Split and Associate operations to generate the desired mesh.
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Pulling Geometry When a Blocking/Mesh Exists
• Pull operations can be defined prior to meshing or after meshing. ThePull operation can be parameterized using

Groups.

• When geometry is pulled when a blocking/mesh exists, the blocking/mesh tries to maintain the associations to
the geometry. This can be used to define a parametric mesh.

• If the Pull operation does not change the topology, (that is, the number of vertices, edges, faces remain the same
before and after the operation), the blocking will adjust parametrically. If the geometry does change topologically,
the association of the blocking entities is adjusted to the closest geometric entity, or the associations are released
if possible. In some situations, you may need to adjust the associations manually after such operations.

Note: If a sheet body is meshed and you pull the sheet body to a solid body, the mesh will be removed as
this operation is not supported.

15.5.4. Blending a Mesh or Blocking

The
Blend tool can be used to modify mesh and blocking.

You can use the Blend tool with the Add option to create a mapped block between two mapped faces on volume
blocks (or between two edges in surface blocking).

Using the Blend tool with the Cut option can sweep a loop of edges to cut through a free volume block.
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Creating a Mapped Block
1. Select two blocking faces (two blocking edges for surface blocking).

2. RetainSnapAssociated forBlockOptions, if there is geometry to project to in the newly created region. If there
is no geometry to project to, disable the Snap Associated option.

3. Click Complete.

A new mapped block is created. It will appear in the structure tree under the first body selected.

The smaller size control will be applied to the new block and will propagate through any parallel edge of attached,
mapped blocks.
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Sweeping a Loop of Edges
1. Double click an edge on the source loop of edges.

2. Hold the Ctrl key and double-click an edge on the target loop. The source and target loops must have the same
number of edge segments.

3. Select the Cut option.

4. Click Complete. A new swept or mapped block is created depending on the type of face in the source loop of
edges.

Creating a Blend (Weld) Between Faces
1. Select two blocking faces.
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2. Retain Snap Associated for Block Options if the weld geometry exists either as a surface or as a solid. If there
is no weld geometry, disable Snap Associated so that the new weld face will not be projected to the geometry.

3. Click Complete.

A new swept block representing the solid weld is created.

Note:

• The plates being welded should be in the same component so that only one blocking exists. Faces cannot
be shared between two separate blocking components.

• If the weld geometry exists either as a surface or as a solid, you may prefer to use the Snap Associated
option so that the new block faces that are created are associated to the geometry. Also note that the
weld geometry should be in the same component as the plates for the same reason.
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• Plates can be meshed as separate components with separate component blocking, but in this situation
the edges and faces may be duplicate. Use Merge Blocking to merge the blocking components together
prior to generating the welds. After merging blockings you can check the edge/face connectivity to ensure
the edges/faces are properly connected.

• The weld created will have the same material (family) as the face which was selected first.

If another weld exists connected to the current (new) weld, the material (family) from the neighboring
weld will be used.

If there are welds on both sides which have different materials (families), the material (family) from the
first selected face is used.

15.5.5. Projecting Mesh or Blocking
The
Project tool can be used to imprint a loop of edges to a target face, through a free, volume block.
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Projecting a Loop of Block Edges
To project a loop of block edges:

1. Select the source loop of edges using the Select Curves tool

guide .You
may double-click to select a closed loop of edges. Repeated double-click will cycle through possible loops.

2. Select the target face using the Select Target Faces tool guide

.The
target face may be a free face or mapped face on a free block.

3. Click Complete.
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Note: The projection will look like the target surface mesh.

15.6. Fixing the Mesh
After meshing, the Status History information messages provide feedback to help you visualize, troubleshoot, and
solve problems with the mesh. If meshing was successful on all parts, the Information message gives some details
and statistics of the meshing process. If unsuccessful in meshing all parts, error messages are generated with some
detail on which bodies failed, and possibly which faces failed, leading to the failed body mesh. These error details
can assist you in troubleshooting problems.

Troubleshooting Meshing Problems Using the Status History
• If you select any error message, the software will attempt to highlight the failed topology in the Design window

so you can more easily identify the problem. The failed topology should blink three times. If you select the error
message a second time, the failed topology should blink another three times.

• If you double-select any error message (click the right mouse button two times fast), the software will zoom (if
Zoom option is enabled) into the failed topology, and select the topology.

Restricting the Design Window to Only Parts With Failed Mesh
To restrict the design window to only those parts that have failed to mesh or have failed due to a given error message:

1. Double-select the error message to select the offending topology.

2. In the design window, right-click over white space and pick Select > Component from the Context menu.

3. Click the right mouse button again, and then select Hide Others from the Context menu.

Using the Status History Buttons
Click ...To ...

Zoom to objects on double-select.

Copy selected items to the clipboard.

Delete all messages and close Status history.
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Troubleshooting Blocking Problems
If Meshing fails for any bodies or parts, but a blocking was created, you can use block editing tools to fix the block
topology. Typical problems preventing successful meshing after blocking include the following:

• Small edges or fine features: Sometimes fine features are included in the blocking topology, making it virtually
impossible to get a good quality mesh in such regions of the model. In this case, you can use the Delete tool or
Merge tool to defeature such problems in the blocking.

• Problematic faces: In some cases, the error messages will lead to one or more problematic faces. Zoom in to look
for odd shapes, missing connectivity, slivers or other similar problems. In this case, you can use the Split tool or
Merge tool to fix the connectivity of the face or to simplify the face so that it is more easily meshed.

• Problems creating a watertight solid: In this case, surface blocking may be generated but no volume blocks.
This is typically caused by single-connected edges (no adjacent surface) or triple-connected edges. To find single
and triple edges, turn on Edge Connectivity in the Display options panel, and look for red (single) and/or pink
(multiple) edges. You can use the block editing tools to fix any single- or triple-connected edges in the surface
blocking. For example, theMove tool may be used on an edge to close a small gap between two single-connected
edges. Once all edges are double-connected, you can right-click Blocking in the Structure tree, and use Solidify
to convert the surface blocking to a solid blocking.

If blocking was successful, but after some block editing, the block topology seems to be problematic, you can try to
fix the blocking by right-clicking the blocking in the Structure tree and selecting Check Blocking > Check/Fix. The
Check/Fixoperation tries to resolve some problems in indexing, orientation and connectivity that can cause problems
while meshing.

15.7. Checking the Mesh
After creating the mesh, you should check it to make sure it is satisfactory.

To check the mesh, you can do the following:

• You can change the display to inspect the mesh visually.

There are options to examine the mesh elements on the surface of your model as well as internally. Other options
can display how surfaces or edges are shared between mesh regions. See Setting mesh display options.

• You can view detailed mesh statistics for your model.

Statistics for element count by type and various mesh quality metrics are available to validate the mesh
quantitatively. See Viewing quality statistics.

• You can validate the body mesh generated. This option is especially useful as a helper function for scripting.

To validate the mesh, selectMesh in the Structure tree, and select the Validate option from the context-sensitive
menu.

15.7.1. Setting Mesh Display Options
After creating the mesh, you can use the tools in the Display group of the Mesh ribbon to inspect the mesh visually,
display mesh statistics and identify the location of the lowest quality elements.

• Toggling mesh element visibility:

Mesh elements are visible by default. You can use the Mesh

tool to toggle display of the mesh.
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• Managing Mesh Display options:

Use the Options

tool to open the Mesh Display panel, which allows you to choose what appears in the Design window. Toggle
visibility of each option depending on your area of interest. See managing mesh display for details.

• Viewing Quality statistics:

Click the Quality

tool to toggle the Metrics panel. See Viewing quality statistics.

• Viewing geometry hidden by mesh:

To see the geometry "behind" the mesh, enable Periscope highlighting.

Use Periscope

to toggle periscope highlighting.

• Hiding blocking faces:

You can hide faces of free blocks using the RMB context menu.

Only faces attached to free blocks can be hidden, but you can hide either free faces or mapped faces. If you attempt
to hide a face on a mapped or swept block, the entire block will be hidden. The Structure tree is modified to
indicate hidden face(s).

To restore (unhide) the hidden face(s), cycle the display of the free block off then back on in the Structure tree.

Managing Mesh Display Options
Use the Options

tool to open theMeshDisplaypanel, which allows you to choose what appears in the Design window. Toggle visibility
of each option depending on your area of interest.
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General Options
• ShowMesh Controls If enabled, local mesh controls that have been applied to geometry entities will be shaded

according to the type of control. See Managing local mesh controls.

Turn ShowMesh Controls off to hide the mesh controls. The default is on.

Note:

º If the Mesh On/Off button is turned off in the Mesh ribbon, mesh control visibility is also turned off.

º ShowMesh Controls will only show the meshing controls assigned to the geometry. To see how the
Map/Sweep controls are applied to the block topology that is created when meshing, it could be helpful
to turn on the option Show Block Cage > Shaded.

• ShowMesh This is an alternative to the Mesh

tool to toggle display of the mesh.

Connectivity Options
Use the connectivity options to indicate the number of shared blocking elements connected to a blocking face or
edge.

• To indicate the number of connected edges by color, enable Edges.

º Red indicates the edge is connected to only one face or it is a perimeter edge for surface blocking.
º Blue indicates two connected faces.
º Pink indicates three connected faces.
º Yellow indicates an interior edge in volume blocking, connected to more than three faces.

• To indicate which block faces are shared between two volume blocks, enable Faces.
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Image a) shows surface blocking with Shaded enabled. The rectangular area is mapped while the circular area is
free. The blue line is the edge separating the mapped surface blocking from the free surface blocking. In Image b)
Shaded is disabled. The image shows volume blocking with edge and face connectivity enabled. Edge coloring
indicates the number of connected faces and the green surfaces indicate shared faces.

Block Display Options
Use the block display options to provide visual information about the blocking topology and underlying geometry.

• To toggle visibility of blocking faces, edges, and vertices in the design window, you can use Show Block Cage.

Then, the following options determine what is displayed.

º To show block vertices, enable Vertices.

Note: Edge split vertices used for shaping the edge remain even if block vertices are not shown.

º To shade block faces based on the block type, enable Shaded.

Solid blocks that are mapped will have their faces displayed as green.

Solid blocks that are swept will have their faces displayed as blue.

Solid blocks that are free will have their faces display as red.

The displayed surface texture indicates the type of surface mesh. A checker board pattern indicates mapped
mesh, solid indicates free mesh.

º To show block edges, including edge split vertices used for shaping blocking edges, if they exist, enableWireframe.

Note: The color of displayed edges and vertices indicates how they are associated to the underlying
geometry, assuming Edges connectivity display is disabled. See Associating the blocking to geometry.

• To toggle transparency of the underlying geometry (when mesh visibility is turned off), you can useGhostblocked
geometry. Default is enabled.

º For bottom up block editing, it is usually helpful to make the geometry more transparent to see the block edges
and vertices as you edit.

º For top down block editing, it is usually helpful to make the geometry more opaque to see how the block edges
associate to the geometry.
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• To closely fit the blocking faces and edges to curved geometry, enable Projected shape.

Edge split vertices used for shaping blocking edges, if they exist, will remain on the associated curves even if
Projected Shape is disabled.

Note: Projected shape of surfaces is achieved by projecting nodes in the mesh to the geometry. If you
zoom in, you can see the straight-line borders of the individual mesh facets.

Visualizing Internal Mesh Elements
You can inspect the internal mesh cells using Clip with Plane. When the mesh exists, the clip plane(s) can be used
to see the internal mesh.

• Multiple clipping planes may be enabled simultaneously. The default when more than one section view is enabled
is Union, meaning the sum of all displayed sections is visible. Disable Union in the context menu to view the
intersection of all displayed cross-sections.

• Toggle Reverse Direction in the context menu to view the cross-section from the opposite side.

Note: Section mode does not currently support clipping of mesh.

15.7.2. Viewing Quality Statistics
You can view detailed mesh quality statistics to help determine if your mesh is ready for your solver. The following
options are available:

• You can view blockingmesh quality or bodymesh quality at the body level.
• You can choose from several common measures for quality statistics.
• You can filter the element display based on the selected quality measure.

Viewing Mesh Quality Statistics
Click the Quality

tool in the Display group.
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The Quality tool icon will be highlighted and the Metrics panel will open showing the selected qualitymetric with
its global minimum and maximum value.

• The worst 10% elements will be shown when Mesh quality is displayed. You can change the range of elements
displayed by enabling the Show elements in range option and specifying the Min and Max values based on the
computed ranges.

• To close the Mesh Quality panel, click the highlighted Quality tool in the ribbon.

• To choose between blocking mesh and body mesh, toggle the High Fidelity option to choose blocking mesh or
body mesh when the Physics Type is Structural. The High Fidelity option is not applicable when the Physics
Type is Fluid Dynamics.

º If disabled (default is OFF), the statistics and display are for the Blockingmesh.

Blocking mesh always uses linear element order. If you have specified quadratic element order for your mesh,
the mesh is made quadratic on transfer to Mechanical.
Blocking mesh does not always project fully to the geometry. It uses fast interpolation schemes to speed up
the display.

º If enabled, the statistics and display are for the Bodymesh.

AMesh entity will be created under each body in the Structure tree. To remove the body mesh, you must close
the Quality panel with High Fidelity disabled.
Body mesh contains quadratic mid-side nodes (if quadratic element order is chosen) and is fully projected to
the geometry.
A Mesh Statistics panel is added to show the element count by shape.

Note: Screen updates will be slower and there may be small differences between the values displayed
for blockingmesh and bodymesh because blocking mesh calculations are done assuming linear
elements (no mid-side nodes) and body mesh calculations recognize quadratic elements (with mid-side
nodes) if they are present.

• To choose another quality measure, use the Choose a quality metric drop-down.

The list of available quality metrics will change if High Fidelity is enabled although there is some overlap.
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Metrics Available for Both Blocking Mesh and Body Mesh

Jacobian Ratio
The Jacobian Ratio metric compares the shape of a given element to that of an ideal element. If an element has a
poor Jacobian ratio, the element may not map well from element space to real space, thereby making computations
based on the element shape less reliable. The ideal shape of a hexahedron has all flat sides and 90 degree angles.

There are two ways to calculate the Jacobian Ratio, either based onCornerNodes (nodal points) or based onGauss
Points (integration points). The corner node calculation is more restrictive while the Gauss points calculation is less
restrictive. In either case, the value is bounded by -1 (worst) and 1 (best). An element with Jacobian ratio <= 0 should
be avoided.

An element's Jacobian ratio is computed by the following steps and using all available nodes for the element:

1. At each sampling location listed in the table below, the determinant of the Jacobian matrix is computed and
called RJ. At a given point, RJ represents the magnitude of the mapping function between the element's natural
coordinates and real space. In an ideally-shaped element, RJ is relatively constant over the element, and does
not change sign.

RJ Sampling Locations for corner
nodes calculation

RJ Sampling Locations for corner
nodes calculation

Element Shape

Choose the optimal number of Gauss
quadature points for integration

Corner nodes8-node bricks

Eight Gauss quadrature pointsAll nodes and centroid20-node bricks

2. The Jacobian ratio of the element is the ratio of the minimum to the maximum sampled value of RJ.

The Jacobian ratio of an ideal hexahedral element is 1, indicating (a) its opposing faces are all parallel to each other,
and (b) each midside node, if any, is positioned at the average of the corresponding corner node locations. As a
corner node moves near the center, the Jacobian ratio worsens. If the node is moved significantly, the Jacobian
ratio will become negative and the element is invalid.

The figure below illustrates the Jacobian ratio metric by color for various element shapes.
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Aspect Ratio
• When High Fidelity is enabled, the Aspect Ratio metric is calculated using the ratio of the lengths of sides. The

details vary depending on the type of surface element (face).

º Aspect Ratio Calculation for Triangles

The aspect ratio for a triangle is computed in the following manner, using only the corner nodes of the element.

1. For each node (I, J, and K in the following image), a line is constructed from that node of the element to the
midpoint of the opposite edge, and another through the midpoints of the other 2 edges. In general, these
lines are not perpendicular to each other or to any of the element edges.
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2. Rectangles are constructed centered about each of the 2 lines, with two edges parallel to one of the lines,
and all edges passing through the element edge midpoints and the triangle apex.

3. These constructions are repeated using each of the other 2 corners as the apex.

4. The Aspect Ratio of the triangle is the ratio of the longer side to the shorter side of whichever of the 6
rectangles is most stretched, divided by the square root of 3.

The best possible triangle aspect ratio occurs for an equilateral triangle and is 1. A comparison between an
equilateral triangle and a triangle having an aspect ratio of 20 is shown below.

º Aspect Ratio Calculation for Quadrilaterals

The aspect ratio for a quadrilateral is computed by the following steps, using only the corner nodes of the
element.

1. If the element is not flat, the nodes (I, J, K, and L in the following image) are projected onto a plane passing
through the average of the corner locations and perpendicular to the average of the corner normals. The
remaining steps are performed on these projected locations.

2. Two lines are constructed that bisect the opposing pairs of element edges and which meet at the element
center. In general, these lines are not perpendicular to each other or to any of the element

edges.
3. Rectangles are constructed centered about each of the 2 lines, with two edges parallel to one of the lines,

and with all edges passing through the element edge midpoints.
4. The Aspect Ratio of the quadrilateral is the ratio of a longer side to a shorter side of whichever rectangle is

most stretched.

The best possible quadrilateral aspect ratio occurs for a flat square and is one. A comparison between a square
and a quadrilateral having an aspect ratio of 20 is shown below.

º Aspect Ratio for Hexahedra
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The Aspect Ratio metric for hexahedral elements is defined as the size of the minimum element edge divided
by the size of the maximum element edge. The values are scaled and the default range of values is 1-20, such
that an Aspect ratio of 1 indicates a regular element.

• When High Fidelity is disabled, the Aspect Ratio metric is calculated for different element types as follows:

º Aspect Ratio for Quadrilaterals/Pyramids

The aspect ratio is the Determinant, which is the ratio of the smallest determinant of the Jacobian matrix divided
by the largest determinant of the Jacobian matrix, where each determinant is computed at each node of the
element. A value of 1 would indicate a perfectly regular mesh element, 0 would indicate an element degenerate
in one or more edges, and negative values would indicate inverted elements.

º Aspect Ratio for Prisms

The quality is calculated as the minimum of the Determinant and Warpage. The Determinant is the ratio of the
smallest determinant of the Jacobian matrix divided by the largest determinant of the Jacobian matrix, where
each determinant is computed at each node of the element. Warpage is normalized to a factor between 0 to 1,
where 90 degrees is 0, and 0 degrees is 1.

º Aspect Ratio for Hexahedra

The quality is a weighted diagnostic between Determinant (between -1 and 1), Max Orthogls (normalized between
-1 and 1; if deviation from orthogonality is greater than 90 degrees, then the normalized value will be smaller
than 0) and Max Warpgls (normalized between 0 and 1; warpage of 0 degrees is 1, warpage of 180 degrees is 0).
The minimum of the 3 normalized diagnostics will be used.

The Determinant is the ratio of the smallest determinant of the Jacobian matrix divided by the largest determinant
of the Jacobian matrix, where each determinant is computed at each node of the element.

The Max Orthogls calculates the maximum deviation of the internal angles of the elements from 90 degrees. For
hexahedra, angles between 180 and 360 degrees are also considered (deviation up to 270 degrees).

To determine the warp of a quadrilateral face, the angles between the triangles connected at the 2 diagonals
of the quad will be calculated and the maximum will be used. The maximum warp of the hexahedral element
is the maximum warp of its quad faces.

º Aspect Ratio for Triangles

The ratio between the area of triangle and the maximum edge length for each element is calculated. The values
are scaled, so that an aspect ratio of 1 corresponds to a perfectly regular element, while an aspect ratio of 0
indicates that the element has zero area.
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º Aspect Ratio for Tetrahedra

The ratio between the volume of the element and the radius of its circumscribed sphere power three is calculated.
The values are scaled, so that an aspect ratio of 1 corresponds to a perfectly regular element, while an aspect
ratio of 0 indicates that the element has zero volume.
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Element Quality
The Element Quality metric provides a composite quality value that ranges between 0 and 1. This metric is
proportional to the ratio of the area to the sum of the square of the edge lengths for quad/tri surface elements, or
the ratio of the volume to the square root of the cube of the sum of the square of the edge lengths for volume
elements. A value of 1 indicates a perfect cube or square while a value of 0 indicates that the element has a zero or
negative volume.

This can also be expressed as follows:

For quad/tri surface elements,

,
where c represents a constant which depends on the element type.

For brick volume elements,

,
where c represents a constant which depends on the element type.

The following table lists the value of C for each type of element:

Value of CElement
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6.92820323Triangle

4.0Quadrangle

124.70765802Tetrahedron

41.56921938Hexahedron

62.35382905Wedge (prism)

96Pyramid

Orthogonal Quality
The Orthogonal Quality metric is computed using the face (edge) normal vectors and vectors between centroids
of adjacent cells (faces, edges). The range for orthogonal quality is 0 - 1, where a value of 0 is worst and a value of 1
is best.

Orthogonal quality is the default metric when the Physics Type is set to Fluid Dynamics.

The Orthogonal Quality for 3D cells is computed using the face normal vector (

)
for each face, the vector from the cell centroid to the centroid of each of the adjacent cells (

),
and the vector from the cell centroid to the centroid each of the faces (

).
The image below illustrates the vectors used to determine the orthogonal quality for a cell.

For each face, the cosines of the angle between

and
, and between
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and
, are calculated. The smallest calculated cosine value is the orthogonality of the cell. Finally, Orthogonal Quality
depends on cell type:

• For tetrahedral, prism, and pyramid cells, the Orthogonal Quality is the minimum of the orthogonality and (1 -
cell skewness).

• For hexahedral cells, the Orthogonal Quality is the same as the orthogonality.

In a similar way, Orthogonal Quality for 2D faces is computed as the smallest cosine of the angle between the edge
normal vector,

for each edge and the vector from the face centroid to the centroid of each edge,

.
The image below illustrates the vectors used to determine the orthogonal quality for a face.

Note:

• When the cell is located on the boundary, the vector

across the boundary face is ignored during the quality computation.
• When the cell is separated from the adjacent cell by an internal wall (a baffle), the vector

across the internal boundary face is ignored during the quality computation.
• When the adjacent cells share a parent-child relation, the vector

is
the vector from the cell centroid to the centroid of the child face while the vector
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is
the vector from the cell centroid to the centroid of the adjacent child cell sharing the child face.

Tip: Orthogonal Quality is equivalent to Inverse Orthogonal Quality in Ansys Fluent Meshing, except that
the scale is reversed:

Inverse Orthogonal Quality = 1 - Orthogonal Quality

The orthogonal quality values may not correspond exactly with the inverse orthogonal quality values in
Ansys Fluent because the computation depends on boundary conditions on internal surfaces (WALL vs.
INTERIOR/FAN/RADIATOR/POROUS-JUMP). Ansys Fluent may return different results which reflect the
modified mesh topology on which CFD simulations are performed.

Skewness
The Skewness metric is one of the primary quality measures for a mesh. Skewness determines how close to ideal
(equilateral or equiangular) a face or cell is. The image below compares highly skewed faces to ideal faces.

The following table lists the range of skewness values and the corresponding cell quality.

Cell QualityValue of Skewness

degenerate1

bad (sliver)0.9 — <1

poor0.75 — 0.9

fair0.5 — 0.75

good0.25 — 0.5

excellent>0 — 0.25

equilateral0
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According to the definition of skewness, a value of 0 indicates an equilateral cell (best) and a value of 1 indicates a
completely degenerate cell (worst). Degenerate cells and slivers are characterized by nodes that are coplanar or
nearly coplanar (colinear in 2D).

Highly skewed faces and cells are unacceptable because the equations being solved assume that the cells are
relatively equilateral/equiangular.

Two methods for measuring skewness are:

• Based on the equilateral volume (applies only to triangles and tetrahedra).
• Based on the deviation from a normalized equilateral angle. This method applies to all cell and face shapes,

including pyramids and prisms.

Equilateral-Volume-Based Skewness

In the equilateral volume deviation method, skewness is defined as

,
where the optimal cell size is the size of an equilateral cell with the same circumradius.

Quality meshes have a skewness value of approximately 0.1 for 2D and 0.4 for 3D. The table above provides a general
guide to the relationship between cell skewness and quality.

In 2D, all cells should be good or better. The presence of cells that are fair or worse indicates poor boundary node
placement. You should try to improve your boundary mesh as much as possible, because the quality of the overall
mesh can be no better than that of the boundary mesh.

In 3D, most cells should be good or better, but a small percentage will generally be in the fair range and there are
usually even a few poor cells.

Normalized Equiangular Skewness

In the normalized angle deviation method, skewness is defined (in general) as

,
where

θ max = largest angle in the face or cell

θmin = smallest angle in the face or cell

θe = angle for an equiangular face/cell (60 for a triangle, 90 for a square)

For a pyramid, the cell skewness will be the maximum skewness computed for any face. An ideal pyramid (skewness
= 0) is one in which the 4 triangular faces are equilateral (and equiangular) and the quadrilateral base face is a square.
The guidelines in the table above apply to the normalized equiangular skewness as well.

Note: The Equilateral-Volume-Based Skewness quality metric applies to any mesh element that includes
a triangular face. For triangular and tetrahedral elements, all faces of which are strictly triangular, the
Equilateral-Volume-Based Skewness metric applies directly. For wedge or pyramidal elements, which include
combinations of triangular and quadrilateral faces, the Meshing application computes both
Equilateral-Volume-Based Skewness metrics (for the triangular faces) and Normalized Equiangular Skewness
metrics (for the quadrilateral faces and 3-D element, itself) and reports the maximum computed metric as
the element skewness. As a result, Equilateral-Volume-Based Skewness metrics reported for meshes that
contain wedge and/or pyramidal elements may include skewness values attributable to Normalized
Equiangular Skewness computations.

Characteristic Length
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Characteristic length (also called characteristic dimension) is used to compute the time step that satisfies the
Courant-Friedrichs-Lewy (CFL) condition for a given analysis setup. The CFL condition is of interest mostly in explicit
dynamics and computational fluid dynamics analyses. It governs the maximum time step for which a solution will
be stable.

The characteristic length is defined based on the element type.

For hexahedral elements:

where:

Lc = characteristic length of the hex element

V = volume of the hex element

A = area of the element face

For tetrahedral elements:

where:

Lc = characteristic length of the tet element

h = height of the tet element from a node to its opposite face.

For pyramid elements: (5-node solid element)

where:

Lc = characteristic length of the pyramid element

h = height of the apex node to the base of the pyramid. Here, the base quad face can be divided into 4 different
triangles, the minimum height to these 4 triangles is used.

For Shell quad elements:

where:

Lc = characteristic length of the quad element

A = element area

L = element edge length

D = diagonal of the quad element

For Shell tri elements:
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where:

Lc = characteristic length of the tri element

A = element area

L = element edge length

Metrics Available for Blocking Mesh Only

Angle
The Angle metric checks the maximum internal angle deviation from 90 degrees, for each element. If the elements
are distorted such that internal angles are small, the accuracy of the solution will decrease. You should check your
solver specifications to obtain the limit for the internal angle threshold.

Volume
The Volume metric computes the volume of each element based on the corner points. The default range is 0-20. If
the computed maximum is above 20, then the computed range will be scaled to fit this 0-20 range.

Warpage
TheWarpagemetric computes the distortion of a quadrilateral face relative to a plane, based upon the corner nodes
of that face. The default range is 0-90, where a warpage value of 0 is planar (preferred) while 90 is degenerate. The
warpage for a hexahedral element is the largest of the values for the six individual faces.

Metrics Available for Body Mesh Only

Maximum Corner Angle
The Maximum Corner Angle metric states the maximum angle between adjacent edges and is computed using
corner node positions in 3-D space. (Midside nodes, if any, are ignored.) For example, the best possible maximum
corner angle for a triangle occurs for an equilateral triangle and is 60°. The best possible maximum corner angle for
a quadrilateral occurs for a flat rectangle and is 90°. The images compare Maximum Corner Angle for ideal and
non-ideal triangles and quadrilaterals, respectively.

Parallel Deviation
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The Parallel Deviation metric is computed for quadrilateral surface elements, or quad faces of volume elements,
using the following steps:

1. Ignoring midside nodes, unit vectors are constructed in 3-D space along each element edge, adjusted for consistent
direction, as illustrated in the image below.

2. For each pair of opposite edges, the angle between the vectors is computed using their dot product. In the
illustration above, the dot product of the 2 horizontal unit vectors is 1, and angle between the vectors is acos (1)
= 0°. The dot product of the 2 vertical vectors is 0.342, and the angle is acos (0.342) = 70°.

3. The parallel deviation is the larger of these 2 angles. In the illustration above, with angles of 0° and 70°, this
element's parallel deviation is 70°.

The best possible parallel deviation is 0° and occurs for a flat rectangle. The image below shows quadrilaterals having
parallel deviations of 0°, 70°, 100°, 150°, and 170°.

Warping Factor
The Warping Factor metric is computed for quadrilateral shell elements, and the quadrilateral faces of bricks
(hexahedra), wedges (prisms), and pyramids. A high factor may indicate a condition the underlying element
formulation cannot handle well, or may simply hint at a mesh generation flaw.

Warping Factor Calculation for Quadrilateral Shell Elements

A quadrilateral element's warping factor is computed from its corner node positions and other available data by
the following steps:

1. An average element normal is computed as the vector (cross) product of the 2 diagonals as shown below.

2. The projected area of the element is computed on a plane through the average normal.

3. The difference in height of the ends of an element edge is computed, parallel to the average normal. As illustrated
below, this distance is 2h. Because of the way the average normal is constructed, h is the same at all four corners.
For a flat quadrilateral, the distance is zero.
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4. The "area warping factor" (

)
for the element is computed as the edge height difference divided by the square root of the projected area.

5. If the shell element thickness is available, the "thickness warping factor" is computed as the edge height difference
divided by the average element thickness. This could be substantially higher than the area warping factor
computed in 4 (above).

6. The computed Warping Factor is the larger of the area factor and, if available, the thickness factor.

7. The best possible quadrilateral warping factor occurs for a flat quadrilateral and is zero.

The series of images below compares a "warped" element plotted on top of a flat one for several values of Warping
Factor. Only the right-hand node of the upper element is moved. The element is a unit square, with a real constant
thickness of 0.1.

• When the upper element is warped by a factor of 0.01, it cannot be visibly distinguished from the underlying flat
one.

• When the upper element is warped by a factor of 0.04, it just begins to visibly separate from the flat one.
• Warping of 0.1 is visible given the flat reference, but seems trivial. However, it is well beyond the error limit for a

membrane shell.
• Warping of 1.0 is visually unappealing. This is the error limit for most shells.
• Warping beyond 1.0 would appear to be obviously unacceptable. Furthermore, the warping factor calculation

seems to peak at about 7.0. Moving the node further off the original plane, even by much larger distances than
shown here, does not further increase the warping factor for this geometry.

Warping Factor Calculation for 3-D Solid Elements

The warping factor for a 3-D solid element face is computed as though the 4 nodes make up a quadrilateral shell
element with no real constant thickness available, using the square root of the projected area of the face as described
in 4 (above).

The warping factor for the element is the largest of the warping factors computed for the 6 quadrilateral faces of a
brick (hexahedron), 3 quadrilateral faces of a wedge (prism), or 1 quadrilateral face of a pyramid. Any brick element
having all flat faces has a warping factor of zero. For example, twisting the top face of a unit cube by 22.5° and 45°
relative to the base produces warping factors of about 0.2 and 0.4, respectively as shown in this image.
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Filtering the Element Display
Check the Show elements in range box. The Minimum: and Maximum: range values will be enabled in the panel.

To filter the displayed mesh, enter new values for Minimum or Maximum. You may type a new value or use a slide
control that appears when editing a value. Only those elements within the filter range will be displayed. If High
Fidelity is enabled to show Mesh Statistics, only filtered elements will be counted.

Note: If all/most elements in a block appear to be negative, it is possible that the block is inverted.

To fix such problems, do one of the following:

• Right-click the Blocking object in the tree and select Check Blocking > Fix Inverted.
• Select the problematic block in the Structure tree, and right-click and select Invert Selected

15.8. Transferring a Mesh to Downstream Systems in Ansys Workbench
After you are satisfied with the mesh, you can transfer it to your downstream solver to set up the physics solution
for your study.

Note: By default, the underlying geometry is excluded when transferring the mesh to downstream systems.
The geometry is suppressed when meshed and it will not be passed to downstream systems. The blocking
material and faces represent the geometry that is transferred to downstream systems.
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Transferring Mesh to Mechanical Solvers
If using Workbench and transferring to a downstream Mechanical solver, the software will transfer geometry and
mesh data as follows:

• Meshed bodies that have been suppressed for physics will not be transferred to the downstream systems.

Note: For models with multiple bodies in a single component, when transferring the mesh to Mechanical
solvers, one or more bodies may lose material assignments when the geometry is updated and transferred
again. For example, if a previously suppressed body is activated for physics and the mesh is transferred
to the downstream Mechanical solver, the body may lose its material assignment. You can identify such
tree objects by filtering the tree with the Scoping option set to Partial.

• If a part has not been meshed, it will transfer to Mechanical as an unmeshed body.

º In Mechanical, the Transfer Properties: Source will display as SpaceClaim.
º In Mechanical, any unmeshed body will have its state set as unmeshed. Such bodies will follow the typical

Mechanical meshing workflows wherein if you generate a mesh, only unmeshed bodies will be meshed.

• If a part has been meshed, the block topology (bodies, faces, edges, vertices) will be transferred to Mechanical as
geometry. The associated mesh is also transferred.

The body icon in the structure tree will indicate the geometry is suppressed
.

º Block materials are used to define the bodies in Mechanical.
º Quadratic element mid-side nodes are added to the mesh in the transfer to Mechanical, if applicable.
º In Mechanical, the Transfer Properties: Source will display as SpaceClaimMeshing.
º In Mechanical, any meshed body will have its state set as meshed.

To generate the body mesh, right-click Blocking in the Structure tree and select Body Mesh. You can also write
the mesh data to a file using the Save option and selecting the appropriate format. The Fluent export options can
be set in the SpaceClaim Options window.

Notes:

• You cannot use SpaceClaim as an external CAD system for Ansys Workbench, with Meshing enabled. If you want
to use SpaceClaim with Meshing enabled, disableUseSpaceClaimDirectModelerasanExternalCAD in Workbench
options.

• Any Match controls defined in SpaceClaim and used for meshing will be transferred to Mechanical as Cyclic
Symmetry.

• Named selections/groups created in SpaceClaim will be transferred. See Using Named Selections in Ansys on page
1154 for details on creating Named Selections in SpaceClaim.

• If using groups to transfer important groups/named selections of edges, faces or bodies, consider the following:

º Groups can be applied to edges, faces or bodies of the geometry and/or the blocking. If applied to the geometry
topology, the associated block topology should inherit the group information. That said, the transfer of the
groups to named selections in Mechanical are done using the block topology, so if named selections do not
come in properly to Mechanical it indicates a problem with the association. This can happen when there are
thin features, etc. and the mapping of the geometry to blocking is unclear. To avoid problems, it is often easiest
to just apply the groups directly to the block topology.

º Splitting blocks and other operations that change the block topology IDs can change the contents of groups.
For this reason, you should apply groups after the block topology is mostly complete.
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º When doing design studies where the topology IDs need to persist from one design point to the next design
point you should use one of the following approaches:

Use group parameters to drive parameter changes where blocking topology has groups/named selections
assigned in a persistent way.

Define groups/named selection at the end of a block recording in a persistent way.

Define groups/named selection at the end of a script in a persistent way.

• If you have components of bodies in SpaceClaim, note that shared topology creates multi-body parts. In this
instance, the Mechanical application groups multi-body parts together regardless of the assembly structure in
SpaceClaim, even if the Assembly Hierarchy option is set to Yes in Mechanical. You can use the View Assembly
Structure tool in SpaceClaim to see how the SpaceClaim assembly structure is affected by Shared Topology in
Mechanical.

• If trying to bring mesh data from SpaceClaim Meshing to Mechanical, the recommended path is to use the Workbench
transfer mechanism in the Workbench tab. See Ansys Transfer on page 962 for details.

º You can also write *.cdb/*.inp files that can be read in through External Model.

º For large models, there are some benefits to using a two stage attach (writing the *.inp/*.cdb file separately and
then reading this in through External Model).

• If trying to bring mesh data from SpaceClaim Meshing to Mechanical APDL, save the mesh in Ansys (*.inp/*.cdb)
format and read it into the Mechanical APDL system.

You cannot transfer the SpaceClaim Meshing mesh data to a downstream Mechanical APDL system directly in
Workbench.

• SpaceClaim Meshing mesh data can also be passed to an LS-DYNA system in Workbench using the direct transfer
mechanism. Alternatively, a mesh can be saved in LS-DYNA (*.k) format and read it into LS-Pre/Post or LS-DYNA
solver, or into Workbench via External Model.

• For SpaceClaim assemblies (external documents where parts are saved as different files) when you save in LS-DYNA
(*.k) format, the external documents will be written as separate part.k files using the same names as the external
SpaceClaim documents. The assembly.k file with contain *include cards to maintain the assembly structure.

Note:

º Nested assemblies (assembly of assemblies) are not supported.

º While saving, if you want all data to be written to a single *.k file, disable the Improve data on export
option in the SpaceClaim Options window (File > Options > General > > Export Options).

Transferring Mesh to Fluid solvers
You can transfer the mesh to downstream Fluent, CFX, and Polyflow systems.

When transferring the mesh to downstream fluid solvers:

• Body and part names defined in SpaceClaim will be transferred. If there are multiple bodies, ensure that the names
are unique. Bodies with the same name may be merged into a single body in the solver.

• By default, a boundary zone of type WALL is created for the boundary of each body when the mesh is transferred
to downstream solvers.
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• Named selections can be used to change the default zone type (WALL) for the transferred boundary zones. Use
the appropriate naming convention (case-insensitive) to obtain the appropriate zone type (for example, Named
Selections inletwill be transferred as inlet boundary zone). See Using Named Selections in Ansys on page 1154 for
details on creating Named Selections in SpaceClaim.

• Meshed bodies that have been suppressed for physics will not be transferred to the downstream systems.

You can write the mesh data to a file in Fluent format (*.msh) using Save As > Fluent. The Fluent export options can
be set in the SpaceClaim Options window.

• You can choose to export one .msh file for the entire design or one .msh file per component (blocking object) in
the Structure tree.

• The Improve data on export option in the SpaceClaim Options window (File Options > General > Export
Options) is enabled, by default.

This option merges zones of the same material or group when exporting the mesh to Fluent. You can disable this
option, if required, to retain individual zones after export.

Use the Mesh to Solver option for Ansys Fluent in the Ansys Transfer group in the Workbench tab to transfer the
mesh to Ansys Fluent. Ensure that the appropriate options are selected in the Fluent Launcher to start the Solution
mode in Ansys Fluent.

Exporting Meshes From SpaceClaim
You can export the mesh data to a file using the File > Save As option. Supported formats include:

• Ansys Modeler Mesh (*.amm)

• Ansys Neutral Format (*.anf )

• Ansys (*inp, *.cdb)

• Abaqus (*.inp)

• CGNS (*.cgns)

• Fluent Meshing (*.msh)

• ICEM CFD (*.uns)

• LS-DYNA (*.k)

Note: Meshed bodies that have been suppressed for physics will not be transferred when the mesh is
exported.

If you save the *.uns mesh file using the option from the context-sensitive menu for the blocking object in
the Structure tree, all the mesh is written. In this case, the mesh of suppressed bodies is also exported to
the mesh file.
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Geometry can also be transferred to Fluent Meshing in two additional formats

• Fluent Meshing faceted geometry (*.tgf)
• FM Database (*.fmd) (for input to the Fault Tolerant Meshing Workflow)



16: Customizing SpaceClaim

You can customize SpaceClaim to best suit your working style. Most customization is done on the SpaceClaim options
window, accessible from the File menu.

To customize SpaceClaim:

1. Select SpaceClaim Options from the File menu to display the SpaceClaim Options window.

2. Click the type of option you want to set from the navigation panel on the left.

You can use the up and down arrow keys to navigate the left panel.

3. Modify the options on the page.

4. Click OK to save all your changes and close the window.

Note: If you specify a value that is out of the permitted range in the Options panel or the SpaceClaim Options
dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to see a tooltip that
will explain the valid values for the option.

Option Types
You can set the following option types:

Change your startup options, application interface, application performance (speed vs. graphics
quality), and customize the tools that are displayed while you are working in the Design window.

Popular

Change options for annotations and drawing sheets.Detailing

Change the appearance of the SpaceClaim application window.Appearance

Change the selection options.Selection

Change the objects snapped to while you are sketching and editing solids.Snap

Set the units for dimensions, the sketch grid, and text height.Units

Set the thickness, bend, and relief defaults for sheet metal components.Sheet Metal

Change the default settings for meshing and enable or disable certain meshing tools.Mesh

Change the keyboard/mouse actions used for common navigation tasks.Navigation

Modify how your design changes are displayed in the Design window, whether tools and hints
are displayed, enable background loading, change the language, customize the Spin, Select,
and Undo tools, reset the layout of the panels, and adjust the license warning.

Advanced

Set options for various file types.File Options

Set the search path for support files, such as standard thread size tables.Support Files

Add or remove tools and commands from the Quick Access toolbar.Customize

Include or remove SpaceClaim add-ins.Add-Ins

View and activate SpaceClaim licenses.License
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Purchase material properties from MatWeb, contact SpaceClaim, or view information about
this version of SpaceClaim.

Resources

16.1. Popular Options
Set the startup options, interface, application performance (speed vs. graphics quality), and customize the tools
that are displayed while you are working with your design.
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Graphics Performance Options
Select a value from 1 to 10, where 1 is the lowest quality and 10 is the highest
quality. Select a low number to increase the speed of the application or select
a high number to increase the quality of the graphics. Increasing graphics quality
may lower the SpaceClaim's responsiveness to actions in the Design window. If
you notice a delay when working with your design, modify this option to increase
application speed. Within Rendering Quality, you can also choose Custom,
which allows you to set your own values for Surface tolerance, Normal
tolerance, and Max edge length.

• Surfacetolerance is the distance betweenFacetEdgesand the actual surface.
It's a measure of the distance between the facets and the real geometry.

• Normaltolerance is the angle between adjacentFacetNormals. It's a measure
of the smoothness of the faceting.

• Max edge length sets a limit for Facet size. Smaller Facets match the real
geometry better than larger ones.

Note:

• You can also customize faceting on individual bodies in theProperties
panel with the Tessellation Quality Level setting.

• Values above 7 appear in red since selecting these values will greatly
impact performance. It is strongly suggested that you do not select a
value greater than 7.Images below show the differences between a 7
value (left) and 10 value (right).

• Recalculate Rendering is disabled when you change the Rendering
quality. To re-enable Recalculate Rendering, click Ok or Cancel in
SpaceClaim Options.

Images show a sub-millimeter view of a meters-long part.

Rendering quality

The amount of smoothing applied to text, edges, and face boundaries in the
Design window. This option appears only if your graphics card supports
anti-aliasing.

Anti-aliasing

Startup Options
Select this option to display the splash screen when you start SpaceClaim.Show splash screen
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Select this option to share data, based on performance, to help improve product
reliability, performance and functionality. Shared data does not contain any
model or design information.

Report performance
information to SpaceClaim

Interface Options
Select this option to display hints when you hover over tools, tool guides, and
other icons. They briefly explain what will happen when you select the tool and
provide some hints on how to use the tool.

Show tooltips

ON by default. Select this option to display status messages in the SpaceClaim
window.

Show status messages in
window

ON by default. Select this option to display popup messages in the status bar
area (the lower left corner of the SpaceClaim window). These messages provide
hints and feedback while you work in SpaceClaim.

Showpopupmessages instatus
bar

ON by default. Select this option to display progress messages when importing
files or using the Volume Extract tool.

Showpopupprogressmessages

Select this option to enable keyboard shortcuts. Pressing and releasing the Alt
will display shortcuts that can be used to access the Quick Access toolbar, the
Ribbon groups, and the tools in the Ribbon groups. You can also use Key Tips
to open files from the Recent Documents list as follows:

1. Press and release the Alt key
2. Press 'f' to open the File menu
3. Recent documents will have a number Key Tip displayed next to them
4. Enter the number of the file you want to open

Show tool KeyTips

Check this option ON to add scroll bars to the Design window for panning
left-right and up-down.

Show scroll bars

Control Options
Select Left, Right, Top, Bottom, or Not Shown.Tool Guide position

Default is OFF. When selected, this option displays a view orientation gizmo, as
shown below, in the design window. You can click a linear gizmo arrow to rotate
the design to a new orientation in 3D, or a rotational arrow to rotate the design
in 90-degree increments in the plane of the screen.

Showvieworientation indesign
window
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Select this option to display a small toolbar near your cursor when you right-click.
The contents of the mini-toolbar depend on the tool you are using. You can click
or scroll the middle mouse button to hide the mini-toolbar, and it fades as you
move the mouse away from it. The mini-toolbar is shown in the image below.

Showmini-toolbaronselection

Allows you to use the radial menu to change select modes while other tools are
active, and gives you quick access to the Pull, Move, Fill, and Combine tools. If
you select this option, you can select one or both of the following methods to
open the radial menu:

• Show after holding left mouse button for Nms
• Show after clicking rightmouse button, while holding left mouse button
down

Show radial menu

Select this option to display arrows next to your cursor that indicate the
directions in which you can move your mouse to edit the selected object. The
arrows also convey the change in size that will occur if you pull in that direction.

Show cursor arrows

Adjust the slider to control the transparency of the cursor arrows. Move the slider
to the right to make the arrows more opaque or move it to the right to make
them more transparent. The arrows are set to opaque in the image below.

Arrow transparency

Move the slider to increase or decrease the size of the Move handle relative to
the size of the Design window, as shown in the image below.

Move handle size
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Change the position and size of the toolbar displayed for the sketch grid. You
can set the Position (Bottom, or Corner), and the Size (Large, or Small). The
defaults are Bottom and Large.

Grid guide

16.2. General Detailing Options
You can customize the style of your annotations in a single design or set a custom style as the default for all designs.
You can quickly customize the style to conform to ASME or ISO/JIS standards, or you can create a style by customizing
note leaders, dimensions, and geometric tolerances.

Changing Detailing Options
Application Defaults

Choose any font installed on your system. This font will be used as the default
font for all new windows. This font will be used when a new window is created
for an old or new document. It will also be used for new SpaceClaim sessions.

Newwindow font

The default graphics style used for new drawings.Default drawing graphics style

Check this option to have the scale automatically determined based on model
size. Uncheck the option to set a default custom scale.

Autoscale drawing sheets

Check this option to have new sections created as Total sections. Uncheck the
option to have new sections created as Area sections.

Create total cross sections

Choose either Hatch or None.Default section fill style

Document Options

Select one of the following from the Detailing options for drop-down list:

• All New Documents to create a default detailing style for all your designs.
These settings will not affect any currently open documents.

• This Document to set options for the current design only.

Detailing options for

To reset all options to predefined defaults, click one of the Defaults buttons to
set all document options to the default.

• Reset to ASME Default
• Reset to ISO Default
• Reset to JIS Default
• Reset to GB Default

Predefined Defaults
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View Options
Choose the default view projection :

• First Angle to label the view by the direction you are looking. For example, if
you are looking front, you see the back of an object. Therefore, the back of
the object is the "Front view."

• ThirdAngle to label the view by the object. For example, the front of the object
is the "Front view."

Default view projection

Choose the default front view position:

• Top left to place the front view at the top left corner of the drawing sheet.
This is the ISO standard.

• Top right to place the front view at the top right corner of the drawing sheet
• Bottom left to place the front view at the bottom left corner of the drawing

sheet. This is the ASME and JIS standard.
• Bottomright to place the front view at the bottom right corner of the drawing

sheet. If you use third angle projection, ISO standards also allow this position.

Default front view position

Specify the length of the arrow on section lines.Section line arrow size

Specify the length of section lines.Section line length

Set the ratio of a character's height to width. For example, a value of 1.4 sets the
character height to 140% of its width.

Detail view name text height
ratio

Select One Line to display the detail name and scale on one line. Select Two
Lines to display the scale below the detail name.

Default view note layout

Select how you want the detail label to appear on the drawing sheet.Default detail namenoteprefix

Select how you want the scale label to appear on the drawing sheet.Default view scale note prefix

Select how you want the detail name and scale information to be positioned
relative to the detail boundary.

Detail view boundary note
placement

Specify the length.Section cut line extension
distance

Choose either Away from cut line or Toward cut line.Section line arrow direction

Select a value from the drop-down.

• ISO Conventional
• ASME Simplified
• JIS Conventional
• GB Conventional
• ASME Simplified is the same as ISO and JIS Conventional display standards.

Cosmetic thread display
standard

Select the style you want to use for the projected view arrowheads from the
drop-down list.

Default projected view arrow
style

Check whether or not to show the projected view name.Show projected view name

Check whether or not to show the projected view arrow.Show projected view arrow

Specify a new prefix or choose one from the dropdown list.Default projected view name
prefix
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Check whether or not to show the auxiliary view name.Show auxiliary view name

Check whether or not to show the auxiliary view arrow.Show auxiliary view arrow

Specify a new prefix or choose one from the dropdown list.Default auxiliary view name
prefix

Specify the length of the arrow on projected and auxiliary views.Projected/auxiliary viewarrow
length

Annotation Options
Specify the height of the annotation text.Default text height

Specify the size of the circle that connects note leaders to faces.Leader circle size

Specify the length of the arrow on note leaders.Leader arrow length

Specify the size of the arrowhead on note leaders.Leader arrowwidth

Specify the length of the line from the note text to the note leader arrow.Leader shoulder length

Specify the size of the margin between the note text and the beginning of the
note leader.

Leader textbox gap

Specify the length that a center line will extend past the edge of the object.Center line extend

Select the style you want to use for the arrowheads on note leaders from the
drop-down list.

Default arrow fill style

Select the shape you want to use for the arrowheads on dimensions and leaders
from the drop-down list.

Defaultdimensionarrowshape

Select how you want to align the note leader text with the note leader line from
the drop-down list.

Defaultdimensiontext location

Select the font you want to use if the new window font is not available.Fallback font

Select the default space for adding notes. The options available areView space
(default) andModel space. Notes in theModel space are their true size and are
not scaled based on the Detail scale setting.

Default note space

Select the symbol you want to use to indicate the virtual sharp.Virtual sharps rendering style

Select the frame style for datum symbols.Datum symbol frame

Select the attachment style for datum symbols.Datum symbol attachment
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Choose whether thread designations are shown instead of thread diameters:

• Never: Show the diameter and not the thread designation.

• Always: Show the thread designation instead of the diameter.

• Per thread table: Use the value for
ShowThreadDesignationInDiameterDimensions in the thread table
XML file. The value can be set to true or false.

• If units match: Show the thread designation if the system units match the
units from the thread table.

• Per thread table if units match: Show the thread designation if the units
match and if the ShowThreadDesignationInDiameterDimensions
value is true.

Show thread designation in
thread diameter

Controls how many times larger the callout circle should be compared to the
text height.

DatumCallout text height ratio

Controls the point size used by datum target points, lines, and circles. Default
point size can be overridden on a per object basis.

DatumTargetdefaultpoint size

Controls the hatch spacing for circular and rectangular datum targets. Default
spacing can be overridden on a per object basis.

Datum Target area default
hatch spacing

Controls the hatch angle for circular and rectangular datum targets. The default
angle can be overridden on a per object basis.

Datum Target area default
hatch angle

Controls the arrow shape of leaders connected to datum targets.Datum callout leader arrow
shape

Choose either AWS or ISO.Welding symbols standard

Check the box to use the European standard of keeping the dimension line when
the extension lines are shown.

Enforce dimension line

Check the box to shrink the gap between the dimension text and witness lines.Tight gap between dimension
line and text

Check the box to keep all annotation text oriented horizontally.Horizontal dimension text

Check the box to set all annotation text to the color selected shown in the
Annotation color control. If you choose to override the layer color, select the
color used for the override from the Annotation color control.

Override layer color for
annotations

Specify the size of the margin between geometry and the end of dimension lines.Extension line gap

Specify the length that the dimension lines cross each other.Extension line extent

Specify the length of the arrow that appears outside the dimension lines.Dimension line extent

Specify the distance between the dimension text and its leader line.Dimension text offset

Specify the size of the cross shown to represent the center.Foreshortenedradialdimension
center size

Choose either Linear or Normal to chamfer.Default chamfer dimension
style
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Choose between:

• <length> X 45
• C <length>

Defaultchamferdimensiontext
format

Display the baseline dimension as a 0.Show zero value for base
ordinate dimension

Display all dimensions along the same line.

Check Rotate text if you want the dimensions to be displayed along the line
instead of perpendicular to the line.

Show common dimension line
for ordinate dimensions

Show or hide the endpoint.Show datum target endpoints

Allow solid geometry to hide annotations that are behind the geometry. For
printing, set the Print as image to Yes in the Printing Options to show
annotations as hidden in the print.

Hideannotationsbehindmodel

Linestyle Options
Specify the default width for thick lines.Default thick lineweight

Specify the default width for medium lines.Default medium lineweight

Specify the default width for thin lines.Default thin lineweight

From the drop-down, select an object type, then select the Line style and
Thickness for that object.

• Only a Thickness option is available for Cross hatching.

• Options for Detail view clipping edges apply to all clipping edges of partial
views. You can also set a Color for the clipping edges.

• Only a Thickness option is available for Area cross section border lines.

• Only a Thickness option is available for Cross section arrow tips.

Type of object

Select a line style for the object. For example, when working with Wireframe,
Hidden Line, or Hidden Line Removed visibility modes, you can select a line style
to show the edge(s) of a design's partial view. This feature enables you to easily
identify which parts of the model are cut by the partial clipping boundary.
Non-solid line styles can help to differentiate a detail view with clipped edges
when in wireframe mode.

To enable the display to view while working with your design:

• Select Lineweight in the Show group in the Display tab

• SelectHidden Line, Hidden LineRemovedorWireframe from theGraphics
drop-down in the Style group in the Display tab

Line style

Thick-Empty-Thick lines look like this:

Thick-Thin-Thick lines look like this:

Thickness
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The values in theTrimback section control the line weight for side offset handles.Trim back

Note: If you try to specify a value that is out of the permitted range in the Options panel or the SpaceClaim
Options dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to
see a tooltip that will explain the valid values for the option.

16.3. Drawing Sheet Size and Format Options
The drawing sheet size and format options allow you to choose a drawing sheet layout.

To use a pre-defined drawing format that has been saved as an .scdoc file, select
Useexternal formatand select a format from the list or clickBrowse to choose
a file.

Use external format

To create drawings without a format, select No format and select a size and
orientation, or set a custom width and height.

No format

Deselect Show SpaceClaim -provided default formats in the user interface if
you don't want to list drawing sheet formats that were installed with SpaceClaim
in the external formats selection list.

Show SpaceClaim -provided
default formats in the user
interface

16.4. Modular Grid Options
Modular grid options allow you to change how modular grids appear by default in your drawings. When you change
these options, all new modular grids will use these settings; existing grids in your drawings will not change.

Most of these options are also found in the properties for a grid. To change one instance of a modular grid, see
Displaying a modular grid.

Setting Modular Grid Options
The color of the grid, labels, and the legend axis.Color

The height of all text labels for the grid.Grid text height

The font and text height used for grid labels. Type the complete name for a font,
followed by a comma and the font height in units (mm, in, etc.). You can also
click the ...button and select a font and a size in points. The size will be converted
to the current units.

Font

The distance between grid lines.Grid interval
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The number of rows between each grid line.Intervals per grid line

The type of line used for grid lines.Line style

The thickness of grid lines.Thickness

Show labels for the bottom of grid lines, the top of grid lines, both, or neither.Horizontal text location

Show labels for the left end of grid lines, the right end of grid lines, both, or
neither.

Vertical text location

Override X, Y, or Z with your own labels.Axis labels

A prefix shown before the distance on a grid label.Negative and positive prefixes

A suffix shown after the distance on a grid label.Negative, positive, and zero
suffixes

A label shown next to the section line when you show a modular grid on a cross
section view.

Modular grid description label

Select an option for displaying modular grids for all new views in drawing sheets.

• Automatically showmodular grid when two grid directions are parallel
to the sheet: Two of the X, Y, or Z axes in the view must be parallel to the
drawing sheet to display the modular grid.

• Automatically showmodular grid when at least one grid directions are
parallel to the sheet:The X, Y, or Z axis in the view must be parallel to the
drawing sheet to display the modular grid.

• Do not automatically show themodular grid

Automatic creation for new
views

If selected, then the description label is displayed next to the section line for a
cross section view.

Automatically showmodular
grid description

Show circles around grid labels.Show balloons around grid
labels

Show the legend axis on the lower left corner of the view.Automatically show origin

16.5. Limits and fits options
Limits and Fits options allow you to set the defaults used when applying the Limits and Fits tolerance type.

Sets the fixed datum used to calculate the tolerances. This can be either Hole
Basis (shaft is assembled into the hole) or Shaft Basis (hole is assembled onto
the shaft).

System of Fits

• Fundamental deviation: Fundamental Deviation establishes the location of
the tolerance zone with respect to the Basic Size. When System of Fits is set
to Hole Basis, this will be "H". When System of Fits is set to Shaft Basis, this
can be any of the allowed letter designations (A thru ZC)

• International tolerancegrade: Any of the allowed numeric designations (IT01
thru IT18)

• These properties can also be set by selecting in the Hole-Basis and Shaft-Basis
Preferred Fits tables.

Hole Tolerance class
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• Fundamental deviation: Fundamental Deviation establishes the location of
the tolerance zone with respect to the Basic Size. When System of Fits is set
to Hole Basis, this will be any of the allowed letter designations (a thru zc).
When System of Fits is set to Shaft Basis, this will be "h".

• International tolerancegrade: Any of the allowed numeric designations (IT01
thru IT18)

• These properties can also be set by selecting in the Hole-Basis and Shaft-Basis
Preferred Fits tables.

Shaft tolerance class

The display format for the tolerance. Each method is illustrated below.Method of designation

40H8

40H8 (40.039/40)

40.039/40 (40H8)

40.039/40

40H8/h7

16.6. Appearance Options
You can adjust SpaceClaim's appearance, such as its menu bar style and color schemes. This options page also
contains placeholder elements for future color customization options.
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General
Choose between Fluent (Office 2007) or Scenic (Office 2010), or Windows 8 (Office
2013) style ribbon bar styles. With the Scenic style, the File menu provides a
Recent menu item, which displays Recent Documents (lists the name and
location of all recently opened files) and Recent Places (lists a history of all
recently visited folders).

Ribbon style

Select Silver, Blue, Black, or Custom Color from the menu.Color scheme

Click this button to return the layout of the docking panels and SpaceClaim
windows to their original locations.

Reset Docking Layout

Display selectable section curves at the intersection of the section plane and
bodies while in Sketch mode.

Show cross sections in sketch

Display faces that share an axis with blue shading.Show coaxial face groups

Display small crosses on the sketch grid at the centers of circles, ellipses,
polygons, and arcs.

Show arc centers

Toggle the display of points that represent tangent edges in Sketch and Section
modes.

Show section points

Show facet selection highlighting through objects. When the option isOn, hidden
facet selections are shown. When it isOff, hidden facet selections remain hidden.

Show occluded facet selection

Display cross section area with a filled appearance in Section mode and Sketch
mode.

Fill cross section

When copying the scene from a window, include the tool elements in the image.Add tool graphics to scene
image

When copying the scene from a window, include axes, origins, and datums in
the image.

Add datums to scene image

When copying/saving the scene as an image, set the image background to be
transparent.

Scene image transparent
background

Colors
Set a color scheme forDefeatured face,Failed face,Meshed face,Out-of-date
face, and Sectioned face.

Analysis Mesh

Select a color scheme from the menu. This option controls the color scheme
used in the Design window. You can choose between two pre-set color schemes:
White Background or Black Background. Elements displayed in the design area
will change to colors that work well for the background color.

You can change the colors for other elements. Click the color next to an individual
element and choose a new color from the drop-down. Select colors from the
Custom, Web, or System palettes.

You can apply aRadialGradientbackground by settingBackground toGradient,
settingGradient toRadial, and then choosing two colors for theGradient (Color
1 and Color 2.)

Click Reset to change all the colors back to the SpaceClaim defaults.

Design color scheme
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Set the color scheme for the Back face color and the Highlight and Select
scheme. For the Highlight and Select scheme, you can set the color scheme
for the Primary highlightedmesh, Primary highlighted selectedmesh,
Primaryselectedmesh,Secondaryhighlightedmesh,Secondaryhighlighted
selectedmesh, and Secondary selectedmesh.

Faceted Mesh

Select a scheme from the drop-down menu. Classic and Default cannot be
modified.Customallows you to modify color options to create your own scheme.
Use Ctrl+Shift+H to toggle through schemes in the following order: Classic,
Default, Custom.

Highlight and Select scheme

Set a color scheme for Standard holes.Object colors

Set a color scheme for Free beam curve, Unshared laminar (single) edge,
Unsharedmultiple edge, Shared double edge, Shared triple edge, Shared
multiple edge, and Shared face.

Share Topology

16.7. Selection Options
You can adjust SpaceClaim's selection settings, such as the cursor Hit radius and the tolerance used in Power
Selection.

General
Type the number of pixels your cursor can be from the object you want to select.Hit radius

This option is ON by default. It allows you to hover over an edge and use the
mouse scroll wheel to cycle through the possible loops that include that edge.
You can click a pre-highlighted edge loop to select it. If you are using a multitouch
machine, you can select edge loops by double-clicking OR double-tapping the
first edge of the edge loop you want to select.

Select edge loops usingmouse
scroll wheel

This option is OFF by default. If it is enabled, SpaceClaim will remember previous
selections that were used for some operation. For example, select several faces
and moved them. The next time you select one of the faces, the others will
prehighlight.

Show previous selections with
prehighlight hint

Power Selection
Select this option to automatically display objects in the Selection panel. You
do not need to click

to search when power selecting. Objects similar to the selected object are
automatically displayed in the Related list. This option is on by default.

Automatically calculate Power
Selection results
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Type a percentage to change the relative tolerance used when searching in the
Selection panel. Enter a non-zero percentage to find objects with similar, but
not exactly the same dimensions when power selecting. For example, if you
enter 10% in this option field, select a 10 mm radius round in your design, then
click

in the Selection panel, rounds with a radius between 9 mm and 11 mm will be
returned in the All rounds equal to 10 mm results list. The default is 1%. Adjust
this value to 0% to detect perfect rounds exactly or increase it to find imported
rounds.

Power Selection relative
tolerance

Facets
Allows you to control the scope of selection of mesh facets.

• Fine: Shows the selection hot spot and allows selection of mesh facets, edges,
and vertices.

• Coarse: Allows selection of mesh facets only.

Facets selection granularity

Allows you to control the paint selection radius for selection of mesh facets. The
default radius is 10 pixels. The maximum value you can set is 250 pixels.

Facets paint selection radius

16.8. Snap Options
You can set snapping options for sketching and editing solids. Units for snap options are set by your Units options
for all new documents.

Note: If you try to enter a value that is out of the allowed range in the Options panel or the SpaceClaim
Options dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to
see a tooltip that will explain the valid values for the option.

General Options
Set an appropriate value for Snap radius. The default value is 10 pixels.

Snapping Options for Sketching
Incremental Options

Select Angular snap to snap to objects while sketching.

Enter the angle increment you want to snap to when you select the Snap to
angle option in Select, Move, and Sketch tools.

Angular snap

Objects
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Select Enable snapping in sketches to snap to objects while sketching.

While you sketch, objects you can snap to are highlighted. The points to which
the sketch tools are snapping appear as messages in the status bar.

Check the box next to each item in the list to determine which objects you can
snap to while sketching:

• Line - Snap points along lines (at intersections with sketch grid) indicated by
rectangles

• End point - Snap points at all end points indicated by squares

• Midpoint - Snap point at center of lines indicated by triangles

• Arc/circle center - Snap points at center of arcs and circles indicated by circles

• Tangent from end point - Snap points at tangent angle to end points indicated
by tangent guides

• Perpendicular from end point - Snap points perpendicular angle to end points
indicated by perpendicular guides

• Tangent/perpendicular from line - Snap points at tangent and perpendicular
angles along lines indicated by tangent and perpendicular guides

• Parallel to line - Lines parallel to the sketched line indicated by highlighting

• Parallel to grid - Snap enabled parallel to the grid when snap to grid is disabled

• Grid - Snap enabled to the grid

Enable snapping in sketches

Snapping Options for Editing Solids
Incremental Options

Select to snap to constrain to a linear increment and set the linear interval for
tool movements in the Incremental area.

For example, if you set the Linear increment to 1 mm, you will pull to whole
millimeters instead of fractions of millimeters.

Linear snap

Select to snap to constrain to an angle increment and set the degree interval
for tool movements in the Incremental area.

For example, if you set the Angular increment to 5 degrees, you will move in
larger increments than if set to 1 degree.

Angular snap

Objects
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Select to snap when you press and hold Shift using any tool.

Check the box next to each situation or object in the list to determine when a
tool will snap while editing solids:

• Face parallel - Snap to a parallel face

• Rotate parallel to face - Snap to a parallel face when rotating

• Rotate perpendicular to face - Snap to a perpendicular face when rotating

• Edge - Snap to any edge

• Cylinder radius - Snap to the radius of a cylinder

• Round radius - When creating a round, snap its radius the value of an existing
round on the component

Enable snapping to solids with
the Shift key

Nudge Options
Nudging lets you incrementally change dimension values using the arrow keys.

Depending on the tool you are in, there may be only one dimension or there may be two.

• The active dimension is considered the Primary dimension and the inactive is secondary. The active dimension
can be changed using the Tab key.

• For the primary dimension, you nudge the value up using the Up Arrow key and nudge it down using the Down
Arrow key.

• Nudge the secondary dimension value up with the Right Arrow key and down with the Left Arrow key.

You can set three nudge increment values:

The nudge increment when you press Shift and an arrow key.Normal

The nudge increment when you press Alt+ Shift and an arrow key.Small

The nudge increment when you press Ctrl + Shift and an arrow key.Big

Examples

Snapping to the midpoint of a line
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Editing a solid with angular snap set to 15 degrees

Snapping to an existing diameter

16.9. Units Options
You can set the units for dimensions, the sketch grid, and text height.

Select one of the following from the Units settings for drop-down list:

• All New Documents to create a default detailing style for all your designs. These settings will not affect any
currently open documents.

• This Document to set options for the current design only.

Note: If you try to enter a value that is out of the allowed range in the Options panel or the SpaceClaim
Options dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to
see a tooltip that will explain the valid values for the option.

Setting Units Options
Select Metric or Imperial from the menu.Type
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Select the default units used for length.

• Metric

º Millimeters (default)
º Centimeters
º Meters
º Micrometers
º Nanometers

• Imperial

º Inches
º Feet
º Feet & Inches
º Mils

See the Small Units section below for notes about working with Micrometers,
Nanometers, and Mils units.

Length

If you use Imperial units, you can select Decimal or Fraction to display distance
measurements that are less than 1 unit.

Decimal/Fraction

Select from the following options. For SCDM only, a check box to Use project
units when available will be active only when you are modifying settings for
all new documents. The option will be disabled by default.

Note: When radians are chosen, their angle dimensions will show the
appropriate values and unit suffix (rad).

• Degrees
• Degrees/Minutes/Seconds
• Degrees/Minutes
• Radians

Angle

Select the default units used for mass.Mass

Select Independent to specify the density units from the density fields orDerived
to calculate the units from your selections for length and mass.

Density

Select the abbreviation you want displayed for unit type you selected forLength.Symbol

The number of decimal places you want displayed for distance measurements
for the primary units.

Primary precision

The number of decimal places you want displayed for angle measurements for
the primary units.

Angular precision

Select this option to display trailing zeros in decimal measurements.Show trailing zero
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When this option is selected, tolerances are rounded to a value that gives a
tighter tolerance when you have dual dimensions or when a dimension from
the design window is shown in the drawing window with a different unit setting
than the design window. The purpose is to not lose any precision when converting
from one unit system to another. When this option is not selected, the values
are rounded according to method A in ISO 370-1975 (E). When selected, values
are rounded according to method B.

Use tight tolerances

Select this option to display the units abbreviation in SpaceClaim. The
abbreviation will appear in measurement fields, such as a distance field when
you pull a face.

Show symbol in user interface

Select this option to display the units abbreviation after the measurement in
annotation dimensions.

Show symbol in annotations

Select this option to display a hyphen between whole values and fractions.Show "-" separator

Select this option to display annotation dimensions in both Metric and Imperial.
The unit type you have selected is displayed first and the other is displayed in
square brackets. You can see a preview of the display below this option category.

Use Dual dimensions

The number of decimal places you want displayed for distance measurements
for the secondary units.

Secondary precision

Check this option to show the nearest fractional value Less Than the nominal
dimension and the nearest fractional valueGreaterThan the nominal dimension.
It allows for Ruler-style dimensions. For example, if you were to lay a ruler down
and the distance falls between the marks on the ruler, these values tell you the
nearest marks on either side of the dimension value.

• Fraction: Enter a fraction between 1/128 and 1/2. The default is 1/16, which
is a common ruler increment.

• From both sides: Show fractions on both sides of the nominal dimension.
• Fromclosest: Only show the fraction that is closest to the nominal dimension

regardless of which side it is on.

Show nearest fraction

Grid Options
Click this button to reset the grid settings to the SpaceClaim defaults.Reset to Defaults

Type the distance you want between the smallest grid lines.Minor grid spacing

Type the number of smaller grid lines between larger, darker grid lines.Number of grid lines per major

Text Options
Select a unit type for note text.Text height units

Converting an Existing Solid or Surface FromMillimeters to Inches
1. Change the units to inches as described above.

2. Select the Pull tool in the Edit ribbon group on the Design tab.
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3. Select the object you want to convert.

4. Scale the object by 25.4.

Small Units
You cannot mix Standard units and Small units in the same SpaceClaim session.

• New Designs - If you attempt to create a new design using small units when standard unit designs are open, a
warning is issued. The same is true for creating a design using standard units when small unit designs are open.

• OpeningDesigns - If you attempt to open a design with small units when standard unit designs are open, a warning
is issued. The same is true for opening a design with standard units when small unit designs are open.

• Inserting designs - If you attempt to insert a small unit design into a standard design, a warning is issued. The
same is true when you attempt to insert a standard unit design into a small unit design.

Drawings are an exception for mixing units. Drawing sheets are always in standard units (for example, millimeters
or inches) for annotations (sketched geometry, dimension and note text, etc.). This will result in larger scaling factors
for drawing views, since the geometry in the views is using small units.

Detailing options are in standard units even if the design is in small units.

Because Drawing Sheets are in standard units, measurements reported by certain tools will show standard units.
This applies to the following tools.

• Pull Round
• Pull Chamfer
• Insert Sphere
• Insert Cylinder

The following SpaceClaim options are disabled when working in small units.

• Use dual Dimensions
• Show nearest fraction
• Sheet Metal options are disabled for nanometers

The following tools are disabled when working in small units.

• Standard Holes
• Sheet Metal tools (disabled for nanometers only)

16.10. Sheet Metal Options
You can set the wall thickness, bend, and relief defaults for sheet metal components. These defaults can be changed
for each component or bend by selecting the component or bend and modifying the property values in the Properties
panel. Units for sheet metal options are set by your Units options for all new documents.

Options in the Basic Defaults section apply to all new designs, and persist after you close SpaceClaim. Options in
the Relief Defaults section apply only to new designs in the current session.

Note: If you try to enter a value that is out of the allowed range in the Options panel or the SpaceClaim
Options dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to
see a tooltip that will explain the valid values for the option.
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Basic Defaults
Type a value for the default wall thickness of sheet metal parts.Thickness

Specify an existing Bend Table as the default for new parts.Bend Table

Type a value for the K-factor. The K-factor is a value between .25 and .50 that is
used to calculate the bend radius. K-factor is a percentage of the metal thickness
and depends on factors such as the material and type of bending operation.

K-Factor (for R=T)

Type a value for the default bend radius. The value is a Thickness ratio by
default, but you can select Value to enter an absolute value.

Bend radius

Set the default gap created when you bend a split face, which is shown as C in
the image below.

Split face gap

Set the default gap created in Full, Partial, and No Overlap Junctions and Flanges.
Use

• Thickness ratio to change the gap based on the thickness of the wall.

• Value to specify the exact width of the gap.

Junction gap

Set the percentage of overlap in Partial Overlap Junctions. The default is 50%.

For individual Partial Overlap Junctions, you can change theOverlapProportion
property in the Sheet Metal properties panel with the Junction selected.

Junction overlap
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Set the format for displaying Bend Annotations in the Unfolded part.Bend annotations

+/- Angle

+/- Angle Radius

Up/Down Angle

Up/Down Angle
Radius
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Note: When the Bend Radius is set to Thickness ratio and you change
the sheet metal part thickness for the part, the value for the InnerRadius
now changes in the Sheet Metal Properties panel. Changing the part
thickness property will not change all the bend radii, but the displayed
bend radius changes to show that there is a problem for you to fix. You
can fix them by selecting the desired bends and changing their properties
manually.

Controls whether Bend Lines extend beyond the Unfolded part outline. OFF by
default. When unchecked, the lines extend beyond the outline.

When checked, the lines are trimmed at the part outline.

Trim bend lines to part outline
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Relief Defaults
Bend Relief: These values are the defaults used when you create a bend.

Choose Square, Rounded, or Rip from the menu.

• To use a different Relief for an individual bend, choose aType from theEdgeReliefmenu
in the ribbon.

• To change the Type after a bend is created, select the Relief and change the type in the
Options panel.

Type

Use:

• Thickness ratio to change the relief width and depth based on the thickness of the wall.
• Value to specify the exact width and depth of the bend relief.

In the images below, A is the width and B is the depth of the bend relief.

Width and Depth

Rounded reliefSquare relief

Corner relief: These values are the defaults used when you create a corner.

Choose one of the reliefTypes from the dropdown menu. Each Type has settings
as follows:

• Smooth - Diameter
• Square - Width
• Circular - Diameter
• Triangular - Width and Height
• Rectangular - Width and Height
• Oblong - Diameter
• Diagonal - Width
• Laser Edge - Diameter
• Laser Symmetric - Diameter

Type

Use:

• Thickness ratio to change the relief width and depth based on the thickness
of the wall.

• Value to specify the exact width and depth of the bend relief.

In the image below, D is the Corner Relief depth.

Depth
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Export Options
Select this option to round all the edges in your design whose neighboring faces
are not co-planar when you export a DXF file. You can set the round radius values
if you select this option.

Round all sharp corners at DXF
export

Select this option to export the bend extent lines at DXF export. Bend lines can
be trimmed to the part outline if Trim bend lines to part outline is checked in
the Basic Defaults section. OFF by default.

Export bendextent lines atDXF
export

Colors Options
Select highlighting colors to use on sheet metal designs. To distinguish between corner reliefs and edge reliefs,
select two different colors. Colors on designs will appear more saturated than the colors shown in the sheet metal
options.

Click Reset Colors to restore the default colors.

Unfold Layers Options
Assign default layer colors and linestyle for:

• Bend Lines-Up
• Bend Lines-Down
• Forms
• Overall Dimensions (color only)
• Bend Dimensions (color only)

16.11. Mesh Options
SpaceClaim allows you to customize the default settings for meshing and to enable or disable certain meshing tools.

Customizing Mechanical Defaults
The following options are used when the Physics Type is set to Structural:

Use the drop-down list to set the default Element Order for the Add tool to
QuadraticorLinear. The default setting isQuadratic, generating mesh elements
with mid-side nodes. You can select Linear to generate mesh elements with
mid-side nodes removed.

Element Order

Set the Default Free Mesh Type for the Add tool. You can choose HexCore
(default), HexDominant or Tetra. See Selecting an Element Shape for details.

Default Free Mesh Type

Customizing Sizing Defaults
Select Curvature to have the Add tool respect surface curvature by default.Curvature

SelectProximity to have theAdd tool respect proximity in thin regions by default.Proximity
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Biasedgesizes tomatchsmall edges is enabled by default. Deselect this option
to obtain a uniform mesh by removing biasing to match small edges. This option
is only available as a global option.

Bias edge sizes tomatch small
edges

See Understanding the effects of Curvature and Proximity settings for details on the Sizing options.

Customizing Boundary Layer Defaults
Use the drop-down list to set the default Layer Growth Method to be used in the Layers Tool for boundary layers
on geometry surfaces.

See Adding boundary layers to a mesh for details on the Layers tool.

Setting Blocking Options
[Optional] Use the check box to disable orEnable AdvancedTools. Default and
general recommendation are to enable Advanced Tools. If you disable Advanced
Tools, the block editing tools (Edit group on theMesh ribbon) and the blocking
topology will be hidden.

Enable Advanced Tools

[Optional] Use the check box to enable or disable Automatic Multi-Threaded
BlockMeshing. By default, SpaceClaim Meshing will use multi-thread processing
when creating the mesh. For example, multiple surfaces meshed in parallel will
be processed in multiple threads. You can allow the software to select the number
of threads automatically, or manually set the maximum number of threads.

Note: This affects only the number of threads for mesh processing.
SpaceClaim will use additional threads for other processes such as
Progress bar updates.

Automatic Multi-Threaded
Block Meshing

[Optional] Use the check box to enable Normal projection instead of closest.
By default, this option is disabled, that is, blocking entities are projected to the
closest point on the geometry. When this option is enabled, blocking entities
are projected normal to the geometry.

Normal projection instead of
closest

[Optional] Use the check box to enableProject inner faceswhen theybecome
(material) boundaries. By default, this option is disabled. When this option is
enabled, block associations are modified while splitting or deleting blocks, or
changing block material. Inner block faces that are changed to boundary faces
are projected to the geometry. You may use the Associate tool to remove the
association, if required.

Project inner faces when they
become (material) boundaries

[Optional] Use the check box to enablePrime surfacemeshing. By default, this
option is disabled. When this option is enabled, an alternative surface meshing
method is used for faster surface meshing performance for models having large
surfaces with many cut out loops. Note that the surface mesh quality may
deteriorate when this method is used.

Prime surfacemeshing
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[Optional] Use the check box to enableUseSplitAngle to split edges to improve
the mapped mesh quality and prevent skewed mesh on side faces. This option
is disabled by default. In cases where the mesh is skewed, you can enable this
option to create new splits rather than align to existing splits. Specify an
appropriate value for the split angle (default 60 degrees). Splits will be created
at nodes where the angle of an end node of an edge (edge vector) to the
corresponding end node of a parallel edge is less than the split angle specified.

The examples show the improved mesh quality using this option.

Use Split Angle

Improved mesh - after using the Split
Angle

Original Mesh - before using the Split
Angle

Note: The global meshing options (Normal projection instead of closest, Project inner faceswhen they
become (material) boundaries, and Use Split Angle) are considered at block creation and saved. If you
want to modify any of these settings, you need to delete/undo the blocking upon modification of these
parameters. Else you will not see the changes take effect.

16.12. Navigation Options
SpaceClaim allows you to customize how you spin, pan, and zoom. You can customize which mouse button/keypress
combinations are used as shortcuts for these tools, or you can select a theme to match another CAD application you
are familiar with.
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Select an option in the group to set how turning the mouse wheel zooms the
design:

• In Zoommode: Turning the mouse wheel only zooms while the Zoom tool on
the Orient group on the Design tab is active.

• In Spin/Pan/Zoommode: Turning the mouse wheel zooms when any of the
Spin, Pan, and Zoom tools are active.

• Always (hold Ctrl to Query Select): The mouse wheel always zooms in any
tool.

Zoom

Speed: Set the zoom speed.

Select a spin method in the Spin group:

• Arcball: Rotates the view using the spot where you start dragging as the
rotation axis. Imagine the axis running straight up and down from your mouse
position and perpendicular to your current view. Navigation in most 3D CAD
systems works like this.

• Turntable: Rotates the view using the top of your design as the up direction
and the location of your mouse as the rotation axis. This is the spin method
commonly used in architectural CAD packages.

Spin

Show spin center: Select to display the axis about which you are spinning the
design.

Rotate about pre-selected object: Select to spin the design around the
highlighted edge.

You may want to uncheck this box if you are working with large or complicated
designs.

Speed: Set the spin speed.

Select your Clip with Volume or ClipView options:

• Previewcolor:Select aClipViewpreview color to set the preview color of the
sphere representing your selected ClipView.

• Clip selection: Trims the visible and selected surfaces inside a Clip Volume
by the Clip Volume boundary. If you select this option, you are working in Clip
Selection mode, and you can toggle Clip selection and Zoom to fit from the
Misc section of the Properties panel. If you do not select this option, you are
working in Clip Interactive mode. In this mode, you cannot modify options
from the Misc section of the Properties panel. When you select a face within
the boundary, the entire face (unclipped) displays.

• Zoom to fit: Changes the behavior of the ClipView>Locate function. If this
option is selected, then the Clip Volume is moved to the center of the graphics
window and is magnified for the user, when Zoom to Fit is chosen. If it is not
set, then the Clip Volume is only centered, and not magnified.

ClipView

Alternative Navigation Themes
The following table shows CAD applications matched to alternative themes.
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Navigation theme (closest match)CAD Application

DefaultSpaceClaim

DefaultCreo Parametric®

DefaultSolid Edge®

Alternative 1CATIA®

Alternative 2Rhino®

Alternative 3ANYSYS®

Alternative 3SOLIDWORKS®

Alternative 3ALGOR®

Alternative 3KeyCreator®

Alternative 4Inventor®

Custom Themes
Modify the key and mouse shortcuts shown in the Theme list for any theme. Custom is displayed as the selected
Theme. Your changes are saved immediately.

Modify the Spin, Pan, and Zoom settings to set the mouse and key shortcuts used for those actions. You can also
change the Zoom-in drag direction and the Zoom-in wheel direction to Upward (turning the mouse wheel away
from you zooms in) or Downward (turning the mouse wheel towards you zooms in).

Click Reset All to delete the custom theme and select the Default theme.

16.13. Advanced Options
Modify how your design changes are displayed in the Design window, whether tools and hints are displayed, enable
background loading, change the language, customize the Spin, Select, and Undo tools, reset the layout of the panels,
and adjust the license warning.

Note: If you try to enter a value that is out of the valid range in the Options panel or the SpaceClaim Options
dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to see a tooltip
that will explain the valid values for the option.

General
Select this option to enable constraint based sketching. You need to restart
SpaceClaim to use constraint-based sketching.

Enable constraint based
sketching

Select this option to animate the steps when you select a view.Animate changes to view
projection

Select this option to dynamically show you the parts moving on screen when
switching between configurations.

Animate configuration change

1117Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Customizing SpaceClaim



Select this option to automatically extrude or revolve in section mode. As you
sketch in Section mode, lines that begin on an existing edge are extruded to
form surfaces, and closed surfaces form solids. If the line begins on a solid, the
line is finished automatically when you click another point on the solid. To
automatically revolve, the sketch must be attached to a revolved face.

Auto-extrude/revolve sketches
in Sectionmode

Type the number of actions you want available for undo. It's recommended that
this value be set to at least 50. To enable your changes, you must restart
SpaceClaim.

Maximum undo steps

Select a language from the menu. The SpaceClaim user interface and online
help display in the selected language.

Language

Reset all modifiable user settings to a default state. To apply the updated settings,
you must restart SpaceClaim.

Reset All User Settings

Export a SpaceClaimuser.config file (XML format) for editing and/or future
import.

Export User Settings

Apply non-default, customized selections that are unique to an individual user.
A valid SpaceClaimuser.config file (XML format) must be available for import.
User.config file location can vary depending on SpaceClaim installation,
but generally, this file type is stored in your local AppData directory. Once you
locate theuser.config file you want to import, or, enter the name of the
user.config file in the File Name text box, click Open to import the file.

Import User Settings

Creating the Universal User Settings File
1. Create an environment variable called SpaceClaim_ADMIN_CONFIG. It should point to a fully qualified file name

which may be on the network, for example:
[SpaceClaim_ADMIN_CONFIG=\\dell_server\shared\user\admin.config

2. Begin by creating your own user.config file as described below.

• Open SpaceClaim and go to the Options menu.

• Change the settings any way you want.

• Click the Export User Settings button in the Advanced options page.

• Save as "user.config" or any other name you want with the ".config" extension.

• Place in the location which your Environment variable points to.

3. Test that your settings have exported correctly as follows.

• Close out SpaceClaim.

• Locate your user.config file.

a. Go to Computer>Local Disk

b. Click in the Path panel at the top of the window.

c. Type: %APPDATA%

d. Double click Local.

e. Double click SpaceClaim
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f. Select all the settings folders and delete them.

4. Open a new SpaceClaim session and see the results of your user.config file.

Note:

• The name can be anything - 'admin.config' is just an example.

• This file will be used by SpaceClaim instead of the local user configuration file.

• To use the settings you created, make sure you clear out your local settings before you start SpaceClaim.
You should only need to do this once.

• You may need to delete local settings to get SpaceClaim to use the central config file the first time. This
is because SpaceClaim checks the file dates and uses the newest of the two files.

• After the first time, you should not need to delete local settings again.

• When you do a new install on a machine with the Environment variable set, the admin user settings will
be used without needing to delete the local settings.

• Once you have a specified central config file, any changes made will persist. However, settings within tabs
restricted by 'panel.config' cannot be overridden.

Restricting Access to Specific User Settings
You can prevent some tabs in the SpaceClaim Options panel from being overridden by a user. This is done with the
'panel.config' file that specifies which tabs to disable.

There is an example panel.config file in the following directory:

C:\<installation directory>\panel.config

where <installation directory> is the location where you installed the application.

This file is simply an example to work from and currently does nothing.

Unlike the 'admin.config' file, which can be named anything, 'panel.config' should not be renamed.

Creating a 'panel.config' File
All of the option panel names are listed below. Use them to customize panel.config as you like. Place the file in the
same location as the admin.config where your Environment variable points.

Popular

Detailing_General

Detailing_SizeAndFormat

Detailing_ModularGrid

Appearance

Snap

Units

SheetMetal
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Navigation

Advanced

FileOptions_General

FileOptions_ACIS

FileOptions_AutoCAD

FileOptions_CATIA

FileOptions_IGES

FileOptions_JTOpen

FileOptions_OBJ

FileOptions_Parasolid

FileOptions_PDF

FileOptions_ProEngineer

FileOptions_Rhino

FileOptions_SketchUp

FileOptions_STEP

FileOptions_STL

FileOptions_VRML

SupportFiles

Customize

AddIns

License

Resources

SpaceClaim Labs

This example will disable the 'Popular', 'Snap', and 'File->CATIA' options.

<PanelsToDisable>
<PanelName>Popular</PanelName>
<PanelName>Snap</PanelName>
<PanelName>FileOptions_CATIA</PanelName>
</PanelsToDisable>

Pull Tool
Select Automatic, Add, Cut, or NoMerge to set the initial state of Pull. The
Automatic option is selected by default.

Default extrude behavior

Select this option to animate all the steps when you select the Full Pull option
to revolve, sweep, or blend your design.

Animate Full Pull
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Behavior
Select when you want interim calculations performed when modifying solids
from the menu. If this option is turned on, the preview of a change is displayed
as a rough wireframe model rather than a rendered, 3D model. If you work with
very large designs, a wireframe preview can be faster than doing the calculations
necessary to render the change as a shaded 3D model. Select:

• Auto to allow SpaceClaim to determine when to render the preview based on
the size of the component and the capabilities of your graphics card.

• On to always display changes as rough wireframe previews rather than
rendered previews.

• Off to always render the preview instead of displaying it as a wireframe model.

Preview beforemodifying

Select this option if you want SpaceClaim to help you when you are moving
solids together so that the edges (such as rounds) converge perfectly. If this
option is enabled, when you are moving solids together, SpaceClaim will display
a progress bar as it performs the convergence steps. When the option is enabled,
if the geometry fails while dragging (using the Pull or Move tool) beyond a certain
point, SpaceClaim will figure out the last value at which the geometry can be
created and will set it at that point. With the option disabled (default), you can
drag beyond the geometry failure when the geometry disappears.

Enable geometry convergence

With this option selected, all the points on the offset edge are the same distance
from the initial edge. In the examples below, the original edge is highlighted in
green, the regular offset is shown in orange, and the geodesic offset is shown in
blue.

Offset edges by geodesic
calculation

The problem search area is capped at 250. Select this option to ignore the
restriction, which allows the Repair tools to find and repair all problem areas.

Ignore problem area search
limit in Repair tools

Mirrored components will be left hand transforms of the original model, and
not contain the true, mirrored geometry. Drawing sheets and downstream
applications will see the original model, not the transformed component.

Enable left handmirror
transforms

Allows you to change the top view to Z, Y, or X. This setting is saved with the
document and only applies to new documents. You may want to change this
setting when you import drawings from other CAD applications that use a
different upward direction. This option is automatically set to Y when you run
SpaceClaim with an Ansys license, giving your design the same orientation in
SpaceClaim and Ansys. Choose X when you need to comply with manufacturing
conventions.

Top view direction
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Examples

Extruding while sketching in Section mode

Graphics
Allows you to select the graphics renderer for SpaceClaim.

• Disabled: Select this option to disable the graphics renderer.
• Direct3D11 (Default)
• WARP
• OpenGL

Renderer

Select this option to enable the display of solids and surfaces as
three-dimensional, shaded objects. The shading represents the exposure of the
scene to ambient lighting, with shadows and highlights to improve rendering.
This option is enabled by default.

Enhanced Shading

Select this option to calculate faceting in parallel to improve performance.Multi-threaded faceting

16.14. File Import and Export Options
You can open and insert files from many other modeling applications in SpaceClaim for editing, and save your
SpaceClaim designs as many different file types. If you work frequently with non-SpaceClaim files, you should set
your file options to optimize the importing and exporting process for your needs.

Note: If you try to enter a value that is out of the allowed range in the Options panel or the SpaceClaim
Options dialog, you will see a red exclamation mark icon next to the field. You can hover over the icon to
see a tooltip that will explain the valid values for the option.

General File Options
SCDOC
Options

Select to orient large designs while they are loading.Loadmodel in background
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Select to open external components as lightweight graphics
representations when opening SCDOC files. This option is disabled
when Loadmodel in background is unchecked.

Note: You cannot toggle a lightweight component's display
Off using the check box in the Structure Tree. Lightweight
components cannot be modified which includes their display
status.

Load lightweight only

Select to ignore external components whose SCDOC file has the
Read-only property checked ON. This property can be set at the OS
level or, more likely, by a PDM system.

• The option is disabled by default, which means that modified
read-only references are versioned when saved.

• When enabled, modified read-only references are skipped when
saving and a warning is displayed.

Ignore read-only files during
save

Use to search the support file folders when loading assemblies.Search Support File Folders
when loading assemblies

Import
Options

Select to use the SpaceClaim color scheme for layers. This option is
enabled by default to avoid fully saturated colors, on which
highlighting is less visible. Faces of imported data will retain their
original color tones if this option is turned off.

Use SpaceClaim color tones
when importing

Open or insert a non-SpaceClaim assembly as multiple documents.
When you save your design, click References to adjust where the
documents are saved.

Createmultiple documents
when importing assemblies

Select this option if a design contains an external component that
was previously imported and converted to the SpaceClaim .scdoc
format, and you want to re-use that previously imported file.

Note: When SpaceClaim is integrated with a manufacturing
application, this option is ignored. In the manufacturing use
case, it is common to alter geometry to accommodate
manufacturing processes and save the model with the same
name. If this option is on, it could cause the manufacturing
version to be overwritten.

Usematching SpaceClaim
documents for faster import

Immediately save an opened or inserted non-SpaceClaim file to an
SCDOC file. (If you do not select this option, then opened or inserted
files are not saved until you save the design.) Make sure that Save
importeddocumentand loadas lightweight isNOT checked if you
do not want to save any imported documents.

Automatically save imported
documents
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Improve a file when it is opened or inserted. You can choose to have
SpaceClaimClean and simplify geometry,Stitch nearby surfaces
together, and Find coincident surfaces within a Tolerance that
you specify. De-selecting this option imports the file without
improvements so the file appears more quickly, but you may have
to perform the improvements manually.

Improve imported data

Improve performance when importing large CATIA V5, Creo
Parametric, SOLIDWORKS, or Solid Edge assemblies by running
translation in multiple threads

Usemulti-threading

If you open a SpaceClaim document with external components, the
external components will be opened as lightweight.

Use lightweight assemblies for
SpaceClaim documents

If you select this option, then you can select one of the following load
methods:

• Save imported document and load as lightweight: When this
option is selected, the imported file will be opened in memory. An
SCDOC file will be created for each part in the file, saved, and then
loaded as lightweight, which frees the heavyweight data from
memory. You will see an entirely lightweight assembly. If you then
right-click one of the lightweight components and select Load
Component, then the part will be fully loaded very quickly. Also,
this method displays the color of imported parts. The methods
below do not. PMI information cannot be imported with a
lightweight model.

• Assembly structure and lightweight geometry: This method
imports the document just like in the above option, creating
lightweight parts in SpaceClaim, but no SCDOC files are created
or saved. As a result, this option uses less memory than the above
method when importing the document. However, if you use Load
Component on one of the lightweight components, the entire
document must be re-imported in order to get all of the data for
the component. Loading the component can be very slow. This
method is recommended if you intend only to use the lightweight
facets and not the heavyweight geometry or if you are working
with smaller imported documents. Since an SCDOC is not created
and saved, you are able to toggle Off the display of these
lightweight components using the check box in the Structure Tree.

• Assemblystructureonly: Only the component name and hierarchy
is created. No lightweight facets are created.

Use lightweight assemblies for
imported documents

Select to open or insert hidden components within CATIA v5,
Parasolid, Creo Parametric, SOLIDWORKS, and SketchUp files, and
turn off their visibility in the Structure tree.

Importhiddencomponentsand
geometry
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Select the objects to be imported:

• Free curves

• Points

• Planes

• Axes

• Coordinate systems

• Object names

Objects to be imported

Export
Options

Select to improve a file when it is exported. This allows you to turn
off the behavior if you don't want to merge faces and edges before
a model is exported, such as exporting to Rhino.

Improve data on export

Select to save components that have their visibility turned off in your
design as hidden components when you save them as any other file
type. This option is supported for ACIS, Rhino, SketchUp, and
SAT/SAB formats.

Exporthiddencomponentsand
geometry

Select to export CATIA files with object names.Export object names

Select to split periodic faces when exporting the files.Split periodic faces

Save drawing as image quality
(dpi)

ACIS File Options
Import
Options

Select this option to create components and use the name of the
ACIS bodies for the components. If you deselect this option, then the
ACIS structure is used in the Structure tree.

Convert ACIS bodies to
SpaceClaim components

Select this option to insert the character between the part name and
the body name, when the names are different. For example, with the
character set to a period, the name would be part.body. If you
deselect this option, then the component name of imported
components and solids are the same in the Structure tree.

Split body name by the
following characters

Select this option to import part manufacturing information.Import part manufacturing
information

Export
Options

Select this option to export part manufacturing information.Export part manufacturing
information

Select this option to include material assignments in the exported
file.

Export material information
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Use this option to set the format of exported designs.Version

File Options

AMF Options
Import
Options

Select to create a lightweight faceted body with full connectivity
information between facets

Connected facets

Select to create a lightweight faceted body with no connectivity
information between facets.

Simple facets

Select to convert AMF triangles into full geometry. File size and
memory usage is large. Specify Merge faces.

Solid/surface body

Export
Options

Export a compressed file.Compress file

(Deviation is in current model units):

• Coarse: Deviation = 2mm, Angle = 30 degrees

• Medium: Deviation = 0.75mm, Angle = 30 degrees

• Fine: Deviation = 0.5mm, Angle = 30 degrees

• Custom: Enter custom values for Deviation and Angle

Resolution

Enter a value in current model unitsFacet maximum edge length

Enter a value in the range 1- 10.Facet maximum edge length

AutoCAD File Options
Inport
Options

Select how you want to import these entities as 3D into SpaceClaim.Insert polyfacemesh, 3DFace
and Solid entities into 3D as

Select how you want to import these entities onto drawings sheets.Insert polyfacemesh, 3DFace
andSolidentitiesontodrawing
sheets as

Select the behavior for hatch identities.Insert hatch entities as

This is useful for AutoCAD files that have models positioned outside
of the SpaceClaim modeling range (+/- 1km). The center of the
bounding box for the imported data is moved to world origin
coordinates (0, 0, 0). This option is ON by default.

Center imported data
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This setting must be on in order to support text entities and table
names that require a code page conversion. The latest version of
Teigha has removed the need for this but the current version of
RealDWG still needs it.

Allow default code page
conversion

Import associated dimensionsAssociate dimensions to
geometry

Select a font to use when the original font in the DXF file is missing.Substitute font

to use Teigha 2021.7 libraries.Teigha(AssociatedDimensions)

to use Autodesk RealDWG libraries (up to 2021). Import supports
associated dimensions in your design. Use this option to import DWG
files with 3D bodies. For export it will disconnect dimensions from
the geometry in your design.

Autodesk RealDWG

Export
Options

Select the AutoCAD version to set the format of exported designs.Version

Remove color information from exported designs.Save as black andwhite

Select dimensions to associate with adjacent geometry.Associate dimensions to
geometry

On by default.Include drawing format

Off by default. Set the output of your AutoCAD files to a 1:1 ratio.Scale output 1:1

Choose either Solids or Hidden line curves.Export solids as

Select to use Teigha 2021.7 libraries.Teigha(AssociatedDimensions)

Select to use Autodesk RealDWG libraries (up to 2021). Import
supports associated dimensions in your design. Use this option to
import DWG files with 3D bodies. For export it will disconnect
dimensions from the geometry in your design.

Autodesk RealDWG

Note: When saving a drawing as a DWG or DXF file, you can also access the last two Export
options by choosingSaveAs from the File menu. Click theOptionsbutton in the Save As dialog
box.

CATIA File Options
Whether you import or export CATIA files, XYZ locations of point objects will scale as expected.

Import
Options

Select to include product manufacturing information when you open
or insert CATIA designs. If you select this option, and you previously
selected Import assembly structure only in the General file options,
that option will be deselected.

Import part manufacturing
information
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Deselect if you do not want to perform surface optimization on CATIA
files when they are imported. This option is on by default.

Trimcontrolpointsoutside face
boundaries

Select to create Groups from CATIA Geometric Sets. Select
Publications only to create SpaceClaim Groups for publications
only.

Map CATIA Geometric sets
toSpaceClaim Groups

Select to import CATIA geometry sets with the state set to In Work
Object. This option is disabled by default.

In-work Object

For CATIA CGR files, you can specify how to import the faceted data (similar to other faceted formats
such as AMF and STL):

• Lightweight

• Connected facets

• Simple facets

• Solid/surface body

Export
Options

Select the CATIA version to set the format of exported designs.Version

Reduce the number of control points on surfaces.Simplify spline surface data

Check this option ON to export the model as a Hybrid design.Export as hybrid design

Creo Parametric Options
Import
Options

Select if you want to import quilts. A Quilt in Creo Parametric is a
collection of individual surface bodies.

Import Quilts

Select if you want to import that information.Import part manufacturing
information

ECAD File Options
Import
Options

Layout Geometry

Requires you to also set the method for creating solderballs
(Bounding Box or Cylinders/Spheroids)

Layer Topology

ICEM CFD File Options (For SCDMOnly)
Import
Options

Export one .uns file for the entire design. This is the default setting.Per design
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Export one .uns file per component (blocking object) in the Structure
tree.

Per component

IGES File Options
Import
Options

Select to stitch everything together and make a solid if possible. With
this option selected, the import may fail if the model is corrupt.

Use facewise connections

Import models as a collection of individual surfaces, skipping only
the surfaces that are corrupt.

Import faces independently

Export
Options

Select On or Off.Export using JAMA IGES subset

• Manifold Solid B-Rep Object (MSBO - Type 186): MSBO defines
a manifold body with all the necessary topology information like
shells, faces, loops, edges and vertices.

• Trimmed surfaces (Type 144): The boundaries of these surfaces
will be represented by Curve on a Parametric Surface Entity (Type
142).

• Bounded surfaces (Type 143): The boundaries of these surfaces
will be represented by Boundary Entity (Type 141). The boundary
entity will refer to model space curves and surface parametric
curves, with preference set to model space curves.

Export SpaceClaim body

Fluent File Options (For SCDMOnly)
Export
Options

Exports one .msh file for the entire design. (Default)Per design

Exports one .msh file per component (blocking object) in the
Structure tree.

Per component

JT Open File Options
Import
Options

Imports JT PMI (Product and Manufacturing Information) files with
datum labels, text notes, dimension measurements, and GTOLs
(geometric distance and tolerance information, also called GD&T).

Import part manufacturing
information

Import polylines from JT facet data. To enable this option, Free
curves under General file options must be turned on.

Import polylines

• B-Rep

• Facets

Import data
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• Connected facets

• Simple facets

• Solid/surface body

Select Merge faces, if required.

Import facets data as

Export
Options

• Coarse,Medium,Fine to use the deviation and angle preset values.

• Custom to use the Deviation and Angle sliders to set a custom
resolution.

Resolution indicates the number of sides of a polygon used to
represent a circle. The deviation is the difference in distance
between the circle's radius and the polygon's radius. The angle is
the angle between the edge of the polygon and a tangent drawn
through the circle at the same point.

• Default to use the system setting.

• Use JTOpen Toolkit configuration file to import/export JT files,
which allows you to control common translation parameters using
a standard configuration file, the format of which is defined by JT
Open Toolkit. Using the toolkit also ensures 100% data
compatibility and allows you to have more control over the number
of LODs (Levels of Detail) and tessellation parameters for each LOD
in an exported JT file.

Resolution

Select On or Off.Export part manufacturing
information

Select a JT version.Version

NX File Options
Import
Options

Select if you want to import that information.Import part manufacturing
information

OBJ File Otions
Import
Options

Choose a system of units.Units

Export
Options
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Select to change the faceting setting for exported files so it is different
from the graphics faceting setting.

• Coarse,Medium,Fine to use the deviation and angle preset values.

• Custom to use the Deviation and Angle sliders to set a custom
resolution.

Resolution indicates the number of sides of a polygon used to
represent a circle. The deviation is the difference in distance
between the circle's radius and the polygon's radius. The angle is
the angle between the edge of the polygon and a tangent drawn
through the circle at the same point.

• Facetmaximumedge length: Enter a value in current model units

• Facet maximum aspect ratio: Enter a value in the range 1- 10

Override quality

Parasolid File Options
Select the Parasolid version to set the format of exported designs.Version

When checked, an extra instance node is NOT created for every component
in the assembly during export.

Shallow assembly export

PDF File Options
PDF 3D

Select On or Off.Import part manufacturing
information

• Connected facets

• Simple facets

• Solid/surface body

Select Merge faces, if required.

Import PDF facets as

Select On or Off.Export part manufacturing
information

PDF 2D

Set the quality by entering a value (default is 110 dpi).Shaded quality (dpi)

When checked on, it improves the quality of model edges in PDF.Overlay vector edges

Rhino File Options
Import
Options
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• Connected facets

• Simple facets

• Solid/surface body

Select Merge faces, if required.

Convert Rhino layers to
SpaceClaim components

Export
Options

Select to export layers.Convert SpaceClaim
components to Rhino layers

Choose a Rhino version.Version

SketchUp Options
Import
Options

Choose Solid or Facets. If Solid, enable Simplify to surfaces to
cleanup geometry by fitting planes, cylinders, and cones.

Import as

Export
Options

Choose a SketchUp version.Version

STEP File Options
Import
Options

Select to stitch everything together and make a solid if possible. With
this option selected, the import may fail if the model is corrupt

Use facewise connections

Select to import models as a collection of individual surfaces,
skipping only the surfaces that are corrupt.

Import faces independently

Export
Options

Choose a protocol to use to format exported designs.Protocol

STL File Options
Import
Options

Select a system of units.Units

Select to create a lightweight mesh with full connectivity information
between facets.

Connected faceted body

Select to create a lightweight mesh with no connectivity information
between facets.

Simple faceted body
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Select to convert STL triangles into full geometry.SelectMerge faces
to seamlessly merge one or more faces.

Solid/surface body

Export
Options

• Binary (Default)

• ASCII

Format

• Per design

• Per component

• Per body

File

Select to use the deviation and angle preset values.Coarse, Medium, FineResolution

Select to useDeviationandAngle sliders to set the resolution of the
STL mesh.

See below for a description of the effect of these options. Deviation
is the distance between a chord drawn through a curved cross-section
of the model and the curve's most distal point. The angle is the angle
that the chord line makes with a line tangent to the cross-section
curve.

Custom

Select to enter a desired edge length. The value you specify is the
maximum value for the edges, however smaller edge lengths may
be created. The ACIS modeler attempts to meet your desired edge
length setting, but in some design scenarios, may create an edge
length that is less than what you specify as your facet maximum edge
length setting, to best accommodate the design.

Facet maximum edge length

Select to change the triangle faceting ratio when you export an STL
file.

Facet maximum aspect ratio

STL Resolution Options
Deviationcontrols how far facet edges are away from model edges. The images below show the effect of Max distance
on the mesh of a cylinder. These examples keep the Aspect ratio fixed at 3 and the Facet maximum edge length
set to 4mm.
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Max Distance = 0.01mm

Max angle = 20-degrees

Max Distance = 0.75mm

Max angle = 20-degrees

Notice how the settings change the facets along the edge of the circle. The interior is a flat plane, so 45-degree
triangles are the most efficient facets.

The example on the left shows the default Max distance of 0.75mm. This refers to the gap seen in the zoomed-in
(top) image. Decreasing the Max distance to 0.01mm results in more facets along the edge, which brings the facet
edges closer to the cylinder edge, as seen in the example on the right.

Similarly, decreasing the Max angle will result in more facets along curved edges. This example shows the result of
decreasing the Max angle from 20 degrees to 1 degree.

Max Distance = 0.75mm

Max angle = 1-degree
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Without a fixed Aspect ratio and without a Max edge length, you can get more distorted triangles as shown in the
following images.

No set Aspect Ratio or Maximum Edge
Length

Max Distance = 0.01mm

Max angle = 20-degrees

No set Aspect Ratio or Maximum Edge
Length

Max Distance = 0.75mm

Max angle = 1-degree

No set Aspect Ratio or Maximum Edge
Length

Max Distance = 0.75mm

Max angle = 20-degrees

TGF File Options
Export
Options

Export per designPer design

Export per assemblyPer assembly

Export per partPer part

Export per bodyPer body

Facet
Resolution

Select to use the deviation and angle preset values.Coarse, Medium, Fine

Select to useDeviationandAngle sliders to set the resolution of the
TGF mesh.

Custom

Select to change the triangle maximum edge length when you export
a TGF file.

Facet maximum edge length

Select to change the triangle faceting ratio when you export an TGF
file.

Facet maximum aspect ratio

Select to extract feature edges when you export a TGF file. Enter an
angle to use for determining feature edges.

Extract feature edges

VRML File Options
Override
quality

Select to use the deviation and angle preset values.Coarse, Medium, Fine
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Select to useDeviationandAngle sliders to set the resolution of the
VRML mesh.

Deviation is the distance between a chord drawn through a curved
cross-section of the model and the curve's most distal point. The
angle is the angle that the chord line makes with a line tangent to
the cross-section curve.

Custom

Select to change the triangle faceting ratio when you export an VRML
file.

Facet maximum aspect ratio

Workbench Options (For SCDM only)
1. Select Workbench in the panel on the left.

2. Set basic and advanced geometry options.

3. Set theAlwaysuseSpaceClaim's readerwhenpossibleoption depending on whether you want SCDM to ignore
the Ansys CAD Configuration Manager's (CCM) settings when opening a document. File formats that can be
imported into SCDM fall into the following three categories:

a. Formats that are never routed through Ansys Part Manager (VRML, STL, PLY, IGES, STEP, and so on). These
formats always use SpaceClaim's reader.

b. Formats that must be read through Ansys Part Manager (CATIA V6, DesignModeler, Creo Elements, and so
on). Workbench preferences always apply to these formats.

c. Formats that are readable by both Part Manager and SpaceClaim's reader.

The option includes a table indicating which reader will be used for each file type. Formats listed in the table are
from categories 2 and 3 above. Enabling the option forces any format from category 3 to be routed through
SpaceClaim's interoperability functions. When the option is disabled, each format's behavior is determined by
its setting in the CCM.

16.15. Support File Options
You can specify the directories in which you store support files, such as drawing sheet formats or thread size tables.
Drawing sheets contained in these directories are displayed within the Format tool.
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Support Files Search Paths, defined in SpaceClaim Options, are also used when searching for models required by
assemblies. This situation occurs, for example, when external components are moved to a different directory.

To set the location of support files:

1. Select SpaceClaim Options from the File menu to display the SpaceClaim Options window.

2. Click Support Files from the navigation panel on the left.

3. Click Browse to replace the selected path or click Add to add another path, and navigate to the file or directory
you want to include. (You can also select the path and click Remove to remove it.)

4. Select a path and click Move Up or Move Down to order the file paths.

5. Click OK.

To change the file location display:

• Drag nodes to reorder the search paths, which determines the order in which files are searched.
• Right-click the top level (or root) node and select Add to add a new search path.
• Right-click a node and select Browse, Remove, Move Up, and Move Down.

File Backup Settings
Check theBackupeverycheck box to enable theAutosave feature. With Backup,
you can save your files automatically, helping to reduce the risk or impact of
data loss in case of a crash or freeze. The default Backup time interval is 10
minutes, but you can select a time interval from 1 to 100 minutes.

Backup every

Once you select a time interval, you can enter or click the Browse button to
select a location for the Backup files on your computer. By default, SpaceClaim
stores Backup files on your C: drive in your Users folder. If you save your file
before your session ends, your Backup files are purged.

When you relaunch SpaceClaim after a crash or freeze, an information box
displays to notify you that Backup files are available. To recover them, click
Recover from the File menu and select the file you want to open.

Backup file location

Click the Clear Backup Files button to manually purge your Backup files at any
time.

Clear Backup Files

Use the scroll box to select the number of days (0-100) that you want to store
your Backup files. By default, SpaceClaim sets the number of days at 7.

Keep Backup files for ^ days

Set the number of files to show in the Recent Documents list. The default is 8.
Can be set to 0.

Number of recent files to show

Template Settings
Enable the option and specify the path for the template file.Use template for new designs

Enable the option and specify the path for the BOM template.Use BOM template as default

Using a Template for New Designs
To create a design template, do the following:
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1. Create some geometry (or set some parameters) you wish to use as a template for new designs
2. Save the document as a SpaceClaim Template File (*.scdot)
3. InSupport Filesoptions, check theUse template for newdesigns check box and specify a path to the template

files.

File Location Settings
Enable the option and specify a path. When you choose to open an existing
design, the Open dialog opens and displays files in this directory.

Initialize Open dialog to the
following directory

Enable the option and specify a path. When you choose to save your design, the
Save dialog opens and displays files in this directory.

Initialize Save dialog to the
following directory

16.16. Ribbon Tabs
You can show or hide the following Ribbon Tabs from the Ribbon Tabs page of the SpaceClaim Options window.

• Design
• Display
• Assembly
• Measure
• Facets
• Detail
• Repair
• Prepare
• Workbench
• Mesh
• Sheet Metal
• Tools
• Keyshot
• Journal

Use the Reset button to return to the original tab configuration.

16.17. Panels
You can show or hide any of the following Panels in the Panels page of SpaceClaim Options.

• Structure
• Selection
• Layers
• Groups
• Views
• Options - Selection
• Properties
• Appearance
• Camera Options

Use the Reset button to return to the original configuration.
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16.18. Quick Access Toolbar Options
The Quick Access toolbar (QAT) is located on the title bar. The Ribbon is the menu bar that contains all the tools in
groups. You can add or remove tools from this toolbar and control the placement and display of the Ribbon.

To customize the Quick Access toolbar:

1. Click
next to the Quick Access toolbar.

2. Select any items you want to appear in the toolbar.

3. (Optional) SelectPlaceQuickAccessToolbarbelowtheRibbon to create a separate toolbar on the SpaceClaim
interface.

4. Select Customize Quick Access Toolbar to display the SpaceClaim options window. (Any changes you made in
the previous steps are saved automatically.)

You can also select SpaceClaim Options from the File menu and click Customize.

5. Select the ribbon group that contains the tool you want to include in the QAT from theChoose commands from
drop-down menu.

6. Click the tool you want to include and click Add.

Select a tool and click Remove to remove it from the QAT.

7. Click OK.

Additional options are available to customize the Quick Access toolbar.

Double-click the name of the active tab or press Ctrl+F1. Double-click a tab or
press Ctrl+F1 again to restore the ribbon bar.

Temporarily minimize the ribbon
bar

1. Click

next to the Customize Quick Access toolbar.

2. SelectMinimize the Ribbon to hide the ribbon when you are working in the
Design window.

To use the ribbon while it is minimized, click a tab to display the ribbon bar
temporarily.

Keep the ribbon bar minimized

Click

next to the Customize Quick Access toolbar and select Maximize the Ribbon.

Restore the ribbon bar

16.19. License Options
You can view and activate SpaceClaim licenses. If you have questions about licensing, contact SpaceClaim customer
support.

Enter the number of days you want to be warned when your SpaceClaim license
is about to expire.

License expiration warning
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The licensed add-ins that are available to you are listed. Select an add-in to
activate the license. When you try to activate an add-in, and a license is not
available, you will receive a warning message.

Products

Set your preferences for the primary SpaceClaim license, an Alternate flagship
license, and the Meshing license. Specifying an Alternate license allows for a
different license to be used in case the primary SpaceClaim license is unavailable,
except when None is selected.

License Preferences

License Preferences
You can set your preferences for the primary SpaceClaim license, an Alternate flagship license, and the Meshing
license. Specifying an Alternate license allows for a different license to be used in case the primary SpaceClaim
license is unavailable, except when None is selected.

For additional details, see the Ansys, Inc. Discovery Installation Guide.

Select the appropriate Alternate License and Meshing license preferences from the options available.

Meshing LicenseAlternate License

Specifies the Meshing license to use.

• CFD PrepPost
• Electronics
• Mechanical Pro
• Mechanical Premium
• Mechanical Enterprise PrepPost
• Mechanical Enterprise
• Ansys LS_DYNA

Specifies a flagship license to use if the primary
SpaceClaim license is unavailable (in all cases except
None).

• None
• CFD PrepPost
• Electronics
• Mechanical Enterprise PrepPost
• Mechanical Enterprise

Enable Check for SpaceClaim license prior to alternate license to ensure that the primary SpaceClaim license is
checked before choosing an alternate license.

By default, SpaceClaim queries and checks out license keys in the following order:

1. It looks first fordisco_level1ora_spaceclaim_dirmod, in that order. These are the primary SpaceClaim licenses.

Note: If you prefer SpaceClaim query the legacy license (a_spaceclaim_dirmod) first anddisco_level1
second, set the ANS_MODELER_FLIP_LICENSE environment variable to 1.

2. If neither primary license is present, it looks for an alternate SpaceClaim license, as defined in the License
Preferences section of the SpaceClaim Options panel.

3. If none of the primary or alternate licenses are present but SpaceClaim finds a compatible flagship license, a
message dialog appears so you can select the other license.

Overriding the License Preferences
You can use a command line option (/p) to override the primary SpaceClaim license and Alternate license preferences,
and specify a different license on application startup.

For example:
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SpaceClaim.exe /p=ansys

Legacy SpaceClaim Licensing

Switching to a Different License Type
Click New License to reconfigure the SpaceClaim license.

Your Windows login must be set up as an administrator.

Reconfiguring allows you to change from an evaluation to a customer license.

Flex Licensing
If flex licensing is available for you, your license is stored on a server. You can check out a flex license on a specific
computer, and then go off the network and continue to use the borrowed license. You borrow the license for a
specified period of time, after which it is returned to the server on the date and time you specify.

Borrowing the License
1. Do one of the following:

• Check Specific Borrow Length and enter the number of days you want to borrow the license.

The maximum number of days is determined when SpaceClaim is purchased.

• Check Specify return date/time and enter the exact date and time.

Use this option if the borrow time is shorter than one day.

2. Select the Translator licenses to borrow.

3. Click Borrow License.

When the license if successfully borrowed, Borrow License is disabled (grayed out) and title bar shows the
expiration date or the time remaining.

Returning the License
Click Return License and click OK. Restart SpaceClaim to complete the return.

Node-locked Licensing
A node-locked license is intended to prevent unauthorized (repeated) use of the SpaceClaim application, and requires
that a serial number only works on a single machine. In SpaceClaim, node-locked licenses can include, for example,
Data Exchange Package I, Data Exchange Package II, JT Open, TraceParts, and CATIA V5.

To use the same serial number on another machine, you must first deactivate the license on the first machine. To
do this, select the Deactivate License button in the License Options dialog box. The Deactivate License button
displays only if you have a node-locked serial number license, and is not visible to Flex customers, or most serial
number customers.

16.20. Resources
You can use the Resources page to purchase material properties from MatWeb, contact SpaceClaim customer
support, or view information about the SpaceClaim version.
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Click Get Materials to purchase material properties and export technical
datasheets from the MatWeb collection in the SpaceClaim material library format.

Get Materials

Click Contact Us to contact SpaceClaim customer support.Contact Us

Click About... to view copyright, software build date and version, and (if
applicable) QA Services information for SpaceClaim.

About...

Downloading Materials
You can purchase materials for the SpaceClaim Material Library directly from the MatWeb website.

1. Select SpaceClaim Options from the File menu and select Resources.

2. Click Get Materials.

3. Once you download materials, place them in the SpaceClaim\Library\Materials directory.

New materials are automatically added into the SpaceClaim Material Library.

16.20.1. Quality Assurance Services
You can verify that your Ansys programs are running properly on your computer and operating system by using
different levels of service for verifying and validating the program under Ansys Quality Assurance Services. Such
testing can benefit you when your system undergoes changes, such as an upgrade to the operating system or the
installation of different libraries.

When the Quality Assurance Services environment variable is active, a notification message appears during start-up.
Select Do not show this message again to disable the notification for subsequent sessions.

The notice also appears in the About SpaceClaim dialog, indicating when the Quality Assurance Services environment
variable is active.

16.21. Multitouch Options
The Multitouch options page is only visible if a multi-touch device is connected to your computer.

General
Enable or disable multi-touch functionality in SpaceClaim.Enable multitouch

Select either of the following, then set the options in the Settings section.

• Timing-based: This mode automatically chooses touch functions based on
the amount of time a touch signal is maintained. For example, using two fingers
moving together to immediately drag invokes panning, while holding two
fingers down for a while, then moving them, invokes what are normally
right-mouse-button drag mouse gestures.

• Gizmo-based: Existing mouse buttons and popular keyboard buttons are
placed in an on-screen gizmo, to clearly map existing functions onto the touch
interface. This mode is intended to transition existing SpaceClaim users to
the touch interface.

See Using a multitouch screen for more information about multitouch styles.

Use style

1142Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

Customizing SpaceClaim



Displays a red filled circle at the location of the recognized pen or touch locations
on the screen. This was added to facilitate online demos, so the viewer can see
where fingers are touching on the remote screen.

Show touch spots

Settings
The options in this section change depending on your Use style setting.

• If you select Timing-based, then you can set Query next direction: Set the direction of flick-based query. The
default is up.

• If you select Gizmo-based, then you can setGizmo configuration: Select Switch buttons to reverse the direction
of the gizmo. The default gizmo is configured for right-handed use and the reversed gizmo is configured for
left-handed use.

16.22. Displaying Workspace Tools
You can adjust the display of workspace tools and the display of your design in the Design window using the Show
drop-down list of tools in the Display ribbon group on the Display tab, and by modifying SpaceClaim options.

Customizing the Tools Displayed
SpaceClaim offers the following tools on the Display ribbon group on the Display tab to assist you while creating,
editing, and detailing your designs:

Check the World Origin box to display the axes that set the default orientation
of the design in the Design window.

World Origin

Check the Spin Center box to mark the center of the spin when using the Spin
tool. (This is the same as the Show Spin Center SpaceClaim option.)

Spin Center

Check the ZoomLegend box to display the zoom legend in the Design window.Zoom Legend

Check the Lineweight box to change the line style to the thickness set by the
Lineweight tool in the Style ribbon group.

Lineweight

Check the Face Highlight box to enable pre-highlighting of faces.Face Highlight

Check the Face Spotlight box to show a spotlight attached to the cursor when
passing over faces.

Face Spotlight

Check theBodyGlowbox to enable highlighting for pre-selection and selection
of bodies. This setting applies to all windows.

Body Glow

Check theVerticesbox to show all vertices in the model. Vertices are not shown
on closed periodic edges (for example, on a cylinder). This setting works on a
per-window basis, enabling it in one window has no effect on other windows.

Vertices

Check theBody Interferencebox to show any bodies that are intersecting. This
setting works on a per-window basis, enabling it in one window has no effect
on other windows.

Body Interference
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Check the Ambient Occlusion Only box to render the display with a diffuse,
non-directional shading effect that approximates how light should be shining
on any specific surface based on the light source and, if included, the
environment. The shading represents the exposure of the scene to ambient
lighting, for example, interior surfaces of a model are typically more occluded
and will appear darker than the exposed outer surfaces. This option can be used
when the Enhanced Shading option is enabled.

In the example, the image on the left is rendered with Ambient Occlusion and
shows the shadows and highlights that are missing in the image on the right.

Ambient Occlusion Only

Check the Adjacent Entities box to display faint highlighting on adjacent faces
when you hover over an edge and on adjacent edges when you hover over a
vertex. Scrolling the mouse wheel switches between adjacent entities. This
feature is useful in selecting the correct edge or face to extrude.

Adjacent Entities

Check the Offset Baseline Faces box to display offset relationships with blue
shading.

Offset Baseline Faces

Check theStandardHolesbox display Standard Holes in blue. When unchecked,
Standard Hole faces display in the normal face color.

Standard Holes

Check the Lightweight Components box to display Lightweight components.
This also has a flyout for setting Lightweight component transparency.

Lightweight Components

Check the Environment box to display according to the settings in the
Appearance panel.

Environment

To display other workspace tools, modify the settings in the Popular SpaceClaim options.

You can also display journal-related tools by checking the Show Journal Tab option in the Popular SpaceClaim
options.
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Examples

Hovering over an edge with Adjacent Entities highlights the faces shared by the edge

16.23. Configuring Windows
SpaceClaim has several docking windows that are initially docked along the left side of the application. You can
minimize these panels, detach them, or dock them to different sides of the application. You can also dock and detach
your design windows.

Click the thumbtack icon to minimize the docked panel. Mousing over a
minimized panel expands the panel while the cursor is over it. Once the cursor
leaves the expanded panel, it returns to its minimized state.

To minimize a panel

Click the thumbtack icon

to "stick" the panel to the application window.

To maximize a panel

Drag a panel by its title bar to detach it. Drag a design window by its tab to detach
it.

To detach a panel or window

Drag a panel or window by its title bar or tab. As you move the panel or window
over the application, icons indicate possible docking positions.

Mouse over an icon to preview the docked location. Release the mouse button
to dock the panel at that location.

To dock a panel or window

1. Select SpaceClaim Options from the File menu and select Appearance.

2. Click Reset Docking Layout.

3. Click OK.

To return docked panels to their
default layout

16.24. Customizing a View
You can change the shortcut keys for standard views and create your own custom views to save settings for object
orientation and visibility.

User-created views will not auto-scale when they are moved.

Clicking the Name column header in the Views panel toggles through ascending, descending, and user defined order.
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Changing View Shortcut Keys
1. Select the View tab in the Structure panel.
2. Select a shortcut key combination in the Shortcut drop-down list for the view you want to change.

Adding a Custom View
1. Position the view in the design window as you want it saved.
2. Select the View tab in the Structure panel.
3. Click Create View at the top of the panel.
4. Select from the following options:

• Name: Enter a unique name for the view. The name will appear in the Structure tree.
• Shortcut: Select a key combination from the drop-down list.
• Orientation: Select if you want the current orientation to be saved in the view.
• Object visibility: Select if you want the visibility of objects in the current view to be saved in the view. Objects

that are hidden when you create the view will be hidden when you apply the view. Visibility is applicable to all
types of geometry, planes, and curves.

• Visibilitybehavior fornewobjects: Select the visibility behavior you want to apply to objects you create after
you create the view.

• Leave Unchanged: New objects will retain their visibility when you apply the view.
• Visible: New objects will be visible when you apply the view.
• Hidden: New objects will be hidden when you apply the view.

5. Click OK.

Your custom view is added to the View tool menu.

Using Custom Views
The options that are available for custom views are:
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You can change the current view to a custom view in the following ways:

• Select the View tab in the Structure panel, right-click the view, and select
Apply view from the context menu.

• Use the shortcut key (if assigned).
• Select the view from the View tool menu

in the Orient ribbon group.
• Double-click the view.
• Select the view and click enter.

Applying a Custom View

Position the view in the design window as you want it saved.

Right-click the custom view you want to replace and select Replace from the
context menu.

The custom view is replaced with the current view.

Replacing a Custom View

Right-click the custom view you want to rename and select Rename from the
context menu.

Enter a new name for the view.

Renaming a Custom View

Right-click the custom view you want to edit and select Properties from the
context menu.

Edit the view properties.

Editing Custom View Properties

Select the view you want to delete and clickDelete View at the top of the panel.

You cannot delete standard views.

Deleting a Custom View

16.25. Creating Custom Shortcuts
You can create custom shortcuts for SpaceClaim commands.

1. Select SpaceClaim Options from the File menu to display the SpaceClaim Options window.

2. Click Customize and then Shortcuts in the navigation panel on the left.

A list of current shortcuts is displayed.

3. Click Add... to create a new shortcut.

The New Command Shortcut dialog opens.

4. Select a command from the dropdown list. The list is separated into two collapsible lists.

• Popular Commands
• Ribbon Commands

5. Enter a key sequence.

If the key sequence entered is already in use, you will be notified.

6. When an acceptable sequence is entered, click Assign to save the shortcut.

You can continue to add more shortcuts or select an existing shortcut and click Edit to change it.

When you are done creating and editing shortcuts, click OK to exit.
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17: SpaceClaim Add-Ins

The following add-ins are currently available for SpaceClaim:

• Ansys Launcher - Pass designs back and forth between SpaceClaim and Ansys. See Ansys Add-In on page 1149.

• Conversion - Batch convert files to the SpaceClaim format.

• TraceParts - Insert a component from an expansive library of standard parts.

You must install and activate each add-in before you can use it. You will receive a warning message if you try to activate
an add-in and a license is not available. If you want to use an add-in, but it is not available, contact SpaceClaim Customer
Support.

Activating an Add-In
1. Select SpaceClaim Options from the File menu then click Add-Ins.

2. Check the box next to the add-in to activate it.

3. Click OK.

4. Exit SpaceClaim and restart it.

Inserting a Trace Part
1. Select Insert from Trace Parts from the Insert tool on the Design tab.

2. Select the part you want to insert.

3. Click OK.

The selected part appears as a new component in your design.

17.1. SpaceClaim API
The SpaceClaim Application Programming Interface (API) allows you to create add-in applications that extend the
functionality of SpaceClaim. An add-in application is a managed code DLL that uses Microsoft .NET Framework 3.0
and the SpaceClaim API.

Information about the SpaceClaim API can be found in help files in a sub-folder in the SpaceClaim installation folder.
The sub-folder has a name of the form "SpaceClaim.Api.Vx", where "Vx" refers to the version of the API. For example,
information about API V21 can be found in the "SpaceClaim.Api.V21" sub-folder.

The following documents are provided:

• SpaceClaim_API.chm - the Developer's Guide to writing an add-in.

• API_Class_Library.chm - documentation for classes, structs, methods, and properties in the API.

• Developers Guide.pdf - an overview of the SpaceClaim API and its concepts.

These documents are written by developers for developers, and are available only in English.
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17.2. Ansys Add-In
SpaceClaim and Ansys provide a combined solution that you can use to simplify CAD models for analysis. With this
add-in, you can send a model that was imported or created in SpaceClaim to Ansys Workbench, Ansys Mechanical,
Ansys DesignModeler, or any other integrated Ansys products. The geometry is sent into Ansys along with any driving
parameters or analysis specific attributes (spot welds, midsurfaces thicknesses, etc) that you have defined. Driving
parameters can be edited within Ansys to run sets of iterative analyses.

The basic process is simple:

1. Import a CAD model into SpaceClaim.

2. Simplify and modify the model for analysis.

3. Define parameters and named selections that you can use in Ansys.

4. Send data to Ansys:

• Start Ansys Workbench and create a geometry cell:

• To work with an existing design, click Import Geometry in Ansys and choose an existing SCDOC file, then
use Edit Geometry to launch SpaceClaim with that document loaded.

• To start a new design, clickNewSpaceClaimGeometry in Ansys to launch SpaceClaim with an empty design.

5. Modify and send data between SpaceClaim and Ansys, and rerun the tests as often as necessary.

6. Return the validated design options or recommended changes to the designer when testing is complete.

Sending Data to Ansys
You can transfer the active model to Ansys, even if it has not been saved. You can also send data from a document
that is open in SpaceClaim or from a saved SpaceClaim document.

Only visible objects are sent to Ansys, hidden objects are not sent.

The following data is transferred to Ansys:

• Geometry

º Solids

º Surfaces

º Line bodies (Beams)

When a Beam with Section Anchor type set to Location is transferred to Workbench, its Location becomes a
Workbench Offset of type,User Defined. The X and Y offset components will, in general, change to preserve the
Beam cross-section position relative to the Beam line. This coordinate transformation is necessary to account
for differences between SpaceClaim and Workbench reference frames.

º Points

• Origins

• Named Selections (groups)

• Driving dimensions (groups)

º Ruler dimensions
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º Pattern count

º Driving annotation dimensions

º Shell thickness

• Midsurface thickness values on surfaces

• Spot welds

• Material properties

Customizing SpaceClaimwith Ansys ACT
Within Ansys ACT, you can create custom applications or "extensions" to customize supported Ansys products,
including SpaceClaim.

An ACT "wizard" extension enables you to leverage both the functionality of SpaceClaim and the scripting capabilities
of the Workbench framework API. You can manipulate existing features and simulation components, organizing
them as needed to produce a custom automated process. A wizard exposed in SpaceClaim provides simulation
guidance within the application workflow, walking non-expert users through a step-by-step simulation. For more
information, see ACT Simulation Wizards and SpaceClaimWizard in the Ansys ACT Developer's Guide.

17.2.1. Ansys Part Names
Workbench applications only support flat (single-level) assemblies. An Ansys part is created for each SpaceClaim
part, at any level in the assembly. This part contains bodies that are visible and match the import filters set in Ansys.
The filters are Import Solid Bodies, Import Surface Bodies, and Import Line Bodies.

In Ansys DesignModeler, multi-bodied parts are parts (components) that contain more than one body (solid, surface,
or line body). For example, for two surface or two solids to share topology, they must be placed in a multi-bodied
part.

Ansys Mechanical allows a maximum of two assembly levels. You can have components inside components, but
nothing deeper.

If you send a component with two or more bodies into Ansys Mechanical, then it shows up as a part with multiple
bodies in it (multi-bodied part).

If you send a component with two or more bodies into Ansys DesignModeler, then everything becomes flat.

When you send a SpaceClaim assembly to Ansys Mechanical, it also gets flattened to 2 levels.

Ansys DesignModeler:Ansys Mechanical:SpaceClaim:
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SpaceClaim Part and Body Names in Ansys
In Simulation, the Geometry node represents the assembly, and nodes immediately beneath that represent parts.
If a part has more than one body, then child nodes are shown for each body, but if there is only one body, no child
nodes are shown. This is based on the number of bodies transferred, which is subject to visibility and filters.

For a multi-body part Ansys Mechanical displays the part name on the part node and the body name on the body
node, but for a single-body part Ansys displays a combined name on the part node, in the form <Part name> (<body
name>). For example, Wheel (Solid).

The image above shows an assembly in SpaceClaim on the left and the same assembly in Ansys on the right.
Component 1 is displayed as a single-body part in Ansys and component 3 is moved to the root level.

Component instance names are not transferred.

Mass Properties
Ansys will calculate the volume, center of gravity, and moments of inertia of the part if these values are not supplied.
SpaceClaim supplies the volume and allows Ansys to calculate the center of gravity and moment of inertia.

17.2.2. Using Groups to Drive Changes in Ansys
SpaceClaim and Ansys have full round-trip associativity. This means that changes to the model can be sent back
and forth between SpaceClaim and Ansys.

You can define groups to use as parameters and named selections. If the objects in the group are similar or related,
then a property is created that can be used to change a parameter in Ansys. For example, you could create a group
of all faces that have the same offset and use this group to change the offset in Ansys.

Note: Negative dimension values can invert the direction vector of SpaceClaim operations that they are
associated with. This change is applied to the current and subsequent design point updates. Thus, when a
Workbench input parameter is used as a driving dimension for a SpaceClaim geometry, negative dimension
values may result in unexpected geometric changes.

Updating Group Parameters
Groups are instantly added to the Parameters group in Workbench. Changes to the group in SpaceClaim, such as
renaming and deleting the group, are also immediately reflected in Workbench.

However, if you edit the dimension of a group parameter in SpaceClaim, the new value isnotautomatically updated
in Workbench. You must click Update Parameters in the Ansys group to push the change to Workbench. You can
also send the change by saving the project or closing SpaceClaim. This means that if SpaceClaim is not running, you
know that the parameters are up-to-date.
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Using Driving Dimensions in Ansys
You can create driving dimension groups in SpaceClaim and use them to change key dimensions in Ansys. Just select
the part in the structure tree in Ansys and find the CAD Parameters section in the Details panel. Change a value and
run the analysis again to see its affect. You can use Update to send the new values back to SpaceClaim.

• Creating a driving dimension with Pull (offset)

• Creating a driving dimension with Move (translation or rotation)

• Creating a driving dimension with the Select tool (round radius and distance between offset faces)

17.2.2.1. Adding a Driving Dimension with the Pull Tool
You can save a ruler dimension as a driving dimension in the Groups panel. When you click a driving dimension
created with Pull, the Pull tool is automatically activated. Changing the dimension is like pulling the object. The
points, edges, faces, or axes for the dimension are offset if you change the dimension's value. The state of the Add,
Cut, and No Merge options are saved with the group.

You can save the following types of driving dimensions with the Pull tool:

• Distance (offset)
• Radius

To add a driving dimension with the Pull tool:

1. Click
Pull in the Edit group on the Design tab.

2. Select the points, edges, faces, or axes that you want the dimension to offset if it is changed.

3. Click Ruler in the Options panel or the mini-toolbar.
4. Select the face, edge, point, or axis where you want the selected faces dimensioned to.

5. Click Create Parameter on the Groups panel.
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The video shows creating a radius dimension and a distance offset dimension. The cylinder's radius changes and
the offset for the axis changes when the dimensions are changed.

17.2.2.2. Adding a Driving Dimension with the Move Tool
You can save a ruler dimension as a driving dimension in the Groups panel. When you click a driving dimension
created with Move, the Move tool is automatically activated. Changing the dimension is like moving the object. The
points, edges, faces, or axes for the dimension are moved if you change the dimension's value.

To add a driving dimension with the Move tool:

1. Click
Move in the Edit group on the Design tab.

2. Select the face or faces that you want the dimension to move if it is changed.

3. Click a direction or rotation axis on the move handle.

4. Click Ruler in the Options panel or the mini-toolbar.

5. Select the face, edge, or point where you want the selected faces dimensioned to.

6. Click Create Parameter on the Groups panel.

The video shows creating a radius dimension and a distance offset dimension. Changing a dimension is like moving
the face. The cylinder and the planar face move when their saved dimensions are changed.

17.2.2.3. Adding a Driving Dimension for Rounds
Groups with driving dimensions are saved in the Groups panel. When you create a group for a round or series of
rounds that have the same radius, you can change the radius by changing the value stored for the group. Likewise,
when you create a group for faces with an offset relationship, you can change the distance between the faces by
changing the group value.

To add a driving dimension for rounds:
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1. Click Pull in the Edit group on the Design tab.

2. Select a round or a chain of rounds that have the same radius.

3. Click Create Parameter on the Groups panel.

Now you can change the value for the group to change the radius of the round.

To add a driving dimension for offset faces:

1. Click
Select in the Edit group on the Design tab.

2. Select a face with an offset relationship.

3. Click Create Parameter on the Groups panel.

Now you can change the value for the group to change the distance between the offset faces.

17.2.3. Using Named Selections in Ansys
You can create named selections in the SpaceClaim Groups panel and then use these groups as named selections
in Ansys.

See Using Groups to Drive Changes in Ansys on page 1151 for information about using groups to make changes to the
design in Ansys.

To create a named selection:

1. Select the objects you want to include in the group.

You can use the Selection panel to select objects in the same part that are similar or related to the object that is
currently selected.

2. Click Create NS in the Groups panel.

3. (Optional) Rename the group.

It is helpful to rename the groups with a prefix that tells you the group's type, because named selections and
driving dimensions are grouped together in the structure in Ansys.

4. Send your change to Ansys.

17.2.4. Ansys Workbench Settings
There are many user preferences in Workbench that control geometry transfer. The settings supported by SpaceClaim
are explained below.
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DescriptionWorkbench setting

The following parameters are transferred:

• Part parameters: Only includes the sheet metal parameters for thickness, inner
radius, and kFactor if the part is a sheet metal part. These are transferred with
the names, Sheet.Thickness, Sheet.InnerRadius, and Sheet.kFactor.

• Assembly parameters: Groups for the active window (belonging to the root part)
that have a dimension.

If you have more than one part occurrence for the same primary part in SpaceClaim
(for example, 4 wheels in a car assembly), then part parameters are only transferred
for the first occurrence. The parameters for each part node are not transferred
because Simulation allows you to set contradictory parameters on different nodes,
even if they share the same geometry.

The Parameter Processing option also controls whether parameters are applied
if they have been changed in Simulation and then the Update: Use Simulation
Parameter Values command has been executed.

New assembly parameters are applied in the order that dimension groups are listed
in theGroups panel in SpaceClaim. You can change this order by dragging a group
to a new location in the list.

Parameter Processing

The Personal Parameter Key is a string that can match the start or the end of the
parameter name. You can specify more than one key separated by semicolons. By
default, SpaceClaim groups have no parameter prefixes.

Personal Parameter Key

SpaceClaim does not transfer vertex members because CAD Associativity for
vertices is not supported at this time.

NamedSelectionProcessing

Supported by SpaceClaim.Named Selection Prefixes

Supported by SpaceClaim.Materials Property Transfer

This option may slow things down, which is why there is a preference to turn it off.
With SpaceClaim, the performance difference should be negligible, so you should
keep it enabled.

CAD Associativity

Coordinate systems belonging to the root part are transferred.Import Coordinate Systems

Spot Welds are transferred.Import Work Points

Simulation allows parts to share a B-Rep, which means transfer is faster and the
B-Rep only must be meshed once. Because spot weld points must be defined in
terms of special vertices created in the B-Rep (for example, a vertex in a face requires
a degenerate loop containing a single vertex), B-reps can only be shared if they are
identical in the spot welds that they have. SpaceClaim compares spot weld points
and create instances that share a B-Rep for those part occurrences that have the
same spot weld requirements.

We recommend that you leave this option turned on.

Import Using Instances
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DescriptionWorkbench setting

Smart update will only re-transfer parts that have changed, which can save a lot of
time with a large assembly. Unfortunately, what constitutes a change in this case
is an all-or-nothing consideration, which means a part will need to be re-transferred,
along with any other parts that would share its B-Rep, if any of the following have
changed:

• The placement of the part occurrence in the overall assembly has changed.
• Bodies have changed geometry, or been added/removed, or made visible/invisible,

or the filters have selected different bodies.
• The name of the part or any of the bodies has changed.
• Named selection members for this part occurrence have changed.
• Spot weld points for this part occurrence have changed.
• Parameters (currently only sheet metal parameters) for this part have changed.

If you save your work in Simulation as a "dsdb" file, the timestamps used for smart
update are saved with it, which means smart update continues to work in the next
session.

Do Smart Update

Attach is what Ansys calls a transfer. This preference uses a file for data transfer
rather than reading data streams directly. This may be faster for large assemblies.

Attach File Via Temp File

If this is set to 2D, then only surface bodies lying in the XY plane are transferred.Analysis Type

Simulation does not support bodies of mixed dimensionality in a multi-body part.
They will transfer successfully, but they will fail to mesh. Mixtures of surface and
line bodies are supported, but mixtures of solid-surface or solid-line are not.
Therefore, if a part contains a mixture of solid and surface bodies, which is quite
common in SpaceClaim,Mixed Import Resolution can be used to specify whether
solids bodies or surface bodies should be used.

If Mixed Import Resolution is set to None, a mixture of solid bodies and surface
bodies could be transferred, and as already mentioned, the part will fail to mesh.
The default setting is None, since most CAD systems do not support mixtures of
solids and surface bodies, but this setting should be set to Solid or Surface with
SpaceClaim.

Mixed Import Resolution

Settings Not Supported by SpaceClaim
The following settings are not supported by SpaceClaim:

• CAD Attribute Transfer

• Reader Save Part File

• Enclosure and Symmetry Processing

• Work points (construction points)

17.2.5. Configuring SpaceClaim and Ansys
In order to transfer geometry, parameters, and named selections from an external SpaceClaim license to Ansys
Workbench, the correct import options must be set within Workbench.

To set the Workbench geometry import options:
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1. Click Tools > Options in the Ansys Workbench menu.

2. Select Geometry > Import in the left panel of the Options dialog.

3. Check the Use SpaceClaim Direct Modeler as an External CAD option.

4. Select 3D for the Analysis Type.

5. Make sure there are no prefix values to filter for in the Parameters or Named Selections fields.

6. The following options should not be selected: Reader Save Part File, and Smart Update.

All other options should be selected.

7. Select None for Mixed Import Resolution.

8. Select SpaceClaim for the Preferred Geometry Editor.

9. Restart Workbench for the changes to take effect.

17.2.5.1. Connecting to Ansys

Launching Workbench from SpaceClaim
If you have the Ansys add-in installed in SpaceClaim and Ansys installed on your computer, then you will see a new
Ansys button on the Prepare tab. Click the Ansys Workbench button to send the current model in SpaceClaim to a
new project in Workbench. A new geometry cell will be created automatically.

Connecting to SpaceClaim from Ansys Workbench
Start Ansys Workbench and create a geometry cell:

• To work with an existing design, click Import Geometry in Ansys and choose an existing SCDOC file, then useEdit
Geometry to launch SpaceClaim with that document loaded.

• To start a new design, click New SpaceClaim Geometry in Ansys to launch SpaceClaim with an empty design.

17.2.5.2. Updating Data with Ansys
SpaceClaim is a recognized geometry editor in Ansys.

The SpaceClaim title bar now shows the system ID for the Workbench project and the system name as a prefix, as
in: A:Geometry - <remainder of title>. Document tabs for the corresponding geometry cells display the Ansys icon
and the unique system name from Ansys to make them easy to find.

Note:

• When you transfer geometry to Ansys, only surface bodies are stitched. Other bodies are fused, and a
warning is issued if shared topology fails.

• When a Beam with Section Anchor type set toLocation is transferred to Workbench, its Location becomes
a Workbench Offset of type, User Defined. The X and Y offset components will, in general, change to
preserve the Beam cross-section position relative to the Beam line. This coordinate transformation is
necessary to account for differences between SpaceClaim and Workbench reference frames.
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Editing SpaceClaim Data From Ansys
• To work with an existing design, click Import Geometry in Ansys and choose an existing SCDOC file, then useEdit
Geometry in SpaceClaim to launch SpaceClaim with that document loaded.

• To start a new design, click New SpaceClaim Geometry in Ansys to launch SpaceClaim with an empty design.

• To edit a design that is used in a simulation, open the Workbench project and clickEditGeometry inSpaceClaim.

• Click Reset in the geometry cell to disconnect the cell and clear its contents.

Initiating Changes From SpaceClaim
Click the File menu and select Save Project to save the Workbench project.

This is the same as clicking Save in Workbench. The entire project schematic is saved, including any geometry cells,
anddesign.wbpjanddesign_files folder are created, wheredesign is the name of your design. The .scdoc file for each
geometry cell is saved in this folder.

17.3. Driving dimensions with Excel
The Excel add-in lets you control dimensions with an Excel spreadsheet.

When you create a spreadsheet in the Excel ribbon, Driving Dimension groups are automatically added to an Excel
spreadsheet. In the spreadsheet, you can enter new target values, or use Excel's formulas to calculate new values.

Using an Excel Spreadsheet to Drive Dimensions
1. Create Driving Dimension groups for dimensions you want to control

In thePullandMove tools, create Ruler Dimensions and add them to Groups to create Driving Dimension groups.

2. Open the Excel tab.

3. Click Create.

The spreadsheet is created and automatically populated with groups

Auto update is On by default. If you have several dimensions to change, turn it off so the model does not update
until you have entered all the new values.

4. Enter Target Values.

5. Click Update to apply the new dimensions to your model.

As with all spreadsheet calculations, you should avoid circular calculations.

Values are applied sequentially, so order your groups in the sequence that you want to perform the operations.
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17.4. MakerBot Thingiverse
The MakerBot add-in allows you to upload models to MakerBot's Thingiverse design community.

To upload a model to Thingiverse:

1. Click Login to login to Thingiverse.

2. A web page opens for you to authorize SpaceClaim to access your Thingiverse account.

a. If you do not have an account, the application redirects to the web page for creating an account.
b. When you create an account, you are required to authorize SpaceClaim.

SpaceClaim displays a message in the Status Bar when you are logged in and the Login button grays out..

3. The Upload button is enabled. Click Upload to upload the current mesh model.

4. A dialog opens to enter information Thingiverse needs to process your model.

When you submit the information, Thingiverse opens the web page containing your model.

5. It may take a few minutes for your model to appear as Thingiverse processes the information and generates
thumbnail images, etc.

The link to your model can be copied to the clipboard.
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18: Getting Help

There are several resources you may find helpful when using SpaceClaim.

• Online help

Detailed tooltips are provided for each tool within SpaceClaim. You may find that a careful reading of the tooltip provides
all the information you need to use the tool.

If you need more information, click

in the tab bar or press F1 while the tooltip is open to display the online help for the tool. The online help provides
step-by-step instructions, animations, and examples.

• Customer support

SpaceClaim is committed to providing you with every opportunity to communicate directly with us so you benefit by
helping us continuously improve our products, services, and build our growing community. We want to help you apply
SpaceClaim efficiently to solve your product development problems.

SpaceClaim's annual lease license includes subscription services, so you can be confident that you will always have
access to expert technical resources and the latest software. Subscription services provide the latest product releases
and upgrades, direct access to SpaceClaim technical resources via phone, email, and chat, and personalized access to
our customer portal.

When contacting customer support, the following information may be needed to properly diagnose your issue:

º SpaceClaim version number

º Environment details (operating system, hardware, graphics card)

º Brief description of your issue

º Detailed steps to reproduce the issue

º Related files (journal files, data files)

Gathering this information before contacting customer support could help in finding a resolution more quickly.

Checking for Updates
When you open the SpaceClaim application, it automatically checks for updates. If updates are available, a message
appears in the status bar.

1. Select SpaceClaim Options from the File menu and click Resources.

2. Click Check for updates to check for recent software updates.

Downloading Models, Contacting Support, or Finding the Version Number
1. Select SpaceClaim Options from the File menu and click Resources.

2. Click:

• Get SpaceClaimmodels to download models from the SpaceClaim model library

• Contact us to contact SpaceClaim Customer Support through the website
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• About SpaceClaim to find the version number of the SpaceClaim software you are running.
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19.1. Glossary

List of Terms

3Dmarkup
A document type that enables you to annotate and compare different versions of a design.

Absolute coordinates
See Coordinates

ACIS
Modeling engine by Spatial Corporation. You can import and export ACIS files (.sat and .sab).

Alignment axis
Axis around which you can rotate a component using the Orient tool.

Anchor in Detail views
A point used as the starting point for scaling.

Anchor in Move tool
The center ball of the Move handle. You can drag the center ball or use the Anchor tool guide to place the anchor on
a solid, face, edge, vertex, or origin.

Anchor in Patterns
A member of a linear or rotational pattern that does not move with the pattern. You can anchor one or more pattern
members using the Fulcrum tool guide.

Anchor point
See Anchor

Angular reference
Starting point for dimensioning an angle.

1162Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

19.1. Glossary



Angular ruler dimension
See Ruler dimensions

Annotation
Information you can add to a drawing, such as notes, dimensions, geometric tolerances, center marks, and Bills of
Materials.

Annotation plane
Plane on which you can annotate designs, drawing sheets, and 3D markups. Use the Create Note tool to select an
annotation plane and enter text onto the plane.

Arc
Curved line of constant radius; part of a circle. See Sweep arc, Three point arc, Tangent arc.

ASME
American Society of Mechanical Engineers standards for engineering drawing practices. You can customize the style
of your annotations to conform to ASME standards. See ISO, JIS

Aspect ratio
Ratio of the length to width of a rectangle or the height to width of an image. When resizing images, it can be important
to maintain the aspect ratio to avoid distortion.

Assembly
Hierarchy of components and subcomponents showing relationship within a design, as shown in the Structure tree.
In manufacturing, a unit fitted together from manufactured parts. See Assembly tool, Component

Assembly tool
Use the Assembly tools to specify how components are aligned with each other, that is, create a mating condition.
You can Align, Center, and Orient components.

Association
Relationship between objects that enables you to edit them together. For example, when you pull a polygon into
3D, the faces acquire a polygon relationship. If you act on one face or edge, it affects all the faces in the polygon.
Another example of an association is a mirror plane between two faces. See Mirror, Remove associations
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AutoCAD
Software application for 2D and 3D design and drafting by Autodesk, Inc. AutoCAD's native file format is DWG, its
interchange file format is DXF, and its format for publishing CAD data is DWF.

Axial face
Face of a 3D object through which an axis extends. The axis displays when you move the cursor over the axial face.

Axis
Straight line that an object rotates around or that objects are regularly arranged around. See Alignment axis.

Balloon
Annotation consisting of content from the Bill of Materials. Balloon notes update when changes are made to the
BOM table.

Baseline faces
See Offset baseline faces

Bend allowance
Amount of material added to compensate for changes caused by bending sheet metal. Allowance is required to
correct for the change in length caused by bending a flat sheet.

Bend deduction
Value used to calculate unfolded lengths of sheet metal. Bend Deduction is twice the distance from the outside mold
line to the beginning of the bend (set back) minus the bend allowance.

Bend deduction table
CSV (comma-separated value) file used to calculate the developed lengths for unfolded or flat patterns to be
machined.

Bill of Materials (BOM)
Table of components, sub-components, parts, and materials needed to manufacture a finished product.

Blend
Smooth and tangent transition between faces or edges; created using the Pull tool.
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Blend plane
Sections that appears when you edit a face as a blend using the Edit as Blend tool. You can create, move, and orient
blend planes.

Blend surface
Faces you can edit using the Edit as Blend tool. If the face was originally created as a blend, the original blend surfaces
are available for editing. If the face is not blended, the tool first converts the face to a blended surface.

Blended face
Face created by blending between two edges.

Body
A solid or surface.

Bounded line
Segment of a line bounded by one of more intersections with lines or edges. Use the Trim Away tool to delete a
bounded line.

CATIA
Modeling engine by Dassault Syst�mes. You can import and export CATIA files.

Chamfer
Sloping corner between two edges created using the Pull tool; angle with equal setback; bevel.

Chord
Straight line with both end points on a circle.

Chord angle
Degrees of a circle delineated by a chord. In a Swept arc, the starting point and end point of the arc define the chord.

Clip
Hide all geometry in a design above or below the grid or selected plane.
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Closed lines
Intersecting lines that enclose an area to form a region when you sketch shapes in 2D. The regions will become solids
and the lines become edges when you pull your sketch into 3D.

Closed loop
Contiguous sketched lines or edges. Can be selected by double-clicking one of the edges or lines.

Coaxial
Relationship between faces that share the same center of rotation. If you check the Coaxial Face Groups box in the
Display tab, faces that share an axis are indicated with blue shading.

Combine
A tool used to cut or glue geometry together.

Component
Object in a design, including the top-level design component. Each component consists of any number of objects,
such as solids and surfaces, and can contain sub-components. You can think of a component as a "part." Components
can be saved as a separate file. An external component is another design inserted as a component of your design.
Making the component internal prevents changes from being made to the external component file. You can also
create an external component by saving a component as a separate file. See Lightweight components, Assembly

Constant-radius round
Default configuration for a fillet. The radius of the rounded corner is uniform across the length of the line or edge.
See Fillet, Variable radius round

Construction line
Shape drawn with a Sketch tool to help you create an accurate sketch. Construction lines become axes in 3D. They
are also useful for creating mirrors.

Context menu
In the user interface, a list of functions specific to the operation that you are performing. Access the context menu
by right-clicking in the design window.

Converging lines
Non-parallel lines. With the Dimension tool, you can annotate converging lines at a virtual sharp.
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Coordinates - Absolute
Method of inputting points based on distance and angle. Absolute coordinates are measured from the origin (x and
y for 2D and x, y, z for 3D).

Coordinates - Polar
Method of inputting points based on distance and angle. Polar coordinates are measured by entering values for
distance and angle.

Coordinates - Relative
Method of inputting points based on distance and angle. Relative coordinates are measured from the selected point
(x and y for 2D and x, y, z for 3D).

Corner
See Fillet (interior corner) or Round (exterior corner)

Cross-sectionmode
Mode used to edit solids by working with their edges and vertices in cross-section. In this mode, pulling a line pulls
a face, and pulling a vertex pulls an edge. To create a cross-section view, you select the face that will be used to set
the cross-section plane. Hatching is used to show the intersection of the cross-section plane and a solid.

Cross-section view
One of the view selections for drawing sheets. Cross-section view shows a cross-section through your design. You
create a cross-section view from one of the other views on the drawing sheet. See General view, Projected view, and
Detail view.

Curvature
Analysis tool that displays a fringe graph or color shading to represent the curvature along curves or edges. Values
indicate how curvy or "swoopy" the curve or surface is at each point.

Curve
In 3D, any line in space.

Curve center
A small cross that appears on the sketch grid at the center of a circle, ellipse, polygon, or arc.
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Curved slot
A slot created by pulling a hole along the axis of a driving cylinder. A 360 degree curved slot is a round cut. See Radial
slot.

Cutter object
When using the Combine tool to split a solid or surface, the Cutter object is the solid or surface you use to cut the
target. Use the Select Cutter tool guide to select the Cutter object.

Cylindrical face
The surface of a cylinder, formed by points at a fixed distance from the axis of the cylinder.

Datum
Object that is assumed to be an exact size and shape, and be in an exact location, that is used to locate or establish
geometric relationship of other objects.

Datum symbol
Symbol attached to a point, axis, or plane that must be referenced for machining and inspection.

Design
2D or 3D model that contains at least one top-level component.

Design component
See component

Design window
Area in the user interface that displays your model or assembly. Also known as Workspace.

Detach
Create separate surfaces from individual pieces of a sketch, or objects or faces in 3D. You can detach protrusions to
move them with the Move tool's Detach First option.

Detail
Aspects of a design incorporated to communicate with others or submit the design for review. Use the tools on the
Detailing tab to annotate designs, create drawing sheets, and review design changes. You can customize detailing
settings to conform to standards or create your own custom style.
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Detail view
One of the view selections for drawing sheets. Detail view creates an enlarged view of a particular area, magnifying
a portion to show more detail. You create a detailed view from one of the other views on the drawing sheet. See
General view, Projected view, and Cross-section view.

Dimension
Annotation on a drawing showing measurement of an edge or face. Use the Dimension tool to add measurements
to your design, drawing sheet, or 3D markup.

Dimensional sketching
Precise sketching by entering measurement values for the current line or relative to other lines and points. See
Dimensions.

Dimensions
Values or expressions you enter for precise control during the creation or modification of a design. You can dimension
every element, from lines in sketches to faces of solids. See Ordinate dimensions, Progressive dimensions, Ruler
dimension.

Document
A model file (.scdoc) that may contain any combination of design versions, associated drawing sheets, and 3D markup
slides.

Draft
Angle or taper on an object that facilitates removal from a mold or die. You draft by pulling one or more faces around
about another face that you selected as the pivot. You can add or cut material as you pull.

Draft faces
See Draft

Driving cylinder
Shape used when pulling a hole to create a curved or radial slot. You select the face or axis of the driving cylinder
to guide the shape of the slot.

Driving dimension
Ruler dimension created with the Move, Pull, or Select tool and saved within a group.
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Driving edge
Edge you select to drive the change when using the Pull tool. Select a driving edge for revolves, directed extrusions,
sweeps, and drafts. The driving edge is shown in blue.

Driving face
Face you select to drive the change when using the Pull tool. Select a driving face for revolves, directed extrusions,
sweeps, and drafts. The driving face is shown in blue.

DWG
AutoCAD native drawing format. You can open and insert drawings, parts, and assemblies. Drawings can be inserted
as layouts. You can export parts, assemblies, drawing sheets, and 3D markup slides.

DXF
Drawing Interchange Format or Drawing Exchange Format. CAD data file format developed by Autodesk for enabling
data interoperability between AutoCAD and other programs. You can open and insert drawings, parts, and
assemblies.Drawings can be inserted as layouts. You can export parts, assemblies, drawing sheets, and 3D markup
slides.

Eccentric
Not sharing the same center.

Edge
3D object composed of a single outside boundary of a feature. A line sketched in 2D becomes an edge when you pull
your sketch into 3D.

Edge chain
Tangent chain; a continual series of edges that are connected edge-to-edge. Double-clicking an edge in the chain
selects the entire chain.

Edge loop
All of the edges around a face; a continual series of edges that are connected edge-to-edge forming a closed loop.
Double-clicking an edge in the loop selects the entire loop.

Edge tangency
When you blend between two faces, the blend surface begins tangent to the edges of the initial faces and ends
tangent to the edges of the end faces. By deciding which edges you do not want to use for tangency, you can create
a blend with or without the effects of the edges.
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Edit faces as a blend
Using the Edit as Blend tool to move or orient blend planes to edit a face as a blend. See Blend plane, Blend surface.

Ellipse
Geometric shape described as a circle viewed at an angle; oval with two centers of equal radius.

Entity
Term used to refer to any object in a 2D sketch or 3D drawing.

Exploded assembly
View of components in which objects are shown along an axis line.

Extents
The outer boundaries of the objects you have drawn.

Extrude
To pull a face along with its edges. The edges extend to bound the extruded face, creating a new section defined by
the edges.

Face
Side or other surface of a solid. Some examples are the inside surface of a hole or the six sides of a rectangular solid.
See Surface.

Face grid
Horizontal and vertical lines, displayed using the Face Grid tool, that define any face or surface you select in your
design.

Face styles
Modes you can select for displaying a solid or surface. You can set the display to be transparent, opaque, or metallic.
See Graphics styles.

Facet
Simple triangular face used to describe surface geometry in STL (stereolithography) file format.
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Fade scene
Make the geometry under the sketch grid more transparent, by selecting Fade Scene Under Grid in the Display tab.
Selecting this option enhances the visibility of your sketch.

Fill
Use the Fill tool to simplify or clean up geometry by extending surrounding faces to eliminate a selection. The selected
region is filled in or healed with the surrounding surface or solid.

Fillet
Rounded corner at the intersection of two lines or edges; concave intersection between two surfaces. Fillet refers
to an interior corner; exterior corner is known as a round. You can draw a fillet using the Create Rounded Corner
tool or by selecting the Fillet (Constant radius round) option from the Pull options. See Round.

Filleted corner
See Fillet

Filter
See Selection filter

Flag note
See Note

Fulcrum
Hinge; pivot point. When using the Move tool, you can select an object and use the Fulcrum tool guide to move other
objects around it.

Full pull
Pull tool option that enables you to revolve 360 degrees or to the next face, sweep through the full trajectory, or
blend through selected faces.

General view
One of the view selections for drawing sheets. General view makes the selected view independent of the view used
to create it. See Projected view, Cross-section view, and Detail view.
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Geometric tolerances
Annotation symbols used for dimensioning geometry in technical drawings; usage is guided by ASME, ISO, and other
standards.

Golden rectangle
A rectangle with ratio of side lengths (approximately 1:1.618) considered by artists and architects to be aesthetically
pleasing. As you sketch a rectangle, an indicator line appears when the shape has the proportions of a square or
golden rectangle.

Graphics styles
Modes you can select for displaying a design. You can display geometry as shaded, perspective shaded, wireframe,
wireframe with hidden lines displayed in light gray, and wireframe with hidden lines removed. You can apply styles
to your entire design or drawing sheet, to individual layers, or to individual views in your drawing sheet. See Face
styles.

Grid
See Sketch grid

Grid lines
See Face grid

Groups
Sets of objects that appear in the Groups tab. You create a group from any set of selected objects. Information such
as Selection, Alt+selection, move anchoring, axis, and ruler dimension is all stored with the group.

GTOL
See Geometric tolerance

Guides
See Tool guides

Heal
See Fill
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Helix
Pull tool option that revolves the selected shape around an axis to create a screw or drill shape. You control the
height, direction, pitch, and taper.

Home view
Tool used to return the view to the Home settings. You can customize the Home view tool so that it displays your
design with a specific orientation, location, and zoom level.

Imprinted edge
A line that does not define a corner. For example, you might create an imprinted edge on a face of a cube, if you
want to divide the face and pull different parts. Imprinted edges are often created when importing designs.

Inking a line
See Project to sketch

Interference
Edges where solids intersect each other or volumes created by the intersection of solids, surfaces, and components
in your design; can be displayed using the Analysis tools.

Intersect
A tool used to split solids and faces.

Inverse selection
The inverse of the current selection in the active component. For example, if you select the top face of a cylinder,
right-click and select Select > Inverse Selection, the entire cylinder except the top face will be selected.

ISO
International Organization for Standardization standards for architectural and engineering drawing, including
guidelines for dimensioning and tolerancing. You can customize the style of your annotations to conform to ISO
standards. See ASME, JIS.

Isometric view
3D view of surfaces and edges, oriented to show the top, front, and side faces of your design. The angles between
the projection of the x, y, and z axes are all equal at 120�. See Trimetric view.
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JIS
Japanese Standards Association standards for technical drawings. You can customize the style of your annotations
to conform to JIS standards. JIS defaults are the same as ISO, except that JIS uses third-angle views while ISO uses
first-angle views. See ASME, ISO.

K-factor
Parameter of bends in a sheet metal part used to calculate the bend radius. K-factor is a percentage of the metal
thickness and depends on factors such as the material and type of bending operation. Relates to the depth of the
neutral axis; a line within the sheet where the length does not change when the sheet is bent. The inside of the bend
is under compression, the outside is under tension, and the neutral axis occurs somewhere between the midpoint
of the material (K-factor=0.50) and a point closer to the inside of the bend (K-factor=0.25).

Layer
Grouping mechanism for visual characteristics such as visibility and color. You can group objects on layers to organize
your drawing. Layers are especially useful when you want to show or hide annotation planes.

Layout
2D drawing mode that is most useful when you have no immediate need to generate 3D objects from the lines in
the layout. If you try to pull layout lines to 3D, they do not behave the same way that sketched lines do. Think of a
layout as a pencil drawing made on your design. When you are ready to use your layout to create geometry, you
must project the layout lines to a sketch. Projecting a layout line to a sketch is like inking the line. You can import a
2D AutoCAD DXF or DWG file as a layout.

Library
You can select from the Materials Library in the Properties panel and add them to your Local Materials. In Scripting,
the Class Library is a help document that describes the API.

Lightweight assembly
Graphics-only representation of a design. When inserting an external file into a design, select the Enable lightweight
assemblies option to load only the component's graphic information. This improves performance of large and
complex assemblies for quicker viewing. When you are ready to work with the component, you can load the geometry
information.

Lightweight component
See Lightweight assembly

Line
A straight line, arc, or spline drawn in Sketch mode or on a layout plane. Lines have length but no area. When you
pull a sketch into 3D with the Pull tool, lines become edges.
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Local materials
See Library

Markup
Slides you can create to highlight and communicate the differences between versions of a design.

Mass
Analysis tool used to display mass properties, or volume information for the solids and surfaces in your design.

Mass properties
See Mass

Material
Property that you can assign to an object, consisting of material name and attributes such as density and tensile
strength.

Materials library
See Library

Mating condition
Attribute of components that specifies how they are aligned with each other. You create mating conditions with the
Assembly tools.

Measure
Tools for displaying measurement properties of the edges, faces, and solids in your design.

Mesh object
Object created by importing an STL file lightweight (facets only). Mesh objects have the ability to snap to the facets.

Mini-toolbar
Set of tool-specific options that appears when you right-click in the Design window. You can also access the options
in the Options panel.
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Mirror
Associative relationship between two faces or planes mirrored about a centerline plane or planar face. The second
object is a copy of the original; if the geometry of the original is changed, the mirrored copy is also updated. Use the
Mirror tool to designate a face or plane as a mirror, or to create a mirror plane between two faces.

Mode
Three ways of designing: Sketch, Cross-section, or 3D. You can switch between modes at any time.

Mouse up
See Zoom box in

Move
A tool used to translate or rotate geometry.

Neutral plane - Pull tool
The plane, face or edge around which you want to pivot.

Neutral plane - Sheet metal
Sheet metal: the line within a sheet where the length does not change when the sheet is bent; axis.

Non-planar edges
Edges that do not lie in the same plane. See Planar edges.

Normal
The vector that is perpendicular to a flat plane at the selected point. In the case of a non-flat plane, the vector that
is perpendicular to the plane tangent to the surface at the selected point.

Note
Annotation placed on a design, drawing sheet, or 3D markup. Notes contain text or symbols that you insert and can
be connected to geometry by a note leader.

Object
Anything recognizable by the tools. 3D objects include vertices, edges, faces, surfaces, solids, layouts, planes, axes,
and origins. 2D objects include points and lines.
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Offset
Distance an edge, segment, or curve is moved or copied.

Offset baseline faces
See Offset relationship

Offset relationship
A relationship between two faces that is maintained in the 2D and 3D editing tools. Offset relationships are created
when you define a relationship using the Offset tool, create a sheet metal part, or Shell a solid.

Offsetting faces
Pulling a face without selecting the edges. The pull extends the neighboring faces without creating an edge. The
neighboring faces extend to bound the offset face, creating a new section defined by the adjacent geometry.

Offsetting lines
Using the Offset Line tool to create an offset of any line or spline in the grid plane. A new object is created at a
specified distance from the selected object.

Options panel
Area of the user interface that enables you to modify functions specific to tools.

Ordinate dimensions
X or Y distances that originate from a single location, which is usually the lower left corner of the object. Also known
as datum dimensioning or baseline dimensioning

Orientation angle
Property that you define when sketching a polygon. Orientation angle determines the polygon's rotational position.

Origin
Zero point in coordinate system. You can insert an origin at any location in your design where you can anchor the
Move tool, enabling you to dimension from the origin or quickly move the sketch grid to the origin. You can also
insert an origin at a solid's center of mass or volume.

Origin Axis
Axis through the origin.

1178Release 2022 R2 - © Ansys, Inc. All rights reserved.
Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

Published: 2022-09-15T20:01:55.504-04:00

19.1. Glossary



Orthogonal view
Projection that is constrained to regular 90° angles (top, bottom, left, and right of the current view). When you create
a projected view from one of the other views on the drawing sheet, the available projections are orthogonal
(orthographic).

Pan
Move a drawing around by dragging the drawing area around your screen; move the viewpoint laterally relative to
the drawing.

Panwithmulti-touch
Move two fingers together across the screen.

Panel
Sections of the user interface that initially appear along the left side of the application window and include: Structure
panel, Layers panel, Selection panel, Groups panel, Options panel, and Properties panel. You can dock and detach
these panels.

Parasolid
Parasolid geometric modeling kernel. You can open and insert parts and assemblies and export parts and assemblies.

Parent component
A component upon which other components depend. For example, in a block with a hole, the block is the parent
and the hole is the child.

Patch blend
Fill tool option that uses the initial tangency of the neighboring faces to fill the selected edges. Faces are blended
into a smooth, single-face patch, instead of extending the faces attached to the edge until they intersect. Deselecting
the Tangent extension option ignores the tangency of the neighboring faces.

Periodic blend
Pull tool option used to go all the way around when blending faces.

Periodic face
A cylinder, cone, or other revolved surface.
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Pitch
Unit of length that a helix face shifts per 360° rotation; distance from one point on a thread to the corresponding
point on the next thread.

Pivot line
Line around which a face is revolved using the Pull tool.

Plan view
Head-on view.

Planar edges
Two or more edges that lie in the same plane. You can select planar edges and select the Plane tool from the Insert
ribbon group to insert the plane defined by the edges.

Planar face
Face that lies within a plane.

Plane
Construction geometry consisting of a flat surface. Planes can be used for a 2D sketch, section view of a model, a
neutral plane in a draft feature.

PMI
Product Manufacturing Information. You can import PMI if you check the Import Part Manufacturing Information
box when importing CATIA files.

Point
Single location in the sketch grid. 2-D object that has no height, width, or length. The origin, an axis, and a vertex
are examples of points. Use the Point tool to sketch a point on the sketch grid. Points are useful as a dimensional
reference, for splitting, and for creating a point on a line or curve through which you want to draw a three-point
circle.

Polar coordinates
See coordinates
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Polygon
Complex object composed of three or more straight lines in a closed figure. Use the Polygon tool to sketch a polygon
with up to 32 sides.

Power selection
Advanced selection tool available from the Selection tab. Enables you to search for and select all objects with
geometry similar to the currently selected object.

Profile
Line in space; outline of an object; used to describe objects when sweeping or blending.

Project to sketch
Tool used to convert 2D layout lines to a sketch so you can use the layout to create geometry.

Projected view
One of the view selections for drawing sheets. You create a projected view from one of the other views on the drawing
sheet to show another side of the model. See General view, Cross-section view, and Detail view

Properties panel
Area of the user interface that displays editable details about the selected object(s). This panel is initially displayed
on the lower left side of the screen, but can be moved.

Pull
Tool used to distort or deform geometry. Use the Pull tool to offset, extrude, revolve, sweep, draft, and blend faces;
or to round, chamfer, or extrude edges. When converting a sketch to 3D, pulling a line creates a surface and pulling
a surface creates a solid.

Quality
Tools for detecting anomalies or discontinuities in surfaces.

Quick Access Toolbar
Tool icons that appear at the top of the user interface, next to the File menu, and include common Windows commands
such as Open, Save, and Undo. You can customize the toolbar so that it contains the file-related shortcuts you use
most often.
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Radial slot
A slot created by pulling a hole toward the axis of the driving cylinder. See Curved slot.

Radiused corner
See Fillet (interior corner) or Round (exterior corner)

Reference line
Line used as the starting point for dimensioning.

Region
When you sketch shapes in 2D using the sketch tools, regions are formed by closed or intersecting lines. The regions
will become solids and the lines become edges when you pull your sketch into 3D with the Pull tool.

Regular face
An unblended face. The face must be converted to a blended face before you can edit the face as a blend. See Blend
surface

Relative coordinates
See Coordinates

Remove associations
Tool that removes an associative relationship. For example, removing a polygon relationship enables you to make
changes to only one face of the polygon solid without affecting the other faces. See Associations.

Rendering
Mode available from the Properties panel for a view on a drawing sheet. Use Rendering mode to change the Graphics
style for the view. Select Inherit if you want to link the graphics style to the parent view. See Graphics styles.

Revolve
Move in a path around an axis. Use the Pull tool to revolve faces, edges, or a helix around an axis. The axis may be
a straight line, axis, or edge. See Subtractive revolve.

Revolve axis
A straight line, axis, or edge around which you revolve a face, edge, or helix.
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Rotate
Design: Using the Rotate tool to spin a design 90 degrees in the plane of the screen. You can rotate your design
clockwise or counterclockwise. Object: Using the Move handle to spin an object around an axis.

Rotate withmulti-touch
Hold one finger on the axis you want to rotate around and move the other finger in an arc that is centered on your
first finger.

Rotational blend
Pull tool option used when blending faces to create cylinders and cones whenever possible.

Round
Rounded corner at the intersection of two lines or edges. Round refers to an exterior corner; an interior corner is
known as a fillet. Rounds and fillets are both called rounds. See Fillet, Constant-radius round, Variable-radius round.

Round Group
Grouping that is created each time you fill a round. You can reattach a group of rounds as long as some portion of
the original edges (or faces that bordered the edges) still exists in your design. See Group.

Ruler dimension
Option used to enter precise dimensions when pulling or moving. Dimensions may be linear when moving or pulling,
or angular when rotating.

Scale
Solid or surface: Change the size of the selected object using the Pull tool. You can scale dynamically or by entering
a scale value. Drawing sheet or cross-section views: Magnify or shrink the view by selecting a View in the Structure
tree and editing the Properties panel.

SCDOC file
File format for SpaceClaim files (.scdoc). Files comply with the Microsoft Open Packaging Convention, which is also
used by Microsoft Office 2007. These files are actually zip archives with a special structure, the contents of which
are primarily XML data.

Section
Design mode in which you edit solids by working with their edges and vertices in cross-section. View is cut away to
show interior detail.
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Sectionmode
See Section

Selection filter
Drop-down control in the status bar that can be used to limit the selection of objects. Only object types you check
will be selected; for example, only faces and edges.

Selection tab
Area of the user interface where you can locate objects similar to the ones selected. See Power selection.

Shell
Solid or part that is hollowed out from a selected face, leaving a shell of designated thickness.

Shell relationship
Association that stays with a solid when it is moved to another component, unless the relationship would link two
components when it is moved. See Shell.

Silhouette edge
Edge that is rotated to conceal a 3D object and appears as a 2D line.

Sketch grid
Pattern of regularly spaced lines that guides you when sketching. The sketch grid makes aligning and drawing objects
easier.You can adjust the units and spacing of the grid, as well as how solids are displayed when the grid appears.

Sketchmode
Mode for drawing in two dimensions using the sketching tools on the sketch grid. A sketch is a collection of lines
and other 2D objects on a sketch grid. Sketching creates regions that can be pulled into 3D. When you pull your
sketch into 3D with the Pull tool, regions formed by intersecting lines will become solids and lines will become edges.

SLA
See Stereo lithography

Snap
Constrain to objects, angular and linear increments, or grid points while you are sketching or editing solids. You can
customize the snapping behavior in File>Options. Pressing Shift while dragging snaps the tool based on your snap
settings. You can use the Snap to grid tool to constrain or lock all drawing to grid points only.
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Snap view
Tool used to display the head-on view of a face. You can also use the tool to "throw" the highlighted face to the top,
bottom, right, or left.

Solid
Object that encloses volume. A surface becomes a solid if it encloses volume.

Spin
Tool used to re-orient your design in any direction, allowing you to view it from any angle.

Spin center
Axis about which you spin your design when you use the Spin tool.

Spline
A continuously curved line, without sharp boundaries (that is, without vertices). Create a spline by defining a set of
points using the Spline tool. A spline becomes an edge when you pull it with the Pull tool.

Split
Using the Combine tool to split solids or surfaces. You select a solid or surface to use as a Cutting tool to cut the
target. See Cutter object.

STEP
Standard for the Exchange of Product model data (ISO 10303). Defines a methodology for describing product data.
You can select the STEP protocol when you export designs.

Stereo lithography
Technology used for rapid prototyping, in which a laser hardens successive layers of a photopolymer to create a
part with a shape defined by a computer model.

Sticky tool guide
Tool guides that are sticky appear with a double outline when clicked. After you click it, the tool guide remains
selected so you can select multiple objects by clicking on each object.

STL file
File format native to the stereo lithography CAD software created by 3D Systems. You can export parts and assemblies
(.stl).See Stereo lithography.
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Structure tree
Display in the Structure panel that shows you each of the objects in your design. You can expand or collapse the
nodes of the tree to view the objects. You can rename objects, create, modify, replace, and delete objects, as well
as work with components.

Subtractive
Manipulation (revolve, draft, pull, etc.) of a solid in which material is removed. In editing tools performing subtractive
operations, the cursor changes to - to indicate that the edit is subtractive.

Surface
Two dimensional object that has no thickness (as opposed to a face, which is part of a three-dimensional object). A
surface has area but no volume. See Face.

Surface finish symbols
Annotation you can add to a drawing that provides instructions for material removal during manufacturing.

Sweep
Pull a surface or face along a line or edge using the Pull tool. You can sweep faces and edges, and select straight or
curved lines or edges along which to sweep. Sweeping along a spline is a pulling technique for creating a smooth,
swoopy shape. See Trajectory.

Sweep arc
Arc created by defining a center point and two end points; drawn using the Sweep Arc tool.

Sweep circle
The circular path followed by a Swept arc. See Swept arc.

Sweep trajectory
See Trajectory

Swept arc
See Sweep arc

Tangent
Line that touches a curve (arc or circle) at only one point, without crossing over, and is perpendicular to the radius
at the point of tangency. You can sketch a line tangent to a curve or you can sketch an arc tangent to a line or curve.
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Tangent arc
Arc that is sketched using the Tangent Arc tool, using a point on a line or curve as the starting point.

Tangent chain
See Edge chain.

Tangent edges
Transition edge between rounded or filleted faces in hidden lines visible or hidden lines removed modes in drawings.

Tangent extension
See Patch blend

Tangent faces
Faces created by rounds or when edges are drawn on a face.

Taper
Angle of a helix or threads made on a conical surface. See Helix, Thread.

Target
The object you want to cut, when using the Combine tool to split a solid or surface.

Tessellation
An approach for data exchange between CAD programs. Tessellation represents entities such as lines and surfaces
in a CAD system with tiny triangles (polygonal data representations). Data formats such as XML and VRML are examples
of tessellated data.

Theme
Set of view navigation options used for spin, pan, and zoom.

Thickness edge
Edge across the thickness of a sheet metal wall.

Thickness face
The end face of a sheet metal wall. The thickness face is shown highlighted in orange in the image below.
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Thread
Texture created on the surface of a cylinder, cone, or hole using the Annotation tools.

Three point arc
Arc created by defining a starting point, an end point, and a radius; drawn using the Three-Point Arc tool.

Tool guides
Functions that are specific to the selected tool.

Torus
Doughnut-shaped object created using the Pull tool to sweep a sketched shape around an axis on a circular path.

Trajectory
Straight or curved line or edge along which you sweep a face or an edge.

Translate
Move in a plane (x, y, or z).

Trim away
Delete a line portion bounded by an intersection with a line or edge.

Trimetric view
3D view of surfaces and edges, oriented to show the top, front, and side faces of your design. Compared to isometric
view, trimetric view angles the front face slightly towards you, shows less of the side face, and less of the top. This
is the default Home view. See Isometric view.

U-V lines
See Face Grid

UV grid
See Face Grid
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Variable radius round
Fillet created from a constant-radius round by selecting one edge of the round and pulling it to a new radius. See
Fillet, Constant-radius round.

Vee-die width
Sheet metal property; sets the width of the tooling that produces a bend.

Vertex
Point that terminates a line; point at which two or more lines or edges intersect. Vertices can be selected for sketching,
dimensioning, and other operations.

View
Orientation settings that you can apply to your design, including spin, pan, and zoom. You can adjust these settings
individually or you can apply one of the following preconfigured views: Trimetric, Isometric, Top, Bottom, Front,
Back, Right, Left. You can also select Snap View and click a face to view it head-on.

Virtual sharp
Point of intersection formed by extending converging lines.

Wall face
The side face of a sheet metal wall. The two perpendicular wall faces are highlighted in orange in the image below.

Wireframe
View mode in which all edges of the part or assembly are displayed.

World origin
Axes that set the default orientation of the design in the Design window. Display the World origin by checking the
World Origin box on the Display tab.

Zoom box in
Tool used to pan and zoom until the design fits within a selected area.

Zoom extents
Tool used to enlarge or contract the view so that the selected face, the selected edge, or the design fills the Design
window. If you are working with a drawing sheet, Zoom extents will fit the drawing sheet to the Design window.
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